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Bienvenue

Merci d’avoir choisi Samplitude !

Vous possédez maintenant une des plus puissantes applications station de travail
audionumérique basée sur ordinateur qui soient disponibles pour les
professionnels de l’audio.
Samplitude est une application d’enregistrement multipiste, de post production
et de mastering pour les professionnels de la musique qui demandent de la
fiabilité, de l’efficacité et des performances optimales.
Ce mode d’emploi vous présentera toutes les caractéristiques de Samplitude.
Les plus impatients peuvent se reporter directement à la section Prise en main
du mode d’emploi. Toutefois, étant donné la multitude de fonctions
particulièrement sophistiquées de Samplitude, nous vous recommandons
fortement de lire ce mode d’emploi dans son intégralité.
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Configuration nécessaire

Samplitude nécessite la configuration matérielle et logicielle minimale suivante:
– Gravure de CD audio, édition/montage audio : Pentium 200
– Traitements en temps réel avec effets standard: Pentium II
– Traitements en temps réel avec effets Master lors du mixage: Pentium III

800 MHz

Besoins en matière de disque dur
Le nombre de pistes disponibles dépend totalement de la vitesse de rotation, du
temps d’accès et du taux de transfert du ou des disques durs utilisés. Avec les
disques Ultra DMA modernes, vous pouvez manipuler de nombreuses pistes.
Nous vous conseillons l’emploi de disques 7200 tours/minute avec temps d’accès
inférieur à 9 ms.

Autres exigences
– 64 Mo de RAM pour Windows 9x, 128 Mo pour Windows NT 4.0 ou Windows

2000/XP.
– 20 Mo d’espace disque pour les fichiers programmes et les fichiers d’exemples

et de didacticiels ; espace disque suffisant pour l’enregistrement
audionumérique (10 Mo/min audio en 16 bits, 44,1 kHz).

– Carte graphique VGA ou mieux, résolution minimum de 800x600 en 256
couleurs, 32000 couleurs pour l’intégration AVI, résolution 1024x768 ou
supérieure recommandée pour la Table de Mixage en temps réel.

– Carte son 16 bits, 24 bits ou 32 bits compatible Windows. Possibilité d’utiliser
des cartes son à entrées/sorties multiples.

– Graveur de CD obligatoire pour la fonction de gravure de CD-R (vous pouvez
trouver la liste des graveurs pris en charge dans la documentation
électronique).

Précision sur la configuration informatique nécessaire
L’enregistrement et l’édition audionumériques ont fait beaucoup de chemin en
peu de temps. Si l’on regarde les débuts relativement limités et «basse-fidélité»
de l’enregistrement et de l’édition audio numérique, nous voyons que le domaine
progresse rapidement et nous amène bien au-delà des capacités des systèmes
disponibles il y a seulement 2 ans!
On peut réaliser des merveilles grâce aux stations audionumériques, mais soyons
réalistes – ce type de traitement demande une puissance de calcul adéquate.
Les ordinateurs personnels gagnent continuellement en puissance, et ce qui
n’était que des «possibilités» est devenu réalité dans le monde audio numérique.
Nous avons inclus la section suivante à titre de guide pour la configuration
nécessaire à l’édition audio numérique. Ces besoins «basiques» augmenteront
significativement si vous désirez faire de l’enregistrement numérique multipiste
avec votre ordinateur.
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Configuration nécessaire
Gardez cela à l’esprit en lisant ce qui suit:

Edition d’échantillon ou d’audio simple
Pour une édition audio simple, avec pas plus de 4 ou 6 pistes mono ou 2 ou 3
pistes stéréo, un ordinateur à Pentium 200 équipé d’un disque dur rapide suffit.
Dans tous les cas, utilisez un disque dur dont le temps d’accès est de 10 ms ou
moins. Si vous utilisez Samplitude sous Windows NT 4.0, Windows 2000 ou
Windows XP, il est conseillé de disposer au minimum de 128 Mo de RAM.
Samplitude en lui-même ne demande pas beaucoup de mémoire. Néanmoins,
en fonction du système d’exploitation utilisé, vous obtiendrez de meilleurs
résultats avec davantage de mémoire.
Cette configuration système permet d’effectuer des tâches d’édition audio
simples. S’il vous faut plus de pistes, reportez-vous à la section suivante pour
connaître la configuration nécessaire.

Productions multipistes
Samplitude permet de réaliser sur disque dur des enregistrements audio
multipistes élaborés et des tâches de production audio qui s’accomplissent
d’habitude dans les studios d’enregistrement professionnels ou semi-
professionnels, dans les maisons de pré-production et post-production ou dans
les stations de radio et de télévision.
Ces types d’applications sont plus exigeants que l’enregistrement et l’édition
simple d’une poignée de pistes. Plus le nombre de pistes nécessaires est élevé,
plus la configuration informatique devra être puissante et fiable.
Nous vous conseillons d’opter pour une configuration comprenant un
Pentium II 400 ou supérieur, Windows 98, NT ou 2000 ou XP avec un disque
dur 7200 tr/minute proposant un temps d’accès de 9 ms ou plus rapide. Les
disques IDE actuels conviennent en général très bien aux exigences de
l’enregistrement et de la reproduction audio numérique.
Du matériel supplémentaire est nécessaire pour synchroniser Samplitude avec
des appareils externes. Pour un potentiel encore supérieur d’édition en temps
réel et d’effets, nous vous recommandons l’emploi d’un ordinateur à Pentium
III, Pentium IV ou AthlonXP.

Enregistrement multipiste avec des séquenceurs MIDI
Un autre type de travail multipiste communément accompli avec Samplitude
implique la synchronisation avec des séquenceurs MIDI. Les séquenceurs MIDI
tournent souvent en multitâche sur le même ordinateur que Samplitude et les
deux programmes doivent être synchronisés. Si vous utilisez un grand nombre
de pistes audio, les besoins du système augmenteront automatiquement dans
ce type de configuration. Par nature, un séquenceur MIDI consomme peu de
ressources et ne nécessite donc pas un ordinateur ultra-puissant. Par contre,
pour pouvoir faire tourner les deux programmes simultanément sur le même
ordinateur, les besoins de vitesse sont évidemment plus importants.
En outre, il vous faudra installer sur l’ordinateur un programme d’affectation
MIDI virtuel ou une interface MIDI afin de pouvoir synchroniser les deux
applications.
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Configuration nécessaire

Productions multipistes avec montage vidéo
Comme les productions audio multipistes et les productions vidéo
nécessitent d’énormes ressources, il est préférable de les laisser sur des
ordinateurs séparés, surtout si vous comptez synchroniser de nombreuses
pistes audio à des pistes vidéo. Vous pouvez toutefois utiliser un même
ordinateur si les pistes audio sont réduites par mixage à un nombre limité
de pistes (quelques pistes stéréo), l’édition vidéo devient alors la priorité
pour le processeur de l’ordinateur.

Que faut-il d’autre?
En tant qu’application basée sur un hôte, Samplitude est compatible avec
la plupart des composants matériels et logiciels des stations de travail
pour PC. Vous pouvez obtenir de plus amples renseignements à ce sujet
auprès de votre revendeur. Les revendeurs peuvent être d’une grande
utilité et peuvent bien connaître le type de matériel nécessaire à l’emploi
avec Samplitude. Ils peuvent aussi vous aider quant aux logiciels
supplémentaires que vous pourriez employer en conjonction avec
Samplitude. On ne pose jamais trop de questions, aussi n’ayez pas peur
de solliciter leur savoir.

Problèmes de compatibilité
Nous avons porté un soin particulier au développement et à la création
de composants informatiques matériels et logiciels à la pointe de
l’industrie audio et vidéo.
Samplitude en est un exemple idéal. Le fait que Samplitude fonctionne
aussi bien sous Windows 98, NT, 2000 que XP illustre notre volonté de
rester à la pointe des produits et des technologies. Samplitude s’interface
avec deux composants principaux – la ou les cartes son et le système
d’exploitation (Windows). Nous nous efforçons constamment de résoudre
tout problème pouvant survenir suite à l’emploi de notre logiciel dans
votre environnement. De temps en temps, de nouveaux pilotes de cartes
son ou des mises à jour des systèmes d’exploitation sont proposés. Même
si elles sont en général bénéfiques, ces mises à jour peuvent parfois avoir
un effet néfaste sur les fonctionnalités du logiciel. Soyez assuré que nous
faisons tout notre possible pour résoudre dans les plus brefs délais les
problèmes qui peuvent périodiquement survenir. Quand c’est possible,
nous le faisons en coopération avec les autres fabricants de matériel et de
logiciel, afin d’assurer des performances constantes et fiables à nos
produits. Si vous avez besoin d’une assistance technique sur l’un de nos
produits, n’hésitez pas à contacter nos services d’assistance aux
coordonnées indiquées dans le logiciel.

Migration: Comme les composants audio de PC et le logiciel Samplitude
peuvent toujours être employés quand vous changez ou faites évoluer votre
système, vous bénéficierez des performances supérieures des futurs
processeurs.
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Installation de Samplitude

Note: pour une installation correcte de votre clé («Dongle»), veuillez consulter le fichier
Readme indépendant portant sur ce sujet.

1
Insérez le CD-ROM d’installation dans le lecteur CD-ROM.

2
Le programme d’installation démarre automatiquement. Si ce n’est pas le cas,
ouvrez le Gestionnaire de fichiers/Explorateur et cliquez sur la lettre de lecteur
représentant le lecteur de CD-ROM (généralement D:\.) Double-cliquez sur
start.exe.

3
Pour commencer l’installation de Samplitude, cliquez sur INSTALL

4
Le programme d’installation de Samplitude démarre. Suivez les instructions à
l’écran.
Une fois que tous les fichiers ont été copiés sur le disque dur, un groupe de
programmes sera créé. L’installation est maintenant terminée. Confirmez-le
avec Finish (Terminer).
Vous pouvez à présent lancer le programme à tout moment depuis le menu
Démarrer de Windows.

Par défaut, Samplitude établit les chemins d’accès pour l’audio enregistré, les
projets, etc. sur des sous-dossiers dans le dossier du programme. Vous pouvez
changer ces chemins d’accès dans les propriétés du système (touche: «Y») en
fonction de votre méthode de travail. Nous vous recommandons de conserver
les données des nouveaux VIP et des projets sur un autre disque que celui du
système. Veuillez aussi regarder le contenu du CD «Add-on».
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Assistance

Si vous rencontrez des problèmes avec votre logiciel, veuillez entrer en contact
avec notre équipe d’assistance. Samplitude doit avoir été enregistré avant que
vous puissiez faire appel à une des options d’assistance que nous vous offrons.
De l’aide est aussi disponible sur le site web officiel de Samplitude:

www.samplitude.com

Ce site web vous amènera à la page d’assistance clientèle de Samplitude,
contenant entre autres les offres gratuites suivantes:
– La FAQ (foire aux questions) et les trucs et astuces généraux. Dans la plupart

des cas, vous y trouverez la solution à vos problèmes. Dans le cas contraire,
contactez notre assistance technique.

– Forum : Vous n’êtes pas seul. D’autres utilisateurs ont peut-être déjà rencontré
le même problème que vous et peuvent vous aider à trouver une solution.
Notre service technique est également un habitué de ce forum.

– Section de téléchargement : Des mises à jour, améliorations et correctifs sont
proposés régulièrement et gratuitement en téléchargement. De nombreux
problèmes que vous rencontrez nous sont familiers et se résolvent avec le
dernier correctif. Outre ces correctifs, vous pouvez trouver de nombreux
assistants pour vérifier et optimiser votre système.

– Groupe de discussion : Il vous permet de communiquer directement avec
d’autres utilisateurs de Samplitude.

Vous pouvez également contacter notre service technique par email, téléphone
ou fax.

France:
Tél: 01 48 63 11 46
Fax: 01 48 63 22 92
Email: scv@scv.fr
Email: proservice@magix.net

Autres pays:
Tél: +33 (0)1 48 63 11 46
Fax: +33 (0)1 48 63 22 92
Email: proservice@magix.net

Avant de prendre contact, veillez à disposer des informations suivantes:
– Version de Samplitude, revendeur
– Configuration de votre ordinateur (système d’exploitation, processeur,

mémoire, disque dur...)
– Configuration de la carte son (type, pilote)
– Informations sur les autres logiciels installés
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Quoi de neuf dans Samplitude 8?

Son Surround 12-canaux, effets Surround et son objet (Samplitude
Professional seulement)
Prend en charge tous les formats multicanaux communs. Configure jusqu’à 12
canaux.
Samplitude V8 dispose d’un concept de mise en œuvre surround nouveau et
révolutionnaire, qui répond aux besoins actuels et futurs de la production sonore
en musique, en diffusion et en post-production. En plus de la prise en charge
du surround, cela comprend un package complet d’effets surround avec
activation d’égaliseurs multicanaux, et des outils de traitement dynamique
(Samplitude Professional seulement). Le simulateur de pièce en temps réel, à
convolution, introduit dans la Version 7 dispose maintenant de capacités
surround et est livré avec de nouvelles réponses impulsionnelles pour des
applications stéréo et surround.
La possibilité d’objet surround est une véritable innovation. Chaque objet audio
d’un projet Samplitude peut être positionné individuellement dans le champ
surround – idéal pour un emploi efficace et créatif en production multicanal
pour la musique, la diffusion, le film et la radio (Samplitude Professional
seulement).

Gestionnaires d’archives fichiers, d’objets, de pistes, de plages et de
marqueurs
Un gestionnaire orienté projet établi pour gérer les objets, pistes, plages et
marqueurs, qui été développé en coopération avec des utilisateurs professionnels,
permet une gestion et un archivage efficaces, ainsi qu’une gestion de tous les
contenus de projets et de toutes les données directement depuis l’environnement
de travail. Utilisez le nouveau navigateur de fichiers pour rechercher du matériel
audio et pour une pré-écoute rapide.

MAGIX Analogue Modeling Suite (am|track) (Samplitude
Professional seulement)
Les simulations d’effets analogiques non linéaires traditionnels de Samplitude
V8 complètent les excellents effets audio déjà disponibles. Cela comprend un
compresseur analogique de haute qualité avec une simulation optionnelle de
l’effet de saturation de bande (am|track) et un concepteur de transitoires (am|puls)
pour influencer le caractère percussif ou le maintien (sustain) des enveloppes
de signal.

MAGIX Elastic Audio (Samplitude Professional seulement)
La hauteur de l’audio peut être éditée aussi souplement que le MIDI. Un éditeur
est prévu pour cela, qui combine l’automation de hauteur avec les routines de
détection de hauteur pour la correction de la hauteur de matériel audio
monophonique. Plusieurs algorithmes sont disponibles pour l’automation de
hauteur, dont le rééchantillonnage (resampling) et la transposition (pitch shift)
utilisant plusieurs algorithmes. Le matériel audio monophonique peut aussi
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être découpé en tranches de notes. La hauteur de chaque tranche peut alors être
changée individuellement. Les applications typiques de cet outil sont, par
exemple, la correction d’intonations ou l’emploi créatif pour changer ou corriger
des mélodies, comme la création d’une seconde voix. L’automation de hauteur
peut aussi être employée pour ajuster du matériel  polyphonique (par ex. des
enregistrements de chœur et d’instruments à vent).

MIDI: éditeur de batterie, multi-éditeur de contrôleur (Samplitude
Classic & Professional seulement)
Les outils MIDI grandement améliorés permettent un emploi souple et créatif
d’arrangements musicaux dans le programme. L’éditeur MIDI perfectionné
dispose d’un multi-éditeur de conception nouvelle pour simultanément afficher
et éditer des données de commande MIDI et de pitch bend. Un nouvel éditeur
de batterie incluant une matrice et un éditeur par cellule avec option de
dynamique («vélocité») graphique et une gestion pratique de configuration de
batterie (Drum Map) permet le traitement des instruments de percussion au
moyen de différentes options d’édition.

Changement de la post-production image
La synchronisation avec des fichiers vidéo (AVI) a été changée pour le format
DirectShow. Cela a considérablement amélioré la compatibilité avec divers
formats vidéo. Plus encore, vous pouvez maintenant employer n’importe quel
équipement compatible DirectShow (carte graphique) pour directement
visualiser les vidéos sur votre téléviseur, vidéophone ou moniteur de contrôle.

Autres caractéristiques (certains des changements complets)
– Maniement amélioré des données MIDI et des instruments virtuels dans le

programme
– Quantification améliorée (MIDI)
– Enregistrement par superposition (overdub), fusion MIDI, réduction (collage,

report, etc.)
– MAGIX Robota Pro (Samplitude Professional seulement): synthétiseur

analogique virtuel à huit voix avec séquenceur pas à pas intégré dans le style
des boîtes à rythmes classiques.

– Prise en charge de ReWire (Samplitude Classic & Professional seulement) –
idéal pour les utilisateurs qui emploi principalement l’audio et le mastering
sur PC, mais ne veulent pas se passer d’autres outils ReWire.

– Enregistrement par insertion (punch-in) piste par piste
– Prise en charge améliorée des contrôleurs physiques externes (dont la Yamaha

O2R96)
– Agent Remix (AutoCut & AutoLoop de matériel audio basés sur les temps)
– Maniement optimisé des effets (maniement, interface utilisateur)
– DVD-Audio: gravez directement depuis la fenêtre de projet des DVD audio

en son haute définition stéréo et surround
– Vidéo plein écran, soit sur un second moniteur soit sur un téléviseur à toutes

les résolutions (compatible 16:9)
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Prise en main – Débutant

L’enregistrement multipiste simplifié
Première piste
1. Lancez Samplitude en double-cliquant sur son icône.
2. Cliquez sur l’icône Nouveau Projet Virtuel (New Virtual Project) de la barre

d’outils supérieure.
3. La boîte de dialogue Configuration du nouveau projet virtuel (VIP) (Setup for

new Project) s’ouvre à l’écran. Appuyez sur la touche Retour de votre clavier
pour effacer le titre «NEW», puis donnez un nom au projet.

4. Cliquez sur l’icône de dossier, et naviguez jusqu’au dossier désiré pour
l’enregistrement audio – c’est-à-dire un dossier (ou disque) où vous désirez
enregistrer/placer vos fichiers audio.

5. Sélectionnez l’option 4 pistes (4 Tracks), la bonne fréquence d’échantillonnage,
puis cliquez sur OK. Un projet VIP 4 pistes est alors prêt à l’emploi.
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6. Sélectionnez Recording (enregistrement) comme environnement de travail
(Workspace).

Les barres d’outils sont ainsi optimisées pour l’enregistrement et les boutons
non nécessaires à l’enregistrement sont masqués. Prêt à enregistrer ? (Le
bouton REC de la piste 1 doit être allumé en rouge.)

7. Cliquez sur l’icône OPT(ions) d’enregistrement de la barre d’outils supérieure.
Une fenêtre regroupant divers paramètres d’enregistrement s’ouvre alors:

8. Vérifiez que tous les réglages sont corrects.
9. Vérifiez que votre carte son est affichée dans le menu déroulant et cliquez

sur Monitor pour l’activer. Les indicateurs de niveau à DEL réagiront au signal
entrant.

10. En vous aidant des indicateurs de niveau à DEL, réglez le niveau d’entrée de
sorte que les passages les plus forts ne dépassent pas le segment 0 dB. (Le
niveau du signal d’entrée doit se régler à la source ou depuis une console de
mixage.)
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13. Cliquez sur Oui (Yes) pour conserver la prise. La boîte de dialogue se referme
et la prise s’affiche sous la forme d’un objet dans le projet VIP.

14. Cliquez sur Close pour refermer la fenêtre Paramètres d’enregistrement
(Record Parameter).

15. Sauvegardez à présent votre projet 4 pistes en appuyant sur Ctrl + S.

11. Quand vous êtes prêt, lancez l’enregistrement au moyen du bouton
Enregistrer (Record).

12. Une fois que l’enregistrement est terminé, cliquez sur Stop. Une boîte de
dialogue vous demande alors si vous souhaitez conserver la prise enregistrée
ou non.
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Enregistrement de nouvelles pistes
16. Armez la piste 2 pour l’enregistrement en cliquant sur son bouton

d’enregistrement «R».

                                                    Armez la piste 2 pour un enregistrement
                                                   supplémentaire

17. Cliquez sur l’icône d’options d’enregistrement de la barre d’outils supérieure.
La fenêtre Paramètres d’enregistrement (Record Parameter) s’ouvre alors à
l’écran (comme pour la piste 1).

18. Pour pouvoir entendre la piste 1 pendant l’enregistrement de la piste 2, cochez
la case Lecture pendant l’enregistrement (Playback while Recording).

19. Répétez ensuite simplement les étapes 7-14 précédentes, en vous assurant
de donner un nom unique et propre à chaque piste. N’oubliez pas de
sauvegarder votre travail!

Mixage dans Samplitude
Réglage du volume et du panoramique en temps réel
1. Ouvrez la table de mixage de Samplitude en cliquant sur le bouton de table de

mixage de la barre d’outils inférieure ou en appuyant sur la touche «m».
2. Lancez la lecture du projet 4 pistes au moyen de la barre d’espace. Le volume

de l’une des pistes vous semble trop fort ou trop faible ?
3. Pour régler le volume d’une piste, faites glisser son fader vers le haut (hausse

de volume) ou vers le bas (baisse de volume).
4. Pour ramener un fader sur sa position neutre (0 dB), il suffit de double cliquer

dessus.
5. En bas à droite de la table de mixage se trouvent deux faders Master. Ces

faders déterminent le niveau de sortie final (volume général) de toutes les
pistes. Pour régler le volume général du projet, faites glisser l’un des faders.
Ces faders réagissent comme de simples faders de voie.
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6. Une fois le réglage du volume terminé, arrêtez la lecture audio à l’aide de la
barre d’espace.

7. Pour donner de l’ampleur et de la netteté à un mixage, il est conseillé d’attribuer
une position de panoramique propre à chaque piste dans l’espace stéréo. Si
vous lancez la lecture en appuyant sur la barre d’espace, vous remarquez que
toutes les pistes sont placées au centre de l’espace stéréo.

Astuce: Vous pouvez également piloter la lecture depuis la palette de transport
flottante ou depuis le bouton Lecture/Arrêt (Play/Stop) de la table de mixage.

8. Pour régler la position d’une piste dans l’image stéréo, cliquez sur son
potentiomètre Pan, puis faites glisser la souris vers la gauche ou vers la droite.
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9. Pour faire revenir un potentiomètre Pan sur sa position centrale, double-

cliquez simplement dessus
10. Une fois les réglages de panoramiques terminés, arrêtez la lecture audio

avec la barre d’espace.
11. Sauvegardez ensuite les réglages effectués. (Ctrl + S)

Astuce: La barre d’espace permet de lancer et d’arrêter la lecture aussi souvent que
nécessaire.

Donnez du relief à vos pistes – Emploi des effets en temps réel
de Samplitude
1. Dans la fenêtre de la table de mixage toujours ouverte, vous pouvez remarquer

que chaque voie (piste), dispose de quatre boutons rotatifs gris. Ils contrôlent
le correcteur 4 bandes totalement paramétrique de la voie. Lancez la lecture
audio via la barre d’espace.

2. Pendant que vous écoutez le projet 4 pistes, remarquez-vous que certaines
pistes disposent d’un registre grave riche alors que d’autres en manquent ?
Cliquez sur le potentiomètre LO. Dès lors, faites glisser la souris vers la gauche
pour atténuer les graves ou vers la droite pour les accentuer. Utilisez cette
technique pour toutes les pistes dont vous souhaitez régler la correction.

3. En reprenant la méthode appliquée à l’étape 2, réglez les potentiomètres de
médiums («LM» et «HM») et d’aigus «Hi» de chaque piste le nécessitant. Vous
pouvez lancer et arrêter la lecture à tout moment au moyen de la barre d’espace.

4. Pour faire revenir un potentiomètre de correction sur sa position centrale par
défaut (désactivé), double-cliquez dessus.

5. Cliquez à présent avec le bouton droit sur l’un des potentiomètres de correction.
Vous accédez alors à la fenêtre de réglage du correcteur paramétrique 4 bandes
représentée ci-dessous:
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6. Vous pouvez y définir en temps réel la correction désirée au moyen des

curseurs de réglage, ou en saisissant directement les valeurs désirées dans
les champs numériques. La courbe de correction s’affiche à l’écran.

7. Une fois que vous avez défini la correction souhaitée, vous pouvez revenir
sur la table de mixage – les potentiomètres de correction reprennent alors les
réglages réalisés et leur gain est réglable depuis la table de mixage.

8. Juste au-dessus du correcteur de chaque voie se trouve un potentiomètre Delay.
Il sert à appliquer des effets de retard et de reverb à vos pistes. Lancez la
lecture audio grâce à la barre d’espace.

9. Ecoutez votre projet 4 pistes. Une piste vocale, solo ou mélodique pourrait-
elle bénéficier d’un effet de retard (écho ou «delay«) ou de reverb? Cliquez
sur le potentiomètre Delay, puis augmentez ou diminuez le niveau de l’effet
delay/reverb en faisant glisser la souris vers la droite ou vers la gauche. Le
bouton «On» adjacent vire au bleu clair pour indiquer que le delay/reverb est
actif. Utilisez cette procédure pour toutes les pistes à traiter.

10. Pour rapidement désactiver l’effet delay, cliquez sur le potentiomètre Delay/
Reverb. Il se grisera à nouveau.

11. Cliquez à présent sur l’un des boutons Delay/Reverb avec le bouton droit de
la souris. Cela ouvrira la fenêtre de dialogue Delay/Reverb.

12. Vous pouvez maintenant faire vos réglages de delay ou de reverb. D’abord,
sélectionnez le type d’effet en choisissant le mode approprié. Une fois le
mode sélectionné, vous pouvez faire les réglages avec les curseurs qui
s’appliquent à l’effet choisi.



34

Prise en main – Débutant

Mixage en un fichier stéréo
Il est possible de réduire en un fichier stéréo les projets multipistes virtuels
(VIP) avec les effets en temps réel. Il existe plusieurs façons de créer un fichier
de ce type, mais nous n’allons ici n’en traiter que deux : la création d’un fichier
stéréo lors du mixage ou le prémixage de pistes.

Mixage dans un fichier (Mix in File)
1. Une fois que vous avez fait tous les réglages de mixage désirés, vous êtes prêt

à effectuer un mixage en stéréo. Dans la table de mixage, activez Mix in File
(sortie dans un fichier).

2. Sélectionnez l’emplacement où sera créé le fichier de mixage en cliquant sur
le bouton icône Mix in File, puis naviguez jusqu’à l’endroit désiré et donnez
un nom au futur fichier de mixage.

3. Cliquez sur le bouton Lecture / Arrêt (Play/Stop) de la fenêtre de transport,
ou pressez la barre d’espace, et toutes les pistes du projet seront mixées en
temps réel dans le fichier.

4. Refermez ensuite la table de mixage via la touche M, puis appuyez sur Entrée
pour afficher tous les fichiers ouverts – le nouveau fichier stéréo créé doit
être visible. Agrandissez ce fichier dans la fenêtre – vous pouvez à présent
lancer la lecture du fichier de mixage.

5. Vous pouvez placer le fichier de mixage dans son propre projet VIP afin de
pouvoir l’éditer de manière non destructive ou faire le mastering. Procédure:

– Refermez toutes les fenêtres en appuyant sur la touche H
– Ouvrez un nouveau VIP (voir étapes 1- 4), mais optez pour un projet à une

seule piste.
– Cliquez sur le bouton Open Audio File (Ouvrir fichier audio) de la barre d’outils,

puis recherchez le fichier de mixage .wav que vous venez de créer.
– Ouvrez ce fichier .wav – il est automatiquement placé dans le VIP.

Prémixage de pistes
La commande Prémixage de Pistes est souvent préférable à la création d’un
fichier stéréo final lors du mixage, car elle propose davantage d’options quant à
l’utilisation immédiate du fichier de mixage stéréo.
Le prémixage permet, comme son nom l’indique, de réduire des pistes
sélectionnées en un signal stéréo. Cette procédure permet de libérer des pistes
ou d’effectuer le mixage final d’un projet.
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1. Cliquez sur le bouton Mixdown de la table de mixage ou lancez la commande

Track Bouncing du menu Tools (Outils).
2. Plusieurs options sont proposées. Dans notre exemple, sélectionnez:
– From VIP Start to last Object End (Du début du VIP jusqu’à la fin du dernier

Objet)
– New VIP (Nouveau VIP)
– Format 32 Bit (Float), puis cliquez sur OK.
3. Attribuez un nom et un emplacement au fichier de prémixage à créer, puis

cliquez sur OK.
4. Le prémixage est alors effectué en mode «offline» (en différé).
5. Un nouveau VIP contenant le fichier de prémixage s’ouvre ensuite

automatiquement.

Vous pouvez dès lors éditer ou masteriser le fichier de mixage stéréo créé.

Edition
1. Ouvrez le VIP du fichier de mixage stéréo créé à la page précédente.
2. Agrandissez la section de la forme d’onde en cliquant sur le bouton de zoom

avant vertical situé en bas à droite de la fenêtre.

Zoom vertical

Zoom horizontal

3. Placez le curseur au début de la forme d’onde en appuyant sur la touche Orig
(Home) de votre clavier.

4. Faites un zoom avant horizontal (sur la représentation graphique) par le biais
du bouton de zoom avant horizontal situé à gauche du bouton de zoom avant
vertical.

5.  Placez le curseur au dessus de l’affichage de forme d’onde, et notez que le
curseur passe automatiquement en mode de sélection («Range»). Cliquez et
glissez pour définir une sélection entre le début de la forme d’onde et le
début du projet, comme représenté.

6. Supprimez cette sélection en appuyant sur Ctrl + Suppr. Cette édition porte
uniquement sur le projet VIP – le fichier Wave d’origine n’est pas affecté.
Nous nous sommes ainsi débarrassés du blanc situé au début.

7. Vous pouvez remarquer que la bordure du VIP vient se caler sur le début du
projet. Vous pouvez définir la position du VIP en cliquant dans la moitié
inférieure de la forme d’onde, puis en faisant glisser la souris.
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8.  Affichez la forme d’onde dans sa totalité en cliquant sur le bouton All rouge
de la barre d’outils ou sur le bouton de zoom arrière horizontal, puis activez
la courbe de volume en cliquant sur le bouton vol de la piste. La courbe de
volume apparaît sous la forme d’une ligne jaune placée en haut de la fenêtre
de la forme d’onde.

                    Bouton Volume

        Courbe de
                                                                                                           volume

9. Nous allons à présent créer un fondu de sortie (Fade Out) non destructif à la
fin de la forme d’onde. Insérez deux poignées sur la courbe de volume en
double-cliquant directement sur la courbe. Insérez la première poignée à
environ 1,05 et l’autre à la fin de la forme d’onde. De petits carrés jaunes
apparaissent au niveau des poignées. Les poignées peuvent être déplacées
par cliquer-glisser.

10. Abaissez à présent la poignée droite jusqu’à la position 0 dB située au bas
de la bordure de la forme d’onde (bordure de «l’Objet»). Vous pouvez
remarquer que la représentation de la forme d’onde se rétrécit afin de refléter
la baisse de volume.

Astuce: Les zones internes aux limites des cases entourant les formes d’ondes sont
baptisées Objets. L’édition orientée objet est une fonction majeure de Samplitude.
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Vous venez ainsi de réaliser votre premier fondu non destructif dans Samplitude.

Mastering
Samplitude intègre de puissants outils d’édition et de mastering, dont l’éditeur
de fondus (Crossfades), le compresseur multibande et les filtres FFT.
Tous ces outils méritent d’être présentés, et bien que nous aimerions tous les
détailler, nous allons ici nous concentrer uniquement sur le Compresseur
Multibande et préparer le mixage du projet en vue de le graver sur CD. Les
autres outils seront traités plus en détails dans la suite de ce manuel.
Maintenant que le fondu de sortie (Fade Out) a été réalisé, il faut s’assurer que
la plage dynamique disponible pour le projet a été exploitée de manière optimale.
Par essence, cela correspond à optimiser le volume général du projet sans aller
jusqu’à la distorsion qui dégraderait le signal. Le compresseur multibande est
très largement considéré comme étant un super outil, pour ne pas dire le plus
approprié, pour cette tâche.
1. Ouvrez la table de mixage au moyen de la touche M, activez le compresseur

multibande (Multiband Dynamics) en section Master FX au moyen de son
bouton. Faites un clic droit dessus pour ouvrir la fenêtre de dialogue du
compresseur multibande.

2. Dans la case preset, utilisez la flèche descendante du menu déroulant pour
sélectionner la configuration Warm Vocal With DeEsser (c’est juste un essai
!). Cliquez sur le bouton Play, puis écoutez la différence par rapport au mixage
d’origine.

3. Passez à présent à la configuration Max Loudness. Ce réglage permet d’obtenir
le volume maximal possible sans pour autant créer de distorsion, ce qui est
très utile avant la gravure du CD. Cliquez sur «OK».

Note : Il s’agit d’une approche très simplifiée du Mastering, qui est un véritable art
à «maîtriser». Nous nous pencherons d’ailleurs plus longuement sur le sujet dans la
suite du manuel.
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Gravure d’un CD audio
Il est très simple de graver des CD audio compatibles Red Book avec Samplitude.
Depuis n’importe quel projet multipiste (VIP), il suffit d’insérer des marques
de plages (à l’aide du bouton T de la barre d’outils), pour pouvoir lancer aussitôt
la gravure.
1. Refermez la Table de Mixage en appuyant sur la touche «M».
2. Dans le menu CD, sélectionnez l’option Set Track Indices On Object Edges

(Placer marqueurs de plages aux limites des objets). Un marqueur de plage
rouge s’affiche alors au début de chaque plage de CD à créer.

3. Sauvegardez votre projet ! (Ctrl + S)
4. Insérez un CD-R vierge dans le graveur de CD, puis cliquez sur l’icône «Make

CD» (Graver CD) de la barre d’outils supérieure. Une boîte de dialogue s’ouvre
alors et vous propose différentes options.

5. Dans la section Mode, sélectionnez «Burn on the fly» (gravure à la volée). La
gravure est alors effectuée par le biais des routines internes de gravure de CD
de Samplitude. Tous les effets (fondus, correcteurs, etc...) sont calculés en
temps réel au cours de la gravure.

6. Dans la fenêtre de dialogue CDR Recording Options (Options de gravure CDR),
sélectionnez la vitesse de gravure (2x, 4x etc., en fonction des possibilités de
votre graveur), puis désactivez l’option «Simulate Recording» (simulation de
gravure) afin d’enclencher le processus de gravure.

7. Lancez ensuite la gravure en cliquant sur OK.
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Chacune des pistes d’un projet VIP dispose des boutons suivants:

Solo, Mute, Record
Buttons

FX Routing

MIDI mode

Plugins

Track Properties

Peakmeter

V0lume / Pan Fader

Volume / Pan Buttons

Program Title Bar

Menu
Bar

Toolbars  Time Display

Track
Properties

Visual
Meter

Floating Transport Control ZoomSystem
Meter

Workspace bar



40

Fenêtre VIP – Description détaillée

Boutons de piste: Solo, Mute, Rec, Lock, Vol, Pan
Informations sur la piste (Track Info)
Cliquez sur le nom de la piste, et une fenêtre Track Info s’ouvrira. Veuillez vous
référer au chapitre «Menu Track» pour une description des options.

Bouton Solo
Le fait de cliquer sur ce bouton fait passer la piste en écoute solo (le bouton
prend alors une couleur dorée). Toutes les autres pistes sont coupées. Un clic
droit dessus affiche la liste de toutes les cartes son disponibles. (Vous pouvez
ainsi affecter la piste à un périphérique de lecture en quelques secondes.)

Bouton Mute
Cliquer sur le bouton Mute coupe le signal de la piste (le bouton prend alors
une couleur bleue). Un clic droit dessus affiche la liste de toutes les cartes son
disponibles. (Vous pouvez ainsi affecter la piste à un périphérique de lecture en
quelques secondes.)

Bouton Rec (armement en enregistrement)
Cliquer sur le bouton Rec arme la piste en enregistrement (le bouton Rec prend
alors une couleur rouge). Un clic droit dessus affiche la liste de toutes les cartes
son disponibles. (Vous pouvez ainsi affecter la piste à un périphérique de lecture
en quelques secondes.)

Bouton -/+
Utilisez-le pour développer/réduire l’affichage de la piste sur sa hauteur.

Bouton Lock (verrouillage)
Par défaut, le fait de cliquer sur ce bouton empêche les objets de la piste d’être
déplacés sur l’axe horizontal (le bouton prend alors la couleur rouge et une
icône de cadenas fermé). Le menu Object (objet) > Lock Objects (Verrouiller Objets)
> Lock Definitions (Définitions de verrouillage) vous permet de définir les fonctions
qui seront verrouillées.

Bouton de monitoring manuel (symbole de haut-parleur)
Avec ce bouton, vous pouvez commuter manuellement le monitoring (écoute
de contrôle) d’entrée. Cela ne fonctionne qu’avec les pilotes ASIO. Pour les
pistes enregistrant des données MIDI, cela commute aussi le renvoi des données
ou «MIDI Thru».

Bouton FX
Ce bouton ouvre la fenêtre de routage d’effet «FX routing» pour la piste. Dans
celle-ci, vous pouvez établir l’ordre des effets (internes et plug-ins) et la position
pré/post des départs AUX. Veuillez vous référer au chapitre «Emploi des effets
dans Samplitude» pour plus de détails.
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Bouton MIDI
Ce bouton fait passer la piste en mode d’enregistrement MIDI. De plus, il fait
apparaître certains paramètres MIDI de piste comme les changements de
programme et de banque. Pour plus d’informations, référez-vous au chapitre
«Paramètres de la fenêtre Track Info».

Bouton Vol (courbes de volume)
Cliquer sur ce bouton active la courbe de volume de la piste. Le bouton Vol
prend alors une couleur dorée et une ligne représentant le volume s’affiche sur
la piste.

Création d’une courbe de volume:
1. Activez la courbe de volume de la piste en cliquant sur son bouton Vol, puis

double-cliquez à n’importe quel endroit de la ligne (située en haut de la piste).
Vous venez de créer une «poignée».

2. Les poignées représentent des points d’évolution de la courbe de volume. Il
suffit de créer des poignées, puis de les faire glisser à l’écran pour créer
virtuellement n’importe quelle forme de courbe de volume.

Note: Si vous souhaitez désactiver temporairement la courbe de volume, cliquez
simplement sur le bouton Vol de la piste. La ligne représentant le volume de la piste
disparaît de l’écran et l’automation de volume générée par la courbe est ignorée. Il
vous suffit de cliquer de nouveau sur le bouton Vol pour réactiver la courbe de
volume de la piste.

Bouton Pan
Cliquer sur le bouton Pan active la courbe de panoramique de la piste. Le bouton
Pan prend alors la couleur bleu et une ligne bleue représentant la position de
panoramique s’affiche sur la piste.

Création d’une courbe de panoramique:
1. Activez la courbe de panoramique de la piste en cliquant sur son bouton Pan,

puis double-cliquez à n’importe quel endroit de la ligne bleue (située au milieu
de la piste). Vous venez de créer une «poignée».

2. Les poignées représentent des points d’évolution de la courbe de panoramique.
Il suffit de créer des poignées, puis de les faire glisser à l’écran pour créer
virtuellement n’importe quelle forme de courbe de panoramique.

Note: Si vous souhaitez désactiver temporairement la courbe de panoramique,
cliquez simplement sur le bouton Pan de la piste. La ligne bleue représentant le
panoramique de la piste disparaît de l’écran et l’automation de panoramique
générée par la courbe est ignorée. Il vous suffit de cliquer de nouveau sur le bouton
Pan pour réactiver la courbe de panoramique de la piste.

Panoramique Surround: Cliquer avec le bouton droit de la souris sur le bouton
Pan vous donne accès au module de panoramique Surround. Vous pouvez
trouver de plus amples renseignements sur ce mode au chapitre Fonctions
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Surround de Samplitude («Samplitude Surround Sound») de l’aide en ligne
(Samplitude Professional seulement).

Crête-mètres, Faders, Menu de sélection des périphériques,
Plug-ins
Chaque piste est pourvue de deux crête-mètres à diodes (LED) situés juste en
dessous des boutons Solo, Mute et Rec.

Crête-mètres à LED
Les crête-mètres indiquent le niveau de la piste en cours de lecture. Une fonction
de «maintien de crête» permet de laisser affichée à l’écran la crête la plus forte
survenue lors de la lecture. Sur les pistes stéréo, le crête-mètre du haut représente
le canal gauche alors que celui du bas représente le canal droit. Sur les pistes
mono, les deux crête-mètres sont couplés. Ce n’est valable que pour le monitoring
d’entrée. Pour la lecture, les crête-mètres sont toujours placés après le
panoramique, reflétant les niveaux gauche et droit.
En dessous de ces crête-mètres, chaque piste propose un fader de volume et un
curseur de panoramique.

Fader de volume
Ce fader permet d’augmenter ou de diminuer très facilement le volume de la
piste. Si la courbe de volume de la piste est activée ou si les mouvements du
Fader de volume avaient été préalablement enregistrés depuis la table de mixage,
ce fader va permettre de «moduler» le volume général de la piste. En d’autres
termes, si vous avez créé une courbe d’automation du volume mais estimez
après coup que le volume est trop fort, il suffit d’abaisser le niveau général de la
piste au moyen de son fader de volume.

Curseur de panoramique
Ce curseur permet de déplacer très facilement le signal de la piste dans l’espace
stéréo. Si la courbe de panoramique de la piste est activée ou si les mouvements
du curseur de panoramique avaient été préalablement enregistrés depuis la table
de mixage, ce curseur va permettre de «moduler» le panoramique général de la
piste. En d’autres termes, si vous avez créé une courbe d’automation du
panoramique mais estimez après coup que la piste doit être déplacée plus à
gauche, pas besoin de refaire toute votre courbe de panoramique. Il suffit de
déplacer la piste sur la gauche au moyen de son curseur de panoramique. Un
clic droit sur le curseur de panoramique ouvre les réglages de panoramique
pour les pistes stéréo, ou, dans les projets Surround, le module Surround. Pour
plus de détails, référez-vous aux chapitres «Table de mixage» et «Surround».

Note: Il suffit de double-cliquer sur le fader de volume ou le curseur de panoramique
pour le ramener instantanément en position centrale par défaut.

Menus de sélection des périphériques de lecture/enregistrement (In/
Out)
Ces menus déroulants répertorient les périphériques d’entrée (In/
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enregistrement) et de sortie (Out/lecture) pouvant être affectés à chaque piste.
Cliquer sur leur petit triangle les déroule pour sélectionner et modifier les
périphériques affectés à chaque piste.

Astuce importante: Les réglages de zoom de la piste ont un effet sur le mode
d’affichage des différents boutons. Tous les boutons ne sont donc pas toujours
présents à tous les niveaux de zoom. Si certains boutons «disparaissent», réglez
simplement le niveau de zoom.

Bouton Plug-ins (PL)
Le bouton Plug-ins vous donne accès à la boîte de dialogue DirectX/VST Plug-
ins, où vous pouvez sélectionner les Plug-ins à appliquer sur la piste.

Veuillez vous reporter au chapitre «Utilisation des effets dans Samplitude» pour
de plus amples détails.

Slots de Plug-in
Fournit un accès rapide à tous les effets de piste, dont les effets plug-ins et
natifs, comme Amp Simulation ou Vocoder. Cliquez sur la flèche pour choisir
parmi les plug-ins DirectX, les plug-ins VST et les effets internes. Quand un
effet est chargé dans un slot, vous pouvez le court-circuiter en cliquant sur le
slot. Désactivez un effet du slot en choisissant l’option «no effect» du menu
(première ligne). Vous pouvez aussi charger ici des instruments logiciels ou des
entrées Rewire.

Boutons Zoom et Setup
Boutons de zoom VIP
La fenêtre VIP contient dans son coin inférieur droit des boutons de zoom avant
et arrière, horizontal et vertical. Vous pouvez également remarquer les barres
de défilement verticale et horizontale de couleur gris clair.

Zoom vertical avant et arrière: Placés verticalement en bas à droite de la
fenêtre VIP, ces boutons permettent d’effectuer un zoom avant ou arrière sur la
fenêtre VIP dans le plan vertical. Cliquer sur le bouton «+» effectue un zoom
avant alors qu’un clic sur le bouton «–» entraîne un zoom arrière.
Les boutons à flèche verticale ou horizontale situés à droite de la loupe vous
donnent accès à différents réglages de zoom présélectionnés.

Veuillez vous référer au chapitre «Travail en fenêtre VIP » pour plus de détails.
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Barre de défilement vertical: Située sur la droite de la fenêtre VIP et de
couleur gris clair, cette barre de défilement permet de vous déplacer dans la
direction verticale après un zoom avant.

Note: Vous pouvez cliquer et tirer sur l’une des extrémités de la barre de défilement
vertical pour rapidement zoomer en avant et en arrière (le curseur se changera en
une flèche à deux têtes). Un double-clic sur l’extrémité de la barre de défilement
ramènera le niveau de zoom à sa valeur par défaut.

Zoom horizontal avant et arrière: Placés horizontalement en bas à droite
de la fenêtre VIP (juste à gauche des boutons de zoom vertical), ces boutons
permettent d’effectuer un zoom avant ou arrière sur la fenêtre VIP dans le plan
horizontal. Cliquer sur le bouton «+» effectue un zoom avant alors qu’un clic
sur le bouton «–» entraîne un zoom arrière.
Les boutons à flèche verticale ou horizontale situés à droite de la loupe vous
donnent accès à différents réglages de zoom présélectionnés.

Veuillez vous référer au chapitre «Travail en fenêtre VIP » pour plus de détails.

Barre de défilement horizontal: Située sur la droite de la fenêtre VIP et de
couleur gris clair, cette barre de défilement permet de vous déplacer dans la
direction horizontale après un zoom avant.

Note: Vous pouvez cliquer et tirer sur l’une des extrémités de la barre de défilement
horizontal pour rapidement zoomer en avant et en arrière (le curseur se changera en
une flèche à deux têtes). Un double-clic sur l’extrémité de la barre de défilement
affichera la totalité du contenu de la fenêtre VIP. Les boutons de zoom sous la barre
de défilement vous permettent de changer les niveaux de zoom.

Boutons de menu Zoom
Dans le coin inférieur droit se trouvent deux boutons donnant accès à des menus
qui permettent de rapidement régler une valeur de zoom ou de se déplacer dans
la section affichée du VIP. (Les mêmes commandes se retrouvent dans les menus
View-Horizontal et View-Vertical.)

Champs temporels
Les champs situés sur le bord inférieur de la fenêtre VIP affichent la position
réelle du curseur, la longueur de la plage sélectionnée et sa fin, exprimées dans
l’unité temporelle actuelle.

Par un clic droit sur ces champs, vous pouvez changer l’unité, le type de valeur
affiché et le nombre de champs (jusqu’à cinq).
Vous pouvez éditer manuellement les valeurs numériques en double-cliquant
sur le champ correspondant. Vous pouvez aussi employer des valeurs relatives
dans ces champs, en saisissant, par exemple, «+2:00» dans les champs
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temporels, ce qui augmente la valeur du champ temporel de 2 (secondes, temps,
etc. – selon l’unité de mesure employée).
Vous pouvez aussi accéder à cette fonction par les raccourcis-clavier alt+ pavé
numérique 1..5 ou par les éléments correspondants du menu «Range > Edit
Time Display > Field 1..5».

Position à l’écran et niveau de zoom des fenêtres
Le coin inférieur gauche de la fenêtre VIP regroupe quatre boutons Setup et
quatre boutons Zoom. Ce sont les boutons de configuration de l’écran.

Setup: Les quatre boutons Setup (configuration de l’écran) peuvent chacun se
voir affecter une position à l’écran et un niveau de zoom précis. En affectant
différents réglages à différents boutons Setup, vous pouvez ainsi alterner en
quelques secondes entre différentes vues. Pour affecter des réglages d’écran à
un bouton Setup, cliquez sur le bouton Setup en tenant enfoncée la touche
«Shift». Pour les supprimer, faites un clic droit sur le bouton désiré.

Zoom: Les quatre boutons Zoom (configuration de l’écran) peuvent chacun se
voir affecter un niveau de zoom. En affectant différents réglages à différents
boutons Zoom, vous pouvez ainsi alterner en quelques secondes entre différents
niveaux de zoom. Pour affecter le niveau de zoom en vigueur à l’écran à un
bouton Zoom, cliquez sur le bouton Zoom en tenant enfoncée la touche «Shift».
Pour les supprimer, faites un clic droit sur le bouton désiré.

Barre d’outils de zoom
Différents boutons et présélections de zoom sont disponibles via la barre d’outils
Zoom, que l’on peut afficher grâce au gestionnaire de barres d’outils (Options >
Program Preferences > Edit Toolbars).

Barre d’espace de travail (Workspace) et barre des boutons
Situés en bas à gauche de l’écran, les boutons de ces barres vous permettent
d’accéder en toute simplicité aux fonctions suivantes:

Espace de travail (Workspace): Les espaces de travail sont conçus pour vous
aider à organiser les très nombreux éléments des menus et boutons des barres
d’outils afin de mieux visualiser les fonctions proposées par Samplitude.
Les menus, barres d’outils et entrées des barres d’outils comprennent des
éléments que vous n’utilisez jamais ou uniquement à un stade spécifique de
votre travail. Veuillez vous reporter au chapitre «Terminologie de Samplitude»
pour plus d’informations.

Object Editor/Visualization/Transport/Mixer/Manager: Ces boutons
lanceront l’éditeur d’objet pour l’objet sélectionné, la fenêtre des commandes
de transport ou du mixer, etc.
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Verrouillage des marqueurs

La fenêtre VIP dispose dans son coin supérieur droit d’un bouton de verrouillage
en forme de cadenas. Cliquer sur ce bouton empêche tout déplacement accidentel
des marqueurs (affichés tout en haut de la fenêtre VIP). En temps normal, il
suffit de cliquer sur un marqueur pour pouvoir le faire glisser à n’importe quel
endroit. Par contre, si ce bouton est enclenché, TOUS les marqueurs restent
verrouillés sur leur position actuelle.

Pour plus d’informations sur l’empli des marqueurs, référez-vous au chapitre
«Menu Range».

Témoins d’utilisation processeur/disque
Placés au bas à gauche de la fenêtre VIP, ces deux compteurs vous indiquent en
temps réel la consommation des ressources système et disque par Samplitude.

Il est très utile de connaître la «marge de manœuvre» disponible pour pouvoir
ajouter des pistes ou des effets en temps réel supplémentaires. Plus le nombre
de pistes et/ou le nombre d’effets en temps réel augmente, plus le système est
sollicité et plus la quantité de puissance de traitement nécessaire augmente.
Ces témoins vous indiquent la charge supplémentaire pour le système en cas
d’ajout de pistes/effets.
Si une surcharge se produit, vous pouvez remédier au problème soit en
augmentant le réglage de mémoire tampon («buffer») de Samplitude, soit en
réduisant le nombre de pistes et de traitements en temps réel. Vous pouvez
aussi temporairement libérer de la puissance de traitement en convertissant
des effets en temps réel en fichiers audio avec la fonction de «gel» d’objet ou de
piste (Object ou Track Freeze).
Le témoin CPU indique la consommation des ressources processeur alors que
le témoin Disk affiche la consommation des ressources du disque dur. Servez-
vous de ces deux indications pour paramétrer les réglages de Buffer et de
TrackSpeed de Samplitude de manière optimale.

Panneau de transport
Le panneau de Transport de Samplitude est une fenêtre flottante accessible via
le bouton Transport de la barre des boutons. Les commandes de lecture
principales sont très similaires à celles d’un magnétophone traditionnel.
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Retour au Début           Arrêt             Avance rapide
                  Retour rapide      Lecture/Pause      Enregistrement

Retour au Début: Ce bouton ramène la tête de lecture au début du projet.

Retour rapide: Lorsque Samplitude est à l’arrêt, ce bouton permet de faire
revenir la tête de lecture vers le début du projet (vers la gauche). Lorsque
Samplitude est en lecture, ce bouton fait défiler vers l’arrière et la lecture reprend
à l’endroit où la tête de lecture a été ramenée dès que le bouton est relâché.

Arrêt: Arrête la lecture et ramène la tête de lecture à l’endroit d’où la lecture a
été lancée.

Lecture/Pause: Ce bouton lance la lecture depuis l’endroit où se trouve la tête
de lecture. Si vous appuyez dessus en cours de lecture, la lecture s’interrompt
(pause) et la tête de lecture reste à sa place.
Le petit bouton placé dans le coin supérieur droit du bouton de lecture (ou un
clic droit sur le bouton de lecture) ouvre la fenêtre Paramètres de Lecture
(Playback Parameter) pour le fonctionnement master stéréo. Cela vous permet
de fixer la fréquence d’échantillonnage (Sample Rate), la carte de sortie (Device),
et les options de Scrubbing/Varipitch.

Avance rapide: Lorsque Samplitude est à l’arrêt, ce bouton permet de faire
avancer la tête de lecture vers la fin du projet (vers la droite). Lorsque Samplitude
est en lecture, la lecture reprend à l’endroit où la tête de lecture a été avancée dès
que le bouton est relâché.

Enregistrement: Ce bouton lance l’enregistrement à l’endroit où se trouve la
tête de lecture. Une ou plusieurs pistes doivent être armées avant de pouvoir
effectuer un enregistrement.
Dans le cas d’un enregistrement par Punch-In, l’enregistrement ne démarre
qu’à partir du point de Punch In défini, puis cesse une fois le point de Punch
Out sélectionné franchi.
La fenêtre Enregistrement (Record) s’ouvre dès que l’enregistrement commence.
Le petit bouton situé dans le coin supérieur droit du bouton Enregistrement (ou
un clic droit sur le bouton Enregistrement) ouvre la fenêtre Paramètres
d’enregistrement (Record Parameter). Cela vous permet de faire des réglages
comme la lecture pendant l’enregistrement (Playback while Recording) et vous
permet aussi d’enregistrer directement depuis cette fenêtre.

Compteur temporel: Ce compteur affiche la position en cours de la tête de
lecture. Double-cliquer dessus vous permet de saisir numériquement une
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nouvelle position. Cliquer sur le bouton de sélection d’unité vous permet de
choisir parmi diverses unités de mesure.

L, 1, 2: Ces boutons activent les sélections («Ranges») sauvegardées. Le bouton
L restaure la dernière sélection effectuée (au cas où vous auriez accidentellement
changé de sélection).

Affichage temporel L/E: Donne la longueur (L) et la fin (E) de la plage (Range)
sélectionnée et peut être édité en double-cliquant dessus.

Bouton Marker: Ce bouton ouvre le gestionnaire de marqueurs pour une
édition plus détaillée des marqueurs.

Boutons de marqueurs 1-12: Cliquer sur un de ces boutons l’associe à la position
de lecture actuelle. S’il était déjà associé à une position préalablement
sauvegardée (il apparaît alors en couleur), le programme déplace la tête de lecture
sur la position sauvegardée. Un clic droit permet d’effacer la mémoire du bouton
(Delete Marker) et vous permet d’y inscrire une nouvelle position.

Bouton In: Détermine la position de punch-in.

Bouton Out: Détermine la position de punch-out. Si les marqueurs de punch-
in et de punch-out sont définis, l’enregistrement par insertion («Punch») peut
être lancé avec le bouton Lecture. Le programme lira le projet jusqu’au point de
punch in, point auquel il passera en mode d’enregistrement. Ce mode continuera
jusqu’à arrivée au point de punch-out, point auquel le programme revient en
mode de lecture et poursuit la lecture jusqu’à ce qu’il soit arrêté.
Faites un clic droit sur les boutons In/Out pour accéder à un menu grâce auquel
vous pouvez supprimer les marqueurs Punch ou en définir de nouveaux.

Menu de mode d’enregistrement audio: Dans le menu audio, vous pouvez
choisir de reproduire ou pas les autres pistes pendant que vous enregistrez ou
d’activer le mode punch-in.

REC M: Ce bouton permet de commuter on/off l’écoute (monitoring) du

dispositif d’enregistrement: Un clic droit sur le bouton vous permet de choisir
le type de Monitoring (voir le chapitre «Monitoring» dans la partie du manuel
consacrée au Menu Options ->System/Audio).

Bouton Sync: Si aucune synchronisation n’est configurée, ce bouton ouvre la
fenêtre de synchronisation. Vous pouvez y configurer Samplitude pour
fonctionner en synchronisation avec un autre logiciel ou équipement externe
via l’horloge MIDI, le MTC ou le MMC. Après configuration, ce bouton vous
permet d’activer/désactiver la synchronisation. Référez-vous au chapitre MIDI
pour plus d’informations concernant la synchronisation.

Bouton Punch: Ce bouton active le mode Punch-In, qui permet de lancer
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l’enregistrement depuis une position définie, en cours de lecture. Cette procédure
est généralement utilisée pour enregistrer plusieurs prises ou faire des
«overdubs».

Bouton Loop: Ce bouton active le mode Loop (bouclage), dans lequel la lecture
se poursuit en boucle sur une zone préalablement définie).

Vous pouvez masquer la zone de boutons de droite en cliquant sur la petite flèche
située près du bouton (X) de fermeture de la fenêtre Transport.

Mode d’enregistrement MIDI: Dans le menu déroulant MIDI, vous pouvez
choisir le mode d’enregistrement MIDI (Normal, Overdub, Multi-Overdub ou
Replace). (Voir le chapitre «MIDI»)

Indicateur Sync/MIDI In/Out: En cas d’activité sur les ports MIDI
correspondants, les témoins In et Out clignotent.

BPM: Ce champ affiche le tempo du projet. Durant la lecture, il affiche le tempo
actuel tel que défini par les marqueurs de tempo. Pour sélectionner le tempo du
projet depuis la liste, cliquez sur le petit triangle. Vous pouvez aussi le saisir
manuellement en double-cliquant sur le champ. Après changement du tempo
du projet de cette façon, Samplitude propose d’adapter tous les objets audio au
nouveau tempo par étirement/compression temporelle (time-stretch).

Bouton Click: active/désactive le métronome.

SNAP: Affiche la grille et active le magnétisme (Snap) en mode mesures/temps.
Voir les réglages de magnétisme et de grille (Snap and Grid setup).

Molette JOG & SHUTTLE / Boutons SCRUB: Ces boutons (et cette molette)
sont réservés au repérage audio (Scrubbing). Lors d’un repérage, l’audio est
relu à très faible vitesse afin de simplifier le réglage des points d’édition.
Si elles ne sont pas visibles à l’écran, il est possible d’afficher les commandes
Jog/Shuttle/Scrub en cliquant sur le bouton Jog situé en haut à droite du panneau
de transport.
Cliquez sur l’un des boutons Scrub fléchés en tenant le bouton de la souris
enfoncé. L’audio est alors relu à vitesse lente dans le sens des flèches.
Vous pouvez également réaliser un repérage en cliquant directement sur la
molette Jog/Shuttle. Le repérage s’effectue alors à une vitesse déterminée par la
position du pointeur de la souris sur la molette. Le fait de déplacer le pointeur
vers la moitié gauche lance la lecture en sens inverse à la vitesse sélectionnée.
Le fait de ramener le pointeur dans la moitié droite relance la lecture en sens
normal à la vitesse sélectionnée.
En résumé, la molette Jog/Shuttle vous permet de déterminer aisément et en
temps réel la vitesse et le sens de lecture du repérage audio.
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Barre d’état (Status Bar)
Ces deux afficheurs indiquant les réglages de mémoire tampon (Buffer) de
Samplitude ainsi que la résolution de lecture/enregistrement. Ces témoins
apparaissent dès le début de la lecture ou de l’enregistrement.
Le témoin PlayBuf indique le nombre de mémoires tampons utilisées, suivi du
nombre de mémoires tampons défini dans la fenêtre Système (raccourci : Y).
Les erreurs sont indiquées s’il s’en produit durant la lecture actuelle.

Indicateur de cache/piste (Track)
Situés sur la barre d’état, ces deux indicateurs sont visibles lorsque Samplitude
est à l’arrêt. L’indicateur Cache indique l’état du cache RAM TrackSpeed.
«PreLoaded» signifie que les mémoires tampons TrackSpeed ont été préchargées
en RAM pour préparation à la lecture.
L’indicateur Track vous indique sur quelle piste se trouve actuellement le curseur.
Cela aide à sélectionner la bonne piste dans les projets ayant un grand nombre
de pistes.

Visualisation
L’afficheur Visualisation est une fenêtre flottante permettant de mesurer les
signaux audio de différentes façons. Pour afficher la fenêtre, passez par le menu
Window > Visualization ou par le bouton Visualization dans la barre de boutons.

L’afficheur Visualisation peut être librement redimensionné. Vous pouvez
paramétrer l’afficheur Visualisation en cliquant dessus avec le bouton droit de
la souris, puis en sélectionnant le réglage désiré.
Samplitude propose une fenêtre spéciale permettant d’afficher les niveaux
sonores et le spectre des projets de différentes façons.

Setup
Le bouton «Setup» situé en haut à gauche de la fenêtre permet de configurer
totalement les réglages de l’afficheur Visualisation:

Mode: Vous pouvez choisir entre Oscilloscope, Crête-mètre, Spectroscope (qui
est en fait un analyseur de spectre), indicateur de corrélation, Oscilloscope L-R
(corrélation de phase, goniomètre), indicateur de direction et Spectrogramme
(affiche la structure spectrale dans le temps).
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Echelle d’affichage (Value/Range): Il est possible de définir la valeur
minimum et maximum de tous les modes d’affichage. En mode crête-mètre,
vous pouvez même choisir si les niveaux à afficher en numérique doivent être
de type crête ou RMS (efficaces), ainsi que la valeur maximum. Vous pouvez
définir la valeur de référence 0dB du crête-mètre. C’est la valeur pour laquelle le
crête-mètre doit afficher 0dB. Si vous saisissez ici par exemple une valeur de -
9dB, le crête-mètre affiche l’amplitude maximale 0db quand le niveau de sortie
réel équivaut à -9dB (comme demandé par certains standards de diffusion).

Vitesse (Speed): Vous avez le choix entre trois vitesses d’affichage des niveaux.
Vous avez même la possibilité de régler la valeur d’amortissement: réglez en
ms la valeur nécessaire à la visualisation pour s’actualiser quand la valeur d’entrée
a changé de 10 dB.

Maintien de crête (Peak hold): Vous pouvez activer ou désactiver le maintien
de crête, dont vous pouvez définir la durée et le temps de déclin.

Options spectrales (Spectral options): Ce sous-menu permet de paramétrer
l’analyseur de spectre, le Spectrogramme et le Spectrographe, le nombre de
bandes utilisées, la distribution linéaire ou logarithmique des bandes et mode
de calcul de la valeur des bandes depuis le signal. Vous pouvez également
configurer les options stéréo, afficher le signal gauche/droit uniquement ou la
somme ou la différence des deux canaux.

Couleurs (Colors): Il est possible de définir les couleurs d’affichage des lignes,
de la grille et du fond de l’Osci/Corrélateur ainsi que des barres du crête-mètre
et de l’analyseur de spectre. Ce dernier peut fonctionner en mode plein (3 couleurs
fixes pour les valeurs minimum-moyenne-maximum) ou dégradé (transitions
entre les couleurs).

Réinitialisation totale (Reset all): Cette option réinitialise toutes les fenêtres
de visualisation ouvertes.

Périphérique audio (Audio device): Quand plusieurs périphériques de sortie
sont définis, vous pouvez choisir ici celui de destination pour l’audio.

Ouvrir Nouvel Afficheur (Open new Visualization): Ouvre une nouvelle
fenêtre Visualisation que vous pouvez régler sur un autre mode d’affichage pour
un contrôle optimal du signal. Il est possible d’ouvrir jusqu’à quatre afficheurs
Visualisation, dont trois pour le signal en lecture et un pour le signal d’entrée
(ouvert par la fenêtre des paramètres d’enregistrement).

Charger/Sauver Configuration (Load/Save preset): Permet de charger une
configuration de réglages présélectionnée ou de sauvegarder vos propres réglages.
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Compteur temporel (Time Display)
Vous pouvez accéder au Compteur depuis le menu Window > Time Display.

Cette fenêtre affiche la position actuelle de la tête de lecture dans le projet au
format sélectionné. Vous pouvez changer ce format en cliquant sur le compteur
avec le bouton droit de la souris, puis en sélectionnant le format souhaité. Nous
vous recommandons le format SMPTE – heures: minutes: secondes: images
(frames).
Il est possible de modifier les couleurs et la police d’affichage du compteur.
Pour ce faire, cliquez sur le compteur avec le bouton droit de la souris, puis
sélectionnez le paramètre à modifier. Il est même possible d’agrandir le compteur
et de le placer à n’importe quel endroit de l’écran.
Cliquez sur le compteur avec le bouton droit de la souris pour ouvrir un menu
vous permettant de choisir les préférences pour le compteur temporel.
Ce menu contient plusieurs raccourcis pour programmer des options vous
permettant de personnaliser la police (Font) ainsi que les couleurs de la police
(Font color) et du fond (background) du compteur. Vous pouvez aussi y choisir
l’unité de temps, qui est la même que celle définie dans le menu Affichage
(View).
Vous pouvez définir de une à cinq lignes avec «Number of Rows». Chaque
ligne peut afficher une des valeurs suivantes, que vous pouvez sélectionner dans
le menu Current Field d’un clic droit sur la ligne correspondante.

St. - Position / Range Start: Cette ligne affiche la position de la sélection
actuelle ou celle du curseur en temps réel.

Len - Range Length: Si une zone est sélectionnée, cette ligne affiche la longueur
de la sélection.

End - Range End: Si une zone est sélectionnée, cette ligne affiche la fin de la
sélection.

CD Positions: Affiche plusieurs positions par rapport au CD, dont CDS: position
from CD start (début de CD, premier marqueur de plage), CDE: position to CD
end (fin de CD, marqueur de fin de CD), CDT: position from current CD track
(par rapport à la plage actuelle) ou TrE: position to CD track end (par rapport à
la fin de plage).

Act: Mouse Position. Cette ligne affiche la position actuelle de la souris (non
éditable).
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Mix: Mixer Value. Cette ligne affiche la valeur de la commande de mixer
dernièrement sélectionnée (non éditable).

Rec: Record position. Cette ligne affiche la position d’enregistrement actuelle
(non éditable).

RSp: Remaining Record Time (free disc space). Cette ligne affiche l’espace restant
pour l’enregistrement.

De la même façon, vous pouvez configurer les champs temporels au bord
inférieur de la fenêtre VIP:

Vous pouvez éditer manuellement les valeurs d’un double clic sur le champ
correspondant. Vous pouvez aussi utiliser des valeurs relatives dans ces champs,
en saisissant, par exemple, «+2:00» dans les champs temporels, ce qui augmente
la valeur du champ temporel de 2 (secondes, temps, etc. – selon l’unité de mesure
employée).
Vous pouvez aussi accéder à cette fonction par les raccourcis-clavier alt+ pavé
numérique 1..5 ou par les éléments correspondants du menu «Range > Edit
Time Display > Field 1..5».

Vous devez posséder maintenant une bonne compréhension de certains des outils
offerts dans le VIP. Ces outils vous permettent de mener facilement à bien des
tâches fréquemment accomplies dans Samplitude. Avant d’examiner les fonctions
plus détaillées disponibles dans les menus déroulants (fonctions de fondu enchaîné
Cross Fade, par exemple), nous allons vous présenter les bases de l’édition audio
orientée objet.
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Introduction
L’édition orientée objet est une méthode de travail qui vous permet d’apporter
divers changements au matériel audio de façon virtuelle sans changer vraiment
le matériel audio (les données sur le disque dur).
Virtuel signifie que tous les changements (effets, volume, panoramique, instants
de début et de fin d’un fichier audio) sont calculés durant la lecture.

Exemple
Le début et la fin d’un fichier audio doivent être réajustés. Le fichier audio doit
être normalisé, compressé et traité par un correcteur («égaliseur»).
En mode destructif, le processus serait le suivant:
Le fichier audio doit être coupé. Maintenant, pour ne pas perdre le matériel
audio, la version coupée est sauvegardée dans un nouveau fichier audio. Ensuite,
ce fichier est normalisé, ce qui nécessite à nouveau un traitement. Ensuite, le
fichier audio est compressé et subit ensuite une correction tonale (EQ), qui doit
à son tour être calculée. Si vous n’avez fait aucune erreur durant ces étapes,
alors le fichier audio est terminé et vous pouvez continuer votre travail. Toutefois,
vous pouvez avoir involontairement supprimé une transitoire lors de l’édition,
ce qui vous oblige à refaire toutes les étapes.
Avec l’édition orientée objet de Samplitude, l’avantage est que vous pouvez
normaliser, compresser et changer les réglages de filtre dans l’éditeur d’objet
(Object Editor). Vous pouvez à tout moment changer ces réglages ou les
transférer à d’autres objets. La découpe du fichier audio s’effectue soit très
précisément avec l’éditeur d’objet soit dans le VIP (changement de longueur et
de position de départ de l’objet).
Les avantages sont évidents:
La vitesse de traitement augmente car il n’est pas nécessaire d’écrire sur disque

sauf, bien sûr, durant le report de pistes.
– Une fois l’édition terminée, un CD peut être immédiatement gravé avec les

paramètres réglés sans nécessiter de recalcul. Les calculs sont effectués durant
le processus de gravure.

– Les fichiers audio d’origine sont toujours disponibles, et peuvent être employés
dans d’autres projets ou dans d’autres versions d’un projet.

– Bien sûr, d’autres programmes offrent aussi des effets en temps réel, mais
seulement par piste ou comme effets «offline» (en différé) pour les clips audio.
Les objets de Samplitude apportent un mode de travail très souple: par
exemple, vous pouvez ajouter différents effets à des objets individuels d’une
piste, ayant différentes balances AUX.

L’éditeur d’objet (Object Editor) est le cœur de l’édition orientée objet. Il peut
être un outil pour un ou plusieurs objets.
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L’éditeur d’objet en mode MAX

L’éditeur d’objet, affiché ici en mode MAX (qui n’est pas activé par défaut) est
divisé en trois panneaux horizontaux: effets de l’objet (Object Effects), Position/
Fondus (Position/Fades) et transposition/extension-compression temporelle
(Pitchshifting/Timestretching). Il peut toujours rester ouvert, pour une mode
de travail très rapide: un clic de souris sur un objet et l’éditeur d’objet affiche
toutes les propriétés et possibilités d’édition pour cet objet. Nous vous
recommandons de garder l’éditeur d’objet ouvert en dehors de la fenêtre
principale sur un second moniteur.
Par exemple, vous pouvez affecter à un objet certains plug-ins et un réglage EQ
différents de ceux des autres objets de la même piste. Vous pouvez aussi faire
un fondu d’entrée d’un objet ou changer une hauteur si elle n’est pas correcte
(dans ce cas, le son fautif doit seulement être isolé comme un objet ou en
employant l’éditeur «Elastic Audio»).
Toutes les éditions peuvent être effectuées à la souris, mais vous pouvez aussi
employer le clavier (via des éléments de menu individuels). Autre avantage des
raccourcis: chaque utilisateur peut créer et sauvegarder ses propres raccourcis.
Cela apporte un plus haut degré de souplesse.
Les réponses aux questions suivantes sont données dans les prochaines pages:
Qu’est-ce qu’un objet et comment travailler avec des objets?
Qu’est-ce que l’éditeur d’objet et quelles possibilités offre-t-il?
Que m’apporte l’édition orientée objet?
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Qu’est-ce qu’un objet?
Un objet donne accès aux fichiers audio disponibles (Projets Wave), mais ne les
modifie pas, car les effets, fondus, etc. demandés par l’objet son calculés en
temps réel.
L’objet symbolise le fichier audio ou des parties de celui-ci. On peut aussi parler
d’un objet comme d’une référence à un fichier audio.
L’affichage de la forme d’onde et du fond d’objet dépendent des réglages des
options d’affichage du VIP et peuvent adopter différents styles. Vous pouvez
déplacer les effets (Move Objects), les copier (Copy Objects), et leur ajouter des
effets (menu Effects), et vous pouvez placer un objet à plusieurs endroits dans
un VIP, par exemple sur plusieurs pistes ou en séquence sur une piste. Cette
illustration vous donnera une meilleure idée:

Deux objets faisant appel au même projet Wave.

Les objets sont colorés en rouge et bleu (la couleur de la forme d’onde «alternance
rouge et bleu» a été choisie. Ce manuel étant en noir et blanc, le rouge correspond
au gris plus clair). Les lignes noires délimitent le début et la fin d’un objet: les
deux objets bleus accèdent à la première moitié du fichier .WAV, le rouge à la
seconde moitié.
Bien sûr, un objet plus long pourrait accéder à la totalité du fichier .WAV.
Si deux objets se chevauchent (en plaçant l’un par dessus l’autre), c’est toujours
l’objet visible qui est lu. Si «Auto Crossfade active» est coché, le fondu-enchaîné
(«crossfade») sera automatiquement généré pour la zone de chevauchement
avec les réglages de crossfade par défaut.
Gérer des données à l’aide d’objets a pour avantage que les fichiers audio de
chaque piste soient présents – une ou plusieurs fois, et que différent filtres,
plug-ins, etc. puissent être ajoutés.
Les objets sont aussi des contenants qui représentent les données audio pour
les employer dans le VIP. Peut importe que le projet Wave soit au format .WAV
ou AIFF format, de même pour sa résolution et sa fréquence d’échantillonnage.
Même les formats compressés comme le Mp3 sont acceptés. Un objet de VIP se
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traite toujours de la même manière. Les objets MIDI existent aussi. Les
caractéristiques spécifiques des objets MIDI sont évoquées dans un chapitre
dédié.
Ne confondez pas les objets avec les sélections («Ranges»)! Les objets se réfèrent
à la section du projet Wave que vous reproduisez. Les objets et les sélections
sont des choses différentes dans le VIP. Les sélections ou «Ranges» ne servent
qu’au couper-coller en fonction du temps, sur plusieurs pistes et à déterminer
la plage de lecture ou d’édition. C’est pourquoi il y a à la fois un menu Edit, qui
contient toutes les commandes nécessaires pour travailler sur les sélections et
un menu Object pour toutes les commandes basées sur les objets.

Les poignées d’un objet
Si un objet a été sélectionné (sélection et désélection d’un objet), cinq poignées
apparaissent dans l’objet. De plus, sa couleur de fond change (ici: fond blanc)
pour le différencier d’un objet non sélectionné.

Objet sélectionné avec grandes poignées d’objet.

Les poignées de longueur sont dans les coins inférieurs gauche et droit. Vous
pouvez les employer pour régler la longueur et la position de démarrage de
l’objet dans le projet Wave (l’éditeur d’objet peut aussi servir à changer la
longueur).
La longueur d’un objet dépend du fichier audio auquel il se réfère. Plus long est
le fichier audio, plus long peut être l’objet. Ce fichier audio de référence restreint
la longueur de l’objet qui ne peut pas être plus long que ce fichier audio.
Les poignées de fondu (en haut à gauche et en haut à droite) servent au fondu
d’entrée (fade in) ou de sortie (fade out) d’un objet, et plusieurs formes de courbes
différentes sont possibles. Vous pouvez employer l’éditeur d’objet pour régler
la courbe en détail.
La poignée de volume est en haut au centre. Vous pouvez l’employer pour régler
le volume. Le niveau de volume est affiché dans la fenêtre contextuelle.
Le nom de l’objet est visible à côté de la poignée de longueur de gauche. (ici:
«selected Object»), et le symbole de clé sur la droite est expliqué dans
«Verrouillage des objets».
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L’éditeur d’objet est un outil pour accomplir toutes les éditions d’un objet
sélectionné (ou de plusieurs objets simultanément sélectionnés – même si par
la suite nous parlerons toujours d’un objet). Il s’ouvre en double-cliquant sur
l’objet (ou en pressant Ctrl + O quand l’objet est sélectionné [Sélection et
désélection d’un objet]). Si le curseur de lecture est au dessus d’un objet alors
qu’aucun autre objet n’est sélectionné, c’est cet objet qui est sélectionné quand
on appuie sur Ctrl + O pour ouvrir l’éditeur d’objet. Seul l’objet du dessus est
sélectionné si vous essayez d’ouvrir plusieurs objets non sélectionnés.
Une fois l’éditeur d’objet ouvert, vous pouvez changer d’objet d’un simple clic
de souris. L’éditeur affiche alors les réglages du nouvel objet.
Si un réglage est changé, un astérisque apparaît dans la barre de titre de l’éditeur
d’objet entre le nom de la piste et celui du fichier audio. Cela vous permet de
savoir facilement si des changements ont été faits.

Fonctions de base
Les divers éléments sont évoqués dans le sens inverse des aiguilles d’une montre
en partant d’en haut à gauche.

Il y a trois possibilités de sélection pour les trois différentes fenêtre de l’éditeur
d’objet (référez-vous au chapitre intitulé «La fenêtre Object Effects, la fenêtre
Position/Fades, la fenêtre Pitchshifting/Timestretching»).
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Quand vous sélectionnez «Min», une petite vue de la fenêtre d’effets de l’objet
(«Object Effects») apparaît, avec moins de possibilités de sélection – «Max»
affichant les trois fenêtre empilées verticalement les unes au dessus des autres.
La barre inférieure est identique dans les trois fenêtres: vous pouvez vous en
servir pour lire le matériel audio.

Play/Stop: Ce bouton commande la fonction de lecture normale (barre d’espace).

Play Solo: Ce bouton amène directement le curseur de lecture au début de
l’objet et lance la lecture de l’objet sélectionné seulement; toutefois, les bus et
routages AUX dépendant de la piste sont aussi reproduits.

Témoin PL: Indique que l’objet sélectionné est actuellement reproduit.

Vous pouvez saisir le nom de l’objet dans la case situé à droite.

Saut à l’objet précédent/suivant: Ces boutons sont inactivés si plusieurs objets
sont sélectionnés.

Utilisez les derniers boutons de droite pour quitter l’éditeur d’objet en confirmant
les réglages faits («OK») ou en les annulant («Cancel»). Le dernier bouton
(«Help») appelle l’aide en ligne.

Vous pouvez aussi éditer plusieurs objets d’un coup (par ex. un groupe d’objets).
Les valeurs affichées dans l’éditeur d’objet correspondent alors toujours au
dernier objet sélectionné (ou à celui directement sélectionné dans le cas de
groupes d’objets). Quand vous fermez l’éditeur d’objet avec OK, toutes les valeurs
modifiées sont transférées à tous les objets sélectionnés. Si Alt + OK est pressé,
elles ne sont appliquées qu’à l’objet actuel.

Symboles pour copier les réglages (à l’extrême droite)

Le symbole gauche sert à copier les réglages de la fenêtre Object Effects (et
seulement de celle-ci!), et celui de droite à coller les réglages copiés.

FX/Routing: Ouvre le routage des effets (Effect routing) pour l’objet.

Freeze: La fonction «Gel» (Freeze) pour l’objet actuel s’ouvre en cliquant sur
l’objet actuel.

FX Bypass: Si cette case est cochée, tous les effets de cet objet sont
temporairement désactivés.
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Lock: L’objet est protégé d’un déplacement accidentel (il est verrouillé). D’autres
verrouillages (contre les fondus, les changements de longueur ou la suppression)
peuvent être faits dans le menu «Object».

Cliquez sur «To All» («pour tous») afin d’explicitement actualiser tous les objets
sélectionnés quand l’éditeur d’objet est ouvert. Tous les réglages effectués sur
un objet sélectionné (dans n’importe laquelle des trois fenêtres) sont alors
transférés aux autres objets sélectionnés.
Color: Permet de changer la couleur d’affichage de forme d’onde (Sample) et du
fond (Background.
Une nouvelle fenêtre s’ouvre pour choisir la couleur.

La fenêtre Object Effects

La fenêtre Object Effects de l’éditeur d’objet

Les cadres Gain et AUX Sends
Gain: Contrôleur de gain supplémentaire, habituellement au début de la chaîne
d’effets.

AUX Sends (départs auxiliaires): Chaque objet peut être envoyé à tous les
bus AUX disponibles. Deux contrôleurs de départ AUX peuvent être affichés
simultanément (les deux derniers qui ont été «manipulés»). Le bouton Edit ouvre
la fenêtre de dialogue de départ AUX avec accès complet à tous les contrôleurs
de départ AUX.

Les panneaux Plug-ins et EQ (égaliseur)
Les plug-ins d’effets fournissent une interface simple mais très efficace pour
l’édition d’effet.
Tous les plug-ins et effets par insertion installés peuvent être sélectionnés en
cliquant sur la flèche de chaque emplacement de plug-in.
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Vous pouvez activer ou désactiver les plug-ins à l’aide du bouton On. Le bouton
Edit ouvre l’éditeur de plug-in. Le bouton Edit le plus bas ouvre la fenêtre de
dialogue pour les réglages avancés et le changement de l’ordre des plug-ins.
Vous pouvez ici charger plus de plug-ins qu’il n’y a d’emplacements visibles.
Pour charger des effets internes supplémentaires, utilisez le dialogue FX/
Routing.
Pour supprimer un plug-in ou un effet interne, sélectionnez «No Effect« dans
le menu d’emplacement de plug-in.
Le niveau des 4 bandes de fréquences se règle dans le panneau EQ. Le bouton
«On» active/désactive l’égaliseur. Le bouton «Edit» ouvre le dialogue de
l’égaliseur paramétrique 4 bandes complet.

Les panneaux Pan/Mute/Invert et Volume
Les réglages de panoramique ainsi que d’ampleur stéréo peuvent être édités ici.
Utilisez L <-> R pour échanger les canaux gauche et droit. Le bouton «Edit»
ouvre une fenêtre avec les nouveaux paramètres suivants:

Stereo: Règle l’amplitude stéréo de base. Vous pouvez employer un «enhancer»
stéréo multi-bande pour un réglage de l’ampleur de base fait indépendamment
sur 3 bandes de fréquences.

Balance + Stereo Enhancer: La commande Pan règle la balance stéréo. Un
réglage central correspond à un niveau de 0dB pour les deux canaux. Si le
panoramique est tourné sur la gauche, le niveau du canal droit est réduit
proportionnellement et vice versa. La commande Stereo contrôle l’ampleur de
base de l’extrême gauche = 0% = mono à l’extrême droite = extrême expansion
(200%) en passant par une valeur normale (au centre = 100%).

-4.5 dB Panorama + Stereo Enhancer: Contrôle la position panoramique de
façon à ce que les niveaux des deux canaux soient réduits de -4,5 dB quand le
contrôleur est en position centrale. Aux positions extrêmes, un des canaux est
fermé tandis que l’autre est augmenté au dessus de la plage de commande de –
4.5dB à 0dB. Cela nivelle la chute de volume perçue en cas de réglage central.
Utilisez ce mode pour positionner des objets mono dans une représentation
stéréo.

2 Channel Panorama: Dans ce mode, les deux boutons deviennent des
commandes de panoramique pour les deux canaux, comme sur deux voies mono
d’une table de mixage.

2 Channel Volume: Dans ce mode, vous pouvez contrôler séparément les pistes
stéréo d’un objet.
La phase du signal de chaque canal peut être changée (L ou R). Vous pouvez
aussi couper n’importe quel canal.

Fader (panneau de volume): Le volume se règle avec le fader.
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Reset: Le bouton «Reset» ramène le fader à -0.00. «Norm» normalise l’objet à
0 dB.

Surround d’objet
Si un bus surround est disponible, une nouvelle section peut être arrangée dans
l’éditeur d’objet. Avec un fader de départ, elle permet au signal de sortie d’un
objet d’être dirigé vers ce bus surround et arrangé indépendamment du
panoramique de piste dans les réglages de panoramique surround.

Surround Send (départ surround): Règle le niveau de l’objet dirigé vers le
bus surround.

Edit (édition): Ouvre le module surround pour le panoramique surround de
l’objet.

Output (sortie): Ici, vous pouvez sélectionner le bus surround auquel l’objet
doit être envoyé. Un objet peut de la même façon être envoyé à une piste stéréo
normale. Toutefois, contrairement aux départs AUX, le départ surround d’un
objet peut servir avec les bus AUX surround comme avec les bus surround et le
master surround.

La fenêtre Position/Fade
Cette fenêtre vous permet de régler toutes les positions temporelles concernant
l’objet (start/début, length/durée, end/fin) et les paramètres de fondu («fade»)
pour l’objet sélectionné. L’unité de mesure peut être changée dans chaque champ
de saisie de temps par simple clic.

Fenêtre Position/Fade de l’éditeur d’objet

Le panneau Position/Length (position/durée)
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La position de démarrage (Start Object) de l’objet sur la ligne chronologique, la
durée de l’objet (Object Length), la fin de l’objet (Object End) et le début de
l’objet dans le fichier .WAV (Wave Start) peuvent être réglés ici soit en saisissant
une valeur, soit à l’aide des boutons flèches.
Vous pouvez employer les deux petites flèches situées sur le bord droit du
panneau pour augmenter ou diminuer les valeurs à la souris.
Les boutons flèches ont les propriétés suivantes:
Ceux du haut déplacent l’objet vers l’avant (vers le début du projet)/vers l’arrière
(vers la fin du projet).
Ceux entre «Object Start» et «Object Length» ne déplacent que le début de l’objet.
Ils fonctionnent donc comme la poignée inférieure de gauche de l’objet.
Ceux entre «Object Length» et «Object End» ne déplacent que la fin de l’objet.
Ils fonctionnent donc comme la poignée inférieure de droite de l’objet.
Ceux du bas laissent la position et la durée de l’objet intactes, et déplacent
essentiellement son contenu (venant du fichier .WAV) dans l’objet sur la gauche
ou la droite.
Le paramètre Nudge steps vous permet de choisir l’intervalle de temps
correspondant à un clic quand on change la position/durée avec les boutons
flèches. L’unité à droite de la valeur peut être changée d’un simple clic qui ouvre
un menu contextuel. De plus, le bas du menu contient aussi des presets pour
Nudge steps, en fonction de l’unité de mesure, par exemple «1/16» (double
croche) pour une unité de mesure «bar/beat» (mesure/temps).

Le panneau Fade-in (fondu d’entrée) et Fade out (fondu de sortie)

Ce dialogue vous permet d’éditer les fondus. Diverses étapes de copie et de
changement de nom sont aussi possibles pour le projet Wave.
Les réglages sont les mêmes pour fade in et fade out, c’est pourquoi nous ne
parlerons pour le moment que de fade in.
«Curve» vous permet de régler la forme de la courbe du fondu.
«Fade offset (%)» vous permet de déterminer la valeur de fondu que vous désirez
avoir en dehors des limites de l’objet. La valeur peut être réglée de 0% (fondu
dans les limites de l’objet) à 50% (fondu symétrique par rapport aux limites de
l’objet) jusqu’à 100% (fondu extérieur aux limites de l’objet). L’objet est étiré en
fonction du pourcentage de durée de fondu. Le «vrai» début de l’objet est affiché
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comme une ligne en pointillés.
Vous devez vous assurer que le matériel audio correspondant reste contenu
dans le projet .WAV dans le cas d’un réglage Fade offset supérieur à 0%, sinon
il peut être possible qu’un objet ne puisse pas subir de fondu avec un réglage
Fade offset modifié. Par exemple, si le début de l’objet coïncide précisément
avec le début d’un projet Wave, vous ne pouvez plus faire de fondu si Fade
offset est supérieur à 0%.
Cliquer sur le bouton Menu ouvre un menu dans lequel vous pouvez réinitialiser
(Reset) le temps de fondu établi et grossièrement régler la forme de courbe sur
Linear (linéaire), Exp. (Exponentielle), Log. (Logarithmique), Cos. (Cosinusoïdale)
et Sin. (Sinusoïdale). D’autres formes de courbe peuvent aussi être chargées
(Load…). Vous y trouverez aussi 3 possibilités de réglage Fade Offset: Fade inside
(correspond à 0%), Fade symmetrical (correspond à 50%) et Fade outside
(correspond à 100%).
Vous pouvez aussi demander (Get Global Crossfade) un fondu enchaîné global
(les fondus enchaînés sont obtenus à partir des valeurs standards pour les fondus
enchaînés automatiques) et le régler (Set Global Crossfade) (les valeurs de fondu
enchaîné actuelles sont prises comme valeurs standards pour les fondus
automatiques).
Vous pouvez employer le fader pour affiner la forme de courbe choisie auparavant
avec «Menu».
Les durées de fondu peuvent être changées dans les champs situés entre les
boutons «Menu». L’unité de mesure peut aussi être changée ici par clic droit.
La forme de courbe résultante pour le fondu d’entrée et le fondu de sortie est
représentée graphiquement en même temps que son décalage («fade offset»).

Audio File (fichier audio)
Ce champ vous permet d’échanger, de copier et de renommer le projet Wave
auquel se réfère l’objet, directement dans l’éditeur d’objet.
Ouvrez le dialogue de sélection de fichier en cliquant sur l’icône de dossier
située à droite du nom du fichier audio.
Si le fichier audio est employé par plusieurs objets dans le VIP, vous pouvez
préciser s’il doit être échangé dans l’objet actuel seulement ou dans tous les
objets qui l’utilisent.

La fenêtre Pitchshifting/Timestretching

La fenêtre Pitchshifting/Timestretching de l’éditeur d’objet
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Le panneau Pitch Shifting/Time Stretching
La transposition («Pitchshifting») et l’extension/compression temporelle ou
«changement de tempo» («timestretching») peuvent intervenir simultanément
ou l’une après l’autre, excepté en mode de rééchantillonnage («Resampling»).

Pitch Shift/Factor (transposition): Vous pouvez saisir une valeur de
transposition par demi-tons ou sous forme d’un facteur (pourcentage) par rapport
à la valeur initiale.

Stretch Length/Factor (changement de tempo): Vous pouvez saisir une
valeur de changement de tempo soit en déterminant la nouvelle longueur
(Length) de l’objet soit sous forme d’un facteur de la valeur initiale.
Vous pouvez aussi changer les valeurs à l’aide du bouton rotatif.
Le tempo peut aussi être changé dans «BPM» après avoir saisi le tempo d’origine
(«Original BPM»). Vous pouvez aussi aller chercher le tempo du VIP dans une
sélection ou boucle préalablement marquée en cliquant sur le bouton adjacent.
Le tempo est automatiquement lu dans l’onde si elle est «patchée» (voir menu
«Tools» -> Timestretch/Pitchshift Patcher).
Les modes qui peuvent être sélectionnés sont Resample, Standard, Smooth,
Beat Marker Slicing, Beat Marker Stretching, Monophonic Voice. Pour des détails
sur ces modes, lisez la section timestretching/pitchshifting dans le chapitre
«Effets».

Les changements par Pitch Shift et Time Stretch sont ramenés à 0 si on presse
le bouton «Reset».

Le bouton «Elastic Audio» ouvre l’éditeur Elastic Audio. Voir le chapitre Elastic
Audio.

Le panneau Object Loop (boucle d’objet)
Ce panneau s’active en cochant «Loop On» (s’il est décoché, tous les réglages de
bouclage antérieurs sont supprimés).

Vous avez alors accès aux paramètres Loop Start (début de boucle), Loop Length
(durée de boucle) et Loop End (fin de boucle), dans lesquels l’unité de mesure à
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droite de la valeur peut être changée par clic droit.
La boucle peut être corrigée à l’aide des boutons flèches qui changent la valeur
par paliers ayant la valeur réglée dans Nudge steps.
Les flèches du haut changent la position de début de la boucle sans changer sa
durée, c’est-à-dire que la fin de la boucle change parallèlement.
Les flèches du milieu changent la position de début et la durée de la boucle. La
fin de la boucle ne change pas.
Vous pouvez employer les boutons flèches du bas pour bouger la fin de la boucle,
ce qui change la durée de boucle.
Tous les réglages se reflètent immédiatement dans l’objet sélectionné par la
forme des lignes verticales (qui marquent le début et la fin de la boucle).
Si un objet est sélectionné, alors la totalité de cet objet est en boucle; toutefois,
si une sélection («range») a été préalablement marquée dans l’objet, c’est elle
qui est mise en boucle.
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Intégration de fichiers .WAV comme objets dans le VIP
Pour pouvoir travailler avec un objet, un fichier .WAV doit être disponible pour
être affiché comme un objet dans le VIP.
Créez un nouveau VIP.
Cliquez dans la moitié haute de la piste à l’endroit (horizontalement) où doit
être créé le nouvel objet. Le curseur de lecture est maintenant placé exactement
sur la position où sera ajouté l’objet et la piste est surlignée.
Un clic sur l’outil «Open Audio File» (ouvrir fichier audio) de la barre d’outils
du programme (ou menu File -> Load Audio File) ouvre une fenêtre grâce à
laquelle vous pouvez chercher un fichier audio (des fichiers .WAV se trouvent
dans le dossier «C:\MAGIX\Samplitude\Audio\Tutorial» si le programme a
été installé sur le disque C:\). Sélectionner un fichier et cliquer sur Ouvrir fait
s’afficher le fichier audio comme un objet dans le VIP.
Si plusieurs fichiers audio ont été sélectionnés (par maintien de la touche Ctrl
pendant que vous cliquez), ils apparaîtront l’un après l’autre.
Il est aussi possible de faire glisser et de déposer le fichier depuis une fenêtre de
l’Explorateur ou d’employer le nouveau gestionnaire de fichiers (bouton
«Manager»).

Différences lors du chargement de fichiers audio
Il existe quelques différences importantes dont il faut tenir compte lors du
chargement de fichiers audio:
Si aucun VIP n’est ouvert, le fichier audio est édité en mode Wave Edit (édition
destructive d’un objet). Les changements sont apportés au matériel audio (ou
une copie est créée si on clique sur «Create copy»).
Si un VIP est déjà ouvert, un objet se référant à ce fichier audio est
immédiatement créé dans le VIP. Toute édition est effectuée de façon virtuelle.
Il y a une différence supplémentaire entre charger et importer des fichiers audio.
Dans ce dernier cas, le fichier audio est converti en un fichier .Wav lors de
l’importation et copié dans le répertoire du projet. Cela n’est nécessaire que
pour les formats de fichier qui ne peuvent pas être directement ouverts par
Samplitude (Fichiers Windows Media (WMF) et certains fichiers MPEG).
Toutefois, vous pouvez accroître les performances de votre ordinateur si vous
importez des formats compressés du type .MP3 ou .OGG plutôt que de les
charger en vue d’éviter la décompression en temps réel.

Intégration de plages de CD comme objets dans un VIP
Bien sûr, vous pouvez aussi charger des plages audio de CD. Cliquez dans la
moitié haute de la piste sur la position horizontale où doit être créé le nouvel
objet. Le curseur de lecture est maintenant placé exactement sur la position où
sera ajouté l’objet (la plage de CD) et la piste est surlignée. Cliquez sur CD/
DVD -> Load Audio CD Track(s) … et une fenêtre de dialogue s’ouvre, vous
permettant aussi de choisir diverses options en dehors de l’écoute du CD.
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Sélection et désélection d’un objet
Chaque objet peut être sélectionné à la souris. Pour cela, cliquez dans la moitié
inférieure de l’objet.
La sélection s’identifie par le changement de couleur du fond de l’objet et les
cinq poignées (les poignées d’objet), qui apparaissent aux coins de l’objet.

Sélection d’un objet par clic de souris dans sa moitié inférieure.

La sélection peut être annulée en maintenant la touche Ctrl et en cliquant à
nouveau dans la moitié inférieure de l’objet ou en cliquant à côté de l’objet.

Sélection et désélection multiples, inversion de la sélection
La méthode la plus rapide pour sélectionner plusieurs objets est de cliquer dans
la moitié basse d’une piste et de maintenir le bouton de la souris. Faites ensuite
glisser la souris sur la droite pour ouvrir le lasso d’objet. Tous les objets pris
dans ce lasso seront sélectionnés quand vous relâcherez le bouton de la souris.
S’il n’y a pas d’espace libre sur la piste pour cliquer, utilisez l’option «menu
Object -> Select Objects -> Object lasso». Cela fait passer la souris dans un
mode spécial pour étendre le lasso d’objet depuis n’importe quel position dans
le VIP.
Vous pouvez maintenant sélectionner ou désélectionner individuellement les
objets en maintenant enfoncée la touche Ctrl et en cliquant sur l’objet concerné.
Maintenir enfoncée la touche Shift et cliquer avec la souris est une autre
possibilité de sélection multiple des objets. Tous les objets situés entre la première
sélection et la position actuelle de la souris sont sélectionnés. Si aucun objet
n’est préalablement sélectionné, le premier objet sur lequel on clique est
sélectionné. Vous pouvez désélectionner avec la touche Shift.
Cela n’est possible qu’en mode d’objet normal. En mode «Link» (couplé), vous
ne pouvez sélectionner qu’un objet à la fois.
Tous les objets sélectionnés peuvent être désélectionnés en cliquant dans la
moitié basse d’une piste. Dans ce cas, toutefois, vous devez faire attention à ne
pas cliquer sur un objet.
Une sélection peut être inversée de façon à ce que les objets sélectionnés soient
désélectionnés et vice versa: (menu «Objects» -> Select Objects -> Switch
Selection).

Déplacement des objets
Cliquez dans la moitié inférieure de l’objet et gardez le bouton de la souris
enfoncé: l’objet suit maintenant le mouvement de la souris et peut être déplacé
dans la piste ou sur d’autres pistes. Quand vous relâchez le bouton de la souris,
l’objet reste à sa position actuelle.
Si vous désirez déplacer simultanément plusieurs objets, vous devez d’abord
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les sélectionner (voir Sélection et désélection multiples, inversion de la sélection).
Il faut alors un clic de souris sur un des objets sélectionnés en maintenant le
bouton de la souris enfoncé – tous les objets sélectionnés bougent alors avec la
souris.
Si la touche Shift est pressée quand vous déplacez les objets, la position
temporelle est verrouillée et vous ne pouvez que changer de piste.
Pour déplacer les objets pas à pas, vous devez procéder comme suit:
Dans «menu Object -> Move/Edit Objects -> Object Move Step 1 ou 2", vous
trouverez un grand nombre de commandes destinées au clavier. Un système
intelligent de raccourcis-clavier assurera que toutes les commandes nécessaires
pour éditer deux effets fondus-enchaînés puissent être demandées au clavier.
Vous trouverez plus d’informations dans le chapitre de référence du menu.
Pour changer les pas de déplacement 1 et 2, allez dans Object -> Move/Edit
Objects -> Object/Fade step settings…
Vous pouvez aussi faire le déplacement dans l’éditeur d’objet: sélectionnez les
objets à déplacer et ouvrez l’éditeur d’objet. Cliquez sur la flèche gauche ou
droite du champ Position/Length de la fenêtre Position/Fades et les objets se
déplaceront par pas d’une valeur réglée par le paramètre Nudge steps.
Les boutons pour déplacer pas à pas un objet avec la souris se trouvent dans la
barre d’outils de sélection ou «Range» (cliquez sur la commande de menu:
Window -> Range bar) pour la faire apparaître. Des boutons permettent de
déplacer le début et la fin de l’objet, ou la totalité de l’objet.
Voir aussi «Couplage d’objets («Link»)»: vous y verrez comment plusieurs objets
peuvent être déplacés dans une piste ou dans la totalité d’un VIP.

Changement de la durée et de la position de début d’un objet
Les limites de l’objet peuvent être changées grâce aux poignées de longueur (les
poignées d’objet): si la souris est amenée sur la poignée de longueur au début
de l’objet, le curseur de la souris se change en double flèche. Maintenant cliquez
en maintenant le bouton de la souris enfoncé: la position de début de l’objet
change quand on déplace la souris. Cela change aussi la longueur de l’objet.
L’éditeur d’objet offre aussi des possibilités avancées pour y faire tous les
changements. Ces fonctions possèdent aussi des boutons leur correspondant
dans la barre d’outils «Range».

Duplication d’objets
Dupliquer un objet est très simple, puisqu’il suffit de le déplacer en maintenant
la touche Ctrl enfoncée.
Pressez et maintenez la touche Ctrl. Cliquez dans la moitié basse de l’objet et
maintenez le bouton de la souris enfoncé. Déplacer la souris dupliquera l’objet
dont la copie suivra le mouvement de la souris.
La même chose se produit si plusieurs objets sont dupliqués:
Après que plusieurs objets aient été sélectionnés (voir Sélection et désélection
multiples, inversion de la sélection), pressez et maintenez la touche Ctrl. Cliquez
dans la moitié basse d’un des objets et maintenez le bouton de la souris enfoncé.
Déplacer la souris dupliquera les objets dont les copies suivront le mouvement
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de la souris.

Changement de l’affichage de forme d’onde
Vous pouvez faire des changements basiques de l’affichage de la forme d’onde
dans les options du menu View. Toutes les possibilités sont décrites en détail
dans la section sur les déplacements dans le VIP, nous n’en ferons donc ici
qu’une rapide présentation:
Vous pouvez changer la taille de la forme d’onde en maintenant enfoncée la
touche Shift et en tournant simultanément la molette de la souris (si elle en a
une). La tourner vers le bas réduit la taille. C’est nécessaire pour dessiner les
courbes de niveau si le niveau de 0 dB est dépassé.
Il peut être utile d’augmenter la taille d’affichage de l’onde (tourner la molette
vers le haut)) si vous désirez un affichage détaillé de l’attaque et de la chute d’un
son.
Vous pouvez zoomer horizontalement sur la forme d’onde à la position occupée
par le curseur de lecture en pressant la touche Ctrl et en bougeant simultanément
la molette de la souris. C’est important si vous désirez un affichage détaillé de
l’attaque et de la chute d’un son et si vous voulez précisément régler un fondu
d’entrée et de sortie à la souris. Vous pouvez faire un zoom arrière en pressant
le bouton Ctrl et en tournant la molette vers le bas, ce qui vous donne une
bonne vue d’ensemble du VIP.

Edition des fondus avec les poignées ou dans l’éditeur d’objet
La méthode la plus simple consiste à cliquer sur les poignées de fondu de l’objet
sélectionné et à les déplacer (voir Poignées de l’objet). Dans ce cas, c’est la forme
de courbe réglée en fenêtre «Position/Fades» (dans l’éditeur d’objet) qui est
employée.
Plus de possibilités sont offertes après ouverture de l’éditeur d’objet (voir
L’éditeur d’objet): Vous pouvez choisir n’importe quelle forme de courbe et
durée de fondu en fenêtre «Position/Fades».

Effets dans l’objet
Tous les effets de piste peuvent être utilisés dans n’importe quel objet. Pour
cela, vous devez ouvrir la fenêtre Object Effects (dans l’éditeur d’objet) et
sélectionner les effets.
Les effets d’objet ont certains avantages par rapport aux effets de piste. La latence
est compensée automatiquement pour tous les effets, pour que les effets
s’appliquent précisément à l’échantillon près. Les effets consommateurs de
ressources de processeur peuvent aussi être employés plus efficacement.
Exemple: En dehors de votre reverb principale, vous envisagez d’ajouter des
effets de reverb totalement différents sur les coups de caisse claire à titre
d’accentuation. Pour cela, vous devez fractionner la piste de caisse claire et
déplacer sur une piste différente les coups de caisse claire que vous désirez
éditer. Utilisée comme effet de piste, la seconde reverb est toujours incluse même
si elle n’est employée qu’un court moment. A la place, vous pouvez aussi isoler
les coups de caisse claire sur la première piste mais n’ajouter la reverb que
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comme un effet d’objet. A propos: la reverb ne disparaît pas à la fin de l’objet
mais chute de façon normale!
Tous les effets de la piste où se situe l’objet sont ensuite employés.

Verrouillage des objets
Il suffit de cliquer sur le symbole de clé en bas au centre de chaque objet pour le
protéger d’un éventuel déplacement accidentel. Cette fonction est aussi offerte
par l’éditeur d’objet via le paramètre «Lock» (fonction de base) si l’objet est
préalablement sélectionné.
Cliquer à nouveau sur la clé déverrouille l’objet.
Pour verrouiller plusieurs objets, ils doivent d’abord être sélectionnés puis
verrouillés exclusivement grâce à l’éditeur d’objet.
Les variations accessibles via le menu Object -> Lock Objects -> Lock Definitions…
s’appliquent aux objets uniques et multiples.
Voici quelques autres possibilités de verrouillage des objets:
Tous les objets d’une piste peuvent être verrouillés en cliquant sur le symbole
de cadenas de la piste.
D’autres verrouillages (contre les fondus, les changements de durée ou la
suppression) peuvent être réglés dans le menu «Objects ->Lock Objects -> Lock
Definitions…».
Le verrouillage peut être temporairement désactivé quand vous travaillez avec
la souris en tenant la touche Alt pendant que vous cliquez avec la souris.

Intégration d’une section d’un projet Wave dans un objet
Aucun VIP ne doit être ouvert au début de cette procédure! (Voir aussi
«Différences lors du chargement de fichiers audio»).
Une fenêtre s’ouvre quand vous cliquez dans le menu File -> Load Audio File,
d’où vous pouvez chercher le fichier audio. Sélectionnez le fichier et cliquez sur
«Ouvrir» pour afficher le fichier audio comme projet Wave dans le VIP.
La totalité de la zone est sélectionnée. Cliquez une fois sur la forme d’onde pour
la désélectionner et vous pourrez ensuite faire une sélection («range») en cliquant
et en faisant glisser la souris. La barre d’espace peut servir à écouter cette
sélection.
Ouvrez maintenant le VIP.

Par la commande de menu: Cliquez dans la moitié haute de la piste et sur la
position horizontale où vous voulez créer le nouvel objet. Si vous cliquez sur
Object -> New Object, la sélection faite précédemment sera insérée.

Par Glisser & Déposer: Pressez la touche Entrée pour que le VIP et le projet
Wave soient affichés en mosaïque.
Amenez la souris sur la zone sélectionnée et cliquez dessus sans relâcher le
bouton de la souris. Déplacez maintenant la souris sur le VIP et relâchez le
bouton: La sélection est à présent un nouvel objet dans le VIP.

Edition destructive d’un objet
Vous pouvez éditer de façon destructive (définitive) le matériel audio d’un objet:
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Faites un clic droit sur l’objet qui contient le matériel audio devant subir l’édition
destructive. Dans le menu contextuel qui apparaît, cliquez sur une commande
adéquate pour ouvrir le projet. Vous pouvez maintenant effectuer toutes les
éditions destructives. L’avantage est que des effets extravagants peuvent être
immédiatement ajoutés au matériel audio, ce qui réduit la charge du processeur
durant la lecture en mode virtuel.

Notes importantes sur l’édition destructive: si vous éditez en mode destructif un fichier
audio utilisé dans un VIP, l’objet qui y fait référence dans le VIP fait maintenant
appel au fichier audio édité. Par exemple: si un réglage de filtre a été ajouté à un
fichier audio en mode destructif, l’objet sera entendu dans le VIP avec ce réglage de
filtre. Quand vous travaillez en mode destructif, vous devez donc savoir si le fichier
audio à éditer est utilisé par un objet dans le VIP. «Create Copy» (Créer une copie)
est activé par défaut pour toutes les éditions destructives. Dans ce cas, une copie du
matériel audio affect est toujours créée pour les effets. Ainsi, les objets du VIP qui font
appel à au fichier audio d’origine (non édité) y ont toujours accès.

Exemple 1: Comparaison de 2 VIP
Deux VIP sont disponibles (A.VIP et B.VIP), où des objets accèdent au même
fichier audio. B doit être employé pour tester si une simulation de pièce sonne
bien. A doit servir à la comparaison.
Le simulateur de pièce (Room Simulator) s’ouvre si vous cliquez sur Offline
Effects -> Room Simulator… après avoir sélectionné un objet. («Create Copy«

est déjà activé). Vous pouvez maintenant faire tous les changements dans le
simulateur de pièce. En cliquant sur le bouton «OK», l’effet est ajouté à un
nouveau fichier audio. De multiples options de sauvegarde sont disponibles.
Vous pouvez maintenant facilement alterner entre A et B; le simulateur de pièce
est à B.
C’est bien entendu possible, mais pas pratique. Il est plus facile d’activer le
simulateur de pièce virtuellement et de le geler ultérieurement.

Exemple 2: Ajout d’effets à un fichier audio
Deux VIP sont disponibles (A.VIP et B.VIP), où des objets accèdent au même
fichier audio. Une simulation d’ampli (Ampsimulation) doit être ajoutée à ces
deux VIP. Si vous cliquez sur Offline Effects -> Ampsimulation… après avoir
sélectionné un objet, le simulateur d’ampli s’ouvre («Create Copy« est déjà
activé). Désactivez cette fonction! Vous pouvez maintenant faire tous les
changements dans le simulateur d’ampli. En cliquant sur le bouton «OK», l’effet
est ajouté au fichier audio existant et A et B ont tous deux accès à ce fichier
audio édité.

Vous trouverez plus d’informations sur l’édition destructive dans le chapitre sur l’édition
des projets Wave.

Déplacement sur une position déterminée
Il existe plusieurs méthodes pour déplacer un objet sur une position déterminée:
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1. Faites un clic droit sur l’objet à déplacer. Dans le menu contextuel qui s’ouvre,

cliquez sur: Move/Edit Object -> Move Objects. Une fenêtre s’ouvre, où la
nouvelle position de début de l’objet (New Start position) peut être saisie en
échantillons (Samples), millisecondes, temps SMPTE ou mesures (Bars).

2. Procédez comme suit si vous voulez qu’un objet démarre à la position actuelle
du curseur de lecture: Faites un clic droit sur l’objet à déplacer. Dans le menu
contextuel qui s’ouvre, cliquez sur: Move/Edit Object -> Object to Playcursor
Position et l’objet se place à droite du curseur de lecture.

Groupage/dégroupage d’objets
Si vous voulez associer de façon permanente plusieurs objets en un groupe,
vous devez procéder comme suit:
– Sélectionnez tous les objets que vous désirez ajouter à ce groupe (voir Sélection

et désélection multiples, inversion de la sélection)
– Cliquez sur le symbole Grouper (Group) de la barre d’outils du programme

ou faites un clic droit sur un des objets sélectionnés et cliquez sur «Group
Objects» dans le menu contextuel. Ces objets forment maintenant un groupe.

– Cliquez sur le symbole Dégrouper (Ungroup) de la barre d’outils du
programme ou faites un clic droit sur un des objets sélectionnés et cliquez
sur «Ungroup Objects» dans le menu contextuel. Tous les éléments du groupe
sont de nouveau séparés.

Si les couleurs de groupe sont activées, une couleur différente est affectée à
chaque groupe. Cela permet de facilement les distinguer.
Vous pouvez aussi activer l’affichage des numéros de groupe dans les objets en
mode VIP.
Des objets peuvent être individuellement sortis du groupe si vous cliquez sur
Ungroup en maintenant enfoncée la touche Shift.

Couplage des objets
Voici comment coupler les objets:
Cliquez sur le bouton «Link one track» dans la barre de mode souris (Mouse
Mode Toolbar). Tous les objets de la piste situés à droite de l’objet déplacé sont
maintenant couplés.
Cliquez sur le bouton «Link all tracks» dans la barre de mode souris (Mouse
Mode Toolbar). Tous les objets situés à droite de l’objet déplacé, dans toutes les
pistes, sont maintenant couplés.
Si vous cliquez sur le bouton Normal Object mode de la barre d’outils, tous les
objets reviendront en mode normal.
Vous pouvez temporairement désactiver le mode objet en pressant «K». L’autre
mode est alors sélectionné tant que cette touche est gardée enfoncée.

Si vous désirez coupler de façon permanente des objets, et cela indépendamment
du mode d’édition, vous devez utiliser la fonction de groupage d’objets (voir
Groupage/dégroupage d’objets).
Si un objet est accidentellement divisé («split»), sélectionnez Undo (Annuler)
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dans le menu Edit ou dans le menu contextuel obtenu par un clic droit.

Chevauchement d’objets
Une piste (voie) ne peut relire qu’un seul objet à la fois.
Si un objet vient en chevaucher un autre, il couvre ce dernier (comme une feuille
de papier couvrant partiellement ou entièrement un objet). La partie non visible
d’un objet n’est pas lue. La partie masquée peut être rendue visible et donc à
nouveau audible en déplaçant l’objet du dessus. Pour créer un fondu-enchaîné
(crossfade) entre deux objets consécutifs se chevauchant partiellement, vous
pouvez employer l’éditeur «Crossfade Editor» dans le menu «Edit» de Samplitude
pour régler précisément le fondu enchaîné.
Si «Auto Crossfade active» est coché, un fondu-enchaîné est automatiquement
créé dès que l’objet superposé entre par fondu.

Réunion d’objets
Vous pouvez travailler avec deux objets qui n’ont «rien à voir l’un avec l’autre»
(c’est-à-dire incluant des fichiers audio différents):
Sélectionnez les deux objets et faites un clic droit sur l’objet de gauche.
Sélectionnez «Glue Objects» dans le menu contextuel pour créer un nouveau
fichier. Ce fichier se situe maintenant dans un dossier créé par Samplitude,
dans le dossier du VIP.
Cette fonction est proche de la fonction de gel («Freeze»).

Bouclage d’objets
Le bouclage ou «Looping» d’un objet signifie sa lecture totale ou partielle en
boucle durant toute la durée de l’objet.
Un objet est normalement reproduit de son début à sa fin. Un objet bouclé est
aussi lu depuis son début, mais dès que le début de la zone à boucler est atteint,
cette zone est relue répétitivement jusqu’à ce que la fin de l’objet soit atteinte.
Un objet bouclé peut par conséquent être plus long que le projet Wave auquel il
fait référence.
Si un objet est mis en boucle, son contenu est répété depuis la position de début
de boucle quand la durée de l’objet est étendue à l’aide de la poignée de durée
ou longueur. Les fichiers audio de l’objet sont donc lus du début de la boucle à
la fin de celle-ci puis répétés.
L’avantage de cela est l’économie de ressources: Par exemple, si une séquence
de 4 temps d’une piste de batterie est fréquemment répétée, vous n’aurez besoin
que d’un seul objet. Cela économise de l’espace de stockage et améliore la lisibilité
du projet.
Il existe deux variantes:
1. La plus simple est de faire un clic droit sur l’objet et de sélectionner «Build

Looped Object». La totalité de l’objet est traité comme une boucle. Tirez
maintenant la poignée de longueur de droite vers la droite pour afficher une
ligne verticale sur l’ancienne fin de l’objet, indiquant que l’objet sera répété:
l’objet est mis en boucle et peut être étendu à volonté sur la droite.

2. Une boucle d’objet peut être affiché de façon bien plus détaillée à l’aide de
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l’éditeur d’objet. Activez le bouclage en cochant la case «Loop on» en section
Object Loop. Vous pouvez maintenant régler et adapter la boucle de l’objet
dans l’objet selon vos désirs.

Rognage d’objets
Rogner un objet signifie réduire sa taille à la sélection faite dans celui-ci, c’est-à-
dire éliminer les franges extérieures aux nouvelles limites de la sélection.
Pour cela, vous devez faire une sélection dans un objet. Utilisez maintenant le
bouton droit de la souris pour cliquer dans la moitié inférieure de l’objet et
sélectionnez «Trim Objects»: l’objet ne fait plus maintenant que la longueur de
la sélection préalablement faite.
Si vous avez sélectionné plusieurs objets n’ayant pas les mêmes points de début
et de fin, les durées d’objet sont réduites et pas étendues.

Echange de fichiers audio «derrière» l’objet
Pour échanger un fichier audio auquel l’objet fait appel, ouvrez la fenêtre
Position/Fades de l’éditeur d’objet et cliquez sur l’icône de dossier située à droite
du nom de fichier. Vous pouvez sélectionner un nouveau fichier .WAV dans la
fenêtre de dialogue qui s’est ouverte.
Cela peut être nécessaire si vous travaillez avec différents programmes audio et,
par exemple, si vous désirez utiliser des CD d’échantillons dans Samplitude.
Imaginons que vous ayez créé un fichier audio à l’aide d’un logiciel
échantillonneur et que vous ayez intégré ce fichier audio dans Samplitude
(intégration du fichier .WAV dans le VIP en tant qu’objet). Si vous désirez par la
suite utiliser des échantillons différents dans le VIP, créez un autre fichier audio
utilisant les nouveaux échantillons et utilisez ceux-ci pour échanger avec les
données audio précédentes. Samplitude utilisera alors les nouveaux échantillons
(les nouvelles données audio).
Pour les projets Wave créés dans Samplitude, vous pouvez ouvrir le VIP ayant
été la source de création du fichier .WAV directement via la commande «Edit
Root VIP», vous pouvez éditer le fichier et le convertir à nouveau en fichier
.WAV.
Ainsi vous pouvez, par exemple, obtenir un VIP de mastering avec 10 objets,
chacun contenant une plage de CD. Les pistes seront mixées avec Samplitude et
exportées par report de pistes. Si vous désirez alors encore modifier le mixage
d’une plage, sélectionnez «Edit Root VIP» dans le menu contextuel et Samplitude
ouvrira le projet correspondant. Quand le projet Wave est fermé, les changements
effectués dans le VIP source («Root VIP») sont rajoutés au projet Wave.
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Courbes de volume personnalisées
1. Après ouverture d’un VIP, cliquez sur le bouton Vol de la piste 1 pour activer

la courbe de volume.
2. Pour cet exemple, nous allons insérer quatre poignées sur la courbe et créer

une courbe de volume personnalisée avec baisse, remontée, puis de nouveau
baisse du volume.

  Commencez par réduire le volume général de 3,0 dB au moyen du fader de
volume de la piste. Le volume général est indiqué dans le petit champ situé à
gauche du fader. Vous pouvez alors remarquer que la taille de la forme d’onde
change et, dans notre exemple, se rétrécit.

  Au moyen de doubles clics sur la courbe de volume, insérez 4 poignées
approximativement aux endroits ci-dessous:

Astuce: Veillez bien à double-cliquer SUR la courbe/poignée de volume et non pas
sur le reste de l’objet. Si vous loupez la courbe ou la poignée, vous risquez d’ouvrir
l’éditeur d’objet ou d’effectuer une autre opération (en fonction du mode de souris
en vigueur).

3. Cliquez à présent sur l’une des quatre poignées, puis faites-la glisser à l’écran.
Vous remarquez que le profil de la courbe de volume s’étire (comme un
élastique). Regardez comment la forme d’onde évolue. Vous pouvez également
remarquer que la hausse ou la baisse de volume en décibels de la poignée est indiquée
dans une bulle d’aide.

  Créez à présent la courbe de volume illustrée ci-dessous en faisant glisser les
poignées 2 et 3:

4. Vérifiez que le magnétisme et le mode Loop (lecture en boucle) sont activés,
délimitez une sélection sur la totalité de l’objet, puis lancez la lecture en boucle.
Ecoutez les variations de volume découlant de la courbe crée.
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5. Faites glisser l’une des poignées de volume, puis regardez comment la courbe

évolue en temps réel.
6. Arrêtez la lecture. Vous pouvez supprimer des poignées de volume existantes

en double-cliquant dessus, ou en les sélectionnant par simple clic, puis en
appuyant sur la touche Suppr de votre clavier.

7. Recréez à présent 4 poignées de volume, puis répétez l’étape 4 ci-dessus. Vous
pouvez créer ou supprimer des poignées de volume durant la lecture, mais
cette tâche est alors plus aisée en mode souris «Object and Curve Mode» (objet
et courbe). Sinon, cliquer sur l’objet risque d’annuler la sélection et, par conséquent
la lecture en boucle, ou risque d’ouvrir l’éditeur d’objet.

  Sélectionnez le bouton «Object and Curve Mode» de la barre d’outils et notez la
différence de curseur.

8. Lancez la lecture en boucle. Double-cliquez sur une poignée de volume existante
et elle sera supprimée. Double-cliquez sur la courbe de volume et une nouvelle
poignée sera insérée.

9. Stoppez la lecture, puis recréez 4 poignées de volume conformément à l’étape
2.

10. Revenez ensuite en mode souris universel en cliquant sur le bouton «Universal
Mode» de la barre d’outils de mode souris.

Fader de volume
1. Avec la courbe de volume activée à l’écran, faites glisser le fader de volume de

la piste 1 vers la gauche afin de réduire le volume de la piste de 3 dB
supplémentaires (et abaisser ainsi le volume de la piste à –6 dB). Vous pouvez
remarquer que la courbe de volume évolue à l’écran et répercute la baisse du
volume tout en conservant les écarts de volume relatifs.

2. Cliquez à présent sur le fader de Volume, puis faites-le glisser vers la droite
afin de relever le volume de la piste de +9 dB (jusqu’à la position +3 dB). La
courbe de volume évolue alors de nouveau quand on utilise le fader de volume
pour augmenter le volume général de la piste. Comme la Poignée 3 atteint le
sommet de l’objet (0 dB), les écarts relatifs de la courbe sont nivelés.

  Cela n’est pas toujours le cas car le format 32 bits à virgule flottante de
Samplitude permet d’échelonner les fichiers en interne au-delà du niveau
0 dB maximum applicable aux fichiers audio.

3. Pour conserver les écarts de niveaux relatifs, vous pouvez faire un zoom arrière
sur la forme d’onde de 3 façons:

– En cliquant sur le bouton de zoom vertical situé dans le coin inférieur droit,
puis en sélectionnant l’option Zoom Out Track:

– ou vous pouvez presser Ctrl+ Flèche vers le bas,
– ou vous pouvez employer le menu View > Vertical > Zoom Out Track.



78

Travail dans la fenêtre VIP
Ceci est une vue de la forme d’onde, après zoom arrière. Comme vous pouvez le
voir, les écarts relatifs entre les poignées de la courbe de volume ont été conservés.

4. Double-cliquez sur le fader de volume pour rapidement revenir à sa position
centrale (0db) par défaut.

5. Cliquez sur le bouton Vol de la piste 1. La ligne jaune représentant la courbe
de volume disparaîtra, et les variations de volume seront désactivées.

Note: Quand vous n’utilisez pas la courbe de volume personnalisée, le fader de
volume représente un moyen rapide d’augmenter ou d’atténuer le volume général
de la piste.

Courbes de panoramique personnalisées
1. Cliquez sur le bouton Pan de la piste 1 afin d’en activer la courbe de

panoramique.
2. Pour cet exemple, insérez quatre poignées de panoramique comme vous l’avez

fait pour les poignées de volume. Cliquez à présent sur l’une des quatre
poignées, puis faites-la glisser à l’écran. Vous remarquez que le profil de la
courbe de panoramique s’étire. Vous pouvez modifier la courbe en créant
des poignées et en tirant dessus.

3. Double-cliquez à présent sur la ligne bleue représentant la courbe de
panoramique. Une poignée se crée. Il suffit alors de cliquer sur la poignée en
question et de la faire glisser à l’endroit désiré. Entraînez-vous à cette
manipulation jusqu’à ce que vous vous y habituiez.

4. Pour supprimer une poignée existante, il suffit de double-cliquer dessus.
5. Faites à présent revenir le curseur de lecture au début de la piste au moyen de

la touche Home (Orig) de votre clavier.
6. Si vous ne l’avez pas encore fait, lancez la lecture à l’aide de la barre d’espace,

puis écoutez l’action de la courbe de panoramique que vous avez créée.
7. Arrêtez ensuite la lecture en appuyant sur la barre d’espace. Bien entendu,

vous pouvez également lancer et arrêter la lecture depuis le panneau de
transport!

Curseur de panoramique
1. Avec la courbe de panoramique activée à l’écran, faites glisser le curseur de

panoramique de la piste 1 vers la gauche afin de réduire le volume du canal
droit de 3 dB.

2. Cliquez à présent sur le curseur de panoramique, puis faites-le glisser vers la
droite afin d’abaisser le volume du canal gauche de 3 dB. Vous pouvez
remarquer que la courbe de panoramique est «transposée» à l’écran et
répercute les mouvements du curseur de panoramique. Autrement dit, les
écarts de panoramique relatifs définis sur la courbe de panoramique restent
conservés lorsque vous déplacez le curseur de panoramique vers la gauche ou
vers la droite.

3. Pour ramener instantanément le curseur de panoramique sur sa position centrale
par défaut, double-cliquez sur le curseur.

4. Cliquez ensuite sur le bouton Pan de la piste 1. La courbe de panoramique
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bleue disparaît alors de l’écran et l’automation du panoramique
correspondante est désactivée.

Note: Lorsque la courbe de panoramique n’est pas active, le curseur de
panoramique sert simplement à rapidement déplacer le signal de la piste vers la
gauche ou vers la droite.

Fondu d’entrée (Fade-In)
1. Placez le pointeur de la souris sur la moitié inférieure de la piste 1 (outil Objet),

puis sélectionnez l’objet en cliquant dessus (les cinq poignées de l’objet
apparaissent à l’écran).

2. Dans le coin supérieur gauche de l’objet se trouve une poignée. Placez le
pointeur de la souris sur cette poignée. Vous remarquez que le pointeur se
change en double flèche gauche/droite. Cliquez alors sur la poignée, puis
faites-la glisser vers la droite afin d’appliquer un fondu d’entrée à l’objet. La
durée du fondu est définie par la distance de déplacement de la poignée.

3. La durée du fondu d’entrée est indiquée dans une bulle d’aide quand vous le
créez. La valeur affichée est au format employé par le panneau flottant de
transport pour l’affichage de position.

4. Ramenez le curseur de lecture au début de la piste au moyen de la touche
Home (Orig) de votre clavier.

5. Si Samplitude est à l’arrêt, lancez la lecture au moyen de la barre d’espace et
écoutez le fondu d’entrée que vous venez de créer.

6. Arrêtez ensuite la lecture en appuyant de nouveau sur la barre d’espace.

Note: Le fait de cliquer sur un objet avec les deux boutons de la souris (cliquez sur
le bouton droit légèrement avant le bouton gauche) ouvre l’éditeur d’objet (Object
Editor). Dans cet éditeur, vous pouvez créer un fondu d’entrée et en définir
précisément la courbe. Pour l’instant, jetez-y simplement un œil. L’éditeur d’objet
est l’une des fonctions majeures de Samplitude que vous utiliserez très souvent.
Vous trouverez de plus amples renseignements sur l’éditeur d’objet dans la suite de
ce chapitre.
Fondu de sortie
Les fondus de sortie se définissent exactement de la même manière que ceux
d’entrée, excepté que cela se fait au moyen de la poignée supérieure droite de
l’objet.
Bien entendu, vous pouvez créer des fondus d’entrée et de sortie au moyen des
courbes de volume. Néanmoins, comme vous pourrez le voir dans la suite du
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manuel, on obtient en général de meilleurs résultats en se servant des poignées
des objets et de l’éditeur d’objet. Les raisons de cela apparaîtront plus loin dans
ce manuel.

Navigation avec les sélections («Ranges»)
Dans Samplitude, les sélections jouent un rôle important dans la réussite de
l’édition audionumérique multipiste. Chaque sélection (»Range») délimite
simplement une zone de données d’un VIP ou d’un projet Wave à laquelle
seront apportées des modifications. En fait, les sélections indiquent les pistes et
les objets qui seront lus et édités. Il est possible de délimiter, déplacer, étendre,
inverser, sauvegarder, rappeler et éditer les sélections.
Les sélections revêtent une importance particulière lorsque vous utilisez certaines
fonctions de Samplitude, telles que le prémixage de pistes ou «report de pistes».
Comme vous le savez probablement maintenant, il est possible de combiner les
données d’un VIP et de les mixer dans un même fichier audio stéréo. Lorsque
vous faites appel à la fonction de prémixage de pistes, le programme vous
demande de définir la zone ou «plage» de prémixage : vous pouvez choisir une
sélection particulière ou bien l’ensemble des données du projet.
Les sélections peuvent être délimitées à l’intérieur d’une même piste ou bien
sur plusieurs pistes. Pour délimiter une sélection dans une seule piste, déplacez
la souris à l’intérieur des limites horizontales de la piste. Pour délimiter une
sélection portant sur deux pistes, étendez la sélection au-delà des limites verticales
de la première piste de façon à déborder sur la deuxième piste. Cette procédure
peut être appliquée à un nombre illimité de pistes VIP. Il peut s’avérer nécessaire
d’appliquer un zoom vertical avant ou arrière sur la fenêtre VIP afin d’afficher
les pistes souhaitées.
Une fois qu’une sélection est effectuée, on peut changer sa durée (sur le plan
horizontal à l’intérieur d’une même piste) et sa hauteur (sur le plan vertical sur
plusieurs pistes).
Lorsque vous appliquerez les exemples de manipulation de sélection décrits ci-
dessous, souvenez-vous qu’il est possible de délimiter n’importe quel type de
sélection. Nous allons travailler avec la fonction de magnétisme afin de simplifier
les choses, mais sachez qu’une sélection ne se terminant pas nécessairement
sur le bord d’un objet vous permet de manipuler du matériel de toute forme et
de toute durée. En d’autres termes, les sélections peuvent être employées sur
une partie d’un ou de plusieurs objets, sur une ou plusieurs pistes.

Exemple 1
Vous voulez sélectionner plusieurs objets situés sur des pistes adjacentes afin
de les déplacer par glisser/déposer. Au lieu de sélectionner les objets en cliquant
tour à tour sur chaque objet tout en maintenant la touche Shift enfoncée, il
suffit de délimiter une sélection au-dessus des objets, puis de sélectionner la
commande Object > Select Objects. Tous les objets couverts en totalité ou en
partie par la sélection que vous avez délimitée sont ainsi sélectionnés.

Exemple 2
Vous voulez enlever toute une section de données des pistes du VIP. Par exemple,
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votre client décide d’enlever du morceau un couplet entier afin de raccourcir le
morceau/publicité et de le faire cadrer avec le format radio (par exemple, un
jingle de 45 secondes réduit à 30 secondes). Pour cela, délimitez une sélection
au-dessus de toutes les pistes occupées par le couplet à couper et utilisez Edit >
Cut, qui permet de couper la section de données indésirables, et refermez
l’intervalle ainsi créé entre les objets. Vous obtenez alors une version plus courte
du morceau.
Utilisez les outils présentés ci-dessous afin d’ajuster la durée de la sélection à
couper. Ils vous aideront à définir les limites exactes de la section indésirable.

Exemple 3
En musique Dance, les boucles de batterie sont souvent utilisées sur une grande
partie du morceau. Pour éviter d’enregistrer l’intégralité de la boucle et d’utiliser
un espace disque précieux, vous pouvez créer une boucle virtuelle qui lit la boucle
de manière répétitive depuis le début de la section audio mise en boucle. La
longueur des boucles virtuelles peut être étirée à l’intérieur d’une piste de façon
à répéter la boucle sur l’intervalle de temps souhaité.
Pour construire des objets à boucle virtuelle avec la commande Object > Build
Loop Object, vous devez délimiter une sélection à l’intérieur des bordures de
l’objet sélectionné. Une fois que la fonction est activée, vous pouvez agrandir ou
raccourcir librement la boucle virtuelle en faisant simplement glisser la poignée
inférieure droite de l’objet.

Exemple 4
Une sélection peut être mise en lecture à l’aide des nombreuses options de
lecture de Samplitude. Vous pouvez même ajuster la durée et la position de la
sélection au cours de la lecture.
Un exemple: lors du montage d’un reportage d’actualités radio, le producteur
de l’émission pré-écoute plusieurs sélections afin de ramener le reportage à une
durée exploitable. Les sélections peuvent servir à isoler des zones à couper et à
l’édition plus poussée des objets.

Navigation avec les marqueurs
Les marqueurs occupent une place importante dans votre travail quotidien avec
Samplitude. Les marqueurs servent à indiquer des positions précises dans vos
projets auxquelles vous pouvez ensuite accéder à tout moment. Par exemple,
lors du Mastering d’un enregistrement «live» depuis une bande DAT, il est
extrêmement pratique d’enregistrer des marqueurs au début de chaque morceau
au cours de l’enregistrement de la bande.
Les marqueurs peuvent être déposés dans la fenêtre du projet afin de repérer
plus facilement certaines positions d’édition.
La sélection des marqueurs est simple. Il existe trois méthodes principales:
Cliquez sur le corps du marqueur dans la barre des marqueurs située au-dessus
de la section des pistes.
Appuyez sur la touche numérique correspondante du pavé numérique pour
créer des marqueurs numérotés.
Vous pouvez également utiliser le gestionnaire de marqueurs (Marker Manager,
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menu Tools) pour localiser et sélectionner des marqueurs. Ce gestionnaire
répertorie tous les marqueurs insérés dans un projet. Pour sélectionner un
marqueur, il suffit de cliquer dessus dans la liste du gestionnaire de marqueurs.
Le gestionnaire de marqueurs vous permet aussi de renommer vos marqueurs.
Passez au marqueur précédent (Left)/suivant (Right) avec les commandes «Range
> Move Play Cursor > Marker left/right» (raccourcis-clavier F2 /F3).

Exemples d’utilisation des marqueurs
Exemple 1
Le Mastering d’un CD audio requiert l’affectation de «marqueurs d’index ». Ces
marqueurs peuvent être configurés soit automatiquement (via le bouton «Auto
CD Track indices» dans la barre d’outils), soit manuellement en cliquant sur le
bouton «Set CD Track Index» dans la barre d’outils. Il est possible de déplacer
les marqueurs de façon à ajuster la position de départ relative d’une piste CD.

Exemple 2
Vous pouvez utiliser les marqueurs afin de simuler des coupures dans vos pistes
audio. En insérant un marqueur et en le déplaçant, il est possible d’auditionner
différentes positions de coupure. Vous pouvez augmenter le niveau de zoom de
la fenêtre pour travailler avec une plus grande précision. Le marqueur peut ainsi
être déplacé par plus petits pas.

Exemple 3
Le gestionnaire de marqueurs (Marker manager) du menu Tools vous permet
de donner un nom à vos marqueurs. Vous pouvez ainsi insérer des marqueurs
dont le nom correspond à des sections de données audio spécifiques. Exemples :
‘Couplet 1’, ‘Pont’, ‘Refrain 1’, ‘Intro’, etc. Il suffit alors de sélectionner le
marqueur désirée en cliquant sur son corps (dans la barre des marqueurs en
haut de la fenêtre de projet) ou sur l’entrée correspondante du gestionnaire
d’objets afin d’accéder instantanément à la position souhaitée.
Autre possibilité d’utilisation pratique des marqueurs : Pour délimiter
rapidement une sélection entre des marqueurs, il suffit de double-cliquer entre
deux marqueurs sur la barre des marqueurs. Si le curseur de lecture est
positionné entre deux marqueurs, vous pouvez délimiter une sélection entre le
curseur de lecture et ces deux marqueurs en appuyant sur les touches shift-F2 /
shift-F3 (»Range -> Edit Range -> Range Start to Left Marker/Range End to
Right Marker»).

Zoom
Les zooms permettent de se concentrer sur certaines informations des fenêtres
VIP. Plus le niveau de zoom utilisé est important, plus la résolution d’affichage
des données des pistes est grande. Il est ainsi plus facile d’éditer les courbes
d’automation en augmentant le niveau du zoom car cela permet d’isoler les
événements de courbe individuels, donc de travailler avec davantage de précision.
A l’inverse, il peut s’avérer nécessaire de réduire le niveau de zoom d’un long
projet afin de pouvoir visualiser l’ensemble des données du VIP.
Samplitude met à votre disposition un grand nombre de niveaux de zoom dans
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les VIP. Voici la liste des fonctions de zoom proposées par Samplitude:

Zoom à l’aide de la barre d’outils de position
Ces boutons parlent (presque) d’eux-mêmes; les boutons rouges servent à
appliquer un zoom horizontal sur les formes d’ondes, les boutons bleus un
zoom vertical sur les pistes. Toutes ces options sont également accessibles via la
commande Menu View - Horizontal / Vertical. Vous pouvez donc leur affecter
vos propres raccourcis clavier.

Zoom à l’aide de la souris
La souris permet de délimiter des sélections sur lesquelles vous pouvez appliquer
des zooms. Double-cliquer dans la moitié supérieure d’une piste (en mode Zoom
Mouse, obtenu par le bouton à icône de loupe en barre d’outils) applique un
zoom avant (arrière en tenant la touche Alt enfoncée) sur la fenêtre VIP. Chaque
double-clic change le niveau du zoom d’un intervalle prédéfini. Pour appliquer
un zoom avant sur une sélection, il suffit de double-cliquer dans la sélection.

La méthode la plus conviviale pour appliquer un zoom avec la souris consiste à
cliquer dans la barre de marqueurs et grille en maintenant le bouton de la souris
enfoncé, puis de faire glisser la souris verticalement, vers le haut pour appliquer un
zoom arrière, vers le bas pour appliquer un zoom avant.

Zoom à l’aide du clavier
La touche flèche vers le haut applique un zoom avant sur la fenêtre, la touche
flèche vers le bas un zoom arrière. Vous pouvez utiliser la combinaison de touches
Alt + touche flèche gauche/droite afin de faire défiler les sections de piste à
gauche/droite dans la fenêtre.

Zoom à l’aide de la barre de défilement
Les barres de défilement vertical et horizontal des fenêtres VIP peuvent servir à
modifier le niveau de zoom de la fenêtre. Lorsque vous placez le pointeur de la
souris sur l’extrémité gauche ou droite de la barre de défilement horizontal, il
prend la forme d’une flèche bidirectionnelle vous permettant de faire glisser les
extrémités de la barre de défilement et de modifier le niveau de zoom de la
fenêtre. Les chiffres figurant sur le côté gauche de la barre de défilement
horizontal indiquent la durée de la section audio affichée dans la fenêtre au
format SMPTE (minutes, secondes et images).
Vous pouvez faire glisser la barre de défilement vers la gauche/droite afin de
passer en revue le projet comme vous le souhaitez.
La barre de défilement vertical vous permet de faire défiler les différentes pistes
VIP dès lors que le niveau de zoom a été augmenté : lorsque vous appliquez un
zoom vertical dans la fenêtre VIP, moins de pistes sont visibles, et la longueur
de la barre de défilement vertical est réduite. Vous pouvez alors déplacer la
barre de défilement afin de visualiser les autres pistes du VIP. Si le pointeur de
la souris est placé sur le sommet ou la base de la barre de défilement vertical, il
prend la forme d’une flèche bidirectionnelle (haut/bas) vous permettant de faire
glisser les extrémités de la barre de défilement et ainsi de modifier le niveau de
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zoom vertical de la fenêtre.

Zoom à l’aide des boutons de zoom de la barre de défilement
A droite de la barre de défilement horizontal se trouvent deux ensembles de
boutons zoom permettant d’appliquer des zooms avant et arrière à la fenêtre
VIP. Les paliers de zoom sont prédéfinis. Utilisez les boutons situés en dessous
de la barre de défilement vertical pour appliquer un zoom vertical avant/arrière
sur les pistes.
Samplitude adopte des niveaux de zoom supplémentaires, définissables par
l’utilisateur, qui peuvent être préréglés indépendamment du projet.
Vous pouvez expérimenter différents modes et méthodes de zoom. Une fois
familiarisé avec leurs fonctionnalités, vous pourrez préférer une méthode à une
autre. A vous de décider ce qui vous semble le plus intuitif et le plus pratique.
La sauvegarde des niveaux de zoom vous permet de passer rapidement d’une
résolution d’affichage à l’autre.
Les 8 boutons situés dans le coin inférieur gauche de la fenêtre VIP permettent
de conserver en mémoire certains niveaux de zoom et positions de fenêtre à
l’écran. Ils sont intitulés «Setup» et «Zoom». Les boutons «Setup» servent à
enregistrer le niveau de zoom et la position de défilement dans la fenêtre. Les
boutons «Zoom» enregistrent uniquement le niveau de zoom.
Pour enregistrer la position et le niveau de zoom de la fenêtre, maintenez la
touche Shift enfoncée et cliquez sur le bouton Setup souhaité.

Repérage audio
Le repérage (Scrub) consiste à faire défiler rapidement un projet afin de repérer
auditivement des données audio. C’est comme si vous faisiez basculer un
magnétophone à bobines en un mode d’édition où les moteurs sont dissociés
des commandes de transport et où les bobines peuvent être tournées
manuellement. Les têtes de lecture, quant à elles, restent fonctionnelles et, à
mesure que vous tournez les bobines à la main, les données audio sont lues à la
vitesse de rotation des bobines. Vous pouvez ainsi vous rendre rapidement sur
une position de lecture donnée ou pré-écouter des éditions à vitesse très lente.
Avec des données numériques, le repérage est légèrement plus compliqué dans
la mesure où aucune véritable mécanique n’intervient. Le repérage s’effectue
au moyen d’un rééchantillonnage en temps réel (fonction «Varipitch») qui
permet de modifier la hauteur des données audio tout en conservant la même
vitesse de lecture. Cela permet efficacement d’accélérer ou de ralentir la vitesse
de repérage.
Le taux de conversion de la fréquence d’échantillonnage dépend du mouvement
de la souris. Plus le mouvement est ample, plus la hauteur de lecture augmente
et plus les données audio défilent rapidement. Au contraire, si vous ralentissez
le mouvement ou inversez sa direction, la hauteur de lecture diminue et le
défilement des données audio est ralenti ou inversé.
Vous pouvez activer la fonction de repérage à l’aide de la touche «0» du pavé
numérique avec la souris en mode Scrub, ou avec la commande de transport.
Pour configurer le repérage, ouvrez la boîte de dialogue des paramètres de lecture
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(Play Parameter, raccourci-clavier: p).
Boîte de dialogue Play parameter

Scrubbing (repérage): Pour effectuer le repérage, il suffit d’appuyer sur la
touche 0 du pavé numérique (verrouillage du pavé numérique actif) ou de
sélectionner le mode Scrub pour la souris et de la déplacer à droite/gauche du
curseur de lecture. Samplitude lance la lecture à très basse vitesse; la position
de la souris par rapport au curseur de lecture contrôle la vitesse et la direction.

Jogging: C’est la distance entre le curseur de lecture et la souris qui détermine
la vitesse de lecture.

Absolute: Lorsque la souris est placée complètement à gauche, les données
audio sont lues en sens inverse à 2 fois la vitesse normale. Lorsque la souris est
placée complètement à droite, les données sont lues à 2 fois la vitesse normale.
Lorsque la souris est au centre de la fenêtre, la lecture des données s’interrompt
(vitesse 0).

Two Speed: Vous pouvez définir une vitesse qui sera utilisée lors du repérage
via les boutons dédiés du panneau de transport.

Astuce: Le repérage peut servir à travailler sur des sections audio d’un projet en
toute précision. Le mode de repérage relatif (Jogging) peut être un moyen
d’employer de façon pratique la fonction de repérage. Comme il permet de ralentir
la lecture audio par réduction de la distance entre le pointeur de la souris et le
curseur de lecture, il simplifie le repérage de sections de votre matériel audio
représentant un événement crucial.
La lecture s’arrête dès que la touche numérique «0» est relâchée et le curseur de
position reste à l’emplacement exact où la lecture de repérage a été interrompue.

Vous pouvez utiliser différents niveaux de zoom afin de travailler en mode de
repérage relatif avec davantage de précision.
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Les gestionnaires ou «Managers» combinent en une fenêtre les fonctions de
gestion et de contrôle fréquemment requises, comme celle concernant les
marqueurs, les pistes et les plages de CD. Cela comprend un navigateur de
fichiers (File Browser) pour rechercher, pré-écouter et charger des fichiers media.
Les gestionnaires peuvent être ouvert dans la fenêtre principale ou en dehors
d’elle sans la bloquer. La fenêtre Manager est compatible multi-moniteur et
conserve sa dernière position après fermeture. Vous pouvez ouvrir
simultanément plusieurs gestionnaires indépendants les uns des autres dans
différentes fenêtres.
Le gestionnaire intègre les sous-menus suivants (avec les raccourcis-clavier):
– Navigateur de fichiers ou «File Browser» (Ctrl+Shift+B)
– Gestionnaire d’objets ou «Object Manager» (Ctrl+Shift +O)
– Gestionnaire de pistes ou «Track Manager» (Ctrl+Shift+S)
– Gestionnaire de marqueurs ou «Marker Manager» (Ctrl+Shift+Alt+M)
– Gestionnaire de sélections ou «Range Manager» (Ctrl+Shift+Alt+B)

Pour ouvrir un gestionnaire, cliquez sur le bouton «Manager» dans la barre
d’outils ou sélectionnez «New Manager» dans le menu «Tools». Vous pouvez
aussi ouvrir une fenêtre de gestionnaire supplémentaire via cette entrée de menu.
Utilisez la souris pour cliquer sur l’onglet de la fenêtre (en bas du cadre)
correspondant au sous-menu désiré. Vous pouvez prédéfinir des raccourcis pour
ouvrir directement ces sous-menus (voir ci-dessus).
Note: les raccourcis affectent aussi un gestionnaire déjà ouvert et fait passer à
l’affichage demandé par le raccourci. Si plusieurs fenêtres de gestionnaires sont
ouvertes, le raccourci affecte la première fenêtre ouverte ou celle actuellement
active.

Navigateur de fichiers (File Browser)
Introduction
Samplitude a un navigateur de fichiers, intégré dans le gestionnaire («Manager»),
que vous pouvez employer pour pré-écouter les fichiers et les charger directement
dans les projets. Le navigateur vous permet de définir des répertoires (dossiers)
favoris et donne accès aux dossiers récemment ouverts.
Pour afficher le navigateur de fichiers, cliquez sur le bouton «Manager» dans la
barre d’outils puis sélectionnez «File Browser» en bas de la fenêtre Manager.

Menu: Tools/Manager/File Browser
Raccourci: Ctrl+Shift+B
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Navigation/Favoris
Le navigateur de fichiers est comparable au célèbre explorateur Windows. Les
répertoires (dossiers) et fichiers sont affichés sous forme de listes avec des
symboles de dossier et de fichier.
Utilisez le clavier ou la souris pour naviguer. Un menu déroulant de disque
dans la barre d’outils permet de changer rapidement de support de données
connecté à la station de travail.
Un filtre d’affichage situé dans la barre d’outils vous permet de limiter l’affichage
à certains types de supports, par ex. les fichiers .WAV, MIDI ou projet seulement.
«All media files» (tous les fichiers média) sont affichés par défaut.
Comme dans les autres fenêtres de gestionnaire, l’option de recherche (Search,
icône de jumelles) vous permet de rechercher des dossiers ou fichiers dans la
fenêtre actuelle. Saisissez un critère de recherche dans le champ de recherche
et cliquez sur le bouton de recherche (avec l’icône des jumelles). Les dossiers ou
fichiers trouvés sont surlignés. Vous pouvez trouver et surligner plusieurs entrées
répondant au critère de recherche en saisissant la ou les premières lettres.
Le navigateur de fichiers s’ouvre sous forme de panneaux. Le panneau de droite
recèle la liste des favoris, que vous pouvez fermer avec le bouton «Options» de
la barre d’outils. Utilisez les boutons «Add» ou «Remove» pour respectivement
ajouter et supprimer des dossiers de la liste des favoris.
Sous la liste des favoris se trouve un champ affichant les derniers chemins
d’accès utilisés et qui vous permet de changer le dossier du projet actuel (current
project folder).

Pré-écoute des fichiers
Vous pouvez employer l’icône de lecture dans la barre d’outils pour pré-écouter
un fichier audio surligné. Si la case «Autoplay» est cochée, tout fichier audio
surligné est immédiatement lu. Ainsi, vous pouvez écouter une liste complète
en n’utilisant que les touches curseur. Cliquer à nouveau sur le bouton de lecture
stoppe la lecture continue.
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Astuce: Durant la lecture, les commandes du panneau de transport sont allouées
au fichier. Les fonctions de lecture et de positionnement sont entièrement
disponibles.

La lecture ne passe pas par le mixer ni par les effets internes. Contrairement aux
fonctions de lecture de la fenêtre de chargement «Load», qui utilisent les routines
du système d’exploitation, cette lecture utilise le périphérique audio sélectionné
dans les paramètres de lecture (Play Parameter: «P»). Cela peut être un
périphérique MME, WDM ou ASIO. Si aucune reproduction ne se fait, vérifiez
d’abord que les réglages et le routage de ce périphérique sont corrects.

Note: Pour pré-écouter les données de certains fichiers, par ex. au format WMA,
vous devez convertir ces fichiers au format .Wav. La conversion s’effectue
automatiquement en tâche de fond.

Chargement de fichiers depuis l’explorateur dans les projets
Certains fichiers média peuvent être insérés dans un projet ouvert à la position
temporelle désirée par glisser-déposer. Si la liste du navigateur de fichiers est
au premier plan, presser la touche «Entrée» donne le même résultat.
Si un fichier audio est tiré de la liste des clips et déposé sur la barre de titre de la
fenêtre du programme, il est ouvert en mode d’édition d’onde.
Si plusieurs fichiers ont été sélectionnés dans la liste, tous les fichiers sont insérés
comme de nouveaux objets à partir de la position actuelle du curseur. «Load
Options…» (bouton Options de la barre d’outils) vous permet de déterminer si
tous les fichiers à insérer dans le projet actuel doivent l’être à la suite ou en
colonne, par ordre alphabétique, ou en tenant compte des positions d’horodatage.
Ces options de chargement s’appliquent réciproquement aux fichiers que vous
insérez via la fenêtre de chargement «Load» du programme.
Il existe d’autres options dans le menu contextuel d’un fichier média (clic droit):
– Load file (Charger fichier)
– Delete file (Supprimer fichier): Supprime le fichier du support.

Note: Ce processus ne peut pas être annulé!

– Select all files (Sélectionner tous les fichiers)
– Open in linked program (Ouvrir dans programme associé): Le fichier est ouvert

dans l’application Windows qui est associée à ce type de fichier. Cela peut
être un lecteur MP3, Samplitude ou un éditeur Wav différent.

– Open in Windows Explorer (ouvrir dans l’explorateur Windows): Ouvre le
dossier actuel dans une nouvelle fenêtre de l’explorateur Windows.
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Gestionnaire d’objets (Object Manager)
Introduction
Le gestionnaire d’objets, intégré dans le gestionnaire («Manager»), référence
tous les objets inclus dans le projet et permet l’édition des paramètres des objets
sélectionnés.
Pour afficher le gestionnaire d’objets, cliquez sur le bouton «Manager» dans la
barre d’outils puis sélectionnez «Objects» en bas de la fenêtre Manager.

Menu: Tools/Manager/Object Manager
Raccourci: Ctrl+Shift+O

Vous pouvez exporter les informations du gestionnaire d’objets sous forme d’un
fichier texte. Cliquez sur le bouton «Export text» dans la barre d’outils. Le bloc-
notes Windows s’ouvre avec un extrait venant de la liste du gestionnaire d’objets.
Les informations suivantes sont sauvegardées:
– Nom et chemin d’accès du projet
– Nom de piste et d’objet
– Position de début dans le projet
– Chemin d’accès au fichier source

Finalement, vous trouverez ce fichier dans votre dossier de projet
(nom_du_projet.txt).

Visualisation et sélection d’objet
Les objets sont affichés dans une arborescence et triés en fonction des pistes,
seules les pistes portant des objets étant listées. A titre d’option, vous pouvez
choisir de n’afficher que les objets de la piste active (Barre d’outils: «Options»).
Vous pouvez utiliser les boutons +/- de la barre d’outils pour afficher ou non les
objets de piste dans la totalité de la fenêtre. Cliquez sur le symbole «+» à gauche
du numéro de piste pour développer l’affichage d’une piste.
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Sélection des objets: une case à cocher carrée près du nom de l’objet vous
permet de sélectionner un ou plusieurs objets, qui apparaissent alors comme
«sélectionnés» dans la fenêtre de projet. Si un objet sélectionné fait partie d’un
groupe d’objet, les autres objets du groupe sont aussi sélectionnés dans la fenêtre
de projet et dans le gestionnaire d’objets. Vous pouvez identifier des objets
groupés par le numéro de groupe d’objets dans la colonne Group du gestionnaire
d’objets.

Recherche d’objets : comme dans les autres fenêtres de gestionnaires, le
gestionnaire d’objets dispose d’une option de recherche vous permettant de
rechercher des objets dans la fenêtre actuelle. Saisissez un critère de recherche
dans le champ de recherche et cliquez sur la touche «Entrée». Les objets trouvés
sont surlignés, mais pas sélectionnés dans la fenêtre de projet.

Suppression, changement de nom et édition d’objet
Vous pouvez directement supprimer des objets dans le gestionnaire d’objets en
sélectionnant un ou plusieurs objets simultanément et en pressant la touche
«Suppr». Sinon, vous pouvez supprimer un objet via son menu contextuel
(«Delete object»).
Vous pouvez renommer des objets en double-cliquant sur leur nom et en
saisissant le nouveau nom voulu. Sinon, vous pouvez utiliser leur menu
contextuel («Rename object»).
Faites un clic droit sur l’objet et lancez l’éditeur d’objet (Object Editor) pour
éditer un objet directement depuis le gestionnaire d’objets.

Edition des paramètres d’objet
Vous pouvez éditer les paramètres suivants dans le gestionnaire d’objets:
– Position de début (Start Position)
– Durée (Length)
– Fin (End)
– Volume
– Verrouillage (Lock)

Double-cliquez sur le paramètre correspondant pour l’éditer et saisissez une
nouvelle valeur. Les valeurs numériques peuvent être changées par cliquer-tirer,
auquel cas Ctrl+Shift permet des changements plus importants. La touche «Tab»
fait passer à la prochaine valeur éditable. Les touches «Flèche haut/bas»
permettent de naviguer verticalement dans une colonne si vous êtes dans une
colonne de texte.

Gestionnaire de pistes (Track Manager)
Introduction
Le gestionnaire de pistes affiche toutes les pistes du projet actuel et vous permet
de masquer les pistes en fenêtre de projet et de mixer tout en vous donnant un
accès direct au Solo, à la coupure (Mute), et à l’enregistrement (Record).
Pour afficher le gestionnaire de pistes, cliquez sur le bouton «Manager» dans la
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barre d’outils puis sélectionnez «Tracks» en bas de la fenêtre Manager.

Menu: Tools/Manager/Track Manager
Raccourci: Ctrl+Shift+S

Visualisation et sélection des pistes
Toutes les pistes du projet actuel sont affichées dans le gestionnaire de pistes.
Pour sélectionner une piste, double-cliquez sur son numéro. La piste est
sélectionnée dans la fenêtre de projet. Si la piste n’est pas à l’écran (hors de la
zone visible), la fenêtre de projet défile verticalement jusqu’à sa position.

Recherche de piste: comme dans les autres fenêtres de gestionnaires, le
gestionnaire de pistes dispose d’une option de recherche vous permettant de
rechercher des pistes dans la fenêtre actuelle. Saisissez un critère de recherche
dans le champ de recherche et cliquez sur la touche «Entrée». Les pistes trouvées
sont surlignées.

Changement de nom, suppression et collage de pistes
Vous pouvez supprimer des pistes dans le gestionnaire en sélectionnant une ou
plusieurs pistes et en pressant la touche «Suppr». Sinon, vous pouvez supprimer
une piste via son menu contextuel («Delete track»).
Vous pouvez renommer des pistes en double-cliquant sur leur nom et en
saisissant le nouveau nom voulu. Sinon, vous pouvez utiliser leur menu
contextuel («Rename track»). La touche «Tab» fait passer à la prochaine valeur
éditable. Les touches «Flèche haut/bas» permettent de naviguer verticalement
dans une colonne si vous êtes dans une colonne de texte.
Vous pouvez aussi insérer de nouvelles pistes directement dans le gestionnaire
de pistes. Faites un clic droit sur une ligne de piste et sélectionnez «Insert track»
dans le menu contextuel. Une nouvelle piste est ajoutée après la dernière piste
du projet.

Affichage et masquage des pistes
En plus des fonctions Solo, Mute et Record, vous pouvez aussi masquer des
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pistes. Pour masquer une piste en fenêtre de projet ou dans le mixer, décochez
la case «Arrangement» ou «Mixer» lui correspondant. Les pistes masquées
restent disponibles et sont toujours lues et éditées, même masquées.
Recochez la case pour réafficher la piste.

Gestionnaire de marqueurs (Marker Manager)
Le gestionnaire de marqueurs affiche tous les marqueurs du projet actuel, quel
que soit leur type. Cela permet un accès direct ou une prévisualisation depuis la
liste.
Pour afficher le gestionnaire de marqueurs, cliquez sur le bouton «Manager»
dans la barre d’outils puis sélectionnez «Markers» en bas de la fenêtre Manager.

Menu: Tools/Manager/Marker Manager
Raccourci: Ctrl+Shift+Alt+M

Vous pouvez exporter les informations du gestionnaire de marqueurs sous forme
d’un fichier texte. Cliquez sur le bouton «Export text» dans la barre d’outils. Le
bloc-notes Windows s’ouvre avec un extrait venant de la liste du gestionnaire de
marqueurs. Les informations suivantes sont sauvegardées:
– Nom du projet
– Type de marqueur
– Nom du marqueur
– Position du marqueur dans le projet

Finalement, vous trouverez ce fichier dans votre dossier de projet
(nom_du_projet.txt).

Visualisation et sélection de marqueur
Tous les marqueurs du projet actuel peuvent être affichés.

Filtre (Filter): un filtre de marqueurs optionnel vous permet de restreindre
l’affichage aux marqueurs des types sélectionnés. Sélectionnez tous les types de
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marqueur que vous désirez voir affichés en cochant chaque type de marqueur
dans le menu Filter puis cliquez sur le bouton Filter. Tous les types de marqueur
non cochés sont masqués.

Recherche de marqueurs: comme dans les autres fenêtres de gestionnaires, le
gestionnaire de marqueurs dispose d’une option de recherche vous permettant
de rechercher des marqueurs dans la fenêtre actuelle. Saisissez un critère de
recherche dans le champ de recherche et cliquez sur la touche «Entrée». Les
marqueurs trouvés sont surlignés.

Saut aux marqueurs et pré-écoute
Double-cliquez sur un marqueur dans la colonne Type pour placer le curseur
de lecture sur ce marqueur.

Lecture de marqueurs: sélectionnez un marqueur et cliquez sur le bouton de
lecture en boucle du marqueur («Play marker in a loop») dans la barre d’outils.
Une sélection entourant le marqueur sélectionné est créée et la lecture est lancée.

Suppression des marqueurs et changement des noms, positions et
types de marqueurs
Vous pouvez supprimer des marqueurs dans le gestionnaire de marqueurs

en sélectionnant un ou plusieurs marqueurs et en pressant la touche «Suppr».
Sinon, vous pouvez supprimer un marqueur («Delete markers») ou tous les
marqueurs («Delete all markers») via le menu contextuel («Delete Marker»).
Vous pouvez renommer des marqueurs en double-cliquant sur leur nom et en
saisissant le nouveau nom voulu. Sinon, vous pouvez utiliser leur menu
contextuel («Rename markers»). La procédure de changement directe de la
position d’un marqueur dans la liste est la même. La touche «Tab» fait passer à
la prochaine valeur éditable. Les touches «Flèche haut/bas» permettent de
naviguer verticalement dans une colonne si vous êtes dans une colonne de texte.

Astuce: Vous pouvez à tout moment changer le type dans le menu contextuel du
marqueur correspondant, par exemple pour transformer un marqueur de position
en marqueur de plage de CD (CD Track).

Gestionnaire de sélections (Range Manager)
Introduction
Le gestionnaire de sélections affiche toutes les sélections du projet actuel, quel
que soit leur type. Cela permet un accès direct aux positions de la liste ou une
lecture de l’emplacement sélectionné.
Pour afficher le gestionnaire de sélections, cliquez sur le bouton «Manager»
dans la barre d’outils puis sélectionnez «Ranges» en bas de la fenêtre Manager.

Menu: Tools/Manager/Range Manager
Raccourci: Ctrl+Shift+Alt+B
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Définition des sélections et options de recherche.
Définitions des sélections («Ranges»): pour sauvegarder une sélection dans
le gestionnaire, vous devez d’abord l’avoir définie dans la fenêtre de projet.
Ensuite, cliquez sur le bouton vert «Define new range» dans la barre d’outils du
gestionnaire de sélections.
Les sélections qui ont été sauvegardées par la fonction «Store Range» du
programme (Alt+F2, Alt+F3, etc.) apparaissent dans la liste avec des indicateurs
F2, F3, etc.
Recherche de sélections: comme dans les autres fenêtres de gestionnaires, le
gestionnaire de sélections dispose d’une option de recherche vous permettant
de rechercher des sélections dans la fenêtre actuelle. Saisissez un critère de
recherche dans le champ de recherche et cliquez sur la touche «Entrée». Les
sélections trouvées sont surlignées.

Edition des paramètres de sélection
Vous pouvez éditer les paramètres suivants dans le gestionnaire de sélections:
– Nom (Name)
– Début (Start)
– Durée (Length)
– Fin (End)

Pour éditer un paramètre, double-cliquez dessus et saisissez une nouvelle valeur.
Les valeurs numériques peuvent être changées par cliquer-tirer, auquel cas
Ctrl+Shift permet des changements plus importants. La touche «Tab» fait passer
à la prochaine valeur éditable. Les touches «Flèche haut/bas» permettent de
naviguer verticalement dans une colonne si vous êtes dans une colonne de texte.
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Présentation générale des effets
Dans Samplitude, les données audio peuvent être manipulées à cinq niveaux.
Dans ces niveaux, tous les effets disponibles peuvent être combinés entre eux.
L’ordre des effets peut être librement choisi dans la fenêtre de dialogue Effect-
Routing obtenue par le bouton FX de piste (avec certaines restrictions, voir la
section sur le routage d’effet). Notez aussi l’action éventuelle du changement de
l’ordre des effets.
1. Effets destructifs (menu Offline Effects). Les effets sont appliqués (figés)

directement sur une copie des données audio, permettant d’utiliser la fonction
d’annulation Undo. Vous pouvez ouvrir la boîte de dialogue des effets depuis
le menu Offline Effects.

2. Effets et manipulations effectués au niveau de chaque objet dans les projets
virtuels (traitement en temps réel), depuis l’éditeur d’objet.

4. Effets en temps réel sur les voies de la table de mixage (traitement en temps
réel). Chargez ces effets via le bouton FX des pistes de VIP ou des voies de la
table de mixage.

5. Effets en temps réel sur la section Master de la table de mixage (traitement en
temps réel). Chargez ces effets via le bouton FX des voies Master de la table
de mixage.

Les effets ne sont pas tous disponibles aux cinq niveaux de traitement du signal
audio. Il existe quelques limitations:

– Noise Reduction, Convolution, Remove DC Offset et De-clipping ne sont
disponibles que comme effets destructifs.

– Certaines commandes de manipulation d’échantillons (Sample data * et / 2,
Reverse, Change Sample rate, Build Physical Loop…) ne sont pas disponibles
en temps réel.

– Il n’y a pas de commande de menu spéciale pour un Fade-In/Out en temps
réel (contrairement à sa contrepartie destructive dans Offline effects -> sous-
menu Amplitude/normalize) car vous avez pour cela les poignées d’objet.

– Le Room Simulator n’est disponible dans sa version classique que comme
effet destructif

– Timestretching/Pitchshifting/Resampling n’est disponible que comme effet
destructif et comme effet d’objet.

– L’effet Delay n’est disponible que dans la piste.
– L’éditeur Elastic Audio, pour un travail poussé sur la courbe de

Timestretching/Pitchshifting, n’est disponible que comme effet d’objet dans
Samplitude Professional.

Sauvegarde des paramètres d’effets (Presets)
Les boîtes de dialogue des effets de Samplitude offrent un champ de sélection
de Preset (réglages préprogrammés). Ces presets sont sauvegardés et rappelés
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dans/depuis le dossier «FX-Preset» (sous-dossier de Samplitude).
Si aucune entrée n’apparaît dans ce répertoire, vous pouvez quand même
recharger une configuration en cliquant sur la touche «Load Setup». Dans ce
cas, la configuration rechargée n’est pas répertoriée dans la liste déroulante du
champ de sélection, aussi devrez-vous naviguer à sa recherche.
Les effets ajoutés/lancés depuis la table de mixage ou l’éditeur d’objets sont
préconfigurés sur les valeurs par défaut attribuées au projet VIP. Si vous désirez
attribuer au projet VIP les réglages effectués dans la boîte de dialogue de l’effet,
vous devez cliquer sur la touche OK pour les transférer au projet VIP.
Vous avez aussi la possibilité d’appliquer les réglages du dernier effet destructif,
une entrée correspondante se trouvant dans la case Options. S’il n’y a pas
d’application destructive de l’effet, les paramètres sélectionnés dans la liste
s’appliqueront aux paramètres par défaut pour l’édition destructive.

Effets en temps réel
Les effets en temps réel sont calculés au cours de la lecture audio depuis le
disque dur. Les effets sont appliqués au flux audio de façon non destructive, en
temps réel. Vos fichiers audio d’origine ne sont pas physiquement modifiés par
le traitement en temps réel. Vous pouvez modifier les paramètres d’effets en
temps réel. Les effets sont appliqués au nouveau fichier audio par report de
pistes du VIP (ou d’une partie de celui-ci). Les effets en temps réel peuvent
s’appliquer sur trois niveaux: éditeur d’objet, effets de piste et section de mixage
Master. C’est aussi leur ordre d’application.

Effets d’objet
Tous les effets d’objet peuvent être employés sur n’importe quel objet. Pour
cela, vous devez ouvrir la fenêtre Object Effects et sélectionner les effets.
Les effets d’objet ont certains avantages par rapport aux effets de piste.
1. Les effets gros consommateurs de ressources du processeur peuvent être
employés plus efficacement.
Exemple: En dehors de votre reverb principale, vous envisagez d’ajouter des
effets de reverb totalement différents sur les coups de caisse claire à titre
d’accentuation. Pour cela, vous devez fractionner la piste de caisse claire et
déplacer sur une piste différente les coups de caisse claire que vous désirez
éditer. Utilisée comme effet de piste, la seconde reverb est toujours incluse même
si elle n’est employée qu’un court moment. A la place, vous pouvez aussi isoler
les coups de caisse claire sur la première piste mais n’ajouter la reverb que
comme un effet d’objet.
2. Vous n’avez pas besoin d’autant de pistes. Plutôt que d’avoir une piste séparée
pour chaque effet ou réglage de correcteur (EQ) différent pour un instrument
en fonction des différentes parties de l’arrangement, vous appliquez des effets
d’objet et n’avez toujours qu’une piste par voix initialement enregistrée.
2. Tous les réglages sont conservés quand vous déplacez ou copiez un objet.
3. Tous les réglages d’effet de l’objet (tous les réglages des effets simples dont
ceux de tous les plug-ins Direct X / VST) peuvent être copiés et collés dans un
autre objet.
Exemple: pour créer le fameux effet de «doublage» sur une piste de caisse claire
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(donnant une quantité de reverb énorme seulement sur les coups de caisse claire),
découpez la piste de caisse claire au niveau des coups concernés. Puis chargez
le simulateur de pièce ou «Room Simulator» (ou un plug-in approprié dans le
cas de la version classique de Samplitude) sur un objet caisse claire et réglez-le
selon vos besoins. Chargez le preset de routage d’effet «RoomSim Post Fades»
avec FX Routing quand votre «objet caisse claire» a un fondu sortant pour vous
garantir que la reverb restera présente au mixage au-delà de la fin de l’objet.
Puis pressez le bouton de copie dans cette fenêtre de dialogue ou dans l’éditeur
d’objet. Vous pouvez maintenant coller cette «pêche de reverb» sur tous les
coups de caisse claire que vous désirez traiter. Vous pouvez même faire
légèrement varier les réglages de reverb pour chaque objet.

Importance de l’ordre de traitement des effets et de la
manipulation du signal
La séquence des traitements d’effet et des autres manipulations (automation du
volume et du panoramique) affecte souvent le résultat. Certains effets dépendent
du niveau du signal entrant.
Toutes les fonctions dynamiques («Dynamics») et celles qui suppriment ou
réduisent le bruit (De-hisser et Noise Reduction) dépendent du niveau du signal
entrant et, dans certains cas, de la réponse en fréquence du signal entrant. Si
vous avez trouvé un réglage optimal pour les paramètres, vous ne devez pas
appliquer de changements aux blocs d’effet qui précèdent ces types d’effets. Par
exemple, utilisez les sections Dehisser et Multi-band Dynamics dans le mixage
Master seulement après que tous les changements aient été appliqués
individuellement aux objets et voies de la table de mixage.
Il est donc important de comprendre le chemin du signal dans Samplitude.
Vous pouvez le changer dans la fenêtre de dialogue FX routing.

Routage des effets (FX Routing)
Pour changer l’ordre des plug-ins natifs FX et DirectX, cliquez sur le bouton FX
dans l’en-tête de piste de la fenêtre VIP ou en bas de l’écran de la table de mixage
(pistes et master de la table de mixage). Cela ouvrira la fenêtre de dialogue Effect
Routing. (le reclassement individuel des plug-ins DirectX/VST est contrôlé via
un bouton Plug-in séparé)
Les décisions d’insérer/réordonner les effets doivent être soigneusement pesées,
particulièrement pour employer les options de traitement dynamique
(Dynamics), de traitement à base FFT (Filter et Dehisser) et Pre/Post.
Tant que vous resterez conscient des conséquences spécifiques des changements
apportés à l’ordre des effets, vous ne devriez pas avoir beaucoup de problèmes.
A titre de conseil général, il est toujours préférable de réduire le volume d’écoute
avant de changer le routage de câblage. Cela évitera qu’un volume excessif
déclenché par un compresseur à l’aspect innocent ne ravage vos tweeters! (c’est
essentiel dans un environnement à équipements «physiques», aussi est-ce une
bonne habitude à prendre.)
Vous pouvez apporter tous les changements nécessaires à vos réglages d’effets
en temps réel dans la fenêtre de dialogue FX. L’apparence de la fenêtre de dialogue
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changera légèrement, selon qu’elle sera lancée depuis l’éditeur d’objet, une piste
ou le Master de la table de mixage, avec certains éléments désactivés/ajoutés.
L’ordre de tous les effets est librement configurable. Le terme «Effets» ne se
réfèrent pas seulement aux effets ayant un dialogue de réglage (par ex. Dynamics
ou EQ), mais aussi au fader de volume et de gain, et aux départs Aux. Certaines
entrées sont grisées, et n’apparaissent dans la liste que pour permettre un
réarrangement de l’ordre des effets.

En page d’effets de piste (FX), il y a deux entrées de départ Aux (AUX Send (pre
et post), vous apportant une souplesse de routage maximale. Dans le dialogue
des réglages Aux, vous pouvez choisir pré ou post, avec l’entrée correspondante
dans la chaîne du signal utilisée pour «dériver» le signal Aux vers le bus Aux
correspondant. Vous avez peut être constaté que la gestion des Aux est bien
plus souple que celle d’une console physique, car vous pouvez placer les deux
départs Aux n’importe où dans la chaîne du signal. Cela vous permet de placer
le départ AUX (pré) avant le fader de volume (comme à l’ordinaire), mais après
le correcteur (pas si courant)!
Vous avez aussi deux entrées DirectX/VST, vous permettant de placer des plug-
ins aux points pré et post. L’ordre de ces effets est défini par leurs positions
relatives dans la fenêtre d’enchaînement des Plug-ins.

Options
Use Advanced Dynamics for Mixer Dyn./Limiter: Dans la piste Master, le
processeur dynamique/limiteur s’obtient avec «Advanced Dynamics» plutôt
qu’avec le limiteur «Dynamics» normal.
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All Tracks: Le réglage s’appliquera à toutes les pistes (effet de piste seulement)

Cases à cocher FX: Chaque effet peut être individuellement désactivé, en
décochant la case qui lui est associée. Dans la liste des effets FX, vous avez la
possibilité de supprimer un effet insérer grâce au bouton «Remove». Cela
économise de la RAM, car l’effet est déchargé de la mémoire. Un effet disponible
mais actuellement déchargé est indiqué part un tiret horizontal dans sa case à
cocher.

Edit: Ce bouton ouvre le dialogue de réglage de l’effet actuellement sélectionné
(s’il y en a un)

Boutons Copier/Coller: Vous pouvez rapidement copier un réglage d’effet
complet (avec tous les réglages intégrés et ceux de plug-in DirectX) dans un
autre objet/piste.

Liste des effets: La liste de tous les éléments d’effet/voie est affichée selon
l’ordre de traitement, de haut en bas.

Reset: Réinitialise tous les effets (les désactive)

On/Off: Court-circuite l’effet sélectionné («bypass»). Les effets actifs sont cochés.

Remove: Supprime l’effet sélectionné de la mémoire, économisant ainsi la RAM
du système (éditeur d’objet seulement). Les effets ainsi déchargés sont marqués
d’un tiret horizontal dans leur case à cocher.

Sélecteur de périphérique d’entrée «Input» (pistes seulement): C’est le
même réglage qu’en en-tête de piste.

Sélecteur de périphérique de sortie «Output» ou de bus de prémixage

(pistes seulement): C’est le même réglage qu’en en-tête de piste ou en fenêtre
de dialogue Play Parameter (Master)

Flèches de déplacement: Déplacez une entrée de la liste vers le haut ou le bas
avec les boutons flèches pour changer l’ordre de traitement des effets.

Copier/Coller: Vous pouvez rapidement transférer un réglage de routage d’une
piste à l’autre par copier/coller. Si la piste présente un routage (ordre des effets)
différent, il sera adapté au nouveau réglage d’effet (puisque la position de routage
est mémorisée avec les réglages d’effets).

Reset (Effect Order): Ramène le routage des effets à l’ordre de traitement par
défaut.
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Load/Save/Select (Routing Preset): Vous pouvez sauvegarder (Save)/charger
(Load) vos routages personnels. Plusieurs presets sont fournis, dont ceux de
versions antérieures de Samplitude pour la compatibilité. Il va sans dire que le
routage actuel sera adapté si vous chargez un projet plus ancien.
Certains autres presets servent aux cas apparaissant souvent.

Exemple: Si le plug-in Reverb/Echo Post Fades est inséré comme plug-in dans les
effets Echo ou Hall d’un objet, généralement, vous désirerez que ces effets
s’appliquent à la fin de l’objet. Si l’objet a un fondu de sortie (comme c’est
quasiment toujours le cas quand «Autocrossfade» est employé), la reverb se
mélangera totalement. C’est pourquoi le volume Preset vient avant le plug-in dans
la chaîne d’effets par défaut. L’équivalent est le preset «RoomSim Post Fades»
quand vous employez le simulateur de pièce («Room simulator»).

Différences entre les dialogues Effect Routing (FX) dans l’éditeur
d’objet, dans la piste et dans le Master
– Dans les routages d’effet pour un objet et pour une piste se trouve un choix

spécial nommé «FX Inserts». Les effets natifs plus complexes de Samplitude
y sont regroupés et vous ne pouvez pas changer les positions des éléments de
ce groupe les unes par rapport aux autres. Néanmoins, vous pouvez changer
la position du choix «FX Inserts».

– Dans l’éditeur d’objet, il n’y a qu’un seul départ AUX (post) et un seul choix
de plug-in (pre). Il n’y a pas de routage In/Out de périphérique.

Effets destructifs (menu Offline Effects)
Ces traitements modifient irrémédiablement les données audio (techniquement,
c’une copie de l’original qui est modifiée, mais l’édition modifie physiquement
les données sous-jacentes de la copie).
Les traitements destructifs font en général partie des premiers traitements à
appliquer. Les opérations destructives visant à modifier le niveau d’un signal
doivent donc toujours être effectuées avant de procéder aux effets en temps réel
et aux traitements dynamiques.
Sur les projets 16 bits, toute perte de qualité découlant des manipulations de
réduction de niveau est irrémédiable. Soyez donc très prudent lorsque vous
travaillez sur des fichiers 16 bits !
Les effets sont appliqués (figés) directement sur une copie des données audio,
ce qui permet d’utiliser la fonction d’annulation Undo si le résultat n’est pas
celui escompté. Les effets s’appliquent depuis leur boîte de dialogue accessible
via le menu Offline Effects.
Les effets destructifs peuvent être appliqués de deux manières différentes.
Vous pouvez passer sur la fenêtre du projet Wave par clic droit sur l’objet
correspondant et en sélectionnant «Wave Editing». Dans la fenêtre du projet
Wave qui apparaît, une sélection est délimitée. Elle correspond à la partie du
fichier Wav à laquelle l’objet fait référence. L’effet que vous sélectionnez dans le
menu Effects est appliqué à cette sélection.
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Vous obtiendrez plus d’informations sur les modes d’édition d’onde dans la
section «Edition d’onde». Certaines fonctions fonctionnent uniquement
lorsqu’une sélection est délimitée. Si aucune sélection n’est délimitée, aucune
édition ne peut être appliquée. Pour éditer toutes les données du fichier audio,
vous devez délimiter une sélection de l’ensemble des données (pressez «A»
pour tout sélectionner).
La méthode la plus rapide consiste à sélectionner l’objet et à appliquer l’effet
souhaité directement sur l’objet. La plupart des fonctions du menu Offline Effects
peuvent être appliquées directement sur les objets VIP. Le menu Offline Effects
s’obtient aussi par clic droit sur l’objet. Dans le menu qui s’ouvre alors,
sélectionnez le sous-menu Effects (destructive) puis le processus désiré.
Les effets affectent la totalité des données des objets sélectionnés, quelle que
soit la sélection courante délimitée dans le projet virtuel (Exception : la fonction
Get Noise Sample).
Pour ne pas modifier toutes les données d’un objet, il faut d’abord le découper
(délimitez une sélection de la longueur souhaitée et appuyez sur la touche «T»).
Nous vous conseillons d’activer le mode Crossfade Automatique (menu Edit >
Auto Crossfade) afin d’obtenir des transitions douces entre objets, exemptes de
pops.
Il est même possible d’appliquer un effet à plusieurs objets sélectionnés. Dès
lors que plusieurs objets sont sélectionnés dans le VIP, l’effet choisi est appliqué
à chacun des objets sélectionnés et aux données audio du/des fichiers(s) audio
physique(s) auxquels ils font référence.

Annulation (Undo)
Quelle que soit la méthode que vous avez choisi d’employer, plusieurs étapes
d’annulation vous sont offertes, si les choses tournent mal. Le nombre
d’annulations possibles est défini dans les réglages Options > Program
Preferences > Undo Definitions. L’annulation Undo vous donne la liberté de
librement expérimenter différents réglages d’effets. Pour une sécurité maximale
(en cas de coupure de courant durant le traitement d’effet), vous pouvez travailler
sur une copie des données audio, rapidement obtenue à partir de la sélection
effectuée en choisissant Edit > more.... > Copy as.... Cela sauvegardera la sélection
comme un nouveau fichier.

Important: L’annulation du traitement d’effet nécessite que l’option de création de
copie (Create Copy) soit activée dans la fenêtre de dialogue d’effet Effects. (si cette
option n’est pas offerte, c’est qu’elle est activée et ne peut pas être désactivée).

Désactivez cette option uniquement si vous souhaitez économiser de l’espace
disque et du temps lorsque vous travaillez sur de très gros fichiers. Attention, si
vous désactivez cette option, vous devez impérativement être sûr de ce que vous
faites!

Des informations détaillées sur l’emploi de plusieurs effets de Samplitude se trouvent
dans la section de référence sur les menus, menu Effects!
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Suite de modélisation analogique: am|track (Samplitude
Professional seulement)

Modélisation analogique de compresseur et de simulateur de bande
am|track
am|track est un compresseur analogique et un simulateur de bande combinés
en une unité. Son application est prévue en traitement individuel du signal
d’une voie ou d’un sous-groupe.
Dans la section suivante, nous expliquerons d’abord la section compresseur
d’am|track, ses particularités par rapport à une compression logicielle
«conventionnelle» et ses paramètres. Nous poursuivrons ensuite avec le
simulateur de bande («Tape simulator»).

Section Compresseur
Deux compresseurs complètement différents fonctionnent dans am|track. Les
deux ont des réglages et des performances sonores indépendantes.
Vous pouvez vous demander pourquoi nous parlons de «son» avec un
compresseur alors que nous ne traitons «que» d’un processus de régulation.
Toutefois, la mise en œuvre de la théorie «fort devient faible» n’est
malheureusement (ou heureusement) pas si facile.
De nombreux algorithmes, conceptions et topologies différents ont été dérivés
de l’histoire du traitement analogique et numérique du signal pour résoudre le
vrai «problème»: la réduction de plage dynamique. Toutes les conceptions ont
un caractère autonome. Le pré-filtrage dans le circuit de détection et la méthode
de détection influencent grandement les résultats sonores. De nombreux
compresseurs ont les mêmes VCA (Voltage-Controlled Amplifiers ou
«amplificateurs contrôlés par tension») consacrés, et pourtant ils sonnent tous
différemment en raison de la façon dont ils sont contrôlés et de la façon dont ils
caractérisent un signal, une production entière ou même un genre avec leur
«son propre». Nous considérons que notre but est de vous fournir un certain
son dans le monde numérique au moyen de nos processeurs dynamiques.
Deux modes de fonctionnement d’am|track peuvent être sélectionnés à l’aide
du commutateur «Mode» («VCA/Vintage»):
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Mode VCA

En mode VCA, la sélection de paramètre correspond à la configuration de câblage
d’un compresseur moderne avec un VCA comme circuit de contrôle et une
conception prédictive en section détecteur, c’est-à-dire que le signal de contrôle
pour la réduction de niveau est tiré du signal entrant. Le son basique typique de
ce genre: précis, essentiellement neutre et prévisible en relation avec les
paramètres réglables.
En mode VCA, le signal de contrôle est tiré de l’entrée, mais passe d’abord au
travers d’un filtre passe-haut réglable (réglable dans le panneau via «detector hp
freq» en mode expert). Le filtre permet que les signaux de basse fréquence aient
moins d’influence sur la régulation. L’emploi de la batterie dans un sous-groupe,
par exemple, est une astuce commune pour un meilleur impact.
Le signal filtré arrive finalement au détecteur. Les paramètres réglés sont
directement appliqués et affectent la régulation due aux méthodes de détection
prédictive du mode VCA. A l’opposé de cela, il existe une topologie de conception
à contre-réaction ou «feedback», qui est offerte par le second mode de
compresseur.

Mode VINTAGE
Ce mode est le statut initial au démarrage d’am|track. Il a moins d’options que
le mode VCA et sonne de façon moins «chirurgicale», mais est plus orienté vers
le caractère du son.
Le mode «Vintage» simule une conception de circuit datant de l’époque où les
VCA ne pouvaient pas être employés ou seulement de façon insuffisante. Un
transistor à effet de champ (FET) était souvent employé à la place comme
résistance variable. Associé à une résistance fixe dans le circuit d’entrée, il formait
ce que l’on nomme un réducteur de tension, c’est-à-dire un changement de la
résistance du FET causée par un changement de tension sur sa broche dite
«gate», ce qui entraînait une atténuation du signal entrant. Un circuit de détection
assez simple servait à piloter le FET; toutefois, il recevait son signal de la sortie
du compresseur (c’est-à-dire après la totalité du circuit de contrôle). Cette boucle
de réinjection assurait dans les conceptions de l’époque la stabilisation des
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paramètres de travail et c’est un des facteurs essentiels des compressions souvent
qualifiées de douces et «musicales» des représentants de ce type de conception,
comme les Urei 1176 ou 1178. Le véritable «désavantage» – les paramètres
temporels réglés (attaque, relâchement) ne sont pas indépendants du signal
entrant – peut même être un avantage dans certaines applications, par exemple
pour les voix, la basse et même la batterie (par ex. des sous-groupes, des
microphones d’ambiance). Dans ce cas, vous devez simplement faire confiance
à votre oreille.

En raison de la régulation de réinjection, la réduction de niveau anticipée est
habituellement d’environ 20dB max., généralement moins, par exemple, que
celle d’appareils à VCA avec détection prédictive. Une boucle de réinjection
nécessite donc quasiment toujours un amplificateur de compensation. La
commande «Drive» de l’am|track régule dans ce cas l’amplification de réinjection.
Cela peut amener si haut qu’avec un signal d’entrée fort, le détecteur peut saturer
et les crêtes de signal «disparaître». En même temps, la régulation devient plus
«intense», car les signaux plus faibles atteignent maintenant le niveau seuil.
Selon l’application, vous pouvez employer cela de façon créative et produire
une compression complexe du signal, qui ne sonne pas «figée» en raison des
transitoires qui passent au travers.
En raison du comportement non linéaire d’un FET, le niveau de réduction n’est
pas non plus linéaire. Dans une représentation graphique de rapport entrée/
sortie, la courbe n’aurait pas de «plateau» pour de forts rapports de compression
comme c’est habituellement le cas, le signal est postérieurement bien plus
«relâché». Les crêtes du signal peuvent par conséquent aussi passer au travers,
mais le niveau moyen du signal peut éprouver une forte compression. D’un
point de vue technique, la régulation peut sembler imparfaite mais, selon
l’application, le son va d’une sensation «aérienne « à un rendu «funky». Dans le
circuit virtuel de l’am|track, la régulation dépend aussi de la fréquence. Les aigus
sont moins compressés, pour que même des réglages extrêmes n’aient pas un
son plat et sans vie.
Nous avons aussi appliqué le même processus à la zone des graves. Dans des
conditions d’écoute correctes, vous pouvez remarquer que le signal a toujours
de la «puissance» ave cde forts taux de compression, puissance qui serait sinon
perdue en raison d’un suivi plus rapide de la courbe d’enveloppe.
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Paramètres de compression
Mode VCA
Dans ce mode, vous avez un jeu «ordinaire» de paramètres de compression
dynamique:
– «Threshold»: C’est le seuil d’activation du compresseur au dessus duquel

la réduction de dynamique commence. Si nécessaire, utilisez l’indicateur de
niveau seuil. Si le signal entrant atteint le seuil fixé, une ligne rouge centrée
s’affiche. Si la ligne monte (et est perdue de vue), votre valeur seuil est en
dessous du niveau moyen. A l’opposé, la ligne tend à descendre dès que le
signal entrant est trop faible pour atteindre la valeur seuil.

– «Ratio»: C’est le taux ou «rapport» (1:n) de réduction du signal quand celui-
ci atteint la valeur seuil. Exemple: Réglez «threshold» sur -20dB et «ratio»
sur 1:4.: Un signal entrant de -10dB est ramené à 2,5dB (10dB: 4 = 2.5dB)

– «Attack»: C’est le temps de réaction, c’est-à-dire le temps nécessaire à la
régulation pour accomplir la réduction de niveau nécessaire. Des temps courts
permettent d’intercepter les crêtes de niveau; des temps plus longs les laissent
passer sans entraves (la compression peut s’appliquer à ce qui vient «ensuite»).

– «Release»: C’est le temps que met le circuit pour revenir à un facteur
d’amplification normal.

Notes sur Attack et Release: généralement, des temps courts de réaction et de retour à
la normale sont employés pour une compression modérée et pour diminuer le volume
de l’attaque. Des temps plus longs conviennent mieux pour conserver «l’esprit» d’un
instrument pour de forts taux de compression ou pour rendre le son «crunchy». Pour
des signaux sources difficiles comme une piste de voix très dynamique (par ex. dans
une ballade), une solution consiste à travailler avec une attaque plus longue pour que
le processus de régulation soit plus progressif et plus calme. Dans ce cas, le temps de
retour à la normale doit être ajusté en écoutant les breaks ou en suivant le tempo du
morceau.
Vous pouvez employer un retour à la normal plus court pour des voix plus modernes,
agressives, «mises en avant» où les bruits de respiration font partie intégrante du style
et où la voix doit sonner de façon très alerte et compacte.

– «Knee»: Ce paramètre vous permet de déterminer la forme de la courbe dans
la zone de transition entourant le seuil. Une transition ou «articulation» brutale
(«hard knee») signifie que le passage du taux d’amplification 1:1 à la réduction
de niveau s’effectue de façon brutale, et une articulation douce («soft knee»)
que la transition se fait avec démarrage sous la valeur seuil, le signal étant
progressivement «conduit» à la réduction. Un réglage brutal est idéal pour
une compression audible avec un effet riche comme sur des pistes
individuelles de batterie. Vous devez envisager un réglage plus doux pour
des sources complexes et sensibles comme des guitares, pianos ou voix. Plus
le signal est difficile, plus facilement une différence se repèrera. Ce paramètre
peut être moins important pour les signaux plus faciles à gérer. Veuillez noter
que vous pouvez avoir à re-régler la valeur de seuil (Threshold) pour des
réglages de transition douce («soft knee»), puisque la compression entre alors
en jeu pour des niveaux plus bas.
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Mode Vintage
Ce mode est destiné à changer les réglages «à l’oreille». Tout ce que vous aimez
est permis…c’est pourquoi vous ne trouverez ici que les «bases essentielles»:
– «Drive: comme expliqué ci-dessous, son usage principal est l’ajustement du

facteur d’amplification de la boucle de réinjection, c’est-à-dire du niveau du
signal employé par le circuit de détection pour le traitement. De plus, le taux
ou «ratio» interne se modifie ici: plus élevée est la valeur «drive», plus élevé
est le taux de compression.

– «Attack» et «Release»: généralement, tout s’applique ici comme en mode
VCA. Toutefois, vous changez non seulement l’enveloppe d’attaque et de
relâchement du processus de réduction de gain mais également la «fenêtre
de temps» dans le détecteur. La méthode d’ajustement de la réinjection
entraîne aussi une certaine «imprévisibilité». Dans ce mode, vous ne pouvez
pas espérer autant de contrôle sur la machine, en contrepartie de quoi il sera
plus indulgent avec vous.

Réglages de compression «Expert»
Bien sûr, vous pouvez compresser avec am|track sans jamais presser le bouton
«Expert» et sans avoir testé ses possibilités supplémentaires. Nous avons masqué
derrière la plaque avant quelques paramètres «délicats» destinés à un emploi
spécifique. Ceux-ci s’appliquent aux deux modes de compression.

– «Look ahead»: am|track analyse le signal à l’avance. Cette option sert à régler
le temps (en millisecondes) durant lequel vous voulez que le processus
réunisse à l’avance les informations du signal. Le routage du signal audio est
retardé du temps choisi ici, pour que le circuit de détection reçoive le signal
entrant en premier (retard de prédiction). Vous pouvez maintenant augmenter
le temps de réaction (Attack) tout en interceptant les crêtes rapides. La
compensation de latence de Samplitude assure que le timing des autres pistes
de l’arrangement est ajusté pour qu’il n’y ait normalement pas de retards. Si
vous désirez des résultats percussifs, vifs avec une faible complexité, vous
pouvez même régler le retard à  0.
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– «Detector Hp Filter»: ce filtre coupe-bas est situé avant le circuit de détection

des deux compresseurs. Vous pouvez l’employer pour spécifiquement exclure
les sons de graves et de médiums des réglages. Les signaux complexes
contenant des informations de graves et de médiums comme ceux d’un sous-
groupe ou d’un mixage complet sont moins enclins à produire des artéfacts
comme l’effet de «pompage» que des signaux riches en extrêmes graves. Les
graves contiennent la majeure partie de l’énergie du programme audio et
déclencheraient donc continuellement le processus de réduction de gain,
entraînant une modulation désagréable de la totalité du spectre de fréquences.

– «Auto Makeup Gain»: en général, vous devriez avoir à re-régler le niveau de
sortie pour compenser la perte de volume générale occasionnée par le
processus de compression. Ce travail s’effectue automatiquement si «Auto
Makeup» est activé. Le décalage du volume est calculé à l’aide des paramètres
réglés et s’applique comme facteur initial après la régulation globale.
Désactivez cette fonction si vous préférez à la place une réduction de niveau
«classique» et si vous désirez ajuster manuellement l’amplification.

– «Adaptive Release»: effectivement, nous n’avons pas mentionné dans la
section sur les «réglages de paramètres de relâchement ou retour à la normale»
que vous pouviez rendre les choses encore plus simples en laissant le logiciel
régler le temps de retour à la normale en fonction du programme audio. Le
relâchement adaptatif («Adaptive release») est «semi-automatique»: réglez
grossièrement le temps de retour à la normale et, en fonction de la «puissance
du signal actuel», le temps de relâchement variera de «légèrement plus long»
à «considérablement plus long». Cette régulation est particulièrement intense
en «Mode Vintage» car elle affecte les processus dans la boucle de réinjection.
Par exemple, lors du traitement de pistes vocales ou de matériel dense et
complexe, la régulation peut sonner de façon plus calme et plus musicale
quand «adaptive release» est activé.

– «A.R. Capacity»: Tourner la commande «A.R. Capacity» détermine le temps
de réponse du relâchement adaptatif («adaptive release»). Avec un réglage
plus élevé, l’adaptation du relâchement devient plus lente. Vous pouvez vous
en servir pour influencer la réponse du relâchement d’une sélection ultérieure.
Si, par exemple, vous voulez traiter des voix pour qu’elles sonnent comme si
elles étaient placées «sur le devant», vous pouvez employer un temps de retour
à la normale (relâchement ou «Release») court (peut-être 80-100 ms) et
augmenter le réglage semi-automatique (par ex. 80). A l’opposé, vous pouvez
réduire le suivi automatique en échangeant les taux (faible capacité, temps de
relâchement généralement plus élevé).

– «Mix Direct/Comp»: La compression parallèle est une astuce populaire en
studio, particulièrement pour les matériaux audio complexes. Le but du mixage
dans les signaux d’origine est de conserver la balance spectrale et les
transitoires de la source, tout en pouvant ajouter la «compression» en tournant
sur la droite la commande de mixage. Un signal «mixé» sonne souvent de
façon moins fermée, moins «compacte» et plus transparente, la portion
«compressée» pouvant souvent être moins intense qu’en absence de mixage
du son d’origine.



108

Effets et Plug-ins d’effet
Section Tape
La simulation de bande («Tape») d’am|track se situe après la section de
compression et vous offre l’opportunité de donner à vos enregistrements une
«touche analogique» en reproduisant les aspects typiques d’un enregistrement
sur bande. Aujourd’hui, de nombreux studios utilisent toujours des
magnétophones 1 et 2 pouces reconnus pour leur «sonorité», leur «chaleur» et
leur «satiété», par opposition  à la technologie numérique neutre et analytique.
Il existe de nombreux facteurs essentiels à l’impression sonore causée par des
enregistrements sur bande. Parmi ceux-ci:
a) Les distorsions qui se produisent quand la bande est amenée dans sa plage de

saturation.
b) La réponse en fréquence obtenue, car plusieurs étages de filtrage traitent le

signal durant l’enregistrement et la lecture (la fameuse courbe de réponse
pré- et post-correcteur). La réponse en fréquence d’une machine typique révèle
des crêtes plus ou moins caractéristiques – particulièrement dans le bas du
spectre – qui dépendent de la vitesse de bande et de la distance entre les têtes
d’enregistrement et de lecture.

c) Les harmoniques complexes résultant de la combinaison de a) et b).
d) Les effets de perte (principalement dans les aigus) dus à l’auto-effacement du

courant HF («polarisation», pré-magnétisation) et à l’inter-modulation entre
le signal audio et le courant HF.

e) Les artéfacts supplémentaires qui se produisent durant l’emploi, comme:
– Accentuation de l’effet de «bosse» dans les graves dû à l’usure de la tête.
– Harmoniques paires supplémentaires dues à la magnétisation permanente

de la tête résultant des débris de particules et du passage normal de la bande.
– Changement de la structure harmonique due aux modifications des

paramètres de fonctionnement, par ex. en cas de changement de type de
bande (-> boucle d’hystérèse altérée, courbe de rémanence).

En ce qui concerne la simulation de ces processus, nous nous sommes concentrés
sur certains aspects du «monde réel» et avons créé une «machine» virtuelle
dans l’am|track, qui permet les interventions suivantes à l’aide des commandes
de l’interface:
– «Level»: Règle le niveau d’entrée. Vous déterminez quand la «bande» est

saturée et quelle est l’intensité de l’effet de coloration. Vous gagnez en même
temps plus de force ou «loudness».

– «EQ Low/Hi»: Ajuste la réponse en fréquence (commande de balance
spectrale). Vous pouvez choisir d’avoir un signal de sortie à haut niveau de
basses ou avec plus d’aigus. Cela modifie la préaccentuation du «côté
enregistrement» ainsi que la correction ou «égalisation» de lecture. En mode
«Expert», vous pouvez faire varier les fréquences employées dans les graves
et dans les aigus pour la distorsion et l’égalisation. Toutefois, veuillez noter
que la réponse en fréquence de la simulation ne sera pas neutre même si la
commande «EQ Low/Hi» est réglée au point neutre. Il y aura toujours une
légère amplification sélective de fréquences, mais cela doit être considéré
comme le «son» d’une machine.

– «Bias»: Augmenter ce «Bias» (polarisation) donne un «niveau
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d’enregistrement» plus élevé, mais la saturation de bande arrive alors plus
tôt. Vous augmenterez aussi les effets de perte mentionnés ci-dessus, et le
résultat sera une réduction (dynamique) des aigus. Tourner la commande
Bias vers la gauche donne l’effet opposé. Les aigus ne sont pas réduits, mais
le niveau du signal reste plus bas. La «courbe d’hystérèse virtuelle» est
simultanément décalée, ce qui entraîne la création d’harmoniques paires. La
courbe de réponse du volume est maintenant légèrement asymétrique, ce
qui pourrait signifier que notre «machine« n’est pas correctement calibrée et
que de la rémanence a été appliquée à la tête d’enregistrement/lecture, causant
un effet de «vieillissement » au son. C’est à votre oreille de choisir vos réglages
préférés pour chaque cas spécifique.

Astuces d’emploi de la simulation de bande:
Les harmoniques générées durant la saturation peuvent rapidement conduire à
une «fatigue acoustique» de l’auditeur, particulièrement sur du matériel audio
riche en hautes fréquences, et/ou à un décalage de fréquence au bénéfice des
aigus. En comparant directement avec le son quand la section Tape est désactivée,
les différences peuvent être plus facilement plus facilement. Des réglages subtils
sont généralement suffisants pour obtenir une «touche analogique» avec les
signaux complexes.
Utilisez la simulation de bande comme un «bloqueur de crête» si vous employez
un des deux compresseurs pour  compresser les signaux: les transitoires que le
compresseur laisse passer (par ex. si le temps de réaction ou «Attack» est long)
peuvent être délicatement bloquée par simulation ultérieure de couchage du
signal sur «bande».

Suite de modélisation analogique: am|pulse (Samplitude
Professional seulement)

am|pulse est un «modéliseur de transitoires»; un outil créatif pour l’édition
directe de l’enveloppe de signaux percussifs ou dynamiques. En faisant cela,
l’effet vous offre d’autres possibilités de «polir» votre signal ou de l’aliéner
considérablement. Ainsi, l’outil fonctionne principalement d’une manière «non
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numérique» en accord avec son origine de «modélisation analogique». Nous
avons configuré les modules individuels comme des «circuits virtuels», à partir
d’éléments de modèles et de composants que nous avons empruntés au «monde
analogique». Le but est un type de contrôle harmonique et un son original.
Les sélections sur lesquelles on peut appliquer am|pulse sont:
– Des pistes d’instruments de batterie (par ex. grosse caisse, caisse claire ou

toms) ou une piste de batterie complète (par ex. un signal de sous-groupe);
augmentation ou diminution de «l’attaque» (choisissez entre un son vif ou
un son doux), amplification ou réduction de l’ambiance («sustain» sur les
pistes de micros overhead ou d’ambiance).

– Guitare ou basse acoustique et électrique (accentuation ou atténuation de la
réactivité, par ex. jeu avec un médiator).

– Egalisation des fluctuations de volume et des plosives dans un enregistrement
vocal ou réduction du bruit de fond.

Caractéristiques opérationnelles de la section des transitoires
(Transients)
A première vue, on pourrait croire qu’un compresseur dynamique travaille «en
sous-main». Ce n’est toutefois pas le cas. Par rapport aux compresseurs
conventionnels, am|pulse est indépendant du niveau. Si, par exemple, vous
réduisez l’attaque d’une caisse claire de 6 dB, c’est indépendant de la force avec
laquelle elle a été jouée. Toutefois, vous devez déterminer un seuil comme pour
un compresseur. Le signal n’est pas modifié sous le seuil, mais augmente quand
«l’écart» par rapport au signal augmente.
Les possibilités d’emploi d’am|pulse mentionnées sont basées sur le principe
de la «reconnaissance de transitoires». am|pulse analyse continuellement le
signal entrant au moyen de ce que l’on appelle des «suiveurs d’enveloppe» qui
tracent le signal en fonction du temps. Plusieurs suiveurs d’enveloppe sont
employés dans les sections Attack et Sustain. Toutes deux ont des durées
d’attaque et de chute différentes. L’attaque et le sustain peuvent être efficacement
reconnus grâce à des mesures comparatives continues.
En interne, am|pulse utilise des VCA virtuels (Voltage Controlled Amplifiers ou
«amplificateurs contrôlés par tension») qui génèrent une tension de commande
à partir des enveloppes obtenues. Vous pouvez employer le fader pour appliquer
sa valeur à l’attaque et à la chute ou «decay». Cela vous permet de «multiplier»
le signal entrant par la tension de commande (monter la commander) ou de
«diviser» le signal par cette tension (baisser la commande).
Seuls des signaux dynamiques conviennent à l’édition en raison de la
reconnaissance des transitoires. Un signal entrant plus percussif donne un
fonctionnement plus net et plus prévisible.

Paramètres de la section des transitoires (Transients)
Trois faders se trouvent sur la façade pour traiter l’attaque et le sustain:
– «Level» (canal gauche): le niveau est monté au dessus de la ligne; déplacer

le fader dans la direction opposée réduit le niveau. En position centrale, le
signal reste intact.
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– «Level» (canal droit): comme ci-dessus. Les deux faders de canal sont par

défaut couplés (comme le sont les «détecteurs» internes). Vous pouvez éditer
les canaux séparément en enfonçant le bouton portant le symbole de cadenas.
Les tensions de commande des deux canaux sont alors déterminées
séparément.

– «Length»: C’est ici que vous déterminez combien de temps le signal est
tracé et «maintenu» dans la section correspondante. Une valeur basse ne
donne qu’une courte amplification ou réduction au son assez électronique.
Es durées plus importantes sonnent généralement de façon plus homogène;
toutefois, le signal peut se trouver trop affecté (particulièrement durant la
phase d’attaque). Selon la complexité du matériel audio initial, la durée
(«length») doit être réglée avec soin.

Sections «Saturation» et «HF details»
En tant qu’outil créatif, am|pulse offre un niveau de saturation réglable et un
module «high-frequency details».
Ces deux sections sont situées dans le circuit après le traitement des transitoires.
Les sons modélisés peuvent y recevoir un traitement supplémentaire. Il existe
de nombreuses possibilités de combinaison de ces trois sections pour créer des
sons uniques. Nous décrirons ci-dessous quelques-unes de ces configurations.
La section «saturation» fonctionne comme un préampli à lampes. Il manifeste
le comportement de compression de volume typique des lampes et amène le
signal à saturation dans les hauts niveaux. La commande «saturation» détermine
principalement le gain d’entrée de l’étage de lampes.
Quand elle est tournée à fond à gauche, aucune saturation ne se produit et cette
section reste inactive.
Des harmoniques supplémentaires se développent durant l’amplification du
signal (principalement impaires, associées à quelques harmoniques paires de
niveau inférieur). Le signal devient d’abord plus fort et plus «riche». Il devient
plus rugueux et plus «sale» quand l’amplification augmente, et finit avec une
distorsion radicale pour un niveau d’entrée suffisamment haut.
La saturation du signal est dans ce cas sélective quant aux fréquences.
Cette méthode garantit que la saturation s’accomplisse relativement proprement.
Les signaux entrants ayant de hauts niveaux de graves tendent à moins «s’étaler».
Entre autres choses, un tel pré- et post-filtrage est une caractéristique sonore
virtuelle d’amplificateurs de guitare, particulièrement à haut gain.
Le résultat en est une légère réduction des bas médiums quand la saturation
augmente.
La section «HF details» est un circuit qui utilise aussi une combinaison de filtres
et un étage d’amplification non linéaire. Elle convient pour «faire ressortir» des
détails dans les aigus de votre signal sans cet aspect dur ou agressif qui survient
dans les plages extrêmes quand on emploie des égaliseurs (numériques).
Vous êtes sans doute familiarisé avec des circuits similaires que l’on nomme
«Exciter» ou «Enhancer».
Dans cet étage, le signal passe d’abord au travers d’un filtre coupe-bas. Vous
pouvez employer le paramètre «Tune» pour régler sa fréquence de coupure.
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Une unité d’amplification qui ajoute au signal des aigus supplémentaires suit
le filtre. Cela amène une «distorsion» de la plage de fréquences restante.
Beaucoup de processeurs soi-disant «psycho acoustiques» fonctionnent selon
ce principe: le signal «enrichi» est mélangé avec celui d’origine et l’auditeur
obtient l’impression d’un «signal rafraîchi» avec «plus de détails». Au final,
toutefois, nous réglons la compression de volume et les transitoires confuses
en tirant parti du fait que notre oreille est moins sensible aux distorsions des
aigus que, par exemple, des médiums. Evaluez soigneusement ce procédé et, si
nécessaire, faites des comparaisons avec/sans au moyen du commutateur
«bypass».
Le degré de distorsion interne dépend du réglage de la commande «level». En
même temps, vous déterminez la part «traitée» (en dB) avec laquelle le signal
d’origine sera mixé.

Astuces pour le travail créatif avec am|pulse
Nous avons ajouté à am|pulse quelques presets que vous pouvez appeler dans
le menu de sélection de l’interface. Certains d’entre eux sont des points de départ
idéaux pour les essais suivants:
– Attack & Sustain sont souvent des processus contraires. Si, par exemple, vous

voulez apporter plus de «mordant» à une batterie électronique en accentuant
son attaque, essayez de réduire le sustain. Les deux sections nécessitent alors
souvent moins de «drive» et le son a généralement des effets bien plus calmes
que si vous n’utilisiez qu’une seule des deux sections mais à un niveau double.

– Pour augmenter la sonie ou «loudness», les sons avec beaucoup d’attaque
mais un faible niveau moyen ne peuvent être «domptés» qu’au moyen du
niveau de saturation. Quelques dB de «saturation» suffisent généralement.
Observez le crête-mètre.

– Essayez de simuler plusieurs types d’amplificateur:
Combinez les sections de transitoires et de saturation avec une légère réduction
de l’attaque (environ 2-3dB) et une légère saturation (peut-être 6dB). Les
résultats sont des bords de signal adoucis, une sonie légèrement accrue et un
peu plus de «vie» dans le signal. Vous pouvez peut-être ajouter 1-2dB dans
«HF details». Le résultat deviendra alors très proche de celui d’un amplificateur
à lampes.

– Si vous préférez un peu plus de filtrage par la section de saturation (la sonie
ou «loudness» des lignes précédentes) mais moins de «crunch», baissez
légèrement le fader d’entrée «input» et augmentez parallèlement la commande
«saturation».
Observez ici aussi le crête-mètre: des changements subtils ont déjà une grande
influence sur le comportement d’impulsion global du signal et de légères
colorations peuvent même être constatées lors d’une comparaison avec/sans.

– Réglez l’attaque et le sustain des canaux gauche et droit sur des valeurs
opposées pour que le signal «bouge» dans le champ stéréo en fonction de ses
propres données de transitoires. Cet «autopanoramique» fonctionne même
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avec des sources mono et est idéal pour créer des boucles nouvelles et uniques.

Robota Pro (Samplitude Professional seulement)
Le Robota est une boîte à rythmes à huit voix sous forme d’instrument virtuel
(VST) basé sur la synthèse analogique virtuelle. Cela signifie que quasiment
aucun échantillon n’est employé comme son de batterie (bien que cela soit aussi
possible); les sons sont générés en temps réel par un synthétiseur spécialisé
dans les sons de batterie. Cela permet la production de sons analogiques typiques
de boîtes à rythmes classiques, comme les TR-808, TR-909 Roland ou de
modèles modernes comme l’Electribe Korg ou la X-Base Jomox. Le Robota est
contrôlé par un séquenceur pas à pas par « programmation légère en pas à pas»
ou via MIDI.

«Données techniques»
– Séquenceur 8 pistes
– 64 pas (4x16 ou 2x32)
– Mode «Notes» (information de dynamique par pas)
– Mode Snapshot (le réglage d’instrument peut être sauvegardé pour chaque

pas, temps de «rappel de snapshot» variable)
– Presets de Groove (information de «swing» (jeu ternaire) & de «dynamique»)
– Mode «Follow» & «auto copy» pour une édition simplifiée
– 8 «instruments» (1 par piste de séquenceur). Disponible pour chaque

instrument:
– Section Oscillateur (sinusoïdale/triangulaire/dents de scie/.WAV) +

générateur de bruit
– Modulation (FM/en anneau)
– Section Lo-Fi («basse fidélité»)
– Section Filtre (filtre multimode (12/24dB), filtre en peigne, enveloppe de filtre)
– Simulation de lampes
– Compresseur
– Volume + pan
– Routage de sortie pour paire de sorties stéréo 1 – 4
– Organisation de 8 instruments comme « kits de batterie»
– Fichiers de configuration («Setup») pour le statut global de la machine (pattern

+ réglage d’instrument + autres réglages)
– Affichage de configuration («Config View») avec réglages poussés

(déclencheur MIDI, matrice de contrôleurs, paramètres de jeu, etc.)
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Synthèse
Les huit voix du Robota sont de constitution identique. La synthèse du Robota
est assez compliquée, car chaque voix doit générer une grande variété de sons
de batterie, allant d’une charleston sifflante à de lourds sons de grosse caisse.
Le synthétiseur de batterie Robota est constitué d’un oscillateur pour lequel on
peut choisir une forme d’onde (sinusoïdale, triangulaire ou dents de scie) ou un
échantillon. Vous pouvez aussi ajouter un générateur de bruit ou vous en servir
comme modulateur de hauteur (dans lequel le contrôleur de «bruit» détermine
la vitesse de la modulation).
L’oscillateur dispose d’une enveloppe de hauteur et de commandes attack/decay
(attaque/chute). Il possède aussi une modulation de fréquence et en anneau
(ring). L’intensité de modulation peut être contrôlée par un paramètre
d’enveloppe (FM/rng dcy). Après vient une section «Lo-Fi» constituée d’une
distorsion (rectify, redressement à diode), d’une réduction de résolution (bits)
et d’une réduction de fréquence d’échantillonnage (dwnsampl). La durée des
effets Lo-Fi peut aussi être réglée au moyen d’une enveloppe (decay). Ensuite
vient un filtre multimode (passe-bas (lp)/passe-bande (bp)/passe-haut (hp)) avec
une pente de coupure de 12 ou 24 dB. Un filtre en peigne (une ligne de retard
ainsi nommée en raison de l’aspect «peigne» des crêtes et creux de sa
représentation spectrale) peut aussi être ajouté («comb»). Vous pouvez aussi
moduler la fréquence du filtre au moyen d’une enveloppe. Un circuit
compresseur ajoute «impact» et «puissance» au son («compressor»: intensité;
«response»: attaque et relâchement) et un étage d’amplification à lampes vous
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permet de «renforcer» encore le son avant la sortie.
Cliquez sur «M» pour couper le son de l’instrument (Mute); sur «S» pour le
faire passer en solo.
Utilisez le bouton haut-parleur pour une pré-écoute de l’instrument. Sinon,
vous pouvez employer un clavier MIDI pour éditer les sons et pour déclencher
individuellement les voix par des messages «note-on» et pour changer
individuellement les paramètres de synthèse via des messages MIDI CC ou de
«changement de commande» (référez-vous aussi à la section intitulée «Fenêtre
de configuration»). Veuillez aussi vérifier que le bouton «MIDI trigger» est activé
pour un déclenchement par MIDI.  (Pour l’édition en mode Stop, veuillez vous
assurer que vous avez activé l’écoute de contrôle (monitoring) d’entrée dans
Samplitude).
Le Robota dispose de 8 sorties audio, sous forme de 4 paires stéréo. Il est conseillé
d’utiliser plusieurs paires stéréo si vous voulez éditer séparément des patterns
avec beaucoup de pistes et de sons dans la table de mixage de Samplitude. Quand
vous éditez un instrument, vous pouvez choisir la sortie à laquelle vous voudriez
l’envoyer (curseur horizontal sous l’afficheur).
Par défaut, tous les instruments sont dirigés vers la paire de sorties 1. Sachez
que les changements faits ici ne sont pas sauvegardés avec leur instrument,
mais dans un fichier de configuration.

Séquenceur
Une méthode classique de programmation à «pas lumineux» sert à contrôler
les patterns de batterie comme c’est plus ou moins le cas dans les boîtes à rythmes
et «groove boxes» classiques. Le séquenceur pas à pas est dans ce cas constitué
de 16 boutons à diode représentant 16 pas. Ils correspondent aux divisions
individuelles de la mesure (en triples-croches, seule une demi-mesure est
affichée). Un bouton allumé correspond au déclenchement du son de batterie
sur cette section de mesure. Un clic gauche active le pas, et un nouveau clic
gauche le supprime.
Un pattern de batterie peut avoir une longueur maximale de quatre mesures. Le
petit curseur «bars» permet de choisir le nombre de mesures.
Utilisez le bouton «Edit» approprié pour sélectionner la mesure que vous voulez
éditer. Utilisez le bouton «Follow» pour sélectionner le mode de suivi, c’est-à-
dire la façon dont l’affichage des pas suit le défilement des pas dans la mesure
actuellement jouée.
Auto Copy: Si le pattern fait plus d’une mesure, cette fonction Auto Copy
reproduit automatiquement dans les mesures suivantes les notes placées sur la
première mesure. Cela facilite beaucoup la création d’une rythmique continue
sur une boucle de 4 mesures. La fonction Auto Copy n’affecte pas les notes qui
ont été placées dans les mesures suivantes aussi pouvez-vous, par exemple,
programmer une variation n’apparaissant qu’en 4ème mesure.

Programmation d’un nouveau pattern de batterie:
1. Utilisez le curseur pour sélectionner la longueur du pattern.
2. Sélectionnez le mode «notes».
3. Si vous éditez durant la lecture, vous devez désactiver «Follow». Choisissez la
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mesure que vous voulez éditer à l’aide du bouton «Edit».

4. Utilisez le sélecteur pour choisir l’instrument à éditer.
5. Le bouton «Clear» vous permet de supprimer toutes les programmations

dans la mesure actuelle pour l’instrument sélectionné. Avec «auto copy» activé
et la mesure I affichée, un clic sur «Clear » supprime tous les pas (les 64
pas).

6. Allumez les boutons de pas voulus. Vous pouvez employer la commande
«Step Velocity» pour prédéfinir la dynamique d’un pas.

7. Répétez la procédure pour les autres instruments.

Snapshots
Il est aussi possible d’automatiser les paramètres éditables d’un son de batterie
avec ce que l’on nomme des «Snapshots». Cela permet aux paramètres de son
d’un instrument d’être sauvegardés avec les boutons de pas du séquenceur.
Ainsi, vous pouvez façonner un événement individuel dans le son et, pour les
séquences à multiples mesures, vous pouvez programmer des procédures très
vivantes et très «folles». De cette façon, vous pouvez même programmer des
mélodies en changeant l’accord des pas affectés (veuillez vous assurer que les
oscillateurs fonctionnent en «mode chromatique» dans la fenêtre Configuration.

Voici comment automatiser un instrument de batterie à l’aide des snapshots.
1. Réglez le mode d’édition sur «Snapshots».

Si vous éditez durant la lecture, vous devez désactiver «Follow». Choisissez
la mesure que vous voulez éditer à l’aide du bouton «Edit». L’automation par
snapshot doit d’abord être désactivée (éteignez le bouton «On»). Les réglages
que vous venez de faire seront sinon remplacés par le snapshot déjà enregistré
à la position actuelle.

– Sélectionnez un instrument et changez-en le son à votre goût. Vous pouvez
contrôler le son d’un instrument une fois la lecture stoppée en cliquant sur le
bouton haut-parleur ou en déclenchant le son par MIDI (cela nécessite d’avoir
activé l’écoute de contrôle (monitoring) dans Samplitude).

2. Sauvegardez le son comme un snapshot dans un des boutons de pas.
3. Vous pouvez maintenant changer de son d’instrument de batterie et

sauvegarder de nouveaux réglages dans un autre des boutons de pas.

Note: Les changements de paramètre ne se font pas de façon brutale, mais progressive,
en interne, pour éviter les craquements. Vous pouvez employer la commande «time»
pour déterminer la vitesse à laquelle les paramètres évolueront vers le nouveau son.
Cela vous permet de créer d’intéressants effets de «morphing» entre sons. Le réglage de
cette commande est sauvegardé avec le pattern (ou avec le fichier de configuration).

4. Vous pouvez sauter d’un snapshot à l’autre en utilisant les touches curseur si
vous désirez corriger individuellement certaines scènes (cela nécessite d’avoir
activé l’écoute de contrôle (monitoring) dans Samplitude).

5. Cliquez maintenant sur «On» pour activer l’automation des snapshots.
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Groove
Le secret du «groove» d’une rythmique c’est le jeu en avance ou en retard de
chaque note selon certaines cadences. Par exemple, le jeu ternaire ou»shuffle»
est utilisé en house, où les doubles croches paires sont retardées.
Le Robota possède des préréglages (presets) de dynamique (velocity) et de retard
(swing) de groove. Les presets de dynamique ont une certaine marge de variation
(augmentation ou diminution) de la dynamique d’origine pour chaque pas d’une
mesure; les presets de retard groove ont une certaine marge de variation quant
à l’instant de jeu de chaque pas, afin de le jouer un peu avant ou un peu après.
Le résultat est une séquence de batterie au son considérablement plus vivant.
L’amplitude de chaque effet peut être sélectionnée avec le la commande %.
Les presets Groove peuvent être sélectionnés dans les listes de la fenêtre
Configuration.

Configurations (Setups), kits de batterie (Drum Kits), Presets et
Patterns
Chargement/sauvegarde
Les instruments, kits de batterie, patterns et configurations peuvent être
sélectionnés à l’aide des boutons «Haut/Bas» près de leur case d’affichage. Sinon,
cliquez sur leur affichage, ce qui ouvre une liste des presets disponibles. Cliquez
sur le bouton «Sauvegarder» (symbole de disquette) pour sauvegarder un preset.
La fenêtre standard de sauvegarde apparaît. Le nom du preset actuel est affiché.
Vous pouvez saisir un nouveau nom de fichier et, comme d’ordinaire, supprimer
les presets inutiles dans le navigateur de fichiers.
(Veuillez noter que le Robota utilise toujours les dossiers ou «répertoire»
prédéfinis, même si vous changez pour un autre. Vous ne pouvez pas sauvegarder
les fichiers à un autre endroit.)
Le Robota organise les sons et les rythmes selon la hiérarchie suivante:
– Un son d’élément de batterie est sauvegardé comme un «instrument».
– Les 8 instruments peuvent être sauvegardés ensemble comme un kit de

batterie ou «drum kit». Les paramètres individuels d’instrument, par contre,
ne sont pas sauvegardés, puisque seules sont enregistrées 8 références aux
noms de fichier voulus. Par conséquent, si vous supprimez manuellement
un instrument de votre disque dur ou changez un de ces sons ultérieurement
avant de le sauvegarder à nouveau, cela affecte par conséquent les kits de
batterie qui emploient cet instrument. Les kits de batterie ou «Drum kits»
conviennent donc pour organiser des sons fréquemment employés. Ainsi, si
vous avez préparé vos propres sons de batterie en changeant des presets
existants et désirez les sauvegarder en tant que kit de batterie, vous devez
d’abord sauvegarder les instruments comme de nouveaux presets puis
sauvegarder le kit de batterie.

– Toutes les informations de notes et de snapshots sont sauvegardées dans le
pattern.

– La combinaison de tous les paramètres (instruments + pattern + autres
réglages) est une configuration ou «setup». Dans ce cas, peu importe quels
instruments appartiennent à quel kit de batterie et que vous ayez apporté des
changements individuels aux paramètres. Une configuration enregistre
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toujours le statut total tel qu’il est actuellement, avec tous les paramètres de
sons, notes, snapshots et réglages de groove.

– En général, vous pouvez sauvegarder tous les processus d’édition comme
une configuration ou «setup». Cela «gèle» tout de façon sûre et vous pouvez
repartir de cette situation à tout moment. Toutefois, nous vous recommandons
les actions suivantes:

– Créez une bibliothèque d’«instruments» personnels.
– Groupez les instruments régulièrement employés comme un kit de batterie

ou «drum kit».
– Créez une base suffisante de «patterns de base».

Vous avez peut-être déjà fait assez de provisions pour des projets futurs. Vous
pouvez maintenant employer les configurations ou «setups» de façon appropriée
en les associant chacune à un morceau. Un avantage est dans ce cas de pouvoir
changer de pattern et de kit de batterie en plus de déclencher individuellement
des notes (veuillez aussi vous reporter à la section Fenêtre Configuration).
Vous pouvez changer de configuration individuelle dans Samplitude avec la
liste des presets (au dessus de la sélection d’instrument) ou par message MIDI
de changement de programme (1-128).
SI vous sauvegardez un projet dans Samplitude, la dernière configuration
sélectionnée est ouverte. Vérifiez que vous avez sauvegardé la configuration
avant de fermer le VIP.
(Si vous employez des changements de programme, veuillez noter que les
numéros d’emplacements de stockage peuvent changer si vous avez inséré de
nouvelles configurations). Les configurations ne sont pas associées fixement à
un numéro de programme mais classées par ordre alphabétique.)

Fenêtre Configuration
Utilisez le symbole de «clé» en haut à droite du Robota pour accéder à la «partie
du bas».
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Vous pouvez y changer les réglages suivants:
– Section «MIDI play» (jeu par MIDI):
– Régler le canal MIDI de réception (Receive Channel) pour déclencher les 8

voix de l’extérieur.
– Déterminer les «touches de déclenchement» correspondant aux différents

instruments.
– Matrice de commande MIDI: Une sélection de «numéros de changement de

commande MIDI (CC)» qui vous permettent de contrôler depuis un
équipement externe les commandes sonores de l’instrument actuellement
sélectionné. («Ex works» comprend les numéros de CC par défaut du clavier
Oxygen 8 de M-Audio). La colonne de droite affiche les paramètres disponibles
du «moteur» de chaque source. Vous pouvez configurer la matrice comme
vous le désirez et même faire des routages vers plusieurs destinations.

Section «PATTERN/DRUM KIT PLAY» (jeu de pattern/kit de
batterie):
– Sélectionnez le canal de jeu «channel». Il n’y a pas besoin de

correspondance avec le canal réglé dans «MIDI Play». Cela dépend de la
conception de cotre environnement de travail.

– Sélectionnez la «note de déclenchement» et le pattern ou kit de batterie
correspondant. Cela vous permet de «jouer» des patterns ou des kits depuis
le clavier.

– «Change«: détermine l’instant où se fera le changement: immediately
(immédiatement), with the next beat (à la mesure suivante), ou always on bar
1 (toujours en mesure 1).

Section «GROOVE PRESET»:
– «Swing»: Si nécessaire, choisissez un preset de swing (retard) dans la liste.

L’intensité d’action des presets peut être réglée en section séquenceur avec la
commande % correspondante.

– «Velocity»: Sélectionnez un preset pour moduler le volume de votre pattern.

Section «MACHINE GLOBALS»:
– «Accuracy vs. CPU» (précision contre usage intensif du processeur):

«Normal» est choisi par défaut; c’est un compromis entre un timing approprié
et une charge moyenne du processeur. «High» est encore un peu plus
«précis», particulièrement en cas d’usage intensif de la modulation de filtre
et de l’enveloppe de hauteur. Vous ne devez utiliser «low» que si la capacité
de traitement est consommée par d’autres instruments ou effets car le timing
et les enveloppes ont alors une moindre priorité.

– «Oscillators (oscillateurs)»: «Retrigger» réinitialise la phase des
oscillateurs à chaque phase pour que la forme d’onde et la modulation sonnent
identiquement à chaque pas. Avec un réglage sur «free» (libre), tous les
oscillateurs sont constamment en service, ce qui, selon l’application, peut
donner un son plus vivant et plus «analogique».

– «Tuning mode» (mode d’accord): Par défaut, la commande «tune» se cale
sur des valeurs «tonales» («chromatiques») pour que vous puissiez
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programmer des mélodies, des arpèges ou des lignes de basse à l’aide des
sons adaptés. Un accord à réglage libre («Free») est aussi possible.

– «Knob mode» (mode de contrôle de commande): A vous de choisir. Vous
pouvez déplacer la commande de bas en haut ou latéralement («hor./vert.»)
ou «dessiner» un cercle avec la souris («circular»). La dernière option est
plus précise pour les petites variations de valeur de paramètre en raison du
plus grand chemin parcouru en mode circulaire. «hor./vert.» est recommandé
pour les changements plus radicaux.

Section «CONFIG MEMORY»:
– «Save with current setup»: Quand ce bouton est activé, tous les

changements faits en fenêtre Configuration sont sauvegardés lors de la
prochaine sauvegarde de Setup et sauvegardés encore à la réouverture.

– «Save as default»: Cela sauvegarde la configuration actuelle comme
configuration par «défaut». C’est utile si vous désirez retrouver les mêmes
conditions dans le VIP.

– «Restore default». Utilisez la fonction de restauration pour remplacer un
réglage de «Configuration» créé à parti d’un chargement de Setup avec votre
«standard».

Remix Agent
Le Remix Agent est un outil puissant qui détermine le tempo (BPM, ou
‘battements par minute’) ainsi que l’instant des temps (les noires des morceaux).
C’est utile par exemple quand un CD audio est importé et que vous voulez mixer
‘autres sons dans un arrangement.

Quand utiliser le Remix Agent?
– Quand vous voulez précisément découper un morceau pour créer des Objets

de remix dans un Objet multipiste pour réarrangement selon vos désirs.
– Quand le tempo de l’arrangement doit être adapté au tempo du morceau.
– Quand le tempo du morceau doit être adapté au tempo de l’arrangement.

Impératifs
Les conditions suivantes sont nécessaires à l’emploi du Remix Agent:
– Le morceau doit dépasser les 15 secondes.
– Le morceau doit être «rythmé» (dansable).

Lancement du Remix Agent
Avant d’ouvrir le Remix Agent, vous devez placer le curseur de lecture du VIP
ou de l’éditeur d’onde (Wave Editor) sur la position où la détection doit
commencer dans l’objet morceau (Song). Si le morceau possède une longue
introduction sans rythmique mais disons seulement de calmes nappes de
synthés, vous devez placer le marqueur de départ après l’intro. La règle de base
est que le Remix Agent doit toujours être «nourri» avec de la musique «dansable».
Le marqueur de départ doit aussi être réglé avant un temps (noire) et encore
mieux, avant le premier temps d’une mesure.
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Le Remix Agent se lance depuis le menu «Tools» ou le menu contextuel (clic
droit sur l’Objet).

Note: Si vous voulez employer le Remix Agent dans l’éditeur d’onde (Wave Editor),
le mode d’édition virtuelle doit être activé. L’option «Save only tempo & beat
information» (conserver seulement les informations de tempo et de temps) est alors
disponible à partir de l’étape 3 (Step 3).

Emploi du Remix Agent
Le Remix Agent fonctionne en 3 étapes ou «steps»:
(I) Détection du tempo
(2) Détermination du début de mesure
(3) Application des détections de tempo (BPM) et de mesure.

Etape 1: Détection du tempo
A l’ouverture du Remix agent, il analyse le matériel et essaie de déterminer
automatiquement le tempo. Le matériel est alors reproduit avec un clic de
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métronome et des lignes pour visualiser les positions dans l’affichage d’onde.
Les repères suivants sont visualisés:
– Position du début de la mesure (temps 1): lignes rouges.
– Position des autres noires (temps deux, trois ou quatre): lignes vertes.
– Positions détectées de façon sûre: lignes épaisses.
– Positions détectées de façon moins sûre: lignes fines.
– Des lignes bleues s’affichent si vous corrigez le tempo (voir ci-dessous) puis

«marquez» le tempo.

Note: Si des informations de tempo ou de mesure sont déjà disponibles, elles sont
affichées comme des points sur les positions correspondantes au dessus de l’affichage
de forme d’onde.

Le tempo détecté est affiché en BPM sur le côté gauche sous la forme d’onde. Il
existe aussi un fader et un bouton Mute sur le côté droit pour contrôler le volume
du métronome.
Si les clics du métronome correspondent au rythme de la musique, les débuts
de mesure sont ensuite déterminés. Sinon, vous pouvez manuellement corriger
le tempo.

Correction
Bien sûr, la détection automatique de tempo ne fonctionne pas toujours du
premier coup. Dans ce cas, vous pouvez avoir à «aider» le Remix Agent. Cliquez
d’abord sur le champ «No (enter tempo manually)» (Non, saisie manuelle du
tempo).
Il existe différentes possibilités:
1. Correction du tempo: Le Remix Agent offre différents tempos. Le tempo

sélectionné est celui que le Remix Agent a déterminé comme étant le plus
probable. S’il ne correspond pas à votre échantillon, sélectionnez un tempo
différent dans la liste. Une fois la sélection correcte faite, le morceau doit être
synchronisé avec le clic du métronome durant la lecture. Toutefois, les temps
peuvent rester inexacts malgré le tempo correct. Si c’est le cas, utilisez la
correction On-/Offbeat.

2. Tap Tempo: Sinon, vous pouvez cliquer en cadence sur le bouton «Tap Tempo»
ou battre le tempo avec la touche «T». Des lignes bleues supplémentaires
apparaissent dans l’affichage d’onde. Après au moins quatre frappes, le Remix
Agent essaie de sélectionner le tempo correct dans la liste sous «Tempo
Correction». L’affichage près du  bouton «Tap Tempo» donne le statut actuel:

– L’affichage est rouge: «Unlocked, Tapped [TEMPO]»: Aucun tempo
convenable n’a été trouvé. Cliquez sur Reset pour recommencer.

– L’affichage est vert: «Locked [TEMPO]»et «Tapped [TEMPO]» ne
correspondent pas: le Remix Agent cherche un tempo convenable. Continuez
de marquer le tempo jusqu’à ce que les deux valeurs correspondent.

– L’affichage est vert: «Locked [TEMPO]» et «Tapped [TEMPO]» correspondent:
le Remix Agent a trouvé un tempo convenable. Quand vous reproduisez le
morceau, il doit être synchronisé avec le clic du métronome. Les temps,
toutefois, peuvent rester inexacts malgré le tempo correct. Si c’est le cas,
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utilisez la correction On-/Offbeat.

3. Correction On-/Offbeat: si les temps sont incorrectement décalés, vous
pouvez les corrigez vous-même. Selon la complexité du rythme, le Remix
Agent offre une ou plusieurs options. Essayez ces alternatives jusqu’à ce que
les clics de métronome soient sur les temps.

Quand les clics de métronome correspondent à la musique, vous pouvez passer
à l’étape suivante.

Etape 2: Détermination du début de mesure:
Ensuite, le début de mesure doit être corrigé. Le premier temps de la mesure
doit toujours correspondre au clic fort du métronome ou avec la ligne rouge
dans l’affichage de forme d’onde. Si le curseur de lecture est réglé juste avant le
premier temps d’une mesure, il n’y a généralement pas besoin de correction.
La correction peut se faire en une étape: si le début de mesure peut être entendu,
cliquez une fois sur «Tap One» avec la souris ou pressez la touche «T» du clavier
sur ce premier temps.
Sinon, vous pouvez aussi choisir de combien de noires le premier temps («One»)
doit être décalé vers la fin.

Note: Dans tous les cas, la visualisation (les lignes dans l’afficheur) et le
métronome sont retardés.
Passez à la dernière étape si les débuts de mesure sont maintenant corrects.

Etape 3: Application de la détection de tempo (BPM) et de mesure
Cela vous permet de déterminer ce que vous voulez faire avec le matériel que
vous venez d’analyser.
Vous avez trois possibilités:
1. Créer des Objets Remix depuis le morceau (le matériel analysé).
2. Adapter le tempo de votre projet au tempo du morceau ou vice versa.
3. A présent, ne sauvegarder que les informations de tempo et de mesure dans

le fichier audio pour un emploi ultérieur éventuel.

Création d’Objets Remix
Le morceau est découpé en Objets individuels mesure par mesure, pouvant être
utilisés et édités dans le VIP selon vos désirs. Quelques exemples:
– Créez des boucles à partir de morceaux complets pour ensuite les utiliser

dans vote propre matériel.
– Remixez des morceaux, c’est-à-dire changez l’ordre des Objets Remix, coupez

et doubles individuellement des parties ou temps du morceau, ou ajoutez
d’autres boucles, échantillons, etc., au morceau.

Note: L’option de «création d’Objets Remix» ne peut être sélectionnée que si le
Remix Agent a été ouvert depuis un VIP.

Quantification audio (Audio Quantization)
Les nouveaux Objets tiennent précisément dans la grille de mesures de
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l’arrangement.
La musique «faite à la main» contient de légères variations de tempo, donc il
peut y avoir des longueurs de mesures différentes. La compression temporelle
(time-stretch) d’Objet est automatiquement activée et appliquée pour corriger
la différence de longueur afin que les Objets tiennent toujours bien dans la
grille rigide de l’arrangement.
Utilisez le rééchantillonnage pour de petites corrections: si les corrections
requises ne sont pas trop importantes, vous pouvez employer le
rééchantillonnage de haute qualité à la place du time-stretch.
Note: si vous changez ultérieurement le tempo de votre projet multipiste (et
réglez les Objets audio dans le VIP au nouveau tempo), il y aura des changements
de hauteur clairement audibles dans les Objets Remix.

Objets Remix en mode de bouclage (Loop)
Les nouveaux Objets sont convertis en mode de bouclage (Loop). Quand vous
augmentez la longueur de l’Objet avec la poignée droite pour souris de l’Objet,
ce dernier est lu en continu selon sa longueur d’origine.

Appliquer le tempo de l’objet au VIP
L’arrangement (VIP) adopte la valeur de tempo (BPM) détectée. Si vous voulez
utiliser le morceau découpé comme base d’une nouvelle composition – comme
avec les remix – cette option doit être activée.

Note: la correction temporelle assignée aux Objets s’effectue en réglant le time-
stretch en temps réel de l’Objet et peut par conséquent être changée dans l’éditeur
d’Objet. Au contraire, les réglages de TS déjà faits sont remplacés.

Group: Les Objets Remix sont groupés.

Use crossfades: Les Objets Remix sont fondus-enchaînés. Les paramètres de
fondu-enchaîné par défaut sont employés.

Abort: La fenêtre est fermée, aucun changement n’est fait.

Tempo Alignment
Cette option vous permet d’aligner le tempo du morceau sur celui de votre projet
ou de votre morceau.

Note: L’option «Tempo alignment» ne peut être sélectionnée que si le Remix Agent
a été ouvert depuis un VIP.

Apply Arrangement Tempo to Object tempo
Ajuste la longueur de l’Objet à l’arrangement existant.
Il y a trois possibilités:

Use Time stretching (utiliser le time-stretch): La hauteur du morceau
reste la même mais la qualité sonore peut en souffrir.
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Use Resampling (utiliser le rééchantillonnage): Le rééchantillonnage
change la hauteur (comme si on changeait la vitesse d’une platine disque), mais
conserve la majeure partie de la qualité sonore.

Note: si vous changez ultérieurement le tempo de votre projet multipiste (et réglez
les Objets audio dans le VIP sur le nouveau tempo), il y aura des changements de
hauteur clairement audibles dans les Objets rééchantillonnés par le Remix Agent.

Use Audio quantization (utiliser la quantification audio): si la
quantification audio est sélectionnée, les réglages de tempo sont inclus dans le
fichier audio comme si les Objets remix étaient créés en premier (voir ci-dessous)
et immédiatement combinés à un nouveau fichier audio. Si la détection n’est
pas fiable, le résultat peut entraîner des variations de tempo extrêmes. Dans ce
cas, il est particulièrement important de régler le marqueur de départ sur une
position (avant appel du Remix Agent) où le tempo est fiablement détecté.
(L’avantage de la quantification audio est que de petites variations del tempo
dans la musique sont «lissées»). Les débuts de mesure de la musique
correspondent aux débuts de mesure dans l’arrangement: ils ne dérivent pas
petit à petit.

Create bar markers within current range (créer des marqueurs de

mesures dans la sélection actuelle) / Create quarter markers within

current range (créer des marqueurs de noires dans la sélection

actuelle): Cette option place les marqueurs au début de mesures (les positions
de lignes rouges dans l’affichage de forme d’onde), et/ou sur les noires dans le
Projet d’onde. Vous pouvez employer ces marqueurs pour ultérieurement créer/
éditer des boucles dans le Projet d’onde.
Ces options sont aussi disponibles quand vous alignez le tempo dans l’autre
sens en adaptant le tempo du VIP sur celui de l’Objet, ou si vous conservez
juste les informations de tempo dans le Projet d’onde.

Apply Object Tempo to Arrangement Tempo (Appliquer le tempo de
l’Objet à celui de l’arrangement)
L’arrangement (VIP) prend en compte la valeur de tempo (BPM) trouvée. Si
vous voulez utiliser le morceau découpé comme base d’une nouvelle composition
– comme avec les remix – cette option doit être activée.
Change global settings (changer les réglages généraux): Le tempo (BPM) de
l’arrangement (VIP) est réglé sur la valeur déterminée.
Adapt tempo map (adapter la piste de tempo): Un marqueur de tempo est placé
dans l’arrangement (VIP) pour chaque mesure entre la position du curseur de
lecture et la position finale des Objets remix.
– Use Bar position instead of tempo marker: Les marqueurs de position de

mesures sont employés à la place des marqueurs de tempo.
– Use quarter notes: Si cette option est activée, quatre marqueurs (noires) sont

placés au lieu d’un (rondes).
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Un exemple d’emploi dans les deux cas: Mixage de deux morceaux
1. Adaptez d’abord le tempo du projet au morceau par fondu dans le second

morceau. («Apply Object tempo to arrangement tempo» -> «Change global
settings»)

2. Puis adaptez le tempo du second morceau au tempo du projet.
(«Apply arrangement tempo to Object tempo»)

3. Comme le tempo du projet correspond maintenant à ceux des deux morceaux,
vous pouvez facilement faire un fondu entre les deux morceaux.

Save & bar info: Si cette option est activée, les informations de tempo et de
mesures sont sauvegardées dans le fichier audio. Les Objets dans le VIP ou le
VIP restent inchangés.

Problèmes et solutions concernant le Remix Agent
Problème:
Le métronome ne fonctionne pas et il n’y a pas de lignes dans l’affichage de
forme d’onde.

Cause possible:
Le matériel ne contient pas de temps marqués ou le morceau contient un passage
sans temps marqués (nappes de synthétiseur, voix seules, etc.).

Solution:
Le morceau et l’Objet doivent être limités aux seuls passages rythmiques

2nde cause possible:
Un marquage manuel inapproprié ou la saisie dune mauvaise valeur de BPM.

Problème:
Essayez les boutons de correction du tempo ou marquez manuellement le tempo
jusqu’à l’obtention du verrouillage («locked»).

Problème:
Le métronome joue de façon inexacte ou saccadée; les lignes dans l’affichage de
forme d’onde sont irrégulières et fines.
Solution:
Le morceau et l’objet doivent être limités aux seuls passages rythmiques

Problème:
La correction Offbeat correction est infructueuse.

Solution:
Le marqueur de départ doit être réglé avant une noire ou, mieux encore, devant
la première noire de la mesure.
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Problème:
En cours de morceau, le métronome clique soudainement sur le temps faible.

Cause du problème:
De temps à autre, les morceaux sont composés de façon à ce que des passages
individuels soient décalés d’une croche. Par exemple, un style populaire de
musique électronique utilise des breaks de 7 croches.

Solution:
Si le morceau doit être complètement découpé en mesures individuelles, le Remix
Assistant doit être appliqué plusieurs fois – avant et après le décalage de chaque
passage.

Elastic Audio: Introduction (Samplitude Professional seulement)
Informations générales
Elastic Audio est un éditeur spécialisé vous permettant de changer la hauteur
du matériel audio. Une combinaison d’algorithmes de rééchantillonnage
automatique et de transposition ainsi qu’une détection de hauteur pour le
matériel monophonique permettent à l’utilisateur de changer radicalement la
hauteur de divers matériels audio.
Les bases du rééchantillonnage viennent de la technologie analogique. Avec
une machine à bande, par exemple, il était possible d’enregistrer un solo de
guitare lentement et de le relire à plus haute vitesse pour augmenter le tempo.
Toutefois, la hauteur augmentait alors aussi en raison de la lecture accélérée et
le solo devait donc être enregistré avec des instruments accordés plus bas.
Aujourd’hui, les algorithmes de transposition peuvent changer la hauteur d’une
séquence de sons sans influer sur le tempo. Samplitude dispose d’une variété
d’algorithmes de transposition.
Elastic Audio offre les possibilités suivantes:
– Automation des algorithmes de rééchantillonnage et de transposition qui,

jusqu’à présent, n’étaient disponibles que de façon statique dans l’éditeur
d’objet. Cela comprend aussi un algorithme pour la transposition respectueuse
du format de matériel audio monophonique utilisant les résultats de l’analyse
de fréquence basique servant à la détection de hauteur.

– Correction automatique et manuelle de la courbe de détection de hauteur de
matériel audio monophonique.

– Correction automatique et manuelle de la hauteur des notes de matériel audio
monophonique.
Changement mélodique de matériel audio monophonique.

– Correction manuelle de la courbe de hauteur de matériel aléatoire.

Note sur le time-stretch: Le time-stretch ne peut pas être automatisé, mais peut être
employé de façon statique quand vous employez Elastic Audio.

Modes d’édition
L’éditeur Elastic Audio a deux modes de fonctionnement différents: Relative
(«relatif») et Direct.
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Mode Relative («relatif»)
La courbe de hauteur ou «pitch curve» (automation de la hauteur dans le temps)
est éditée comme une déviation relative de la hauteur (comme la commande de
pitch bend pour les données MIDI).

Cela peut se faire avec une courbe librement dessinée, des courbes à «pas»
quantifiés et l’outil de courbure Curve Bend. L’outil de lissage de courbe («curve
smooth») permet l’adoucissement de la courbe d’automation. Durant la lecture,
il adoucit les changements de valeur trop brutaux dans la courbe de hauteur.

Vue d’ensemble de l’affichage en mode Relative
Axe des Y: transposition par demi-tons (dans la plage de –48 à +64 demi-tons).

Courbe orange: courbe éditable de hauteur et d’automation représentant le
désaccord relatif de la note d’origine.

Ligne rouge: ligne du 0. (Ligne de référence pour l’édition de la courbe de
hauteur).

Mode Direct
En mode Direct, la courbe de hauteur est immédiatement tracée. Les
changements sont absolus. La hauteur du matériel audio d’origine doit être
connue pour pouvoir ajuster la hauteur en conséquence. Une analyse préalable
de la hauteur du matériel est donc la base du mode Direct. Cela ne fonctionne
généralement qu’avec du matériel monophonique, tonal, comme des voix solo,
instruments solo et de la parole.
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Cliquer sur le bouton «Detection» lance l’analyse. L’analyse d’objets longs peut
prendre du temps. Après analyse, les objets de VIP sont divisés en tranches
individuelles («Slice Object») selon les hauteurs reconnues. La hauteur estimée
d’une tranche détermine sa position dans l’affichage indépendamment du
déroulement précis de la courbe de hauteur dans la tranche. Deux poignées
sont créées sur la courbe de hauteur aux bords des tranches. Ces poignées
peuvent être déplacées pour produire une enveloppe de hauteur augmentant ou
diminuant et pour conserver les petits changements de hauteur (vibrato).
En dehors de la fonction de traçage de hauteur, ce mode apporte aussi des
fonctions d’«accord» pour une correction automatique de hauteur.

Vue graphique d’ensemble en mode Direct
Axe des Y: Hauteurs exprimées comme sur une partition musicale. Les sons
peuvent être désélectionnés sur le clavier. Ils ne sont alors pas employés pour la
correction automatique de hauteur du tracé quantifié. Vous pouvez obtenir des
réglages de gamme appropriés en sélectionnant la tonique et la gamme dans la
case «Edit Slice Object».

Ligne orange: Nouvelle courbe de hauteur (éditable)

Ligne grise: Courbe de hauteur d’origine (résultat de l’analyse)

Ligne bleue: Hauteur moyenne d’une tranche ou «Slice Object» (éditable)
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Bases
Ouverture de l’éditeur Elastic Audio
Sélectionnez les objets devant être traités par l’éditeur (les objets peuvent être
situés sur plusieurs pistes). Elastic Editor se lance depuis le menu «Real-time
Effects» ou l’affichage Time Stretching dans l’éditeur d’objet.

Raccourci-clavier: Ctrl-Shift+E.

Interaction d’Elastic Audio et des objets dans le VIP
Dans l’éditeur Elastic Audio, vous pouvez éditer simultanément plusieurs objets.
La correction temporelle des notes ne s’accomplit pas dans l’éditeur mais en
coupant et en déplaçant les objets dans le VIP.
Si un morceau coupé en différents objets VIP doit ensuite être traité dans
l’éditeur, la capacité multi-objet est requise.
La méthode de travail sur un seul objet est aussi prise en charge.

Chargement d’objets dans l’éditeur Elastic Audio.
L’éditeur Elastic Audio «charge» d’abord les objets qui ont été sélectionnés à
l’ouverture. Par rapport aux effets d’objet, il peut donc éditer un groupe entier
d’objets.
Toutefois, un seul objet peut être affiché et traité par piste. Si les objets chargés
dans l’éditeur viennent de plusieurs pistes, la piste traitée et affichée dans l’éditeur
peut être changée.

Elastic Audio: Description de tous les éléments de commande
(Samplitude Professional Seulement)
Panneau d’affichage (VIEW)

Waveform: commutation on/off de l’affichage de forme d’onde.

Boutons de zoom: Ces boutons de zoom s’emploient comme dans le VIP (voir
Menu View – Get Position and Zoom Level).

Zoom 100%: Tout le matériel de la piste actuellement chargée dans l’éditeur est
affiché sur l’axe horizontal.

Refresh: Rafraîchit l’affichage graphique du matériel. Les changements apportés
à la longueur sont ainsi affichés.
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Panneau EDIT VIP-OBJECT

Ces options et paramètres affectent toujours les objets VIP sélectionnés dans
l’éditeur.
La sélection d’objets VIP s’effectue via les tranches, les objets dans l’éditeur
Elastic Audio ou dans le VIP lui-même.

Track selection: Si des objets venant de plusieurs pistes sont chargés dans
l’éditeur Elastic Audio, une piste peut être choisie ici.

Algorithms: Vous pouvez choisir entre les modes Resample (rééchantillonnage,
preset), Monophonic Voice (voix monophonique), Standard, Smooth (lissage)
et Beat Marker Slicing (découpe par marqueurs de temps).

Veuillez lire les informations appropriées sur les algorithmes dans la section sur les
effets de rééchantillonnage/timestretch du menu «Realtime Effects».

Options: Il existe quelques réglages en relation avec les algorithmes sélectionnés.

Curve smooth (lissage de courbe): Ce paramètre adoucit la courbe de hauteur
programmée selon une constante de temps (en ms). Avec un réglage élevé, les
sauts de hauteur virent au glissando.

Reset: Les courbes d’automation des objets VIP sont réinitialisées.

Panneau EDIT SLICE OBJECT
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Ces options et paramètres affectent toujours les tranches sélectionnées dans
l’éditeur. Ce panneau n’est disponible qu’en mode Direct.

Options de correction automatique de hauteur:
Key (tonique): Tonique de la gamme. Ce réglage n’a bien sûr pas d’effet pour
la gamme chromatique.

Scale: Type de gamme.

Pitch contour: Tune! Ce bouton déclenche la quantification («nivellement»)
de la hauteur flottante des tranches sélectionnées.

Contour smooth (lissage de contour): Sert à définir la «rigueur» de la
quantification. Des valeurs basses donnent une quantification dure, avec pour
résultat la disparition des petites variations de hauteur («effet Cher») qui se
produisent toujours dans des sons naturels (par ex. du vibrato).

Tone: Tune! Quantification de la hauteur estimée des tranches sélectionnées.
Les sections correspondantes de l’enveloppe de hauteur de tranches sont
déplacées comme un tout et par là adaptées aux hauteurs perçues. Les variations
de hauteur existant au sein d’une tranche sont conservées.
La détermination réussie de la hauteur d’une tranche est un préalable nécessaire
à une automation réussie.
La qualité du réglage automatisé est influencée par:
– La correspondance des limites de la tranche avec les limites du son
– Une détection réussie de la hauteur de base:
Du glissando ou d’autres types d’intonations avec de fortes variations de hauteur

peuvent rendre le calcul des hauteurs intermédiaires inexploitable pour
graduer ensuite les hauteurs moyennes. Dans certains cas, vous pouvez y
remédier en divisant et en lissant une variation de hauteur à l’aide de la
fonction Pitch Contour.

Reset: Réinitialise les tranches sélectionnées. La courbe orange chevauche la
ligne grise et la tranche revient à sa hauteur médiane d’origine.

Note: Cette fonction est aussi disponible en mode Relative via le menu Slice-Object.

Commandes de lecture

Reset (réinitialisation totale): Tous les contours de tout matériel chargés
dans l’éditeur sont réinitialisés.

Bypass: Lecture sans édition.
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Stop/Play: Stops/lance la lecture de l’arrangement.

Play Solo: Les objets activés dans l’éditeur sont lus.

Barre d’outils
Plusieurs outils sont disponibles pour traiter les tranches et l’enveloppe de
hauteur. Deux outils peuvent chacun être assignés à un des deux boutons de la
souris. L’outil assigné au bouton gauche vire au bleu; celui assigné au bouton
droit vire au rouge. Pour assigner les boutons, cliquez simplement sur le bouton
voulu avec le bouton de souris correspondant. L’outil «Zoom» est une exception:
les boutons sont automatiquement assignés.

Outil de sélection (flèche): Utilisez cet outil pour déplacer verticalement
des tranches (Slice Objects). Cela modifie la hauteur de toute la tranche. De
plus, vous pouvez sélectionner des tranches et des poignées de courbe. Les
sélections multiples sont possibles à l’aide des touches Ctrl ou Shift, de même
que l’allongement d’un lasso.

Fonction de dessin libre: Vous pouvez employer l’outil crayon pour dessiner
librement la courbe de hauteur. Si vous pressez la touche Shift, une ligne droite
se dessine de la position de départ à la position actuelle de la souris. Si vous
maintenez aussi la touche Ctrl, les tranches adjacentes sont réunies pendant le
dessin.

Dessin avec quantification: C’est l’outil pour le dessin quantifié. La
quantification signifie que la ligne est libre horizontalement mais est
verticalement magnétisée sur les demi-tons en mode Relative et sur les notes de
la gamme sélectionnée avec «tune» en mode Direct.
En mode de dessin quantifié, il est aussi possible de faire une ligne droite avec
la touche Shift et de joindre des tranches avec la touche Ctrl.

Outil de courbure: Vous pouvez employer cet outil pour courber l’enveloppe
de hauteur entre deux poignées voisines. Le centre de la courbe est déplacé,
tandis que les poignées de courbe restent inchangées. En pratique la courbe est
«cintrée». En combinaison avec le déplacement des poignées de courbe aux
limites de la tranche, vous pouvez courber  l’enveloppe de son tout en maintenant
les structures microtonales (vibrato).

Ciseaux: Vous pouvez employer cet outil pour couper manuellement le matériel
audio en tranches (selon les notes) si la détection automatique n’est pas suffisante.
Utilisez Ctrl + les outils crayon pour relier les tranches.

Gomme: Les courbes en orange sont ramenées à leur valeur initiale, c’est-à-dire
que l’enveloppe de hauteur correspond à nouveau à l’original – la courbe
correspond à celle détectée. Cela signifie que vous pouvez aussi employer cet
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outil pour temporairement court-circuiter l’automation. Ainsi, il est possible
d’ignorer toute erreur avec une haute résolution temporelle.

Outil de navigation: Utilisez l’outil de navigation pour déplacer verticalement
et horizontalement la sélection visible.

Outil loupe (Zoom): Le bouton gauche de la souris fait un zoom avant et le
bouton droit un zoom arrière. Vous pouvez délimiter une sélection en maintenant
enfoncé le bouton gauche de la souris et le zoom se fera sur la sélection qui sera
affichée à taille maximale.

Boutons pour les options de visualisation globale.
Ces boutons ont un effet global pour l’éditeur Elastic Audio.

Grille on/off: Utilisez-le comme dans le VIP.

Mode objet unique): Le niveau de zoom horizontal maximum est appliqué en
se limitant à un objet.

Synchronisation du VIP et de l’éditeur Elastic Audio: Les niveaux de zoom
horizontal des deux fenêtres sont synchronisés entre eux.

Mode «arrimé»: Si ce bouton est activé, les fenêtres de l’éditeur Elastic Audio
et du VIP sont arrimées l’une à l’autre.

Application de l’éditeur Elastic Audio (Samplitude Professional
seulement)
Découpe par hauteur (Pitch Slice) des objets et objets VIP
Durant la détection de hauteur, les objets sont divisés en tranches en fonction
de leur hauteur, correspondant idéalement à une note d’une mélodie (musique
monophonique) ou à une syllabe de langage. Dans le langage, les hauteurs
correspondent à la position des voyelles.
Après l’analyse, toutes les tranches sont sélectionnées (en bleu).
Les divisions peuvent être corrigées manuellement. Les tranches se découpent
avec l’outil ciseaux et se réunissent avec l’outil de courbure en gardant la touche
Ctrl enfoncée.
La ligne bleue représente la hauteur détectée et estimée pour chaque objet, qui
résulte plus ou moins de la moyenne des hauteurs dans la tranche.
Dans le groupe «Edit Slice-Object», vous pouvez appliquer des fonctions aux
objets ainsi «tranchés» – correction de l’enveloppe de hauteur et de la hauteur
perçue. Plus encore, vous pouvez réinitialiser (Reset) les corrections des tranches
sélectionnées.
Les objets VIP sont affichés en noir en statut de sélection.
Vous pouvez appliquer aux objets VIP sélectionnés les fonctions du groupe
«Edit VIP-Object». Cela implique la sélection d’un algorithme et d’un niveau de
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lissage (Curve smooth) pour les courbes de hauteur ou d’automation.
Vous pouvez aussi réinitialiser (Reset) les corrections des objets VIP sélectionnés.

Sélection des objets tranchés et des objets VIP
Les objets tranchés peuvent être sélectionnés et désélectionnés. Ctrl + «a»
sélectionne toutes les tranches. Cliquez sur un espace vide pour désélectionner.
Les objets VIP ne peuvent pas être directement sélectionnés dans l’éditeur. Si
un objet tranché est sélectionné, l’objet VIP correspondant l’est aussi. Toutefois,
les objets VIP peuvent être sélectionnés/désélectionnés dans le VIP.

Rééchantillonnage ou automation de transposition (Pitch Shifting)
Automation d’un objet VIP avec changement de longueur (rééchantillonnage
ou «resampling»):
– Chargez des objets dans l’éditeur Elastic Audio en mode Relative.
– Sélectionnez l’algorithme Resample.
– Sélectionnez l’outil crayon.
– Avec la souris, dessinez la courbe d’automation orange
– Recommandation: Pressez la touche «Refresh» – vous pouvez alors voir le

changement de longueur d’objet résultant du rééchantillonnage.

Automation de timbre sans changement de longueur (Pitch
Automation)
– Comme le rééchantillonnage, mais sélectionnez un algorithme de hauteur

(standard, smoothened, monophonic voice). La longueur des objets VIP reste
inchangée.

Correction de hauteur (correction d’intonation) pour matériel audio
monophonique
Premières étapes (pour toute l’édition à suivre):
– Chargez des objets dans l’éditeur Elastic Audio.
– Accomplissez la détection de hauteur (bouton Detection en mode Direct).
– Faites la sélection voulue. Toutes les tranches sont sélectionnées

immédiatement après l’analyse.
– Sélectionnez les algorithmes adaptés – vous devriez commencer par essayer

Monophonic Voice (voir ci-dessus).
– La hauteur peut maintenant être éditée à la souris avec les outils en modifiant

la courbe orange ou la hauteur.

Correction manuelle de la hauteur générale d’une tranche
– Sélectionnez la tranche avec l’outil de sélection (flèche).
– Déplacez-la verticalement avec la souris.

Correction automatique de la hauteur générale d’une tranche
mélodique.
– Sélectionnez les tranches avec l’outil de sélection (flèche).
– Sélectionnez Scale dans le groupe Edit Slice-Object et, si nécessaire, éliminez

les sons supplémentaires ne devant pas être corrigés en cliquant sur le clavier



136

Effets et Plug-ins d’effet

du côté gauche de l’éditeur et en les désélectionnant.
– Cliquez sur le bouton «Tone Tune!».

Correction automatique de l’enveloppe de hauteur
– Sélectionnez les tranches avec l’outil de sélection (flèche).
– Sélectionnez Scale dans le groupe Edit Slice-Object et, si nécessaire, éliminez

les sons supplémentaires ne devant pas être corrigés en cliquant sur le clavier
du côté gauche de l’éditeur.

– Cliquez sur le bouton «Pitch Contour Tune!».
– Utilisez le paramètre «Smooth Curve» pour lisser la «force» de quantification.

Les enveloppes de hauteur au sein sont en principe plus ou moins nivelées
d’une tranche.

Correction d’augmentation ou diminution de hauteur
– Sélectionnez les tranches avec l’outil de sélection (flèche).
– Sélectionnez l’outil gomme.
– Bougez la courbe de hauteur en bougeant les poignées aux extrémités des

tranches, ou en cliquant et en tirant sur la ligne orange.

Redéfinition libre de la hauteur/Produire une modulation de la
fréquence (trille et vibrato).
– Sélectionnez les tranches avec l’outil de sélection (flèche).
– Sélectionnez l’outil crayon (quantifié ou non).
– Dessinez la modulation de hauteur.

Création de «voix synthétiques» (suppression du vibrato par
quantification «dure» de la micro-enveloppe de hauteur).
– Réglez le paramètre Contour Smooth sur 0.
– Si vous employez l’algorithme Monophonic Voice, vous devez désactiver

Formant Factor Correction (Options dans le cadre Edit VIP-Object).
– Pour des changements mineurs de hauteur comme ici, l’algorithme Resample

est généralement le bon choix, car la variation de longueur est alors faible en
raison de la modération des changements.

– Pour les artefacts résultant d’une quantification dure: passez en mode Relative.
Les sauts résultant des erreurs d’analyse peuvent être corrigés dans la courbe
jaune.

Création de «voix de robot » – Quantification sur une hauteur
– Sélectionnez les tranches avec l’outil de sélection.
– Sélectionnez l’outil crayon pour le dessin quantifié.
– Pour les artefacts: augmentez la valeur du paramètre Contour Smooth.
– Pour les artefacts: passez en mode Relative. Les sauts résultant des erreurs

d’analyse peuvent être corrigés dans la courbe jaune.
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Création d’une seconde voix (effet harmoniseur ou placement d’une
seconde voix)
– Dans le VIP, placez une copie de l’objet dans la piste en dessous.
– Sélectionnez les deux objets dans le VIP.
– Ouvrez l’éditeur Elastic Audio
– Sélectionnez la piste
– Chaque piste peut maintenant être éditée individuellement, mais l’algorithme

de rééchantillonnage (Resample) ne doit pas être employé pour éviter des
différences de tempo entre pistes.

Elastic Audio: problèmes et solutions (Samplitude Professional
seulement)
Correction de la détection de hauteur
Informations générales
La hauteur incluant la séparation des tranches et l’estimation de la hauteur perçue
selon la détection de hauteur peuvent être erronées pour les raisons suivantes:
– Matériel avec réverbération
– Traitement de la stéréophonie
– Analyse défectueuse
– Voyelles non exprimées (sons sifflants…)
– Sons bruyants

Dans les deux derniers cas, l’analyse ne peut pas donner de résultat car aucune
hauteur n’est disponible.
L’approche qu’a MAGIX avec Elastic Audio est de fournir à l’utilisateur la
possibilité d’obtenir de bons résultats grâce à des moyens d’intervention
«manuelle» variés quand la hauteur ne donne pas ou ne peut pas donner de
résultats.

Plages non reconnues
Symptômes:
Son: Quand vous changez la hauteur, vous n’entendez pas les changements de
hauteur faites en mode Direct.
(Cela devient particulièrement évident si le paramètre Curve Smooth est réglé
sur une valeur basse).
Représentation graphique dans l’éditeur: L’enveloppe de hauteur orange est
interrompue dans les zones non reconnues en mode Direct.

Remède:
Aucune correction ne sera requise dans les passages non mélodiques d’un signal
monophonique.
Sinon, la courbe peut être modifiée dans les sections en mode Relative.
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Erreur dans la détection de hauteur
Symptômes:
Son: La hauteur varie brièvement à cadence rapide et ne correspond avec la
valeur ou le déroulement établi en mode Direct.
Des sons supplémentaires à forte distorsion apparaissent aussi quand
l’algorithme Monophonic Voice est appliqué. L’algorithme qui lui-même dépend
de la détection de hauteur échoue également.
Représentation graphique dans l’éditeur: En mode Direct, la courbe s’agite à
ces endroits. En mode Relative, la courbe d’automation de hauteur manifeste
aussi un déroulement «agité» si un nouveau décalage de hauteur a été fait en
mode Direct.

Remède:
– En mode Relative, essayez de lisser les courbes à ces endroits.
– Vous devez éviter d’employer l’algorithme Monophonic Voice dans ces cas.

– Augmenter la valeur du paramètre Curve Smooth adoucit ou supprime
les anomalies courtes.

Correction des limites de tranche
Les contours des tranches doivent bien correspondre aux contours de note pour
que la correction automatique ou manuelle de la hauteur médiane des tranches
donne un résultat correct.
Les limites de la tranche peuvent être corrigées manuellement en réunissant
deux tranches ensemble par collage et en les divisant à nouveau au bon endroit
avec les ciseaux.

Elastic Audio: Raccourcis-clavier et fonctions de la molette de
souris (Samplitude Professional seulement)
Navigation avec la molette de souris
Défilement horizontal: Molette de la souris
Défilement vertical: Alt + Molette de la souris
Zoom vertical: Shift + Molette de la souris
Zoom horizontal: Ctrl + Molette de la souris
Zoom hor. + vert.: Ctrl + Shift + Molette de la souris

Raccourcis-clavier
Ctrl + Espace Play solo/stop
Espace Play/stop

Ctrl + A Tout sélectionner
A Rafraîchir l’affichage
Ctrl + Z Annuler
Ctrl + 1-8 Sélection d’outil du bouton gauche de souris

Ctrl + Shift + 1-8 Sélection d’outils du bouton gauche de souris
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Shift + Alt +P Afficher/masquer la courbe de hauteur
Ctrl + Alt + T Afficher/masquer les autres pistes chargées

Ctrl + Curseur haut Agrandir la forme d’onde
Ctrl + Curseur bas Réduire la forme d’onde
Curseur gauche Déplacer la tête de lecture à gauche
Curseur droit Déplacer la tête de lecture à droite
Ctrl + Curseur gauche Zoom avant
Ctrl + Curseur droit Zoom arrière
R Changement de la référence d’accord

(Fréquence pour l’accord du «la» de concert).

Shift + A Afficher/masquer le panneau View
Shift + O Afficher/masquer  le panneau Edit VIP-
Object
Shift + F Afficher/masquer le panneau Pitch
Shift + S Afficher/masquer le panneau Edit Slice-
Object
Ctrl + Pavé num. 4, 5, 6 Enregistrer mémoire de zoom 1, 2, 3
Alt + Pavé num. 4, 5, 6 Charger mémoire de zoom 1, 2, 3 sans zoom
vertical
Pavé num. 4, 5, 6 Charger mémoire de zoom 1, 2, 3
sans zoom vertical



140

La table de mixage

Généralités
Vous pouvez ouvrir la table de mixage en cliquant sur «Window» -> «Mixer» ou
sur le bouton Mixer. Elle ressemble à une vraie table de mixage, mais en beaucoup
plus souple grâce à l’environnement numérique.
Tous les réglages changés dans la table de mixage sont calculés et traités en
temps réel. Cela comprend les effets de piste et master, les réglages de
panoramique et de niveau, les affectations de périphériques aux pistes /bus
individuels et le master.
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Utilisation de la table de mixage
Chaque piste VIP à sa propre piste de mixage. Toutefois, vous pouvez masquer
toute piste de VIP ou de table de mixage dans le gestionnaire de pistes Track
Manager (Menu Tools->Manager)

Autres habillages («Skins») de la table de mixage
En page Options->System/Audio->Path/Skins (touche «y»), vous pouvez
sélectionner d’autres habillages pour la table de mixage. Vous pouvez aussi
facilement changer l’habillage de la table de mixage, du VIP et des commandes
de transport en cliquant dans le menu système de la fenêtre (le coin supérieur
gauche de la fenêtre).
Pour plus d’informations sur la façon d’obtenir et d’installer d’autres habillages
de table de mixage (et de VIP), visitez notre page d’accueil Samplitude à l’adresse
http://www.samplitude.com ou la zone d’assistance de Samplitude.

Emploi du clavier
– Touches curseur : Permettent de sélectionner l’élément actif sur la table de

mixage (fader, bouton ou sélecteur)
– Page précédente / Page suivante : Fait varier la valeur de l’élément de table en

mixage sélectionné
– Home (Orig): Ramène l’élément de la table de mixage sur sa valeur prédéfinie

(passive). Une nouvelle pression sur la touche Home fait revenir l’élément
sur sa dernière valeur. Vous pouvez ainsi faire des comparaisons de réglages
en toute simplicité.

– Fin: Ouvre la boîte de dialogue d’un élément, par exemple la boîte de dialogue
de correction d’un potentiomètre de correction. Cette fonction entraîne le
même résultat qu’un clic droit sur un potentiomètre.

– Retour : Permet la saisie numérique d’une valeur.

Utilisation de la table de mixage avec la souris et le clavier.
Clic gauche: Permet de sélectionner un élément.

Ctrl-clic gauche: Permet de sélectionner plusieurs éléments (sélection
multiple).

Shift-clic gauche sur des boutons: Fonction spéciale permettant de couper
le signal (Mute) d’une piste ou de la faire passer en Solo malgré l’appartenance
à un groupe actif.

Shift-clic gauche sur des sélecteurs ou des faders: Inverse la sélection
(sélection négative)

Alt-clic gauche: En tenant enfoncée la touche «Alt», il est possible de configurer
séparément des éléments appartenant à un groupe.

Double-clic sur chiffres: ouvre un champ de saisie numérique.
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Double-clic sur boutons: Ramène l’élément sur sa valeur prédéfinie (passive).
Un autre double-clic le fait revenir sur sa dernière valeur.

Clic gauche sur des valeurs affichées, sous les faders ou sur les coins de
gauche du bouton: diminue la valeur. Si le bouton est gardé enfoncé, la valeur
diminue automatiquement jusqu’au relâchement ou l’atteinte de la limite du
paramètre. (Clavier: «Page Suiv. »).

Clic droit sur des valeurs affichées, sous les faders ou sur les coins de
droite du bouton: augmente la valeur. Si le bouton est gardé enfoncé, la valeur
augmente automatiquement jusqu’au relâchement ou l’atteinte de la limite du
paramètre. (Clavier: «Page Préc.»)

Clic droit sur boutons (par ex. Compressor): ouvre la fenêtre correspondante.
(Clavier: «Fin»)

Il est possible d’ajuster précisément les faders. Cliquez sur le fader, tenez le
bouton gauche de la souris enfoncé, déplacez le pointeur vers la gauche ou la
droite du fader, puis modifiez la valeur en relevant ou abaissant la souris. Plus
le pointeur de la souris est éloigné du fader, plus le pas de réglage est fin.
Il est possible d’obtenir des mouvements de fader encore plus précis en effectuant
l’opération tout en tenant enfoncée la touche «Shift».

Les potentiomètres peuvent se régler de deux façons. Après avoir cliqué sur le
potentiomètre, déplacez le pointeur en cercle – c’est la méthode standard - ou
de manière verticale comme pour les faders. Vous pouvez affiner le pas de réglage
en tenant enfoncée la touche «Shift».

Voies
Chaque piste VIP correspond à une voie spécifique sur la table de mixage. Les
objets présents sur la piste reprennent par conséquent les réglages qui y sont
affectés.
Chaque voie propose les réglages suivants (de haut en bas):

Entrée : Détermine l’entrée audio/MIDI pour l’enregistrement.

Gain : Régule la sensibilité d’entrée de la voie.

Départs Aux : Déterminent la quantité de signal à diriger vers les bus AUX. Un
clic droit ouvre la fenêtre de réglage AUX Routing.

Inserts: C’est la chaîne d’effets de la voie. Tous les effets internes et plug-ins
chargés apparaissent ici. En cliquant sur le bouton, vous pouvez rapidement
sélectionner un nouvel effet interne ou plug-in ou un instrument virtuel à charger
depuis le menu. Si vous faites un choix de menu pour un emplacement («slot»)
déjà employé, un nouvel effet est chargé dans la chaîne avant l’existant. Quand
un effet est chargé dans un slot, vous pouvez le court-circuiter en cliquant sur
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ce slot. Pour décharger un effet déjà chargé, choisissez «no
effect» (pas d’effet) pour ce slot. Vous pouvez activer/désactiver
n’importe quel effet d’un clic gauche sur son nom, un clic droit
ouvrant son éditeur.

Delay (écho/reverb): Un clic droit ouvre la fenêtre Delay de
la piste.

PL (plug-ins): Active les effets plug-in du canal correspondant.
Un clic droit sur cette touche fait apparaît la fenêtre de gestion
de plug-in. Cette fenêtre de dialogue vous permet d’ajouter ou
de supprimer des effets et d’accéder aux dialogues de réglages
d’effet. Cliquez ici pour plus d’informations sur les plug-ins.

Bouton Link: Couple les commandes d’une paire de canaux.
Si vous travaillez avec un signal stéréo réparti entre un canal
gauche en piste 1 et un canal droit en piste 2, c’est une façon
aisée de s’assurer que les commandes bougent parallèlement.

Correcteur : Cette section permet de modeler le son d’une
piste à l’aide d’un correcteur paramétrique 4 bandes. Les
potentiomètres servent à faire varier le volume de chaque plage
de fréquences.
Dans les champs de valeurs, vous pouvez définir
numériquement le volume et la largeur de la bande de
fréquences.

Pour une précision de réglage accrue, cliquez sur un
potentiomètre avec le bouton droit de la souris. La fenêtre du
correcteur paramétrique s’ouvre alors, affichant les réglages
en détail.

Nom de la piste : Indique le nom de la piste tel que choisi en
fenêtre Track Info. Les faders AUX et Sub Mix ont une couleur
différente pour mieux les distinguer. Un clic gauche sur le nom
de piste ouvre la fenêtre Track Info dans laquelle peuvent être
faits les sélections de périphérique d’entrée/sortie et d’autres
réglages spécifiques de la piste. Un clic droit ouvre un menu
contextuel de raccourcis vers les éléments les plus importants
du menu de piste (Track) dont copier/coller les réglages d’effet
de piste. Vous pouvez aussi y masquer des pistes de la table de
mixage.

Panoramique : Le placement du signal s’effectue dans le
champ stéréo. L’action de ce potentiomètre varie selon que la
piste est mono ou stéréo. Lorsque le potentiomètre est en
position centrale, le signal de la piste est au centre du champ
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stéréo (que la piste soit mono ou stéréo). Lorsque le potentiomètre n’est pas en
position centrale, le signal mono se déplace dans le champ stéréo (vers la gauche
ou la droite). Sur les pistes stéréo, c’est la balance de volume entre les canaux
gauche et droit qui est affectée.

Solo: La touche Solo permet de couper toutes les pistes à l’exception de celle
qui est activée. Un clic droit permet de sélectionner le périphérique de sortie de
la piste.

Mute: Coupe le signal de la piste. Un clic droit permet de sélectionner le
périphérique de sortie de la piste.

Automation: (bouton A) Permet d’enregistrer les mouvements de fader de
volume et de commande de panoramique sous forme de courbes de volume, de
panoramique et Surround en lecture. Toute courbe existante est rappelée sur la
table de mixage si vous déplacez les faders de volume et/ou les commandes de
panoramique.

Ecoute (monitoring): Cliquez sur l’icône en forme de haut-parleur pour activer
la fonction d’écoute. Les données audio peuvent alors être lues en permanence
depuis les entrées de la carte son et redirigées vers les sorties.
Si l’option d’écoute logicielle avec effet («Software FX Monitoring») est activée,
il est possible d’écouter n’importe quel effet inséré sur une voie de mixage ou
sur la section Master – à condition que la carte son dispose d’un pilote ASIO
totalement fonctionnel.

Durant la lecture, une piste peut être «écoutée» ou reproduite, pas les deux. Les
objets d’une piste dont l’écoute est activée ne produisent pas de son.

Vous trouverez plus de renseignements sur l’écoute en section «Monitoring»
du chapitre «Lecture/Enregistrement».

Fader de volume : Permet de régler le volume des voies.

FX: Ouvre la fenêtre de routage des effets (Effect routing) où vous pouvez
configurer et éditer la chaîne d’effets et spécifier l’ordre dans lequel les effets
doivent être utilisés. Veuillez aussi lire la section «Séquence des effets» du
chapitre «Effets».

Aux: ouvre la fenêtre AUX, où vous pouvez déterminer si le départ auxiliaire est
pris avant ou après fader. La position exacte de la dérivation pré/post se règle en
fenêtre FX routing de la piste.
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Out (sortie): Affiche le périphérique de sortie de la piste. Dans
le menu déroulant, qui s’ouvre en cliquant sur la flèche, vous
pouvez rapidement assigner la sortie de la piste. Le nom du
périphérique de sortie par rapport au nom de bus Sub Mix est
précédé d’une lettre qui indique si la piste est dirigée vers la
piste Master («M» rouge), vers une autre sortie que Master
(«O» vert) ou vers un Bus («B» bleu).

Section Master
La section Master est située en haut de la fenêtre et à droite des
voies.

Plug-ins Master : Permet de traiter le signal de sortie général
Master par des Plug-ins DirectX ou VST. Choisissez un plug-
in dans le menu en cliquant sur la flèche du slot. Un clic droit
sur le bouton affiche la fenêtre de dialogue de Plug-in pour la
section Master. Pour activer/désactiver les effets Plug-ins,
cliquez simplement sur le bouton.

Dehisser: L’effet Dehisser Master vous permet de minimiser
au mieux le bruit, souvent perçu comme un souffle aigu. Faites
un clic droit sur le bouton pour afficher la fenêtre de réglage
de l’effet, un clic gauche pour insérer/retirer l’effet de la chaîne
du signal.

FFT EQ: Filtre FFT Master: Ce filtre vous permet de filtrer le
signal de sortie Master selon une courbe définie dans la fenêtre
de réglage du filtre FFT. C’est une version simplifiée du filtre
FFT /analyseur du menu d’effets offline. Faites un clic droit
sur le bouton pour afficher la fenêtre de réglage de l’effet, un
clic gauche pour insérer/retirer l’effet de la chaîne du signal.

Distortion : Un clic droit ouvre la fenêtre de l’effet de
distorsion de la piste.

Multiband Dynamics: Donne accès à la section dynamique
multibande. Faites un clic droit sur le bouton pour afficher la
fenêtre de réglage de l’effet. Le bouton est allumé quand la
section est active. Faites un clic gauche pour insérer/retirer
l’effet de la chaîne du signal.

Dynamics/Limiter: La section Limiteur Master peut être
ajustée par clic droit sur ce bouton. Faites un clic gauche pour
activer ou désactiver la section. Pour un VIP jusqu’à la Version
5.9, c’est l’ancien effet Dynamics FX en mode Limiteur, pour
un nouveau VIP, c’est l’Advanced Dynamics qui est employé
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par défaut. Vous pouvez choisir quel module dynamique employer en page de
configuration (Setup) de table de mixage.

RoomSimulator: Simulateur d’espaces de la section Master. Un clic droit ouvre
la fenêtre de réglage de l’effet.

AmpSimulation: Simulateur d’ampli pour reproduire divers types d’amplis.
Un clic droit ouvre la fenêtre de réglage de l’effet.

Vocoder: Permet de traiter le signal Master par un effet de Vocoder. Un clic
droit sur le bouton ouvre la fenêtre de réglage.

Correcteur Master: Ce correcteur affecte le signal général Master.

Stereo Enhancer (StE): Effet permettant de régler la largeur stéréo du signal
Master. La commande permet le réglage de l’ampleur stéréo entre 0 (Mono) et
100 (stéréo) jusqu’à 200, qui équivaut à un déphasage de 180° des deux canaux
(ou au signal latéral pur). D’un clic gauche sur le bouton, vous pouvez incorporer
cet enhancer stéréo multibande qui fractionne le signal en trois bandes de
fréquences distinctes pouvant être spatialisées séparément.

PL (Plug-in): Cliquez sur le bouton pour afficher la fenêtre de dialogue de Plug-
in pour la section Master.

Mono: Ce bouton entraîne la production du signal master en mono. Il a pour
but de vérifier la compatibilité mono.

Normaliser (N): Normalisation Master. Cliquer sur ce bouton optimise le fader
de sorte que les passages les plus forts du signal soient calés sur 0 dB.
Cela nécessite que les sections les plus fortes soient détectées et lues dans le
VIP. Si vous cliquez sur le bouton «N», le programme règle le signal master à
0dB. Pour indiquer les valeurs maximales après modification, cliquez sur la
touche de réinitialisation des crêtes. Le crête-mètre est alors réinitialisé.
Cliquer sur l’affichage numérique de valeur de crête en mode d’arrêt de lecture
amène la tête de lecture sur la position VIP de cette valeur.

Link: Ce bouton permet de coupler deux faders. Utilisez-le si vous voulez régler
simultanément les faders gauche et droit.

Fader: Ces deux faders règlent le niveau des signaux Master gauche et droit. Il
suffit de double-cliquer sur un fader pour le réinitialiser en position 0 dB.

FX: Ouvre la fenêtre de routage des effets (Effect routing) où vous pouvez
configurer et éditer la chaîne d’effets et spécifier l’ordre dans lequel les effets
doivent être utilisés. Veuillez aussi lire la section «Séquence des effets» du
chapitre «Effets».
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Mix in file (icône de dossier): Cette fonction vous permet de mixer le signal
dans un fichier .WAV durant chaque lecture. C’est particulièrement utile si vous
voulez employer le signal de sortie traité de la table de mixage.
Veuillez vous assurer qu’elle est désactivée si vous ne désirez pas mixer le signal
Master dans un nouveau fichier. Sinon le système écrasera l’ancien fichier à
chaque lecture.
Note: Vous n’avez pas à utiliser la fonction Mix in File pour exporter votre mixage. Il
est beaucoup plus pratique d’employer la fonction Trackbouncing (Menu Tools). Si
vous désirez conserver la sensation «live» du mixage, vous pouvez enregistrer les
mouvements dynamiques de la table de mixage durant la lecture sous forme de courbes
d’automation de volume, panoramique, contrôleur MIDI et VST.

Mixdown: La totalité du VIP y compris tous les réglages est sauvegardée dans
un fichier. Veuillez lire la section sur le report de pistes ou «Track Bouncing»
dans le chapitre «Menu Tools ».

Out (sortie): Routage de la sortie Master. Vous pouvez diriger le master
vers n’importe quel périphérique de reproduction disponible. Ce réglage est
identique au réglage de périphérique de reproduction dans la fenêtre des
paramètres de lecture (raccourci).

Réglages globaux
Sur le côté droit de la table de mixage se trouve d’autres boutons pour faire des
réglages globaux concernant la fenêtre et la manipulation de la table de mixage.
Cela comprend (dans le sens horaire en partant d’en bas à gauche):

Start Track (à gauche des voies): Si le VIP comporte de nombreuses pistes,
seule une partie des voies de mixage est en général affichée sur la table de mixage.
Vous pouvez faire défiler la section visible au moyen de la barre de défilement
située au bas de la table de mixage.
En maintenant la touche «Shift» enfoncée, cliquez sur un des boutons «Start
Track» pour mémoriser l’affichage actuel (un clic gauche suffit la première fois).
Vous pouvez rappeler l’affichage mémorisé en cliquant à nouveau sur le bouton
«Start Track» voulu.

Note: Vous pouvez configurer l’affichage d’autres éléments de la fenêtre table de
mixage avec les options situées à droite du master en section de masquage
d’éléments (aux, EQ etc.).

Reset (réinitialisation)
Reset (Mono): Configure la table de mixage pour l’utilisation de pistes mono
(pour les projets Wave mono ou LR).

Reset (Stereo): Configure la table de mixage pour l’utilisation de pistes stéréo
(pour les projets Wave stéréo).

Reset Aux: Réinitialise toutes les départs AUX des voies sur leur valeur par
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défaut (= pas de départ Aux).

Reset EQ: Réinitialise le correcteur.

Reset Peaks: Réinitialise le crête-mètre à DEL (maintien de crête ou «Peak
Hold»).

Reset FX: Réinitialise tous les paramètres d’effets sur leur valeur par défaut, ce
qui a pour conséquence de couper tous les effets.

Snapshots (configurations de mixage)
Les boutons Snapshot se situent à droite de la table de mixage. Un snapshot est
une configuration de mixage ou «total recall» de tous les réglages de la table de
mixage. Cette fonction convient parfaitement à la comparaison de différents
mixages entre eux. Vous pouvez facilement passer de l’un à l’autre ou charger
et sauvegarder des snapshots.
Un clic gauche sur un bouton snapshot sauvegarde (s’il est vide) ou rappelle
(s’il est mémorisé) un snapshot. Remplacez un snapshot par shift-clic. Vous
pouvez renommer un snapshot en double cliquant sur son champ de nom.
Quand vous chargez un snapshot (bouton inférieur à icône de dossier), les
réglages actuels de la table de mixage sont temporairement sauvegardés et
peuvent être restaurés en cliquant sur «Load last Mixer». Cela permet aussi de
comparer le snapshot et les réglages actuels.
8 configurations de mixage différentes peuvent être sauvegardées/rappelées par
banque de snapshots. Si une banque ne suffit pas, faites un clic droit sur les
boutons snapshot pour ouvrir un menu vous permettant de passer à la banque
de 8 suivante (Next Bank). Vous pouvez mémoriser 32 snapshots via ce menu.
Si vous désirez utiliser un réglage spécifique dans un autre projet, vous pouvez
sauvegarder une banque entière de 8 snapshots dans un fichier .mix et le
recharger ultérieurement. Les boutons de chargement/sauvegarde sont les
boutons à icône de dossier situés sous les 8 boutons Snapshot.
Ouvrez le menu contextuel d’un clic droit sur les snapshots pour charger (Load
Snapshot), sauvegarder (Save Snapshot), supprimer (Delete Snapshot) et
échanger les banques de snapshots.

Grouper/Dégrouper: Des éléments de mixage peuvent être groupés pour être
simultanément réglés. Par exemple, vous pouvez rapidement régler un
prémixage sans passer d’abord par un bus submix. Maintenez enfoncée la touche
«Shift» et cliquez sur les éléments que vous voulez modifier simultanément
(par ex. les faders de volume de différentes pistes) puis cliquez sur le bouton
«Group Selected Controls» (cadenas fermé). Un petit marqueur rouge indique
les éléments sélectionnés.
Un clic sur le bouton «Ungroup Controls» (cadenas ouvert) dégroupe les
commandes.

Play/Stop: Lance et arrête la lecture du VIP.



149

La table de mixage
Solo (S)/Mute (M): Permet d’activer ou désactiver toutes les fonctions Solo
et/ou Mute de manière globale.

Bypass: Permet de désactiver tous les effets de la table de mixage à des fins de
comparaison.

AutoRec: S’allume en cas d’enregistrement automatique du volume ou du
panoramique d’une voie. L’automation doit être activée sur au moins une voie.

Boutons de masquage: Masquent des groupes de commandes de la table de
mixage. (comme leur nom l’indique: Inputs, Aux, Inserts, EQ.)

Bouton x supplémentaire: la catégorie «AUX» a un bouton supplémentaire pour
étendre ou réduire le nombre de départs AUX affichés.

Setup: Ouvre la fenêtre de configuration de la table de mixage.

Veuillez aussi lire la section «Project properties > Mixer setup» du chapitre «Menu
Options ».

Bus et routage
Bus AUX
Les pistes AUX ne contiennent généralement pas d’objets, mais plutôt des effets
dynamiques, qui reçoivent des pistes et objets transmis par les départs auxiliaires
«AUX Send». Le niveau de départ AUX de ces pistes et objets gère la portion du
signal qui est envoyée au bus AUX. Le bus AUX renvoie son signal d’effet au
bus MASTER ou à tout autre périphérique de sortie choisi. Avec les bus AUX,
vous pouvez par ex. ajouter la reverb Room de votre choix au mixage, en
appliquant différentes intensités à chaque piste.

Bus de prémixage ou Submix
Un bus de prémixage ou «submix» réunit plusieurs pistes. Il contrôle le volume,
le panoramique et les réglages d’effet de toutes les pistes qui sont «dirigées»
vers lui. Par exemple, toutes les pistes concernant la batterie (piste de charleston,
piste de grosse caisse, etc.) peuvent être réunies en un bus submix pour que la
totalité du kit de batterie puisse être contrôlée via le contrôleur de volume du
bus submix.

Fonctionnement:
– Le prémixage (Submix) ou les retours AUX sont placés dans une voie de la

table de mixage et fonctionnent comme des voies ordinaires.
– Ajouter des voies ou en modifier des existantes crée des bus submix ou AUX

en ajoutant des voies spécifiques de l’application ou en convertissant des
voies existantes. Note: une voie peut servir de Submix ou AUX et en même
temps contenir du matériel audio enregistré!

– Les bus Submix ou AUX sont toujours stéréo.
– Les bus Submix peuvent recevoir des pistes d’un numéro de voie inférieur
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comme un équipement réel.

– Les bus AUX sont une destination pour les pistes de départ AUX d’un numéro
de voie inférieur.

– Les bus Submix et AUX peuvent servir à tout effet de voie, dont l’automation
de volume, panoramique et au départ AUX. Vous pouvez aligner votre sortie
sur des périphériques de sortie ou bus submix d’un numéro de voie supérieur
comme avec toute autre voie.

– L’automation de volume et de panoramique pour les bus AUX et submix
sont les mêmes que pour les autres voies. Elles apparaissent comme des
pistes visibles dans les voies de  VIP et de table de mixage.

Fenêtre de réglages AUX

Dans cette fenêtre, tous les bus AUX disponibles sont référencés. Dans
Samplitude professional, vous pouvez avoir un nombre illimité de bus AUX, la
limite étant de 6 bus dans la version classique. Six d’entre eux sont directement
accessibles depuis la table de mixage, les autres devant être réglés dans cette
fenêtre.

Vous pouvez saisir l’intensité de chaque bus AUX sous forme de valeurs
numériques ou en déplaçant la barre orange (non visible en mode «Off»).
Par défaut, les bus AUX de Samplitude sont pris en position «post». Activez la
case «pre» pour prendre le signal en position «pré». Vous pouvez définir la
position précise des bus AUX  «pre» et «post» dans la chaîne d’effets en fenêtre
de routage d’effets.
New AUX bus: Un nouveau bus AUX est créé.
Reset AUX Sends: Tous les AUX sont réinitialisés et donc non assignés.

Routage d’effet
La séquence de tous les effets en temps réel peut être changée individuellement
pour chaque piste et canal master. Cela concerne les plug-ins VST™ et DirectX,
qui peuvent être «pre» ou «post». Utilisez les boutons des Plug-ins pour ouvrir
la fenêtre.
Pour ouvrir la fenêtre de routage d’effet de la table de mixage, cliquez sur le
bouton FX en partie basse de la voie de table de mixage ou à côté des commandes
de volume et de panoramique en fenêtre de piste.
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Veuillez lire la section sur le «Routage des effets» dans le chapitre «Menu Effects».

Intégration d’unités d’effet externes
Intégrer des processeurs d’effet externes est une option intéressante. Cela
nécessite une interface audio multi-canal dans laquelle une paire de canaux est
réservée au processeur d’effet externe. Une interface numérique est préférable
pour une transmission sans perte.

Séquence des étapes:
– Routage du signal. Décidez si vous voulez utilisez l’effet comme AUX ou en

Insert.
– Départ d’effet externe:
  INSERT: Dirigez directement la sortie de la voie vers la sortie physique de la

carte reliée à l’unité d’effet.
  AUX: Créez une voie AUX pouvant recevoir n’importe quelle piste. La sortie

de la voie AUX doit être dirigée vers une sortie physique de la carte son.
– RETOUR: Créez une piste normale comme voie de retour. L’entrée physique

de la carte son est l’entrée à laquelle l’unité d’effet est branchée. Sortie: le
dispositif master d’écoute de contrôle. La voie de RETOUR doit toujours être
placée après le bus AUX. Il ne sera ainsi pas possible d’accidentellement
envoyer la voie de RETOUR au bus AUX situé avant. (Risque de boucle de
réinjection!)

– Activez l’écoute de contrôle forcée sur la voie de RETOUR. Cela mixe le signal
d’effet entrant dans le master.

Note: Le niveau du signal d’effet est correctement affiché durant l’enregistrement.

– Types d’écoute: Ecoute matérielle: Le signal de retour est déjà mixé avec le
signal master dans la carte son (virtuellement sans latence). Ecoute logicielle:
Le signal entre dans le programme via le mémoire tampon (buffer) ASIO et
sort conjointement au signal master (Latence: double de la mémoire tampon
ASIO).

Note: Ce routage peut aussi servir avec des pilotes WDM et l’écoute de contrôle
matérielle avec comme restriction l’impossibilité de l’écoute de contrôle forcée (Force
Monitoring). Un routage externe ou dans l’interface audio doit dans ce cas
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remédier à la situation, s’il est accepté.

Réglages de panoramique pour les pistes stéréo
Faites un clic droit sur un des boutons de panoramique de la table de mixage ou
du VIP pour ouvrir cette fenêtre.

Panorama: Contrôle la position panoramique de la piste.

Stereo width: Contrôle l’ampleur de la stéréo. Vous pouvez employer un
enhancer stéréo multibande pour réglage d’ampleur différent sur trois bandes.

Phase: Change la phase du signal pour chaque canal (L/gauche ou R/droit).

Center channel damping: Contrôle la position panoramique de façon à ce
que les niveaux des deux canaux soient réduits d’une valeur réglable en dB quand
le contrôleur est en position centrale. S’il est sur les positions extérieures, un
des canaux est plus atténué tandis que l’autre est augmenté au dessus de la
plage de contrôle allant de la valeur atténuée à 0dB. Cela nivelle la différence de
volume perçue en cas de réglage en position centrale. Réglez l’atténuation à -
6dB pour un positionnement panoramique correct de matériel mono dans une
piste stéréo; -4.5dB est recommandé pour la stéréo. Il est conseillé de régler la
valeur simultanément pour toutes les pistes.

Copy: Les signaux des canaux gauche et droit sont respectivement copiés sur
l’autre canal. Utilisez cette fonction si vous voulez traiter un signal stéréo
défectueux (par ex. un signal mono enregistré par erreur en stéréo sur le canal
gauche).

2 channel surround On: Samplitude peut produire des sons surround 2
canaux pour les systèmes capables de les lire. Cela inclut les systèmes compatibles
Dolby Surround ProLogic. Plus de détails dans «Mode Surround 2 canaux»
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Réglages MIDI
Introduction
Samplitude dispose de fonctions MIDI complètes. Les fichiers MIDI peuvent
être importés, enregistrés, lus et édités par des éditeurs internes. En dehors de
la synchronisation par timecode MIDI, l’application principale est le contrôle
de synthétiseurs internes et externes. Cela comprend en particulier les nombreux
instruments VST et échantillonneurs logiciels. Des contrôleurs physiques
externes, par ex. une Mackie Control, utilisent aussi les messages MIDI pour
une télécommande complète.

Astuce: Si désiré, toutes les fonctions MIDI peuvent être désactivées dans Options->
System Audio («Y») /MIDI (Deactivate all MIDI functions). Cette option
supprime le bouton MIDI des pistes et la possibilité de sélectionner un périphérique
MIDI pour enregistrer et reproduire.

Réglages MIDI
Tous les réglages MIDI généraux se trouvent en fenêtre Options/ System
(raccourci clavier: «Y») – sous-menu «MIDI».



154

Le MIDI dans Samplitude
Global Play Device/Global Record Dev.
Déterminent les périphériques généraux de lecture et enregistrement MIDI.
Si une piste spécifique ne peut pas être placée sur un certain canal de sortie ou
d’entrée, les réglages globaux s’appliquent à cette piste. C’est comparable à un
réglage général de périphériques de lecture et d’enregistrement MIDI.

Audio/MIDI Synchronisation
Définit la rigueur avec laquelle Samplitude synchronise les pistes MIDI avec les
pistes audio. Le réglage doit être à 100% si vous avez une configuration
relativement rapide avec un processeur et un disque dur rapides, afin d’obtenir
la synchronisation la plus exacte du MIDI et de l’audio. Toutefois, si les
performances de votre système ne sont pas suffisantes pour synchroniser les
pistes MIDI avec les pistes audio assez vite, vous devez choisir une valeur Sync
Velocity plus basse.

Info
Cette section donne des informations sur le moteur MIDI actuellement utilisé.
La plupart des systèmes sont en 16 bits. L’emploi d’autres moteurs MIDI – 32
bits – est possible avec Windows NT/2000/XP.

Deactivate all MIDI functions.
Vous pouvez désactiver toutes les fonctions MIDI en vue de vérification.
Samplitude désactive alors toutes les fonctions MIDI dans le MIDI ou les projets.
Entre autres choses, cela supprime le bouton MIDI et le menu MIDI du
programme.

Automatic volume fader mode for MIDI tracks
L’action du fader de volume de piste peut être manuellement changée à tout
moment (clic droit sur le fader de volume). Quand vous basculez une piste en
mode MIDI ou audio, le fader de volume de la piste peut automatiquement
s’adapter. Le passage automatique au contrôleur de volume MIDI pour les pistes
MIDI est activé par défaut.
Sélectionnez dans la liste le mode de commande que vous voulez voir activé
quand vous passez une piste en mode MIDI (avec le bouton MIDI). Vous pouvez
utiliser le contrôleur 7 (volume MIDI) et la dynamique MIDI (velocity).
Sélectionnez «Don’t Change Volume Fader mode» si vous voulez régler le fader
de volume de façon exclusivement manuelle.

Note: Quand vous revenez en mode audio, l’assignation initiale de volume audio
est restaurée.
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MIDI: Importation, enregistrement, édition
Importation de fichiers MIDI
Des fichiers MIDI existants peuvent être importés comme objets dans les projets
de Samplitude. Vous pouvez toutefois aussi charger un fichier MIDI comme
projet indépendant de la même façon qu’un projet audio (Wave).

Menu: File/Open Project/MIDI (*.MID) …
Raccourci: Shift+M
Souris: Glissez & déposez depuis le navigateur de fichiers ou l’Explorateur
Windows

Si vous importez des fichiers MIDI, sachez que seuls les SMF de type 0 et 1 sont
compatibles avec la fonction d’importation. Chaque fichier doit porter l’extension
*.MID pour pouvoir être reconnu comme un format d’importation acceptable.
Le processus d’importation de fichier MIDI est généralement identique à celui
d’un fichier audio .WAV, que vous importiez dans une fenêtre VIP ou dans une
fenêtre de projet MIDI. Vous pouvez déterminer la position dans le VIP où sera
inséré l’objet MIDI. Réglez la tête de lecture sur cette position, marquez une
section de la piste voulue, et glissez & déposez directement le fichier sur la
position du curseur depuis le navigateur interne ou l’Explorateur Windows.
La procédure de chargement, qui dans ce cas est une importation car les fichiers
sont convertis au format MIDI interne et sauvegardés en interne (par opposition
à un fichier .WAV qui reste inchangé), s’effectue comme suit:
Décidez d’abord si le fichier MIDI doit être ouvert dans une fenêtre de projet
MIDI séparée ou si les informations doivent être insérées dans une piste de
VIP. Si vous voulez insérer les données MIDI dans une piste de VIP, choisissez
la piste et la position dans celle-ci où vous voulez créer l’objet MIDI afin de
placer la tête de lecture (le curseur) sur la position voulue et ainsi indiquer à
Samplitude l’endroit où l’objet doit être créé.
Sélectionnez ce qui suit dans le menu: «File > Open Project > MIDI» (Shift +
M).
La fenêtre de sélection de fichier s’ouvre et vous pouvez choisir le fichier MIDI.
Dans la fenêtre d’importation suivante, indiquez si vous voulez importer un
fichier MIDI contenant des données pour plusieurs canaux MIDI dans une
seule piste de VIP (All MIDI channels into one VIP track) ou dans autant de
pistes de VIP (Each MIDI channel into one VIP track). Dans ce dernier cas,
chaque canal du fichier MIDI (le MIDI autorise jusqu’à 16 canaux) est chargé
dans sa propre piste de VIP.

Note: Cette fenêtre s’affiche automatiquement si une fenêtre VIP est active. Si vous
voulez ouvrir le fichier MIDI dans une fenêtre de projet MIDI indépendante sans
insérer le contenu dans un VIP, vérifiez qu’aucune fenêtre de projet VIP n’est active.
Samplitude affiche aussi la fenêtre d’importation MIDI si une section de fenêtre de
projet MIDI est déposée dans une piste de VIP.
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La fenêtre d’importation contient des informations sur le statut du fichier MIDI
à charger:

Veuillez noter le nombre de pistes MIDI (Tracks used in File) et la longueur des
pistes en secondes (Play Length).
Chaque fichier MIDI standard (SMF) conserve aussi les informations de tempo.
Samplitude affiche ces informations dans un cadre de la fenêtre. A ce moment,
vous pouvez décider avant d’importer le fichier d’adapter ou non le tempo du
VIP à celui du fichier MIDI importé.
Si vous sélectionnez «All MIDI tracks into one VIP track», Samplitude importe
l’objet MIDI dans la piste de VIP actuellement sélectionnée. Le nouvel objet
MIDI reçoit alors toutes les pistes MIDI du fichier MIDI.

Enregistrement de pistes MIDI
L’enregistrement de pistes MIDI dans Samplitude est assez simple.
Généralement, les données MIDI sont enregistrées comme les données audio
dans une piste de VIP de Samplitude. La différence majeure entre données
audio et données MIDI est que ces dernières nécessitent considérablement moins
d’espace disque que les données audio.
Samplitude ne fait pas vraiment de distinction entre pistes audio et pistes MIDI.
Chaque piste peut contenir des objets audio et MIDI. Vous pouvez donc
immédiatement commencer le travail avec de l’audio ou du MIDI sans avoir à
envisager une séparation des pistes.
Toutefois, certains réglages doivent être faits avant de démarrer un
enregistrement MIDI. Indiquez d’abord au programme quel périphérique
d’entrée MIDI vous voulez employer. Sélectionnez votre périphérique
d’enregistrement (auquel vous avez branché un clavier ou un séquenceur externe)
dans la section «MIDI» de la fenêtre «Track Info». Puis activez l’option «MIDI»
en section «Record» de la même fenêtre.
Sinon, faites un clic droit sur le bouton «R» de la piste et sélectionnez «MIDI
Record» (enregistrement MIDI, voir l’illustration).
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La couleur du bouton d’enregistrement passe au violet pour indiquer que cette
piste enregistrera des données MIDI.

Astuce: Le bouton MIDI de la piste change aussi le mode d’enregistrement pour le
mode MIDI, active la piste et révèle d’importants réglages MIDI tels que les
périphériques d’enregistrement et de lecture MIDI. Vous n’avez pas à ouvrir la fenêtre
«Track Info».

Un clic droit sur le bouton d’enregistrement ou sur celui du périphérique
d’enregistrement de la piste affiche maintenant un menu avec tous les
périphériques d’entrée MIDI disponibles pour l’enregistrement, à la place des
périphériques d’entrée audio habituels. Sélectionnez le périphérique voulu pour
l’enregistrement.
L’enregistrement peut commencer dès que le périphérique d’enregistrement a
été sélectionné et que la piste a été activée pour l’enregistrement (le bouton
d’enregistrement est violet). Pressez le bouton d’enregistrement de la palette
Transport. L’enregistrement démarre immédiatement après pression du bouton.
Pressez à nouveau ce bouton pour arrêter l’enregistrement.
Il vous sera alors demandé si vous voulez conserver ou supprimer
l’enregistrement. De plus, cette fenêtre vous permet de changer ultérieurement
le mode d’enregistrement des données MIDI enregistrées.

Mode d’enregistrement MIDI
– «Normal»: Un nouvel objet est créé durant l’enregistrement.
– «Overdub»: Les données MIDI enregistrées se mélangent avec les données

existantes dans les objets. Si l’enregistrement courre sur plusieurs objets,
ceux-ci sont combinés en un nouvel objet.

– «Multi-Overdub»: Les données MIDI enregistrées se mélangent avec les
données existantes dans les objets. Par contre, les objets existants sont
préservés. Ce mode est utile pour par exemple enregistrer a posteriori des
changements de contrôleur MIDI portant sur plusieurs objets.

– «Replace»: Les données MIDI enregistrées remplacent les données existantes
dans les objets. Les données existantes sont supprimées. Plusieurs objets
existants seront combinés.

Note: Pour enregistrer simultanément plusieurs pistes MIDI, activez l’enregistrement
pour toutes les pistes dans lesquelles vous voulez enregistrer. Contrairement à un
périphérique audio qui n’est disponible que pour une piste, vous pouvez assigner le
même périphérique MIDI à plusieurs pistes. Bien sûr, l’audio et le MIDI peuvent être
enregistrés simultanément sur plusieurs pistes; toutefois, une même piste enregistrera
ou de l’audio ou du MIDI.
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Edition d’objets MIDI
Introduction
L’édition d’objets MIDI dans Samplitude suit les mêmes principes que l’édition
des objets audio. En principe, un objet audio est un simple moyen de faire jouer
un fichier audio réel de votre disque dur. Les objets MIDI sont aussi bâtis selon
ce principe: Ils se réfèrent à des fichiers MIDI enregistrés ou importés non
disponibles comme fichiers MIDI sur le disque dur mais qui sont sauvegardés
dans le fichier projet lui-même.
Les objets MIDI ont le même aspect: Ils ont des poignées de début et de fin
d’objet qui servent comme avec les objets audio à déterminer la section des
données MIDI à reproduire.
Les objets MIDI peuvent être copiés, fractionnés et émargés. Ils ont des poignées
de fondu pour les fondus entrant (Fade In)/sortant (Fade Out) et une poignée
de volume pour gérer la dynamique.
Les objets MIDI peuvent être édités en mode d’édition offline – correspondant
à l’édition d’onde pour les fichiers audio. Ils sont habituellement édités dans
l’éditeur MIDI.

Edition destructive et non destructive
La principale différence entre objets MIDI et objets audio pour le travail est de
nature conceptuelle: par rapport aux fichiers audio, les fichiers MIDI ont
généralement une tendance à l’édition destructive, par ex. le déplacement
d’événements dans l’éditeur MIDI, la quantification et l’ajout d’événements.
Après de tels changements, le contenu des objets MIDI ne correspond plus aux
fichiers initialement importés ou enregistrés. Contrairement aux fichiers audio
pour lesquels l’inclusion destructive de données change de façon irréversible le
fichier initial, les données MIDI sont simplement une séquence d’instructions
de lecture pour différents synthétiseurs qui peuvent ultérieurement être changées
à nouveau sans difficultés. Après l’importation, les fichiers MIDI initiaux n’ont
plus de relation avec les objets MIDI internes et restent intacts.
Toutefois, cette différence de concept est en général un avantage pour l’utilisateur
et est habituelle dans le maniement des données MIDI par les logiciels musicaux.

Exemple: Vous importez un pattern de batterie de deux mesures et vous le copiez par
Ctrl+tirer. Dans le second objet vous pouvez maintenant faire varier la seconde mesure
pour créer un break avec l’éditeur MIDI. SI vous faisiez cela au moyen de l’édition
destructive sur une onde dans des objets audio, le break apparaîtrait aussi dans l’original
(mesure 2), car le fichier audio modifié sert aussi de base à l’objet initial.

Bien sûr, les objets MIDI dispose aussi de l’édition non destructive. Nous faisons
référence aux possibilités d’édition virtuelle. Par exemple, la variation de
dynamique effectuée sur une piste ou dans l’objet MIDI n’a qu’un effet virtuel.
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Autre différence importante: La poignée de volume de l’objet et les fonctions de
fondu d’entrée et fondu de sortie d’un objet MIDI agissent par modulation de
toutes les valeurs de dynamique des événements d’enfoncement de touche (note-
on) dans cette plage.

Réunion d’objets MIDI
Menu «Objects»: Glue Objects
Utilisez cette commande pour réunir tous les objets sélectionnés sur une piste
ainsi que les objets intermédiaires en un seul objet. Les effets non destructifs de
piste et d’objet sont ignorés (par ex. réglages de dynamique, changements de
programme ou affectation des instruments de batterie).
Ainsi, un objet mis en boucle peut aussi être transformé en un nouvel objet
MIDI. Par exemple, vous pouvez créer de «vraies» données MIDI à partir d’un
pattern de kit de batterie mis en boucle pour travailler plus en détail.

Report MIDI
Menu «MIDI»: MIDI Bouncing
Vous pouvez choisir entre report global et report de la plage/sélection (Range).

Report MIDI global (whole Project): tous les fichiers MIDI sont mélangés
ensemble. Il est tenu compte des effets de piste et d’objets. Un nouvel objet
MIDI est créé dans la piste sélectionnée. Les objets antérieurs sont supprimés.

Report de la plage/sélection (Sel. In Range): Tous les objets de la sélection
sont combinés. Il est tenu compte des effets de piste et d’objets. Un nouvel
objet MIDI est créé dans une nouvelle piste. Les objets antérieurs ne sont pas
supprimés.

Travail avec l’éditeur d’objet MIDI
Introduction
Menu «Object» / Object Editor
Raccourci: Ctrl+O
Souris: Shift+double clic

Des effets en temps réel se référant aux objets dans l’éditeur d’objet peuvent
être ajoutés aux objets MIDI. Dans ce cas, Samplitude affiche automatiquement
un éditeur d’objet MIDI spécial. Des fonctions similaires à celles rencontrées
dans l’éditeur d’objet audio se retrouvent dans l’éditeur d’objet MIDI. Cela
implique de confirmer la longueur de l’objet et sa position dans le VIP.
Certaines des possibilités offertes par l’éditeur d’objet MIDI dépendent du
nombre de pistes MIDI dans un objet MIDI. Contrairement à ce qui se fait dans
beaucoup d’autres programmes séquenceurs, un objet MIDI de Samplitude
peut comporter 16 pistes MIDI pouvant transmettre sur 16 canaux MIDI comme
un fichier MIDI normal. Vous pouvez employer le mode max de l’éditeur d’objet
pour avoir une vue générale des pistes ou canaux MIDI qui se trouvent dans un
objet MIDI pouvant avoir été créé, par exemple, à partir d’un fichier General
MIDI (case à cocher «Max»).
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S’il n’y a qu’une seule piste dans l’objet MIDI, seuls les réglages de cette piste
MIDI sont disponibles.
Vous pouvez utiliser l’éditeur d’objet MIDI pour quantifier les données MIDI
dans l’objet MIDI. Veuillez noter que ces réglages affectent l’objet MIDI en
temps réel et pas de façon destructive. Les données MIDI d’origine et la
quantification restent intactes. Les changements sont calculés en temps réel,
tandis que les données MIDI sont simplement reproduites. Par conséquent,
vous ne voyez pas ces changements dans l’éditeur de touches MIDI ou de batterie
MIDI Key or Drum Editor.

Description des fonctions et réglages de l’éditeur d’objet MIDI:
Velocity (Dynamique)
Le fader de dynamique (velocity) est comparable au fader de volume de l’éditeur
d’objet audio (Wave).
Normalement, chaque note MIDI a une valeur de dynamique qui détermine
avec quelle «force» la note est jouée. Changer la valeur de dynamique dans
l’éditeur d’objet fait varier le volume des notes de l’objet MIDI entre ses valeurs
minimale et maximale (0 à 127), ce qui se reflète dans les valeurs de dynamique
réelles des notes. Bouger le fader revient à bouger la poignée médiane de l’objet
MIDI en piste de VIP.

Position/Length (Position/Longueur)
Cette zone détermine la position de l’objet MIDI ainsi que sa longueur (Length).
Les réglages correspondent au déplacement de l’objet dans la piste de VIP ou au
changement de sa longueur à l’aide de la poignée inférieure, à gauche et à droite
de l’objet.

Fade In/Out («mode Max»)
Ces réglages déterminent les effets de fondu d’entrée (Fade In) et de sortie (Fade
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Out) d’un objet. Si vous ajoutez un effet de fondu à un objet MIDI, les
changements sont interprétés comme un changement de la valeur de dynamique
des notes affectées. Les durées de fondu peuvent être changées directement
dans l’objet à l’aide de ses poignées supérieures gauche et droite. En mode Max,
l’éditeur d’objet offre une sélection de différentes courbes.

Object Name (Nom de l’objet)
Saisissez ici le nom de l’objet.

MIDI Real-time Effects (Effets MIDI en temps réel)
Les 16 canaux MIDI possibles sont affichés en mode Max. Si l’objet MIDI n’a
pas de données pour un canal, celui-ci est grisé.
Les réglages d’un seul canal MIDI sont affichés en mode normal, réduit.

Canal d’entrée MIDI «IN Ch» (mode Max seulement): Coupe ce canal de
l’objet MIDI.

Canal de sortie MIDI «OUT Ch»: Dirige les données MIDI d’un canal vers
un autre canal.

Transp.: Transpose toutes les notes MIDI de ce canal.

Changement de programme (Program) et de banque (Bank): Les valeurs
saisies ici sont toujours transmises si l’objet est lu. Utilisez ces réglages si
différents objets d’une piste MIDI doivent employer des programmes différents
d’un synthétiseur. Dans ce cas, les réglages de piste, qui ont habituellement
priorité, doivent être sur «No change» (pas de changement), sinon tous les
réglages d’objet se référant à cela seront écrasés.

Crossfades (Fondus-enchaînés, en mode Max)
Vous pouvez régler (set)/obtenir (get) les réglages de fondu généraux (global)
dans les menus de la zone Fade In/Fade Out.

L’éditeur de fondu-enchaîné (Crossfade Editor) vous permet de faire des réglages
globaux pour les fondus MIDI. Toutefois, cela correspond au réglage de base de
tous les fondus-enchaînés du projet. Les fondus-enchaînés entre objets MIDI et
objets audio sont possibles. Créez un fondu-enchaîné entre deux objets et pressez
la touche «Set» pour le sauvegarder. Si le fondu-enchaîné est créé, vous pouvez
à tout moment l’employer pour d’autres objets en cliquant sur «Get».

Bypass effects (Court-circuiter les effets)
Désactive tous les effets en temps réel pour cet objet MIDI.

Link all Channels (Associer tous les canaux)
Les réglages seront changés simultanément pour tous les canaux.
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Quantize (Quantification)
C’est une quantification virtuelle rapide sans autres options, tandis que les
réglages de quantification de l’éditeur MIDI affectent immédiatement les notes
et modifient leur position de début. Elle devient effective durant la lecture de
toutes les notes MIDI. La quantification réelle des notes demeure inchangée.
Absolute et Relative se réfèrent aux résolutions absolue et relative du projet VIP
ou de l’objet.

Reload MIDI File (Recharger le fichier MIDI)
Il peut être nécessaire de recharger les données MIDI du fichier depuis lequel
l’objet a été créé. Note: Tous les changements précédents sont écrasés.

Bar definitions (Définitions de mesure)
Cela vous permet de faire vos propres réglages de mesure pour l’objet MIDI.
Les réglages peuvent différer du reste du projet ou d’autres objets MIDI. Les
quatre valeurs de la fenêtre de réglages (Numerator (numérateur), Denominator
(dénominateur), BPM (tempo) et PPQ (divisions par noire)) peuvent vous aider
si vous voulez augmenter la précision des notes et données MIDI. Par exemple,
vous pouvez spécifier une résolution (PPQ) différente pour permettre une
quantification plus fine.

MIDI Editor (Editeur MIDI)
Ouvre l’éditeur MIDI (Piano Roll), où vous pouvez facilement définir, éditer et
quantifier des événements MIDI.

Background color (Couleur de fond)
Change la couleur de fond de l’objet MIDI.

MIDI Track selection (Sélection de piste MIDI)
Utilisez cette option si vous voulez fractionner un fichier MIDI multipiste en
pistes de VIP indépendantes en changeant tous les objets MIDI comme un
groupe. Vous devez tenir compte du fait que cette fonction n’est activée que si
plusieurs objets MIDI sont activés dans le VIP. Une sélection de plusieurs objets
avec le lasso d’objets ou par succession de Shift+ clics sur les objets permet cela.

Play/Stop (Lecture/Arrêt)
Lance et arrête la lecture à partir de la position actuelle.

Editeur MIDI (Samplitude Classic & Professional seulement)
Ouvrir l’éditeur MIDI (MIDI Editor)
L’éditeur MIDI de Samplitude vous permet d’éditer les objets MIDI. L’éditeur
MIDI possède plusieurs éditeurs secondaires ou sous-éditeurs, affichages,
sélections et outils.
Double-cliquer sur un objet MIDI dans le projet ouvre l’éditeur MIDI. Sinon, il
peut être lancé pour l’objet MIDI sélectionné en cliquant sur la commande «MIDI
Editor» du menu «MIDI».
L’éditeur MIDI est ouvert à la position actuelle ou pour la sélection définie.
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Si aucun objet MIDI n’est sélectionné, une fenêtre apparaît dans laquelle vous
pouvez créer un objet à la position actuelle de lecture. Vous pouvez alors choisir
dans un petit menu de modèles MIDI prédéfinis dans le sous-menu «Templates»
(modèles) de Samplitude. Ce sont des fichiers MIDI standards que vous pouvez
copier ici ou directement exporter comme modèle (template) depuis Samplitude.
Si le dossier Template ne contient qu’un fichier, aucun menu n’est affiché et
l’objet est immédiatement créé.

Note: Habituellement, double-cliquer sur un objet audio ouvre l’éditeur d’objet. Vous
pouvez changer cette caractéristique pour les objets MIDI en décochant l’option «Open
MIDI Editor with double-click» dans le menu Options de l’éditeur MIDI.

Travail avec l’éditeur MIDI:
Représentation des notes, déplacement, zoom
Introduction
Les fichiers MIDI peuvent être édités dans trois zones principales de l’éditeur
MIDI:
– Piano Roll (affichage avec clavier type piano mécanique) ou Drum Editor

(éditeur de batterie) (il est possible de passer de l’un à l’autre)
– Editeur de contrôleurs (par ex. dynamique, volume MIDI …)
– Editeur de liste
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Plusieurs outils sont disponibles pour l’édition, par ex. le crayon ou la gomme.
Vous pouvez aussi employer le Piano Roll pour donner des valeurs précises à
chaque événement MIDI dans les champs d’édition.
Sauf dans quelques cas exceptionnels, les changements se réfèrent généralement
à tous les événements MIDI sélectionnés (affichés en rouge), par ex. la
suppression ou le déplacement de notes. Changer une valeur au sein d’une
sélection multiple applique le changement à tous les éléments sélectionnés. Par
exemple, vous pouvez sélectionner un groupe de notes dans le Piano Roll puis
changer la dynamique de ce groupe avec l’éditeur Velocity. Toutes les notes
sélectionnées seront modifiées.

Représentation des notes dans le Piano Roll et l’éditeur de contrôleurs (dont les
courbes de dynamique).
Les notes non sélectionnées dans l’éditeur sont affichées en bleu. L’intensité de
la couleur suit la dynamique: la dynamique croît avec l’intensité de la couleur.

Notes sélectionnées: Les notes sélectionnées sont affichées en rouge, une
couleur plus foncée signifiant là aussi une dynamique plus élevée.

Note: Les couleurs des notes sélectionnées peuvent aussi être définies individuellement
en fonction de leur dynamique. Ouvrez le fichier «vel_sel_map.bmp» du dossier Bitmap
et changez les couleurs selon vos goûts.

Evénement actuel: L’événement actuel s’affiche en rouge vif avec une bordure
rouge. Ses propriétés sont affichées dans les champs d’édition situés au dessus
du Piano Roll. Si un événement est sélectionné à la souris, il devient l’élément
actif.

Affichage des événements filtrés: Vous pouvez filtrer l’affichage de certains
événements pour améliorer la visualisation globale des événements dans un
objet MIDI.
Un objet MIDI de Samplitude peut contenir des événements pour jusqu’à 16
canaux MIDI et 16 pistes MIDI (pistes initiales du fichier MIDI standard
importé). Cela vous permet de piloter un instrument VST à multiples sorties
sur plusieurs canaux MIDI en n’employant qu’un seul objet. Avec l’éditeur MIDI,
les notes peuvent être éditées simultanément pour tous les canaux ou seulement
pour le canal sélectionné dans l’objet.
Plusieurs options de visualisation simples d’emploi sont disponibles. Vous
pouvez utiliser le filtre de canal «Channel Filter» (Menu «Options») pour afficher
tous les canaux ou seulement ceux sélectionnés. Les notes des autres canaux
sont grisées et ne peuvent pas être sélectionnées.

Exemple:
L’objet MIDI a des notes sur les canaux MIDI 1, 2 et 5. En sélectionnant les
canaux MIDI dans le sous-menu channel filter, vous pouvez rendre accessibles
à la sélection et aux outils d’édition toutes les notes des canaux 2 et 5. Sélectionnez



165

Le MIDI dans Samplitude
les deux canaux dans le menu. Toutes les notes non sélectionnées – filtrées – du
canal 1 sont grisées dans le Piano Roll et l’éditeur de liste.
Les événements des canaux filtrés peuvent être masqués complètement en
activant «Hide filtered MIDI data» dans le menu Options.
L’éditeur de liste a d’autres filtres d’affichage, qui n’agissent que sur la liste.
D’abord, les filtres d’affichage sont initialisés par les filtres de lecture (réglages
mute), mais les filtres peuvent être réglés indépendamment les uns des autres.

Affichage des événements coupés: Les notes peuvent être désactivées dans
l’éditeur d’objet MIDI (Ctrl+O) avec les cases à cocher «In Ch». Des événements
ainsi «coupés» sont grisés dans les éditeurs Piano Roll et Liste d’événements.
Les événements situés avant le début ou après la fin de l’objet sont également
affichés de façon plus claire par rapport aux événements coupés situés à l’intérieur
des limites de l’objet. Celles-ci sont identifiées par les lignes vertes dans l’éditeur,
ou par des sélections grises en mode d’affichage transparent.

Evénements au-dessus ou au-dessous de la visualisation actuelle: Deux
petits témoins rouges au-dessus et au-dessous de la barre de défilement verticale
sur le côté droit de l’éditeur MIDI indiquent s’il y a des notes en dehors de la
sélection affichée.

Déplacement et zoom
Réglez l’affichage et le zoom vertical et horizontal avec les barres de défilement
(comme en fenêtre de projet).

Molette de la souris: Défilement horizontal
Shift+Molette de la souris: Zoom vertical
Alt+ Molette de la souris: Défilement vertical scroll
Ctrl+Molette de la souris: Zoom horizontal

Couplage des fenêtres MIDI Editor et VIP
Si vous changez la vue ou le zoom avec les barres de défilement, maintenir la
touche Shift change la fenêtre correspondante, éditeur MIDI ou VIP.

Play/Play Solo
«Play Solo» ne reproduit que l’objet MIDI actuellement ouvert dans l’éditeur
MIDI (selon les réglages de filtrage du menu «Options»). «Play» reproduit la
totalité de l’arrangement.

Travail avec l’éditeur MIDI: sélection des événements
Sélection des événements MIDI (Piano Roll, Editeur de batterie, Editeur de
dynamique, Editeur de liste)
– Sélectionner les événements: clic gauche sur l’événement
– Ajouter/supprimer l’événement à/de la sélection: Ctrl+clic gauche sur

l’événement
– Changer ou régler l’événement actuel au sein d’une sélection multiple: Clic

gauche sur un événement sélectionné
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– Régler l’événement actuel, désélectionner tous les autres événements: Double-

cliquez sur l’événement
– Sélectionner les événements d’une même ligne ou sélection temporelle:

Maintenez Shift et cliquez
– Sélectionner toutes les notes de même hauteur: double-cliquez sur la touche

correspondante du clavier de gauche.
– Sélectionner toutes les notes: Ctrl+A (ne fonctionne que pour la hauteur choisie

avec le clavier, pour les notes de cette hauteur)
– Sélectionner la note suivante ou précédente: Touches curseur

Comme dans la liste, un simple clic est une méthode très efficace pour
sélectionner comme événement actif à éditer un événement unique dans un
groupe, par ex. un pattern.

Edition d’événements: Piano Roll

Outils d’édition
Il existe plusieurs possibilités d’édition pour les notes dans le Piano Roll; ce
sont les modes de souris. Les mêmes fonctions d’édition de notes (sauf la
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suppression) s’appliquent à tous les modes, qui ne diffèrent donc que par leur
réaction aux clics dans les espaces vides.

Sélection (Ctrl+1)
Lasso: Vous pouvez dessiner un cadre de sélection en tenant enfoncé le bouton
de la souris.
Un clic dans un espace vide annule une sélection.

Crayon (Ctrl+2)
Un clic gauche dessine une note. Son début et sa longueur sont déterminés par
les réglages actuels de quantification (Toolbar Editor).

Crayon à batterie ou «Drum Pencil» (Ctrl+3)
Une séquence de notes est dessinée. La longueur des notes et leurs intervalles
sont déterminés par les réglages actuels de quantification.
Quand on maintient Alt: La hauteur de la première note est conservée pour
toutes les notes dessinées ensuite. Ramener la souris en arrière (vers la gauche)
tout en maintenant son bouton pressé supprime les notes dessinées.

Crayon à pattern ou «Pattern Pencil» (Ctrl+4)
Dessine un motif de notes librement défini (Ctrl+P).
Quand on maintient Alt: La hauteur de la première note est conservée pour
toutes les notes dessinées ensuite. Ramener la souris en arrière (vers la gauche)
tout en maintenant son bouton pressé supprime les notes dessinées.

Outil dynamique «Vel» (Ctrl+5)
Cliquer sur une note et tirer modifie sa dynamique («Velocity»).

Gomme (Ctrl+6)
Cliquer sur une note la supprime. Faire glisser la souris avec le bouton pressé
supprime toutes les notes survolées.

Astuces:
– Le mode Gomme peut être activé n’importe quand en cliquant/tirant avec le

bouton droit de la souris. Par exemple, vous pouvez dessiner des notes avec
un crayon par clic gauche et supprimer des notes ajoutées par clic droit. Il
n’est pas nécessaire de changer d’outil.

– Double-cliquer sur une hauteur dans un espace libre sélectionne toutes les
notes ayant cette hauteur.

– e canal MIDI et la dynamique des notes créées peuvent être saisis dans les
champs d’édition de la section «New» au dessus du Piano Roll en mode dessin.

Edition de l’événement sélectionné (champs d’édition)
Vous pouvez éditer toutes les propriétés de chaque événement dans le Piano
Roll et l’éditeur de liste en employant les champs d’édition situés sous les outils
d’édition.
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Les champs suivants servent à cela:
– Ch (canal)
– Pitch (hauteur)
– Vel (dynamique)
– Pos (position de début)
– Len (longueur ou durée)

Pour éditer, double-cliquez sur la valeur affichée pour colorer son fond.
Maintenant, maintenez enfoncé le bouton gauche de la souris et tirez le curseur
en haut ou en bas pour augmenter ou diminuer la valeur.

Note: Maintenir enfoncée la touche Ctrl donne de plus grands changements de
valeur.

Vous pouvez aussi saisir des valeurs numériques avec le clavier ou utiliser la
molette de la souris pour changer la valeur.
Des caractéristiques spéciales concernent les multisélections:
Les valeurs des notes sont changées de façon relative quand elles sont modifiées
à la souris, avec la molette de la souris ou en saisissant des valeurs numériques
puis en pressant Entrée (hauteur et dynamique).
Des changements absolus s’effectuent si la touche «Shift» est pressée
simultanément à l’action de la souris ou quand la saisie est entérinée par
Shift+Entrée.

Note: Les changements de canaux sont toujours absolus, comme ceux des événements
de contrôleur MIDI pour l’octet 1 (= type de contrôleur). L’octet 2 ne peut toujours
être changé que pour l’événement actuel.

Travail avec l’éditeur de contrôleurs: Sélection et édition
d’événements
Ouverture
L’éditeur de contrôleurs se situe sous le Piano Roll et peut être masqué. Il permet
d’afficher et d’éditer 4 contrôleurs MIDI simultanément.
Ouvrez-le en cliquant sur le bouton sous le clavier ou par le raccourci clavier
«Alt+V». Sa taille peut être changée en cliquant sur les boutons +/- dans son
coin inférieur droit.
Les valeurs des événements existants y sont affichées sous formes de barres
verticales colorées. Une barre plus foncée et plus haute symbolise une valeur
plus élevée. Les barres sont situées directement sous les notes.

Outils
L’éditeur de contrôleurs offre quelques outils pour éditer les courbes et les valeurs.
Sélection (flèche): Fait une sélection à la souris.
Dessin (crayon): Dessine de nouvelles valeurs de contrôleur sous forme de courbe
ou de valeurs individuelles par simple clic sans glissement.
Edition (croix): Change les valeurs existantes
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Vue multiple
Les trois multi-boutons servent à afficher ou masquer les courbes de tous les
contrôleurs possibles. Cliquer sur la zone de menu des boutons ouvre un menu
qui vous permet de choisir un contrôleur MIDI pour cette bande de contrôleur.
Sélection et traitement des notes: En cliquant dans la partie haute d’une barre
de contrôleur, la valeur du contrôleur peut être changée immédiatement en la
tirant à la souris. Cliquer dans les deux tiers inférieurs de la barre sélectionne la
note correspondante, qui s’affiche dès lors en rouge dans l’éditeur.

Astuces:
– Dans les événements polyphoniques, les barres sont situées les unes au dessus

des autres, rendant difficile la sélection de la note voulue. Pour n’éditer que
les notes ayant une certaine hauteur, par ex. toutes les notes C1, dans l’éditeur
de contrôleur, cliquez sur cette touche dans le clavier. La touche et le fond de
la ligne de hauteur sélectionnée sont surlignés. Seules les notes de cette
hauteur sont affichées dans l’éditeur de contrôleurs.

– Des notes de hauteurs différentes, par ex. tous les C1, D1 et A1, peuvent être
affichées par Ctrl+Clic (ou Shift+Click pour une multisélection continue entre
les deux clics). Ce ne sont que des options d’affichage de l’éditeur de contrôleur.
Il n’est pas possible de sélectionner plusieurs notes par double clic.
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– Une autre possibilité consiste à éditer sélectivement les barres de contrôleur

situées au dessus les unes des autres, en s’aidant du fait que la barre de la
note actuellement sélectionnée est sélectionnée/éditée par la souris. Par
conséquent, cliquez d’abord sur la note dans le Piano Roll, ou cliquez dans
les barres situées au dessus des autres puis sélectionnez la note requise avec
les touches curseur. Puis changez la valeur du contrôleur en cliquant dans le
tiers supérieur de la zone rouge (actuellement sélectionnée) de la barre.

– En plus de directement changer la valeur de dynamique de la note sélectionnée,
vous pouvez changer plusieurs valeurs de dynamique d’un coup en cliquant
dans un espace libre et en tirant la souris sur plusieurs valeurs de dynamique
tout en maintenant son bouton enfoncé. Vous pouvez aussi créer des
séquences en faisant faire une courbe à la souris. Toute (multi-)sélection
antérieure est ignorée. Par exemple, vous pouvez facilement créer un effet de
crescendo ou decrescendo.

Editeur de liste (Event List)
Ouverture
L’éditeur MIDI a un affichage intégré de tous les événements sous forme de
liste. Cet éditeur de liste s’ouvre avec le bouton situé au dessus du clavier ou par
le raccourci «Alt+L».
Quand il est ouvert et activé pour l’édition, il est encadré d’un mince filet rouge.
Cela permet d’expliquer que certaines fonctions, par ex. la sélection d’événement
suivant/précédent (touches curseur) ou la commande «Select all» (tout
sélectionner), ne concernent que la liste.
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Travail avec l’éditeur de liste
L’éditeur de liste ne se contente pas d’afficher les événements de note, il affiche
aussi ceux de contrôleurs MIDI et les données exclusives de système (Sysex).
Ces données peuvent être masquées et même filtrées durant la lecture («mute»).
Double-cliquer sur un message Sysex de la liste ouvre un éditeur simple pour
visualiser et éditer les messages Sysex.
Une note est toujours faite d’un événement Note On et d’un événement Note
Off qui sont toujours sélectionnés et édités ensemble (les événements Note Off
ne sont par défaut pas affichés, mais peuvent l’être si l’on coche la case «Show
Note Off» sous l’éditeur).
De nouveaux événements peuvent être directement créés dans l’éditeur de liste
en utilisant le bouton «Insert». Les valeurs actuelles des champs d’édition du
cadre supérieur du Piano Roll s’appliquent toujours. Par conséquent, avant
d’éditer ces champs, veuillez vous assurer qu’aucun événement n’est sélectionné
dans le Piano Roll.

Astuce: Si aucun événement n’a été sélectionné, vous pouvez déterminer le point
d’insertion en réglant le curseur de lecture.

Pour n’éditer que certains événements, l’éditeur de liste a un filtre d’affichage
pour chaque colonne. Ce sont les petites cases à cocher au dessus de ses colonnes.
Sélectionnez un événement représentatif. Cela peut être par exemple une note
d’une certaine hauteur. Puis cliquez sur le filtre d’affichage correspondant à la
colonne voulue afin de n’afficher que des événements dont la valeur est identique
pour cette colonne, par ex. ayant la même hauteur que l’événement sélectionné.
Tous les autres événements sont maintenant masqués.
Les filtres d’affichage peuvent être associés. Par exemple, vous pouvez utiliser
la commande «Select all» (Ctrl+A) pour tout sélectionner puis n’éditer que les
événements de changement de commande 7 (volume) du canal MIDI 6.

Conseils & astuces
– Vous pouvez copier & coller des données MIDI dans l’éditeur et entre

différents objets MIDI. Les données MIDI sont toujours insérées à la position
actuelle du curseur de lecture.

– Duplication: Si la grille est activée (Menu «Options» – Quantization grid
active), les notes sélectionnées sont copiées et insérées à partir du point de
grille suivant la sélection. Ils sont sinon insérés immédiatement après la
sélection.

– Création de patterns (motifs) d’après la sélection (Ctrl+P): La longueur des
patterns est quantifiée si la grille est active. Le pattern peut être dessiné dans
l’objet MIDI en mode de crayon à pattern ou «Pattern Pencil».

– Pour directement sélectionner les notes d’une certaine hauteur, double-cliquez
sur un espace vide à cette hauteur dans l’éditeur Piano Roll ou sur son clavier.

Quantification
Introduction
De petites irrégularités survenues lors de l’enregistrement du pattern peuvent
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être aplanies par la fonction de quantification.
La fonction «Swing» vous permet de donner du «groove» à des séquences qui
sonneraient sinon de façon mécanique.
Cliquer sur «Q» déplace toutes les notes sélectionnées sur une grille de
quantification réglable. Si aucune note n’a été sélectionnée, toutes les notes
sont quantifiées.
Vous pouvez choisir une valeur de base (1/4, 1/8, etc.), de triolet ou de n-olet
pour la quantification de début et de durée. Des valeurs pointées sont aussi
possibles pour la quantification de durée.

Options de quantification «Quantization Options» (menu «Options» de l’éditeur
MIDI):
Rigueur de la quantification en % (Strength 0...100):
– «100» déplace précisément l’événement sur la grille de quantification
– «50» déplace l’événement sur le point intermédiaire entre la position actuelle

et la grille de quantification
– «0» signifie qu’il n’y a aucun mouvement -> Quantification désactivée

Jeu ternaire en % (Swing 0…100):
Règle les cadences de jeu non binaires (par ex. ternaire). Détermine la division
de la grille en points intermédiaires.
– 50... Division «50-50»: Les croches intermédiaires sont à égale distance des

croches qui les entourent (jeu «binaire»)
– 67... Méthode de jeu ternaire,  division en 3 pour 2

Fenêtre en % (Window 0..100):
Fenêtre de quantification, les événements visibles dans cette fenêtre sont
quantifiés, les autres restent à leur position.
– 100: La fenêtre couvre la totalité de la sélection entre les divisions de la grille

de quantification.
– 50: La fenêtre couvre la moitié de l’intervalle de quantification. Les événements

distants d’un quart de l’intervalle de grille de part et d’autre d’une ligne de
grille sont quantifiés.

– 0: Aucune fenêtre -> Quantification désactivée.

Décalage (Offset):
-100...100
0  La totalité de la grille de quantification est décalée:
-100 donne à un réalignement sur la gauche (plus tôt), +100 sur la droite (plus
tard), d’une valeur correspondant à un demi-intervalle de grille.

N-olet (N-tuplet: Off, 3, 5, 7, 9):
La grille est divisée en sections configurées en fonction du nombre de divisions
ternaires (par ex. 8T, 16T, etc.). N’importe quelle valeur autre que les valeurs
presets peut être saisie. Veuillez noter que vous devez travailler au choix avec les
réglages Swing ou N-tuplet.
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Réinitialisation (Reset):
Restaure les valeurs par défaut. Quand la grille est activée, les notes sont
«aimantées» sur les valeurs de quantification lors de la création et de l’édition.
Les options de quantification sont aussi prises en compte; Par exemple, les notes
se calent d’abord sur leur position respective dans la fenêtre de quantification
durant le déplacement.

Raccourcis de l’éditeur MIDI
Espace Lecture/arrêt
Ctrl+Espace Lecture en solo
0 (pavé numérique) Arrêt à cette position
Suppr., Ret. Arrière Supprime tous les événements sélectionnés

Ctrl + A Sélectionne tous les notes sans filtrage d’affichage
(Piano Roll) ou Evénements (Liste)

Ctrl + Z Annuler
Ctrl + Y Restaurer
Ctrl + I Importer SMF (fichier MIDI standard)
Ctrl + E Exporter SMF (fichier MIDI standard)
Alt + L Afficher/masquer l’éditeur d’événement
Alt + V Afficher/masquer l’éditeur de dynamique
Alt + R Afficher la grille de quantification
Ctrl+1 Mode de sélection
Ctrl+2 Mode de dessin
Ctrl+3 Mode de dessin de batterie
Ctrl+4 Mode de dessin de pattern
Ctrl+5 Mode de changement de dynamique
Ctrl+6 Mode de suppression
Ctrl+7 Mode loupe
Ctrl + Q Quantifier
Alt + Q Ouvrir les réglages de grille/quantification «Global
grid/quantize settings»
Curseur haut/gauche Sélectionner note/événement précédent
Curseur droit/bas Sélectionner note/événement suivant
R Grille on/off
F Défilement automatique durant la lecture
Ctrl + Curseur haut Zoom vertical avant
Ctrl + Curseur bas Zoom vertical arrière
Ctrl + Curseur gauche Zoom  horizontal avant
Ctrl + Curseur droit Zoom  horizontal arrière
Molette de la souris Défilement horizontal
Ctrl+ Molette de la sourisZoom  horizontal
Shift+ Molette de la souris Zoom vertical
Alt+ Molette de la souris Défilement vertical
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Editeur de batterie (Drum Editor) (Samplitude Classic & Professional
seulement)
Ouverture (passage en mode éditeur de batterie)
Après avoir ouvert l’éditeur MIDI (double-clic sur un objet MIDI), cliquez sur le
menu «Options» et sélectionnez «Drum Editor». Une liste d’instruments de
batterie s’affiche maintenant à gauche (à la place du clavier de piano).

Note: Si une configuration de batterie (drum map) est activée dans la piste
(indiquée par la croix sous «Drum» dans les informations de piste), l’éditeur de
batterie est automatiquement chargé à l’ouverture de l’éditeur MIDI.

Mode Cell
Si l’éditeur de batterie est ouvert, le mode Cell est activé par défaut. C’est
simplement un mode d’affichage qui permet une autre visualisation es
événements MIDI.
Les notes sont affichées comme des cellules, c’est-à-dire que la véritable longueur
de la note n’est pas affichée, mais vous pouvez à la place choisir une longueur
d’affichage individuelle pour chaque instrument.

Note: La valeur de longueur en mode Cell du Piano Roll définit la largeur de
l’affichage.
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Le but du mode Cell est d’améliorer l’affichage, particulièrement si vous éditez
de la batterie avec beaucoup d’événements rythmiques. Cela donne une méthode
de travail plus structurée et plus efficace car l’affichage peut être limité aux
informations essentielles: position de début de note et dynamique.

Edition des événements de batterie
Les modes de souris suivants sont disponibles pour éditer les événements dans
le Piano Roll:

Sélection (Ctrl+1): Utilisez ce mode pour sélectionner et déplacer les
événements de batterie et pour changer la longueur d’un ou de plusieurs
événements simultanément.

Mode crayon (Ctrl+2): Des événements de batterie peuvent être insérés dans
ce mode. Si la quantification est activée, les événements se calent immédiatement.

Crayon à batterie ou «Drum Pencil» (Ctrl+3): Ce mode est aussi un mode de
dessin; toutefois, la longueur de quantification est aussi prise en compte lors du
dessin des événements.

Crayon à pattern ou «Pattern Pencil» (Ctrl+4): Ce mode vous permet de dessiner
des motifs (patterns) de batterie (ou mélodiques). Vous pouvez trouver des
patterns presets en cliquant sur la petite flèche de l’icône. Si vous désirez dessiner
votre propre pattern, vous devez d’abord le sélectionner en «mode Sélection » et
presser Ctrl+P (ou sélectionner dans le menu «Edit» [de l’éditeur MIDI] > «Create
pattern from selection»). Quand vous avez sélectionné un pattern preset ou
créé le vôtre, vous pouvez commencer à dessiner depuis n’importe quelle
position, par ex. F#2 ou E3. La plus basse note du pattern représente la hauteur
de saisie.

Mode dynamique «Vel» (Ctrl+5): Vous pouvez sélectionner des événements
dans ce mode et changer la valeur de dynamique de tous les événements
sélectionnés les uns par rapport aux autres. Quand la touche Shift est maintenue,
des valeurs absolues sont programmées, c’est-à-dire que tous les événements
modifiés prennent la même valeur de dynamique.

Mode Gomme (Ctrl+6): Utilisez ce mode pour supprimer individuellement
des événements d’un simple clic de souris.

Mode loupe (Ctrl+7): Dessinez un rectangle sur lequel zoomer. Clic gauche
pour un zoom avant; clic droit pour un zoom arrière.

Mode d’affichage de la dynamique «Vel»
Activer ce bouton pour que la hauteur des blocs de notes représente la dynamique
(velocity) de note. Dans tous les modes de souris (sauf la «gomme»), vous pouvez
donc changer la dynamique en cliquant sur le bord supérieur d’une note avec la
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souris, sans avoir à faire le changement dans l’éditeur de contrôleurs.

Drum Maps (Configurations de batterie)/Drum Map Editor (Editeur de
configuration de batterie)
Les configurations de batterie ou «Drum Maps» assignent des instruments de
batterie  individuels aux notes, par ex. grosse caisse, charleston, caisse claire,
etc. Les notes de base, le canal MIDI et la plage dynamique peuvent être définis
pour chacun de ces instruments. Par défaut, une configuration General MIDI
est employée en premier pour assigner les noms d’instruments. De plus, vous
pouvez régler individuellement pour chaque instrument les valeurs de
quantification et la largeur d’affichage.
La configuration de batterie peut être changée dans les informations de piste (si
la piste est réglée en enregistrement MIDI) via la case «Drum», et dans l’éditeur
Drum Editor lui-même obtenu via un menu contextuel en cliquant sur la case
«Drum».
Toutefois, votre synthétiseur (virtuel ou réel) peut utiliser une configuration
autre que General MIDI.
Cela signifie que les sons produits par les événements de batterie peuvent différer
de ce que vous vous attendez à entendre (par ex. un tom aigu à la place d’une
grosse caisse). Dans ce cas, vous devez changer ou réarranger la configuration.
Vous pouvez faire cela soit directement dans l’éditeur de batterie (Drum Editor),
soit dans l’éditeur de configuration de batterie (Drum Map Editor), qui est aussi
beaucoup plus pratique pour gérer des changements ainsi que le chargement et
la sauvegarde de configuration en tant que fichier.
Le Drum Map Editor vous permet d’associer toute note jouée à une touche
différente et de lui donner un nom. Vous pouvez aussi assigner à chaque
instrument des valeurs de quantification de grille et de longueur ainsi qu’un
canal de sortie MIDI.

Pitch: C’est la note MIDI reçue.

Instrument: C’est le nom de l’instrument de batterie, par ex. «Grosse caisse
1».

Grid: La grille graphique de l’instrument agit comme la grille de Piano Roll
(c’est-à-dire sans quantification en temps réel). Cela est pris en considération
lors de la quantification et du déplacement de notes.

Length: Définit le «magnétisme» des longueurs (durées) de note. Cela est pris
en considération lors de la quantification et du déplacement de notes.

Output note: C’est la note vers laquelle l’instrument de batterie (la note MIDI
reçue du champ «Pitch») est «dirigé» ou «associé».

Channel: Un canal MIDI individuel peut être assigné à chaque instrument.

Exemple: Vous voulez utiliser un certain instrument de batterie, le preset GM 117
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(tambour taiko). Sélectionnez le preset «117 Taiko Drum» dans la case «Prg»
(Programme) et assignez l’instrument requis à un canal différent (pas le 10!). La
note produite détermine la hauteur de l’instrument.

Note: «All» doit être sélectionné comme canal MIDI de la piste. Le canal 10 doit
être explicitement sélectionné comme sortie MIDI dans l’éditeur de batterie Drum
Editor pour tous les instruments qui devront être employés via le canal MIDI 10
(par ex. la grosse caisse Bass drum 2).

Quantification
Chaque instrument de batterie peut avoir sa propre quantification.
Zoomez verticalement dans l’éditeur jusqu’à ce que vous puissiez voir les réglages
individuels pour les événements de batterie. Sélectionnez le mode zoom et
sélectionnez la zone d’événements de batterie à éditer.
Vous pouvez maintenant choisir entre 1 (rondes) et 32 (triples-croches) pour la
durée et la grille de chaque événement de batterie. Des valeurs de N-olet de 1 à
32 sont aussi disponibles. Elles sont précédées d’un grand T (comme dans «N-
tuplet»).
Sinon, une quantification globale peut aussi être employée pour la grille et la
durée, ses réglages se trouvant en haut de l’éditeur MIDI.

Note: Vous pouvez définir quelle valeur doit remplacer «n» dans les n-olets avec la
quantification globale dans le menu «Options» > «Quantization Options» grâce au
paramètre «N-tuplet». Les réglages individuels de chaque instrument de batterie se
trouvent dans le menu à côté de la description de l’instrument.

Changements de tempo et de mesure
Introduction
Les changements de tempo et de mesure sont des critères expressifs importants
dans toute musique. Samplitude offre des possibilités de création étendues.
Dans ce cas, la définition de changement de tempo et de mesure est entièrement
obtenue au moyen de marqueurs dans la fenêtre de projet. Des marqueurs
spéciaux de tempo et de mesure peuvent être définis en utilisant des changements
linéaires ou immédiats du tempo ou de la mesure. Les courbes de tempo qui en
résultent sont automatiquement calculées. L’affichage de la fenêtre de transport
sert au contrôle visuel du tempo ou de la mesure actuels, les valeurs actuelles
étant affichées lors de la lecture ou du repositionnement de la valeur actuelle.
La grille musicale peut aussi être réglée en plaçant des points de support sur
certaines positions temporelles ou sur des événements audio et MIDI déjà
disponibles, par ex. une piste de batterie de référence (méthode appelée Advanced
Tempo Mapping).
Il y a trois types de marqueurs:
– Tempo
– Format de mesure
– Position de mesure

Bien sûr, les informations de tempo peuvent aussi être reçues quand des fichiers
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MIDI sont importés dans le projet actuel. Samplitude crée automatiquement
les marqueurs de tempo requis.
Si nécessaire, des événements MIDI/audio peuvent être couplés à la grille
musicale et positionnés précisément pour des changements de tempo.

Marqueurs de tempo
Un nouveau projet a d’abord un simple tempo «Master» qui peut être défini
dans la commande de transport ou dans les réglages de projet (raccourci clavier:
«I»).
Vous pouvez à tout moment définir un nombre illimité de changements de
tempo directement dans la fenêtre de projet. Le marqueur de tempo est l’outil le
plus important car il permet de définir un changement de tempo sur une position
précise, une interpolation linéaire pouvant s’effectuer à partir de la définition
de tempo précédente.

Note: Les changements de tempo d’un fichier MIDI peuvent être importés dans le
projet actuel et traduits par la création de marqueurs de tempo.

Exemple: Deux noires de l’illustration précédentes sont visibles avant et après le
changement de tempo; la grille et le magnétisme s’adaptent au tempo modifié, et vous
voyez clairement la différence de durée des noires avant et après le changement de
tempo.

Marqueur de format de mesure
Le marqueur de format de mesure change le type de mesure après sa position,
par ex. une mesure 4/4 passe en 3/4. Un nouveau projet a tout d’abord des
mesures uniformes en 4/4 pouvant être définies dans la commande de transport
ou dans les réglages de projet (raccourci clavier: «I»).
Les marqueurs de mesure ne peuvent être insérés qu’au début d’une mesure. Si
un fichier MIDI importé contient des changements de mesure, des marqueurs
de format de mesure sont automatiquement créés.

Marqueurs de position de mesure (Advanced Tempo Mapping)
Le tempo d’une pièce musicale est généralement défini lors de sa composition.
Si vous désirez augmenter le tempo à certaines positions de mesure, définissez
simplement un marqueur de tempo, une interpolation linéaire s’effectuant à
partir de la définition de tempo précédente.
Toutefois, le matériel audio enregistré ne correspond pas souvent au tempo du
projet, par ex. une piste de référence de batteur pour donner le tempo aux futurs
enregistrements ou du matériel supplémentaire composé avec beaucoup de
nuances de tempo. Plutôt que de placer des marqueurs de tempo ou même de
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devoir adapter ce matériel de référence par time-stretch, vous pouvez créer la
grille musicale sur certaines positions temporelles dans le parcours linéaire de
lecture du projet à l’aide de points de support nommés marqueurs de position
de mesure. Ainsi, vous pouvez synchroniser la grille de mesures, la grille musicale
et les données MIDI correspondantes avec le matériel audio disponible.

Exemple: Le batteur a enregistré une piste à l’aide d’un métronome, mais n’a
volontairement pas frappé les débuts de mesure exactement sur les temps. La grille
musicale est adaptée pour conserver cette pulsation (groove) de l’interprétation. En
plaçant un marqueur de position de mesure, la mesure «20» du projet, où démarre le
chorus, est exactement calée sur le premier temps de la vingtième mesure jouée par le
batteur.

Cet exemple pratique montre que les marqueurs de position de mesure servent
à combiner la position d’échantillon/temporelle (ou SMPTE) basée sur l’audio
avec la position des mesures musicales au moyen de points de support définis.
Cela permet l’édition facile de projets dont le tempo change quand la grille
musicale est éditée dans la ligne de temps réelle («La mesure 20 doit commencer
à ce point dans le temps!»).
Un marqueur de tempo est différent en cela qu’il définit une commande claire:
plus vite (ou plus lentement) à partir de là. Un marqueur de position de mesure
définit lui indirectement le tempo en l’ajustant avant le marqueur de telle façon
que la position musicale désirée («Mesure 20») corresponde précisément à la
position du marqueur.

La grille, l’affichage de grille, le métronome et les événements de l’éditeur MIDI
sont automatiquement réglés en fonction des changements de tempo.

Note: Les marqueurs de position de mesure suivant immédiatement un marqueur de
tempo créent toujours un rattrapage de tempo. Au lieu d’un saut de tempo, un
marqueur de position de mesure sert à établir un rattrapage de tempo s’il y a un
marqueur de position de mesure immédiatement après le marqueur de tempo. Comme
le tempo avant le marqueur de position de mesure a déjà été défini, l’ajustement de la
position musicale doit s’effectuer en diminuant ou en augmentant le tempo de façon
à ce que la position de mesure requise corresponde à la position temporelle requise sur
le marqueur de position de mesure.

Travail avec les marqueurs de tempo et de mesure
Création de marqueurs de tempo
Les changements de tempo et de mesure dans Samplitude se règlent directement
dans la fenêtre de projet à l’aide des marqueurs de projet.

Ainsi, vous devez créer un marqueur pour insérer un changement de tempo
sur une certaine position de lecture. Il y a plusieurs façons de faire cela:

1. Fenêtre Tempo/Time Signature
Réglez le curseur (la tête) de lecture sur la position où vous voulez le
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changement de tempo ou de mesure. L’option «Snap to grid» (magnétisme
de la grille) est très utile pour directement placer le curseur sur une mesure
ou une noire. Cliquez sur le bouton de magnétisme (icône de cadenas) dans
la commande de transport (section Tempo).
Ouvrez la fenêtre Tempo/Time Signature via le menu contextuel (clic droit
sur la barre temporelle) ou le menu MIDI.
Cliquez sur le bouton «New Marker» de la fenêtre. Un marqueur est inséré à la
position actuelle du curseur. Vous pouvez maintenant employer les options de
marqueur pour en déterminer les propriétés. Pour un nouveau marqueur de
tempo, saisissez le tempo voulu dans le champ BPM et pour un marqueur de
mesure le nouveau format de mesure (Time signature).
Veuillez noter que les réglages ne concernent que les marqueurs actuellement
sélectionnés dans la liste.
Sachez aussi qu’un marqueur de mesure ne se place qu’au début d’une mesure.
Si la tête de lecture est sur une autre position, le marqueur est automatiquement
déplacé au début de la mesure suivante.

2. Menu des marqueurs
Les marqueurs de tempo et de mesure peuvent aussi être créés via le menu
contextuel des marqueurs et le menu MIDI du programme. Vous pouvez bien
sûr assigner des raccourcis-clavier.

3. Mode Timestretch de souris: Clic sur la ligne de temps
En mode Timestretch de souris, vous pouvez créer directement des marqueurs
d’un clic sur la position de lecture voulue.

Marqueur de tempo: Shift + Clic
Marqueur de position de mesure: Alt + Clic

Edition de marqueur/ fenêtre de marqueur de tempo/mesure
Si un marqueur de tempo est changé ou un marqueur de position de mesure
est déplacé, cela influence les marqueurs suivants et les projets audio/ MIDI
dans le VIP.
Il y a principalement deux possibilités: La position temporelle reste constante,
ou la position musical demeure et c’est la position temporelle qui s’ajuste (fenêtre
tempo/time signature).
Illustration: La position temporelle dans le VIP est la position absolue dans le
VIP. La position musicale est flexible, ce qui est rendu clair par la grille. Maintenir
la position musicale signifie donc que les objets ou marqueurs sont adaptés à la
nouvelle grille créée et que leur position temporelle change donc dans le VIP. Si
la position temporelle est conservée, c’est la position musicale qui change en
conséquence.
Quand des marqueurs de tempo sont manipulés, le comportement des
marqueurs, objets audio et MIDI peut être contrôlé séparément. Avec chaque
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préréglage, les positions musicales (grille) sont maintenues pour les objets MIDI
et les marqueurs de tempo, tout comme la position temporelle des marqueurs
et objets audio. La position temporelle est toujours conservée si la touche «Alt»
est pressée pendant la manipulation avec la souris.
La position temporelle est toutefois toujours conservée pour les pistes fixes
(preset). Cela peut se changer en fenêtre de marqueur de tempo.

Dans cet exemple, le premier marqueur de tempo de la seconde image a été changé.
L’objet MIDI et le second marqueur de tempo ont été déplacés de façon correspondante
pour que les positions musicales (3:01:000 et 4:01:000) soient conservées. La position
temporelle de l’objet audio n’a pas changé, aussi sa position musicale a-t-elle avancé
(de 2:2:000 à 2:01:181).

Autres options:
Chaque marqueur de tempo et de position de mesure peut être ignoré grâce à
l’option «Bypass». Cela se fait automatiquement pour les marqueurs de position
de mesure si des positions absurdes ont été créées durant le déplacement, par
ex. si des marqueurs de position de mesure sont échangés (mesure 20 avant la
mesure 19) ou déplacés dans le projet à une position qui ne peut pas être obtenue
par interpolation du tempo.

Ignore all Tempo Markers: Dans la fenêtre Tempo/Time Signature, il y a une
option pour ignorer tous les marqueurs de tempo. Dans ce cas, seul le tempo
réglé pour le projet est employé («I»).

Manipulation des marqueurs de tempo en mode Timestretch de souris.
Le mode Timestretch de souris simplifie le travail avec les marqueurs de tempo.
Vous pouvez facilement créer des marqueurs de tempo par Shift+clic de souris.
Les marqueurs sont alors initialisés en fonction du tempo. Vous pouvez toutefois
immédiatement adapter ce tempo en maintenant le Shift+clic et en tirant la
souris.
Les marqueurs de position de mesure sont créés par Alt+clic de souris et peuvent
être déplacés par Alt+mouvement horizontal de la souris (sans changer la position
temporelle), par ex. pour manipuler la grille de mesures et l’adapter aux
événements audio disponibles.

Conseils, exemples d’utilisation
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– Chargement de fichiers MIDI comprenant des changements de tempo: les

changements de tempo sont adoptés par le projet actuel et pris en compte
dans les éditions à venir et dans l’éditeur MIDI.

– Les marqueurs de tempo peuvent être placés lors de la composition dans
l’éditeur MIDI (ils s’appliquent alors à toutes les pistes). Les objets MIDI et
marqueurs de tempo suivants conservent leur position musicale (réglage
avancé).

– La grille peut être ajustée sur les événements audio disponibles, par ex. en
assignant des numéros de mesure à certaines positions temporelles. Vous
pouvez utiliser soit la commande de menu «Set new Bar Position Marker»
pour créer un marqueur à la position dans le projet et pouvez assigner la
position de mesure correspondante soit, pour de plus petits changements,
Alt+clic de souris sur la position de grille de mesure correspondante et la
déplacer immédiatement à la position temporelle voulue, par ex. sur le début
d’un objet.

– Si le projet contient des données MIDI, elles sont automatiquement ajustées
(preset). La nouvelle grille de tempo créée sert dans l’éditeur MIDI pour
l’édition ultérieure ou une nouvelle composition (par ex. quantification).

– Quand vous travaillez avec des fichiers MIDI et des changements de tempo
complexes, la carte de tempo (tempo map) peut être désactivée et, si nécessaire,
le tempo peut être réduit avant l’enregistrement de nouveaux fichiers MIDI.
Après enregistrement, la carte de tempo peut être réutilisée. Les données
MIDI nouvellement enregistrées sont maintenant adaptées automatiquement.

Automation MIDI
Introduction
En plus de l’enregistrement et de la lecture de base des données de contrôleur
MIDI dans l’éditeur MIDI, jusqu’à 16 contrôleurs peuvent être utilisés
directement dans la piste pour automatiser des paramètres dans le mode simple
d’emploi d’affichage de courbe. Les fonctions d’édition correspondent à
l’automation des courbes de volume, panoramique et surround audio et à
l’automation des plug-ins VST.
Samplitude accepte:
– Les 128 contrôleurs MIDI continus à 7 bits sur les 16 pistes MIDI disponibles
– Les messages MIDI sysex à 7 bits jusqu’à une longueur de 32 octets (1 octet

de données d’une résolution de 7 bits)
– Les messages sysex à 7 bits selon l’encodage spécial de la table de mixage

O2R (2 octets de données chacun d’une résolution de 7 bits)

Sélection et assignation des contrôleurs
Sélection
D’abord, sélectionnez les ports de lecture et d’enregistrement MIDI pour la
piste. Cela se fait dans les options de piste et ne correspond pas nécessairement
aux périphériques globaux de lecture et d’enregistrement MIDI pour les pistes
uniquement MIDI. Le périphérique de lecture MIDI peut aussi être un
instrument VST, qui est alors sélectionné en fenêtre automation puis automatisé.
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Les effets VST peuvent aussi être automatisés de cette façon. Seul l’effet doit
être sélectionné en premier dans la section «New» de la liste.

Note: Les courbes de plug-in peuvent aussi être activées dans la fenêtre de
paramètres VST du plug-in correspondant. Elle est ouverte si le plug-in a sa propre
interface graphique. Vous pouvez aussi ouvrir la fenêtre des paramètres
manuellement en ouvrant le plug-in avec sa propre interface graphique et en
sélectionnant «VST Parameter Window» dans le menu «VST Plug-in» de la
fenêtre du plug-in VST.

L’option «MIDI Controllers» du menu MIDI ouvre la fenêtre des contrôleurs
où se font tous les réglages d’assignation automatique, d’enregistrement et de
lecture des pistes de contrôleur.
L’option la plus importante pour enregistrer ou actualiser les courbes de
contrôleur est «Record/update MIDI controller curves on this track while
playing». Elle se trouve dans cette fenêtre et dans la fenêtre Track Information.
Pour enregistrer ou actualiser les courbes de contrôleur, vous devez cocher ce
paramètre pour au moins une piste.

Assignation
Il existe plusieurs façons d’assigner des contrôleurs MIDI à une piste.

Manuellement: Les numéros de contrôleur et les canaux correspondants
peuvent être sélectionnés dans les menus déroulants. Chacun des 16 contrôleurs
alloués par piste peut être individuellement nommé ou un nom peut être choisi
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dans le champ de nom de contrôleur. Les noms proposés pour les nouveaux
contrôleurs dépendent du réglage fait pour «New MIDI Controller».

Automatiquement: Quand l’option «record/update controller curves» est
activée, les contrôleurs MIDI standards reçus sur ce canal sont automatiquement
associés (en fonction du réglage fait pour «New MIDI Controller») et un nouveau
nom leur est donné avec une nouvelle couleur automatiquement définie en
fonction du réglage «Names for new controllers».

Via le bouton d’apprentissage «Learn»: Le premier emplacement de
contrôleur libre peut être «apprise» en activant le bouton «Learn» et en envoyant
les données de contrôleur appropriées (par ex. en déplaçant le fader
correspondant de la console de mixage numérique ou de la C-Console). Si aucun
emplacement de contrôleur n’est disponible, sélectionnez une autre piste ou
supprimez un contrôleur en choisissant un libellé vierge dans le champ de nom
de contrôleur. Si l’apprentissage a été réussi, le «Learn» rouge disparaît. Les
contrôleurs Sysex doivent être «appris».
Le format Sysex spécifique de la table de mixage O2R peut être appris en utilisant
la fonction «Learn O2R».

Traitement des pistes de contrôleur
Les contrôleurs activés sont transmis. Dès que des contrôleurs sont reçus, ils
sont soit assignés à de nouvelles pistes soit mis à jour s’ils étaient déjà assignés
(si l’enregistrement de contrôleur est activé). Les valeurs enregistrées sont à
nouveau transmises une fois écoulé le temps réservé à la manipulation par
l’utilisateur.
Si le transfert MIDI est bidirectionnel, c’est-à-dire que l’appareil distant peut
transmettre et recevoir des valeurs, alors MIDI THRU doit être désactivé sur
l’appareil ou le logiciel distant.
Les contrôleurs sont enregistrés durant la lecture. Pour travailler avec les
contrôleurs durant l’enregistrement, activez «Playback while recording» (lecture
pendant l’enregistrement, dans les options d’enregistrement), ou incluez d’abord
toutes les données MIDI dans un objet MIDI d’où elles pourront être extraites
ultérieurement. Les données de contrôleur MIDI (pour une piste seulement,
c’est-à-dire 16 max.) peuvent être extraites des objets MIDI existants (depuis
tous les fichiers *.MID) dans la fenêtre de l’éditeur d’objet MIDI.
Une couleur peut être assignée à chaque courbe.

Réglages spécifiques de piste
Les contrôleurs sont assignés aux courbes dans les cases de nom, de numéro et
de canal de contrôleur. Voir «Assignation» ci-dessus. Vous pouvez changer cette
assignation pour une courbe existante.
Les courbes de contrôleur déjà allouées pour une piste ne sont actualisées
(enregistrées) que si l’option «Record/update MIDI controller track curves on
this track while playing» est cochée. L’allocation automatique de nouveaux
contrôleurs MIDI dépend des réglages globaux pour «Automatic track mapping
for new MIDI controllers» (onglet Setup).
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La case à cocher «Active» active une courbe. Si une courbe est inactive, les
données de contrôleur ne sont ni envoyées ni mises à jour.
La case à cocher «Visible» affiche et masque la courbe dans l’affichage. La courbe
est affichée dans le projet dans une couleur définie à l’aide du bouton Color.
Même si une courbe n’est pas visible, elle peut être active et donc enregistrée/
actualisée ou envoyée. L’édition à la souris n’est par contre pas possible. Pour
supprimer une courbe, sélectionner l’option vierge dans le champ Parameter/
MIDI Contr. (le premier choix du menu déroulant).

New MIDI Controller: Ce réglage détermine l’assignation automatique des
noms dans les champs de nom en fonction du standard de noms de contrôleur
choisi.

Used numbers: Les contrôleurs sont décrits par leur numéro, par ex. Contrôleur
7 -> «Ctrl 7».

General MIDI: Le nom correspondant est employé pour les contrôleurs définis
dans la norme MIDI, par ex. Contrôleur 7 -> «Volume».

C-Console: Les noms correspondant aux sessions de la C-Console incluse sont
employés, par ex. Contrôleur 7 > «Volume (Ch)» pour le volume de piste.
Vous pouvez aussi sélectionner un instrument VST ou un plug-in d’effet dans
le menu déroulant de la piste actuelle, dont les noms de contrôleur apparaissent
alors dans «controller assignment». Ainsi vous pouvez automatiser les plug-ins
VST.

Note: Les noms donnés sont conservés, même si ce réglage est changé ultérieurement.
Pour changer un nom, sélectionnez d’abord un contrôleur différent. L’ancien peut
alors être sélectionné avec la nouvelle règle de dénomination.

Réglages globaux d’automation
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MIDI resolution: Constante de temps (en millisecondes) pour envoyer les
valeurs actuelles de contrôleur. Au démarrage de la lecture, les données de
contrôleur sont transmises si la valeur change après écoulement de cette période
de temps (dans le cadre d’une résolution MIDI de 7 bits). Durant la lecture, les
données de contrôleur MIDI sont récupérées (dans cet intervalle de temps) et
envoyées au périphérique MIDI correspondant.

Timeout for user input: Dès qu’une courbe de contrôleur est actualisée (c’est-
à-dire que de nouvelles données sont reçues pour cette courbe), les données
précédentes de cette courbe ne sont plus transmises. S’il n’y a plus de données
nouvelles, la transmission des données d’origine reprend après écoulement de
cette temporisation.

Visual Refresh Time: La fréquence de rafraîchissement d’écran se règle ici.

VST automation resolution: Constante de temps (en millisecondes) pour
envoyer les valeurs actuelles de paramètre. Au démarrage de la lecture, les
données sont transmises si la valeur change après écoulement de cette période
de temps (dans le cadre d’une résolution MIDI de 7 bits). Durant la lecture, les
valeurs de paramètre de VST sont récupérées (dans cet intervalle de temps) et
envoyées au plug-in VST correspondant.

Send controller data: Active ou désactive de façon globale la transmission
des données de contrôleur MIDI /paramètre de VST.

Show received data automatically: Les courbes de la fenêtre de projet peuvent
être automatiquement mises à jour. La fréquence de rafraîchissement se règle
avec Visual Refresh Time.

Automatic track mapping for new MIDI controllers (Association automatique des
nouveaux contrôleurs MIDI aux pistes):
None: Seules les courbes de contrôleurs déjà assignés sont actualisées. Aucune
autre n’est enregistrée

Only tracks with active option «Record/update MIDI controller

curves…»: Les nouveaux contrôleurs sont assignés aux pistes pour lesquelles
cette option est activée (à partir de la première).

All tracks with same input device: Si l’option «Record/update MIDI curves
on this track while playing» est activée pour une piste, de nouvelles données de
contrôleur reçues du périphérique d’entrée MIDI correspondant (réglé pour
toutes les pistes) peuvent être assignées à toutes les pistes dont le périphérique
d’entrée a été réglé (en commençant par la première).

Current track  MIDI channel (C-Console mono tracks): L’option «Record/
update MIDI curves on this track while playing» ne doit être activée que pour
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une piste (de préférence la piste 1). Les contrôleurs MIDI 0-63 sont alors
automatiquement assignés aux pistes 1-16 en fonction de leur canal MIDI 1-16.
Les contrôleurs 64-127 sont assignés aux pistes 17-32. Cela correspond à la
configuration de C-Console pour l’emploi de pistes mono.

Current track  MIDI channel/2 (C-Console stereo tracks): Comme ci-
dessus, excepté que maintenant les canaux MIDI 1 et 2 sont assignés à la piste 1,
les canaux 3 et 4 à la piste 2, etc. Cela correspond à la configuration de C-Console
stéréo pour l’emploi de pistes stéréo.

Instruments logiciels
Introduction
Avec Samplitude, vous pouvez intégrer des instruments logiciels au standard
VSTi et des synthés MAGIX (par ex. Robota Pro) à un VIP et les contrôler à
l’aide des fonctions et éditeurs MIDI internes. Tous les instruments y compris
leurs sorties multiples sont intégrés de façon transparente au moteur audio
avec toutes les possibilités d’effets et de routage. Le nombre maximum
d’instruments n’est limité que par les performances du processeur. Vous pouvez
toutefois augmenter ce nombre en employant la fonction de gel (Freeze) intégrée.

Installation des instruments et réglages de chemin d’accès
Installez tous les instruments VST selon les instructions de leur fabricant.
Samplitude recherche les instruments VST installés dans le répertoire «VST
plug-ins» du programme. Vous pouvez installer vos instruments VST dans ce
répertoire ou employer n’importe quel lien vers un autre dossier, comme celui
d’une autre application. Ce chemin d’accès doit alors être saisi dans les réglages
de système (touche «y»), dans le sous-menu «Paths/Skins». Plusieurs chemins
d’accès peuvent ensuite être saisis. Tous sont pris en compte. Samplitude trouve
automatiquement les plug-ins placés dans les répertoires ainsi indiqués.
Quand le programme est lancé pour la première fois, il recherche les instruments
et plug-ins disponibles dès que la fenêtre d’informations de piste (Track
Information) est ouverte. Cela peut prendre un certain temps si beaucoup
d’instruments et de plug-ins sont installés. Les plug-ins sont chargés et leur
applicabilité au programme est vérifiée. Cette recherche ne doit être effectuée
qu’une fois. La fenêtre Track Info s’ouvrira immédiatement par la suite.

Astuce: En cas de problèmes avec votre configuration actuelle, vous pouvez réinitialiser
tous vos chemins d’accès et instruments ou plug-ins installés. Supprimez le fichier
«VSTPlug-ins.ini» du dossier Samplitude. Vous devrez alors ressaisir les chemins
d’accès. Les plug-ins préalablement masqués dans le programme s’affichent à nouveau.

Charger les instruments
Dans Samplitude, les instruments ne sont pas gérés dans un rack ou dans une
piste spéciale pour instrument. Vous pouvez directement assigner un instrument
à n’importe quelle piste, où l’instrument est sélectionné comme périphérique
de reproduction MIDI. Peu importe que la piste soit audio ou MIDI, car toutes
les pistes sont traitées identiquement. L’avantage est que les instruments
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sélectionnés apparaissent directement dans la piste contenant les données MIDI
correspondantes. Plus besoin de routage.
Les instruments sélectionnés ou les entrées individuelles sont directement
affichés dans le premier emplacement (slot) d’insert/plug-in de la piste et de la
fenêtre de table de mixage. On peut aussi les couper (clic gauche) et les ouvrir
(clic droit) ici.
Vous pouvez charger un instrument en sélectionnant «New instrument» comme
sortie de piste. Cela peut se faire à différents endroits:
– Dans la fenêtre d’informations sur la piste («MIDI: Playback dev.»)
– Menu de périphérique de lecture (clic droit sur le bouton «Mute», «MIDI ->

New instrument»)
– Slot d’effet Plug-in/Insert de la piste
– Slot d’effet Plug-in/Insert de la table de mixage: Ceci ne peut toutefois se

faire que dans le slot du haut, qui affiche alors aussi le nom de l’instrument
sélectionné.

Dans tous les cas, Samplitude règle automatiquement la piste à enregistrer après
que l’instrument ait été sélectionné, puis ouvre l’éditeur de l’instrument avec
son interface graphique.

Réglages pour les nouveaux instruments logiciels créés
La fenêtre «Settings for newly created software instruments» s’affiche après
sélection de l’instrument.
Avant de charger, vous pouvez faire des réglages importants de routage depuis
et vers l’instrument. C’est particulièrement important pour les instruments à
plusieurs sorties car cela détermine si toutes les sorties seront assignées à la
piste actuelle ou si des pistes doivent être créées.

All instrument outputs to one track: Toutes les sorties audio sont dirigées
vers la piste pour laquelle l’instrument a été ouvert, qu’il s’agisse d’un instrument
stéréo ou à multiples sorties comme Robota Pro. Dans ce cas, plusieurs sorties
sont mixées ensemble avant de passer par les effets de la table de mixage.

Create new tracks: Sélectionnez cette option si toute les sorties d’un instrument
à multiples sorties doivent être automatiquement dirigées vers de nouvelles pistes
créées pour l’occasion. Vous pouvez aussi choisir de créer des pistes mono ou
stéréo. Si vous utilisez un instrument de batterie à 8 sorties mono, il est parfois
judicieux de diriger chaque instrument vers son propre canal mono. A l’opposé,
un synthétiseur à nappe stéréophonique est mieux exploité avec quatre pistes
stéréo.

Assign MIDI output to VSTi: Cochez cette case pour diriger automatiquement
la sortie MIDI de chaque piste de sortie individuelle de cet instrument. Ainsi
vous pouvez contrôler des synthétiseurs multi-timbraux sur différents canaux
MIDI.

Hide audio output channels: Toutes les pistes de sortie nouvellement créées
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pour cet instrument sont masquées dans l’arrangeur mais apparaissent dans la
fenêtre table de mixage. Ce réglage est judicieux si les sorties individuelles d’un
instrument sont contrôlées par un seul fichier MIDI et ne contiennent donc pas
d’informations ou d’objets en fenêtre arrangeur.
Les sorties individuelles peuvent être dirigées de façon à séparer ultérieurement
les pistes. Vous trouverez plus de détails sur ceci dans la section intitulée:
«Routage des instruments». Utilisez le gestionnaire de pistes (Track Manager)
pour afficher les pistes masquées en fenêtre arrangeur.
Separated MIDI input and audio output channels: Utilisez cette option
pour diriger des objets MIDI et les sorties audio d’un instrument vers deux
pistes. Dans ce cas, la sortie audio de l’instrument est désactivée pour la piste
actuellement réglée pour inclure les objets MIDI. Une nouvelle piste est créée,
avec la sortie de l’instrument. Ainsi, vous pouvez gérer les réglages MIDI et
audio en parallèle sans besoin de commutation. Le fader de «piste MIDI» peut
alors contrôler le volume MIDI ou la dynamique et le fader de piste d’instrument
peut contrôler le niveau audio.

Note: Les sorties audio d’un synthétiseur virtuel sont généralement produites, éditées
et mixées dans la même piste que les données MIDI reçues par cet instrument. Cela
entraîne une double assignation du fader de volume, qui règle la dynamique ou le
volume MIDI (CC7) d’un côté et le niveau audio de l’autre. Ce ne sont pas des
paramètres identiques. Par exemple, vous pouvez placer un instrument MIDI joué
avec une forte dynamique comme audio dans le mixage, et vice versa. C’est pourquoi
le fader de volume peut être optionnellement assigné de différentes façons. Faites un
clic droit sur le fader de volume de la piste. Le mode actuellement sélectionné est
affiché dans la case de valeur du fader:
– Pas de lettre = volume audio
– c = volume MIDI (contrôleur 7)
– v = dynamique MIDI («velocity»)

Réglage des paramètres d’instrument
Affichage de l’interface graphique de l’instrument et fenêtre des paramètres
L’éditeur de l’instrument (interface) s’ouvre d’abord quand vous chargez
l’instrument, et peut par la suite être rappelé par clic droit sur le slot d’insertion
affichant le nom de l’instrument. Sinon, vous pouvez ouvrir l’éditeur en cliquant
sur le menu Instrument Outputs > VSTi Editor (clic droit sur le bouton
d’enregistrement de piste).

L’interface graphique est ouverte. Si l’instrument (ou le plug-in) sélectionné n’a
pas d’interface propre, c’est la fenêtre de paramètres (Parameter Dialog) qui
s’ouvre. Ce mode d’affichage est limité à quelques éléments de commande et
peut aussi être explicitement ouvert via le menu de la fenêtre de l’instrument.
Utilisez ce mode si l’interface du plug-in est trop confuse ou occupe trop d’espace
de votre écran. Dans cette fenêtre, huit paramètres librement sélectionnables
de l’instrument s’affichent de façon claire et numérique. Les barres horizontales
gèrent les valeurs de paramètre.
En plus du menu déroulant, la case à cocher «Auto» est importante pour la
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sélection des paramètres. L’activer lance l’automation des paramètres
sélectionnés. La courbe d’automation est affichée dans la piste de projet et peut
être rééditée. Le paramètre peut aussi être automatisé à l’aide du fader.
Vous pouvez aussi activer les paramètres d’automation avec «Auto».
La sélection de paramètres est sauvegardée pour chaque plug-in, aussi quand le
même plug-in est réemployé dans un autre projet, les mêmes paramètres peuvent
de nouveau être contrôlés. L’avantage est que tous les paramètres fréquemment
utilisés par chaque instrument sont immédiatement disponibles.

Menu de la fenêtre
D’autres options se trouvent dans le menu de la fenêtre de l’instrument.
Bypass: Désactive et coupe l’instrument. Sachez que certains instruments
utilisent toujours des ressources du processeur même s’ils sont coupés, tant
qu’ils restent dans un slot d’insertion. Ces types d’instruments doivent être retirés
du slot d’insertion s’ils ne sont plus utilisés.

Monitoring: Cette option doit être activée si l’instrument doit être entendu
durant la lecture ou l’enregistrement. Si le monitoring doit toujours être activé
quand le bouton ROUGE de la piste est activé, sélectionnez «Tape Monitoring»
dans les réglages System/Global Audio Options (touche «y», onglet «Record
Devices», paramètre «Monitoring Model»).

Bank Load/Save; Patch Load/Save: Pour sauvegarder (Save) et recharger (Load)
les réglages et sons d’un instrument. Les formats généralement employés sont
*.fxp pour les patches ou *.fxb pour des banques entières. Certains instruments
ont leur propre format de patch/banque. Les réglages sont alors généralement
chargés directement depuis l’interface de l’instrument.

Randomize parameters: Cette fonction règle tous les paramètres sur une valeur
aléatoire. Pour les synthétiseurs, cela mène à des résultats nouveaux et
surprenants, et la production aléatoire de sons mène à des résultats intéressants
pour la conception sonore. Sachez toutefois que seuls les paramètres accessibles
depuis l’interface peuvent être réglés aléatoirement. Les paramètres de certains
synthétiseurs virtuels très complexes, tels que des systèmes modulaires, ne sont
pas changés par cette option. Veuillez aussi noter que le réglage aléatoire des
paramètres peut engendrer des sons très extrêmes. Cela peut donner une absence
de son audible ou au contraire ayant des niveaux extrêmes de volume ou de
fréquence. Par conséquent, faites attention à votre volume d’écoute quand vous
testez cette fonction.

Automate next parameter: Si vous activez cette fonction, une courbe
d’automation sera dessinée du point actuel jusqu’au prochain changement de
paramètre (fader, sélecteur ou bouton) sur l’interface graphique.

Jeu/écoute des instruments en direct
Ecoute directe de l’entrée
Un générateur de notes MIDI est nécessaire pour jouer d’instruments virtuels
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(logiciels). C’est généralement un clavier MIDI. Bien sûr, cela peut aussi être
un autre PC envoyant des données MIDI ou un séquenceur physique.
Une interface audio à pilotes ASIO est aussi nécessaire à l’écoute de contrôle
(«monitoring») directe. Seul le jeu des instruments est possible avec des pilotes
MME ou WDM.
Les réglages suivants doivent aussi être faits pour l’écoute directe:
– Pilote ASIO (réglages de système – option audio générales)
– Activer l’écoute d’enregistrement globale dans la commande de transport
global (REC M)
– Activer le bouton d’écoute de la piste (symbole de haut-parleur)
– Monitoring du logiciel ou des effets

Le dernier point est facilement négligé, bien qu’essentiel puisque la synthèse et
le traitement s’effectuent entièrement dans l’instrument lui-même intégré à
Samplitude et au moteur audio interne. Pour jouer des instruments, vous devez
donc sélectionner «Software Monitoring» dans le menu «System/Global Audio
Options» (touche «y», onglet «Record devices»).
Sélectionnez «Software FX Monitoring» pour la reproduction avec les effets
internes ou plug-ins pendant l’enregistrement.

Astuce: Vous pouvez aussi sélectionner le mode d’écoute (monitoring) par clic droit
sur le bouton REC M.

Latence: Rappelez-vous que quand on jour d’instruments logiciels virtuels, il y
a un retard dépendant du système entre le moment ou la clavier MIDI est pressé
et celui où le son est entendu. Ce temps de retard que l’on nomme latence
influence considérablement la taille de la mémoire tampon définie dans le pilote
ASIO. Une taille maximale de mémoire tampon de 1024 échantillons est
recommandée pour une sensation de jeu agréable. Cela correspond à 23 ms à
44.1 kHz. Toutefois, seule une latence de 3 ms trouve grâce aux yeux de nombreux
utilisateurs, c’est-à-dire 128 échantillons. Sachez que la charge du processeur
augmente aussi si la mémoire tampon est faible. Le retard «live», ne se produit
toutefois que quand vous jouez d’un instrument; la latence de lecture d’une
piste MIDI enregistrée au préalable via des instruments virtuels est
automatiquement compensée ultérieurement.
Comme les instruments logiciels sont entièrement intégrés au moteur audio
du programme, les signaux de l’instrument peuvent être routés, mixés et
reproduits avec des plug-ins comme vous le désirez. Cela fonctionne aussi de
façon restreinte quand vous jouez et de façon totale durant la reproduction.

Note: Sachez que «Software FX Monitoring» doit être activé pour une écoute incluant
les effets. Toutefois, en combinaison avec une faible latence, cela fait courir certains
risques et augmente le danger de pertes de signal, particulièrement avec des effets
nécessitant un traitement complexe (par ex. le simulateur d’espace en temps réel).
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Enregistrement et reproduction d’un instrument
Un instrument est reproduit de la même façon qu’une piste MIDI normale.
Assurez-vous que l’enregistrement MIDI est activé pour la piste correspondante,
puis pressez le bouton d’enregistrement dans la commande de transport.
L’enregistrement démarre immédiatement.
Quand vous reproduisez des pistes MIDI déjà enregistrées, l’écoute de contrôle
(monitoring) de piste doit être désactivée.

Routage des instruments
Il existe plusieurs possibilités souples de routage du signal d’instrument.
Un instrument peut recevoir plusieurs pistes MIDI. A l’inverse, les sorties d’un
instrument peuvent aussi être envoyées à plusieurs pistes. Un instrument à
quatre sorties stéréo peut produire celles-ci sur différentes pistes simultanément
si désiré.

Routage des sorties d’instrument
L’assignation des sorties se fait normalement quand on ouvre pour la première
fois l’instrument. Vous pouvez alors définir combien de sorties doivent être
employées. Vous pouvez soit diriger toutes les sorties vers la piste actuelle, soit
créer une nouvelle piste mono ou stéréo pour chaque sortie (voir ci-dessus).
Pour obtenir la sortie d’un instrument déjà chargé sur une certaine piste, faites
un clic droit sur son bouton d’enregistrement et sélectionnez dans le sous-menu
«Instrument Outputs» une sortie disponible dans le projet à utiliser pour la
piste. Un instrument peut avoir plusieurs sorties dans une piste. Vous pouvez
aussi regrouper les sorties de plusieurs instruments sur une piste.
La désactivation des sorties de l’instrument fonctionne de la même façon. En
cliquant dans le menu, décochez les sorties à désactiver dans le sous-menu
«Instrument Outputs».
Veuillez noter que toutes les possibilités de routage du moteur de mixage sont
aussi à votre disposition. Vous pouvez diriger n’importe quelle piste ayant un
instrument vers n’importe quel bus, bus auxiliaire ou master.

Routage des entrées d’instrument
Quasiment tous les instruments logiciels nécessitent des données MIDI pour
produire un son. Pour relier une entrée MIDI à une certaine piste contenant
des données MIDI, cliquez sur le bouton de sortie de la piste et sélectionnez
l’instrument que vous voulez faire jouer dans le menu de sortie. Les instruments
déjà chargés sont classés numériquement dans ce menu.
Pour ouvrir un canal d’instrument entièrement nouveau qui réagira
indépendamment des instruments existant déjà dans le projet, sélectionnez son
nom dans le sous-menu «New instrument».

Routage vers les bus
Pour router des instruments vers des prémixages (submix) ou bus AUX – par
ex. pour combiner plusieurs canaux d’un échantillonneur de batterie virtuel en
un sous-groupe – sélectionnez le bus submix voulu comme sortie de piste dans
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la table de mixage.

Ecoute (monitoring) solo: Pour écouter individuellement les sorties
d’instrument, faites simplement passer en solo la piste qui reçoit les signaux de
l’instrument affecté (même si les objets MIDI qui sont au final responsables du
son ne se trouvent pas dans cette piste). Le programme détecte automatiquement
quelle piste MIDI est envoyée et laisse l’instrument continuer de recevoir toutes
les données MIDI précédentes.

Sorties individuelles: Instruments à multiples canaux de sortie
Les instruments ayant plusieurs sorties individuelles – appelés instruments
multicanaux, qui peuvent produire en interne plusieurs signaux et les fournir
sur plusieurs sorties comme un équipement matériel – sont une particularité.
Veuillez vous référer au manuel du fabricant correspondant pour savoir comment
envoyer des données à chaque sortie individuelle de l’instrument.
Le nombre de sorties individuelles disponibles dépend généralement de
l’instrument et est simplement affiché aux bons endroits dans Samplitude. Les
sorties peuvent être disponibles en version stéréo et mono. Le programme traite
les sorties individuelles comme des pistes à part entière, pouvant à leur tour
être mixées, routées et éditées avec des plug-ins.
Deux exemples de gestion typique des sorties individuelles:
1. Adressage d’un instrument avec un canal MIDI et distribution des sons sur

plusieurs pistes individuelles: cette approche, par exemple, est judicieuse pour
tous les échantillonneurs de batterie si vous voulez adresser tout un kit de
batterie, mais préférez mixer et éditer individuellement les sons de la batterie.
Sélectionnez «Create new tracks» (créer de nouvelles pistes) dans la fenêtre
de réglages qui apparaît à l’ouverture de l’instrument. Toutes les sorties
individuelles de votre échantillonneur de batterie sont automatiquement
dirigées vers des pistes nouvellement créées. Si nécessaire, masquez les sorties
multiples avec la fonction «Hide audio output channels». Distribuez
maintenant les sons requis aux sorties individuelles depuis l’instrument lui-
même. Veuillez notez que les pistes servent de canaux pour les sorties
individuelles et doivent être manuellement basculées en écoute (monitoring)
pour que tous les sons soient audibles.

2. Adressage d’un instrument avec plusieurs canaux MIDI: plusieurs canaux
MIDI sont généralement utilisés pour les synthétiseurs dits multitimbraux
qui peuvent recevoir des données MIDI sur plusieurs canaux puis distribuer
ces données aux différents synthétiseurs (parties) internes par lesquels chaque
piste fait jouer une partie spécifique. Cela a aussi pour avantage de n’avoir à
ouvrir qu’un exemplaire de tels instruments, par ex. des échantillonneurs,
pour produire plusieurs sons. Contrairement à un équipement MIDI externe
qui, dans ce cas, est mixé via une table de mixage externe, plusieurs sorties
sont nécessaires pour pouvoir éditer le son de chaque partie (si l’instrument
n’a pas de possibilités de mixage, ou alors insuffisantes). Sélectionnez «Create
new tracks» et «Route MIDI output to instrument» quand vous ouvrez
l’instrument, mais ne masquez pas ces pistes. Puis contrôlez les nouvelles
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pistes de sortie créées: le routage MIDI en entrée et le routage audio de
l’instrument en sortie. Vous pouvez maintenant adresser des parties de ces
instruments en sélectionnant un canal MIDI. N’oubliez pas de diriger
individuellement les parties de l’instrument vers les sorties individuelles
voulues.

Gestion des presets
Si un instrument a des presets, ils sont affichés dans l’emplacement de
programme («Prg») avec leur nom interne (si le mode MIDI est activé).
Ce menu peut servir à facilement «passer en revue» les presets de votre
instrument. Ces presets peuvent aussi être sélectionnés avec le menu «Programs»
en fenêtre de l’instrument.
Les réglages sauvegardés dans Samplitude avec le suffixe *.fxp ou *.fxb
continuent d’être gérés dans l’éditeur d’instrument via les éléments de menu
«Patch/Bank Load/Save».
Si votre périphérique d’entrée MIDI peut envoyer des messages de «changement
de programme», vous pouvez ainsi directement sélectionner les programmes
de cet instrument. Le slot de programme est automatiquement mis à jour dans
la piste, aussi avez-vous toujours une vue du programme.

L’automation d’instrument
L’automation d’instruments peut s’effectuer dans la fenêtre de paramètres et
directement dans l’interface graphique d’un instrument.

Fenêtre des paramètres (Parameter Dialog)
En dehors de son interface graphique, chaque plug-in ou instrument a sa fenêtre
de paramètres (nommée «Parameter Dialog»), accessible via le menu de la fenêtre
des plug-ins/instruments. Pour automatiser un paramètre, sélectionnez ce
paramètre dans une case à menu déroulant non occupée et cochez la case «Auto»
correspondante. Lancez la lecture et changez les paramètres en déplaçant la
barre avec la souris. Les mouvements sont maintenant enregistrés dans la piste
correspondante et affichés comme des courbes que vous pouvez à tout moment
rééditer.

Interface graphique
Pour automatiser directement les paramètres depuis l’interface graphique de
l’instrument, sélectionnez ces paramètres dans la fenêtre des paramètres de
VST et cochez la case «Auto» (voir ci-dessus).

Deux méthodes pratiques d’automation
Sélectionnez l’élément de menu «Automate next parameter» depuis l’éditeur
d’instrument puis bougez n’importe quel fader durant la reproduction. Une
méthode encore plus simple consiste à maintenir les touches Ctrl+Alt tout en
bougeant un élément de commande de paramètre automatisable, par ex. un
fader ou une commande rotative avec la souris.
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Pour plus de conseils concernant l’automation, veuillez lire la section
«Automation: plug-ins et instruments».

Gel des instruments (Freeze)
Les instruments logiciels nécessitent des ressources de processeur pour la
reproduction, ce qui peut devenir assez considérable à un certain moment mais
indispensable à toute reproduction. Par conséquent, veuillez utiliser la fonction
Freeze (gel) pour temporairement libérer des ressources de pistes de VSTi. Vous
conservez un contrôle total des objets MIDI de cette piste, qui peuvent être
restaurés («dégelés») à tout moment.
Pour «geler» un instrument, sélectionnez l’option «Freeze Track» dans le menu
de piste Track (raccourci-clavier: Ctrl+Shift+F). Après un court temps de
traitement, tous les objets MIDI et audio sont remplacés par un seul objet audio
stéréo 32 bits économe en ressources qui est maintenant reproduit à la place de
l’objet et de l’instrument d’origine. Les données d’automation existantes et les
effets de piste sont inclus dans l’objet gelé.
L’instrument de cette piste n’est plus sollicité par les fichiers MIDI de cette
piste et peut même être désactivé, s’il n’est pas activé par d’autres pistes MIDI.
Sélectionnez «Unfreeze Track» (Ctrl+Shift+U) pour ramener les données MIDI
d’origine telles qu’au moment où elles ont été «gelées». La piste nécessite alors
à nouveau les ressources initiales de processeur pour traiter l’instrument.
Sinon, vous pouvez utiliser la fonction «Edit Track Freeze». Dans ce cas, une
nouvelle piste de VIP est ouverte avec la piste d’origine. Désavantage: vous
n’entendrez pas la piste en connexion avec votre arrangement du projet d’origine.
Dès que vous sauvegardez ce projet, un nouvel objet gelé est traité et inclus
dans le projet original.
Le gel fonctionne aussi avec des sorties simples dans d’autres pistes que la piste
de sortie principale (Instrument outputs 1+2). Vous pouvez aussi geler ces pistes
si elles ne contiennent pas d’informations MIDI ni d’objets. Les données MIDI
qui ont été automatiquement dirigées vers la piste ou la sortie individuelle de
l’instrument créent un fichier audio qui est maintenant lu à la place de
l’instrument d’origine. Pour éviter une double lecture des données, désactivez
manuellement la sortie simple de l’instrument dans la piste gelée.
Pour éditer des données gelées, vous ne pouvez pas seulement employer la
fonction Track Freeze Edit car aucune donnée MIDI ne peut être éditée dans
cette piste. Par conséquent, «dégelez» la piste et éditez les données MIDI de la
piste d’envoi. Vous pouvez ensuite regeler la piste.

Note: Tant que l’instrument n’est pas entièrement déchargé de la piste, il reste chargé
en mémoire RAM du système. Les échantillonneurs ou instruments qui nécessitent
des quantités de mémoire considérable doivent donc être déchargés quand leurs pistes
d’insertion ont été gelées.

Astuces sur le maniement des instruments virtuels
– Vous pouvez réaliser ce que l’on nomme des sons empilés (c’est-à-dire des

sons utilisant plusieurs synthétiseurs que vous faites jouer à l’unisson) en
ouvrant plusieurs instruments et en activant l’écoute pour tous les canaux.
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– Pour programmer des rythmiques, vous pouvez créer et sauvegarder dans

l’éditeur MIDI des configurations rythmiques individuelles qui correspondent
aux instruments respectifs.

– Si un instrument peut limiter la quantité de voix, vous pouvez employer cette
option pour économiser des ressources de processeur quand vous n’avez pas
besoin de toutes les voix.

– Certains instruments utilisent des ensembles de sons au standard General
MIDI. Vous pouvez les employer pour reproduire des fichiers MIDI selon le
standard GM. Veuillez importer la totalité du fichier MIDI dans une seule
piste – incluant tous les canaux. Vérifiez que les instruments virtuels peuvent
aussi recevoir les messages de changement de programme qui sont aussi
enregistrés dans un tel fichier, pour que les sons corrects soient demandés
durant la reproduction.

Automation: Instruments et plug-ins VST
Introduction
Les paramètres de plug-ins VST ou instruments VST peuvent être automatisés
en utilisant la résolution temporelle réglable des événements d’automation.
Jusqu’à 16 courbes d’automation pour tout réglage de plug-in ou instrument
VST sont disponibles dans chaque piste, bus AUX ou submix. Comme les
instruments VST peuvent aussi recevoir des données de plusieurs pistes, plus
de 16 paramètres d’automation sont simultanément disponibles par instrument.
Les paramètres d’automation peuvent être télécommandés en externe via l’entrée
MIDI de la piste et des contrôleurs MIDI réglables.
En plus des courbes d’automation d’un paramètre de VST/VSTi, toutes les
courbes d’automation peuvent aussi servir de contrôleurs MIDI, par ex. volume
ou panoramique MIDI, et peuvent être envoyées en sortie MIDI de la piste ou à
l’instrument VST de la piste.

Création de courbes d’automation
Il faut un destinataire pour les données d’automation dans la piste avant qu’une
courbe d’automation puisse être créée dans une piste, comme un plug-in VST
ou un instrument VST.
Si c’est le cas, il y a deux possibilités pour créer des paramètres d’automation.

1ère possibilité: contrôleurs MIDI /fenêtre Automation
Les paramètres d’automation sont sélectionnés en fenêtre «MIDI Controllers/
Automation» (via la fenêtre Track Info ou le menu MIDI).
Raccourci: Ctrl+Alt+a

La fenêtre a deux groupes de fonctions distincts.
Le premier onglet, «Automation/Controller», recèle une liste de 16 paramètres
d’automation possibles ou contrôleurs MIDI pour la piste actuelle. Ces
emplacements d’automation/contrôleur MIDI peuvent être assignés
individuellement pour chaque piste. Sélectionnez d’abord un type de paramètre.
Vous pouvez choisir parmi les suivants:
– Paramètres d’automation pour plug-ins VST et instruments VST, et
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– Contrôleurs MIDI
– Contrôleurs MIDI (par numéros)
– Contrôleurs MIDI (par noms en standard General MIDI)
– Contrôleurs MIDI pour C-Console

Onglet 1: „Automation/Controller«

Pour sélectionner un paramètre d’automation de VST, vous devez d’abord
sélectionner un plug-in ou instrument VST disponible dans la piste. Cela se fait
avec la case à menu déroulant du même nom située sur la gauche. Maintenant,
tous les paramètres de ce plug-in ou instrument VSTi sont accessibles dans
toutes les cases à menu déroulant non employées.

Autres options:
– Visible: La courbe d’automation/contrôleur peut être marquée, mais en restant

active en tâche de fond.
– Active: Active/désactive la courbe d’automation/contrôleur. Les valeurs sont

conservées mais pas prises en compte durant la lecture.
– Contr. Nr: Sélectionne un contrôleur MIDI pour envoyer simultanément des

valeurs au paramètre d’automation de VST.
– Channel: Canal MIDI sur lequel le contrôleur MIDI transmet ses données.
– Color: Sélectionne une couleur pour la courbe d’automation. Une couleur

individuelle peut être assignée à chaque courbe.
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Un slot d’automation déjà occupé peut être «libéré» ou assigné différemment
en sélectionnant le champ de nom de paramètre du slot, ou en désélectionnant
ou en changeant la source dans la case d’automation à menu déroulant (plug-in
VST/VSTi).
Comme déjà mentionné, vous pouvez simultanément assigner un contrôleur
MIDI à chaque paramètre d’automation pour renvoyer les signaux reçus par
l’entrée MIDI à ce paramètre spécial du plug-in VST/VSTi. Dans ce cas, les
valeurs de contrôleur ne sont pas renvoyées à la sortie du périphérique MIDI de
la piste ou à l’instrument VST. Toutefois, ce n’est le cas que si un contrôleur
MIDI a été sélectionné pour un slot de courbe d’automation mais aucun
paramètre d’automation de VST. Si un effet VST ou instrument VST a été choisi
comme destination, la liste des noms de paramètres affiche simplement tous
les paramètres automatisés dans ce but. La courbe d’automation transmet alors
ses valeurs au paramètre de VST/VSTi sélectionné.
Si un plug-in VST ou instrument VST a été choisi comme source, la liste des
noms de paramètres affiche simplement tous les paramètres automatisés pour
cette source. Un numéro de contrôleur doit simplement être sélectionné dans
la case de liste correspondant au nom pour simultanément assigner un contrôleur
au paramètre de VST.
Ce slot ne doit pas être assigné à un plug-in VST/VSTi si des contrôleurs MIDI
doivent être exclusivement envoyés à la sortie MIDI de la piste ou à un instrument
VST, par ex. un contrôleur de volume ou de panoramique.
Vous pouvez assigner un contrôleur MIDI répondant à la norme d’appellation
General MIDI (volume, panoramique, LSB (octet de poids faible) de changement
de banque) ou par numéro (0-127) dans le champ de nom. Une liste de noms
prédéfinis est aussi disponible pour la sélection du programme de C-Console
externe.

2ème possibilité: plug-in VST/fenêtre de paramètres de VST:
Les valeurs à automatiser peuvent aussi être activées dans la fenêtre des
paramètres du plug-in VST ou de l’instrument VST.
Le paramètre sélectionné peut alors être enregistré à l’aide des faders durant la
reproduction.
Toutefois, ceci ne s’applique aux effets que s’il y a aussi des objets audio ou
MIDI à cette position, qui peuvent alors seulement être adressés pour des raisons
relatives à l’interprétation.
La fenêtre de paramètres (Parameter Dialog) peut être ouverte via le menu «Plug-
in» de l’interface graphique du plug-in/VSTi.
Sélectionner un paramètre dans la fenêtre de paramètres VST tout en maintenant
enfoncée la touche «Shift» assigne aussi les paramètres suivants.

3ème possibilité: Via le menu «VSTi»
Sélectionnez «Automate next parameter» dans le menu du plug-in VST. Vous
pouvez alors sélectionner et actionner n’importe quel commutateur ou fader du
panneau de commande de l’instrument. L’automation est enregistrée
simultanément au changement des paramètres.
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4ème possibilité: Surface de Plug-in/instrument
La possibilité la plus simple est de presser la combinaison de touches
Ctrl+Alt+commutateur/fader sur la surface de l’instrument. L’automation peut
être enregistrée avec facilité et à tout moment.

Edition des courbes d’automation
Les courbes peuvent être enregistrées en direct et ensuite éditées à la souris. En
plus du mode normal de souris (créant des points d’automation par double-
clic), un mode de souris spécial courbe ou des modes de souris objet/courbe
sont disponibles. Sélectionnez le mode pan pour la souris afin de dessiner une
courbe d’automation pour un paramètre ou un contrôleur MIDI.
Les points d’automation peuvent être supprimés après sélection via le clavier
(mode d’édition de courbe). Les points libres de courbe d’automation sans objets
audio/MIDI peuvent être coupés, copiés et insérés à la position de lecture actuelle.

Déplacez la courbe d’automation avec les données audio/MIDI
Dans de nombreux cas, il est nécessaire de déplacer le matériel sur l’axe du
temps. Bien sûr, les courbes d’automation soigneusement préparées peuvent
également être déplacées sur une nouvelle position. Pour cela, il faut coupler
les courbes d’automation aux objets avec le mode de souris «Link curve to
Objects» (Coupler la courbe aux objets). Cliquez sur le bouton correspondant
dans la barre d’outils de mode de souris.
Les courbes d’automation de VST/VSTi ne peuvent pas être déplacées sur
d’autres pistes avec le matériel audio, car elles n’ont pas de plug-ins VST spéciaux.
Comme les instruments VST sont dépendants des pistes dans Samplitude, cela
s’applique aussi aux objets MIDI associés à une automation de VSTi. Toutefois,
vous pouvez copier la totalité de la piste et la coller à une position différente.
Vous pouvez alors supprimer les objets et courbes d’automation de la piste
d’origine.

Réglages d’automation/contrôleur MIDI
Il existe dans la fenêtre de courbe d’automation un autre onglet («Setup») pour
faire tous les réglages concernant l’automation.
D’abord, il y a un ensemble de réglages globaux («Global settings») qui affectent
pareillement toutes les pistes.

MIDI resolution: Constante de temps (en millisecondes) pour envoyer les
valeurs actuelles de contrôleur. Au démarrage de la lecture, les données de
contrôleur sont transmises si la valeur change après écoulement de cette période
de temps (dans le cadre d’une résolution MIDI de 7 bits). Durant la lecture, les
données de contrôleur MIDI sont récupérées et envoyées au périphérique MIDI
correspondant.

Timeout for user input: Dès qu’une courbe de contrôleur est actualisée (c’est-
à-dire que de nouvelles données sont reçues pour cette courbe), les données
précédentes de cette courbe ne sont plus transmises. S’il n’y a plus de données
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nouvelles, la transmission des données d’origine reprend après écoulement de
cette temporisation.
Visual Refresh Time: La fréquence de rafraîchissement d’écran se règle ici.

VST automation resolution: Constante de temps (en millisecondes) pour
envoyer les valeurs actuelles de contrôleur. Au démarrage de la lecture, les
données sont transmises si la valeur change après écoulement de cette période
de temps (dans le cadre d’une résolution MIDI de 7 bits). Durant la lecture, les
valeurs de contrôleur de VST sont récupérées dans cet intervalle de temps et
envoyées au plug-in VST correspondant.

Send controller data: Active ou désactive de façon globale la transmission
des données/contrôleurs MIDI.

Show received data automatically: Les courbes de la fenêtre de projet peuvent
être automatiquement mises à jour. La fréquence de rafraîchissement se règle
avec Visual Refresh Time.

Synchronisation
Introduction
La synchronisation est d’une importance considérable dans un système audio,
car elle est nécessaire pour aligner les vitesses de lecture et d’enregistrement de
différents composants d’un système entre eux.
La synchronisation est un processus relativement simple dans Samplitude, bien
que certains facteurs puissent créer des difficultés. Si nous regardons plus en
détail un système de synchronisation, nous voyons qu’il faut une source de
synchronisation jouant le rôle de «maître» que les autres composant («esclaves»)
suivront.
Samplitude peut être configuré pour fonctionner en maître ou en esclave dans
un système de synchronisation. Comme programme maître, il produit les
informations d’horloge requises par les autres composants du système. Comme
esclave, Samplitude reçoit les données de timecode, qu’il suit durant la lecture
ou l’enregistrement.
Il existe aussi un autre élément dans un système de synchronisation fonctionnant
bien – le format de synchronisation: le «langage» universel parlé par les
composants interconnectés. Dans la plupart des cas, le «maître» dirige (transmet)
tandis que le reste du système reçoit simplement.
Le problème de la synchronisation peut être résolu de nombreuses façons
différentes, car on trouve beaucoup de systèmes de synchronisation différents
dans les studios du monde entier. Vous trouverez dans ce chapitre beaucoup de
conseils et d’astuces utiles sur le sujet.

Formats de synchronisation
Les formats de synchronisation comprennent des informations pour les appareils
esclaves sur la position de démarrage, les signaux de démarrage et d’arrêt, et
(dans les formats perfectionnés) des informations horaires précises. Toutes les
données sont continuellement transmises.
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Samplitude lit et transmet les formats de synchronisation que sont l’horloge
MIDI, le MIDI Time Code (MTC) et le SMPTE, qui doivent être traduits au final
par le logiciel de votre interface MIDI.

Horloge MIDI (MIDI Clock)
L’horloge MIDI contient essentiellement des messages de pointeur de position
dans le morceau (SPP: song position pointer) et de démarrage/arrêt (start/stop).
Il n’y a pas d’informations continues de timing incorporées au signal d’horloge
MIDI. Ce type de synchronisation convient donc principalement au démarrage
et à l’arrêt. Le principal attrait de ce type de synchronisation est le fait que
Samplitude puisse vérifier si les pistes audio sont lues en synchro totale, mais
l’horloge MIDI ne fournit pas d’autres informations temporelles continues
permettant de comparer la position interne au signal externe.
Vous pouvez employer ce type de synchronisation si votre système n’a pas de
changements temporels ou si la synchronisation n’est requise qu’une fois pour
inclure des pistes audio ou MIDI dans Samplitude.

MIDI Time Code (MTC)
S’il vous faut une intégration fiable des pistes MIDI d’un séquenceur interne
dans les pistes audio de Samplitude, l’emploi du format MTC est recommandé.
Le MIDI Time Code ou «MTC» comprend des informations temporelles en
plus des signaux d’horloge MIDI. Ces informations temporelles continuellement
transmises permettent à Samplitude de comparer sa propre position avec le
time code entrant.
En cas de fluctuations de tempo, Samplitude peut apporter les corrections qui
assurent une synchronisation temporelle précise. Cette fonction est connue sous
le nom de «Chase Lock» et peut être réglée dans la fenêtre de synchronisation.
Selon les performances du processeur et l’équipement audio employé, ce choix
fournit la meilleure synchronisation possible.

Synchronisation MIDI
Ouvrez la fenêtre de synchronisation pour changer la configuration de
synchronisation.

Menu «Options»
Raccourci-clavier: Shift + G
Souris: Clic droit sur le bouton Sync de la commande de transport.

Cette fenêtre sert à personnaliser la synchronisation en fonction de vos besoins.
Les deux formats disponibles sont l’horloge MIDI (MIDI Clock) et le MTC (MIDI
Time Code). Quand le SMPTE est employé en combinaison avec le MTC,
Samplitude interprète principalement le MIDI Time Code numérique. Le
SMPTE est un format de time code analogique qui ne peut pas être compris par
l’ordinateur sans conversion. Généralement, un pilote d’interface MIDI convertit
le signal SMPTE en MIDI time code.
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Dès lors que les réglages de synchronisation ont été faits, ils n’ont généralement
pas à être changés de nouveau lors du travail sur le VIP ou projet Wave.
MIDI Machine Control (MMC)
Modes de MMC
La fenêtre de synchronisation permet des réglages de télécommande via MIDI
Machine Control. Samplitude accepte la synchronisation d’appareils externes
via MMC. Trois modes de travail sont proposés:

Receive MMC commands (Slave): Activez cette option si vous voulez utiliser
Samplitude comme esclave. Samplitude suit les déplacements par molette JOG,
les commandes d’avance et de retour rapides envoyés par d’autres appareils.

Transmit MMC commands (Master): Samplitude est le dispositif maître. Le
dispositif externe suit la position temporelle chaque fois que le curseur de lecture
change de position dans le VIP. Si vous activez aussi l’option «Receive MMC
commands», Samplitude reçoit la position de lecture actuelle du dispositif externe



203

Le MIDI dans Samplitude
et l’affiche comme un curseur bleu supplémentaire de la ligne de temps.
L’équipement MMC stoppe la reproduction d’une section dans Samplitude
quand la fin de la section est atteinte. Le démarrage et l’arrêt par la barre d’espace
ne sont transmis que si l’option «Use space key for Remote Playstart» est activée.

Emploi de la commande de transport comme télécommande d’appareils

externes:
Si vous activez l’option «Transport Window as Remote Control for external
machines», la commande de transport ne contrôle plus directement la lecture
et l’enregistrement dans le programme mais commande à la place l’appareil
MMC externe. Les boutons de lecture, arrêt, avance rapide, retour rapide et retour
à zéro n’ont plus d’effet direct sur la reproduction de Samplitude. Le bouton
d’enregistrement lance l’enregistrement dans Samplitude en synchronisation
avec la lecture de l’appareil MMC.

Use Space key for Remote Playstart: Si cette option est activée, les commandes
de démarrage et d’arrêt sont pilotées via la barre d’espace.

Autres options:
Input MIDI Device: Sélectionnez le périphérique MIDI avec lequel vous voulez
piloter Samplitude.

Output MIDI Device: Sélectionnez le périphérique MIDI auquel est connecté
l’appareil que vous voulez piloter.

MMC Input ID: Saisissez l’identifiant d’entrée de Samplitude.

MMC Output ID: Réglez l’identifiant d’entrée des périphériques que vous
aimeriez contrôler.

Exemples de synchronisation
Quelques exemples de synchronisation:

1. Synchronisation d’un séquenceur physique externe. Samplitude est le maître.
Pour synchroniser Samplitude avec un séquenceur physique externe (boîte à
rythmes, groove box, etc.), vous devez d’abord sélectionner le type de
synchronisation. Comme ces appareils externes utilisent généralement des
informations de tempo de morceau ou dépendantes du rythme, ils sont souvent
synchronisés par horloge MIDI. Dans ce cas, des impulsions passent du maître
à l’esclave. Ces impulsions de commande sont transmises avec pour base les
noires. Leur nombre par noire est toujours le même. Les informations de tempo
sont toujours claires car les impulsions ne se produisent pas sur des unités de
temps absolu mais dépendent du rythme.
Cela sécurise la synchronisation du tempo des deux unités qui doivent être
alignées. Bien sûr, le même tempo (plus ou moins) doit être réglé sur les deux
unités dès le début. Le pointeur MIDI de position dans le morceau est un autre
outil important de synchronisation par horloge MIDI, puisqu’il fournit des
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informations sur le nombre d’impulsions de commande qui ont déjà été
transmises. Vous pouvez donc partir de n’importe quelle position du séquencer
puisque vous êtes sûr de retrouver la même position sur les deux unités
synchronisées.

Note: La taille du pointeur MIDI de position dans le morceau est limitée à 1024
mesures (en 4/4). Au delà, aucune synchronisation par horloge MIDI n’est
possible; les appareils esclaves connectés s’arrêtent simplement.

Assurez-vous d’abord que votre séquenceur physique externe accepte la
synchronisation par horloge MIDI en tant qu’esclave. Puis reliez la MIDI Out
du maître (MIDI Out de l’interface MIDI de l’ordinateur sur lequel fonctionne
Samplitude) à l’entrée MIDI du séquenceur physique externe. Maintenant, réglez
le séquenceur physique en mode esclave. Veuillez vous référer au mode d’emploi
de l’appareil pour ce réglage.
Vous noterez que la commande de transport et le réglage de tempo du séquenceur
sont désactivés. Il recevra maintenant ses données du maître, c’est-à-dire de
Samplitude.
Ouvrez maintenant la fenêtre de synchronisation dans Samplitude et activez
l’option «MIDI Clock Output > «MC Output active». Puis sélectionnez le port
MIDI connecté à l’appareil esclave. Sélectionnez le tempo auquel vous voulez
faire tourner le séquenceur physique externe. Cela ne doit pas nécessairement
être le tempo de votre projet Samplitude. Cela reste cependant logique puisque
les mesures de la fenêtre de l’arrangeur dans Samplitude correspondent dans la
plupart des cas aux mesures du séquenceur. Si vous pressez alors le bouton de
lecture dans Samplitude, l’appareil externe démarre en synchronisation avec le
tempo de votre projet.
Sachez aussi que «Transport window as Remote Control for external machines»
doit être désactivé si l’appareil à contrôler ne sait pas traiter les données MMC
(MIDI machine control). Les touches de transport ne contrôlent alors plus ni
Samplitude ni le séquenceur externe.

2. Synchronisation par horloge MIDI sur un appareil externe. Samplitude est
l’esclave.
En principe, il est judicieux de choisir pour maître l’appareil dont le tempo est le
plus stable. Dans la plupart des cas, ce sera Samplitude. Bien sûr, vous pouvez
aussi régler Samplitude en esclave, par exemple si les parties principales d’une
production sont préparées sur un séquenceur MIDI externe et que Samplitude
ne sert que de dispositif audio complémentaire, ou si le séquenceur que la
synchronisation par horloge MIDI comme maître. Les règles suivantes doivent
être observées: Contrairement à un appareil exclusivement MIDI, Samplitude
peut contenir des fichiers audio dont la durée peut devoir être ajustée. Ce n’est
possible qu’en cochant la case Active de «Chase Lock Sync (adapt speed by
resampling)». Toutefois, si le timing du maître est inexact, cela peut entraîner
des fluctuations audibles de la hauteur.

Note: Cette fonction ne doit être employée que si aucun word clock commun n’est
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disponible. Si un word clock commun est disponible, des variations de synchronisation
seront créées.

Pour une synchronisation comme esclave par horloge MIDI, reliez la MIDI Out
de votre appareil externe à la MIDI In du port MIDI sélectionné dans les réglages
de synchronisation. Cochez maintenant «MC Input active» dans
«Synchronization/MIDI Clock Input» et saisissez le tempo du séquenceur
externe.
Samplitude fonctionne maintenant comme esclave. Contrairement à beaucoup
de séquenceurs matériels, Samplitude ne désactive pas les touches de transport
mais «répond» aux commandes reçues du maître. Assurez-vous que l’appareil
externe est en mode «synchronisation maître» (beaucoup d’appareils nomment
cela «Internal Sync Mode» avec «Sync Out» (sortie de synchro) activé). Si vous
faites maintenant démarrer l’appareil externe, le projet de Samplitude démarre
parallèlement.
Si «Chase Lock Sync» est activé, les fluctuations que Samplitude doit niveler
sont affichées en bas à droite de la fenêtre de l’arrangeur. Si votre séquenceur
externe est réglé sur un tempo différent de celui de Samplitude, ce dernier
essaiera de se caler sur le tempo entrant en changeant le tempo de lecture par
rapport au tempo (BPM) initial après démarrage du séquenceur. Toutefois, cela
peut nécessiter plusieurs mesures et donner des fluctuations audibles de hauteur.
Il vaut mieux s’assurer que vous démarrer avec le même tempo sur les deux
unités synchronisées.

3. Synchronisation par MIDI Time Code (MTC) d’un second séquenceur logiciel.
Samplitude est le maître.
Samplitude peut être synchronisé avec un autre séquenceur logiciel ou
enregistreur sur disque dur. Si elle est acceptée, la synchronisation par MIDI
Time Code convient alors particulièrement bien.
L’avantage de cette méthode de synchronisation est qu’elle est indépendante
des valeurs de tempo du morceau. Les changements de tempo dépendant du
rythme et de la mesure ne sont donc plus un problème dans un projet, puisque
la communication se fait maintenant par valeurs temporelles. En accord avec le
code SMPTE, la division se fait en Heures:Minutes:Secondes:Images ou
«Frames» (format: 00:00:00:00). Les frames sont les plus petites unités SMPTE.
Elles viennent de la technologie du cinéma et établissent le nombre d’images
par seconde (par ex. 24 frames/images pour le film, PAL: 25 frames/images
pour la vidéo).
Si Samplitude doit être synchronisé seulement à de l’audio et pas à des films,
n’importe quelle cadence d’images peut être choisie; toutefois, il est important
que la même cadence d’images soit sélectionnée sur les deux appareils.
Le second séquenceur logiciel peut fonctionner sur la même machine que
Samplitude ou sur une autre. Toutefois, certains points doivent être observés
quand deux séquenceurs tournent simultanément sur le même ordinateur.
D’abord, vous devez vous assurer que les pilotes audio employés peuvent
simultanément s’adresser à plusieurs sorties de carte son, puisque deux
applications audio ne peuvent pas s’adresser en même temps à une même sortie
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de pilote. Sinon, vous pouvez aussi employer deux sorties audio différentes.
La gestion des interfaces MIDI requises pour la synchronisation est similaire.
Dans ce cas, toutefois, le port MIDI est généralement ouvert par un programme,
et les autres applications s’en voient refuser l’accès. Deux interfaces MIDI
couplées ensemble peuvent aussi être employées ici. Il existe une solution plus
pratique: de petits programmes auxiliaires (Hubis Loopback pour Win 95 &
Win 98 ou MIDI Yoke [www.MIDIox.com] pour Win 98, Win NT, Win XP)
installent plusieurs ports MIDI virtuels pouvant être couplés sur l’ordinateur.
Pour synchroniser le logiciel séquenceur via MTC et utiliser Samplitude comme
maître, lancez d’abord les deux programmes. Reliez maintenant la sortie MIDI
du port MIDI utilisé par Samplitude à l’entrée MIDI du système à synchroniser
ou faites le branchement virtuellement au moyen d’un programme auxiliaire.
Sélectionnez à présent le port MIDI correspondant en fenêtre «Synchronization/
MTC Output» et activez « MTC Output active». Sur l’esclave, sélectionnez
l’option esclave («slave») ou réception de MTC («receive MTC») correspondante.
Ce réglage dépend du programme employé. Veuillez vous reporter à son mode
d’emploi pour des détails. Activez le port MIDI In employé. Vérifiez que la
même cadence d’images est réglée sur les deux systèmes. Si vous faites
maintenant démarrer Samplitude, le système esclave suit et cela en
synchronisation avec le maître.

Important: Vérifiez toujours que la position de début de synchro du système esclave
est identique à celle de Samplitude. Si le début de synchro SMPTE ne peut pas être
réglé pour l’autre séquenceur, vous pouvez saisir l’heure de départ de l’autre système
dans Samplitude avec «Synchronization/VIP Start time / SMPTE Offset».

4. Synchronisation par MIDI Time Code (MTC) sur un second séquenceur
logiciel. Samplitude est l’esclave.
Cette méthode est globalement la même que dans 3. Toutefois, le réglage maître/
esclave doit être inversé, c’est-à-dire de la MIDI Out de l’autre séquenceur à la
MIDI In de Samplitude.

Contrôleur physique
Introduction
Samplitude offre une méthode simple pour brancher jusqu’à 4 périphériques
MIDI (par ex. Mackie Control + extension), qui peuvent alors facilement contrôler
le logiciel. Un total de 32 pistes peuvent maintenant être contrôlées (le décalage
de piste peut être réglé pour des périphériques supplémentaires). Nous avons
préparé quelques presets pour des surfaces de contrôle; toutefois, vous pouvez
changer ces presets ou créer un ensemble entièrement nouveau. Prenez votre
temps. Intégrer des surfaces de contrôle nécessite de la concentration.
Bien sûr, avoir une interface MIDI, ou une interface USB (pour les contrôleurs
USB), est un préalable à l’emploi de contrôleurs physiques (pour des contrôleurs
communiquant par MIDI).

Note: Les contrôleurs physiques USB ne fonctionnent pas sous Win 95 puisque ce
système d’exploitation ne prend pas en charge l’USB.
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Votre surface de contrôle est-elle référencée dans la liste des presets?
Pour savoir, ouvrez la fenêtre de configuration de surface de contrôle. Pressez
«y» pour ouvrir la fenêtre. Cliquez ensuite sur l’onglet «MIDI » et ouvrez la
fenêtre en cliquant sur «Hardware Controller Setup».

MIDI Connection to Controller (connexion MIDI à la surface de contrôle): Le
menu déroulant du haut offre une liste de surfaces de contrôle disposant déjà
d’un preset. Cliquez sur le menu et sélectionnez votre surface de contrôle.
En dessous se trouvent les réglages de port MIDI. Les surfaces de contrôle USB
apportent généralement ici leurs propres ports MIDI. Si une surface de contrôle
est employée via une interface MIDI normale, vous devez régler son port MIDI.
Il n’est pas important que le périphérique soit inclus dans la liste des presets!

Personnalisation de votre surface de contrôle/création de votre
configuration personnelle
Si votre périphérique n’est pas dans la liste ou si vous n’aimez pas certains
réglages des presets, pas d’inquiétude. Samplitude peut apprendre. Un menu
déroulant affiche toutes les fonctions contrôlables dans Samplitude, qui doivent
ensuite être assignées à la surface de contrôle. Sélectionnez un élément (par ex.
le fader 1 pour le premier fader visible dans la table de mixage de Samplitude),
actionnez l’élément correspondant de votre surface de contrôle et cliquez sur le
bouton «Learn» (apprentissage).

Note: Les surfaces de contrôle à faders sensibles au toucher envoient un signal (toucher
de fader) à Samplitude quand on touche et relâche le fader. Le bouton «Learn» doit
être pressé après avoir touché et relâché le fader.
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Tous les paramètres pouvant être télécommandés dans Samplitude sont
référencés dans le tableau suivant.
Ainsi, vous pouvez régler individuellement chaque élément de votre surface de
contrôle dans Samplitude. Une fois que vous avez créé une configuration
complète, vous pouvez la sauvegarder sous le nom de votre surface de contrôle.
Elle apparaît dorénavant toujours dans la liste des presets.

Note: Vous pouvez employer n’importe quel contrôleur MIDI pour piloter Samplitude
(par ex. un boîtier de faders MIDI pour régler individuellement le volume des pistes).

Liste des paramètres de Samplitude qui peuvent être télécommandés

Key 1…8 Une pression: Mute on/off
Double clic: Solo on/off
Avec Shift Mode 1: Automation de piste
Avec Shift Mode 2: Plug-ins de la piste correspondante
Avec Shift Mode 3: Couplage de paire de pistes
Avec Shift Mode 4: Enregistrement d’automation on/

off

Link Master Volume Commute on/off le bouton Link en section master de
la table de mixage

Master Normalize Normalisation du master ou «N» (Master Normalize)

Shift Mode 1 Touche enfoncée: automation de piste via touches 1…8
on/off
Shift Mode 2 Plug-ins on/off (ouvre la fenêtre si aucun plug-in n’est
installé) via les touches 1…8
Shift Mode 3 Couplage des pistes
Shift Mode 4 (agit comme commutateur): - Enregistre l’automation

(durant la lecture; l’automation de piste doit être
activée!)
1er clic: enregistre les mouvements de fader;
2ème clic: Fin d’enregistrement – Contrôle
Contrôle les fréquences des 4 bandes de correction
du master, les faders changent le gain
1er clic: Fréquence de commande
2ème clic: Retour à la commande de gain

Stop at position Arrêt à la position actuelle

Play/stop Lecture depuis la position actuelle/arrêt

Fader 1...8 Commandent le volume des 8 premières voies visibles
dans la table de mixage.
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Master Vol. left/right Commande le volume master gauche/droit

Master EQ
Lo/LM/HM/Hi
Gain/Freq. Commande le gain des 4 bandes de correction du
master

Avec Shift Mode 4: Commande les fréquences des 4
bandes de correction du master

Master Stereo Enhancer Commande l’enhancer stéréo multi-bande du master

Pitch Factor Facteur de hauteur employé pour la lecture scrub

Les changements sont aussi employés durant le scrub,
c’est-à-dire que la lecture suivante s’effectue à la
hauteur réglée.

Mute 1...8 Coupe les 8 premières voies visibles dans la table de
mixage de Samplitude.

Solo 1...8 Met en solo les 8 premières voies visibles dans la table
de mixage de Samplitude.

Record Ready 1...8
+ Shift: «Active» l’enregistrement pour la voie correspondante

de la table de mixage de Samplitude.
Commute on/off l’écoute forcée (Force Monitoring)
pour la voie correspondante de Samplitude
(seulement avec les pilotes ASIO, mode de
fonctionnement «manual monitoring») pour la voie
correspondante de la table de mixage de Samplitude.

Potent. 1...8 Règle la valeur assignée à la table de mixage de
Samplitude Mixer sur un emplacement visible.

Select 1...8 Sélectionne la piste dans le VIP.

Fadertouch 1…8 Active les informations d’enregistrement de volume
si l’automation individuelle de piste est activée. Cette
valeur n’est requise que pour les faders sensibles au
toucher.

Shift Touche modificatrice pour accéder à la seconde
fonction des boutons de la surface de contrôle.
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Fader Master Règle le volume master

Scrub Commute on/off le mode scrub

Scrubwheel FWD Scrub avant

Scrubwheel REW Scrub arrière

Pots 1...8 Presse les commandes rotatives de la Mackie Control

Play Lance la lecture

Stop Arrête la lecture

Fast FWD Avance rapide

Rewind Retour rapide
Mode marqueur: Saut au marqueur suivant/

précédent.
Mode objet: Sélectionne l’objet suivant/précédent dans

la piste sélectionnée

Record Démarre immédiatement l’enregistrement.

Mixertrack 1 UP Défilement de 2 voies sur la droite.

Mixertrack 1 DOWN Défilement de 2 voies sur la gauche.

Mixertrack 8 UP Défilement de 8 voies sur la droite.

Mixertrack 8 DOWN Défilement de 8 voies sur la gauche.
Les commandes de voie bougent aussi. Toutes les voies
visibles dans la table de mixage peuvent par
conséquent être pilotées par la surface de contrôle.

Zoom Active le zoom via les touches curseur (sinon
défilement vertical et horizontal dans le VIP)

Zoom left Zoom vertical arrière
Zoom right Zoom vertical avant
Zoom up Zoom horizontal arrière
Zoom down Zoom horizontal avant (n’agit que si le bouton zoom

est activé, peut alors être la même touche que le
curseur).

Assig. Pan Les commandes rotatives 1…8 sont assignées au
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panoramique.

Assig. EQ Les commandes rotatives 1…8 sont assignées au
correcteur.
Assig. Aux Les commandes rotatives 1…8 sont assignées au niveau
des départs AUX.

Marker 1...8 Les marqueurs 1….8 sont définis. Si le marqueur
correspondant est déjà défini, la tête de lecture saute
à cette position.

Marker Mode Passe en mode marqueur.

Loop On/Off Commute on/off le bouclage.

Enter Pour confirmer les changements d’effets dans les
fenêtres (OK/Enter).

Cancel Annule les changements précédents (par ex. effets,
etc.).

Save Sauvegarde le projet ouvert.
Undo/Redo Annule («Shift+Undo/Redo» pour restaurer)
Activate LCD Meter En maintenant enfoncé un des boutons, pressez un

des boutons F1 – F4 sur la Mackie Control ou les
boutons assignés (correspondant à F1 – F4) pour
alterner entre les différents modes de crête-mètre.
Utilisez F8 pour revenir au mode normal (les
dernières valeurs éditées sont affichées).

Automation Read La diode REC/RDY-LED pour „Automation« sur la
MACKIE CONTROL sert de témoin visuel de
l’enregistrement d’automation. Elle s’allume durant
l’enregistrement de l’automation.

Automation Signale l’enregistrement de courbes d’automation de
niveau sur la MACKIE CONTROL.
Automation Pan Touch L’automation de panoramique ne peut être enregistrée

que si le bouton PanTouch est pressé. (Correspond à
Fader Touch et Fader Release pour les faders de
volume sensibles au toucher).

Cursor left Défilement gauche dans le projet ouvert.

Cursor right Défilement droit dans le projet ouvert.

Cursor up Passe à la piste précédente du VIP actuel.
Cursor down Passe à la piste suivante du VIP actuel.
Mixer Ouvre la table de mixage.
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Cut Coupe l’objet sélectionné à la position actuelle du
curseur.

Option Une sélection peut être ouverte avec la molette de
scrub en maintenant le bouton «Options».

Prev. Object Sélectionne l’objet précédent
(Mackie Control: F14)

Next Object Sélectionne l’objet suivant (Mackie Control: F15)

Note: Si le mode objet est activé, vous pouvez sauter à l’objet précédent ou suivant
avec les boutons de retour/avance rapide de la commande de transport (de la surface
de contrôle). La même chose s’applique en mode marqueur. Dans ce cas, vous sautez
au marqueur voisin dans le projet.

Options
Output (Sortie MIDI)
Deactivate: Si votre surface de contrôle n’a pas de faders motorisés, vous pouvez
utiliser cette option pour désactiver l’envoi de données de contrôleur.

Normal Send: Les données de contrôleur MIDI sont envoyées sans demande
de confirmation.

Normal Send + Send Incoming Back: Envoi des données de contrôleur avec
confirmation. Important pour des surfaces de contrôle comme Logic Control;
toutefois, cela peut poser des problèmes à d’autres surfaces de contrôle. Il peut
alors être nécessaire de choisir «Normal Send».
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Introduction
Depuis la version 7.1, Samplitude offre une fonction de gel nommée Freeze,
qui permet de temporairement libérer des ressources de calcul au moyen d’une
pratique opération de report. Les pistes complexes, incluant toutes les données
audio/MIDI, les objets simples et même les bus aux ou submix peuvent donc,
d’un clic sur un bouton, être «gelés» dans leur état actuel avec tous leurs effets,
plug-ins et réglages d’automation.
Il ne reste alors qu’un simple fichier audio stéréo, n’entraînant qu’une charge
négligeable pour le processeur. Ainsi, même les arrangements complexes
peuvent être réalisés ou terminés sur des systèmes à faibles performances et
des portables à économie d’énergie, alors que le projet original a été démarré
sur une station de travail beaucoup plus puissante.
Le gel peut être levé sans délai d’un clic de souris. Tous les réglages d’effet
d’origine, les plug-ins et courbes d’automation redeviennent alors accessibles,
tels qu’au moment du gel.
Une option spéciale rend possible l’ouverture de pistes et d’objets «gelés» dans
leur état d’origine, dans leur propre projet, et leur édition non destructive avec
toutes les fonctionnalités de Samplitude sans avoir à les «dégeler» dans le projet
actuel. Tous les effets internes, plug-ins, automations et même les effets master
sont disponibles, comme d’habitude. Il n’y a pas de limitations. Toute édition
des ces projets gelés assure une mise à jour automatique du matériel gelé.
Ainsi, conjointement à la fonction Freeze, des constructions audio complexes
deviennent possibles, pouvant être éditées dans leur état d’origine d’un clic sur
un bouton tout en permettant de les archiver avec tous les fichiers audio comme
des projets complets («Save complete VIP in…»).
Il existe une variété d’options de gel:
1. Des pistes complètes peuvent être gelées dans leur état actuel.
2. Des objets, ainsi que des groupes d’objets multipistes se chevauchant peuvent

être individuellement gelés.
3. Des bus et bus aux peuvent être gelés dans leur état actuel.
4. Groupage d’objets: Plusieurs objets peuvent être gelés ensemble en un nouvel

objet et ultérieurement ramenés à leur état d’origine.

Gestion des données gelées
Quand vous sauvegardez des fichiers gelés, une quantité considérable de données
peut s’accumuler. Une gestion automatique des données gelées devient alors
nécessaire.
Le principe est simple: comme déjà mentionné, les données et les VIP gelés
sont conservés dans un dossier spécial dans le dossier actuel de projet. Après
finalisation du projet actuel, toutes les données gelées qui ne sont plus utiles
sont supprimées en arrière-plan.
Les données requises pour un dégel sont préservées, tant que les pistes ou objets
gelés correspondants restent dans le projet actuel.
Il y a toutefois une limitation: si des données gelées existent au moment où le
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projet actuel est sauvegardé, toutes les données gelées existantes sont aussi
conservées, même si elles ne servent plus au dégel après finalisation du projet.

Exemple
Les pistes 1 et 2 sont gelées. La piste 2 est dégelée avec finalisation du projet
actuel. Le projet est alors sauvegardé puis finalisé. Durant la finalisation, les
données gelées et le VIP gelé de la piste 2 sont supprimés. Les données gelées
et le VIP gelé de la piste 1 restent inchangés.
Si toutefois le projet actuel est temporairement sauvegardé avant que la piste 2
ne soit dégelée, les données gelées de la piste 2 sont aussi conservées.

Suppression manuelle des données gelées
Il existe une commande spéciale pour se débarrasser des données dorénavant
inutiles: Delete freeze data (menu Tools).

Si aucune donnée gelée n’existe (encore) dans le projet actuel, cette commande
est désactivée et ne peut pas être sélectionnée.
Quand cette commande est employée, toutes les données audio gelées qui ne
sont plus nécessaires au projet actuel sont supprimées.
Les autres projets gelés existants ne sont toutefois pas affectés. Comme l’état
d’origine tel qu’avant l’emploi de la commande Freeze se trouve dans un VIP
gelé, il peut être retrouvé, tant que les données audio nécessaires sont toujours
à leur position d’origine.

Root Projects (projets sources)
Le projet source ou «root project» est une option spéciale étroitement liée à
l’option Freeze. On peut l’employer, par exemple, pour éditer des objets reportés
dans leur état d’origine pour un projet de mastering.
Chaque objet créé dans Samplitude par report («bouncing») peut être édité dans
ce projet primaire avec son état avant report, tant que ses données audio d’origine
et le projet primaire (=root VIP) restent disponibles.
Cette option, grâce à laquelle un projet complet avec toutes ses options peut se
cacher derrière n’importe quel objet, permet des productions audio complexes
et un rappel pratique du statut de travail antérieur à l’opération de report
(«bouncing»).

Exemple d’application 1
Dans un projet, un nouveau fichier audio stéréo a été créé, qui doit servir de
titre pour un CD final. Après ouverture de ce fichier dans le projet de mastering
final, le projet d’origine peut à tout moment être ouvert à l’aide de la commande
«Edit root project» et tous les réglages antérieurs à la procédure de report
(«bouncing») peuvent être changés. Sauvegarder ce projet met automatiquement
à jour le fichier dans le projet de mastering. Cette option est bien sûr disponible
pour chaque objet dans le projet de mastering.

Exemple d’application  2
Pour un reportage radio, diverses contributions sont regroupées en un projet
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final après des fondus et éditions mineures.
Chaque segment est constitué d’un ou de plusieurs objets qui ont été
préalablement employés pour d’autres projets, c’est-à-dire édités, coupés, dotés
d’effets et exportés par report («bouncing»).
La possibilité d’ouvrir le VIP source (root VIP) de chaque objet en dehors du
projet actuel amène une flexibilité incroyable pour l’édition ultérieure du matériel
final dans son état premier. La mise à jour automatique garantit que tous les
changements apportés au VIP source sont immédiatement intégrés dans le projet
de reportage final.

Exemple d’application  3
Pour le travail sur une bande son ou son doublage, les repères («tops») individuels
sont importés. S’il est maintenant déterminé qu’une certaine image nécessite
un changement du matériel d’origine, par exemple la ligne mélodique d’un
instrument virtuel dans le VIP source ou une partie du mixage d’origine (par ex.
une basse trop forte), cela peut se faire sur le champ, avec mise à jour immédiate
des objets correspondants dans le projet final.

Opération
Un fichier audio créé par report («bouncing») dans Samplitude contient un
nouveau choix dans le menu contextuel (clic droit sur l’objet):

Edit root VIP …
Cette commande ouvre une copie du projet source tel qu’il était au moment de
la dernière sauvegarde. S’il a été appelé et édité après la procédure de report, il
peut bien sûr différer du fichier audio précédemment créé.
Après édition du VIP source et appel de la fonction de sauvegarde de projet
«save project», il vous est demandé de confirmer que l’objet qui a été
originellement créé doit être mis à jour au moyen d’une procédure de report de
piste (track-bouncing). Toutes les options de report de piste (réglages de format,
dithering etc.) sont disponibles pour cela. S’il n’existe aucune autre section ou
si une section différente existe, la longueur originelle du fichier audio reste
prise en considération.
Toutefois, la demande de mise à jour automatique n’est suivie d’effet que si le
VIP original est aussi appelé avec la commande «Edit root VIP». Un projet
appelé de la façon habituelle avec «Open project» n’a pas d’effet.

Glue Objects (Réunion d’objets)
L’option évoquée dans cette section est liée à la fonction Freeze. Les nouvelles
données audio sont copiées dans le dossier Freeze et y restent tant que le groupage
est maintenu.
La commande «Glue Objects…» — dans le menu Object — entraîne une opération
de report destructive, par laquelle un nouvel objet est créé par réunion de
plusieurs objets, incluant les réglages d’effets, de time-stretch et les crossfades.
Le nouvel objet n’a pas d’effets. Les fondus restent inchangés. Les départs aux
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du premier objet sont appliqués au nouvel objet.
En appelant la fonction de dégel Unfreeze, l’état d’origine des objets retrouvé.
En utilisant la commande «Edit Object Freeze», des objets groupés peuvent
être appelés et édités comme un projet gelé dans l’état où ils se trouvaient quand
la commande de groupage a été exécutée. Tous les changements accomplis ici
sont automatiquement appliqués aux objets réunis.

Edition de projets gelés
Comme déjà mentionné, une option spéciale rend possible l’ouverture de pistes
et d’objets «gelés» dans leur état d’origine dans leur propre projet et leur édition
non destructive avec toutes les fonctionnalités de Samplitude, sans avoir à les
«dégeler» dans le projet actuel. Ainsi tous les effets internes, plug-ins,
automations et même les effets master sont disponibles comme d’habitude. Il
n’y a pas de limitations.
Un projet gelé est ouvert avec la commande «Edit Freeze», qui se trouve dans le
menu Track ou Object. Il se présente comme un VIP à piste simple, dans lequel
le ou les objets (dans le cas d’un gel de piste par Track Freeze) correspondants
sont dans l’état qui était le leur lors du gel dans le projet d’origine.
Si c’est une piste qui a été gelée, les donnés d’automation et les courbes de
commande MIDI peuvent aussi s’y trouver.
Toutes les éditions de ces projets gelés produisent une mise à jour automatique
du matériel gelé dans le projet d’origine lors de la sauvegarde, au moyen d’une
opération de report automatiquement exécutée.
Si le projet d’origine est dégelé, l’état correspondant au VIP gelé est rétabli. Des
changements de positions, crossfades, effets ou courbes d’automation peuvent
se produire s’ils ont entre temps été édités dans le VIP gelé.

Track Freeze (Gel de piste)
Freeze
La commande Freeze — du menu Track— sert à accomplir un report de la piste
actuelle en format 32 bits flottant et à la fréquence d’échantillonnage du projet.
Un nouvel objet sans effets, facilement identifié par la couleur bleue du gel, et
qui se réfère au nouveau fichier .WAV créé, remplace l’objet d’origine et ses
complexes réglages d’effets. Ce nouveau fichier .WAV est placé dans l’index de
gel, qui est créé en arrière-plan comme un sous-dossier du dossier du projet la
première fois que l’option Freeze est employée.
Le processus intègre les paramètres de piste suivants:
– Objets audio et MIDI (dont les instruments VST de la piste)
– Fondus, fondus-enchaînés d’objet, groupages d’objets
– Effets et plug-ins internes de la piste
– Effets et plug-ins internes de l’objet
– Données d’automation (volume, panoramique, plug-ins VST, paramètres de

VSTi)

Restriction
Les départs pré-fader de la piste ne peuvent bien sûr pas être pris dans un fichier
gelé, dans lequel le calcul s’effectue après le départ. Tant que dure le gel de
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piste, ils sont traités comme des départs post-fader; après le dégel, ils redeviennent
des départs pré-fader.
Logiquement, les départs aux de l’objet ne peuvent pas non plus être pris en
compte pendant la période de gel, puisqu’un fichier complet sans calculs existe
après la procédure de gel. Un gel des bus aux affectés peut servir de solution de
rechange, ceux-ci pouvant être reproduits avec l’objet gelé d’origine.
De cette façon, toute charge de travail du processeur dépassant la reproduction
d’un fichier .WAV 32 bits stéréo est retirée du projet actuel.

Besoins de stockage
Veuillez noter qu’un fichier entièrement nouveau au format 32 bits est créé
pour chaque procédure de gel. Par conséquent, pour 5 minutes de projet, 100 Mo
d’espace de disque dur sont nécessaires à chaque emploi de la fonction de gel
(Freeze). La maintenance automatique des données de gel assure la libération
de cet espace de stockage lors de la sauvegarde et du chargement du projet (voir
ci-dessous). Plus encore, une option permet de supprimer tous les fichiers audio
de gel créés par des reports de gel.

UnFreeze (Dégel)
Pour que les objets audio ou MIDI d’origine soient retrouvés après dégel, ils
sont transférés, avec toutes les données d’effets et d’automation dans un projet
nouvellement créé, également dans le dossier Freeze. Ce VIP gelé est un projet
normal de Samplitude (VIP) qui peut être ouvert et édité (voir ci-dessous: Travail
avec des VIP gelés).
Utilisez la commande de dégel Unfreeze — dans le menu Track — pour rétablir
l’état d’origine de tous les objets et réglages d’effets.
Les commandes Freeze et Unfreeze sont disponibles dans le menu Track mais
aussi via les raccourcis suivants:
– Track Freeze (gel de piste): CTRL+SHIFT+F
– Track Unfreeze (dégel de piste): CTRL+SHIFT+U

Gel d’objet
Freeze
La commande Freeze — du menu Object — sert à accomplir un report de la
piste actuelle en format 32 bits flottant et à la fréquence d’échantillonnage du
projet. Un nouvel objet sans effets, facilement identifié par la couleur bleue du
gel, et qui se réfère au nouveau fichier .WAV créé, remplace l’objet d’origine et
ses complexes réglages d’effets.
Ce nouveau fichier .WAV est placé dans l’index de gel, qui est créé en arrière-
plan comme un sous-dossier du dossier du projet la première fois que l’option
Freeze est employée.
Si la commande Freeze est appelée pour plusieurs objets sélectionnés, qui
peuvent être répartis sur plusieurs pistes, ces derniers sont «gelés« tout à tour
en plusieurs procédures de report de pistes. Un nouveau fichier .WAV et un
projet spécifique (root VIP) sont créés dans le dossier Freeze pour chaque objet.
Le processus intègre les paramètres d’objet suivants:
– Données d’objets audio et MIDI (dont les instruments VST de la piste)
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– Effets et plug-ins internes de l’objet

Les données d’automation (volume, pan, plug-ins VST, paramètres de VSTi),
fondus et fondus-enchaînés d’objets se chevauchant ne sont pas gelés et peuvent
donc toujours être édités.

Besoins de stockage
Veuillez noter qu’un fichier entièrement nouveau au format 32 bits est créé
pour chaque procédure de gel. Par conséquent, pour 5 minutes de projet, 100 Mo
d’espace de disque dur sont nécessaires à chaque emploi de la fonction de gel
(Freeze). La maintenance automatique des données de gel assure la libération
de cet espace de stockage lors de la sauvegarde et du chargement du projet (voir
ci-dessous). Plus encore, une option permet de supprimer tous les fichiers audio
de gel créés par des reports de gel.

UnFreeze (Dégel)
Pour que les objets audio ou MIDI d’origine soient retrouvés après dégel, ils
sont transférés, avec toutes les données d’effets et d’automation dans un projet
nouvellement créé, également dans le dossier Freeze. Ce VIP appelé VIP source
ou  «root VIP» est un projet normal de Samplitude (VIP) qui peut être ouvert et
édité (voir ci-dessous: Travail avec des VIP gelés).
Utilisez la commande de dégel Unfreeze — dans le menu Object — pour rétablir
l’état d’origine de tous les objets et réglages d’effets.
Les commandes Freeze et Unfreeze sont disponibles via les raccourcis suivants:
– Freeze (gel de piste): CTRL+ALT+F
– Unfreeze (dégel de piste): CTRL+ALT+U

Gel de bus/bus auxiliaire
Comme vous le savez, les bus et bus aux de Samplitude offrent les mêmes
fonctionnalités que les pistes normales. Ils ont leur propre représentation de
piste dans le projet, offrent les mêmes effets et peuvent pour leur part être aussi
dirigés, vers les bus et bus aux.
Les pistes des bus/bus aux peuvent être gelées comme les pistes ordinaires.
Cela permet qu’un groupe complet de pistes incluant tous les réglages d’effets,
fondus, fondus-enchaînés et automation soulage d’un coup le processeur.

Freeze (Gel):
Comme avec les pistes normales, la commande Freeze — du menu Track—
sert à accomplir un report de toutes les pistes dirigées vers ce bus/bus aux. Le
nouveau fichier gelé, coloré en bleu, est inséré dans la piste de bus du projet et
lu à la place de la somme antérieure faite dans le bus. Toutes les pistes dirigées
vers ce bus et incluses dans le report sont retirées du calcul de reproduction. Si
un bus aux est gelé, seuls les éléments de signal de piste dirigés vers ce bus aux
sont affectés.
Contrairement à la fonction de report de pistes (track-bouncing), les objets
d’origine sont donc préservés dans le projet actuel avec tous les réglages d’effets,
les données de fondu ou d’automation. Ils ne sont pas transférés dans un VIP
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source (root VIP) et remplacés par des objets nouvellement créés. En contrepartie,
éditer cette piste ou n’importe lequel de ses objets dans le projet actuel n’a pas
d’effet tant que le bus est gelé.
Pour faire apparaître ces pistes coupées, une petite étoile est placée devant le
nom de piste pendant la durée du gel. Pour les pistes qui étaient dirigées vers le
bus aux, le fader aux des départs aux correspondants vire au bleu.

Besoins de stockage
Veuillez noter qu’un fichier entièrement nouveau au format 32 bits est créé
pour chaque procédure de gel.

UnFreeze (Dégel)
Utilisez la commande de dégel Unfreeze — dans le menu Track — pour rétablir
l’état d’origine de tous les objets et réglages d’effets.
Les commandes Freeze et Unfreeze sont disponibles dans le menu Track et
peuvent, comme c’est le cas pour le gel de piste, être demandées pour le bus/
bus aux sélectionné via les raccourcis suivants:
– Freeze (gel): CTRL+SHIFT+F
– Unfreeze (dégel): CTRL+SHIFT+U
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Samplitude 8 offre des possibilités complètes pour mixer un matériel audio
selon différents formats multicanaux.
Un des impératifs est l’emploi d’une table de mixage avec un master surround
master configuré selon le format visé. 5.0 ITU ou 5.1 ITU sont des exemples de
tels formats.
Les canaux du master surround peuvent être assignés à n’importe quel
périphérique de reproduction en fenêtre de configuration de projet. Le master
audio d’une piste de VIP peut être distribuée dans le module de panoramique
surround entre les bus surround disponibles.
Les objets peuvent aussi être directement routés vers le master surround et être
distribués dans le panoramique surround indépendamment de la piste à laquelle
ils ont été assignés.
Le module de panoramique surround offre quatre modes différents pour
positionner les signaux dans le panoramique surround. Différents effets
surround sont aussi disponibles pour mixer au format multicanal.

Note: Samplitude offre aussi un son surround 2 canaux, qui peut servir à des projets
basés sur le «Dolby Surround ProLogic». Une carte audio stéréo standard et un
amplificateur/récepteur compatible «Dolby Surround ProLogic» suffisent pour
travailler en son surround 2 canaux.

Création d’un nouveau VIP avec table de mixage en format
Surround
Menu: «File» -> «New virtual project (VIP)»
Dans la fenêtre «Setup for new Project (VIP)», sélectionnez Surround comme
configuration de table de mixage («Mixer Setup»). Puis sélectionnez le format
voulu dans «Surround Setup» (par ex. 5.1 ITU). Tous les autres réglages sont les
mêmes que pour créer un programme VIP stéréo.
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En plus des canaux de piste audio, la table de mixage du nouveau VIP créé
comprend maintenant le master surround au format surround sélectionné (par
ex. pour 5.1: ITU L, R, C, LFE, Ls, Rs). Tous les canaux des pistes de VIP
correspondantes de la table de mixage sont automatiquement dirigés vers le
master surround. Le master stéréo de la table de mixage est d’abord masqué;
toutefois, il peut être affiché en cliquant sur le bouton «Master» de la table de
mixage. Les voies de la table de mixage peuvent être individuellement dirigées
vers le master surround ou le master stéréo. Voir la section intitulée «Travailler
simultanément aux formats stéréo et surround» pour créer simultanément des
mixages stéréo et surround.

Routage des canaux master surround vers les sorties physiques. Référez-vous à
«Configuration Surround de projet».

Conversion d’un VIP stéréo existant en VIP au format Surround
Le preset surround est sélectionné dans le coin inférieur droit de la table de
mixage du VIP actuel. La fenêtre «Project Mixer Setup» apparaît quand on clique
sur Setup. Ouvrez la fenêtre «Project Surround Setup» avec le bouton «Setup…»
dans le cadre Master. Sélectionnez alors le format voulu dans le menu déroulant
«Presets» (par ex. 5.1 ITU). Les sorties physiques du bus surround se déterminent
aussi dans cette fenêtre. Vous trouverez d’autres détails dans la section intitulée
«Project Surround Setup».

Dans la table de mixage du VIP, les canaux de bus du format surround sélectionné
sont maintenant alignés à côté des pistes audio (par ex. pour 5.1: ITU L, R, C,
LFE, Ls, Rs). Toutes les voies de mixage des pistes du VIP sont automatiquement
dirigées vers le master surround. Les voies de mixage peuvent être
individuellement dirigées vers le master surround ou vers le master stéréo. Voir
la section intitulée «Travailler simultanément aux formats stéréo et surround»
pour créer simultanément des mixages stéréo et surround.

Project Surround Setup (Configuration Surround de projet)
Réglage des sorties physiques des bus surround
La fenêtre «Project Surround Setup» s’ouvre en cliquant d’abord sur le bouton
«Setup» de la section master de la table de mixage puis sur le bouton «Setup…»
dans le cadre Master de la fenêtre « Project Mixer Setup » qui s’est ouverte.
Le format surround pour le mixage se règle en fenêtre «Project Surround Setup».
De nombreux presets sauvegardés peuvent être chargés et vos propres formats
peuvent être édités et sauvegardés. Les réglages de filtrage pour le canal des
effets de basse fréquence (LFE) se font aussi ici.
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Presets
Les formats surround qui ont déjà été créés peuvent être rappelés et les formats
nouvellement créés peuvent être sauvegardés ici. Le nombre de bus surround,
la description, l’ordre et les coordonnées de position des enceintes sont
sauvegardés dans un preset. Quand vous chargez un preset, ses réglages par
défaut sont chargés en correspondance avec les réglages du périphérique de
reproduction.
Exception: sauf si l’option «Audio device settings: save/load in preset» est cochée.
Voir ci-dessous.

Set Default for current preset (Déterminer les réglages par défaut du
preset actuel)
L’assignation actuelle des bus surround aux périphériques de reproduction est
sauvegardée comme une configuration du preset actuellement actif quand on
clique sur ce bouton. Cette configuration est alors toujours chargée quand le
preset est ouvert.

Get Default for preset (Obtenir les réglages par défaut du preset)
Cliquer sur ce bouton charge la configuration du périphérique de reproduction
par défaut appartenant au preset actuellement actif.

Audio device settings: Save/load in preset
Si cette option est cochée, la configuration actuelle du périphérique de
reproduction est sauvegardée indépendamment de la configuration par défaut.
Si cette option est cochée quand un preset est chargé, la configuration du
périphérique de reproduction est aussi chargée.

Channel configuration (Configuration des canaux)
Name (nom)
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Détermine le nom de chaque bus surround. L’abréviation utilisée dans la colonne
«Short» suivante est tirée de cette description. Les premières lettres ou lettres
majuscules suivantes des noms servent à l’abréviation.

Left = L
Left surround = Ls
LFE = LFE

Cette abréviation sert dans le module de panoramique surround et pour intituler
les voies correspondantes de la table de mixage. Durant le report de pistes
surround, l’abréviation est automatiquement ajoutée au nom des fichiers .WAV
qui doivent être créés.

Exemple: Le nom de fichier «Mastermix» est choisi pour le report de pistes d’un
mixage surround 5.1 en 6 fichiers mono. Les fichiers .WAV suivants sont
produits: «Mastermix_L.WAV»; «Mastermix_R.WAV»;... «Mastermix_LFE
.WAV».

Median / Frontal
Ces colonnes décrivent la position de l’enceinte correspondante par rapport aux
niveaux médian et frontal.

Position x / Position y
Décrivent la position précise de l’enceinte dans un système de coordonnées.
Cela peut être édité en saisissant manuellement les valeurs. Les réglages se
réfèrent exclusivement au positionnement d’enceinte en «mode de champ
sonore» (sound field mode) (voir la section intitulée « Modes panoramiques du
module de panoramique Surround »).

Audio device (périphérique audio)
Assignation d’une sortie physique de la carte son au bus surround correspondant.
Un réglage par défaut peut être sauvegardé avec chaque preset surround. Voir
«Set/get default for preset».

Lock channel positions in Surround pan dialog
Si cette case est cochée, la position des enceintes ne peut pas être changée à la
souris dans le module de panoramique Surround (voir la section intitulée «Modes
panoramiques du module de panoramique Surround»). Cette fonction est
initialement toujours activée et ne doit être désactivée que dans des cas spéciaux
(par ex. un positionnement variable des enceintes).

Boutons flèche basse/flèche haute
Si une ligne a été sélectionnée dans le tableau de configuration (correspondant
à un canal surround), cette ligne peut être montée ou descendue dans le tableau.
Cela permet un reclassement rapide des différents canaux.
L’ordre des canaux surround dans ce tableau détermine l’ordre d’affichage dans
la table de mixage, le module de panoramique Surround (par ex. les crête-mètres)
et la fenêtre d’effets Surround.
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LFE-Filter (Réglages de filtrage pour LFE)
Vous pouvez activer un filtre pour le canal LFE dans «Project Surround Setup».
Vous avez le choix entre par défaut un correcteur 4 bandes (4 band EQ) et un
correcteur FFT (FFT EQ). Ces filtres peuvent être édités en cliquant sur «Edit».

Cut-off frequency (Fréquence de coupure)
Détermine la fréquence de coupure du filtre coupe-haut.

High frequency reduction (Atténuation des hautes fréquences)
La pente du filtre au dessus de la fréquence de coupure est fixée à 12dB/octave
pour le correcteur 4 bandes.

Edit
Ouvre une fenêtre pour éditer les réglages de filtrage.

Note: Vous devrez généralement utilise le correcteur 4 bandes, le correcteur FFT
ayant une latence considérable.

Panoramique Surround
Maintenant que les réglages de base ont été faits, vous pouvez passer au véritable
mixage. Il y a deux méthodes pour mixer dans le master surround du matériel
audio affiché en fenêtre VIP.

Panoramique surround basé sur les pistes
Chaque piste audio du VIP peut être assignée à une position dans l’espace
surround via le module de panoramique surround de la voie correspondante de
la table de mixage. Tous les objets de cette piste sont dès lors positionnés à cet
endroit dans l’espace surround. Exception: le panoramique surround basé sur
les objets.

Panoramique surround basé sur les objets
Chaque objet peut être directement dirigé vers le master surround dans l’éditeur
d’objet. Ouvrez l’éditeur d’objet de cet objet et sélectionnez «SurMaster» comme
sortie («Output…») en section «Pan/Mute/Invert». Le module de panoramique
Surround correspondant s’ouvre, et vous pouvez régler le positionnement. Vous
pouvez corriger à tout moment les réglages de panoramique dans l’éditeur d’objet
(Object Editor > «Pan/Mute» Invert» > bouton «Surround send» > «Edit»). Vous
trouverez une description détaillée des possibilités du travail basé sur les objets
dans le chapitre intitulé «Travail basé sur les objets».
Choisir «Stereo» comme sortie avec «Output…» dirige l’objet vers la piste de
VIP et la voie de mixage correspondante, c’est-à-dire un panoramique surround
basé sur la piste (réglage de base). Choisir «SurMaster» entraîne un routage
direct de l’objet vers le bus surround bus, c’est-à-dire un panoramique surround
basé sur l’objet.
Le panoramique surround basé sur l’objet est identifié en affichage d’objet de
VIP par le suffixe «Sur» accolé au nom d’objet.
Cette méthode est idéale pour la conception sonore ou la post-synchronisation,
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particulièrement pour les effets. Vous pouvez faire un fondu entre les réglages
individuels d’objets avec les crossfaders.
Note: En panoramique surround basé sur l’objet, le signal audio ne passe pas
par la voie de table de mixage correspondant à la piste. Tous les réglages qui y
sont faits (départ AUX, correcteur, etc.) n’agissent donc pas sur cet objet.
Pour la plupart des applications, un objet devra être mixé vers le bus surround
via le panoramique surround à base de piste ou à base d’objet. Toutefois, en
pressant la touche Ctrl pendant que vous sélectionnez la sortie, vous pouvez
sélectionner en parallèle «Stereo» et «SurMaster».

Surround Panorama Module (Module de panoramique surround)
Le panoramique d’une piste ou d’un objet dans le bus surround se règle et
s’édite dans le module de panoramique surround.

Panoramique surround basé sur la piste
– Clic droit dans l’affichage de panoramique surround de la voie correspondante

de la table de mixage ou
– Clic droit sur le bouton ou fader pan de la piste correspondante dans le VIP

ou
– Ouvrez le menu contextuel de piste par clic droit dans le VIP et ouvrez «Pan/

Surround Editor» ou
– Sélectionnez la piste voulue dans le VIP puis choisissez « Pan/Surround Editor

» dans le menu «Track».
– Le format surround et la piste actuellement éditée sont affichés dans la barre

de titre de la fenêtre du module de panoramique surround. Exemple:
«Surround Panorama Module: 5_1 ITU - Track 4»

Panoramique surround basé sur l’objet
Ouvrez l’éditeur d’objet (Object Editor -> «Pan/Mute/Invert» -> «Surround Send
> «Edit»).
Le format surround et la piste actuellement éditée sont affichés dans la barre de
titre de la fenêtre du module de panoramique surround. Exemple: «Surround
Panorama Module: 5_1 ITU - Take 3«

Eléments affichés
Partant de la conception de piste stéréo de Samplitude, un indicateur de niveau
d’entrée à deux canaux se trouve à gauche. Les deux indicateurs affichent les
signaux d’entrée mono.
Les indicateurs de niveau des canaux master surround master se trouvent du
côté droit. Seuls sont affichés les niveaux du matériel actuellement édité dans le
module de panoramique surround.
Les canaux d’enceinte de l’installation surround sont affichés comme des pastilles
bleues dans la fenêtre principale de panoramique. Leur position dans le champ
panoramique surround dépend du mode sélectionné (voir la section intitulée
«Modes panoramiques du module de panoramique surround»). Les canaux
coupés sont représentés par une pastille grise. Une pastille rouge signale la
source sonore à positionner dans l’espace surround. Selon le réglage «Pan L/
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R», celle-ci peut être affichée comme deux pastilles.
Les informations supplémentaires suivantes peuvent être affichées en cochant
leur case sous la fenêtre principale de panoramique.

Name: Les enceintes sont décrites par les abréviations déterminées en fenêtre
«Project Surround Setup».

Volume: Les informations de niveau sont affichées pour chaque enceinte. Cela
affiche la valeur du signal commun envoyé à ce bus par la source sonore. Dans
les modes stéréo, la somme des niveaux des deux sources est toujours affichée.
Maintenir la touche Shift et cliquer sur une source permet de brièvement afficher
la valeur d’une seule des sources.

Sound field: La signification de cet affichage dépend du mode utilisé par le
module de panoramique surround (voir la section intitulée «Modes
panoramiques du module de panoramique surround»).

Réglages
Un grand avantage du module de panoramique surround est que différents
modes de panoramique peuvent être employés en fonction du résultat à obtenir.
Certains paramètres sont donc directement dépendants du mode de
panoramique et seront expliqués plus loin. Les valeurs numériques peuvent
être directement saisies dans la fenêtre, ou bien changées par des mouvements
verticaux du pointeur de la souris sur le champ de paramètre, ou encore avec la
molette de la souris.
Commençons par les réglages indépendants du mode de panoramique:

Channel (Canal): Coupe (Mute) ou change le volume des sorties de bus du
module de panoramique surround vers les bus surround. Les sorties de bus/
enceintes coupées sont affichées comme des pastilles grises dans le champ de
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panoramique.

LFE: Niveau du signal commun reproduit via le canal d’effets de basse fréquence
(LFE).

Only to LFE: La source n’est dirigée que vers le canal LFE si cette case est
cochée.

Center: Ce paramètre contrôle la part centrale de la distribution d’une source
sonore à destination des canaux avant. Dans certains environnements de travail
(par ex. une bande son de film), il est habituel de réserver le canal central et de
mixer la musique et les effets sonores sans aucune part au centre. Un signal
placé exactement au milieu est exclusivement reproduit par le canal central si le
format est 5.1 avec Center = 100%. A 0%, il n’est reproduit que comme une
source sonore fantôme par les canaux L (gauche) et R (droit). Ce paramètre est
souvent appelé «divergence».

Pan L/R: Les sources mono et stéréo peuvent être positionnées dans le module
de panoramique surround. Le paramètre «Pan L/R» détermine comment peuvent
être positionnés les signaux mono et stéréo. Une distinction doit être faite entre
les types de signaux. Pour plus d’informations, veuillez lire le chapitre intitulé
«Traitement des signaux stéréo et mono dans des projets surround».

Modes panoramiques du module de panoramique surround
Généralités
Le panoramique peut s’effectuer selon différents modes dans le module de
panoramique surround. Cela facilite l’édition de différents processus de
panoramique. Les sources sonores stationnaires peuvent être positionnées dans
l’espace surround et vous pouvez aussi concevoir les mouvements les plus divers
pour les sources sonores.

Note: Les différents modes panoramiques fonctionnent selon différents principes de
base. Changer de mode peut donc partiellement changer la position acoustique de la
source sonore. Exception: Des rapports de niveaux précis sont adoptés quand vous
passez en mode Matrix.

Le module de panoramique surround est redimensionnable. Dans certaines
circonstances, certains réglages peuvent être faits plus précisément si l’affichage
est à plus haute résolution.
Dans tous les modes (sauf Matrix), la source sonore (pastille rouge) est déplacée
sur la position voulue dans l’espace. Les coordonnées x et y peuvent aussi être
changées par saisie de leur valeur dans le champ numérique correspondant, en
déplaçant verticalement le pointeur de la souris ou en tournant la molette de la
souris sur le champ numérique actif.
Les mouvements de la source sonore peuvent être coordonnés et restreints en
maintenant enfoncées les touches suivantes tout en déplaçant le pointeur de la
souris:
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X + Mouvement de la souris: Les seuls changements de position possibles
sont parallèles à l’axe des x.
Résultat: mouvement L -> R

Y + Mouvement de la souris ou Z + Mouvement de la souris: Seuls sont
possibles les mouvements sur l’axe des y.
Résultat: Mouvement avant –> arrière

C + Mouvement de la souris: La distance entre la source sonore et la position
0 (x=0, y=0) reste la même Le résultat est un circuit circulaire.
Résultat: mouvement circulaire

A + Mouvement de la souris: La source sonore ne peut être déplacée qu’avec
un angle constant. Une ligne allant de la position initiale de la source sonore
jusqu’au point 0 du système de coordonnées détermine les mouvements.
Résultat: mouvement diagonal à angle constant.

Soundfield – Mode (Mode champ sonore)
En mode Soundfield (champ sonore), le signal entrant est affiché comme un
champ sonore concentrique. Chaque ligne rouge correspond à une chute de 3
dB du niveau de champ sonore. Les enceintes sont placées de façon à ce que la
distance entre une enceinte et la suivante reste constante. Ce positionnement
permet une distribution uniforme de la source sonore entre tous les canaux.
Des rapports de niveaux qui ne peuvent être obtenus dans les autres modes se
développent entre les canaux.

Exemple d’emploi: Localisation très précise, particulièrement pour les
mouvements.



229

Son Surround
Inconvénient: Conflits de niveaux, par ex. mouvements dans une direction
constante (le mode angle convient mieux à cela).

Width: Influence la largeur du champ sonore des enceintes.

Caractère du champ sonore (Pan Setup): Les caractéristiques de panoramique
d’un champ sonore peuvent être changées. «Inver. Logar.» donne une chute
rapide du champ sonore et donc un temps de fondu plus court d’une enceinte à
l’autre. «Logar.» donne une chute plus lente du champ sonore et donc un temps
de fondu plus long d’une enceinte à l’autre.

Panning law – Mode (Mode loi de panoramique)
Ce mode utilise un affichage d’espace surround tel que sur de nombreuses tables
de mixage numériques.

Les positions des enceintes sont par conséquent affichées aux limites extérieures
de l’espace disponible. En cochant l’option «Sound field», les niveaux distribués
dans les bus surround sont affichés graphiquement. La distribution de niveau
entre deux enceintes voisines suit la loi des –3dB, selon laquelle une source
sonore placée exactement au centre entre deux enceintes voisines est reproduite
à –3dB.
Exemple d’emploi: Panoramique bidimensionnel statique simple, localisation
sommaire simple.

Inconvénient: Pas de localisation précise, ne convient pas à un panoramique
dynamique (automation).

Pan Law: La valeur de –3dB peut être changée avec ce réglage.
Référez-vous à «Pan Setup» pour d’autres réglages.
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Angle – Mode (Mode angulaire)
Le champ sonore affiché s’étend radialement à partir du centre du cercle. La
source sonore est située sur l’axe central de ce champ sonore. Les enceintes
sont alignées sur un cercle. Les parts de niveau de la source sonore qui sont
dirigées vers les différents canaux sont déterminées par le rapport d’angle entre
la source sonore et l’enceinte ainsi que par l’angle d’ouverture du champ sonore.
Si l’angle de la source sonore et celui du canal correspondent (c’est-à-dire que
l’axe médian du champ sonore pointe directement sur l’enceinte: écart angulaire
= 0), le niveau de ce canal est le plus haut. Si l’écart angulaire augmente, le
niveau de ce canal décroît continuellement.
Exemple d’emploi: Bonne localisation de la direction des mouvements (par ex.
passage d’avion, etc.)
Inconvénient: Ne convient pas à un panoramique de distance.

Width (Breite): Détermine la taille de l’angle d’ouverture du champ sonore.

Caractère du champ sonore (Pan Setup): Les caractéristiques de panoramique
d’un champ sonore peuvent être changées. «Inver. Logar.» donne une plus
grande ouverture angulaire et donc un temps de fondu plus court d’une enceinte
à l’autre. «Logar.» donne un plus petit angle d’ouverture et donc un temps de
fondu plus long d’une enceinte à l’autre.

Const. Max. Sum. Output Level Mode: Si cette option est activée (case Active
cochée), le niveau master de toutes les sorties de canal du module de panoramique
surround ne dépasse pas la valeur saisie ici. Si ce réglage est activé en mode
Angle, les chutes de niveau dans le champ sonore sont évitées en cas de
mouvements en connexion avec de grands angles d’ouverture.
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Matrix – Mode (mode matrice)
Dans ce mode, le niveau du signal entrant qui est envoyé aux bus surround
individuels, peut être directement saisi. Il suffit  de saisir manuellement les
valeurs après double-clic sur les champs numériques.
Vous pouvez aussi faire glisser la souris sur les barres de niveau en gardant son
bouton gauche enfoncé. Un réglage fin est possible en tenant en plus la touche
shift enfoncée.
Exemple d’emploi: Tâches analytiques, par ex. pour router après un report de
pistes ou distribuer simultanément un signal à plusieurs canaux surround.
Distribution sur alignements tri-dimensionnels, par ex. configuration 2+2+2.
Inconvénient: Pas d’automation possible.

S’écartant des autres modes, le réglage «Pan L/R» signifie dans ce mode:

Pan L/R mono: Les niveaux des signaux entrants gauche et droit sont traités en
parallèle.

Pan L/R Stereo: Les niveaux des signaux entrants gauche et droit peuvent être
contrôlés individuellement.

Les autres réglages «Pan L/R» n’ont pas de fonction propre. Les sons ne sont
pas reflétés (effet miroir).

Pan Setup (configuration de panoramique)
La fenêtre des réglages de panoramique surround «Surround Pannings Settings»
vous permet d’apporter d’autres changements au module de panoramique
surround. Vous pouvez l’ouvrir en cliquant sur le bouton «Pan Setup» dans le
module de panoramique surround ou par clic droit sur la source sonore.
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Soundfield Offset (décalage du champ sonore): Le décalage réglé est pris
en compte pour les sources sonores qui sont directement positionnées et dirigées
vers un seul canal surround/enceinte. Par exemple, les signaux venant de
positions directement routées vers des canaux individuels et qui ressortent trop
peuvent être équilibrés.

Soundfield Character: (seulement en mode Soundfield ou Angle). Ce
paramètre est décrit dans la section sur les modes Soundfield et Angle.

Const. Max. Sum. Output Level Mode (Pan Setup): Si cette option est activée
(case Active cochée), le niveau master de toutes les sorties de canal du module
de panoramique surround ne dépasse pas la valeur saisie ici. Cette fonction est
particulièrement utile durant l’automation si la source doit être déplacée au
travers de la pièce. Cela permet d’équilibrer les fluctuations involontaires du
niveau master lors des changements de position.

Link all tracks (coupler toutes les pistes): Les changements des réglages
suivants dans le module de panoramique surround seront toujours transférés à
toutes les pistes du VIP: Soundfield Offset, caractéristiques de chute de niveau,
volume de sortie total constant, centre, loi de panoramique/largeur, niveau et
réglages de LFE, réglages de canaux tels que changements de niveau ou coupure
(mute).
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Copy settings to all tracks (copier les réglages dans toutes les pistes):
Les réglages faits dans ce module de panoramique surround (Soundfield Offset,
caractéristiques de chute de niveau, volume de sortie total constant, centre, loi
de panoramique/largeur, niveau et réglages de LFE, réglages de canaux tels que
changements de niveau ou coupure) sont copiés d’un coup dans toutes les autres
pistes.

Presets
Les réglages fréquemment employés peuvent être sauvegardés comme presets
dans le module de panoramique surround. Le mode et les réglages Pan L/R
peuvent aussi être sauvegardés en plus de la position de la source sonore.
Les presets sauvegardés peuvent être rechargés via le menu déroulant Preset.

Traitement des signaux stéréo et mono dans les projets
surround
Mono (réglage Pan L/R): Pour les signaux stéréo: une somme mono est créée
à partir des signaux gauche et droit. Celle-ci est placée comme une seule source
mono dans l’espace sonore.
Pour les signaux mono: Ce signal est placé comme une seule source mono dans
l’espace sonore.

X-Sym. (réglage Pan L/R): Pour les signaux stéréo: les canaux gauche et droit
sont alignés symétriquement sur l’axe des x. Cela permet par exemple le
panoramique avant gauche/surround gauche d’un signal stéréo.
Pour les signaux mono: une seconde source sonore (mono) symétrique (en
miroir) de ce signal est placée en plus de la source mono d’origine.
L’axe des x sert d’axe de symétrie.

Y-Sym: Pour les signaux stéréo: les canaux gauche et droit sont alignés
symétriquement sur l’axe des y. Cela permet par exemple le panoramique avant
gauche/droit d’un signal stéréo.
Pour les signaux mono: une seconde source sonore (mono) symétrique (en
miroir) de ce signal est placée en plus de la source mono d’origine. L’axe des y
sert d’axe de symétrie.

XY-Sym: Pour les signaux stéréo: les canaux gauche et droit sont alignés
symétriquement sur les axes des x et des y. Cela permet par exemple le
panoramique avant gauche/surround droit d’un signal stéréo.
Pour les signaux mono: une seconde source sonore (mono) symétrique (en
miroir) de ce signal est placée en plus de la source mono d’origine. Elle est le
symétrique de la source d’origine par rapport aux axes des x et des y.

Parallel: Pour les signaux stéréo: les canaux gauche et droit sont gardés à
distance constante l’un de l’autre et bougent parallèlement. La distance entre
les deux sources sonores peut être changée si la touche Ctrl est enfoncée.
Pour les signaux mono: La source sonore d’origine et sa symétrique sont gardées
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à distance constante l’une de l’autre et bougent parallèlement. La distance entre
les deux sources sonores peut être changée si la touche Ctrl est enfoncée.

Stereo Thru: Pour les signaux stéréo: selon la position de la source sonore, les
mêmes rapports de niveau sont reproduits sur les différents canaux. Toutefois,
seul le signal gauche est employé pour les canaux de gauche, comme seul l’est
le signal droit pour les canaux de droite et la part mono pour les canaux central
et LFE.
Pour les signaux mono: pas de fonction spéciale, identique au mode mono.

La somme des niveaux des deux sources est toujours affichée sous chaque
enceinte dans les modes miroir (si cet affichage est activé). Maintenir la touche
shift et cliquer sur une source peut brièvement afficher la valeur individuelle de
chaque source.

Report de pistes surround
Le report de pistes («trackbouncing») surround vous permet d’automatiquement
enregistrer des mixages sonores complexes dans un nouveau fichier .WAV. Les
sorties individuelles des bus surround servent de signal d’enregistrement.
La fenêtre «Trackbouncing» peut être ouverte depuis le menu «Tools» ou dans
la table de mixage en cliquant sur le bouton «Mixdown» du master.

Commencez par cliquer sur le bouton «Surround Trackbouncing». Vous pouvez
choisir d’enregistrer un fichier mono ou stéréo. Les autres réglages se font
comme en report de pistes normal.
Les abréviations réglées dans «Project Surround Setup» sont ajoutées au nom
des fichiers qui vont être enregistrés. Par exemple, si le fichier nommé
«Mastermix» est choisi pour un report de pistes d’un mixage surround 5.1 en 6
fichiers mono, les fichiers .WAV suivants sont produits: «Mastermix_L.WAV»;
«Mastermix_R.WAV»... «Mastermix_LFE .WAV» etc. Les combinaisons
suivantes sont créées pour une sortie en fichier stéréo: «Mastermix_LR.WAV»;
«Mastermix_LsRs .WAV»;... «Mastermix_CLFE .WAV».
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Call AC 3 Encoder: Ce bouton lance l’encodeur Digigram (plug-in optionnel)
pour l’AC3. Le report de pistes se fait alors directement dans ce programme.
Cette option n’est disponible que pour un projet en format 5.1 et à condition que
l’encodeur Digigram soit installé. Vous pouvez aussi intégrer d’autres encodeurs.
Dans ce cas, des transferts par fichier sont intéressants. Des encodeurs DTS,
Windows Media Pro, MPEG-4, et DSD (création de SACD) sont disponibles sur
le marché. Contactez votre spécialiste produit ou notre distributeur local pour
plus de détails.

Travailler simultanément aux formats stéréo et surround
Chaque voie de la table de mixage peut être dirigée soit vers le master surround,
soit vers le master stéréo. Le routage simultané vers les deux n’est pas possible.
Toutefois, vous pouvez utiliser les snapshots (configurations) de la table de
mixage pour plus ou moins permettre les mixages stéréo et surround en parallèle.
Par exemple, faites d’abord un mixage surround. Il peut être sauvegardé dans la
table de mixage comme snapshot. Tous les réglages de panoramique, filtres,
etc. sont sauvegardés.
Le preset Stereo Master est alors sélectionné dans la table de mixage. Toutes les
voies de la table sont dès lors dirigées vers le master stéréo. Si ce dernier est
abaissé dans la table de mixage, il est remonté quand on clique à nouveau sur le
bouton «Master». Tous les réglages nécessaires à la table de mixage stéréo
peuvent à nouveau être faits. Sauvegardez-les ensuite comme snapshot.
Vous pouvez maintenant alterner entre mixage stéréo et mixage surround en
passant d’un snapshot à l’autre.
Les deux mixages peuvent être sauvegardés comme de nouveaux fichiers .WAV
grâce à la fonction de report de pistes («Trackbouncing»). Le report de pistes
doit être fait séparément pour chaque mixage. Le snapshot correspondant de le
table de mixage (stéréo ou surround) devra d’abord avoir été ouvert.

Automation du module de panoramique surround
Les mouvements de panoramique pour les pistes réglées en surround peuvent
être automatisés. Pour cela, activez d’abord l’automation dans le module de
panoramique surround.

Presser le bouton pan de la piste correspondante en fenêtre de VIP permet
aussi cela. Si la source sonore est maintenant déplacée durant la lecture, ce
mouvement est enregistré et affiché comme une courbe dans le VIP. Cette courbe
peut ensuite être éditée dans le VIP à l’aide du mode de souris «Draw Panorama».

Dessin
Pour utiliser ce mode d’automation, vous devez d’abord effectuer déterminer
dans quelle sélection (Range) du VIP vous voulez faire le changement. Activez
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ensuite le mode de dessin (Draw) dans le module de panoramique surround.
Vous pouvez maintenant dessiner n’importe quel mouvement de la source
sonore dans l’espace surround. Cette séquence sera ensuite effectuée dans
l’intervalle de temps préalablement sélectionné la prochaine fois que le VIP
sera reproduit. Cette courbe peut ensuite être éditée dans le VIP à la souris en
mode d’édition de courbe.

Effets dans les projets surround
La différence entre projets stéréo et projets surround
Les mêmes effets (les mêmes algorithmes et la même interface utilisateur) sont
employés en son surround et en son stéréo.
Les effets ont pour cela été améliorés afin de pouvoir traiter jusqu’à 12 canaux
en parallèle et non plus seulement deux comme en stéréo.
L’utilisateur définit le nombre de canaux au moyen du groupage (voir ci-dessous
Mécanismes de groupage d’effets surround, groupe de contrôle surround).

Rappel d’effets surround
Les effets surround peuvent être employés dans les bus surround (dont le master
surround) et dans les bus AUX surround.
Les pistes stéréo de VIP et les objets de VIP peuvent ensuite être dirigés vers ces
bus.
Les effets surround sont rappelés comme des effets de piste normaux dans les
bus. La sélection est limitée à Dynamics, Multiband et Advanced Dynamics,
Room Simulator, FFT Filter, EQ et Delay. Les plug-ins ne peuvent pas être
employés.

Mécanismes de groupage d’effets surround, groupe de contrôle
surround
Groupage et dégroupage
Maintenez la touche «Ctrl» pendant que vous cliquez sur les canaux à grouper
ou à retirer d’un groupe.
Au lieu de presser «Ctrl», vous pouvez aussi utiliser le bouton «+ –» d’ajout/
retrait dans le groupe surround.

Groupage des canaux surround
Les canaux surround peuvent être regroupés en groupes d’effets surround.
Chaque groupe a sa propre interface utilisateur. Les paramètres s’appliquent à
tous les canaux du groupe de la même façon qu’ils s’appliquent aux deux canaux
en stéréo.

Une configuration typique de groupe surround 5.1 serait:
Groupe I: Avant gauche et droite (groupe de deux canaux)
Groupe 2: Arrière gauche et droite (groupe de deux canaux)
Groupe 3: Centre (groupe d’un canal)
Groupe 4: LFE (groupe d’un canal)
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Une configuration typique de groupe surround 7.1 serait:
Groupe I: Avant gauche et droite (groupe de deux canaux)
Groupe 2: Arrière gauche et droite (groupe de deux canaux)
Groupe 3: Centre, centre gauche & centre droite (groupe de trois canaux)
Groupe 4: LFE (groupe d’un canal)

Gestion des paramètres d’effets surround
Les paramètres des groupes actifs respectifs peuvent être édités comme en stéréo.
Les fonctions préprogrammées (preset) de l’interface utilisateur des effets
n’affectent que les canaux du groupe activé.
Il existe un mécanisme preset surround supplémentaire pour gérer tous les
paramètres, ce qui permet de capturer respectivement les réglages de tous les
groupes ou des canaux surround.

Bus de contrôle surround
Les boutons correspondants pour combiner les canaux surround dans les groupes
d’effets surround, pour activer les canaux surround ou les groupes d’effets
surround les faire passer en solo, et pour charger et sauvegarder les presets
d’effet surround se trouvent dans les éléments de contrôle surround.
Les boutons de contrôle d’effet surround apparaissent au dessus de la fenêtre
d’effet avec les effets compatibles surround si ceux-ci sont employés dans un
bus surround ou un bus AUX surround.

Edition des groupes
Avec la touche Ctrl enfoncée ou le bouton de groupage activé, les effets peuvent
être groupés ou dégroupés par clic sur les boutons de canal surround en haut à
gauche du champ de contrôle des effets surround.
Les paramètres des canaux sont supplantés si ces derniers sont ajoutés à des
groupes.
Les groupes sont affichés par la couleur des boutons de canal. Les canaux d’un
même groupe ont la même couleur.

Sélection des groupes pour l’édition
Cliquez sur un bouton de canal appartenant à un groupe pour «armer» un groupe
d’effets surround en vue de son édition (statut activé). Les boutons de canaux
surround appartenant au groupe actif sont alors surlignés en bleu.

Effets des groupes
– Les paramètres réglés dans la fenêtre des effets affectent tous les canaux du

groupe actif (comme ils affecteraient les deux canaux en mode stéréo).
– Si des presets sont chargés par le menu déroulant Preset, les paramètres

affectent tous les canaux surround du groupe actif dans la fenêtre mais pas
les canaux surround des autres groupes.

– Pour les effets dynamiques (dont le module Multiband Dynamics), les signaux
de contrôle sont produits par tous les canaux du groupe (comme ils seraient
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produits par les deux canaux en mode stéréo).

– Pour le simulateur d’espace (Room Simulator), un groupe peut avoir n’importe
quel nombre de canaux, sans rapport avec le nombre de bus surround, car
des réponses impulsionnelles mono ou stéréo sont employées comme en
stéréo. Vous trouverez des détails dans la section sur le simulateur d’espace
surround.

Mise en solo de groupes d’effets surround ou de canaux surround
La totalité du groupe est concernée par l’activation des boutons de solo.
Tous les canaux d’un groupe mis en solo peuvent alors être entendus.
La totalité du groupe n’est pas concernée quand la touche Ctrl est maintenue,
permettant que les canaux puissent aussi être mis individuellement en solo.
Les réglages de solo sont identiques à ceux des bus surround dans la table de
mixage – ils sont conservés après fermeture de la fenêtre d’effets surround.

Court-circuit (bypass) de groupes ou de canaux
Les groupes d’effets surround peuvent être individuellement court-circuités grâce
aux commutateurs Bypass des fenêtres d’effets. Il n’est pas prévu ici de possibilité
de bypass individuel pour les canaux d’un groupe.
Le commutateur Bypass du groupe de contrôle des effets surround affecte tous
les canaux et donc la totalité de l’effet surround.
Le Bypass est un paramètre de groupe. Il permet donc d’exclure individuellement
du traitement d’effet des canaux n’appartenant pas à un groupe. C’est judicieux
quand, par exemple, un filtre ne doit être employé que sur le canal LFE ou
quand le canal LFE doit être exclu de la simulation d’espace.
Le mode Bypass est indiqué par des points rouges dans les boutons de solo des
canaux.

Conseils pour gérer les paramètres d’effet surround: dans de nombreux cas, vous voudrez
régler certains paramètres sur les mêmes valeurs pour tous les canaux; par contre,
d’autres devront rester différents. Il est alors judicieux de grouper d’abord tous les
canaux pour faire les réglages communs ou charger un preset qui est alors transféré à
tous les canaux. Ensuite, d’autres groupages peuvent être faits si nécessaires.

Presets surround
Tous les canaux peuvent être sauvegardés et chargés à l’aide des presets du
groupe de contrôle surround en haut à droite. Le groupage est également
sauvegardé.

Conversion des presets surround lors de la conversion de formats
Si le preset qui est chargé a été sauvegardé sous une configuration sonore ayant
un plus grand nombre de canaux, les réglages son transférés aux canaux
disponibles.
A l’opposé, si la sauvegarde contient un nombre de canaux moindre, les canaux
excédentaires sont initialisés sur les valeurs par défaut.
Par exemple, vous pouvez employer un preset préparé en 7.1 pour travailler en
mode surround 5.1. Les valeurs des paramètres des deux canaux centraux
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supplémentaires en mode 7.1 ne sont alors pas utilisées; seuls sont chargés les
canaux communs.

Simulateur d’espace surround (Surround Room Simulator)
Informations générales
Le même concept que pour les autres effets surround s’applique au simulateur
d’espace surround.
Il permet de traiter jusqu’à 12 canaux en parallèle.
Comme avec un simulateur d’espace en mode stéréo, un exemplaire de l’effet
peut aussi utiliser des réponses impulsionnelles mono ou stéréo pour la stéréo.
Si de vraies réponses impulsionnelles doivent être employées (enregistrement
multicanal), plusieurs groupes doivent alors être créés.

Assignation de réponses impulsionnelles stéréo aux canaux d’entrée
Les convolutions sont calculées comme suit lors de l’emploi de réponses
impulsionnelles stéréo:
– Canal surround gauche avec réponse impulsionnelle gauche
– Canal surround droit avec réponse impulsionnelle droite
– Canaux central et LFE avec un signal mono calculé à l’aide de la réponse

impulsionnelle stéréo

Groupage et gestion des paramètres en emploi des réponses
impulsionnelles surround
Ce cas typique de surround 5.1 est expliqué dans ce qui suit (les réponses
impulsionnelles surround, par exemple, ont aussi 5 canaux).
Si la réponse impulsionnelle surround à 5 canaux est disponible sous la forme
de 5 ou 6 réponses impulsionnelles mono individuelles, aucun groupage ne
peut être appliqué. Chaque canal utilise son propre exemplaire de simulateur
d’espace pour les calculs. Les exemplaires utilisent des réponses impulsionnelles
mono individuelles.
Dans ce cas, les paramètres ne peuvent être changés que pour un canal. Si les
paramètres du simulateur d’espace doivent être réglés simultanément pour tous
les canaux, le groupage doit être effectué avant d’assigner les réponses
impulsionnelles individuelles. Ensuite les canaux peuvent être dégroupés à
nouveau avant de charger les réponses impulsionnelles.
Si les réponses impulsionnelles surround à 5 canaux sont disponibles sous la
forme de 2 réponses impulsionnelles stéréo pour l’avant et l’arrière et de deux
réponses impulsionnelles mono le LFE et le centre, deux groupes doivent être
créés pour les deux paires (avant et arrière).
L’assignation des canaux surround de gauche aux réponses impulsionnelles de
droite et vice versa s’effectue automatiquement. (Il n’y a pas d’allocation
automatique de la gauche au centre et de la droite au LFE). En pratique, le canal
LFE est réglé sur bypass, ou sa convolution est traitée avec réponse impulsionnelle
centrale.
Les réponses impulsionnelles surround fournies avec ce programme sont
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organisées comme suit: les paires LR sont disponibles au format stéréo; le centre
est au format mono.
Les réglages complets peuvent être sauvegardés et rechargés grâce aux presets
surround. Tous les réglages demeurent (paramètres, réponses impulsionnelles,
groupage, condition de bypass de groupe).
Si vous utilisez différentes configurations de canaux, il est recommandé de créer
des presets avec une configuration à plus grand nombre de canaux car ils seront
quand même exploitables dans des configurations à moins grand nombre de
canaux. (Par exemple, des presets 7.1 peuvent servir de presets 5.1 – les deux
canaux centraux supplémentaires en 7.1 ne sont simplement pas employés).

Astuce: L’illustration dans les démonstrations incluses montre comment fonctionne le
simulateur d’espace surround.

Simulation d’espace surround – Théorie et pratique
Simulation d’espace surround quand une source sonore est dans une pièce
Pour créer une reverb surround pour une source sonore en employant la
technologie de convolution, il vous faut une réponse impulsionnelle surround.
Celle-ci est faite des réponses impulsionnelles mono individuelles des canaux
surround (réponses impulsionnelles des canaux surround).
Une tonalité de référence est transmise depuis la position de la source dans la
pièce, et à l’emplacement de l’auditeur, différents réglages sont enregistrés sur
de multiples canaux dans différentes directions surround, ce qui a pour effet
d’enregistrer la réponse impulsionnelle surround.
Le signal mono sec doit être traité par convolution avec les réponses
impulsionnelles individuelles des canaux surround des réponses impulsionnelles
surround. Les résultats peuvent alors être dirigés vers les canaux surround.
Pour cela, le panoramique surround doit être réglé pour que tous les canaux
surround aient le même niveau de signal. Le simulateur d’espace peut être
employé dans le master surround ou un bus surround.

Simulation d’espace surround avec plusieurs sources sonores dans une pièce
En théorie, une nouvelle réponse impulsionnelle surround doit être enregistrée
pour chaque position de la source sonore dans la pièce. Si la reverb doit être
simulée, et donc produite quand deux sources sonores sont actives
simultanément dans la pièce, les convolutions surround doivent être calculées
en parallèle.
Pour calculer plusieurs convolutions surround en parallèle, les différentes pistes
audio peuvent être dirigées vers différents bus surround (cela peut aussi être
accompli grâce aux possibilités surround des objets – les objets pouvant alors
être dirigés vers différent bus surround). Les objets incluant le matériel source
doivent aussi être dupliqués.
Un simulateur surround peut alors être appliqué à chaque bus surround, qui
peut calculer une convolution surround en utilisant la réponse impulsionnelle
surround de la position correspondant à la source sonore dans la pièce.



241

Son Surround
Si chaque canal surround du mixage surround est considéré comme un son
d’une source dans la pièce (une hypothèse simplifiée où des sources sonores
fantômes peuvent se développer en différentes positions dans les pièces), les
convolutions surround à 5 canaux, c’est-à-dire 25 convolutions mono, devraient
être calculées simultanément pour le son surround 5.1 sans tenir compte des
canaux LFE. Les 25 canaux de sortie résultants devraient alors à nouveau être
combinés en cinq canaux surround.

La charge de calcul et de création des réponses impulsionnelles surround pour
les différentes positions émettrices dans la pièce serait très élevée pour une
simulation d’espace surround «mathématiquement correcte».
Il faut ajouter à cela le fait que des signaux totalement exempts de reverb doivent
être disponibles – un impératif difficilement réalisable.
En pratique, des résultats réalistes peuvent être obtenus à moindres frais si le
simulateur d’espace surround est utilisé comme une machine de reverb surround
typique.
Chaque canal surround est traité par convolution à l’aide de la réponse
impulsionnelle mono correspondante dans la réponse impulsionnelle surround.
Par conséquent, cinq convolutions suffisent en surround 5.1 si le canal LFE n’a
pas de reverb supplémentaire.
Cela s’emploi idéalement en AUX surround. Dans ce cas, vous pouvez ajouter
une reverb d’intensité différente sur chaque canal surround.

Conseils pour réduire la sollicitation du processeur par le
surround
– Tous les canaux ne nécessitent pas un traitement de la plus haute qualité.

Une «qualité normale» est quasiment toujours suffisante pour les canaux
arrière. Le paramètre peut être réglé individuellement pour chaque groupe.

– Dans de nombreux cas, le canal LFE peut être court-circuité (bypass)
– Le réglage de bypass reste sauvegardé

L’option «Calculate mono» (Calcul mono) peut être utilisée individuellement
pour les groupes.

Pour le son surround, tous les canaux du groupe sont ajoutés les uns aux autres
an un signal mono et la convolution n’est calculée qu’une fois. Ensuite, la reverb
mono est ajoutée à tous les canaux.
Dans les cas extrêmes, tous les canaux surround ont une convolution de reverb.
Cela nécessite que tous les canaux surround soient regroupés.
La réponse impulsionnelle est aussi convertie en un signal mono quand des
réponses impulsionnelles stéréo sont employées.

Edition d’automation de son surround
1ère possibilité: Enregistrement automatique en fenêtre de
panoramique surround
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Durant un processus d’enregistrement automatique, le signal source signal peut
être placé en toute position dans la pièce. Samplitude enregistre alors les
mouvements durant la lecture ou l’enregistrement et produit des événements
d’automation sur la courbe correspondante dans la piste de VIP. Vous pouvez
placer la position de départ de l’automation comme désiré avant la lecture.
Si vous voulez changer la position de départ du processus d’automation,
l’enregistrement doit démarrer avec la lecture du projet. Vous pouvez cliquer
dans la fenêtre de module de panoramique durant la lecture. La position du
signal source est alors automatiquement enregistrée et Samplitude enregistre
les mouvements ultérieurs. Le témoin d’enregistrement «REC» rouge s’allume
quand l’enregistrement est activé.

2nde possibilité: Mode dessin (Draw) en fenêtre de panoramique
surround
Avant de dessiner et de déplacer la position surround du signal source, il faut
d’abord effectuer une sélection (Range) dans la piste de VIP où doit se faire
l’automation. La case «Draw» doit être cochée sous Automation dans la fenêtre
de panoramique Surround. Vous pouvez alors déplacer le signal source sur une
nouvelle position dans la fenêtre de panoramique. Samplitude crée
automatiquement les événements de la courbe d’automation produisant ce
mouvement.

3ème possibilité: Dessin de courbes d’automation dans la piste de VIP
Samplitude vous permet de dessiner de nouvelles courbes d’automation de son
surround dans une piste de VIP ou d’en modifier des existantes. Assurez-vous
que le bouton Pan de la piste de VIP voulue est activé. La fonction «Automation
On» doit aussi être sélectionnée dans la fenêtre de panoramique surround. Le
mode de dessin de panoramique (Panorama Draw) doit alors être sélectionné
dans la barre de modes de souris. Vous pouvez vous en servir pour dessiner de
nouvelles courbes d’événements dans la piste de VIP. Placez le pointeur de la
souris près d’une courbe existante et cliquez sur le bouton gauche de la souris.
En le gardant pressé, vous pouvez dessiner (enregistrer) de nouveaux événements
pour cette courbe.

Mode surround 2 canaux
Le surround 2 canaux est une méthode pour véhiculer des informations d’espace
supplémentaires dans un signal stéréo normal. Aucun canal audio
supplémentaire n’est nécessaire. Le résultat est un format stéréo normal incluant
des informations surround supplémentaires («encodées»).
Avec un amplificateur compatible Dolby ProLogic (aussi nommé Dolby
Surround), les informations surround supplémentaires peuvent être décodées
et reproduites via 4-5 enceintes. En plus des enceintes stéréo, il y a une ou deux
autres enceintes surround (à l’arrière) et une enceinte centrale supplémentaires.

Le Dolby Surround ProLogic n’accepte qu’un canal arrière. Si vous avez deux enceintes
arrière, elles produisent le même signal.
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Le signal garde une compatibilité descendante vers la reproduction stéréo: il
peut être lu sur tout système non équipé du Dolby Surround.
D’un point de vue technique, le signal de sortie est un signal stéréo ordinaire.
Aucun dispositif de sortie supplémentaire ni par conséquent de bus surround/
master surround n’est nécessaire.
Samplitude peut gérer simultanément des pistes en surround 2 canaux et des
pistes normales. Les signaux gauche (L) et droit (R) de la piste normale sont
reproduits par les enceintes gauche et droite dans le mixage surround. Le centre
reçoit en plus un signal mono (R+L). Vous pouvez activer le surround à 2 canaux
pour chaque piste dans la fenêtre Track Information (paramètres de réglage de
piste).
Le module de panoramique surround peut être ouvert d’un clic droit sur le
contrôleur de panoramique dans la fenêtre de table de mixage ou par clic droit
sur le bouton PAN dans le VIP.
Une autre possibilité consiste à cliquer sur la case de contrôle surround dans la
table de mixage (visible seulement si le mode surround est activé).
Sélectionnez une position pour le signal de la piste dans l’espace surround.
Vous pouvez faire cela en déplaçant le signal d’origine (pastille rouge) à l’aide
de la souris ou d’un joystick.
Vous pouvez automatiser ces réglages et tous les changements. Passez en mode
Automation dans le module de panoramique surround et activez la courbe de
panoramique dans la piste de VIP.
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Samplitude peut directement graver des CD audio à la norme «Red Book».
Aucune autre application n’est nécessaire pour accomplir cette tâche. En fait,
Samplitude vous permettra même de graver vos CD ‘à la volée’; c’est-à-dire que
tout le traitement en temps réel est compilé pendant que s’effectue la gravure
du CD! Cela signifie qu’aucun espace supplémentaire n’est nécessaire sur le
disque dur pour créer un fichier .WAV composite en vue de la création du CD
ni pour convertir les réglages en temps réel dans un fichier .WAV.
Veuillez garder à l’esprit que la gravure en temps réel d’un CD nécessite un
certain niveau de ressources et de vitesse de système. Si votre système n’est pas
à la pointe et manque de vitesse, le processus de gravure de CD peut être
interrompu. Dans ce cas, vous pouvez devoir employer des méthodes
conventionnelles de report de pistes pour convertir votre projet en un simple
fichier .WAV stéréo en vue de la gravure d’un CD.

Que signifie ‘Red Book’?
Le terme ‘Red Book’ est le nom plus commun de la ‘norme pour Compact Disc
audio numérique’. C’est une norme utilisée par les usines de pressage pour
produire des CD audio numériques. Les lecteurs de CD du commerce lisent les
CD au format Red Book et les fichiers .WAV ou audio d’ordinateur doivent être
convertis à cette norme avant de pouvoir être exploités par un lecteur de CD.

Explication du processus
Jusqu’à quelques années en arrière, le mastering semblait être un mystère que
très peu pouvaient pénétrer. Toutefois, cela n’a plus rien d’extraordinaire, tant
la gravure de CD audio est devenu commune et les prix des graveurs de CD-R
toujours plus bas.
Le processus est d’un principe vraiment simple. L’audio contenu dans un CD
n’est rien d’autre que des informations numériques qu’une lecteur de CD du
commerce peut déchiffrer et transformer en ondes sonores analogiques audibles.
Avant de graver l’index des plages sur un CD, des informations sont
programmées dans le VIP. Ces informations sont inscrites dans une section
spéciale du CD audio qui indique au lecteur de CD où se trouve chaque morceau
sur le CD.
Samplitude peut directement graver le CD. Durant le processus l’audio des pistes
de VIP est réduit par mixage interne au format de fichier .WAV stéréo et transféré
à la gravure.
Durant la gravure, le laser du graveur de CD-R insère de petits sillons qui
constituent les informations numériques de l’ordinateur. Le lecteur de CD
interprète via son convertisseur numérique vers analogique intégré ces petits
sillons qui sont ainsi convertis en signal audio lors de la lecture.

Création d’un CD audio – Pas à pas
Enregistrez vos pistes audio dans Samplitude ou importez des fichiers .WAV
dans les pistes de VIP.
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Utilisez les capacités de mixage en temps réel du VIP et la table de mixage pour
faire le master de vos pistes audio. La façon dont cela sonne quand le VIP est
reproduit via une carte son stéréo est celle dont cela sonnera une fois le CD
gravé. Tous les réglages voulus devront être faits avant que ne commence la
gravure de CD.
Réglez les informations d’index de plages pour indiquer où commence chaque
morceau. Si le VIP est un seul projet à piste stéréo contenant chacun des
morceaux sous la forme d’objets séparés, vous pouvez utiliser le bouton ‘Auto
CD Track Indices’ de la barre d’outils pour placer des index de plages de CD au
début de chaque objet. Faites tous les réglages nécessaires quant à la position
des plages avant de graver le CD.
Gardez à l’esprit que Samplitude fait partie du très petit nombre d’applications
de gravure de CD vous permettant vraiment d’utiliser de l’audio continu, comme
un enregistrement ‘live’, pour graver un CD avec des informations individuelles
de plages. La plupart des autres applications vous forcent à ajouter 4 secondes
de silence entre les plages.
Gravez le CD en temps réel ou utilisez l’option en deux phases si votre système
n’est pas suffisamment rapide pour gérer le traitement en temps réel et/ou ce
nombre de pistes.

Etape 1
Pour créer un CD audio, il vous faut évidemment du matériel à mettre sur le
CD. Vous pouvez soit enregistrer de nouvelles pistes audio soit importer dans
le VIP des fichiers .WAV existants.
Pour des informations sur l’enregistrement de pistes audio, veuillez consulter
les chapitres traitant de l’enregistrement audio. Théoriquement, n’importe quel
nombre de pistes peut être utilisé pour graver le CD en temps réel. En réalité,
vous pouvez ressentir à certains moments que votre système ne peut plus fournir.
Même si votre système informatique semble interrompre la reproduction audio
pour un certain nombre de pistes, il y a cependant une bonne chance que la
création de CD se passe bien. Toutefois, c’est un avertissement et selon la quantité
de traitement en temps réel ajouté au VIP, la gravure de CD peut ne pas réussir.
En cas de doute, utilisez les possibilités de report de pistes de Samplitude pour
crée une piste stéréo composite. A partir de là, tout devrait bien fonctionner.
Utilisez la piste stéréo composite dans un nouveau VIP et placez les index de
plages.

Etape 2
Une fois les pistes audio enregistrées et tout assemblé, vous pouvez exploiter
les possibilités de mixage en temps réel de la fenêtre de table de mixage et les
courbes d’automation de VIP pour faire le ‘master’ de vos pistes audio.
Règle de base:
La façon dont l’audio est émis quand le VIP est reproduit correspond à la façon
dont il sonnera après gravure du CD audio. Cela signifie que c’est maintenant
qu’il faut résoudre les problèmes! En d’autres termes, c’est le dernier arrêt avant
que les pistes audio ne deviennent un CD audio et s’il y a des zones
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insatisfaisantes ou si vous n’aimez pas un mixage particulier, consacrez un temps
suffisant à la résolution des problèmes.
Utilisez les effets en temps réel de la table de mixage pour affiner tout signal
audio dans les pistes. Vous pouvez employer les réglages de correcteur, de
processeur dynamique et de delay pour améliorer certaines pistes.
Utilisez la section Master de la table de mixage pour améliorer le signal master
résultant de la réunion des pistes audio. C’est l’étape de traitement finale avant
que l’audio ne soit transféré à la carte son ou au processus de gravure de CD.
Par exemple, utilisez le Stereo Enhancer pour améliorer l’image stéréo de votre
signal master. C’est un moyen remarquable pour donne un certain ‘éclat’ à vos
pistes audio.

Si vos pistes audio nécessitent une automation de volume ou de panoramique,
dessinez les courbes d’automation dans les pistes de VIP. Une alternative consiste
à cocher le bouton Automation (‘A’) d’une voie et de créer la courbe d’automation
de volume ou de panoramique depuis la table de mixage. Quand vous déplacez
les faders dans la table de mixage pendant que l’audio est reproduit, Samplitude
crée la courbe d’automation dans la piste correspondante.

Etape 3
Les index de plages sont employés par les lecteurs de CD du commerce pour
identifier où se situe chacun des morceaux sur le CD audio.
Les index de plages se placent directement dans la fenêtre de VIP. Utilisez le
bouton ‘Set CD Track Index’ pour placer un index de plage sur la position actuelle
du curseur. En fait, les index de plage sont des marqueurs spéciaux utilisés par
le processus de gravure pour indiquer où commence un morceau.
Les index de plage peuvent être déplacés, comme les marqueurs. Pour plus
d’informations sur les marqueurs, veuillez vous référer aux chapitres
correspondants dans ce document.
Si vous devez affiner la position d’un index de plage, zoomez dans la fenêtre de
VIP pour travailler avec plus de précision.
Veuillez notez que la norme Red Book impose que les index de plage soient
séparés d’au moins 4 secondes les uns des autres. En pratique, ce ne sera
quasiment jamais un problème. Toutefois, cela peut être la cause d’un message
d’erreur affiché par Samplitude si pour une raison quelconque vous avez laissé
en fenêtre de VIP un index à moins de 4 secondes d’un autre index de plage.

Pour plus d’informations sur les index de plage et les diverses fenêtres de dialogue
relatives aux CD, veuillez vous référer aux chapitres de référence sur les menus.

Etape 4
Une fois les index de plage placés dans la fenêtre de VIP, il est temps de graver
le CD. Nous considérerons à ce moment que vous avez un graveur de CD-R
dans votre ordinateur (ou relié à lui) et un CD vierge à l’intérieur. Les étapes A
à C doivent être effectuées avant de graver le CD.
1. Cliquez sur le bouton ‘Make CD’ de la barre d’outils ou sélectionnez Make

CD dans le menu CD/DVD.
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2. Il y a deux options disponibles dans la fenêtre Make CD:
– Burn ‘On-The-Fly’ (gravure à la volée), qui calcule tous les effets en temps

réel et est non destructive.
– Generate a complete new file for the whole CD (création d’un nouveau fichier

pour la totalité du CD), qui est non destructive. Samplitude créera un fichier
image disque composite (un fichier .WAV) qui contient toutes les pistes audio
de la fenêtre de VIP réunies.

La plupart des ingénieurs du son utiliseront l’option 1 pour graver leurs CD.
C’est la plus pratique et la plus facile pour transformer vos pistes audio en CD
audio.
Quand vous cliquez sur le bouton OK, la gravure démarre, Samplitude
recherchant les graveurs de CD disponibles. Si vous en avez plusieurs, vous
devrez sélectionner celui voulu. Vous avez aussi des options pour commencer
par simuler la gravure avant de l’effectuer vraiment. C’est une option parfois
utile, particulièrement parce qu’une fois la gravure lancée, elle ne peut pas être
arrêtée. Si des performances insuffisantes du système ou une autre raison
entraîne l’interruption de la procédure, le CD ne sera plus bon qu’à servir de
dessous de verre!

Performances du système et création de CD audio
Quand vous employez les possibilités de gravure en temps réel de Samplitude,
les performances du système deviennent un point important. Une fois la gravure
commencée, elle ne peut pas être interrompue. Si elle est interrompue, le CD
n’est pas complet et par conséquent est inutilisable. Des interruptions peuvent
se produire si votre système ne peut pas supporter la charge de lecture des
pistes audio et graver le CD audio en temps réel.
Le témoin d’utilisation du processeur est un bon indicateur pour savoir si
Samplitude pourra graver le CD sans problèmes. Ci-dessous se trouve une liste
des performances envisageables. Nous devons insister sur le fait que les résultats
individuels peuvent varier selon la configuration du système et la rapidité de ses
composants.

Témoin d’utilisation du processeur et vitesse de gravure du CD:
– Près de 100%: Gravure 1 X
– Jusqu’à 50%: Gravure 2 X
– Jusqu’à 25%: Gravure 4 X

Il est suggéré de simuler la gravure du CD tant que vous n’avez pas confiance
dans la capacité de votre système à fonctionner à la vitesse de gravure
sélectionnée. Vous pouvez aussi avoir à réduire le nombre de pistes et/ou de
traitements en temps réel par reports de pistes dans votre VIP.
Un dernier effort peut être accompli en transformant le processus de gravure
de CD en deux phases. Cela crée d’abord une image disque composite de CD,
c’est-à-dire un fichier .WAV stéréo basique. Tout système devrait ensuite pouvoir
graver en temps réel avec succès ce VIP à simple piste stéréo.
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Gravure d’un DVD audio
Introduction
Samplitude peut graver des DVD audio à l’aide de n’importe quel type de graveur
de DVD. Vous pouvez graver les formats de disque suivants: +R/-R/+RW/-RW.
Les DVD audio ne peuvent être lus que sur des lecteurs compatibles DVD audio!
Ceux-ci se reconnaissent à leur logo DVD-Audio.
Le lecteur nécessite jusqu’à six sorties analogiques individuelles pour la
reproduction multicanal.
Samplitude grave actuellement des DVD sans menu graphique, mais incluant
simplement des marqueurs de plage, qui peuvent être contrôlés comme un CD
audio. Toutefois, pour créer des DVD audio/vidéo avec menus, vidéos et
diaporama, le programme de montage vidéo et de création de DVD «MAGIX
video deluxe pro» sera bientôt disponible et pourra être intégré à Samplitude.

Vous pouvez sauvegarder de l’audio en 16 et 24 bits sur un DVD audio; des
fréquences d’échantillonnage de 44,1 et 48kHz ainsi que leur double et leur
quadruple sont possibles. Jusqu’à 6 canaux audio sont acceptés en surround 5.1
ainsi que d’autres configurations (stéréo, 4.0, etc).
La seule limitation est qu’il ne faut pas dépasser le débit de transmission
maximum garanti d’environ 10Mbits/s pour les lecteurs de salon. Par
conséquent, la fréquence d’échantillonnage de 48kHz est un maximum pour le
son surround 5.1. La limite des 10Mbits/s serait dépassée en 96 kHz.
Par exemple, les durées de lecture suivantes correspondent à la capacité de
stockage d’un DVD-R simple couche (à une fréquence d’échantillonnage de
44,1kHz):
Stéréo 16 bits: environ 7 h
Stéréo 24 bits: environ 4,5 h
Surround 5.1 et 24 bits: environ 1,5 h

Création d’un DVD audio
Dans le VIP, les marqueurs (index) de plage sont placés comme pour un CD.
Un CD audio et un DVD audio peuvent donc être tour à tour gravés à partir du
même projet.
Lancez la création d’un DVD audio via le bouton « Create DVD-Audio» dans la
barre d’outils pour CD.
La fenêtre «Trackbouncing» s’ouvre. Vous pouvez choisir entre 16 bits et 24
bits pour l’audio. Le réglage initial est 24 bits. La case «Create DVD-Audio» doit
être cochée.
Un programme externe de gravure de DVD audio s’ouvre. Son chemin d’accès
(Path) est prédéfini mais peut être changé si nécessaire.
Sinon, vous pouvez aussi ouvrir ici «Video deluxe pro» qui permet la création
perfectionnée de DVD (avec menus).
«OK» lance le processus de report. L’application de gravure de DVD audio est
lancée et les fichiers sont automatiquement transmis.
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Note: Un espace de stockage double de celui d’un DVD est nécessaire sur le disque
dur, car le VIP est d’abord reporté puis l’image du DVD est créée à partir des données
audio complètes, et est ensuite gravée.

La liste des plages est affichée dans l’outil DVD audio. D’autres plages peuvent
être ajoutées manuellement, et le format surround peut être changé (stéréo,
4.0, 5.0, 5.1).
Le bouton «Burn» ouvre la fenêtre de gravure où le graveur et la vitesse de
gravure peuvent être sélectionnés.
L’image du DVD est d’abord créée après avoir pressé le bouton «Start». Le
processus de gravure suit.
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Note: Vous pouvez créer, changer et supprimer des raccourcis clavier avec menu
«Options» -> «Program Preferences -> Edit Keyboard Shortcuts and Menu…». Cliquez
sur le bouton «Show Shortcut list» pour afficher une liste de tous les raccourcis définis
dans les menus. Les raccourcis entre crochets (<>) ne peuvent pas être changés.
Ce sont:
– Space (barre d’espace) pour lecture/arrêt
– Escape (Ech) pour sortir des fenêtres de dialogue /annuler des opérations
– Z pour temporairement faire passer la souris en mode Zoom
– K pour temporairement passer au mode d’objet «Link one track»

Menu «File»
New Virtual Project (VIP)… E

Open Project
Virtual Project (*.vip)... O
MIDI (*.MID)... Shift+M
HD Wave (*.hdp)... Shift+L

Load audio file W
Save Ctrl+S
Save as… Shift+S
Import audio… Ctrl+I
Export audio
.WAV... Ctrl+E

Menu «Edit»
Undo Ctrl+Z
Redo Ctrl+Y
Cut Shift+Del / X / Ctrl+X
Delete Delete
Copy C / Ctrl+C / Ctrl+Insert
Paste / Insert clip V / Shift+Insert

More
Delete with time/ripple Ctrl+Delete
Clear Alt+Delete
Cut with time/ripple Ctrl+Alt+X
Copy + clear Ctrl+Alt+C
Copy as… Shift+C
Paste with time/ripple Ctrl+Alt+V
Overwrite with clip Alt+V / Insert
Volume curve active Alt+K
Pan curve active Alt+P
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Crossfade Editor Ctrl+F

Menu «View»

Sections
1 Shift+B
Activate next section Page down
Activate previous section Page up
Show grid ^
Snap active Ctrl+^
Snap/Grid settings Ctrl+Shift+^, I
VIP Display Mode Definition Shift+Tab
Switch modes 1/2 Tab

Store position and zoom level
1 Ctrl+NumPad 1
2 Ctrl+NumPad 2
3 Ctrl+NumPad 3

Store zoom level
1 Ctrl+NumPad 4
2 Ctrl+NumPad 5
3 Ctrl+NumPad 6

Get position and zoom level
1 NumPad 1
2 NumPad 2
3 NumPad 3

Get zoom level
1 NumPad 4
2 NumPad 5
3 NumPad 6

Horizontal
Half section left Ctrl+Alt+Cursor left
Half section right Ctrl+Alt+Cursor right
Section to play cursor Ctrl+Alt+ „,«
Zoom in Cursor up, Ctrl+ Cursor left
Zoom out Cursor down, Ctrl+ Cursor right
Show all Ctrl+Alt+Cursor up
Zoom to Range Ctrl+Alt+Cursor down

Vertical
Half section up Shift+Cursor up
Half section down Shift+Cursor down
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Zoom In Wave Ctrl+Cursor up
Zoom Out Wave Ctrl+Cursor down

Menu «Track»

Track properties
Mute Alt+M
Mute / Inactive Ctrl+Alt+M
Solo Alt+S
Solo-exclusive Ctrl+Alt+S
Record Alt+R
Force Monitoring Ctrl+Alt+Shift+F
Lock Alt+L
Volume curve active Alt+K
Pan curve active Alt+P
Edit Volume Ctrl+Shift+K
Edit Pan Ctrl+Shift+P

Menu «Object»

Cut Objects
Duplicate Objects Ctrl+D
Trim with alternative crossfade Shift+T
Split Objects T
Trim Objects Ctrl+T
Heal/Unsplit Objects Ctrl+Alt+T
Glue Objects Ctrl+Alt+G

Move/Edit Objects/Crossfades
Object Move Step 1
Move (left) Object left Ctrl+1
Move (right) Object left Alt+1
Move (left) Object right Ctrl+2
Move (right) Object right Alt+2
Move Object(s) left Ctrl+Alt+1
Move Object(s) right Ctrl+Alt+2
Move start Object(s) left Ctrl+3
Move start Object(s) right Ctrl+4
Move end Object(s) left Alt+3
Move end Object(s) right Alt+4
Move crossfade left Ctrl+Alt+3
Move crossfade right Ctrl+Alt+4
Move Object start offset left Ctrl+5
Move Object(s) start offset right Ctrl+6
Move Object end offset left Alt+5
Move Object end offset right Alt+6
Increase left volume Ctrl+8
Decrease left volume Ctrl+7
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Increase right volume Alt+8
Decrease right volume Alt+7
Increase volume Ctrl+Alt+8
Decrease volume Ctrl+Alt+7
Move (left) Object content left Ctrl+9
Move (left) Object content right Ctrl+0
Move (right) Object content left Alt+9
Move (right) Object content right Alt+0
Move Object(s) content left Ctrl+Alt+9
Move Object(s) content right Ctrl+Alt+0

Object Move Step 2
Move (left) Object left Ctrl+Shift+1
Move (right) Object left Alt+Shift+1
Move (left) Object right Ctrl+Shift+2
Move (right) Object right Alt+Shift+2
Move Object(s) left Ctrl+Alt+Shift+1
Move Object(s) right Ctrl+Alt+Shift+2
Move start Object(s) left Ctrl+Shift+3
Move start Object(s) right Ctrl+Shift+4
Move end Object(s) left Alt+Shift+3
Move end Object(s) right Alt+Shift+4
Move crossfade left Ctrl+Alt+Shift+3
Move crossfade right Ctrl+Alt+Shift+4
Move Object Start Offset left Ctrl+Shift+5
Move Object(s) Start Offset right Ctrl+Shift+6
Move Object End Offset left Alt+Shift+5
Move Object End Offset right Alt+Shift+6
Increase left volume Ctrl+Shift+8
Decrease left volume Ctrl+Shift+7
Increase right volume Alt+Shift+8
Decrease right volume Alt+Shift+7
Increase volume Ctrl+Alt+Shift+8
Decrease volume Ctrl+Alt+Shift+7
Move (left) Object content left Ctrl+Shift+9
Move (left) Object content right Ctrl+Shift+0
Move (right) Object content left Alt+Shift+9
Move (right) Object content right Alt+Shift+0
Move Object(s) content left Ctrl+Alt+Shift+9
Move Object(s) content right Ctrl+Alt+Shift+0

Object to play cursor position Ctrl+Alt+P
Object to original time position Ctrl+Alt+O
Arrange Objects… Ctrl+Alt+Shift+A
Mute Objects Ctrl+M
Build Loop Object Ctrl+L
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Select Objects
Selects all Objects Ctrl+A
Deselect all Objects Ctrl+Shift+A
Select next Object > / Ctrl+Alt+W
Select previous Object < / Ctrl+Alt+Q
Object Lasso Ctrl+Alt+L

Group Objects Ctrl+G
Ungroup Objects Ctrl+U
Object name Ctrl+N
Object Editor Ctrl+O
Object Manager Ctrl+Shift+O
Take Manager Ctrl+Alt+Shift+T

Menu «Real-time Effects»
Elastic Audio Ctrl+Shift+E

Menu «Offline Effects»
Normalize Shift+N
Normalize (Quick Access) N

Menu «Range»
Range all A

Move play cursor
To beginning Home
To end End
Left move in page mode Cursor left
Left move in scroll mode Alt+Cursor left
Right move in page mode Cursor right
Right move in scroll mode Alt+Cursor right
Object border left Ctrl+Q
Object border right Ctrl+W
Marker left F 2 / Alt+Q
Marker right F 3 / Alt + W

Edit Range
Move Range start left Alt+ NumPad «/«
Move Range start right Alt+ NumPad «*«
Move Range end left Shift+Cursor left / Alt+ NumPad «-«
Move Range end right Alt+ NumPad «+« / Shift+Cursor
right
Flip Range left Ctrl+Shift+Left cursor
Flip Range right Ctrl+Shift+Right cursor
Beginning of Range -> 0 Ctrl+Page up
Beginning of Range <- 0 Shift+Page up
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End of Range -> 0 Ctrl+Page down
End of Range <- 0 Shift+Page down
Range start to left marker Shift+F 2
Range end to right marker Shift+F 3
Split Range B
Store Range Alt+F 2-F10

(sauf: Alt+F4 et F9)
Other… Alt+F 11
Get Range Ctrl+F 2-F10
Get Range length Ctrl+Shift+F 2-F10
Store markers Shift+0-9
Marker with name ?
Marker with auto number Shift+^
Marker on record position Alt+?
Get markers 1 - 9, 0
Recall last Range Shift+Back
Field 1 Alt+NumPad 1
Field 2 Alt+NumPad 2
Field 3 Alt+NumPad 3
Field 4 Alt+NumPad 4
Field 5 Alt+NumPad 5

Menu «CD/DVD»
Set track Ctrl+Alt+I
Remove all indices Ctrl+Alt+Shift+I
CD Track/Index Manager Ctrl+Alt+Shift+D

Menu «Tools»

Manager
File Browser Ctrl+Shift+B
Object Manager Ctrl+Shift+O
Track Manager Ctrl+Shift+S
Marker Manager Ctrl+Alt+Shft+M
Range Manager Ctrl+Alt+Shift+B
Take Manager Ctrl+Alt+Shift+T

Menu «Play/Rec»
Play Once Space
Play Loop Space
Play with preload Shift+Space
Play in Range/Loop Shift+P
Play only selected Objects Ctrl+Space

Play cut
Play to cut start F 5
Play from cut start F 6



256

Raccourcis clavier standards
Play to cut end F 7
Play from cut end F 8
Play over cut F 4
Play upper audio material Alt+Shift+Space
Play lower audio material Ctrl+Alt+Space
Stop and go to
Current position NumPad
Playback options P

Playback mode
Autoscroll Scroll
Autoscroll Soft Shift+Scroll
Scrubbing active Alt+Shift+Cursor down
Scrub left Alt+Shift+Cursor left
Scrub right Alt+Shift+Cursor right
Record R
Record options… Shift+R
Input monitoring Alt+Shift+M

Menu «MIDI»
Object Editor Ctrl+O
Glue MIDI Objects Ctrl+Alt+G
Track information Alt+I
MIDI Controllers Ctrl+Alt+A

Menu «Options»

Project properties
Mixer setup… Ctrl+Shift+M
Playback options P
Project status Shift+I
Project options Ctrl+Shift+^ / I
Track Information... Alt+I
Synchronization active G
Synchronization setup Shift+G
Program preferences
Draw setup Shift+Tab
System/Audio Y

Menu «Window»
Tile Return
Untile Shift+Return
Mixer M
Time display Ctrl+Shift+Z
Visualization Ctrl+Alt+Shift+V
Transport Control Ctrl+Shift+T
Close all windows Ctrl+H
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Menu «Help»
Help F1
Context help Shift+F 1

Souris

Clic médian Lecture/arrêt
Molette Défilement horizontal
Shift+Molette Les commandes rotatives/faders actifs
peuvent être réglés finement

+ Ctrl Zoom horizontal
+ Shift: Zoom vertical

(Agrandit / réduit la forme d’onde)
+ Ctrl+Shift Défilement vertical dans le VIP (pistes)
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Reproduction
Durant la reproduction, tous les fichiers sont lus depuis le disque dur; ils passent
au travers d’un buffer (mémoire tampon) Trackspeed et enfin des sections d’effet.
Cela assure non seulement l’allocation des effets, mais aussi le réglage du volume
et du panoramique ainsi que l’assignation des bus et des sorties. Les signaux
sont traités par paquets correspondant à la taille du buffer de VIP et sont
finalement reproduits par la carte son via le buffer ASIO (ASIO seulement).

Enregistrement
Durant l’enregistrement, le signal est dirigé au travers du buffer ASIO (ASIO
seulement) puis enregistré sur le disque dur. L’enregistrement dans Samplitude
est conçu de façon à ne pas être réellement un processus en temps réel. Les
buffers d’entrée venant de la carte sont collectés dans le buffer et transférés au
système de fichiers sous forme de blocs plus grands à sauvegarder sur le disque
dur. Les latences ne sont donc pas importantes et la procédure est
particulièrement sure.
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Trajet du signal avec monitoring (écoute de contrôle)
Pour tous les autres modèles, il peut être dit que trois trajets de signal se font
simultanément. La lecture des pistes enregistrées comme en fig. 1,
l’enregistrement des pistes comme en fig. 2, et le monitoring (écoute de contrôle)
des signaux de l’entrée comme décrit ci-après.  Samplitude est conçu pour se
comporter comme la tête de synchro d’un magnétophone analogique à bande.
Les réalignements des signaux individuels sont automatiquement équilibrés.
Durant la lecture, le signal est avancé de la latence des effets et du buffer, de
façon à ce qu’il soit synchrone avec les signaux entrants et qu’aucun décalage ne
se crée en rapport avec les signaux d’enregistrement et de monitoring.

Monitoring matériel
Il est souvent nécessaire d’envoyer immédiatement à une sortie un signal entrant
à enregistrer, pour qu’il serve de signal de monitoring. Dans la plupart des cas,
cela se fait simultanément à la lecture d’un projet. Dans ce cas, le réalignement
entre monitoring et lecture est effectué avec une différence de temps (latence)
aussi petite que possible. Quand vous utilisez des cartes acceptant le monitoring
matériel, vous pouvez obtenir des latences de quelques échantillons seulement
et donc quasiment nulles. Le signal entrant est alors dirigé directement vers la
sortie de la carte son sans passer par un processeur de signal dans l’ordinateur.
Par exemple, les signaux de lecture et de monitoring sont mixés dans la carte
son si les deux pistes ont le même réglage de sortie.

Le monitoring matériel se règle essentiellement directement dans la carte son.
Toutefois, il est intéressant de pouvoir passer du monitoring et de la lecture de
matériel audio existant au monitoring des signaux entrants (tape monitoring).
Le programme a par conséquent deux possibilités d’accès à la carte son:

1. ZLM (MME/WDM seulement): permet de basculer les canaux entre lecture
et monitoring d’entrée (si la carte le permet).
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2. ASIO Direct Monitoring (ASIO seulement): permet de basculer les canaux
entre lecture et monitoring d’entrée (si la carte le permet). Le monitoring direct
ASIO vous permet aussi de contrôler la balance de volume et de panoramique.
Cela assure également que les niveaux réglés soient déjà pris en compte durant
l’enregistrement.

Trajet de signal avec monitoring logiciel
Comme le monitoring matériel, le monitoring dirige un signal entrant vers la
sortie en fonction des réglages de piste; toutefois, le signal passe au travers du
PC et de la latence se manifeste durant la lecture (double buffer ASIO). Le
monitoring logiciel n’est possible qu’avec l’ASIO. Il sert aussi au jeu «live»
d’instruments virtuels.

Trajet de signal avec monitoring d’effet virtuel
Le monitoring d’effet permet aux effets d’être mixés dans la piste audio. Cela
vous permet aussi d’employer Samplitude comme un processeur d’effet «live»
pour des sources externes. Le signal de monitoring est toutefois retardé d’une
(double) latence ASIO et de la latence des effets ou plug-ins utilisés. Les effets
d’AUX/BUS ainsi que les effets master ne sont pas pris en compte dans le trajet
de monitoring.

.
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Automation
Le but de l’automation est de modifier dans le temps certains paramètres (dans
Samplitude, cela peut être les paramètres de panoramique, surround et niveau,
les contrôleurs MIDI ou les paramètres de VST). Les changements sont
représentés au moyen d’une courbe d’automation.
Il existe un mode de souris spécial pour éditer les courbes d’automation. Voir
les «Fonctions de la souris».

Barre de grille/marqueurs
La barre de grille/marqueurs est située au dessus de la première piste visible.
Elle est divisée en deux moitiés.

Bouton clé et bouton cadenas
Pour régler individuellement les objets ou tous les objets d’une piste.
Activer une clé de verrouillage permet de verrouiller:
– des objets individuellement
– tous les objets d’une piste

D’autres paramètres de verrouillage d’objets dépendant des réglages «Lock Objets
-> Lock Definitions…» dans le menu Object.

Bulles d’informations sur les outils
Les bulles d’informations du programme sont d’une grande aide. Amenez le
pointeur de la souris au dessus de l’élément dont vous aimeriez connaître la
fonction et un court texte apparaît avec le nom ou la description de l’élément.
Les raccourcis-clavier et des astuces d’emploi s’affichent aussi.

Bus AUX
Un bus AUX (auxiliaire) est une voie disposant de toutes les possibilités d’une
voie normale. Cela signifie qu’elle peut comprendre des effets de piste et que
son panoramique et son niveau peuvent être automatisés. Elle a une entrée et
une sortie. La différence la plus importante est que vous pouvez dériver vers ce
bus le signal audio de toute voie ayant un numéro inférieur à celui du bus AUX.
Cela se fait avec les faders de départ AUX de la table de mixage.
Les bus AUX servent généralement à des effets comme la reverb ou l’écho, qui
peuvent être utiles à plusieurs pistes, mais à des degrés différents. Dans
Samplitude, les objets peuvent aussi être dirigés vers des bus AUX.

Bus de prémixage (Submix)
Un bus submix est une voie disposant de toutes les possibilités d’une voie
normale. Cela signifie qu’elle peut comprendre des effets de piste et que son
panoramique et son niveau peuvent être automatisés. Elle a une entrée et une
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sortie. La différence la plus important est que vous pouvez envoyer à ce bus le
signal de sortie de toute voie ayant un numéro inférieur à celui du bus submix
(plutôt que de l’envoyer au bus master ou à un périphérique de sortie).

Bus Surround
Un bus surround est nécessaire si des effets surround doivent être appliqués.
Les pistes devant inclure des effets surround doivent donc être dirigées vers un
bus surround où les paramètres appropriés peuvent être réglés.
Toutes les pistes dirigées vers un bus surround disposent du module de
panoramique surround à la place du fader de panoramique normal de piste. Si
un bus surround est disponible, le signal de sortie de chaque objet peut
individuellement être dirigé vers ce bus et placé dans l’espace surround
indépendamment des réglages de panoramique pour la piste.
Chaque bus surround ne peut être dirigé que vers un autre bus surround de
numéro supérieur ou vers le master surround. De plus, un bus surround peut
utiliser un bus AUX surround pour le départ d’effets.
D’un point de vue technique, le master surround est aussi un de ces bus surround
de projet surround avec comme caractéristiques supplémentaires que les canaux
surround puissent être assignés aux périphériques audio mais qu’il ne puisse
pas être redirigé vers un bus surround.

Champ temporel
Tous les champs qui représentent une position temporelle peuvent servir à la
saisie par double-clic avec la souris. Les unités de temps peuvent être changées
en cliquant sur la partie droite du champ.

Courbe d’automation
Affiche les changements de valeur de certains paramètres ou contrôleurs MIDI
d’une piste.

Curseur (tête) de lecture
Le curseur de lecture ou ligne de position est la ligne verticale (mobile durant la
lecture) qui représente la position actuelle de lecture.
La position de départ du curseur de lecture (début de la lecture) se règle en
cliquant avec le bouton gauche de la souris dans la barre de grille ou de
marqueurs. Cela annule toute sélection antérieure.
Vous pouvez retrouver la sélection antérieure en double-cliquant sur la barre de
grille dans la plage grisée.

Editeur d’objet (Object Editor)
L’éditeur d’objet vous permet de précisément éditer les propriétés de chaque
objet audio (plus précisément qu’à la souris). Par exemple, vous pouvez saisir la
longueur d’un objet sous forme de valeur numérique ou régler les caractéristiques
d’un fondu.
Plus encore, vous pouvez aussi éditer les réglages d’effets en temps réel, de
correcteur et de dynamique de l’objet sans avoir à recourir aux effets de piste
dans la table de mixage. Le mode d’édition sélectionné est  indépendant des
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changements concernant la position de l’objet (par ex. déplacement/copie dans
une autre piste). De plus, vous pouvez employer des effets de façon très précise
en ne les appliquant que quand ils sont nécessaires.

Veuillez vous référer à l’introduction détaillée sur le traitement audio orienté objet
dans la section sur les bases.

Edition d’onde
L’édition d’onde vous permet de tirer avantage de l’édition directe du matériel
audio.
Vous trouverez plus d’informations dans le chapitre «Edition d’onde».

Edition destructive
Dans ce mode, les projets Wave sont directement édités sur le disque. Cela
signifie que les changements apportés au matériel audio sont disponibles dans
un fichier audio de la même façon que s’ils apparaissaient visuellement et
acoustiquement dans la fenêtre de projet. Le fichier produit ne nécessite pas de
stockage séparé puisque toute l’édition se fait directement dans les fichiers audio
sur le disque dur. Bien sûr, il existe des possibilités d’annulation («Undo» doit
être activé pour les projets Wave), mais elles ne sont accessibles que tant que le
fichier reste ouvert. Ensuite, les changements sont permanents.

En-tête de piste
Le panneau d’en-tête de piste est la section gauche d’une piste de VIP. Il contient
diverses fonctions incluant des éléments de mixage, des boutons pour charger
des plug-ins, et d’autres paramètres de piste.

En-tête de piste avec MIDI activé:
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Environnement de travail (Workspace)
Les environnements de travail servent à adapter le programme à un certain type
d’activité. On peut en changer, les renommer et en créer. L’environnement de
travaille se choisit en barre «Workspace». Cela concerne les menus, les raccourcis-
clavier et les barres d’outils. Les environnements de travail peuvent s’appliquer
à l’édition d’onde (Wave) ou de projet virtuel.

Fondu (Fade)
Vous pouvez faire un fondu d’entrée (fade-in, montant) et de sortie (fade-out,
descendant) du niveau. Vous pouvez aussi faire un fondu enchaîné entre objets
dans le VIP (Crossfade).

Fondu enchaîné (Crossfade)
Fondu enchaîné de deux objets sur une piste dans le projet virtuel (VIP). Un
fondu enchaîné standard peut être automatiquement créé quand on coupe pour
éviter les clics (Mode Auto Crossfade). Les fondus enchaînés peuvent être édités
directement depuis le VIP et dans l’éditeur d’objet. Toutefois, les fondus
enchaînés peuvent aussi être édités de façon complète dans l’éditeur dédié
nommé Crossfade Editor.
– 2 objets (pas plus!) peuvent se chevaucher
– Fondu enchaîné entre deux objets (l’un qui disparaît pendant que l’autre

apparaît)
– création d’un fondu enchaîné:
– déplacement/coupure etc. d’objets grâce à l’option «Auto Crossfade»
– chevauchement d’objets – activez le fondu enchaîné dans le menu contextuel
– 2 types de fondu enchaîné:
– fondu enchaîné symétrique: le fondu d’entrée (Fade Out) et celui de sortie

(Fade In) ont la même longueur et la même position (simple modification du
début de fondu enchaîné du projet par déplacement ou changement du fondu
d’entrée)

– fondu enchaîné asymétrique: fondus indépendants pour les deux objets
– commutable à l’aide du menu contextuel pour fondu enchaîné ou de l’éditeur

«Crossfade Editor»
– avec le fondu enchaîné asymétrique, l’option de magnétisme «Snap to grid»

peut positionner le fondu d’entrée par-dessus le fondu de sortie

Fondus et fondus-enchaînés
Fondus (Fade In/Out)
– définis par la position, la durée et la forme de courbe
– type de courbe – soit l’une des deux courbes standards soit chargeable depuis

un fichier (fichier texte, pouvant être créé ou édité en externe)
– paramètres de courbe de -200% à +200% (0...linéaire, 100%..original, -

100%...miroir de l’original, >100% mène à une distorsion supplémentaire
de la forme de fondu

– position réglable du point de référence du fader ou du centre de rotation par
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rapport au fondu (0%... bord d’objet, 50%...centre du fondu, 100%...
intérieur)... point In /point Out

– la position et la durée peuvent être éditées au moyen des poignées de l’objet,
une poignée supplémentaire pour déplacer le fondu par rapport au point de
référence peut être mise en service

– dans certaines circonstances, les poignées deviennent transparentes: la poignée
de durée de fondu pour une durée de 0, les poignées de position de fondu et
de chevauchement au bord du matériel audio disponible

– éditable dans l’éditeur d’objet (Object Editor) ou l’éditeur de fondu enchaîné
(Crossfade Editor)

Note: Si le point de référence d’un fondu n’est pas positionné au bord d’un objet
(rapport différent de 0%) et si le fondu a atteint la fin du matériel audio, il n’est pas
possible de zoomer sur le fondu.

Marqueur

Les marqueurs servent à mémoriser des positions. Ils s’affichent sous forme de
barres rouges portant le nom du marqueur sur une ligne spéciale (la barre des
marqueurs) sur le bord supérieur du projet. Les marqueurs se déplacent à l’aide
du bouton gauche de la souris.
Dans un projet, on peut définir n’importe quel nombre de marqueurs. 10
marqueurs sont directement accessibles par les touches de chiffre.
Les marqueurs assignés aux touches de chiffre sont nommés de «1» à «10». Le
choix de menu Range > Store Marker > Marker with name peut servir à définir
et nommer des marqueurs supplémentaires, qui seront affichés par leur nom.
Les marqueurs supplémentaires par rapport aux marqueurs standards (barres
blanches) sont les marqueurs triangulaires pour la gravure de CD; rouge:
marqueur de plage de CD, vert: marqueur de sous-index de CD, bleu: marqueur
de pause de CD. Pour plus d’informations, voir les Fonctions de création de
CD.
Quand vous cliquez avec le bouton droit de la souris sur la barre des marqueurs,
un menu contextuel apparaît. Il vous offre un accès pratique à toutes les
commandes importantes.

Les marqueurs peuvent être gérés et nommés à l’aide du gestionnaire de
marqueurs (Marker Manager)... (menu Tools ou menu contextuel de marqueur).

Pour faire de l’intervalle entre deux marqueurs une sélection, cliquez sur le
premier marqueur puis maintenez la touche Shift et cliquez sur le second. Cela
détermine une nouvelle sélection.
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Vous en saurez plus dans «Navigation avec les marqueurs«

Marqueurs de tempo
Indiquent un changement de tempo à une certaine position dans le projet.

Master Surround
D’un point de vue technique, le master surround est aussi un bus surround de
projet surround ayant comme propriétés supplémentaires le fait de pouvoir être
assigné aux périphériques audio et de ne pas pouvoir l’être à un bus surround.

Menu contextuel
Quasiment toutes les parties d’un VIP et de la table de mixage comportent un
menu contextuel qui s’ouvre à l’aide du bouton droit de la souris. Il se nomme
ainsi car le menu qui apparaît diffère de façon à être adapté au contexte de
travail actuel, c’est-à-dire à l’endroit du VIP ou de la table de mixage sur lequel
on a cliqué.

Mode objet
Détermine à quel point le déplacement d’un objet influence les objets suivants.
Par exemple, en mode «Link until silence», tous les objets suivants ou fondus-
enchaînés sont aussi déplacés. Une représentation complète des modes objet
peut être trouvée dans Mode objet.

Moitié basse: barre de grille
La barre de grille affiche le temps dans le projet en fonction de l’unité de mesure
sélectionnée. Elle vous permet aussi de faire une sélection («range») si cette
option n’est pas directement disponible dans les pistes à cause du mode de
souris sélectionné (par ex. Mode objet/courbe).
Clic gauche de la souris: Positionne le curseur (la «tête») de lecture.
Clic gauche de la souris et glissement de la souris: Nouvelle sélection.
Clic droit de la souris: Menu contextuel avec des options pour la grille et le
magnétisme.

Moitié haute: barre des marqueurs
Tous les marqueurs se placent ici.
Clic gauche de la souris: Positionne le curseur (la «tête») de lecture (magnétisme
des marqueurs placés)
Clic droit de la souris: Menu contextuel avec des options pour régler/appeler
des marqueurs, etc.

Monitoring
Le signal à enregistrer est simultanément reproduit par le périphérique de sortie.
Il existe plusieurs modes selon le pilote et le mode de monitoring utilisés.

Objets
Dans Samplitude, les objets sont des instructions de lecture d’une sélection
dans un fichier audio. Les projets virtuels contiennent des objets dans des pistes.
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Le terme «virtuel» est employé car l’objet ne contient pas l’audio lui-même. Il
contient des informations pour accéder à un point de départ particulier dans le
fichier audio physique et reproduire l’audio durant un temps déterminé par la
longueur de l’objet.
Dans les projets virtuels, les données audio sont représentées par des rectangles
(nommés «Objects») sur de multiples pistes. Un objet est la représentation d’un
échantillon ou d’un segment délimité dans l’échantillon. En d’autres termes:
l’objet est une référence à des données audio qui sont conservées dans les projets
Wave.
De plus, chaque objet a certains attributs, qui peuvent être modifiés avec l’éditeur
d’objet dans Samplitude. Le rectangle offre plusieurs poignées, qui peuvent servir
à modifier les attributs de l’objet que sont le temps de début, la durée et le
volume de l’objet.
Le symbole de verrouillage (clé) placé en bas de chaque objet (s’il est affiché)
peut servir à protéger un objet de modifications accidentelles. Les attributs à
protéger peuvent être choisis dans Lock Objects->Lock Definitions.

Orienté objet
Un fonctionnement orienté objet décrit une méthode de travail qui vous permet
d’apporter divers changements au matériel audio de façon virtuelle sans changer
le matériel audio réel (les données sur le disque dur).

Piste (Track)
Les pistes peuvent contenir des objets audio et MIDI. Les courbes d’automation
s’affichent aussi dans la piste.

Poignée
Les poignées sont les cinq petits rectangles qui apparaissent autour d’un objet
sélectionné.

Avec les poignées, vous pouvez régler plusieurs propriétés d’un objet:

Poignées inférieures:
La poignée gauche règle l’instant de début de l’objet, où l’objet commence la
lecture de l’audio depuis le projet Wave de référence.
La poignée droite règle l’instant de fin de l’objet, où l’objet cesse la lecture de
l’audio depuis le projet Wave de référence.
Notez que vous ne pouvez pas déplacer la poignée gauche/droite au delà du
début et de la fin du fichier audio physique.
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Poignées supérieures:
La poignée gauche règle la durée du fondu d’entrée, c’est-à-dire le temps
nécessaire pour que le fondu atteigne le volume maximum de l’objet.
La poignée droite règle la durée du fondu de sortie, c’est-à-dire le temps nécessaire
pour que le fondu ramène le volume de l’objet à zéro.
La poignée médiane règle le volume de l’objet. Cela fonctionne indépendamment
du fader de volume de piste ou des courbes d’automation de volume. Vous
pouvez aussi accéder au volume de l’objet dans l’éditeur d’objet.

Projet virtuel
Dans les projets virtuels, vous pouvez arranger des objets venant de multiples
projets Wave et monter des projets audio complexes. Toutes les opérations de
coupure, de changement de niveau de volume, de fondu et autres sont
complètement virtuelles, ce qui signifie que le matériel audio reste intact. Cela
vous permet de sélectionner la bonne valeur pour la position de découpe, la
longueur de découpe, le niveau de volume, le réglage d’effet, etc. en
expérimentant sans perdre ni modifier le matériel audio.
Les véritables données audio sont représentées par des rectangles (nommés
«objets») sur de multiples pistes. Un objet est donc une «image» d’un échantillon
ou d’une partie déterminée de celui-ci. En d’autres termes: l’objet se réfère aux
données audio.

Réglages de système
Les réglages qui ne sont pas propres à un projet sont nommés réglages de
système. Ils comprennent des réglages qui s’appliquent à la totalité du projet.

Section
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Une «section» est la partie visible d’un projet. La partie affichée (ou la totalité)
d’un projet dépend du niveau de zoom.
Samplitude offre la possibilité d’afficher n’importe quelle fenêtre de projet en
trois sections. Cela vous permet d’afficher l’échantillon complet dans une section
tout en affichant des sections plus petites dans une ou deux autres parties. Chaque
section est accessible et éditable séparément.

Section active quand on utilise les niveaux de zoom
Si des commandes de zoom sont employées sur une des sections affichées, par
exemple les boutons de la barre de position, il est important de désigner la
section sur laquelle zoomer. Cliquez sur la barre de défilement gauche ou droite
d’une section pour l’activer.
Vous pouvez aussi passer d’une section à l’autre avec les touches Pg Préc./Pg
Suiv. (Page Up/Page Down).

Sélection (Range)
Une sélection peut être faite à la souris. Les sélections peuvent être lues avec la
barre d’espace. Elles sont définies par un marqueur de début et un marqueur de
fin.
Une sélection sert à repérer une section afin de manipuler le matériel de cette
zone (couper, insérer, normaliser, fondu d’entrée, fondu de sortie, déplacement,
effets, suppression, etc.).
La deuxième fonction est la définition de boucles à répéter durant la lecture.
La troisième fonction d’une sélection est la configuration de limites de section
dans laquelle des données graphiques sont affichées.
Chaque projet peut avoir un nombre illimité de sélections définies. Vous pouvez
accéder à 10 sélections directement par les touches de fonction. Des sélections
supplémentaires sont accessibles via le gestionnaire de sélections (Range
Manager). Les bords verticaux d’une sélection peuvent être verrouillés par la
fonction Fix Vertically (Menu «View’). Cela réglera la hauteur de la sélection au
maximum, ce qui est le réglage par défaut des projets virtuels.

Visualisation
L’affichage permet des visualisations différentes du matériel que vous entendez.
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New Virtual Project (VIP)
Un nouveau projet virtuel est créé, immédiatement présenté dans une fenêtre
dans l’environnement de travail de Samplitude.

Project Template: Vous pouvez choisir parmi plusieurs modèles (templates)
de projet disponibles dans ce menu déroulant. Un modèle comprend tous les
réglages de projet tels que nombre de pistes, assignation de périphérique, etc.
Utilisez «Save Project as Template» pour sauvegarder un projet comme modèle.

Mixer Setup: Vous permet de choisir une configuration (setup) de table de
mixage prédéfinie. Ces configurations comprennent le nombre et le type des
pistes ou bus et tous les routages d’entrée/sortie et d’effet. Vous en saurez plus
dans «Mixer Setup». Si vous voulez créer un projet surround, c’est ici que vous
devez choisir ce format. Vous en saurez plus dans «Mixer Setup» et «Surround».

Project Options: Ouvre la fenêtre de dialogue Project Options. Tous les réglages
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(par ex. grille, BPM, mode d’arrangement de CD, sauvegarde automatique, etc.)
faits ici s’appliqueront à tout nouveau VIP créé. Pour cela, ils sont sauvegardés
dans un VIP spécial (template/template.VIP). Le fichier «template.VIP» peut
aussi être directement édité. Vous pouvez alors faire des réglages
supplémentaires pour servir de réglages par défaut à vos projets:
– Réglage d’armement pour l’enregistrement de la première piste
– Quelques réglages de configuration de table de mixage
– Mode de lecture
– Réglages de piste et d’effets master (par ex. mode de compresseur, dossier

d’effets)
– Décalage (offset) de grille: Règle le temps de départ de grille par rapport au

temps de départ de VIP.

Track Number: Fixe le nombre de pistes du projet virtuel. Il est possible d’ajouter
des pistes par la suite avec la commande «Track -> Insert new tracks... ».

Sample Rate: Définit la fréquence d’échantillonnage du projet virtuel.

Note: Des objets avec virtuellement tout type de fréquence d’échantillonnage, format
audio ou codage peuvent être chargés quelle que soit la fréquence d’échantillonnage
du VIP.

Name: Indiquez dans ce champ le nom à donner au Projet.

Create New Project Subdirectory: Un sous-dossier portant le nom du projet
est automatiquement créé dans le dossier des projets virtuels (voir Settings/
Paths). C’est la méthode la plus simple pour garder ensemble tous les fichiers
appartenant à un même projet.

Default Project Length: C’est la longueur par défaut du VIP créé (1, 10, 60
minutes ou une valeur prédéfinie).

Raccourcis: e

Open Project > Virtual Project
Ouvre un projet multipiste de Samplitude. La boîte de dialogue qui s’ouvre est
réglée sur la recherche de fichiers avec extension .VIP.
Lors du chargement d’un projet virtuel, tous les projets Wave qui lui sont
rattachés sont ouverts s’ils ne l’étaient pas déjà. La fenêtre de chaque projet
Wave reste réduite pour éviter d’envahir l’écran. A l’ouverture, les fenêtres des
projets Wave ne sont visibles que sous formes d’icônes, et sont couvertes si le
VIP occupe tout l’écran.
Lorsque vous importez ou enregistrez des fichiers Wave dans un VIP, chaque
objet obtenu se voit ajouter une marque temporelle (horodatage) indiquant sa
position d’origine. Tout VIP s’ouvre dans une fenêtre dédiée dans
l’environnement de travail (workspace) de Samplitude.
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Raccourcis: o

Open Project > MIDI (*.mid)
Cette commande permet d’importer un ou plusieurs fichiers MIDI au sein d’un
projet VIP.

Veuillez vous reporter au chapitre consacré au MIDI pour obtenir de plus amples
détails.

Raccourcis: Shift + m

Open Project > RAM Wave (RAP)
Ouvre un projet RAM Wave. Les projets RAM Wave sont constitués de données
audio enregistrées dans le format propriétaire de Samplitude. Ces fichiers sont
chargés dans la mémoire RAM de votre ordinateur (y compris les fichiers
graphiques, les points de repère, etc… qui leur sont associés).

Raccourcis: l

Open Project > HD Wave (HDP)
Ouvre un projet HD Wave. Les projets HD Wave sont constitués de données
audio chargées directement depuis le disque dur de l’ordinateur et accompagnées
des informations graphiques, points de repère, etc… qui leur sont rattachées.
Les données audio de ces fichiers sont enregistrées au format WAV.

Note: Si la fenêtre active est un VIP, tous les projets WAV chargés sont immédiatement
transformés en objets dans le VIP. Le début de la sélection (Range) actuelle détermine
la position et la piste où l’objet sera créé.
Une exception: quand CD Arrange Mode est coché dans le menu CD. Les objets sont
alors placés d’une façon complètement indépendante de toute sélection en vigueur. A
la place, les objets sont placés à la suite (l’un après l’autre) avec entre eux un intervalle
de séparation prédéterminé. Cet intervalle se règle avec CD->Set Pause Time. Il
représente l’espace entre les plages successives d’un CD.

Raccourcis: Ctrl + l

Open Project > Object (*.Obj)
Ouvre un objet. Un objet sauvegardé à ce format contient des instructions pour
la reproduction des données audio (lien vers un projet Wave, piste, durée,
position, paramètres, etc.). Les objets sont utilisés par les projets virtuels.

Note: Vous pouvez également charger dans les projets VIP des objets préalablement
sauvegardés en les faisant glisser depuis l’Explorateur Windows.

Open Project > Edit List (*.EDL)
Cette fonction vous permet d’ouvrir une liste de montage (EDL) au format texte
de Division Video Systems. Un projet virtuel est créé à partir de cette liste de
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montage. La liste de montage est un ensemble d’informations portant sur les
fichiers WAV utilisés, les bords des objets et les réglages d’automation du volume
et du panoramique, de coupure (Mute), de verrouillage et de fondu.
Cette option rend les projets VIP de Samplitude compatibles avec toute
application qui accepte ce format, notamment EDL Convert Pro de CuiBono
Soft. Les applications de conversion de liste de montage permettent la conversion
vers tout autre format d’échange ou de projet, dont les sessions ProTools, les
projets Sadie, AES31, OpenTL, OMF et beaucoup d’autres.

Open Project > Table Of Contents (*.TOC)
Table of Content (TOC): Table des matières d’un CD masterisé dans Samplitude.
Vous pouvez créer des fichiers .TOC en utilisant la commande «Export TOC»
de la fenêtre «Make CD». Quand vous chargez une TOC, le projet Wave associé,
qui contient les données audio brutes pour le CD, est ouvert dans un nouveau
VIP. Dans ce VIP, tous les marqueurs de plage de CD sont réglés correctement
comme voulu pour le CD.

Load audio file
Ouvre un fichier pour charger des fichiers audio. Les formats suivants sont
acceptés: fichiers Wave (.WAV), fichiers MPEG (.mp2, mp3, mpg), fichiers Apple
(.aif, .aiff), Sound Designer 2, Windows Media (.asf, .wma), Ogg Vorbis (.ogg),
et vidéo pour bande son Windows (.avi) et autres fichiers vidéo (pour les fichiers
MIDI, voir l’importation de fichiers MIDI).
Vous pouvez ouvrir un fichier AVI pour éditer directement la piste audio de la
vidéo (sans importer les données audio du fichier vidéo). Une fois l’édition
terminée, remplacez l’audio dans la vidéo avec la commande «Export Video
Sound» de ce menu.
Les formats de fichier .WAV, MPEG, OGG, AIFF et AVI sont directement lus
par Samplitude; tous les autres formats sont importés lors de l’ouverture, c’est-
à-dire sauvegardés sur le disque dur comme un nouveau projet Wave.
Vous pouvez aussi charger plusieurs fichiers simultanément. Pour cela,
complétez votre sélection via Ctrl+Clic ou  étendez la sélection de fichiers via
Shift+Clic.
Note: En raison d’une particularité de l’explorateur Windows, l’ordre d’affichage
des sélections est inversé. Si vous cliquez par exemple sur Piste 1, Piste 2, Piste
3 (en utilisant «Ctrl»), vous verrez apparaître « Piste 3», « Piste 2», « Piste 1»
dans le champ de saisie (le chargement se fera aussi dans cet ordre). Aussi, si
vous voulez chargez plusieurs titres individuellement, sélectionnez-les en ordre
inverse de celui dans lequel vous voulez les arranger dans le projet. Toutefois, si
vous faites une sélection dans l’explorateur par Shift+Clic, par exemple un dossier
entier, vous pouvez procéder comme suit: sélectionnez d’abord le dernier titre
de la liste. Puis pressez «Shift» et cliquez sur le premier titre de la liste. Si vous
cliquez maintenant sur «Ouvrir», toutes les pistes sont dans bon ordre dans le
VIP.
Si un VIP est ouvert, de nouveaux objets qui se réfèrent aux fichiers audio chargés
sont créés simultanément dans le VIP. Si aucune zone n’a été sélectionnée dans
le VIP, les fichiers sont placés juste après le dernier objet.
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D’autres options de placement pour plusieurs fichiers peuvent être choisies
avec le bouton Options qui ouvre la fenêtre «Options for loading audio files».
Chaque fichier audio peut être écouté avant le chargement.

Note: La fonction de pré-écoute utilise le périphérique de sortie standard su système
multimédia Windows (comme les sons du système). Beaucoup de cartes audio
désactivent le système de son MME normal de Windows quand un pilote ASIO est
employé. Cela donne donc des messages d’erreur lors de l’emploi de la pré-écoute.
Cette dernière est par conséquent désactivée par défaut quand un pilote ASIO est
employé. Toutefois, vous pouvez la réactiver («Options for loading audio file») si vous
sélectionnez un autre périphérique audio pour les fonctionnalités multimédia de votre
PC, par exemple la carte son intégrée à la plupart des PC modernes. Sinon, vous
pouvez employer la nouvelle fonction File Browser (navigateur de fichier) dans les
nouvelles fenêtres Manager (gestionnaire).

Touche w

Load Audio CD Track(s)
Voir «Menu CD»

Save Project
Cette commande enregistre le projet en cours sous le nom affiché dans la fenêtre
du projet. Si vous n’avez pas encore donné de nom à votre projet, Samplitude
vous demande d’en indiquer un.

Raccourcis: s, Ctrl + s

Save Project as
Une fois cette commande lancée, vous pouvez indiquer le nom et le chemin
d’accès du projet dans lequel vous désirez enregistrer le projet en cours. Les
projets en RAM et les projets virtuels VIP peuvent être enregistrés avec un
nouveau nom (les fichiers sources ne sont pas affectés par ce changement de
nom). Les projets HD Wave sont renommés sur le disque dur. Samplitude ne
crée pas de copie des fichiers d’origine pour ne pas gaspiller d’espace sur votre
disque dur.

Raccourcis: Shift + s

Save complete VIP in
Cette commande permet d’enregistrer tous les projets Wave (*.RAP. *.HDP)
rattachés au projet VIP en cours dans le répertoire sélectionné et, ainsi, de
simplifier grandement la création d’une copie de secours de votre projet VIP.

Copy only samples used in VIP: Seules sont copiées les portions des projets
Wave qui sont vraiment utilisées par les objets dans le VIP. Cela revient à utiliser
la commande «Remove unused samples» (menu Tools) sur le VIP sauvegardé
après copie.
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Employer cette fonction peut économiser de l’espace de stockage (beaucoup),
mais il y a une contrepartie. Après avoir accompli cette fonction, les objets ne
peuvent plus qu’être raccourcis, puisque toutes les données audio extérieures à
leurs limites ont été supprimées. Pour contourner cela, vous pouvez définir une
«marge de sécurité» dans les échantillons. C’est le nombre d’échantillons qui
resteront dans le projet Wave – de part et d’autre de l’objet – donnant une réserve
de quelques échantillons au cas où vous voudriez par exemple changer un fondu.
La valeur par défaut de cette marge est de 22050 échantillons ou «samples» (=
500ms à 44,1 kHz).

Save Project as EDL
Le projet virtuel en cours est enregistré sous forme d’une liste de montage au
format texte EDL. Cette liste de montage est un fichier texte où sont indiqués
tous les renseignements portant sur tous les fichiers WAV utilisés, les bords
des objets et les réglages d’automation du volume et du panoramique.
Cela permet ainsi de rendre les projets VIP de Samplitude compatibles avec
toute application qui accepte ce format, notamment EDL Convert Pro de CuiBono
Soft. Les applications de conversion de liste de montage permettent la conversion
vers tout autre format d’échange ou de projet, dont les sessions ProTools, les
projets Sadie, AES31, OpenTL, OMF et beaucoup d’autres.

Save Project as Template
Cette commande permet de créer un modèle de projet reprenant tous les réglages
du projet en cours (format de la grille, nombre de pistes, etc.) mais sans les
objets et les fichiers HDP qui s’y trouvent. Vous pouvez choisir un modèle de
projet lors de la création d’un nouveau projet multipiste VIP. C’est une fonction
très pratique et très utile qui accélère considérablement votre travail et facilite la
conservation de certains réglages entre différents projets. Vous devez utiliser
cette fonction et ne pas faire dériver vos nouveaux VIP de projets existants
enregistrés avec la commande «Save as» car des règles différentes s’appliquent
à la gestion des chemin d’accès aux projets pour ces deux fonctions.

Burn Project Backup on CD
Cette option permet de créer une copie de sauvegarde de la totalité du projet sur
CD ou DVD. Demander cette commande lance le logiciel de gravure de CD/
DVD externe MAGIX CDR. Veuillez vous reporter à l’aide en ligne de mxcdr
pour plus d’informations.

Save Object
Samplitude vous permet de sauvegarder un objet particulier afin de faciliter le
transfert d’objets entre VIP, ou au cas où vous voudriez préserver certaines
parties d’un VIP (en les sauvegardant comme objets). Cette méthode vous permet
par ailleurs de vous constituer des banques d’effets sonores.

Note: Il est possible d’insérer plusieurs fichiers objets dans un VIP par glisser-déposer
depuis l’Explorateur Windows.
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Par défaut, l’extension pour les fichiers objets est *.obj.

Note: Vérifiez bien qu’un seul objet est sélectionné avant de sauvegarder. Si  plusieurs
objets sont sélectionnés, c’est le premier objet de la première piste sélectionnée (piste 1…)
qui sera sauvegardé.

Save Format
Cette commande vous permet de sauvegarder une session complète de
Samplitude. Les sessions de Samplitude sont un moyen rapide de retrouver
l’organisation d’écran, c’est-à-dire la façon dont sont situées fenêtres et barres
d’outils, telle que lorsque la session a été sauvegardée. Considérons que vous
avez un VIP, la table de mixage et plusieurs fenêtres HDP ouverts. SI vous
sauvegardez une session et la réouvrez ensuite, Samplitude replace toutes les
fenêtres ouvertes exactement comme lorsque la session a été sauvegardée.
De plus, enregistrer une session sous le nom «startup.sam» et la placer dans le
dossier qui contient Samplitude (en cas d’installation par défaut, ce serait
c:\MAGIX\Samplitude …) la fait charger par Samplitude au prochain démarrage
du programme.

Rename Project
Cette fonction vous permet de changer le nom du fichier en cours, ce qui vous
évite de devoir l’enregistrer sous un nouveau nom. Pour les projets RAM Wave,
seuls les noms internes sont modifiés (sans être enregistrés). Par contre, dans
le cas des projets HD Wave, tous les fichiers correspondants sont aussitôt
renommés. N’oubliez pas de sauvegarder les projets RAM Wave après avoir
renommé le projet.

Delete Wave Project(s)
Cette commande permet de supprimer vos projets Wave du disque dur.
Elle est donc à utiliser avec prudence car tous les fichiers correspondants seront
perdus!!!
Il n’y a pas pour cette fonction d’annulation ni de corbeille.

Note: Si vous supprimez un projet Wave depuis un gestionnaire de fichiers comme
l’Explorateur Windows, pensez également à supprimer les fichiers associés aux fichiers
de projet (*.hdp, *.ho).

Delete Virtual Project
Cette commande vous permet de supprimer un projet VIP et tous les projets
Wave qui s’y rattachent.

Sélection de fichier: Vous pouvez sélectionner le fichier de projet (.VIP) à
supprimer.

Liste des projets: Vous pouvez choisir parmi une liste des huit projets les plus
récents.
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Liste des fichiers: La liste des fichiers affiche les projets Wave utilisés dans le
VIP sélectionné. Vous pouvez choisir - fichier audio par fichier audio – si vous
voulez conserver le fichier (s’il sert à d’autres projets) ou le supprimer.

Convert Audio
Ce sous-menu contient diverses options pour convertir des formats de projet
Wave mono/stéréo.
Ces conversions peuvent être accomplies en mode d’édition d’onde (Wave
Editing), ou en sélectionnant un objet de VIP avant d’accomplir la commande.
Dans les deux cas, le fichier d’origine reste intact – de nouveaux fichiers sont
créés et nommés automatiquement par Samplitude.
Accomplir la commande depuis un VIP entraîne sur l’objet des changements
qui reflètent la conversion. En d’autres termes, l’objet se réfère maintenant aux
fichiers convertis.
Accomplir la commande via Wave Editing (édition destructive) ne modifie pas
le VIP existant – si les fichiers obtenus sont nécessaires dans le VIP, il faut faire
manuellement l’échange du projet Wave de référence en ouvrant l’éditeur d’objet
(onglet Position/Fades).

Convert Audio > Import Audio
C’est la possibilité d’importer tous les formats de fichiers acceptés comme projets
Wave. Cela n’est nécessaire que pour les formats de fichier qui ne peuvent pas
être directement ouverts par Samplitude (Windows Media Files et certains
fichiers MPEG).
Toutefois, vous pouvez soulager votre ordinateur si vous importez des formats
compressés du type mp3 ou Ogg plutôt que de les charger afin d’éviter le décodage
en temps réel.
Par opposition à «Load Audio File», le fichier audio est converti au format Wave
lors de l’importation et est copié sur le disque dur. Vous pouvez aussi utiliser
cette commande si vous avez de bonnes raisons de travailler avec une copie du
fichier dans le projet.

Raccourci: Ctrl + I

Convert Audio > Save In Format
Cette commande n’est accessible que lorsque vous manipulez directement un
fichier Wave, et elle vous permet de convertir les projets entre les différents
formats de projets Wave de Samplitude. Une autre option est la conversion en/
de projets Wave stéréo/mono et le changement de fréquence d’échantillonnage
et de résolution (nombre de bits). Des conversions au format MP3 ou AIFF sont
aussi possibles.

Range: Sauvegardez la sélection (Range) ou la totalité du fichier

Special Options: Show maximum amplitude: Permet d’afficher le niveau
maximal en dB après sauvegarde pour un réglage correct du niveau master.
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Exclude Master Effect: Les effets master ne sont pas inclus durant la
sauvegarde. Ils ne sont disponibles pour l’édition d’onde (Wave Editing) qu’en
mode d’édition d’onde virtuelle (voir le chapitre «Edition d’onde (Wave Editing)»)
quand vous ouvrez la table de mixage pour un projet Wave.

Dithering Options: Quand vous réduisez la résolution de 24 bits ou d’une
résolution flottante (Float) en 16 bits, la fonction dithering entre en jeu. Vous
pouvez choisir l’algorithme utilisé dans la fenêtre de dialogue correspondante
(voir Options ->Program Preferences->Dithering Options).

Format: Vous pouvez choisir dans cette section le nouveau format du fichier.
Sélectionnez le format souhaité, puis cliquez sur OK pour lancer la conversion.
Il vous sera demandé un nom pour le nouveau fichier qui sera créé, laissant
intact le fichier d’origine.

Quality: Choisissez la qualité de l’algorithme de rééchantillonnage utilisé (voir
Options ->Program Preferences->Resampling Quality Options) quand la
fréquence d’échantillonnage est changée.

Note: Il n’est pas possible d’utiliser le même nom et d’écraser le fichier existant, car il
est ouvert (Samplitude n’écrase pas un fichier ouvert dans cette situation). Il vous
sera alors demandé de choisir un nom et un emplacement pour le nouveau fichier.

Convert Audio > Stereo Wave > 2 Mono
Cette commande crée une copie du projet Wave stéréo et la convertit en un
projet Wave mono gauche et un projet Wave mono droit (les deux projets mono
reprennent le même échantillon).

Convert Audio > 2 Mono > Stereo/LR Wave
Cette commande permet de coupler deux projets mono en un projet Wave G&D
ou stéréo afin de les éditer simultanément.
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Après lancement de la commande, une fenêtre de dialogue s’ouvre et affiche
tous les fichiers mono chargés. «Load file« vous permet de charger d’autres
fichiers. Choisissez le fichier de droite et le fichier de gauche parmi les projet
Wave ouverts avec la touche ^. Les touches <-> vous permettent de changer les
canaux. Après avoir cliqué sur «Link Files», nommez le nouveau fichier stéréo
qui sera alors créé dans le dossier du projet.
Sachez que les fichiers mono ne peuvent être liés qu’à des projets Wave mono
et que seuls peuvent être liés des projets de même résolution et de même
fréquence d’échantillonnage. La longueur des deux projets est alors adaptée, le
fichier mono le plus grand déterminant la longueur totale.

Convert Audio > LR Wave > 2 Mono
Il est parfois nécessaire de diviser un projet stéréo ou deux projets mono joints
(ce que l’on nomme un projet Wave L&R) en deux projets mono indépendants.
Cette option de menu rompt la connexion statique entre ces projets. Pour coupler
de nouveau les deux projets, lancez simplement la commande ‘Convert Audio >
2 Mono > Stereo’ depuis le même menu (voir ci-dessous).

Convert Audio > LR Wave > 1 Mono
Cette commande convertit le projet L&R Wave en cours en projet mono. S’il
s’agissait à l’origine d’un projet stéréo, les deux canaux sont mélangés. Les
échantillons existants sont initialement additionnés à 100 % de leur image, puis
divisés par deux pour empêcher tout écrêtage (distorsion), ce qui revient à baisser
le volume de 6 dB.

Convert Audio > 1 Mono > LR Wave
Le projet Wave mono d’origine est dupliqué, puis les deux signaux sont convertis
en un seul projet Wave L&R contenant les mêmes données audio dans chacun
des canaux.

Export Audio
La commande «Export Audio» vous permet d’exporter vos fichiers de projets
Wave ou de VIP sous divers formats audio.

Remarque sur l’exportation de projets Wave: les projets Wave peuvent être directement
chargés ou importés comme fichiers .WAV par d’autres applications audio. La
commande Export Audio n’est nécessaire que si vous désirez copier le fichier audio ou
le convertir en un format différent. Gardez à l’esprit qu’il vous faut de la place sur le
disque dur et que le processus de copie prend du temps supplémentaire.

Vous pouvez aussi exporter des projets virtuels via cette commande de menu.
La commande dédiée de report de pistes (track bouncing) du menu Tools offre
un contrôle beaucoup plus détaillé du processus de report incluant le report
multipiste, l’exclusion d’effets, le report d’une seule piste ou d’un seul objet de
piste, par exemple.
Les formats d’export suivants sont possibles:
Wave, MP3, MP3 avec encodeur externe, MPEG, Windows Media, Real Audio,
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Ogg Vorbis, AIFF ou AIFF avec QuickTime,  fichiers 32 bits flottants ainsi que
16/20/24 bits et fichiers de transfert (dump).
Vous pouvez aussi exporter des objets MIDI comme fichiers MIDI standards
(SMF ou Standard MIDI Files).

Options
Les deux boutons radio de cette section vous permettent d’exporter la totalité du
fichier ou seulement une portion sélectionnée (Range) de celui.
Vous pouvez de plus décider si vous voulez sauvegarder chaque plage de CD
d’un projet comme un fichier séparé ou tout le projet comme un seul fichier
audio. Si les plages sont sauvegardées séparément, un fichier liste supplémentaire
(. m3u) sera créé aux côtés des fichiers audio. Ce fichier contient les noms de
chacun des fichiers audio dans l’ordre correct. Cette option n’est disponible que
quand il y a des plages de CD réglées dans le projet.
Pour lire automatiquement le fichier exporté une fois la procédure terminée,
cochez «Play exported file». La lecture ne sera pas effectuée par Samplitude
mais par l’application de lecture choisie par défaut pour ce type de fichier.

Bouton Format Settings
Selon le format d’exportation de fichier, ce bouton ouvre différentes fenêtres de
réglages de format.

Export Audio > Wave
La principale raison pour exporter un projet Wave est de compresser le fichier à
un format .WAV particulier. Samplitude peut employer différents codecs de
compression .WAV Windows disponibles dans le système. Sélectionnez le
réglage désiré, et cliquez sur OK.

Export Audio > MP3
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Cette fenêtre vous permet d’exporter des fichiers au format MP3, avec divers
réglages de format.

Export Audio > MP3 with external Encoder
Cette commande permet d’exporter des fichiers au format MP3 par le biais d’un
encodeur externe. La fenêtre de dialogue permet de configurer différents réglages.

Export Audio > MPEG
Cette commande vous permet d’exporter un fichier au format MPEG2 (*.mpg).
Cliquer sur le bouton Format Settings lance la fenêtre Choose Bitrate (choix du
débit), représentée ci-dessous.
Samplitude permet d’exporter des fichiers MPEG2 de 64 kbits/s à 384 kbits/s.

Export Audio > Windows Media (*.wma)
Cette commande vous permet d’exporter un fichier au format Windows Media
(*.wma).
Cliquer sur le bouton Format Settings lance la fenêtre Windows Media Export
Settings, représentée ci-dessus.
Différents réglages de taux (MS Audio Bit rate) sont disponibles, de 6 kb/s à
Voice Audio (audio vocal) et jusqu’à 128 kb/s pour une qualité audio proche de
celle du CD. La fenêtre de dialogue vous permet aussi d’indiquer le titre, l’auteur,
la description et les détails de copyright du fichier à exporter.
Il est en outre possible de générer des fichiers Redirector (*.wvx) en suivant les
instructions indiquées dans la section sur les fichiers Redirector.

Export Audio > OGG Vorbis
Exporte le projet au format OGG Vorbis. Saisissez simplement le nom de fichier
dans la fenêtre de dialogue. Ce format est une excellente alternative au célèbre
format MP3.
Cliquer sur le bouton Format Settings lance la fenêtre des réglages de
compression. Le niveau de compression va de 46 kBit/s à 500 kBit/s (32 kBit/s
à 320 kBit/s pour le MP3). La compression peut être réglée par paliers assez
grands (par ex. 64 kBit/s, 96 kbit/s, 128 kBit/s, 160 kBit/s) mais aussi par
paliers de 2 (par ex. 148 kBit/s, 150 kBit/s, 152 kBit/s).

Export Audio > Real Audio (*.ra)
Cette commande vous permet d’exporter un fichier au format Real Audio (*.ra).
La fenêtre de dialogue initiale est identique à celle de la commande Exporter
Audio > Wave.
Cliquer sur le bouton Format Settings lance la fenêtre Real Media Export Settings
représentée ci-dessus.
Divers algorithmes d’encodage Real Audio sont disponibles via l’emploi des
réglages appropriés dans les réglages de contenu et les menus de destination.
Vous pouvez également y indiquer le titre, l’auteur, et les informations de
copyright du fichier à exporter.

Export Audio > AIFF File with QuickTime
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Cette commande vous permet d’exporter l’audio au format AIFF Macintosh
(*.aif), par le biais des algorithmes de conversion de Quicktime.
Vous passez tout d’abord par une fenêtre de dialogue où vous pouvez nommer
le futur fichier à créer et sélectionner son emplacement sur le disque dur.
Quicktime va créer des fichiers temporaires dans le répertoire choisi (cela fait
partie du processus de conversion).
Le menu déroulant renferme tous les formats de conversion possibles.
D’autres options sont disponibles en cliquant sur le bouton Options.
Le menu déroulant Compression vous permet de choisir l’algorithme de
compression/réduction de bits à employer – ce réglage dépend dans une certaine
mesure du format du fichier d’origine.
Le paramètre déroulant Rate vous permet quant à lui de sélectionner la fréquence
d’échantillonnage désirée.

Export Audio > Aiff
Ce menu permet d’exporter du matériel audio au format AIFF en différentes
résolutions.
Les fichiers audio 16 bits ne peuvent être exportés qu’en AIFF 16 bits. Pour
pouvoir les exporter vers des résolutions supérieures, vous devez tout d’abord
les convertir au format 32 bits flottant à l’aide de la commande File > Convert
Audio > Save in Format.

Export Audio > 32 Bit Float as 16 / 20 / 24 Bit
Cet élément de menu vous permet d’exporter un fichier audio 32 bits flottant en
un fichier audio *.WAV de résolution inférieure.
Du Dithering est appliqué lors de l’exportation pour obtenir une qualité optimale.

Note: Si la fonction Dithering de Samplitude est désactivée, les valeurs de l’échantillon
sont arrondies mathématiquement lors de la conversion de résolution. C’est une bien
meilleure solution qu’une troncature pure et simple.

Export Audio > Export MIDI File
Cet élément de menu vous permet d’exporter toutes les données MIDI du projet
sous forme de fichier MIDI standard ou SMF (*.mid).
.
Export Audio > Export as Dump
Cet élément de menu permet d’exporter du matériel audio sous forme de fichier
de transfert (dump) – seules les données d’échantillons brutes sont stockées
dans le fichier (c’est-à-dire pas d’en-tête de fichier, etc.)
Vous pouvez choisir entre «Intel» et «Motorola» pour l’ordonnancement des
octets. (Ordres nommés Little Endian ou «petit boutiste» et Big Endian ou «gros
boutiste».)

Note: Les fichiers audio 32 bits flottant doivent être convertis en 16 bits ou 8 bits avant
de lancer cette commande. En effet, seuls les fichiers audio 16 bits peuvent être exportés
sous forme de fichiers de Dump.
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Export video sound
Vous pouvez charger de fichiers vidéo comme des fichiers audio pour travailler
sur leur bande son. C’est utile quand vous n désirez pas éditer l’audio mais
seulement traiter la totalité de la piste audio avec des effets comme la
normalisation ou la réduction de bruit. Si vous préférez une confirmation visuelle,
utilisez à la place Menu Options > Project Properties > Media Link.
Après édition de la bande son de la vidéo, vous pouvez la réécrire dans le fichier
vidéo. Vous avez aussi la possibilité de remplacer la bande son d’origine de la
vidéo ou de produire un nouveau fichier vidéo. Il n’est pas nécessaire de perdre
du temps pour une nouvelle compression de la vidéo. Néanmoins, vous pouvez
changer le format audio, par exemple pour un format compressé comme
l’ADPCM. Toutefois, les codecs de compression adaptés doivent bien sûr être
installés.

Create AVI / Audio Copy: Cette option effectue un report de pistes du VIP
actuel dans un fichier audio. Le fichier AVI est copié dans un nouveau fichier,
qui contient la nouvelle piste audio. Cette option conserve le fichier AVI d’origine.

Replace Audio in Video: Cette option effectue un report de pistes du VIP
actuel dans un fichier audio. Ce fichier est fusionné dans le fichier AVI
sélectionné, aussi le fichier AVI a-t-il une nouvelle piste audio.

Note: Si la longueur du fichier vidéo et celle de l’audio diffèrent, un avertissement
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apparaît. Après exportation, le plus long est tronqué, aucune synchronisation
automatique n’est faite. Si vous recevez cet avertissement, essayez de rééchantillonner
votre bande son audio pour obtenir la bonne longueur.

Export to Video deLuxe pro
Cette commande de menu appelle la fenêtre de report de pistes (track bouncing)
et ouvre le programme de montage vidéo MAGIX video deLuxe avec le résultat.

Batch Processing (Traitement par lots)
Le traitement par lots permet d’appliquer la tâche à accomplir automatiquement
à plusieurs fichiers – pour le traitement de gros volumes de données,
généralement la nuit.
Chaque tâche («job») est entrée sur une liste répertoriant les différentes tâches
à accomplir par lots. Il est possible d’entrer différentes tâches par lots qui seront
ensuite exécutées les unes après les autres.
Tâches pouvant être traitées par lots:
– normalisation
– fondus linéaires (d’entrée et de sortie)
– effets en temps réel sur le bus master de la table de mixage
– conversion de format : résolution (16/24/32 bits), fréquence d’échantillonnage,

stéréo/mono/gauche/droite
– sauvegarde à tous les formats d’exportation disponibles

Par exemple, vous pouvez normaliser à 96 % une liste pleine de fichiers WAV
24 bits, leur appliquer un fondu de 5 ms au début et à la fin de chaque fichier,
les compresser à l’aide du compresseur multibande, les convertir tous en mono
16 bits, les rééchantillonner en 22 kHz, puis les sauvegarder tous en mp3.

Jobs (Tâches)
Sur la droite de la fenêtre de traitement par lots se trouve la liste des tâches.
Pour ajouter de nouvelles tâches, cliquez sur le bouton «Add job». Lorsque vous
sélectionnez une tâche (par un clic de souris), 4 onglets de réglages s’affichent:
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source files (fichiers sources), effects (effets), target format (format de destination)
et target files (fichiers de destination). Le bouton «Remove job» permet de
supprimer la tâche sélectionnée. Le bouton «Perform jobs» lance le traitement
par lots.
Tant que Samplitude est ouvert, toutes les tâches restent sauvegardées jusqu’à
leur exécution, même si vous refermez la fenêtre de traitement par lots entre
temps.

Source files (Fichiers sources)
C’est au moyen du bouton «Add file» que se crée la liste des fichiers à éditer.
Des sélections multiples sont possibles. Pour ajouter tous les fichiers audio
d’un même dossier (y compris les sous-dossiers qui s’y trouvent), sélectionnez
«Load directory». Tous les formats audio importables peuvent être chargés dans
Samplitude. L’option «Save list» crée une Playlist (au format *.m3u commun)
permettant une utilisation ultérieure des fichiers sélectionnés. L’option
«Remove» supprime les entrées sélectionnées sur la liste. «Remove all» supprime
la liste en totalité.

Effects (Effets)

1. Normalization (Normalisation)
Vous pouvez normaliser en termes de pourcentage (%), de décibels (dB) ou
manuellement au moyen des niveaux. Pour plus de détails, veuillez vous reporter
au chapitre sur le menu Effects -> Amplitude/Normalize

2. Master Effects (Effets Master)
Pour éviter les redondances en fenêtre du traitement par lots, des réglages d’effets
ont été intégrés aux fichiers de présélections de la table de mixage.
Depuis la table de mixage de Samplitude, vous pouvez exporter la configuration
complète des réglages de mixage sous la forme d’un preset de mixage (* mix).
Cliquez simplement sur le bouton «Save mixer preset» de la table de mixage
(voir illustration).
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En chargeant ces fichiers *.mix dans le module de traitement par lots («Load
preset»), tous les réglages d’effets Master sont inclus (tous les autres réglages
de mixage comme les propriétés des voies, les groupes, etc. sont ignorés). Le
bouton «Edit preset» ouvre une fenêtre de routage d’effets spéciale à partir de
laquelle vous pouvez accéder à tous les paramètres d’effets.
Pour obtenir plus de détails sur la fenêtre de routage des effets, veuillez vous
reporter au chapitre consacré aux effets.
Les presets de mixage sont placés dans le dossier /fxpresets/batch et peuvent
être sélectionnés directement depuis la liste.
Outre les effets master des presets de mixage, vous pouvez reprendre les réglages
des effets en temps différé Resampling/Timestretching, DC removal et De-
Clipping. Les réglages ouvrent la boîte de dialogue de l’effet correspondant.

3. Fondus en début et en fin de projet
Il est possible d’appliquer des fondus linéaires de n’importe quelle durée aux
fichiers.

 Format de destination

Tous les réglages peuvent être sauvegardés sous forme de Presets. Pour plus de
détails, veuillez lire la section sur la sauvegarde des effets (mécanisme des Presets)
dans Samplitude.
Vous avez le choix de la résolution (16/24/32 bits), de la fréquence
d’échantillonnage, du type stéréo/mono/gauche/droite et du format avec l’option
de format applicable.
Pour plus de détails sur la fréquence d’échantillonnage, veuillez vous reporter à
la section: menu Effects -> change sample rate.
Pour de plus amples détails sur les formats d’exportation: menu Effects -> export
audio.
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Destination files (Fichiers de destination)

Les fichiers édités peuvent être sauvegardés de différentes façons:
«Replace file»: Remplace le fichier d’origine par le fichier édité. Si le fichier est
utilisé dans le VIP, vous devez refermer le VIP au préalable.
«Save and rename file in the source directory»: Le fichier édité est sauvegardé
dans le dossier source et renommé.
«Save file in the following directory»: Le fichier édité est sauvegardé dans le
dossier suivant
«Delete source file after editing»: Le fichier source est supprimé après l’édition.
«Save with source directory path«: Le fichier édité est sauvegardé au même
emplacement que le fichier source.

Connect to the Internet
Cette commande ouvre la fenêtre classique de connexion à Internet. Pour
bénéficier de cette fonction, il vous suffit d’une connexion Internet normale –
via modem, RNIS ou ADSL.

FTP Download
Cette commande vous permet d’entrer en relation directe avec n’importe quel
serveur FTP présent sur Internet afin de télécharger directement des données
audio dans Samplitude. La commande est par défaut réglée sur le serveur
MAGIX, ce qui n’est pas une mauvaise chose, car vous pourrez toujours y trouver
de nouveaux sons. Ici encore, il vous suffit d’une connexion Internet
fonctionnelle.

Close Project
Cette commande de menu ferme la fenêtre du projet actif. Si le projet a été
modifié mais pas sauvegardé, un message d’avertissement apparaîtra.

Exit
Cette commande referme Samplitude.
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Ce menu regroupe toutes les fonctions équivalentes aux fonctions de montage
d’un magnétophone à bande comme couper/coller etc.
Dans les projets virtuels, vous pouvez sélectionner une piste pour que l’opération
d’édition ne porte que sur celle-ci. Sur un projet virtuel VIP, vous devez délimiter
une sélection (Range) avant de pouvoir lancer une fonction d’édition. Ce sont
les points de départ et de fin de la sélection qui fixent l’endroit où l’opération
doit commencer et s’arrêter. La position verticale indique la ou les pistes affectées
par l’édition.
Nous vous conseillons d’utiliser la fonction Auto-crossfade dans quasiment toutes
les situations, afin de créer des fondus aux bords des objets et ainsi d’appliquer
des transitions douces entre les points d’édition.
N’oubliez pas que ces opérations sont appliquées sur les deux canaux à la fois
dans le cas des projets Wave stéréo et L&R (si vous ne désirez qu’un seul des
deux canaux, convertissez au préalable le projet Wave en deux projets Wave
mono. Une fois l’édition effectuée, vous n’aurez qu’à fusionner de nouveau les
deux projets).
Attention: Pour éviter les incohérences entre les modes d’objets (par ex. «lock
all audio in time», «link Objects until silence») et les commandes d’édition
classiques, certaines opérations d’édition des projets virtuels fonctionnent
différemment des précédentes versions de Samplitude.
Règle générale: L’action des commandes delete, cut et paste des projets VIP
varie en fonction du mode objet choisi.
Explication: Samplitude propose différents modes objets («link Objects one/all
tracks», «link until silence») à «répercussion». Autrement dit, si vous déplacez
un objet, les objets qui le suivent vont également être déplacés afin de préserver
les Crossfades et les écarts qui les séparent. Dans ces modes objets à
«répercussion», la fonctionnalité de la commande d’édition est aussi affectée.
Par exemple, si vous coupez un objet, les objets suivants vont être
automatiquement ramenés au point de coupure pour éviter qu’un blanc ne soit
créé. De même si vous insérez un objet, les objets se trouvant au point d’insertion
vont être repoussés vers la droite pour faire de la place au nouvel objet. Il s’agit
là du comportement «standard» des fonctions delete, cut et paste comme dans
les anciennes versions de Samplitude.
Dans les autres modes objet («normal», «lock all audio»), ces commandes n’ont
pas cette «répercussion». En d’autres termes, les zones non directement
impliquées dans l’édition restent intactes en termes de mouvements temporels.
Ceci est particulièrement important si vous devez éditer des données audio
synchronisées (projet chaîné à un fichier AVI, par exemple). Exemple : En mode
objet «normal», la commande delete (supprimer) fonctionne comme la
commande clear (effacer), laissant un blanc là où le matériel audio a été supprimé.
Les commandes traditionnelles, qui agissent quel que soit le mode objet en
vigueur, sont accessibles depuis le sous-menu «More». Si vous ne vous habituez
pas à cette configuration, rien ne vous empêche de reconfigurer les raccourcis
clavier avec les réglages des anciennes versions de Samplitude.
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Undo
Permet d’annuler les dernières opérations effectuées (VIP). Samplitude propose
d’ailleurs un historique d’édition des projets VIP et Wave. Samplitude peut
conserver en mémoire les 100 dernières opérations d’édition effectuées afin de
vous permettre de revenir en arrière très facilement sur une opération qui ne
vous satisfait pas.
Les opérations virtuelles ainsi que les opérations dites physiques (Normalisation,
réverbération ou filtre dont l’option Create Copy est cochée, etc.) peuvent être
annulées.
Il est également possible d’annuler les manipulations effectuées sur une sélection
(Range) et sur les marqueurs avec cette commande.
Si vous désirez appliquer des effets aux données audio (menu Effects), vous
n’avez accès à la fonction Undo que si les effets sont appliqués directement sur
les objets VIP – c’est-à-dire destructivement «marqués» sur l’objet, par opposition
aux effets en temps réel. L’option ‘Create Copy’ doit être cochée dans la fenêtre
de dialogue d’effet pour pouvoir annuler («undo») les processus d’effets
destructifs.

Notes: Vous pouvez définir la taille de l’historique d’édition (nombre de paliers
d’annulation ou «Undo Steps») dans Options > Program Preferences > Undo
Definitions.
Certaines commandes, comme Tools > Remove Unused Samples ou CD > Make CD,
sont irréversibles et ne peuvent donc être annulées.

Raccourci: Alt + Retour arrière, Ctrl + z

Redo
Cette fonction permet de rétablir la dernière opération annulée.

Raccourci: Ctrl + a

Undo History

Cette commande ouvre une fenêtre qui répertorie les dernières opérations
d’édition effectuées. Il suffit ensuite de cliquer sur l’opération désirée pour
l’annuler et Samplitude reviendra à son état en vigueur avant cette opération.
Notez qu’il est facile de passer d’une opération à l’autre, pour vérifier que vous
avez bien sélectionné le bon niveau. Une fois que vous êtes certain de l’opération
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à annuler, appliquer l’annulation en cliquant sur OK.

Cut
Projets Wave :
Les données audio de la sélection sont transférées du projet Wave en cours dans
le «presse-papier» (Clip). Les données audio qui se trouvaient à la suite de la
sélection sont alors rattachées aux données audio placées avant la sélection et le
projet Wave obtenu se raccourcit.
Gardez à l’esprit que les données du Clip conservent les mêmes propriétés que
le projet Wave duquel elles proviennent.
Si vous coupez une portion d’un projet mono, le Clip est mono. Si vous coupez
une portion d’un projet stéréo, le Clip devient stéréo. Les données transférées
dans le Clip conservent également la même résolution et la même fréquence
d’échantillonnage que leur projet Wave d’origine. Chaque transfert de données
dans le Clip remplace les données qui s’y trouvaient précédemment.

Projets virtuels (VIP):
Mode objet : Normal, Lock all audio (Verrouiller les objets audio)
Les données audio sont effacées et remplacées par du silence. Les données se
trouvant à la suite des données effacées restent à leur place (= Commande
«Copy +Clear«)
Mode objet : Link Objects one/all tracks (Lien temporel entre objets sur une piste/
toutes les pistes)
Les données audio qui se trouvaient à la suite de la sélection transférée sont
ramenées à la suite des données antérieures à la sélection transférée.
Le projet VIP se raccourcit si la sélection couvre toutes les pistes. Cette méthode
vous permet, par exemple, de raccourcir un projet VIP qui contient un espace
vide à la suite du dernier objet (= Commande «Paste with Time/Ripple»)

Servez-vous de la commande Edit->Paste/Insert Clip  pour insérer le Clip dans
les projets Wave ou VIP.
Raccourcis : Shift +Supprimer, x, Ctrl + x

Delete
Cette commande supprime tous les objets, points de courbe sélectionnés ou la sélection
(Range) faite dans le projet. Les points de courbe ont priorité sur les sélections, la
sélection (Range) a priorité sur un objet sélectionné.
Quand un objet est sélectionné et qu’une sélection (Range) est faite, c’est cette dernière
qui est supprimée. C’est pourquoi si vous voulez supprimer un objet du projet avec
cette commande (à l’aide de la touche Suppr.), il ne doit pas exister de sélection
temporelle (Range).
Une commande «Delete Object» dédiée qui fonctionne indépendamment de la sélection
temporelle (Range) se trouve dans le menu Object->Cut Objects.
Selon le mode objet sélectionné dans le VIP, la suppression d’une sélection (Range)
fonctionne comme suit:

Mode objet : Normal, Lock all audio (Verrouiller les objets audio)
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La suppression se fait sans répercussion sur ce qui suit, n’entraînant pas l’avancée
du matériel audio situé après (=Commande «Clear»).
Mode objet : Link Objects one/all tracks (Lien temporel entre objets sur une piste/
toutes les pistes) et projets Wave
Les données d’échantillons qui se trouvaient à la suite de la sélection supprimée
sont ramenées à la suite des données antérieures à la sélection supprimée. Le
projet est raccourci (=Commande «Delete with Time/Ripple»). Utiliser cette
commande «Delete» ne fera que supprimer les données de l’échantillon actuel,
laissant le Clip et son contenu inchangés. Si vous voulez conserver le matériel
supprimé, utilisez la commande «Cut».

Raccourci: Suppr.

Copy
Cette commande copie les données sélectionnées (Range) dans le Clip. (VIP,
projets Wave) sans les supprimer du projet. La longueur de l’échantillon ne
change pas. Veuillez noter que les données copiées remplacent les données qui
se trouvaient préalablement dans le Clip.

Raccourcis: C, Ctrl + C, Ctrl + Insert

Paste/Insert Clip
Cette commande insère (colle) le contenu du Clip à l’endroit où se trouve la tête
(le curseur) de lecture ou au début de la sélection (Range) délimitée.

Mode objet : Normal, Lock all audio (Verrouiller les objets audio)
Le collage se fait sans répercussion sur ce qui suit, n’entraînant pas le recul du
matériel audio situé après. Les données insérées viennent remplacer celles qui
se trouvaient jusque-là au point d’insertion (=Commande «Overwrite with Clip»).

Mode objet : Link Objects one/all tracks (Lien temporel entre objets sur une piste/
toutes les pistes) et projets Wave
Les données ou les objets placés à la suite du point d’insertion sont déplacés
pour pouvoir accueillir les données du Clip. Les échantillons ou les pistes audio
s’allongent. Les données du Clip ne sont pas modifiées au cours de la procédure
(=Commande «Paste with Time/Ripple»).
Si une sélection est délimitée dans le projet virtuel, la position de début de la
sélection et la position de piste relative servent de point d’insertion au contenu
du Clip. Une fois les données du Clip insérées, Samplitude les sélectionne
automatiquement pour pouvoir éventuellement les supprimer (commande Edit
> Delete) et retrouver le projet tel qu’avant le collage.

Le tableau ci-dessous vous montre l’attribution des canaux si le Clip et le projet
sont sur des canaux différents:

Clip   >   Projet Canal de Clip  --->  Canal de projet
Mono Mono Canal 1 Canal 1
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Stereo Stereo Canal 1 Canal 1

Canal 2 Canal 2
Mono Stereo Canal 1 Canal 1

Canal 1 Canal 2
Stereo Mono Canal 1 Canal 1

Raccourcis: V, Ctrl + V, Shift + Insert

Extract
Cette commande donne le résultat inverse de la commande «Cut» en coupant
les données situées de part et d’autre de la sélection délimitée.

Projets Wave:
Cette commande supprime définitivement la totalité du projet à l’exception des
données sélectionnées. Le fichier audio se raccourcit. Le contenu de la fenêtre
Clip ne change pas.

Projets virtuels (VIP):
Cette commande supprime définitivement la totalité du projet VIP (toutes les
pistes) à l’exception de la zone sélectionnée, que cette sélection s’étende sur une
ou plusieurs pistes. Autrement dit, cette commande agit sur le projet dans son
ensemble, et pas seulement sur une seule piste.
Les objets situés avant et après la sélection sont supprimés du projet. Le contenu
du VirtClip n’est pas modifié.

Insert Silence
Cette commande insère un ‘blanc’ à la position actuelle du curseur de lecture
ou au début de la sélection (Range) actuellement délimitée.
En l’absence de sélection, vous pouvez définir dans la fenêtre qui s’ouvre la
durée du silence par une valeur numérique. Sinon, c’est la longueur de la
sélection (Range) qui est automatiquement employée dans la fenêtre de dialogue.
Les données de ce blanc sont de valeur 0. Les données qui se trouvent après le
point d’insertion. La sélection reste en place et la longueur totale de l’échantillon
change pour prendre en compte ce blanc.

Strip Silence
Cette commande supprime les parties silencieuses de tous les objets sélectionnés
dans un VIP. Après application de la commande, les objets sont fractionnés de
façon à en éliminer toutes les parties silencieuses. Les nouveaux objets silencieux
créés sont tous sélectionnés pour que vous puissiez tous les supprimer d’un
coup en pressant la touche «Suppr.». Sinon, vous pouvez les conserver et d’abord
les examiner.
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Append Projects
Cette commande vous permet de placer un projet à la suite d’un autre. Les
données audio de l’un des projets sont alors copiées directement à la suite des
données audio de l’autre. Sélectionnez tout d’abord l’objet de base, sélectionnez
ensuite cette option de menu puis cliquez sur le projet que vous voulez ajouter
au premier.
Cette option sert généralement pour ‘nettoyer’ les VIP contenant beaucoup de
projets Wave. Vous pouvez:
– combiner un VIP avec un autre VIP. Cela convient aux grands projets, vous

pouvez en éditer des parties dans différents fichiers pour au final les
recombiner.

– combiner un projet Wave avec un autre projet Wave. Une utilisation
particulière de cette option est le ‘nettoyage’ de VIP contenant beaucoup
d’échantillons physiques.

– combiner un projet Wave avec un VIP. C’est une méthode intelligente pour
transférer des marqueurs d’un projet Wave dans un VIP. Normalement, quand
un projet Wave est chargé dans un VIP, les marqueurs restent à l’intérieur
du fichier audio comme marqueurs audio. Souvent, il est nécessaire d’avoir
ces marqueurs dans le VIP. Quand vous combinez un projet Wave avec un
VIP, les données audio sont insérées comme un objet à la fin de la piste
active dans le VIP et les marqueurs du projet Wave sont insérés dans le VIP.

More > Delete with Time/Ripple
Cette commande supprime la sélection (Range) déterminée. Une fois la coupure
effectuée, les données qui suivent sont ramenées (avancées) au point de coupure.

Raccourci: Ctrl + Suppr.
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More > Clear
Remplace la sélection par du silence (VIP). Cette command est utile pour
supprimer du matériel sans changer la longueur des pistes du VIP.

Note: Cette commande ne copie pas les données supprimées dans le Clip. Pour cela,
utilisez la commande Edit > More > Copy+Clear.

Raccourci: Alt + Suppr.

More > Copy + Clear
Les données audio de la sélection sont copiées dans une fenêtre Clip, puis retirées
du projet VIP. La longueur du projet n’est pas modifiée. Les données qui se
trouvaient au préalable dans le Clip sont remplacées par les nouvelles données.
Cette commande permet d’effacer en toute simplicité une portion du VIP à
employer ailleurs sans changer la longueur des pistes dont le matériel a été
extrait.

Raccourci: Alt + C

More > Cut with Ripple
Une fois la coupure effectuée, les données qui suivent sont ramenées (avancées)
au point de coupure.
Dans les VIP: Le VIP est raccourci si la sélection couvrait toutes les pistes. Ainsi,
vous pouvez raccourcir des VIP ayant des espaces vides après le dernier objet.
Raccourci: Ctrl + X

More > Copy as...
Cette commande copie la sélection en vigueur et la transfère dans un nouveau
fichier (projets Wave uniquement).
Un navigateur de type Explorateur s’ouvre alors pour vous permettre de nommer
le fichier et d’en sélectionner l’emplacement de destination.

Raccourci: Shift + C

More > Paste with Ripple
Les échantillons ou objets situés derrière la position d’insertion sont repoussés
pour faire la place au contenu du Clip. Les échantillons ou pistes audio s’allongent
d’autant. Le Clip reste inchangé durant la procédure.
Raccourci: Ctrl + V

More > Overwrite with Clip
Cette commande insère les données du Clip à la place de la sélection en vigueur.
La durée ne change pas.

Remarque: Dans les VIP, cette commande ne remplace pas les données audio réelles,
c’est-à-dire que les projets Wave ne changent pas.
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Le contenu du Clip n’est pas modifié.
Dans les projets virtuels VIP, c’est la sélection en vigueur qui détermine la
position et la piste au niveau desquelles les données du Clip sont insérées.

Raccourci: Alt + V, Insert

More > Crossfade with Clip
Le contenu de la sélection (Range) est fondu enchaîné avec celui du Clip. Dans
ce cas, la position du curseur de lecture détermine la fin du clip qui est utilisée
pour le fondu enchaîné du projet Wave. La longueur du clip détermine la
longueur du fondu enchaîné.
Ici aussi, les règles d’ordonnancement des canaux s’appliquent entre projet et
Clip comme pour la fonction Paste (Coller). Le Clip reste inchangé.

More > Mix with Clip
Cette commande permet de mélanger le contenu de la fenêtre Clip à celui de la
sélection (projets HD Wave uniquement).
Les contenus de la sélection et du Clip sont mélangés à parts égales. L’attribution
des canaux entre le projet et le Clip suit le schéma donné. Le contenu du Clip
n’est pas modifié. Comme cette commande mélange les deux contenus à leur
valeur maximale, faites attention à la distorsion qui pourrait apparaître. Il s’agit
en effet d’une addition, garantissant l’absence de baisses soudaines de volume
de l’échantillon du projet.
Malgré cela, toutefois, vous pouvez toujours avoir à modifier l’amplitude, avant
le mixage, afin d’éviter l’écrêtage/distorsion de l’échantillon résultant du
mélange. Cela peut se faire à l’aide de l’élément de menu Offline Effects >
Amplitude/Normalize.

Append Projects
Cette commande vous permet de placer un projet à la suite d’un autre. Les
données audio de l’un des projets sont alors copiées directement à la suite des
données audio de l’autre.
Sélectionnez tout d’abord le projet dans lequel vous désirez copier les données.
Lancez la commande, puis sélectionnez le projet que vous désirez ajouter au
premier.
Vous pouvez:
– combiner un VIP avec un autre VIP. Cela convient aux grands projets, vous

pouvez en éditer des parties dans différents fichiers pour au final les
recombiner.

– combiner un projet Wave avec un autre projet Wave. Une utilisation
particulière de cette option est le ‘nettoyage’ de VIP contenant beaucoup
d’échantillons physiques.

– combiner un projet Wave avec un VIP. C’est une méthode intelligente pour
transférer des marqueurs d’un projet Wave dans un VIP. Normalement, quand
un projet Wave est chargé dans un VIP, les marqueurs restent à l’intérieur
du fichier audio comme marqueurs audio. Souvent, il est nécessaire d’avoir
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ces marqueurs dans le VIP. Quand vous combinez un projet Wave avec un
VIP, les données audio sont insérées comme un objet à la fin de la piste
active dans le VIP et les marqueurs du projet Wave sont insérés dans le VIP.

Auto Crossfade Active
Une fois cette option activée, toutes les nouvelles données enregistrées ou éditées
dans le VIP ou bien copiées dans le VIP depuis un projet Wave se voient
automatiquement appliquer un fondu d’entrée/de sortie. Si vous avez lancé la
commande «Split Objects», les objets obtenus sont fondus enchaînés, évitant
ainsi des clics au début et à la fin des objets.
Les objets se voient attribuer un réglage global de fondu d’entrée et de fondu de
sortie, réglages qui peuvent être modifiés par le menu Edit > Crossfade Editor.
Ceci peut s’avérer nécessaire si les données audio sont déjà parfaitement propres
et que le fondu nuit à l’attaque de l’échantillon.
Si cette option est cochée et que deux objets se chevauchent, vous obtenez un
fondu enchaîné en temps réel. Si vous ramenez un objet doté d’un fondu par-
dessus un objet le précédant, Samplitude va générer automatiquement un fondu
enchaîné (quand auto crossfade est activé).
Le mode Auto Crossfade est l’outil idéal pour appliquer un fondu linéaire à une
piste de discours ou de jingle, par exemple, qui nécessite une transition douce
exempte de «pops». Vous pouvez, si nécessaire éditer ultérieurement les fondus
enchaînés dans l’éditeur ou en manipulant les poignées de fondu des objets.

Veuillez vous reporter au chapitre «Crossfade Editor» pour obtenir de plus amples
détails.

Delete Curve Handles
Ce sous-menu regroupe des commandes vous permettant de supprimer les
poignées de courbes du projet VIP actif. Description :

Delete Curve Handles > Delete Volume Handle
Cette commande permet de supprimer les poignées préalablement sélectionnées
d’une courbe de volume. Vous pouvez supprimer une par une des poignées de
volume en passant en mode souris Object and Curve puis en double-cliquant
sur les poignées de volume désirées avec le bouton gauche de la souris. Si vous
désirez supprimer plusieurs poignées de volume, utilisez plutôt la commande
‘Delete Volume Handle’ qui convient mieux à cela. Passez en mode de souris
Curve pour sélectionner plusieurs poignées à la fois.

Delete Curve Handles > Delete Panorama Handle
Cette commande permet de supprimer des poignées de panoramique
préalablement sélectionnées. Vous pouvez supprimer des poignées une par une
en passant en mode souris Object and Curve puis en double-cliquant sur les
poignées désirées avec le bouton gauche de la souris. Par contre, si vous désirez
supprimer plusieurs poignées de panoramique, préférez la commande ‘Delete
Panorama Handle’. Passez en mode de souris Curve pour sélectionner plusieurs
poignées à la fois.
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Delete Curve Handles > Delete Surround Handle
Cette commande permet de supprimer des poignées Surround préalablement
sélectionnées. Vous pouvez supprimer des poignées une par une en passant en
mode souris Object and Curve puis en double-cliquant sur les poignées désirées
avec le bouton gauche de la souris. Par contre, si vous désirez supprimer plusieurs
poignées, préférez la commande ‘Delete Surround Handle’. Passez en mode de
souris Curve pour sélectionner plusieurs poignées à la fois.

Delete Undo Levels
Cette commande permet de purger l’historique des opérations d’édition gardées
en mémoire par la fonction Undo (VIP). Il peut être pratique de purger la liste
d’éditions si, par exemple, certains projets Wave y restent référencés alors qu’ils
ne sont plus utilisés par le VIP. Vous ne pourrez pas traiter si supprimer le
projet Wave si l’historique y fait référence, aussi devez-vous vous en débarrasser.
Après avoir supprimé ces niveaux  d’annulation «orphelins», ces projets Wave
redeviendront exploitables librement.
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Le menu Vue regroupe toutes les fonctions permettant de gérer l’affichage de
Samplitude. Vous avez le choix entre différentes options – en sélectionnant
précisément les paramètres d’affichage, vous pouvez personnaliser le contenu
et les fenêtres des boîtes de dialogue en fonction de vos préférences.

Actualiser Formes d’Ondes
Il peut arriver que la représentation graphique des formes d’ondes ou des Projets
présente des inexactitudes ou des erreurs après l’application d’un effet ou d’un
traitement. Ceci peut être dû à différents facteurs, y compris des pilotes
graphiques inadéquats. Même si cette éventualité est rare, vous pouvez corriger
très simplement le problème en lançant la commande Actualiser Formes
d’Ondes. Le contenu graphique de l’écran est alors effacé, puis recalculé en
fonction du Projet.

Sections
Samplitude vous permet d’afficher simultanément une, deux ou trois vues d’un
même projet Wave ou VIP. Avec l’option «2», Samplitude affiche le même
échantillon dans les deux vues. Chaque vue peut être manipulée séparément. Il
est possible, par exemple, d’afficher la totalité de l’échantillon dans une seule
vue et une version zoomée d’une partie de l’échantillon dans l’autre.

L’illustration ci-dessus représente un Projet affiché en mode «3» vues permettant
de visualiser le premier objet de la piste 1 sous différents points de vue.

Remarque  : Il suffit ensuite d’appuyer sur les touches Shift +b pour revenir à la vue 1.
Le mode «3» est l’outil idéal pour localiser les points de bouclage d’un projet Wave.

Vous pouvez afficher l’échantillon dans la totalité de la vue supérieure, le début
de la zone bouclée dans la vue inférieure gauche et la fin de la zone bouclée
dans la vue inférieure droite. Servez-vous de la commande «Ajuster Sélection»
pour cela (touche b).
Il est par ailleurs possible de délimiter des sélections par-dessus plusieurs vues.
Cliquez dans une des vues pour définir le point de départ, puis, tout en
maintenant le bouton enfoncé, faites glisser la souris sur l’autre vue. Il suffit
ensuite de relâcher le bouton de la souris à l’endroit désiré pour fixer le point
final de la sélection. Samplitude vous affiche alors la taille de cette sélection.

Verrouillage vertical
Dans Samplitude, certaines zones peuvent être étirées aussi bien
horizontalement que verticalement. Pour éviter tout étirement fortuit, vous
pouvez fixer le bord supérieur des zones sur la valeur maximale et le bord
inférieur sur la valeur minimale. Vous obtenez alors l’affichage habituel en
déplaçant les zones. Vous perdez toutefois la possibilité de définir tout étirement
vertical d’un segment.
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Montrer/Cacher les Bus
Cette option permet d’afficher ou de masquer les bus (s’il y en a dans le projet).
Vous pouvez obtenir le même résultat au moyen du bouton «Bus» situé dans le
coin supérieur gauche de la fenêtre VIP.
Veuillez vous reporter au chapitre «Utilisation de la Table de Mixage» du Guide
de prise en main pour obtenir de plus amples détails.

Montrer Grille
Cochez cette option pour afficher la grille dans la fenêtre de projet. L’unité de
mesure affichée en haut de la grille dépend du réglage de l’option «Unités de
Temps». La grille vous permet de connaître la position temporelle exacte des
objets et des sélections dans le projet.
En plus de vous renseigner sur la position temporelle dans le Projet, la Grille
peut également vous aider à structurer votre morceau VIP en mesures/temps.
Vous pouvez ainsi réaliser des objets-boucles parfaits à l’aide de la Grille.
La Grille est constituée de lignes verticales affichées à intervalles fixes dans les
Projets VIP et Wave. La fréquence de ces lignes dépend de l’unité de temps
choisie. Exemple : Si la Grille est affichée en Mesures/Temps, les lignes verticales
seront très rapprochées pour indiquer chacun des temps.
Il suffit de zoomer à l’intérieur d’une fenêtre pour que la résolution de la Grille
augmente. Exemple : Pour configurer la Grille à la seconde, il faudra peut-être
faire un zoom avant dans la fenêtre.

L’option de menu Montrer Grille permet d’activer/désactiver l’affichage de la
Grille à l’écran. L’unité de mesure de la Grille (affichée en haut de la Grille)
dépend du réglage de l’option Vue > Unités de Temps. Une échelle de valeurs
en décibels s’affiche par ailleurs à la droite de chaque objet en présence de la
Grille.

Raccourci : #

Type de Grille
Cette option vous permet de sélectionner le type de grille affichée à l’écran (parmi
6) lorsque l’option «Montrer Grille» est cochée.

Unités de Temps
Sélectionnez à l’option «Unités de Temps» l’unité de mesure (parmi 9) dans
laquelle vous désirez afficher les références de la grille. L’unité de mesure choisie
s’affiche au-dessus de la grille. Chaque Projet peut afficher sa Grille dans une
unité de temps qui lui est propre.
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Choix possibles : «Echantillon», «Milliseconde», trois options SMPTE avec
nombre d’images différents, Format MSF pour les CD à la norme Red Book
(SMPTE 75 images), SMPTE/Millisecondes (au lieu des images) et ‘Mesures/
Temps’ pour l’affichage en BPM.

Grille active
Cette fonction vous permet d’activer et désactiver la grille. Dans le cas de projets
virtuels, vous pouvez utiliser la grille d’objet, ainsi que la grille de mesure, la
grille de plage et la grille de fréquence. Dans la grille d’objet, vous pouvez déplacer
des objets au début, à la fin ou sur le point décisif (HotSpot) d’un autre objet.
Dès qu’un point décisif est défini pour un objet, il est automatiquement pris en
compte. Si plusieurs objets ont été sélectionnés, l’alignement s’effectue toujours
sur le point décisif (HotSpot) du dernier objet sélectionné (il se trouve sous le
curseur de la souris). La distance entre les projets sélectionnés reste constante,
c’est-à-dire que tous les objets ne sont pas alignés sur la grille. À l’aide de la
fonction Grille, il devient aisé d’arranger des audio et de conserver des interfaces
toujours synchrones. Les autres types de grilles fonctionnent de manière
semblable. Chaque cellule correspond alors soit à une mesure, soit à une plage,
soit à une fréquence de Timecode. Sélectionnez la grille qui convient aux
opérations que vous souhaitez exécuter dans les paramètres de grille.

Raccourci : Ctrl + #

Paramètres de grille
Cette boîte de dialogue vous permet de sélectionner le type de grille de votre
choix et de l’activer.
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Objet : active la grille d’objet. Elle vous permet de déplacer les objets de manière
synchrone.

Grille de plage : active la grille correspondante et permet d’utiliser la plage
sélectionnée comme base de grille.

Grille de mesure : active une grille ayant les mesures pour base. Permet de
saisir le tempo en BMP. Définissez les propriétés des mesures avec les paramètres
correspondants. La taille d’une mesure peut être définie avec la fonction « Get
range » de la plage actuelle. Il est en outre possible d’indiquer combien de
battements correspondent à la plage actuelle, par exemple 4, si une mesure 4/4
a été sélectionnée. Le tempo (BPM) de la zone sélectionnée correspondante
s’affiche automatiquement.

BPM : permet de subdiviser la grille en battement, soit par exemple, 4 pour 1/16
notes dans une mesure 4/4.

Offset (décalage de grille) : règle le temps de départ de grille par rapport au
temps de départ du VIP.

Paramètres des mesures : entrez ici le type de mesure (numérateur/
dénominateur), le tempo en battements par minute (BPM) et la résolution du
timer en « peaks per quarter » (crêtes par  noire).

Utiliser l’offset pour la grille : le décalage de la grille devient ici le point de
référence de la grille.

Grille on/off : permet d’activer ou désactiver la grille globale, selon la grille
active (Ctrl+r).

Mode d’Affichage VIP
L’option Mode d’Affichage VIP vous permet de personnaliser librement
l’affichage des projets VIP. Vous avez la possibilité de passer d’une configuration
(mode) à l’autre.  En général, choisissez le mode 1 pour afficher une
représentation détaillée de la forme d’onde des échantillons et le mode 2 pour
un affichage rapide sans forme d’onde. Pourquoi pas également réserver le
mode 1 pour afficher les formes d’ondes mono sur leur moitié et le mode 2
pour l’affichage des formes d’ondes dans leur totalité et en double stéréo. Il
suffit d’appuyer sur la touche de tabulation pour passer d’un mode d’affichage
à l’autre.
Vous pouvez également passer directement d’un mode à l’autre en sélectionnant
l’option Mode 1 ou Mode 2 du sous-menu Mode d’Affichage VIP. Pour accéder
à la fenêtre de configuration des modes d’affichage ci-dessous, sélectionnez
l’option Définitions :
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Comme le montre l’illustration, les deux modes d’affichage proposent les mêmes
réglages répertoriés côte à côte pour une meilleure comparaison. Le mode en
vigueur se sélectionne au moyen du menu déroulant placé en haut de la fenêtre.

Affichage forme d’onde
Tracer Forme d’onde : Active la représentation graphique des échantillons
audio. En général, laissez cette option activée. Vous pouvez toutefois la désactiver
pour mieux visualiser les courbes de volume et de panoramique.

Remarque : si le mode Dessin 2 (voir ci-dessus) est activé, l’affichage sinusoïdal sera
désactivé dans les paramètres standard. Vous pouvez cependant modifier ces
derniers à tout moment.

Suivre Fades/Courbes : Cette option est cochée par défaut pour que les
représentations graphiques de formes d’ondes évoluent avec les courbes de Fade
d’entrée/sortie ou des courbes de volume. Ainsi, toute baisse ou hausse du
volume provoquée par une courbe ou un Fade est visible directement à l’écran.
Même si la plupart des utilisateurs laissent cette option activée, vous pouvez la
décocher afin que les formes d’ondes ne changent pas à l’écran.

Demi Alternance : Il est possible d’afficher les formes d’ondes dans leur totalité
ou seulement sur leur moitié pour une plus grande résolution. Si vous préférez
cette deuxième option, cochez la case Demi Alternance.
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Cette option est recommandée car la Grille (raccourci: # ) et les fonctions de
Zoom vertical (Ctrl + curseur haut/bas) sont parfaitement adaptées à ce mode
d’affichage. Les courbes de volume sont, elles aussi, mieux visibles dans ce mode.

Séparer Stéréo : Cochez cette option pour que les pistes stéréo des projets VIP
s’affichent sous la forme d’une double forme d’onde. Vous pouvez ainsi visualiser
les deux canaux au lieu d’un simple canal composite.

Tracer Contour : Cochez cette option pour qu’un contour se dessine autour
de la forme d’onde. Cela offre en général un meilleur confort de visualisation
des formes d’ondes.

Standard : Cochez cette case pour passer sur le mode d’affichage par défaut
des formes d’ondes.

L’affichage des fondus croisés est défini dans la deuxième colonne.

Contour seul : Cochez cette case pour que seul le contour de la forme d’onde
soit affiché à l’écran. Vous pouvez ainsi mieux visualiser des formes d’ondes
qui se chevauchent et ainsi faciliter la réalisation des Crossfades.

Transparent : Cochez cette case pour que les couleurs des deux formes d’ondes
du Crossfade se superposent. Ce réglage donne de meilleurs résultats avec un
fond noir (mis par défaut). Pour un affichage optimal des zones de Crossfade,
nous vous recommandons d’associer ce mode à l’option Couleurs des formes
d’ondes > Alternance Rouge/Bleu.

Entrelacé : Cochez cette case pour qu’il y ait une alternance entre un échantillon
de l’objet gauche et un échantillon de l’objet droit sur la zone du Crossfade.
Vous pouvez ainsi mieux évaluer la longueur du Fade, tout particulièrement si
les deux objets en question sont de couleur différente.

Couleurs des formes d’Onde

Paramètres de couleurs par défaut : Si vous n’avez pas modifié les réglages
de couleurs par défaut (menu Options > Préférences Programme > Couleurs >
Utiliser les couleurs par défaut),

Alternance Rouge/Bleu : Cochez cette option pour que les formes d’ondes
d’objets adjacents s’affichent en rouge et bleu afin de mieux visualiser les
Crossfades en modes Transparent et Entrelacé (voir ci-avant).

Couleurs Comparisonics : Cette option emploie un algorithme d’affichage
breveté Comparisonics™  qui permet d’afficher les données audio dans différentes
couleurs. Chaque segment audio peut prendre une teinte différente selon sa
hauteur et d’autres variables.
Les notes graves sont de couleur bleue alors que les notes aiguës sont de couleur
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verte/jaune/rouge. Les données audio «musicales» ont une couleur franche et
nette alors que le bruit et les autres phénomènes audio prennent une teinte plus
ou moins grise. Vous pouvez ainsi reconnaître directement les différentes
hauteurs de jeu d’un saxophone ou détecter des interférences impossibles à
reconnaître sur un affichage graphique traditionnel. Vous pouvez indiquer la
taille des segments audio au paramètre «Taille des segments Comparisonics» (situé
en bas à droite de la fenêtre Mode d’affichage). Nous vous recommandons
d’indiquer une valeur de 50 ms minimum pour être certain de disposer de
suffisamment de données audio par segment.
Grâce à l’algorithme Comparisonics, vous pouvez rechercher des Projets HD
Wave de manière totalement novatrice par le biais de l’option Menu Sélection >
Recherche Audio Comparisonics. Celle-ci permet en effet de retrouver des données
audio identiques ou proches entre des projets HDP. Veuillez vous reporter au
chapitre Menu Sélection pour obtenir de plus amples détails.

Remarque : Vous pouvez trouver de plus amples renseignements sur l’algorithme
Comparisonics à l’adresse www.comparisonics.com.

Couleurs de groupe : une couleur différente est affectée à chaque groupe,
aléatoirement, lors de la création. Cela permet de les distinguer facilement.

VIP

Différents composants du VIP (commande, curseur, crête-mètre, cadres, texte)
peuvent être activés ou désactivés. Les commandes et curseurs de régulation
correspondent à la boîte de dialogue des pistes, avec toutes les commandes de
mixage, les curseurs des canaux, les boutons Auto et Solo, etc. Si vous conservez
en permanence la fenêtre de mixage ouverte en plus de la fenêtre du VIP, vous
pouvez renoncer à certains éléments de commande identiques aux deux fenêtres,
afin d’alléger la présentation. Par exemple, le crête-mètre.

Attention : si vous masquez le cadre des pistes, la mise en relief de la piste sélectionnée
disparaît également !

Le texte de l’arrangement sert à marquer les deux zones d’édition en mode souris
Universel (plage/objet).

Position d’origine : les positions d’origine ont été définies au début de l’objet
dans le format du Timecode. Un comparatif de la valeur dans l’objet avec la
position sur l’axe temporel ou le Timecode permet par conséquent de comprendre
plus facilement les écarts dans la synchronisation.

Highlight Crossfades : ce paramètre permet de rendre visibles les fondus
enchaînés entre les objets.

http://www.comparisonics.com
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Objets

Arrière-plan : Cochez cette case pour que les objets soient affichés dans une
couleur différente du projet VIP. Sinon, les objets sont de la même couleur que
le fond. Vous pouvez donner une couleur précise à chaque objet au menu Objet
ou au l’èditeur objet.

Nom d’Objet : Cochez cette case pour que le nom de l’objet apparaisse dans
celui-ci. Si vous ne la cochez pas, son nom n’apparaît pas. Vous pouvez donner
un nom à chaque objet depuis le menu Objet.

Larges Poignées : Cette option permet d’afficher en plus gros les poignées des
objets et des courbes de volume/panoramique.

Nom du Projet : Cochez cette case pour afficher à l’intérieur de chaque objet le
nom du fichier audio utilisé. Cette fonction permet de retrouver immédiatement
quel fichier audio est utilisé par quel objet.

Propriétés d’objet : Cochez cette case pour afficher les effets appliqués à l’objet
(EQ correspond au correcteur, DYN au processeur de dynamique, etc.).

Numéro de groupe : Il est possible de regrouper plusieurs objets d’une fenêtre
VIP en un seul bloc. Il peut être pratique de connaître à quel bloc appartient tel
ou tel objet. Cochez cette case pour afficher le numéro de bloc dans les objets.

Bouton Verrou d’objet : Cette option permet d’afficher une clé dans la partie
inférieure de chaque objet. Cette clé permet de modifier en toute simplicité
l’état verrouillé/libre d’un objet par simple clic sur celle-ci. Cette clé ne s’affiche
pas à l’écran si l’objet est trop court.

Clé rouge : L’objet est verrouillé Clé jaune : L’objet peut être déplacé

Marqueurs audio : cette fonction vous permet d’afficher dans les objets les
marqueurs disponibles dans les projets Wave sous-jacents.

Souris

Ajuster le curseur de la souris : cette option permet la modification de l’apparence
du curseur de la souris selon l’objet sur lequel il se trouve. Ce paramètre n’est
utile que pour les modes de souris dans lesquelles plusieurs fonctions de souris
sont réunies.
Dessine pendant le déplacement : l’interface utilisateur est actualisée pendant
le déplacement avec la souris. Sur des ordinateurs peu performants, cela peut
provoquer, dans de rares cas, des erreurs de lecture.
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Pas de modification de la taille du VIP pendant le zoom : si le VIP est
agrandi au-delà de sa taille totale (début au premier objet, fin au dernier), il sera
automatiquement allongé. Vous pouvez contrôler cette action ici.

2e clic pour déplacement d’objet requis : cette option permet le déplacement
d’objets seulement avec un deuxième clic de souris. Le premier clic sélectionne
l’objet, mais il n’est pas déplacé.

Retard de déplacement : si un objet à été sélectionné (clic gauche dans la
partie inférieure de l’objet) et que le retard de déplacement est désactivé, l’objet
peut être déplacé par mégarde. Si le retard de déplacement est activé, Samplitude
attend le temps indiqué avant d’exécuter le déplacement.

Défilement des bords du VIP : si cette fonction est activée, le défilement permet
de déplacer dans le projet un objet ou le bord d’une zone dans les limites du
projet virtuel. Cela facilite, par exemple, la sélection de grandes zones, dont la
taille a été fortement augmentée via le zoom. Si le défilement des bords du VIP
est désactivé, seul le segment actuel du VIP s’affiche alors et seul le défilement
horizontal devient possible.

Raccourci : Shift + Tab

Mémoriser Position et Zoom
Cette commande permet de sauvegarder des réglages de position et de zoom
pouvant être ensuite rappelés au moyen des 8 boutons situés dans le coin
inférieur gauche de la fenêtre VIP, de la commande Vue > Restaurer Position et
Zoom ou au moyen du pavé numérique de votre clavier. Pour effacer un réglage
de position/zoom en mémoire, appliquez un clic droit sur le bouton VIP
correspondant ou affectez-y de nouveaux réglages.
Les raccourcis clavier permettant de sauvegarder des réglages de position/zoom
sont affichés dans l’illustration ci-dessus.

Remarque : N’oubliez pas qu’un clic droit EFFACE le réglage de position/zoom affecté
au bouton. Vous risquez sinon de supprimer accidentellement vos réglages préférés.

Mémoriser Zoom
Cette commande permet de sauvegarder des réglages de zoom pouvant être
ensuite rappelés au moyen des 4 boutons situés dans le coin inférieur gauche
de la fenêtre VIP, de la commande Vue > Restaurer Zoom ou au moyen du pavé
numérique de votre clavier. Pour effacer un réglage de zoom en mémoire,
appliquez un clic droit sur le bouton VIP correspondant ou affectez-y de nouveaux
réglages. Les raccourcis clavier permettent de sauvegarder des réglages de zoom.
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Remarque : N’oubliez pas qu’un clic droit EFFACE le réglage de zoom affecté au
bouton. Vous risquez sinon de supprimer accidentellement vos réglages préférés.

Restaurer Position et Zoom
Cette commande permet de rappeler l’un des 4 réglages de position et de zoom
précédemment sauvegardés au moyen de la commande Vue > Mémoriser
Position et Zoom. Ces réglages peuvent également être rechargés au moyen des
8 boutons situés dans le coin inférieur gauche de la fenêtre VIP ainsi que du
pavé numérique de votre clavier. Pour effacer un réglage de position/zoom en
mémoire, appliquez un clic droit sur le bouton VIP correspondant ou affectez-
y de nouveaux réglages.
Les raccourcis clavier permettant de recharger les réglages de position/zoom
sont affichés dans l’illustration ci-dessus.

Remarque : N’oubliez pas qu’un clic droit EFFACE le réglage de position/zoom affecté
au bouton. Vous risquez sinon de supprimer accidentellement vos réglages préférés.

Restaurer Zoom
Cette commande permet de rappeler l’un des 4 réglages de zoom précédemment
sauvegardés au moyen de la commande Vue > Mémoriser Zoom. Ces réglages
peuvent également être rechargés au moyen des 4 boutons situés dans le coin
inférieur gauche de la fenêtre VIP ainsi que du pavé numérique de votre clavier.
Pour effacer un réglage de zoom en mémoire, appliquez un clic droit sur le
bouton VIP correspondant ou affectez-y de nouveaux réglages.
Les raccourcis clavier permettant de rappeler des réglages de position/zoom
sont affichés dans l’illustration ci-dessus.

Remarque : N’oubliez pas qu’un clic droit EFFACE le réglage de position/zoom affecté
au bouton. Vous risquez sinon de supprimer accidentellement vos réglages préférés.
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Horizontal
Ce sous-menu regroupe toutes les fonctions portant sur la barre de défilement
horizontale (barre rouge) ainsi que sur d’autres options d’affichage horizontal.

Vertical
Ce sous-menu regroupe toutes les fonctions portant sur la barre de défilement
verticale (barre bleue) ainsi que sur d’autres options d’affichage vertical.
Les noms des différentes options parlent d’eux-mêmes comme le montre l’illustration
ci-dessus. Nous vous conseillons de tester les différentes options d’affichage vertical par
le biais du sous-menu Vertical, des barres d’outils et des raccourcis clavier afin de
trouver la méthode qui vous convient le mieux.
Faites tout de même preuve de patience et de persévérance – le temps passé à
configurer vos préférences d’affichage sera gagné au centuple par la vitesse avec
laquelle vous manipulerez ensuite vos Projets Samplitude.
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Ce menu regroupe de nombreuses fonctions relatives aux pistes d’un VIP.

Insert new Tracks > Add one Track
Ajoute une nouvelle piste au VIP après la dernière piste existante du projet VIP.

Insert new Tracks > Add several Tracks
Ajoute plusieurs pistes après la dernière piste existante du projet VIP.
Le nombre de pistes doit être saisi dans une petite fenêtre de dialogue avant
ajout au projet.

Insert new Tracks > Insert empty track

Insère une piste vide dans le projet sous la piste sélectionnée.

Insert new Tracks > New Submix Bus
Cette commande ajoute un bus SubMix (prémixage ou sous-groupe) à la suite
de la piste sélectionnée.
Un bus Submix est une piste à part entière (avec correcteur, effets, Plug-ins)
mais qui peut se voir affecter le signal d’autres pistes de numéro inférieur. Dès
qu’un bus SubMix est créé, il est répertorié dans la liste des périphériques de
sortie possibles pour toutes les pistes de numéro inférieur.
Vous pouvez trouver plus de détails à ce sujet dans le chapitre consacré à la
table de mixage!

Insert new Tracks > New AUX Bus
Cette commande ajoute un bus auxiliaire au projet à la suite de la piste
sélectionnée.
Un bus auxiliaire (ou Aux) est une piste à part entière (avec correcteur, effets,
Plug-ins) mais qui peut se voir affecter le signal d’autres pistes de numéro
inférieur, avec réglage du niveau de départ (au moyen des curseurs Gain de
départ Aux de la table de mixage). Dès qu’un bus auxiliaire est créé, il est
répertorié dans la boîte de dialogue AUX Routing de toutes les pistes de numéro
inférieur.
Vous pouvez aussi envoyer des objets aux auxiliaires, une possibilité remarquable
pour automatiser les effets Aux.
Référez-vous au chapitre sur la table de mixage pour des détails!

Insert new Tracks > New Surround Bus
Vous pouvez aussi mixer votre projet en version surround. Utilisez cette
commande pour créer un bus surround. Toutes les pistes dirigées vers un bus
surround disposent du module de panoramique surround à la place du fader
normal de panoramique pour régler le niveau de sortie de la piste. Dès qu’un
bus surround est créé, le signal de sortie de chaque objet peut aussi être
individuellement dirigé vers ce bus et positionné dans l’espace surround
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indépendamment des réglages de panoramique de la piste (surround d’objet).
Le master surround est créé simultanément quand un bus surround est créé;
les voies sont dirigées individuellement vers les différents périphériques de sortie
(vous trouverez des détails dans  Project Surround Setup dans l’aide en ligne).

Insert new Tracks > New Surround AUX Bus
Cette commande vous permet de créer un nouveau bus Aux surround.
Les bus Aux servent généralement à la mise en œuvre de départs d’effet. La
fonction d’un bus Aux surround est la même, améliorée par la possibilité
d’inclure des effets surround. Il peut recevoir des voies normales (voir le
traitement stéréo et mono dans les projets surround) ou un bus surround de
numéro inférieur (par rapport au numéro de voie). Le bus Aux peut lui-même
être envoyé à un bus surround d’une voie de numéro supérieur.

Cut Track(s)
La sélection (Range) déterminée est coupée dans toutes les pistes et copiée dans
le presse-papier Virtualité.
Si aucune sélection temporelle n’est faite, c’est la piste sélectionnée qui est
coupée.

Copy Track(s)
La sélection (Range) déterminée est copiée de toutes les pistes dans le presse-
papier Virtualité.
Si aucune sélection temporelle n’est faite, c’est la piste sélectionnée qui est copiée.

Insert Track(s)
Toutes les pistes du VirtClip sont insérées dans le VIP actuel au dessus de la
piste sélectionnée ou de la sélection temporelle (Range).

Delete Track(s)
Toutes les pistes du VIP couvertes par une sélection sont supprimées du VIP.
Si aucune sélection n’est faite, c’est la piste active qui est supprimée.

Track Properties
Ce sous-menu donne accès à toutes les propriétés de la piste (cela peut aussi se
faire en cliquant sur le bouton correspondant dans le panneau d’informations
au début de la piste correspondante en fenêtre VIP). Le but principal du menu
est de réaffecter les raccourcis-clavier aux fonctions de Samplitude. Cela vous
permet de piloter Samplitude depuis le clavier.
De plus, le menu vous permet aussi de changer de type de piste, pour en faire
un bus Aux ou SubMix.
Toutes les options de menu affectent la piste sélectionnée (c’est-à-dire celle
surlignée en rouge).

Commande Description
Raccourci
Mute Coupe la piste
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Alt + M
Mute inactive Coupe et désactive la piste (augmente les performances

par libération de ressources puisqu’au cache ni  traitement
d’effet n’est plus nécessaire pour cette piste)

Solo Coupe toutes les pistes non mises en solo
Ctrl + Alt + S
Solo exclusive Coupe toutes les autres pistes
Alt+S
Record Arme la piste pour l’enregistrement
Alt+R
Record Type Règle sur audio ou MIDI le type d’enregistrement pour la

piste et sur stéréo, mono ou réduction mono
l’enregistrement audio

Force Monitoring Commute l’écoute de contrôle (monitoring) de la piste
(Voir Menu Play/Rec > Monitoring pour des détails)

Lock Verrouille la piste. Aucun déplacement ou changement
de longueur d’objet n’est permis.
Volume Curve active Affiche/masque la courbe de volume

Pan Curve active Affiche/masque la courbe de panoramique

Edit Volume Ouvre le champ de saisie numérique du volume
Edit Pan Ouvre le champ de saisie numérique du panoramique
SubMix Bus Transforme la piste en bus SubMix

Aux Bus Transforme la piste en bus Aux

Mute Bus Inputs Coupe l’entrée d’un bus, sa sortie restant active
Global Mute/ Solo Active/désactive tous les statuts mute/ solo des pistes

Track Effects
Cette option permet d’appliquer (comme avec les voies de la table de mixage)
des effets en temps réel à la piste sélectionnée dans Samplitude. Vous pouvez
trouver de plus amples détails sur les effets dans le chapitre «Effets».

Track Effects > Track Routing Dialog
Ouvre la fenêtre de routage des effets de la piste.
Souvent, vous utilisez le bouton FX du panneau de propriétés de la piste (à
gauche de celle-ci) plutôt que cet élément de menu (les deux accomplissent la
même fonction). L’emploi du menu peut être plus pratique dans certaines
situations, comme quand le nombre de pistes du projet est élevé et le zoom
insuffisant (le bouton FX n’est pas toujours visible).
Pour des détails concernant la fenêtre de routage des effets, lisez le chapitre sur
les effets de Samplitude dans le manuel.

Track Effects > Copy/Paste Track Effects Settings
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Cette commande vous permet de copier la totalité des réglages d’effet de la piste
active dans le presse-papier (afin de les coller dans une autre piste). Cela
comprend l’ordre, et les réglages de paramètres, de tous les effets internes (EQ,
Dynamics, Delay/Reverb...) et des plug-ins utilisés.
Vous pouvez aussi accomplir cette fonction avec les boutons à icônes Copier/
Coller de la fenêtre de routage d’effets (Effect routing) de la piste.

Track Effects > Reset Track Effects settings
Ramène tous les réglages d’effets de la piste à leur valeur par défaut – c’est-à-
dire qu’aucun effet n’est appliqué. Y Vous pouvez aussi accomplir cette fonction
avec les boutons «Reset» de la fenêtre de routage d’effets (Effect routing) de la
piste.

Track Effects > Aux Sends
Ouvre la fenêtre de routage des départs AUX pour la piste. Reportez-vous au
chapitre du manuel sur la table de mixage pour des détails!

Track Effects > Track Dynamics/Distortion/Delay/Reverb/EQ/
Plug-ins/Dehisser/FFT Filter/Multi-band Dynamics/Advanced
Dynamics/Multi-band Enhancer/Amp Simulation/Room
simulation
Veuillez vous référer au menu Effects pour de plus amples détails.

Pan/Surround Editor
Cette commande ouvre le module de panoramique surround. Si vous travaillez
en mode Master stéréo normal, alors ce sont les réglages de panoramique des
pistes stéréo qui sont affichés. Vous trouverez plus d’informations sur le module
de panoramique surround dans le chapitre «Surround«.
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Track Information
Ouvre la fenêtre de propriétés de la piste, avec les options suivantes:

Audio
Output (périphérique audio): Un menu déroulant pour sélectionner la carte
audio (ou la sortie stéréo spécifique pour les cartes à sorties multiples) servant à
la reproduction de la piste.

Record (périphérique audio): Un menu déroulant pour sélectionner la carte
audio (ou l’entrée stéréo spécifique pour les cartes à sorties multiples) servant à
l’enregistrement de la piste.

Vous pouvez personnaliser les noms de périphériques apparaissant ici ainsi
que désactiver les périphériques (comme la carte son intégrée du PC) que vous
n’utilisez jamais avec Options > System > Playback ou Record devices. Les
périphériques audio sont toujours organisés par paires stéréo.

All tracks: Ce bouton (juste à droite des deux menus déroulants) vous permet
de rapidement assigner toutes les pistes audio à la lecture ou à l’enregistrement
via la carte audio (ou la sortie stéréo) sélectionnée.

Track/Dev +: En cliquant sur ce bouton, vous passez à la piste suivante et lui
assignez en même temps le périphérique audio suivant pour la lecture ou
l’enregistrement. Si une piste est armée pour l’enregistrement et si vous cliquez
sur ce bouton pour le périphérique d’enregistrement, ce statut est aussi repris
par la piste suivante. Le bouton + entre les deux boutons règle à la fois le
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périphérique de lecture et celui d’enregistrement.

Track Type: Ici se détermine le type de piste, bus aux ou bus submix. Vous
pouvez changer le type de piste dans le menu Track avec Track Properties.

2 Channel Surround active: Cochez cette case pour appliquer à la piste un
son surround à 2 canaux. Vous en saurez plus sur ceci dans le chapitre Surround.

Effects/Routing: Ouvre la fenêtre de routage d’effet pour la piste.

MIDI
Playback Dev: Sélectionne le périphérique de reproduction MIDI pour la piste.

Record Dev.: Sélectionne le périphérique d’enregistrement MIDI pour la piste.

All Tracks: Règle le périphérique de lecture/enregistrement MIDI pour toutes
les pistes.

Global MIDI Options: Ouvre la fenêtre des options MIDI.

Bar /Beats (project): Ouvre la fenêtre de définition de mesure.

Automation/Controller: Ouvre la fenêtre des réglages de courbes
d’automation pour les contrôleurs MIDI / VST.

Record Controller Curves: Permet l’enregistrement de courbes de contrôleur
MIDI depuis des périphériques MIDI.

Playback/Thru Parameters: Les données reçues en MIDI IN sont renvoyées
en MIDI OUT. Les événements MIDI sont reçus sur tous les canaux ou sur un
canal spécifique, déterminé par le paramètre In Chan. Les événements peuvent
être transmis sur leur canal d’origine ou sur un autre (déterminé par Out Chan.).
De plus, une transposition (Transp.), un changement de programme (Program)
et de banque (Bank) peuvent être transmis. La transposition affects tous les
objets MIDI dans la piste.

MIDI Thru active: Permet le renvoi  MIDI pour la piste.

Record
File: Vous pouvez saisir dans ce champ le nom du fichier audio que vous allez
enregistrer. Cliquez sur le bouton à dossier jaune pour ouvrir le navigateur
standard Windows servant à nommer/ rechercher des fichiers. Normalement,
ces fichiers sont nommés en ajoutant au nom de VIP un numéro suffixe
correspondant au numéro de piste et ils sont créés dans le sous-dossier du VIP.
Quand vous éditez la totalité de votre enregistrement dans le VIP comme prévu
par le concept de travail virtuel de Samplitude, il n’est pas nécessaire de changer
quoi que ce soit ici. Néanmoins vous le pouvez: en cliquant sur le bouton dossier,
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vous pouvez saisir un nouveau nom ou choisir un nouvel emplacement pour le
fichier audio.

Record only to RAM: Cochez (activez) cette option pour enregistrer dans la
RAM de votre système (enregistrement en RAM) plutôt que sur le disque dur
(enregistrement sur disque dur). N’employez cette option que pour des
enregistrements très courts! Veillez à ne pas saturer la RAM de votre système
sous peine de voir ce dernier devenir lent et instable.

All tracks: Avec ce bouton, vous pouvez rapidement nommer/renommer les
fichiers d’enregistrement pour toutes les pistes. Plusieurs conventions
d’appellation différentes sont possibles pour bâtir le nom à partir du numéro de
piste, du nom de piste, du nom de projet ou du nom de fichier saisi dans le
champ prévu à cet effet.

Stereo: Cliquez sur cette option pour enregistrer depuis un périphérique d’entrée
stéréo dans un projet Wave stéréo.

Mono: Cliquez sur cette option pour enregistrer dans un projet Wave mono. Si
vous sélectionnez cette option, le sélecteur de périphérique d’enregistrement
audio passe aux périphériques mono, en réalité de canal gauche ou droit d’une
paire d’entrée stéréo. Prenez garde à sélectionner le bon (L pour gauche ou R
pour droit).

Mono (Mixdown): Cliquez sur cette option pour enregistrer depuis un
périphérique d’entrée stéréo dans un projet Wave mono en faisant l’addition du
contenu des deux canaux et en appliquant une atténuation de -6 dB.

Rec: Ces deux boutons radio de mode d’enregistrement vous permettent de
choisir l’enregistrement entre audio et MIDI. Bien que vous puissiez employer
une piste pour une reproduction mixte audio/MIDI, vous ne pouvez pas
enregistrer les deux types de données en même temps sur une même piste.

Track name
Vous pouvez saisir ici un nom pour la piste. Quand vous ouvrirez la table de
mixage, ce nom servira à identifier la voie de la table de mixage associée à cette
piste. Utilisez les boutons << / >> pour rapidement passer d’une piste à l’autre,
afin de configurer toutes vos pistes sans chaque fois refermer et réouvrir cette
fenêtre.

MIDI Controllers/VST Automation…
Veuillez vous référer au chapitre sur le travail avec le MIDI dans Samplitude.

Track Visualization
La visualisation depuis la fenêtre de menu peut être réglée en affichage Master
ou en affichage de piste. Pour plus d’informations sur les différentes vues
possibles, veuillez vous référer au chapitre «Menu Window».
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Hide Track
Masque la piste sélectionnée dans l’affichage de VIP. La piste reste visible dans
la table de mixage et est toujours reproduite.
Une vue générale de toutes les pistes avec leur statut de visibilité est disponible
dans le gestionnaire de pistes (Track Manager: menu «Tools» > Manager > Track
Manager ou par raccourci clavier «Ctrl+Shift+S»). Cela vous permet aussi de
masquer une piste dans la table de mixage.

Minimize Track / Maximize Track / Minimize none
Minimize track: Cette option réduit l’affichage de la piste sélectionnée. Cela
peut aussi se faire avec le bouton + dans le panneau de la piste en fenêtre VIP.

Maximize Track: Cette option réduit l’affichage de toutes les pistes sauf celui
de la piste sélectionnée. La piste sélectionnée subira le plus gros zoom vertical
possible.

Minimize none: Cette option annule la réduction pour toutes les pistes.

Track Freeze/Edit Track Freeze/Track Unfreeze
Veuillez vous référer au chapitre «Freeze» pour plus de détails!

Activate next track
Déplace la sélection de piste vers le bas.
Sinon, vous pouvez employer les touches Alt+ curseur bas.

Activate previous track
Déplace la sélection de piste vers le haut.
Sinon, vous pouvez employer les touches Alt+ curseur haut.
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Contrairement au menu Edit, toutes les commandes de ce menu agissent
exclusivement sur les objets sélectionnés d’un projet virtuel. Les sélections
temporelles (Ranges) permettent uniquement de fixer le point à partir duquel
les objets doivent être insérés ou retirés. Lorsque vous insérez des données dans
un projet virtuel, le début de la sélection temporelle prend la même fonction
que la tête de lecture – les données sont donc insérées au point de départ de la
sélection.
La plupart des opérations d’édition des objets portent en général sur le découpage
et le dimensionnement des objets. Dans cette optique, le caractère virtuel de
Samplitude est un atout considérable – les fichiers audio Wave correspondants
ne sont jamais modifiés. Vous êtes ainsi libre d’expérimenter à loisir sans aucun
risque.
Autre fonction d’exception, l’éditeur d’objet est l’un des atouts de Samplitude
qui permet de traiter chaque objet individuellement.

New Object
Cette commande crée un nouvel objet virtuel. Vous devez tout d’abord avoir
délimité une sélection temporelle (Range) sur la portion exacte du fichier Wave
à reprendre dans le VIP. Les données sélectionnées du projet Wave sont insérées
dans le projet virtuel au niveau de la tête de lecture. Une fois inséré, ce nouvel
objet est automatiquement sélectionné. Vous pouvez obtenir le même résultat
avec la méthode du glisser/déposer pour importer des projets Wave dans les
pistes de VIP.

Note: L’objet est inséré dans le projet VIP au niveau de la sélection dans le VIP. En
l’absence de sélection, c’est sur la piste 1 et au niveau de la tête de lecture qu’est inséré
l’objet.

Cut Objects > Cut Objects
Cette commande transfère le(s) objet(s) sélectionné(s) dans le VirtClip et le(s)
remplace par un espace vide dans le projet VIP. La longueur du projet ne change
pas et tous les autres objets non sélectionnés conservent leur position. Le ou les
objets coupés remplacent les données que contenait précédemment le VirtClip.

Cut Objects > Copy Objects
Cette commande fait une copie de l’objet sélectionné et la place dans le VirtClip.
Il est dès lors possible d’insérer cette copie ailleurs dans le projet VIP au moyen
de la commande Cut Objects > Insert Objects (voir ci-dessous). Le ou les objets
coupés remplacent les données que contenait précédemment le VirtClip.
Note: Vous pouvez également copier/coller un objet en le faisant glisser à la souris
tout en tenant enfoncée la touche Ctrl de votre clavier.

Cut Objects > Insert Objects
Cette commande permet d’insérer dans le projet VIP, au niveau de la tête de
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lecture, le ou les objets placés dans le VirtClip. Les autres objets du projet VIP
conservent leur position. Attention : Il se peut que l’objet inséré recouvre certaines
portions d’autres objets du projet VIP. Faites alors glisser le nouvel objet à un
autre endroit de la piste ou sur une autre piste.

Cut Objects > Delete Object
Cette commande supprime du projet en cours les objets sélectionnés. Toutefois
la longueur du projet ne change pas, les objets non sélectionnés conservent leur
position et le contenu du VirtClip n’est pas remplacé.

Cut Objects > Extract Object
C’est l’inverse de Delete Object. Tous les objets non sélectionnés sont supprimés.
Sachez que cette fonction est similaire à la commande Edit > Extract. La différence
entre les deux, c’est que la fonction du menu Edit nécessite une sélection
temporelle (Range) préalable.

Cut Objects > Duplicate Objects (in place)
Cette commande fait une copie des objets sélectionnés. La réplique créée reste
placée au-dessus de l’objet d’origine afin de pouvoir la déplacer très facilement
à l’endroit désiré à l’aide de la souris. Si vous aviez sélectionné plusieurs objets,
appuyez sur la touche Shift avant de les faire glisser pour que toutes les répliques
d’objets sélectionnées se déplacent en même temps.
Cette commande ne fait pas appel au VirtClip, son contenu n’est donc pas
modifié.
Sachez que vous pouvez obtenir le même résultat avec votre souris. Maintenez
enfoncée la touche Ctrl, cliquez sur l’objet que vous désirez dupliquer, puis
faites-en glisser une copie ailleurs dans le projet.
Vous pouvez sinon utiliser la fonction glisser/déposer pour l’objet du mode
souris universel:
Si vous avez sélectionné plusieurs objets, appuyez sur la touche Ctrl et faites
glisser les objets sélectionnés vers une autre position. Cela vous permet de faire
rapidement et simplement de nombreuses copies des objets sans passer par le
VirtClip.

Cut Objects > Duplicate Objects
Tous les objets sélectionnés sont dupliqués, c’est-à-dire qu’une copie en est
faite et est placée derrière l’ancien objet (selon la grille).
Cette commande est aussi disponible dans l’éditeur MIDI.
La duplication est aussi possible par glisser/déposer (en mode objet ou en mode
universel):
Si plusieurs objets ont été sélectionnés avant duplication, la touche Ctrl doit
être pressée avant le déplacement qui suit la duplication pour que tous les objets
restent sélectionnés et soient déplacés ensemble.
Ainsi, les objets peuvent être reproduits directement sans passer par le VirtClip.

Raccourci: Ctrl+D
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Cut Objects > Duplicate Objects multiple....
Cette commande vous permet de faire plusieurs copies du ou des objets
sélectionnés. Une boîte de dialogue s’affiche à l’écran (voir ci-dessous). Indiquez-
y le nombre de copies désiré, la distance entre les objets dupliqués, et la durée
cumulée des copies. C’est une méthode très efficace pour rapidement créer des
projets à base de boucles.

Number of Objects: Indiquez le nombre de copies désirées.

Group created Objects: Cochez cette case pour que les copies créés soient
regroupées en un seul bloc.

Delta Time: Détermine l’intervalle relatif séparant chaque objet créé du suivant
(du début d’un objet au début du suivant). Le réglage par défaut est la longueur
de l’objet sélectionné. Avec le réglage par défaut, les objets dupliqués sont
adjacents, ce qui donne une boucle parfaite.

Duration: Sinon, la durée peut être spécifiée ici, combinant l’intervalle de temps
et le nombre d’objets dupliqués.

Cut Objects > Split Object On Marker Positions
L’objet est découpé en plusieurs objets au niveau de tous les marqueurs du VIP
placés entre les limites de l’objet.
Les nouveaux objets ont les mêmes propriétés d’objet (effet, volume d’objet,
couleur...tous les réglages de l’éditeur d’objet).

Cut Objects > Split Object On Track Marker Position
L’objet est découpé en plusieurs objets au niveau de tous les marqueurs de
plages de CD placés entre les limites de l’objet.
Les nouveaux objets ont les mêmes propriétés d’objet (effet, volume d’objet,
couleur...tous les réglages de l’éditeur d’objet).

Split Objects
Cette fonction divise ou fractionne les objets sélectionnés pour que des sections
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d’objet puissent être individuellement manipulées. Tous les objets sélectionnés
sont fractionnés à la position actuelle de la tête de lecture, ce qui donne deux
objets indépendants.
Lorsqu’une sélection temporelle (Range) est délimitée sur un objet, cette
commande permet de couper un objet au niveau du début et de la fin de la
sélection. Il n’est pas nécessaire de sélectionner les objets avant de faire la
sélection temporelle et d’appeler cette fonction. Tous les objets affectés par cette
sélection seront de toute façon fractionnés. Si un objet sous-jacent est divisé, le
nouvel objet créé couvre l’objet sous-jacent d’origine.
Les nouveaux objets ont les mêmes propriétés d’objet (effet, volume d’objet,
couleur...tous les réglages de l’éditeur d’objet).
Si la commande est accomplie durant la lecture, la position de fractionnement
est définie par la position réelle de la tête de lecture au moment ou la commande
est sollicitée.

Raccourci: T

Trim Objects
Cette commande permet de ramener les bords de l’objet sur ceux d’une sélection.
La sélection doit bien sûr être contenue dans les limites de l’objet que vous
désirez ainsi émarger.

Raccourci: Ctrl + T

Heal/Unsplit Objects
Avec cette commande, vous pouvez réunir des objets qui ont été fractionnés
(par ex. par accident). Les objets doivent être bord à bord dans le VIP et les
données audio auxquelles ils font référence doivent correspondre. Cela signifie
qu’ils doivent faire référence à des données audio distinctes mais contiguës du
même projet Wave. Si ces conditions ne sont pas remplies, la commande est
grisée. Tous les réglages d’objet (fondus, effets etc.) du second objet sont
supprimés, l’objet obtenu ayant les propriétés du premier des deux.

Glue Objects
Cette option est liée à la fonction Gel («Freeze»). Les nouvelles données audio
sont copiées dans le dossier freeze et y restent tant que l’état de gel (groupage)
est maintenu.
La commande «Glue Objects» — dans le menu Object et le menu contextuel
d’objet — amène une opération de report de pistes destructive, dans laquelle un
nouvel objet est créé par réunion de plusieurs objets individuels, incluant les
effets, les réglages de time-stretch et les fondus enchaînés. Le nouvel objet n’a
pas d’effets. Les fondus restent inchangés. Les départs aux du premier objet
sont appliqués au nouvel objet.
En appelant la fonction de dégel («Unfreeze»), l’état d’origine des objets est
restauré.
En utilisant la commande «Edit Object Freeze», des objets groupés peuvent
être rappelés et édités comme un projet gelé mais dans l’état qui était le leur
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quand la commande de groupage a été exécutée. Tous les changements accomplis
ici sont automatiquement appliqués aux objets groupés.

Freeze Objects
Cette fonction convertit individuellement chaque objet en un nouveau fichier
audio qui remplace alors l’objet d’origine dans le VIP. C’est avantageux si, par
exemple, vous voulez activez des plug-ins en temps réel très exigeants en
ressources de système. L’objet d’origine reste préservé et peut être réédité avec
«Edit Object Freeze» ou restauré avec  « Unfreeze Objects».
Si plusieurs objets sont sélectionnés, la fonction sera appliquée individuellement
à chaque objet. Le fondu d’entrée, le fondu de sortie et le volume d’objet ne sont
pas calculés, car ces propriétés sont reprises par chaque nouvel objet.

Note: Pour transformer plusieurs objets en un seul, sélectionnez les objets voulus dans
la piste et utilisez la commande «Glue Objects».

Freeze Objects > Edit Object Freeze
Ouvre le VIP source («root VIP») de l’objet gelé. Ce VIP contient les pistes avec
les objets d’origine.
Dans le cas de «Glue Objects«, le VIP source contient plusieurs objet, tandis
qu’il n’en contient qu’un pour «Freeze Objects».

Avertissement: La longueur du VIP source ne peut pas être changée, puisqu’elle est
déterminée par celle de l’objet auquel la fonction «Freeze« ou «Glue» a été appliquée.

Freeze Objects > Unfreeze Objects
Cette commande ne peut servir que sur des objets ayant été créés par les
commandes «Glue Objects» ou «Freeze Objects».
Elle rappelle les objets conservés dans le VIP source. Les changements faits
dans le VIP source seront inclus.

Astuce: Si des pistes sont ajoutées au VIP source, il n’est pas possible d’utiliser «Unfreeze
Objects«.
Le VIP source est le projet qui a été créé par gel d’une piste ou d’un objet.

Lock Objects > Lock Objects
Cette commande permet d’empêcher toute modification involontaire apportée
à un objet. D’abord, sélectionnez les objets à «verrouiller» et lancez la commande.
Les objets verrouillés sont marqués par le passage en rouge de leur symbole de
clé.
Vous pouvez définir quelles sont les actions d’édition interdites (déplacement,
changement de durée …) dans la fenêtre Object Lock Definition (voir ci-dessous).
Vous pouvez aussi verrouiller/déverrouiller un unique objet en cliquant
directement sur son symbole de clé. Verrouiller une piste (bouton à icône de
cadenas) revient à activer le verrouillage pour tous les objets de cette piste.
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Lock Objects > Unlock Objects
Cette commande déverrouille les objets sélectionnés qui sont verrouillés.

Lock Objects > Lock Definitions
Sélectionne les options de verrouillage d’objet (comme représenté dans la copie
d’écran). Seul le déplacement («Disable Moving») est verrouillé par défaut.
Verrouiller une piste (bouton à icône de cadenas) revient à activer le verrouillage
pour tous les objets de cette piste.

Disable Moving: Interdit le déplacement des objets verrouillés (par défaut).
Utile dans le projets multipistes, en édition rapide.

Disable Volume Changes: Les poignées de volume des objets verrouillés sont
désactivées.

Disable Fade-In/Out: Les poignées de fondu des objets verrouillés sont
désactivées.

Disable Length Changes: Les poignées de longueur des objets verrouillés
sont désactivées.

Disable Deleting: Cette option empêche la suppression des objets verrouillés.
Elle n’affecte que les suppressions demandés par pression de la touche «Suppr.»
(ou par la commande «Delete Objects» du menu Object > Cut Objects). Elle
n’empêche pas la suppression d’un objet inclus dans une sélection temporelle
(Range) qui est elle-même supprimée.

Move/Edit Objects
Ce sous-menu regroupe des commandes particulièrement poussées agissant
sur l’édition des objets, comme le positionnement et les fondus enchaînés.

Move/Edit Objects > Move Objects
Cette commande vous permet de modifier le point de départ de l’objet.

La fenêtre de dialogue ci-dessous s’ouvre, vous permettant de choisir la nouvelle
position en échantillons (samples), millisecondes, temps SMPTE ou mesures
(bars).
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Move/Edit Objects > Object/Fade Step Settings
Cette fonction très complète permet d’éditer les fondus et fondus enchaînés
d’objets. Pour modifier le fondu enchaîné, sélectionnez deux objets qui se
chevauchent. Pour n’éditer qu’un objet, ne sélectionnez qu’un seul objet.

Toutes ces fonctions peuvent être réglées par paliers, permettant des
mouvements d’objets très précis. Les réglages peuvent être définis via le menu
Object->Move/Edit Objects->Object/Fade Step Settings.

Move/Edit Objects > Object Move Step 1 et Step 2
Ces commandes sont principalement destinées au réglage fin des fondus
enchaînés. Avec ces fonctions de menu, vous pouvez bouger toutes les poignées
d’un ou de deux objets sélectionnés.

Toutes ces fonctions peuvent être effectuées depuis le Menu Object. Toutefois, il est en
général bien plus rapide de les effectuer via les raccourcis clavier.

En combinant «Activate next/previous track» (Alt +curseur haut/bas) et «Select
next/previous Object» (ctrl+alt+curseur gauche/droite), vous pouvez faire des
éditions complètes de projets sans utiliser du tout la souris!
Le principe de base de manipulation des objets est le suivant: la touche Ctrl
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sélectionne l’objet de gauche, la touche Alt l’objet de droite. Le palier
d’incrémentation (Step 1 ou 2) est déterminé avec la touche Shift.
Les touches de numéros (0-9) sélectionnent une des fonctions suivantes pour
l’objet sélectionné:
1...déplace l’objet à gauche
2... déplace l’objet à droite
Assez évident

3... déplace le début/fin de l’objet à gauche
4... déplace le début/fin de l’objet à droite
Quand deux objets sont sélectionnés, les touches ctrl et alt sélectionnent soit la
fin du premier objet soit le début du second. Ctrl + Alt déplace la totalité du
fondu-enchaîné. Quand un seul objet est sélectionné, les touches modificatrices
sélectionnent les points de début et de fin de cet objet.

5...allonge la durée de fondu
6...réduit la durée de fondu
Comme ci-dessus: Quand deux objets sont sélectionnés, cela affecte le fondu de
sortie du premier objet ou le fondu d’entrée du second. Tant que vous n’avez
pas activé les fondus enchaînés asymétriques (voir le chapitre sur l’éditeur de
fondu enchaîné «Crossfade Editor»), vous noterez que Alt + 5/6 n’a pas d’effet,
car les durées des fondus d’entrée et de sortie sont liées. Quand un seul objet
est sélectionné, les touches modificatrices se réfèrent aux points de fondu d’entrée
et de fondu de sortie de l’objet.

7…augmente le volume de l’objet
8...réduit le volume de l’objet
C’est l’équivalent de la montée ou de la descente des poignées de volume de
l’objet.

9...déplace le contenu de l’objet vers la droite
0... déplace le contenu de l’objet vers la gauche
C’est une fonction très spéciale accessible uniquement de cette façon ou via
l’éditeur d’objet. Vous pouvez déplacer le matériel audio auquel l’objet fait
référence. C’est l’équivalent de: déplacer le point de début de l’objet, déplacer la
totalité de l’objet en direction opposée, et déplacer le point de fin de l’objet de la
même valeur. Pour illustrer cela, ouvrez aussi la fenêtre de projet Wave d’un
objet (édition d’onde ou «Wave Editing»), et utilisez les touches. Cela aura le
même effet que si vous déplaciez la sélection temporelle (Range) dans le projet
Wave, qui fournit les données audio à l’objet.

Pour accomplir toutes ces manipulations avec le réglage de pas (Step) 2, tenez
simplement enfoncée la touche Shift avant de lancer la commande (exemple :
Alt + Shift + 0 = déplacement du contenu du second objet vers la gauche d’une
distance équivalente à Step 2).

Move/Edit Objects > Object To Play Cursor Position
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Cette commande ramène le début du ou des objets sélectionnés au niveau de la
tête de lecture. Si plusieurs objets sont sélectionnés, c’est celui ayant le plus
petit numéro de piste qui se cale sur la tête de lecture, tous les autres effectuant
leur déplacement relativement au sien (en considération des modes objet).

Move/Edit Objects > Object To Original Time Position
Cette commande ramène l’objet sélectionné à sa position d’origine (à laquelle il
a été enregistré/créé). Elle est très pratique si vous avez déplacé accidentellement
l’objet et ne vous en êtes rendu compte qu’après plusieurs éditions ou même
lors d’une autre session.

Note: Cette commande n’agit que sur la position temporelle de l’objet. Ainsi, s’il a
changé de piste depuis son enregistrement, il ne reviendra pas sur son ancienne piste.
Si vous souhaitez faire revenir un objet sur sa piste d’origine, utilisez la fonction
Undo ou une copie de secours du VIP!

Move/Edit Objects > Set Original Time Position
Cette commande attribue comme position d’origine à l’objet la position dans
laquelle il se trouve actuellement.

Note: Cette commande ne prend en compte que la position temporelle de l’objet. Ainsi,
s’il change la piste entre temps, il ne reviendra pas sur son ancienne piste.

Move/Edit Objects > Arrange Objects
Cette commande permet d’arranger tous les objets sélectionnés de façon à ce
que chaque objet soit séparé du suivant d’un temps (écart) donnée. C’est pratique
pour préparer un master de CD.
Vous pouvez aussi sélectionner des objets sur plusieurs pistes, l’arrangement
des objets se fera individuellement pour chaque piste. Le premier objet
sélectionné dans chaque piste restera toujours à sa position d’origine.

Mute Objects
Cette commande coupe la reproduction des objets sélectionnés –  c’est-à-dire
qu’ils sont réduits au silence. Leur forme d’onde reste visible.
Les lettres MuL + MuR apparaîtront dans les objets ainsi coupés, indiquant que
les canaux gauche et droit sont coupés. Vous pouvez séparément couper les
canaux gauche et droit dans l’éditeur d’objet.

Raccourci: Ctrl+M

Build Loop Object
Cette commande vous permet de définir une boucle à l’intérieur d’un objet.
Délimitez une sélection à l’intérieur d’un objet. Si aucune sélection n’est faite,
c’est la totalité de l’objet qui est bouclée (début/fin de boucle = début/fin d’objet).
Les données de l’objet sont désormais lues en boucle. Il est ensuite très facile
d’agrandir l’objet pour augmenter le nombre de boucles: faites glisser la poignée
inférieure droite de l’objet vers la droite.
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Pour simplifier, dessinez une sélection par dessus la section à boucler,
sélectionnez Object > Build Loop Object, puis cliquez sur le bord droit de l’objet
et tirez-le vers la droite. La section bouclée sera répétée.
Vous pouvez éditer les valeurs de début/longueur/fin de boucle et désactiver le
bouclage d’un objet avec «Loop on» dans l’éditeur d’objet – dans l’onglet
Pitchshifting/Timestretching.
C’est la méthode idéale pour réaliser de longues boucles de batterie à partir
d’une seule boucle de batterie! Les objets bouclés permettent aussi d’économiser
de la mémoire, puisque ce sont toujours les données du même objet qui sont
lues et relues plutôt que de multiples objets ou des copies du même matériel ou
encore de très longs échantillons!
Si vous fractionnez un objet bouclé en un point donné et désactivez le bouclage
sur le nouvel objet (le second), ce second objet est lu de façon transparente
depuis le point de bouclage dans l’audio. Cela vous permet de boucler une frappe
de batterie pour par exemple créer un roulement. Faites juste une sélection
temporelle (Range) sur la frappe dont vous désirez faire un «roulement», tirez
sur la poignée de longueur, et fractionnez l’objet après la dernière frappe que
vous désirez entendre. Décochez «Loop on» pour le second objet, et la dernière
frappe se poursuivra par sa chute de son naturelle.

Set Hotspot
Cette commande enregistre la position de la tête de lecture comme point de
référence pour la fonction d’alignement automatique. A partir de cet instant, ce
ne sont plus les bords des objets, mais ce point d’alignement qui sert au calage
des objets.
Un point d’alignement est représenté par une ligne verticale en pointillés. Il
peut être extérieur aux limites d’un objet (placé avant ou après l’objet).
Ces points d’alignement sont particulièrement utiles lorsque vous voulez
synchroniser une portion d’un objet qui ne correspond pas à son début.

Select Objects > Select Objects
Cette commande sélectionne tous les objets qui sont recouverts totalement ou
en partie par une sélection, ou qui se trouvent sous la tête de lecture (si aucune
sélection temporelle (Range) n’a été faite).

Select Objects > Select All Objects
Tous les objets du projet seront sélectionnés.

Select Objects > Switch Selection
Cette commande sélectionne tous les objets qui ne l’étaient pas. Les objets
précédemment sélectionnés ne le sont plus.

Select Objects > Deselect Objects
Désélectionne tout objet du projet. C’est utile lorsque vous désirez supprimer
une sélection temporelle (Range) avec la touche «Suppr.», car cette touche donne
priorité aux objets sélectionnés sur la sélection temporelle.
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Select Objects > Select next Object
Sélectionne l’objet suivant sur la piste sélectionnée. Si aucun objet n’est
sélectionné, la commande sélectionne l’objet le plus près de la tête de lecture.

Raccourci: «>», CTRL + ALT + W

Cette commande, en conjonction avec «Select next/previous track» (curseur
haut/bas), vous permet de naviguer entre les objets rien qu’avec le clavier!

Select Objects > Select previous Object
Sélectionne l’objet précédent sur la piste sélectionnée. Si aucun objet n’est
sélectionné, la commande sélectionne l’objet le plus près de la tête de lecture.

Raccourci: «<», CTRL + ALT +Q

Cette commande, en conjonction avec «Select next/previous track» (curseur
haut/bas), vous permet de naviguer entre les objets rien qu’avec le clavier!

Select Objects > Object-Lasso
La façon normale de sélectionner plusieurs objets d’un coup consiste à cliquer
dans l’espace libre à droite de l’objet dans la partie basse de la piste et à encadre
les objets à sélectionner.
Parfois, cependant, il n’y a pas assez d’espace entre les objets. Le lasso résout ce
problème.
Une fois activé, vous pouvez cliquer sur un objet et dessiner un cadre de sélection,
sans pour autant déplacer l’objet sur lequel vous avez cliqué (ce qui serait le cas
en mode standard).
Une fois vos objets sélectionnés, la souris revient en mode standard, ce qui
signifie que vous devrez réactiver le lasso chaque fois que vous voudrez l’utiliser.

Raccourci: Ctrl + Alt + L

Group Objects
Cette commande rassemble tous les objets sélectionnés en un seul groupe.
Toutes les opérations ultérieures s’appliquent alors au groupe dans son
ensemble.

Raccourci: Ctrl + G
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Ungroup Objects
Cette commande dissout le groupe d’objets sélectionné. Vous pouvez ensuite
manipuler chacun des objets individuellement.

Raccourci: Ctrl + U

Object Color/Name > Object Background Color

Samplitude vous permet d’attribuer une couleur différente aux objets
sélectionnés. La fenêtre de dialogue ci-dessus vous permet d’appliquer quasiment
toutes les couleurs possibles en fonction des capacités graphiques de votre
ordinateur.

Object Color/Name > Object Foreground Color
Vous pouvez également modifier la couleur d’affichage de la forme d’onde de
l’objet. La fenêtre de réglage est identique à celle de la commande précédente
(voir ci-dessus).

Object Color/Name > Object Name
Une autre façon de distinguer certains objets est de leur donner un nom différent.
Cette commande vous permet de donner un nom particulier à un ou plusieurs
objets.
Attention : Ce nom ne s’affiche que si vous avez coché «Object Name» dans View >
VIP Display Mode > Definition Menu, ou en pressant Shift+Tab après avoir sélectionné
l’objet.

Raccourci: Ctrl + N

Object Editor
Cette commande vous donne accès à l’éditeur d’objet de Samplitude.
L’éditeur d’objet est couvert en détail dans le chapitre qui lui est réservé. Veuillez
vous y référer pour plus d’informations.
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Object Manager
Voir le menu «Tools».

Take Manager
Voir le menu «Tools».

Wave Editing
Samplitude est, à la base, un éditeur audio multipiste non linéaire et non
destructif. Cela signifie que les productions audio que vous réalisez sont,
normalement, effectuées en mode virtuel (VIP), et que les données audio
d’origine restent absolument intactes. Or, dans certaines circonstances, il est
préférable de travailler directement sur un projet Wave, comme vous le feriez
avec un éditeur audio classique.
Il s’avère que Samplitude peut également fonctionner en tant qu’éditeur audio
traditionnel, mais offre à présent deux choix possibles – le mode d’édition
destructif (Wave Editing) et le mode d’édition Wave virtuel. L’équipe de
développement de Samplitude a mis au point un procédé permettant de
contourner les problèmes d’espace disque et de temps associés au mode d’édition
destructif. Quand on travaille directement sur des projets Wave, les puissantes
options offertes par Wave Editing distinguent nettement Samplitude des éditeurs
audio traditionnels!
Lisez la section sur l’édition virtuelle pour une introduction au nouveau mode
Wave Editing, et consultez aussi le Glossaire pour un résumé des bases de
l’édition d’onde.
Des différences existent entre l’édition destructive classique et le nouveau mode
d’édition Wave virtuelle «Wave Editing», quand on travaille sur des projets Wave:

Conversion des opérations d’édition lors de la sauvegarde
Toutes les éditions: couper, coller, supprimer et insérer sont virtuelles. Les points
d’édition dans le projet sont repérés par une ligne en pointillés. Il n’y a pas de
création de fichiers d’annulation. Toutes les opérations d’édition résident dans
la RAM et ne sont vraiment appliquées au projet Wave que lorsque vous
sauvegardez ce dernier.

Section générale Master : Vous pouvez ouvrir la table de mixage pendant
que vous travaillez dans un projet Wave afin d’appliquer les manipulations
d’effets en temps réel comme vous le feriez en section Master normale du VIP.
Ces effets seront appliqués au projet Wave quand vous sauvegarderez ce dernier.
Pour obtenir de plus amples informations sur la section Master de la table de
mixage, veuillez vous reporter au chapitre sur l’utilisation de la table de mixage
dans le guide de prise en main.

Menu File Export audio: Ouvre la fenêtre de report de pistes (des conversions
de format sont possibles). (Tools > Track bouncing)

Auto Crossfade: L’option Auto Crossfade (Menu Edit) fonctionne également
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avec les projets Wave et permet d’appliquer des fondus par défaut lors des
opérations de coupure ou d’insertion. Pour éditer un fondu appliqué par défaut,
délimitez une sélection au-dessus de lui, puis ouvrez l’éditeur de fondu
(Crossfade Editor).

Création d’un nouveau fichier par glisser-déposer: Vous pouvez délimiter
une sélection dans le projet Wave puis la faire glisser à un emplacement vide du
bureau du programme. Un nouveau projet Wave est alors créé. Vous pouvez
ainsi créer des copies de la totalité ou de certaines portions d’un projet Wave.

Edit a copy of Wave Content
Cette commande ouvre pour édition audio le projet Wave auquel un objet fait
référence. Par contre, à la différence de la commande «Wave Editing« normale,
elle copie les données audio de l’objet à la fin du projet Wave et modifie l’objet
pour qu’il fasse dès lors référence à la copie.
Ce système présente l’avantage d’offrir une possibilité d’annulation dans le VIP.
Vous pouvez annuler l’édition audio sans avoir à rouvrir le projet Wave.
L’inconvénient, c’est que cela modifie la longueur du projet Wave, ce qui est
parfois indésirable (si les données audio sont utilisées dans une boucle, par
exemple).

Edit Root VIP
Le projet source (root) est une option spéciale étroitement liée à l’option Freeze.
Il peut servir, par exemple, pour éditer dans leur état d’origine des objets reportés
pour un projet de mastering.
Tout objet créé dans Samplitude par report peut être édité dans ce projet source
tel qu’il était avant report, tant que les données audio d’origine et le projet source
(=root VIP) sont encore disponibles.
Cette option, par laquelle un projet complet avec toutes ses options peut se
cacher derrière tout objet, permet des productions audio complexes et un rappel
pratique du statut de travail antérieur à l’opération de report.

Operation
Ouvre une copie du projet source dans l’état dans lequel il était lors de la dernière
sauvegarde. S’il a été rappelé et édité après la procédure de report, il peut bien
sûr différer du fichier audio précédemment créé.
Après avoir édité le VIP source et appliqué la fonction de sauvegarde de projet
(«save project»), il vous est demandé de confirmer si l’objet créé à l’origine doit
être mis à jour au moyen d’une procédure de report de pistes. Toutes les options
de report de pistes (format, réglages de dithering etc.) s’appliquent pour cette
opération. Si aucune section autre ou différente n’existe, la longueur d’origine
du fichier audio est valable pour ce processus.
Toutefois, la demande de mise à jour automatique n’est effectuée que si le VIP
d’origine est aussi appelé avec la commande «Edit root VIP». Un projet appelé
de la façon normale avec «Open project» n’a pas d’effet.
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Ce menu permet un accès rapide aux effets en temps réel au niveau objet. De
façon concordante, les options de menu offertes ici peuvent être contrôlées depuis
l’éditeur d’objet.
Pour plus de détails sur ces effets, veuillez lire les articles y ayant trait dans le
chapitre consacré au «menu Offline Effects».

Object Switch Channels
Avec cette fonction, vous pouvez intervertir les canaux stéréo gauche et droit.
C’est utile pour corriger des enregistrements dont les canaux sont inversés.

Object Multi-band Enhancer
Cet enhancer stéréo multibande vous permet d’effectuer des modifications et
corrections précises sur l’image stéréo selon trois bandes de fréquences
indépendantes. Le signal est séparé en trois bandes de fréquences et chaque
bande est traitée individuellement.
L’assemblage des bandes indépendantes est 100% neutre du point de vue des
fréquences grâce à la technique de filtre complémentaire RIF («réponse
impulsionnelle finie») – aucune décoloration de la réponse en fréquence n’est
introduite.
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».

Invert Phase
Les données échantillonnées appartenant à la sélection temporelle (Range) sont
inversées symétriquement à l’axe des amplitudes. Cette inversion de phase
signifie que les valeurs négatives deviennent positives et vice versa.
Cette fonction permet d’apparier des échantillons ayant des phases différentes.
Appliquée à l’échantillon sélectionné conjointement aux fonctions de mixage
disponibles (qui sont, d’un point de vue mathématique, des fonctions d’addition),
cette fonction vous permet de soustraire des échantillons.

Object EQ
Cette fenêtre de dialogue contient un correcteur paramétrique 4 bandes. Vous
pouvez activer les filtres sur quatre bandes de fréquences réglables pour modifier
le son d’un échantillon. Vous pouvez faire des réglages de fréquences large
bande pour les plages haute et basse ainsi que des corrections sur des bandes
étroites et spécifiques.
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».

Object FFT Filter
Le filtre FFT à application en temps réel dans l’éditeur d’objet, dans la piste et/
ou le master de mixage stéréo permet le filtrage à phrasé linéaire précis de signaux
et convient donc bien au mastering. Il contient 1024 bandes de fréquences,
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pouvant chacune être accentuée de +30 dB et réduite d’environ –80 dB. Le filtre
FFT à application en temps réel est une option «mineure» avec un nombre
énorme de réglages, analyses et modes de fonctionnement possibles pour
l’édition destructive de matériel audio (menu «Offline Effects»). La courbe du
filtre peut être éditée en traçant une courbe à la souris.

Object Dynamics / Object Advanced Dynamics /Object Multi-band
Dynamics
Ouvre la fenêtre de l’effet dynamique correspondant pour l’objet. Pour plus
d’informations sur les paramètres d’effet, référez-vous au menu «Offline
Effects»et au chapitre du manuel sur les effets.

Object Dehisser
Ce De-esser complète le réducteur de bruit (Noise Reduction). Il peut servir à
supprimer le bruit blanc constant de bas niveau (les sifflantes) qu’on trouve
typiquement dans du matériel enregistré au travers de préamplis micros ou de
cartes son analogiques.
Le Dehisser, contrairement au réducteur de bruit, n’a pas besoin de recevoir
d’échantillon de bruit.
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».

Object Distortion
Cet effet vous permet d’ajouter de la distorsion au matériel audio en utilisant
une ligne à caractéristiques non linéaires; le signal devient plus fort et des partiels
sont ajoutés. En ajustant le point de départ de la distorsion (seuil ou «Threshold»),
une distorsion au son analogique et doux (c’est-à-dire avec Threshold à –40 dB)
peut être créée (saturation). Une distorsion au son numérique dur peut être
créée avec un réglage de Threshold à 0 dB. Le réglage de rapport (Ratio) détermine
l’intensité de cette distorsion.

Object Amp Simulation
Cette simulation d’ampli est un effet en temps réel qui simule les propriétés
sonores d’un ampli à lampes. Elle convient particulièrement aux sons de guitare
mais également aux sons d’orgue ou aux enregistrements de voix.
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».

Object Vocoder
Le Vocoder en bref: Une porteuse (par ex. Une nappe de cordes ou un accord de
synthé) est affectée par un modulateur (par ex. des paroles ou un chant, ou
même des boucles de batterie) pour donner l’impression que le matériel audio
«parle» ou «chante».
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».
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Object Room Simulator
Cette commande ouvre le simulateur d’espace (Room Simulator) pour l’objet.
Vérifiez bien que le volume de l’objet est placé avant cet effet pour éviter une
disparition de la queue de réverbération. Pour plus d’informations sur les
paramètres d’effet, référez-vous au menu «Offline Effects».

Object Resampling/Timestretching
Cette commande ouvre la fenêtre de dialogue pour un algorithme de
rééchantillonnage (resampling) ou de transposition (pitchshifting) assigné à
l’objet. Par exemple:

Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects» et au chapitre «Elastic Audio«.

Elastic Audio
Ouvre l’éditeur Elastic Audio. Dans la première partie du manuel se trouve une
description détaillée de cet éditeur dans le chapitre du même nom.

Raccourci: Ctrl + Shift + E

Object DirectX / VST Plug-ins
Cette fonction vous permet d’employer des plug-ins compatibles DirectX
Microsoft et VST 2.0 avec Samplitude. Cela permet de compléter les effets
existant déjà avec un nombre illimité d’effets de tierces parties.
Pour plus d’informations sur les paramètres d’effet, référez-vous au menu
«Offline Effects».
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Les effets et traitements proposés dans ce menu agissent directement sur les
projets audio enregistrés sur le disque dur (HDP), en RAM (RAP) ou sur les
objets sélectionnés dans la fenêtre VIP. A l’exception de la commande Normalize
Object (Virtual), toutes les commandes du menu sont destructives. Autrement
dit, elles modifient irrémédiablement les données audio. Toutefois, chaque effet
intègre une option Create Copy (dans sa fenêtre de réglages) qui permet de faire
une copie des données qui sera accolée aux données d’origine et sur laquelle
porteront les traitements.
Quand vous traitez des objets sélectionnés en fenêtre VIP, avoir cette copie
vous permet d’annuler le processus et de restaurer le projet d’origine (sec, c’est-
à-dire sans effet). Après une annulation, la copie accolée reste toutefois présente
dans le fichier audio (même si elle n’est plus référencée dans le projet VIP) tant
que vous ne la supprimez pas délibérément, manuellement ou avec l’option
Tools > Remove Unused Samples.

Remarque : Si vous appliquez un effet sur un objet qui apparaît à différents endroits
du projet (projet à base de boucles, par exemple) SANS cocher la case Create Copy,
toutes les occurrences de cet objet dans le projet vont être affectées car le fichier audio
de référence aura été modifié de manière destructive. Pour éviter ce problème, cochez
la case Create Copy de sorte qu’une version traitée des données audio soit spécifiquement
créée pour l’objet en cours d’édition (voir paragraphe précédent).

Nous vous recommandons de toujours laisser la case Create Copy cochée lorsque
vous appliquez des effets par le biais de ce menu. Même si cela entraîne une
consommation d’espace disque plus importante, vous êtes ainsi certain de
toujours pouvoir revenir en arrière en cas d’erreur ou de doute. On n’est jamais
«sûr» de ne plus avoir besoin du fichier d’origine!
Si la case Create Copy n’est pas cochée, les opérations d’édition en pourront pas
être annulées, quels que soient les réglages effectués pour les projets HD Wave
dans Options > Program Preferences > Undo Definitions. En cas d’erreur, votre
seul recours sera de recharger une copie de secours de la totalité du Projet (en
espérant que vous en ayez fait une…). Ceci s’applique aux VIP et aux projets HD
Wave.
Certaines fenêtres et boîtes de dialogue d’effets ne proposent pas d’option Créer
Copie (fenêtre Fade In/Out, par exemple) car elles créent automatiquement un
fichier d’annulation si l’option Undo est activée pour les projets HD Wave
(Options > Program Preferences > Undo Definitions). Ces fichiers d’annulation
sont temporaires et automatiquement effacés à la fermeture du Projet.

Conseil d’utilisation : Si la fonction Create Copy a été mise à profit (lors de l’application
d’effets sur un objet de la fenêtre VIP), vous avez la possibilité d’alterner entre les
différentes versions traitées et les données audio d’origine par le biais du gestionnaire
de prises (Take Manager)!
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Options étendues pour effets destructifs (Destructive Effect
Calculation)
Ici vous pouvez régler certaines options pour l’application des effets destructifs.

Calcul des effets destructifs dans les objets de VIP
Dans la partie haute de la fenêtre, vous pouvez choisir entre trois façons de
stocker l’audio de l’effet calculé après application d’effets destructifs sur des
objets de VIP.
Ces données seront conservées pour les opérations d’annulation («Undo»), si la
case «Create copy» a été cochée dans la fenêtre de réglages de l’effet choisi.
Astuce: Ne décochez cette case que si vous êtes vraiment sûr de ne pas vouloir
annuler le calcul et si vous voulez économiser le temps et l’espace disque
nécessaires à la création de ces données audio supplémentaires.
1. «Append effect to original file»: C’était la méthode habituelle dans les versions

précédentes du programme. Vous obtenez moins de fichiers et pouvez
rapidement accéder aux calculs d’effet selon un fichier spécifique. Il existe
quelques désavantages: quand vous travaillez avec un fichier d’une résolution
de 16 bits, l’effet est aussi conservé dans cette résolution, ce qui n’est pas
souhaitable quand vous voulez bénéficier de la résolution interne de calcul
qui est de 32 bits. Plus encore, la longueur du fichier est modifiée, ce qui
causera des problèmes si vous utilisez le projet Wave comme une boucle ou
dans d’autres VIP.

2. «Write effect to an FX file (..._FX.wav)»: Les résultats de tous les calculs d’effet
sont stockés dans un seul fichier séparé, nommé comme le projet Wave
d’origine mais avec le suffixe «_fx». Ainsi le projet Wave d’origine reste intact.
De plus, vous avez la possibilité de stocker le calcul d’effet au format 32 bits
flottant afin de conserver la plus haute qualité pour l’effet.

3. Enfin, vous pouvez choisir «Generate a new FX file for each effect». Tous les
effets destructifs sont alors stockés dans des fichiers séparés avec un suffixe
portant un numéro tournant. Sinon, ces fichiers peuvent aussi avoir des noms
détaillés.

Calcul des effets destructifs dans les projets Wave
Quand vous demandez un effet destructif dans un projet Wave, les options ci-
dessus sont caduques et les résultats d’effet sont toujours insérés dans le projet
Wave.
Néanmoins, des fichiers temporaires sont créés pour les actions d’annulation,
quand l’annulation («Undo») est activée pour les projets Wave et que «Create
Copy» est coché.
Quand un effet est appliqué sur une sélection temporelle (Range) dans le projet
Wave, il est possible d’ajouter un fondu-enchaîné au début et à la fin des données
audio traitées entre l’audio de l’original et celui de l’effet. Pour cela, cochez la
case «Create Crossfade» correspondante dans la fenêtre de dialogue d’effet. La
longueur des fondus-enchaînés se règle aussi à cet endroit.
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Amplitude/Normalize > Normalize
Cette fonction modifie l’amplitude générale de l’échantillon.
Les données sélectionnées sont modifiées pour obtenir une amplitude maximale
de 100 % (ou toute autre valeur située entre 1 et 400 %). Samplitude détecte
tout d’abord le point d’amplitude le plus élevé, puis le compare au pourcentage
choisi. Toutes les autres valeurs sont ensuite pondérées selon le nouveau facteur.
La fonction Normaliser permet d’obtenir la pleine modulation d’un signal audio,
voire de le surmoduler. Cette fonction est à utiliser par exemple avant de convertir
un échantillon à une résolution inférieure. Plus la résolution en bits est faible,
plus la plage dynamique diminue. La fonction Normaliser vous permet donc de
partir d’un échantillon optimal.
Si vous manipulez des sons provenant d’un seul instrument, réglez le facteur
sur 100 %.
Si par contre, le signal audio à traiter contient par exemple des sons de
percussions d’accompagnement, vous pouvez le surmoduler entre 120 et 200 %.
Vous faites ainsi apparaître les crêtes générées par les percussions. Cette méthode
vous permet également de modifier le son d’instruments naturels en les
surmodulant.
Si vous désirez appliquer d’autres traitements à votre signal (filtres, réverbération,
compression, par exemple), il est conseillé de réduire l’amplitude de 50 à 70 %
pour empêcher que les divers traitements consécutifs ne fassent saturer le signal.

Un point important à noter: Un son qui est enregistré un niveau relativement faible,
puis normalisé n’atteint pas la qualité d’un son enregistré à volume optimal. Exemple
: Si, lors de l’enregistrement, le volume du son ne correspond qu’à 50 % de la plage
maximale possible, les données audio ont une qualité 15 bits. Vous ne pouvez rien
changer à cela, même en normalisant le son à 100 %. Essayez toujours d’enregistrer
au plus proche du 0 dB sans toutefois atteindre la saturation.

Normalize to: Vous permet de déterminer le niveau de normalisation visé. Cela
peut se faire en saisissant la valeur voulue dans les champs de données, en
réglant le fader ou en pressant les boutons préréglés sur 50, 95, 100 ou 200%.
La valeur est affichée en pourcentage et en dB. 0dB=100% (déviation maximale).
Normaliser sur une valeur supérieure à 0dB a pour résultat une distorsion
numérique.
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Peak maximum: Affiche la plus haute crête détectée dans la sélection ou l’objet.

Peak change: Affiche le changement de niveau en dB, en accord avec le niveau
de normalisation sélectionné et la plus haute crête détectée.

Working Mode (mode de travail)
Virtual: Cette fonction accomplira la normalisation en temps réel sur les objets
sélectionnés. Cela diffère du processus de normalisation destructive qui
restructure le fichier audio.
La fonction de normalisation en temps réel détecte les crêtes de l’objet et ajuste
le volume de ce dernier pour que les plus hautes crêtes correspondent
précisément au niveau de normalisation sélectionné. Vous pouvez ramener
l’objet à son réglage de volume d’origine en cliquant sur le bouton «Reset»,
situé sous le fader de volume dans l’éditeur d’objet.
Cette option n’est pas disponible quand vous travaillez sur des projets Wave
(Wave Editing)

Destructive: Le matériel audio du projet Wave est physiquement modifié.
L’annulation n’est disponible que si Undo est activé alors que la case  «Create
copy» est cochée.

Multiple object selection (sélection d’objets multiples)
Quand plusieurs objets sont sélectionnés, il existe deux techniques différentes
pour les normaliser.

Independent normalization: Chaque objet est normalisé en fonction de son
propre niveau maximal (crête).

Unified normalization: Le niveau maximal est détecté de façon commune
pour tous les objets et chaque objet est normalisé en fonction de cette valeur.
C’est le comportement par défaut.

Quick Access (Accès rapide)
Set parameters: Ce bouton vous permet d’établir une valeur (par ex. 99%) et
une méthode de normalisation pour des multisélections d’objets, valables quand
vous accédez à la fonction Normalize via l’option d’accès rapide Quick Access.

Get parameters: Pour recharger ces paramètres dans la fenêtre.

Raccourci: Shift + «N»

Amplitude/Normalize > Normalize (quick access)
Normalise rapidement la sélection temporelle (projets Wave) ou les objets
sélectionnés (VIP) selon une valeur fixe. Cette valeur se définit dans la fenêtre
Normalize.
Les modes de normalisation sont toujours appliqués en accord avec le type de
projet – c’est-à-dire que les projets Wave en mode d’édition destructif sont
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normalisés «destructivement» et les projets Wave en mode d’édition virtuel Wave
Editing (ainsi que les objets de VIP) sont normalisés «virtuellement».

Raccourci:  «N»

Amplitude/Normalize > Fade In/Out
Cette fonction ouvre la fenêtre Fade In/Out où vous pouvez créer des fondus
d’entrée et de sortie de manière destructive sur les projets Wave.

Attention : Depuis cette fenêtre, les fondus ne s’appliquent de manière destructive que
sur les projets Wave. Pour appliquer un fondu destructif sur un objet de VIP, cliquez
sur l’objet avec le bouton droit de la souris, puis sélectionnez l’option Wave Editing.
Cela ouvrira le projet Wave auquel l’objet se réfère.

Si vous préférez créer un fondu non destructif, servez-vous des courbes ou des
poignées de volume disponibles dans le VIP.

Fade Start in %: Définit le niveau du signal au début du fondu en pourcentage
par rapport au niveau d’origine. Pour créer un fondu d’entrée simple, réglez ce
paramètre sur 0. Pour créer un fondu de sortie simple, réglez ce paramètre
sur 100.

Note: Vous pouvez régler ce paramètre en cliquant sur un des trois boutons de
pourcentages «préprogrammés» (0, 50, 100), en déplaçant le curseur ou en saisissant
la valeur dans la case.
Conseil d’utilisation : Les fondus d’entrée ne doivent pas nécessairement partir d’une
valeur de 0 pour finir à 100. De même, il n’est pas obligé de faire partir les fondus de
sortie de 100 pour les faire terminer à 0. Vous pouvez choisir librement les niveaux
souhaités entre 0 et 200. Utilisez l’affichage graphique pour vous aider à «visualiser»
la courbe que vous appliquez.

Fade End in %: Définit le niveau du signal à l’issue du fondu en pourcentage
par rapport au niveau d’origine. Pour créer un fondu d’entrée simple, réglez ce
paramètre sur 100. Pour créer un fondu de sortie simple, réglez ce paramètre
sur 0.

Note: Vous pouvez régler ce paramètre en cliquant sur un des trois boutons de
pourcentages «préprogrammés» (0, 50, 100), en déplaçant le curseur ou en saisissant
la valeur dans la case.
Conseil d’utilisation : Les fondus d’entrée ne doivent pas nécessairement partir d’une
valeur de 0 pour finir à 100. De même, il n’est pas obligé de faire partir les fondus de
sortie de 100 pour les faire terminer à 0. Vous pouvez choisir librement les niveaux
souhaités entre 0 et 200. Utilisez l’affichage graphique pour vous aider à «visualiser»
la courbe que vous appliquez.

Fade Curve: Ce paramètre vous permet de définir le type de courbe utilisée
pour le fondu.
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EXP.: Ce bouton donne à la courbe un profil exponentiel. Servez-vous ensuite
du curseur pour définir le degré du profil.

LINEAR: Ce bouton donne à la courbe un profil linéaire. Servez-vous ensuite
du curseur pour définir le degré du profil.

LOG.: Ce bouton donne à la courbe un profil logarithmique. Servez-vous ensuite
du curseur pour définir le degré du profil.

Conseil d’utilisation : Il suffit d’indiquer une valeur négative dans le champ numérique
Fade Curve pour inverser le profil de la courbe.

Fade In: Cliquez sur ce bouton pour définir instantanément un fondu d’entrée
simple. Le fondu commence à niveau 0 et se termine à niveau 100.

Fade Out: Cliquez sur ce bouton pour définir instantanément un fondu de
sortie simple. Le fondu commence à niveau 100 et se termine à niveau 0.

Important : Si vous avez le choix, optez toujours pour des fondus non destructifs
effectués depuis la fenêtre VIP par le biais des courbes et des poignées de volume. Si
vous préférez appliquer les fondus de manière destructive, vous pouvez constater que
la fenêtre de dialogue Fade In/Out ne propose pas d’option Create Copy. N’ayez
crainte, cette fenêtre de dialogue est l’une de celles du menu Offline Effects créant
automatiquement une copie d’annulation si le paramètre Undo est activé dans Options
> Program Preferences > Undo Definitions pour les projets HD Wave.

Raccourci: «F»

Amplitude/Normalize > Set Zero
Cette commande ramène à la valeur 0 (silence) les données se trouvant dans la
zone délimitée. Il est ainsi possible d’éliminer facilement le bruit de fond et les
imperfections d’un échantillon.

Exemple
Entre les phrases d’un discours enregistré, il y a inévitablement du bruit de
fond (par ex. le froissement de pages). En sélectionnant ces zones et en les
remplaçant par du silence (retour à zéro), vous pouvez nettoyer votre
enregistrement.

Switch Channels
Cette option vous permet de permuter les canaux gauche et droit d’un projet
Wave stéréo.

Stereo Enhancer
Cette option vous donne accès à la fenêtre Multi-Band Stereo Enhancer où vous
pouvez modifier et corriger très précisément l’image stéréo (sur trois bandes de
fréquences séparées) des projets Wave ou des objets de VIP sélectionnés.
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Note: L’Enhancer stéréo ne fonctionne que sur les fichiers audio stéréo.

Cet enhancer stéréo multibande vous permet de modifier et corriger très
précisément l’image stéréo de trois bandes de fréquences séparées. Le signal
est séparé en trois bandes de fréquences, puis chaque bande est traitée
séparément.
Lors de leur réunion, les bandes conservent leur phase grâce à la technique du
filtre complémentaire RIF (réponse impulsionnelle finie) – aucune coloration
de la réponse en fréquence n’est introduite. Cette méthode est supérieure à
celle de nombreux autres enhancers stéréo, qui fonctionnent en détruisant la
cohérence de phase.
La méthode que nous avons employée et qui consiste à régler l’image stéréo de
plusieurs bandes d’un même signal donne de bien meilleurs résultats que les
enhancers traditionnels. Par exemple, le fait d’augmenter la largeur de base de
la bande des médiums fait disparaître les problèmes de confusion des aigus et
des graves. Ces problèmes apparaissent souvent en raison des oppositions de
phase. Par ailleurs, la disparition de la compatibilité mono due à une
augmentation de la largeur de base se limite au traitement d’une bande
particulière.

Voici quelques exemples d’utilisation de l’enhancer stéréo multibande
1. Réduction ou élargissement de la stéréo.
2. Consolidation des graves grâce à la réduction de la largeur de la bande de

graves.
3. Gestion et correction des problèmes d’image stéréo d’un mixage final.
4. Repositionnement dans l’espace stéréo d’un segment mono d’un

enregistrement stéréo (mixage directionnel). Vous pouvez ainsi déplacer de
gauche à droite dans l’image stéréo une piste de voix mixée au centre.
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5. Atténuation ou suppression de signaux mono médiums pour «aérer» des pistes

ou des boucles de batterie afin d’ajouter d’autres instruments ou voix.

Dans la section supérieure gauche de la fenêtre se trouve la section de filtrage.
L’affichage graphique représente approximativement la réponse en fréquence
de chaque bande. L’axe vertical donne l’atténuation en –dB, l’axe horizontal la
fréquence en kHz. Vous pouvez afficher les échelles en mode linéaire ou en
mode logarithmique. Avec les deux curseurs offerts en mode multibande, vous
pouvez régler les fréquences de séparation des bandes de graves et de médiums
(1) et des bandes de médiums et d’aigus (2).
En haut et au milieu se trouvent les paramètres pour la manipulation stéréo. A
droite se trouvent les options de commande standards, boutons radio et cases à
cocher pour les différents modes et le sélecteur A/B/C pour une comparaison
rapide des trois configurations de la fenêtre.

Multi Band
Cochez cette case pour que l’algorithme puisse travailler sur les trois bandes de
fréquences (en mode multibande).
Le mode multibande n’est pas activé automatiquement lorsque vous appelez
l’enhancer en section Master de la table de mixage. Cela diminue la charge
initiale que doit supporter le processeur lors de la sélection en section Master.

Band Separation
Ce paramètre agit sur plusieurs caractéristiques du segment de filtre afin
d’améliorer la définition de la séparation.
Voici les résultats obtenus avec une séparation élevée:
1. Augmentation du niveau d’attaque des courbes de filtres – raccourcissement

de la transition entre les bandes.
2. Augmentation de l’absorption à l’intersection (Réglages : Faible : environ 25

à 35 dB, Normal : environ 35 à 45 dB, Elevé : environ 55 à 75 dB).
3. Baisse de la précision de la réponse en fréquence de chaque bande. Ce n’est

en général pas une source de problème puisque la précision de chaque bande
de filtre est annulée par le filtre complémentaire. Le signal de sortie est toujours
reproduit avec définition.

4. Augmentation de la charge du processeur.

Direction Pan
Cette case vous permet de passer d’un mode de gestion du panoramique à un
autre.
Lorsqu’elle est cochée, seule la portion mono (signal central) est prise en compte
lorsque vous changez le réglage de panoramique. Le potentiomètre de
panoramique agit comme un contrôleur de mixage directionnel et vous permet
de déplacer vers le canal gauche ou le canal droit des voix préalablement placées
au centre. Toutes les autres portions du signal audio non placées au centre restent
à leur position.
Lorsque la case n’est pas cochée, les commandes de panoramique fonctionnent
comme n’importe quelle autre commande de panoramique – la totalité du signal
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stéréo est déplacée (portions mono et portions gauche et droite).

Stereo (largeur de base)
Réglez la largeur sur une valeur entre 0 et 200. La valeur 0 correspond au
réglage «Mono», 100 = «Pas de changement» ou «Stéréo», et 200 = «Largeur
maximale» (Signal de différence).
En fonction de la corrélation entre la gauche et la droite, le niveau du signal
risque d’augmenter lorsque la valeur de cette commande est réduite. Dans des
cas extrêmes, il peut arriver que le niveau soit relevé de +3 dB. C’est le cas si les
canaux gauche et droit sont identiques (cela équivaut à une corrélation maximale)
et si vous réglez cette commande de largeur stéréo sur 0 (Mono).
Plus la valeur de largeur stéréo est supérieure à 100, plus la compatibilité mono
diminue. A l’inverse, plus vous réduisez la largeur stéréo, plus la compatibilité
mono augmente.

Gain
Vous pouvez régler ici le gain de chaque bande de +/- 6dB.

Pan
Ce potentiomètre gère le panoramique de chacune des bandes de fréquences.
La valeur d’atténuation en dB est affichée.
Si la case Direction Pan est cochée, ce potentiomètre prend fonctionne comme
un contrôleur directionnel. Dans ce cas, il ne déplace dans l’espace stéréo que la
portion mono (signal central) du signal.
Ce système vous permet d’isoler des voix mixées au centre et de les déplacer
entre la gauche et la droite de l’espace stéréo. Par contre, toutes les autres portions
non situées au centre conservent leur position.

Solo
Le mode Solo (bouton Solo enclenché) vous permet de vérifier les résultats des
réglages sur chacune des bandes séparément. Cela simplifie grandement le
processus de changement des paramètres de filtrage. Vous pouvez par exemple
isoler une plage de fréquences spécifique dans un mixage et changer l’aspect de
son image stéréo.

A/B/C
Cette section vous permet de paramétrer trois configurations différentes. Il suffit
ensuite de cocher la case désirée pour passer sur la configuration correspondante.
Cette section peut également vous servir de fonction Bypass : pour cela, laissez
une des configurations sur les réglages par défaut.

Phase Correlator
Ce bouton vous donne accès à la fenêtre Oscilloscope/Corrélateur de Phase.
Cette fenêtre est d’une grande utilité, tout spécialement en mode solo. Elle vous
permet de visualiser la largeur stéréo et le réglage de panoramique de chaque
bande de fréquences.
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Play/Stop
Ce bouton lance l’écoute-test en temps réel de l’audio traité par l’enhancer.

Save, Load, Delete
Ces boutons vous permettent, respectivement, de sauvegarder, recharger et
supprimer des configurations de paramètres pour cette fenêtre. Ces fichiers
portent l’extension *.ste.

OK
Cliquez sur le bouton OK pour appliquer l’algorithme sur la sélection délimitée
ou sur l’objet VIP.

Cancel
Ce bouton referme la fenêtre sans appliquer les réglages effectués.

Invert Phase
Les données se trouvant dans la zone délimitée sont inversées par rapport à
l’axe de l’amplitude. De par cette inversion, les valeurs négatives deviennent
positives et vice versa. Cette fonction est réversible par simple réemploi de la
même commande.
Il est ainsi possible de rendre compatibles des échantillons ayant des phases
différentes.
Appliquée à l’échantillon sélectionné conjointement aux fonctions de mixage
disponibles (qui sont, d’un point de vue mathématique, des fonctions d’addition),
cette fonction vous permet de soustraire des échantillons.

Parametric Equalizer....
Cette fenêtre contient un correcteur paramétrique 4 bandes. Vous pouvez activer
les filtres sur quatre bandes de fréquences réglables pour modifier le son d’un
échantillon. Vous pouvez faire des réglages de fréquences large bande pour les
plages haute et basse ainsi que des corrections sur des bandes étroites et
spécifiques.
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Notez que la table de mixage (Raccourci: «M») offre aussi un correcteur par
voie. Ce processeur fonctionnera en temps réel et le matériel audio ne sera pas
altéré (édition non destructive).

1..4 Les bandes de correction sont arrangées par groupes de boutons, contrôlant
la fréquence, la largeur de bande (Q) et le gain (volume). Chacun de ces
paramètres peut être réglé en bougeant la commande correspondante ou par
saisie numérique dans les champs de données. La correction peut aussi être
réglée dans la courbe de réponse en fréquence située au dessus. Faites glisser la
pastille correspondant à une bande de correction pour dessiner la courbe voulue.

Type: Pour la première et la quatrième bande de correction (servant généralement
aux fréquences les plus basses et les plus hautes), trois boutons représentant
des courbes vous permettent de choisir une courbe de filtrage passe-bas, en
plateau ou passe-bande.

Freq.: La fréquence de chaque filtre peut être réglée de 10 Hz à 24 kHz. Comme
chaque fréquence est réglable, plusieurs filtres peuvent être réglés sur la même
valeur, afin d’obtenir un effet plus prononcé.

Q: La largeur de bande de chaque filtre peut être réglée de 10 Hz à 10 kHz. Une
fois encore, le chevauchement des fréquences de filtrage est possible.

Gain Db: Ces commandes déterminent l’amplification ou l’atténuation (+/-20
dB) du niveau du filtre (volume). Avec la valeur 0, le filtre est désactivé et ne
sollicite donc pas le processeur.

Volume: Le fader Volume permet de compenser d’éventuelles baisses de volume
occasionnées par la correction paramétrique des bandes de fréquences.

Indicateurs de niveau In/Out: Ces crête-mètres indiquent le niveau d’entrée
(In) et de sortie (Out) des données audio.
Reset: Réinitialise les indicateurs In/Out en cas d’écrêtage (allumage du témoin
d’écrêtage rouge Clip)

A, B, C: Cette section vous permet d’alterner instantanément entre
3 configurations de réglages du correcteur paramétrique. Vous pouvez ainsi
expérimenter différents réglages et les comparer. Pour passer de l’une à l’autre,
sélectionnez simplement un autre bouton et faites les réglages voulus, puis
sélectionnez un autre bouton et ainsi de suite. Les réglages sont conservés en
mémoire dans le projet et peuvent être sauvés sous forme de groupe par le biais
du bouton Save.

Bypass: Cette option permet de couper l’action du correcteur paramétrique (de
le court-circuiter) afin de réaliser des comparaisons avec/sans traitement.

Create Copy: Comme dans la plupart des autres effets du menu Offline Effects,
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cette importante option permet de générer un fichier d’annulation avant le
traitement, ce qui permet de revenir en arrière si le résultat du traitement ne
vous satisfait pas. Comme toujours, nous vous conseillons vivement de toujours
cocher cette case.

Play/Stop: Ce bouton lance l’écoute test en temps réel permettant de vérifier
instantanément l’action des réglages du correcteur paramétrique sur vos données
audio avant de les appliquer réellement.

FFT Filter/Analyzer...
Cette commande ouvre la fenêtre de réglage FFT Filter/ Spectrum Analyzer.
Cette fenêtre vous permet d’appliquer destructivement un filtrage FFT à des
projets Wave ou à des objets sélectionnés en fenêtre VIP. Le filtre FFT est l’un
des outils les plus puissants de Samplitude avec des possibilités de réglage
graphique uniques permettant de redessiner librement la réponse en fréquences
d’une zone délimitée. Cette fonction peut s’avérer inestimable en cas de problème
de correction en Mastering de précision ou en restauration audio.

Alors...qu’est-ce que c’est?
C’est la combinaison d’un analyseur de spectre FFT (transformée de Fourier
rapide) et d’un filtre FFT. Autrement dit, vous disposez d’un analyseur de spectre
afin d’identifier la réponse en fréquence d’un signal, et d’un correcteur graphique
permettant de dessiner directement les modifications que vous souhaitez y
apporter.

Que faire avec?
Il existe littéralement mille et une applications possibles de ce processeur. En
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fait, un manuel aussi épais que celui que vous avez dans vos mains pourrait
facilement être écrit rien que sur ce sujet! En gardant cela à l’esprit, nous allons
nous concentrer sur les applications les plus courantes.
Pour les explications suivantes, nous partons du principe que vous disposez de
certaines connaissances sur les principes et la terminologie de l’analyse de spectre
audio.
1. Vérification et correction de la réponse en fréquences d’un mixage
2. Amplification ou atténuation de fréquences infra-graves (grondement ou

plosives)
3. Réglage de l’amplitude d’un instrument ou d’une note spécifique
4. Analyse de la réponse en fréquence d’un enregistrement et application à un

autre (convolution)
5. Fondu enchaîné entre deux courbes de filtres séparées

Conseil d’utilisation : Si vous comptez en apprendre plus sur la théorie à l’origine du
correcteur/analyseur FFT, nous vous conseillons la lecture d’un document spécialisé
sur le sujet.

Types de courbe
Vous disposez au total de neuf courbes de couleurs différentes organisées en
trois groupes de trois courbes (chacune d’une couleur différente) pouvant être
affichées simultanément.
Un premier groupe de trois courbes (jaune, rouge, bleue) est accessible en mode
statique (Static), un deuxième est utilisé au lancement du filtrage dynamique
(Dynamic Start) et un troisième utilisé à l’issue du filtrage dynamique (Dynamic
End).

Courbe bleue : Tant qu’AUCUNE modification n’a été apportée à la réponse
en fréquences, la courbe bleue représente la réponse en fréquences d’origine
des données audio sélectionnées. Une fois que des modifications ont été
apportées, la courbe bleue représente la réponse en fréquences qu’est censé
avoir le signal audio après traitement par le filtre. En mode d’édition Direct/
Match, c’est la courbe bleue qui peut être modifiée à la main pour apporter des
changements absolus à la réponse en fréquences. Autrement dit, toute courbe
que vous tracez ou modifiez à la main DEVIENT la nouvelle courbe de réponse
en fréquences.

Courbe jaune : La courbe jaune s’affiche une fois que des modifications ont
été apportées à la courbe de réponse en fréquences. Elle rappelle alors la réponse
en fréquences d’origine afin de mieux voir les différences. Cette courbe ne
s’affiche qu’en mode d’édition Direct/Match, ou bien en mode d’édition Filter
si vous réglez le nombre de courbes sur 3 (avec l’option Settings > Draw Settings
> Curve Number).

Courbe rouge : La courbe rouge est placée (centrée) par défaut à 0 dB et indique
les variations relatives apportées à la courbe de réponse en fréquences (c’est à
dire les variations de gain nécessaires pour arriver à la réponse en fréquences
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souhaitée). Il suffit de modifier le tracé de la courbe rouge pour agir sur la réponse
en fréquences.

Curseurs
Curseur à gauche du graphique: Ce curseur modifie l’échelle d’amplitude
du graphique pour les courbes jaune et bleue. L’amplitude est indiquée en dB à
la droite du curseur vertical.

Curseur à droite du graphique: Ce curseur modifie l’échelle d’amplitude du
graphique pour la courbe rouge. L’amplitude est indiquée en dB à la gauche du
curseur vertical.

Curseur de volume (Vol.): Ce curseur permet de régler le niveau général du
filtre FFT, sans changer la courbe de réponse en fréquences. Le changement
d’amplitude est affiché (en dB) sous le curseur.

Zoom
All: Cliquez sur ce bouton pour faire un zoom arrière total. Un second clic sur
ce bouton vous ramène au niveau de zoom préalable.

–  Le bouton – vous permet de faire un zoom arrière niveau par niveau. Vous
disposez au total de 10 niveaux de zoom.

: Le bouton + vous permet de faire un zoom avant niveau par niveau. Vous
disposez au total de 10 niveaux de zoom.

Max: Le bouton Max (maximum) vous permet de faire un zoom avant total. Si
vous cliquez à nouveau sur ce bouton, vous retournez au niveau de zoom
précédent.
Vous disposez au total de 10 niveaux de zoom.

Note: Une fois que vous avez effectué un zoom avant, servez-vous de la barre de
défilement placée sous le graphique pour vous déplacer. Les fréquences en cours
d’affichage sur le graphique sont signalées (en Hz) au-dessus de celui-ci.

Draw Mode (Mode d’affichage, sous les boutons de zoom)
Dans le premier mode (bouton radio de gauche), la réponse en fréquences est
affichée sous forme de courbe. Dans le second mode (bouton radio de droite), la
réponse en fréquences est affichée comme des «partiels» individuels (utile pour
éditer la partie basse de la réponse en fréquences).

Hz/Notes (à droite de Draw mode)
Choisissez l’unité de mesure du graphique (fréquences en Hz ou notes
musicales). Vous ne pouvez afficher le graphique au format note que lorsque le
bouton radio de droite de Freq lin/log est sélectionné.
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Freq lin/log (à droite de Hz/Notes)
Le mode linéaire (bouton de gauche) donne une meilleure vue du registre aigu
alors que le mode logarithmique (bouton de droite) offre une meilleure
visualisation du registre grave.

dB lin/log (à droite de Freq lin/log)
Le mode d’affichage linéaire de l’amplitude (bouton de gauche) donne une vue
plus détaillée du registre aigu Le mode d’affichage logarithmique de l’amplitude
(bouton de droite) donne une vue plus détaillée du registre grave.

Filter Mode (mode de filtrage)
Static: Dans ce mode, la courbe de filtre que vous éditez affecte la totalité du
projet Wave ou de l’objet sélectionné. Optez pour ce mode sauf si vous avez
l’intention de faire un fondu-enchaîné entre deux courbes de réponse en
fréquences.

Dynamic Start: Si vous souhaitez faire un fondu-enchaîné entre deux courbes
de réponses en fréquences, choisissez ce mode pour configurer la première
courbe (Dynamic Start). Le filtre FFT va donc partir de cette courbe, puis va
évoluer vers la seconde courbe (Dynamic End).

Dynamic End: Si vous souhaitez faire un fondu-enchaîné entre deux courbes
de réponses en fréquences, choisissez ce mode pour configurer la seconde courbe
(Dynamic End). Le filtre FFT va donc partir de la première courbe (Dynamic
Start), puis va évoluer par fondu-enchaîné vers cette courbe.

Edit Mode (Mode d’édition)
Filter: Passez dans ce mode pour éditer la courbe de filtre (courbe rouge).

Direct/Match: C’est dans ce mode que vous pouvez éditer la réponse en
fréquences corrigée (courbe bleue). Optez pour ce mode pour effectuer des
modifications absolues de la courbe de réponse en fréquences. Dans ce mode,
toute courbe tracée devient la nouvelle courbe de réponse en fréquences.

Analyze all
Cliquez sur ce bouton pour que l’analyseur de spectre FFT analyse le projet
Wave ou l’objet sélectionné. Notez que cette option ne s’applique que quand le
mode de filtrage est réglé sur «Static».

Reset
Cliquez sur ce bouton pour ramener toutes les courbes à leur position par défaut
(0dB).

Analyze > Filter
Cliquez sur ce bouton pour transférer la courbe de réponse en fréquences (du
projet Wave actuel ou de l’objet sélectionné) sur la courbe rouge. Cela vous
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permet d’appliquer rapidement à un enregistrement la réponse en fréquences
d’un autre.

Invert Filter
Cliquez sur ce bouton pour inverser la courbe de réponse en fréquences.

Prevent Clip.
Si des données audio saturent après réglage de leur courbe de réponse en
fréquences, cliquez sur ce bouton pour instantanément réajuster la courbe (d’une
façon empêchant l’écrêtage).

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!

Play/Stop
Cliquez sur ce bouton pour entendre en temps réel et en stéréo l’audio ainsi
filtré.

Preview
Cliquez sur ce bouton pour entendre le résultat calculé (traité) du filtrage audio.
Optez pour ce mode d’écoute si votre ordinateur n’est pas suffisamment puissant
pour l’écoute test en temps réel.

Conseil d’utilisation : Vous pouvez définir la durée de pré-écoute en pressant la touche
«Y» et en saisissant le nombre de secondes voulu dans le champ Options > System/
Audio > Onglet Program > Preview Time (milieu de la fenêtre).

Play original
Ce bouton relit les données audio d’origine. Vous pouvez ainsi faire une
comparaison entre les données d’origine et les données traitées.

Settings
Ce bouton vous donne accès à la fenêtre Advanced Settings (réglages avancés).
Dans cette fenêtre, vous pouvez définir les facteurs d’analyse audio. En général,
les valeurs par défaut suffisent pour une utilisation normale, mais vous pouvez
essayer d’autres réglages pour un résultat plus pointu.
Pour obtenir une grande précision dans le registre des graves, choisissez une
résolution élevée (à partir de 8192). Le tableau ci-dessus vous indique la précision
d’analyse en Hz pour une fréquence d’échantillonnage de 44,1 kHz:
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Résolution Précision en Hz
256 172
512 86
1024 43
2048 21.5
4096 10.7
8192 5.3
16384 2.7
32768 1.35

Il faut que la résolution soit élevée (8192) pour le filtrage des bandes de fréquences
graves ou pour certaines harmoniques atténuées. Toutes les autres applications
peuvent généralement se contenter d’une résolution de 1024 ou de 2048. Des
valeurs inférieures à 1024 ne donnent pratiquement jamais de bons résultats.
Deux suggestions importantes:
1. Si vous avez dessiné des courbes de filtrage très détaillées, il est impératif de

sauvegarder les paramètres de courbe. Le fait de changer de mode ou d’ajuster
un paramètre, même de façon minime, va modifier le rendu de la courbe.

2. Avant de faire une écoute-test avec une résolution élevée, vérifiez que la valeur
de la mémoire tampon Test Buffer (Options > System/Audio > Advanced Buffer
Settings) est égal ou légèrement supérieur au réglage de résolution (dans la
fenêtre Advanced Settings de l’analyseur FFT) sous peine de ne pas pouvoir
lancer l’écoute test.

Si le signal audio décroche lors de l’écoute test, c’est sûrement un signe qu’il
faut changer la valeur Test Buffer ou la résolution.

Settings > Analysis Parameters
Analysis Precision High: Lors de l’analyse, les données audio sont divisées
en blocs. Si vous cochez la case High, Samplitude fait se chevaucher les blocs
de 50 %, ce qui assure une meilleure analyse des sons courts (percussions, par
exemple). Mais, dans ce cas, les calculs durent deux fois plus longtemps.

Analysis Precision Normal: Lors de l’analyse, les données audio sont divisées
en blocs placés bout à bout sans chevauchement.

Analysis Accuracy Noise: Optez pour cette option si le signal à analyser est
peu ou pas mélodique (percussions ou cymbales, par exemple).

Analysis Accuracy Tones: Optez pour cette option si le signal à analyser a une
hauteur identifiable (guitare ou flûte, par exemple).
Lorsque vous travaillez sur des morceaux complets (mixage, par exemple), le
choix du réglage dépend du type de signal contenu dans le morceau. A vous de
faire le bon choix.

Channels Left: Sur les fichiers stéréo, sélectionnez ce réglage pour analyser
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uniquement le canal gauche.

Channels Right: Sur les fichiers stéréo, sélectionnez ce réglage pour analyser
uniquement le canal droit.

Channels Both: Sur les fichiers stéréo, sélectionnez ce réglage pour analyser
les deux canaux à la fois.

Analysis Time(s): Indiquez dans ce champ la durée en secondes de l’analyse
que doit effectuer l’analyseur /filtre FFT.
Ce paramètre n’a d’influence sur l’affichage de la réponse en fréquences que si
vous vous trouvez en mode «Static».

Remarque : La réponse en fréquences des données audio est recalculée à chaque fois
que vous modifiez la résolution (champ Resolution) ou l’un des paramètres d’analyse.
Ainsi, si après avoir lancé le calcul de la réponse en fréquences d’un fichier entier à
l’aide de la commande «Analyze All», vous décidez de modifier l’un des paramètres,
le calcul sera à refaire. Ajustez donc tous vos paramètres, puis, ensuite, faites le calcul
de la réponse en fréquences en cliquant sur la touche «Analyze All».

Settings > Filter Parameters
Precision: Ce paramètre permet de régler la précision du filtrage FFT des
données audio lorsque vous validez l’opération en cliquant sur la touche OK.
Vous avez le choix entre les valeurs Low (faible), Normal et High (élevée), cette
dernière offrant bien entendu la meilleure précision mais en contrepartie les
temps de traitement les plus longs.

Precision Real Time: Ce paramètre permet de fixer la précision du filtrage lors
des écoute-tests de vérification en temps réel du résultat. Vous avez le choix
entre les valeurs Test, Low, Normal et High, cette dernière offrant bien entendu
la meilleure précision mais en contrepartie les temps de traitement les plus
longs.

Conseil : Si votre machine n’est pas assez puissante pour effectuer une écoute-test en
temps réel en précision High, essayez un degré de précision moindre. La qualité de la
pré-écoute sera affectée, mais pas celle du résultat final lorsque sera appliqué le filtre
FFT sur le fichier audio.

Max Range (dB): Indiquez dans ce champ l’amplitude maximale de la courbe
rouge.

Min Range (dB): Indiquez dans ce champ l’amplification minimale de la courbe
rouge. Si vous désirez rendre inaudibles certaines parties du spectre, fixez une
valeur très basse (-120 dB, par exemple).
Note: Vous pouvez également effectuer ce réglage au moyen du curseur à droite du
graphique.
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Threshold: Lorsque vous éditez la courbe bleue (en mode d’édition Direct/
Match), seules les fréquences situées à l’origine au-dessus de cette valeur seuil
seront changées. Cela facilite le réglage des niveaux des partiels (quand le mode
d’affichage «Draw mode» est réglé pour afficher les partiels).

Note: Vous pouvez également affiner ce réglage au moyen du curseur à droite du
graphique.

Settings > Draw Settings
Ces réglages affectent la façon dont les courbes de réponse en fréquences sont
affichées.

Draw Grid: Cochez la case «On» pour faire apparaître la grille et la case «Off»
pour la faire disparaître.

Curve Numbers: Sélectionnez le nombre de courbes (1, 2 ou 3) que vous désirez
afficher à l’écran.

Settings > Dynamic Filter Mode
Cette section offre trois modes de filtrage dynamique différents.

Direct: Samplitude fait une transition simple entre deux courbes.

Circle/Direct: Samplitude fait la transition entre les deux courbes et la courbe
de départ est déplacée (vers les fréquences plus basses ou plus hautes). Si vous
avez paramétré un filtre passe-bande comme courbe de départ, les médiums
évoluent dans le temps (balayage du filtre). Dans ce mode, Samplitude prend
comme référence les valeurs les plus hautes des courbes de départ et de fin,
puis effectue un balayage à l’intérieur de la plage ainsi définie.

Note: Si vous êtes en mode d’édition Filter, vous devez d’abord éditer la courbe rouge.
Si la courbe reste sur 0 dB, c’est qu’aucune valeur plus élevée n’est disponible pour le
calcul.

Circle: Cochez cette case pour faire passer la première courbe de filtre en mode
circulaire. Dans ce mode, ce sont la valeur la plus haute et la valeur la plus basse
qui définissent la plage d’action du balayage. La seconde courbe ne sert qu’à
définir l’endroit où doit s’arrêter le balayage. Elle n’a aucune autre influence sur
le résultat final.

Note: Si vous êtes en mode d’édition Filter, vous devez d’abord éditer la courbe rouge.
Si la courbe reste sur 0 dB, c’est qu’aucune valeur plus élevée n’est disponible pour le
calcul.
Conseil d’utilisation : Entraînez-vous au filtrage dynamique en utilisant des signaux
large bande ou des signaux de bruit. Cela vous permettra de vous rendre compte plus
facilement de l’action du filtre.
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Settings > Resolution
La résolution détermine le nombre de bandes de fréquences ou de filtres
disponibles pour le calcul des courbes. Il suffit de diviser la résolution par deux
pour connaître le nombre de fréquences disponibles pour l’analyse.

Note: Des résolutions supérieures à 8192 ne sont nécessaires que pour le filtrage détaillé
des bandes de fréquences basses, ou pour certains «partiels» atténués. Toutes les autres
applications peuvent se contenter d’une résolution de 2048 ou de 4096.

Save
Cliquez sur ce bouton pour stocker en mémoire la configuration de filtrage
(paramètres et courbes) en vigueur.

Load
Cliquez sur ce bouton pour rappeler une configuration de filtrage préalablement
sauvegardée.

Note: Une fois que vous avez défini les réglages souhaités, vous pouvez refermer la
fenêtre Advanced Settings. Les réglages de filtrage restent mémorisés par Samplitude
pour le reste de la session, même s’ils n’ont pas été archivés au moyen du bouton
«Save». Par contre, si vous relancez Samplitude sans avoir sauvegardé vos réglages,
ce sont les réglages par défaut qui seront rechargés à l’ouverture du filtre FFT.

Analyse et filtrage de la réponse en fréquences d’un mixage:
1. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,

passez sur sa fenêtre. S’il doit être appliqué sur un objet VIP, sélectionnez
cet objet (en cliquant dans sa moitié inférieure).

2. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,
faites une sélection temporelle (Range) dans la fenêtre de projet Wave. S’il
doit être appliqué sur un objet VIP, passez à l’étape 3.

3. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

4. Dans le coin inférieur gauche de la fenêtre, sélectionnez le premier mode
d’affichage de courbe (Draw mode). La réponse en fréquence s’affiche alors
sous la forme d’une courbe à l’écran.

5. Cliquez sur (activez) l’option Direct/Match (du côté droit de la fenêtre - Edit
mode).

6. Cliquez sur le bouton «Analyze All». Le spectre de la sélection délimitée ou
de l’objet sélectionné est alors analysé. Une fois l’opération terminée, la
réponse en fréquences obtenue vient s’afficher sur le graphique sous la forme
d’une courbe bleue.

7. Vous pouvez dès lors agir sur n’importe quelle portion de la courbe bleue au
moyen de la souris. En d’autres termes : Si vous remarquez une forte crête à
1000 Hz (et que le son est très criard à cet endroit), servez-vous de la souris
pour la réduire. Le correcteur/analyseur FFT est l’outil idéal pour adoucir des
fréquences stridentes.
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8. Cliquez sur un des boutons de lecture-test pour entendre en temps réel le

résultat de vos changements sur la courbe de fréquences.
9. Répétez les étapes 6 et 7 jusqu’à ce que vous arriviez à la réponse en fréquences

recherchée. Si vous souhaitez recommencer l’édition de la courbe depuis le
début, réinitialisez celle-ci simplement à l’aide du bouton «Reset».

10. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin
d’appliquer le traitement sur le projet Wave ou l’objet sélectionné, et de
refermer la fenêtre FFT Filter/Analyzer.

Accentuation ou réduction du registre des infra-graves:
1. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,

passez sur sa fenêtre. S’il doit être appliqué sur un objet VIP, sélectionnez
cet objet (en cliquant dans sa moitié inférieure).

2. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,
faites une sélection temporelle (Range) dans la fenêtre de projet Wave. S’il
doit être appliqué sur un objet VIP, passez à l’étape 3.

3. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

4. Dans le coin inférieur gauche de la fenêtre, sélectionnez le mode d’affichage
en partiels (Draw mode).

5. Cliquez sur (activez) l’option Direct/Match (du côté droit de la fenêtre - Edit
mode).

6. Cliquez ensuite sur le bouton Settings pour ouvrir la fenêtre des réglages
avancés (Advanced Settings). Réglez le paramètre Resolution sur 16384.
Fermez (Close) la fenêtre Advanced Settings.

7. Cliquez sur le bouton «Analyze All». Le spectre de la sélection délimitée ou de
l’objet sélectionné est alors analysé. Une fois l’opération terminée, la réponse
en fréquences obtenue vient s’afficher sur le graphique sous la forme d’une
courbe bleue.

8. Vous pouvez dès lors agir sur n’importe quel harmonique entre 10 Hz et
50 Hz au moyen de la souris. Attention : Vous risquez d’endommager vos
enceintes si vous amplifiez les infragraves de manière excessive. Baissez
toujours le volume de vos enceintes d’écoute avant de procéder à un tel
réglage ! Cliquez à droite de chaque «partiel», puis ajustez-en le niveau en
faisant glisser la souris.

9. Cliquez sur un des boutons de lecture-test pour entendre en temps réel le
résultat de vos changements sur la courbe de fréquences.

10. Répétez les étapes 8 et 9 jusqu’à ce que vous arriviez à la réponse en
fréquences recherchée. Si vous souhaitez recommencer l’édition de la courbe
depuis le début, réinitialisez celle-ci simplement à l’aide du bouton «Reset».

11. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin
d’appliquer le traitement sur le projet Wave ou l’objet sélectionné, et de
refermer la fenêtre FFT Filter/Analyzer.

Réglage de l’amplitude d’un instrument ou d’une note spécifique:
1. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,

passez sur sa fenêtre. S’il doit être appliqué sur un objet VIP, sélectionnez
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cet objet (en cliquant dans sa moitié inférieure).

2. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,
faites une sélection temporelle (Range) dans la fenêtre de projet Wave. S’il
doit être appliqué sur un objet VIP, passez à l’étape 3.

3. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

4. Dans le coin inférieur gauche de la fenêtre, sélectionnez le mode d’affichage
en partiels (Draw mode).

5. Cliquez sur (activez) l’option Direct/Match (du côté droit de la fenêtre - Edit
mode).

6. Cliquez sur le bouton «Analyze All». Le spectre de la sélection délimitée ou
de l’objet sélectionné est alors analysé. Une fois l’opération terminée, la
réponse en fréquences obtenue vient s’afficher sur le graphique sous la forme
d’une courbe bleue.

7. Cliquez sur le bouton «Zoom Max» pour un zoom avant maximum sur le
graphique.

8. Pour agir sur l’amplitude d’un instrument, cochez la case Hz (du paramètre
Hz/Notes). La fréquence s’affiche alors en Hertz (Hz). Pour agir sur
l’amplitude d’une note, cochez la case Notes (du paramètre Hz/Notes). La
fréquence s’affiche alors sous forme de hauteurs musicales (Notes).

9. Pour agir sur l’amplitude d’un instrument, repérez sa plage de fréquences
fondamentale (là où les fréquences sont les plus fortes), puis redessinez les
«partiels» dans cette zone (augmentez leur taille pour accentuer l’amplitude
ou réduisez-la pour diminuer l’amplitude). S’il s’agit d’une note, repérez sa
plage de fréquences, puis redessinez-la (augmentez sa taille pour accentuer
l’amplitude ou réduisez-la pour diminuer l’amplitude).

10. Cliquez sur un des boutons de lecture-test pour entendre en temps réel le
résultat de vos changements sur la courbe de fréquences.

11. Répétez les étapes 9 et 10 jusqu’à ce que vous arriviez à la réponse en
fréquences recherchée. Si vous souhaitez recommencer l’édition de la courbe
depuis le début, réinitialisez celle-ci simplement à l’aide du bouton «Reset».

12. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin
d’appliquer le traitement sur le projet Wave ou l’objet sélectionné, et de
refermer la fenêtre FFT Filter/Analyzer.

Application de la réponse en fréquences capturée dans un autre
enregistrement:
1. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,

passez sur sa fenêtre. S’il doit être appliqué sur un objet VIP, sélectionnez
cet objet (en cliquant dans sa moitié inférieure).

2. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,
faites une sélection temporelle (Range) dans la fenêtre de projet Wave. S’il
doit être appliqué à un objet VIP, passez à l’étape 3.

3. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

4. Cliquez sur (activez) l’option Direct/Match (du côté droit de la fenêtre - Edit
mode).
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5. Cliquez sur le bouton «Analyze All». Le spectre de la sélection délimitée ou de

l’objet sélectionné est alors analysé. Une fois l’opération terminée, la réponse
en fréquences obtenue vient s’afficher sur le graphique sous la forme d’une
courbe bleue.

6. Cliquez sur le bouton Analyze > Filter afin d’appliquer à la courbe rouge la
courbe de réponse en fréquences analysée. Cliquez sur (activez) l’option Filter
(Edit mode). La courbe rouge (représentant la réponse en fréquences audio
analysée) apparaît sur le graphique.

7. Cliquez sur Cancel pour fermer la fenêtre FFT Filter/Spectrum Analyzer.
8. À présent, si vous souhaitez appliquer la réponse en fréquences analysée

(courbe rouge) directement à un projet Wave, vérifiez que la fenêtre de ce
dernier est la fenêtre active. De même, si elle doit être appliquée à un objet
VIP, veillez à bien sélectionner cet objet (en cliquant dans sa moitié inférieure).

9. Si vous souhaitez appliquer la réponse en fréquences analysée (courbe rouge)
directement à un projet Wave, faites une sélection temporelle (Range) dans
la fenêtre de projet Wave appropriée. Si vous devez appliquer l’analyseur/
filtre FFT à un objet VIP, passez à l’étape 10.

10. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

11. Cliquez sur un des boutons de lecture-test pour une écoute en temps réel.
12. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin

d’appliquer le traitement sur le projet Wave ou l’objet sélectionné, et de
refermer la fenêtre FFT Filter/Analyzer.

Fondu enchaîné entre deux courbes de filtre:
1. Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,

passez sur sa fenêtre. S’il doit être appliqué sur un objet VIP, sélectionnez
cet objet (en cliquant dans sa moitié inférieure).

2.  Si vous devez appliquer l’analyseur/filtre FFT directement sur un projet Wave,
faites une sélection temporelle (Range) dans la fenêtre de projet Wave. S’il
doit être appliqué à un objet VIP, passez à l’étape 3.

3. Allez au menu Offline Effects, puis lancez la commande FFT Filter/Analyzer,
et la fenêtre FFT Filter/Spectrum Analyzer s’ouvrira.

4. Dans le coin inférieur gauche de la fenêtre (Draw mode), sélectionnez le mode
«Courbe». La réponse en fréquences sera affichée sous forme de courbe.

5. Cliquez sur (activez) l’option Filter.
6. Cliquez sur (activez) l’option Dynamic Start.
7. La courbe bleue affichée correspond alors à la réponse en fréquences de départ

du fichier audio. Cochez à présent l’option Dynamic End  sous Filter mode.
8. Modifiez à la souris le tracé de la courbe rouge (alors affichée sous forme de

ligne droite à 0 dB). Vous générez ainsi les variations relatives à apporter à la
réponse en fréquences.

9.  Cliquez sur un des boutons de lecture-test pour entendre en temps réel le
résultat du fondu-enchaîné de courbes de fréquences.

10. Répétez les étapes 8 et 9 jusqu’à ce que vous arriviez à la réponse en
fréquences recherchée. Si vous souhaitez recommencer l’édition de la courbe
depuis le début, réinitialisez celle-ci simplement à l’aide du bouton «Reset».
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11. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin

d’appliquer le traitement sur le projet Wave ou l’objet sélectionné, et de
refermer la fenêtre FFT Filter/Analyzer.

Problèmes et solutions concernant le correcteur/analyseur FFT
1. Léger effet de trémolo ou d’écho, ou son un peu râpeux:
Ceci peut arriver si vous avez coché «Low» pour Precision dans la fenêtre
Advanced Settings. Utilisez un autre réglage de précision.

2. Effets de modulation sur les plages de fréquences graves en cas de réglages de filtre
extrêmes:
Ceci est également dû au réglage «Low» pour Precision dans la fenêtre Advanced
Settings. Utiliser un autre réglage de précision peut résoudre le problème.

3. Problèmes d’écoute test en temps réel lorsque la résolution est élevée:
Vérifiez que la taille de la mémoire tampon Test Buffer (menu Options ->
System/Audio->Advanced buffer Settings) est supérieure ou égale à celle de la
résolution (fenêtre Advanced Settings) du filtre FFT.

4. Il est impossible d’éliminer totalement certaines plages du spectre:
Vérifiez que vous êtes bien en mode d’édition Filter, puis réduisez le réglage dB
Min à une valeur entre –100 et –120 dB.

5. Différences entre filtrage et analyse:
Après filtrage et une seconde analyse de la réponse en fréquence de la sélection
éditée, le nouveau processus analytique ne coïncide pas avec la réponse en
fréquence corrigée (la courbe bleue) avant traitement. Pourquoi? Les réponses
se ressembleront si vous utilisez Analyze All et le réglage Precision «High»
avant le filtrage et pour la nouvelle analyse.

6. De la résonance apparaît lors de l’application d’un filtre passe-bande dont la largeur
est très étendue:
Réduisez les angles de la courbe en évitant de tracer des lignes verticales.

7. Les résultats de la transition pour le filtrage dynamique sont irréguliers en mode de
filtrage Dynamic Start ou Dynamic End:
Utilisez le réglage le plus haut pour Precision.
Le mode de filtrage dynamique Direct réduit ce problème quand des valeurs
moindres sont employées pour la résolution. Pour les autres modes de filtrage
dynamique, faites des essais avec différents réglages.

8. Les résultats obtenus après calcul des réglages (OK) ou pré-écoute différée ne
correspondent pas aux résultats obtenus au moyen de l’écoute test en temps réel (bouton
Play/Stop):
Réglez les paramètres Precision et Precision Real Time du filtre dans la fenêtre
Advanced Settings) sur la même valeur. Faites attention à ces réglages quand
vous travaillez avec le filtre FFT.
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Enfin, faites toujours preuve de patience et de rigueur dans le réglage du correcteur/
analyseur FFT. N’oubliez pas de bien garder à l’esprit vos réglages afin d’éviter toute
confusion ou inexactitude, et par-dessus tout, n’oubliez pas de cocher la case Create
Copy pour pouvoir annuler!

Dynamics (généralités)
Généralités concernant la manipulation dynamique
Voici une présentation des trois modules de traitement dynamique proposés
par Samplitude:

Dynamics: Module de traitement dynamique rapide et simple d’emploi pouvant
être configuré en mode compresseur, expandeur, gate ou limiteur. Ce module
utilise un algorithme extrêmement efficace qui ne sollicite que peu les ressources
du processeur.

Advanced Dynamics: Ce module est un outil plus complet combinant un
module dynamique classique (compresseur/expandeur/gate), et un limiteur
approchant. Au final, vous obtenez un signal modulé de manière optimale et
sans aucun effet secondaire avec un volume parfaitement ajusté.
Contrairement au correcteur dynamique standard, le mode de fonctionnement
n’est pas déterminé par des configurations – le mode est ici uniquement
déterminé par la ligne des caractéristiques. Il est ainsi possible de combiner
librement les différents modes de fonctionnement.
Vous pouvez régler les paramètres sur la ligne de caractéristiques du graphique
ou en indiquant les valeurs désirées dans les champs prévus à cet effet.
La détection des niveaux peut s’effectuer en mode PEAK (crêtes), RMS (niveaux
efficaces) ou «fast» (rapide). En mode «fast», l’ordinateur est moins sollicité,
mais le mode de fonctionnement diffère tout de même des modules de correction
standard. Le mode RMS reproduit exactement le comportement des processeurs
dynamiques analogiques. Un son plus vivant est obtenu en mode PEAK.

Multiband Dynamics: Ce module correcteur dynamique multibande offre
les capacités de traitement dynamique les plus complètes. Le principal avantage
de la manipulation dynamique sur plusieurs bandes de fréquences (par rapport
à un correcteur dynamique standard) est que les effets secondaires de type
«pompage» et autres sont spectaculairement réduits. Par exemple, la présence
d’une crête dans les aigus n’entraînera pas l’atténuation de la totalité du signal
y compris dans les graves, vous permettant de focaliser le traitement sur des
plages de fréquences.

Quel module utiliser et quand?
L’emploi de tel ou tel module dynamique dépend de l’application et de la précision
de traitement souhaitée. Un correcteur dynamique simple (module «Dynamics»)
est présent sur toutes les voies de mixage car ce module est très simple d’emploi
et consomme extrêmement peu de ressources processeur. Il permet ainsi d’agir
sur la dynamique des pistes avec la plus grande facilité.
Le son d’un objet doit souvent au contraire être modifié de façon très spécifique.
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Par exemple, la dynamique d’un instrument peut varier entre le couplet et le
refrain en raison du changement de style de jeu. C’est généralement désirable,
mais cela peut être adouci ou accentué par un emploi précis de la compression.
Dans ce cas, l’emploi du module Advanced Dynamics module est conseillé car
il vous permettra d’agir de manière optimale sur le comportement des données
source.
Le module Multiband Dynamics est généralement employé en section Master
pour l’optimisation de la balance finale du morceau. Toutefois, comme de
l’écrêtage peut toujours survenir en sortie de ce correcteur (rappelons qu’il relève
les niveaux), il est parfois nécessaire d’insérer un limiteur en bout de chaîne,
afin qu’il ramène tous les échantillons problématiques au niveau du seuil de
limitation. Si vous avez l’intention d’utiliser le module Multiband Dynamics en
mastering de CD, appliquez-le de préférence au niveau de chaque objet (avec
l’éditeur d’objet) afin de le configurer précisément pour chaque morceau (chaque
objet pointant dans ce cas sur un fichier qui est un mixage stéréo de morceau
complet).
Sachez par ailleurs que les ingénieurs de Mastering se méfient souvent des
correcteurs dynamiques multibandes. En réalité, nous pouvons raccourcir la
phrase: les ingénieurs de Mastering expérimentés se méfient souvent, ou pour
le dire autrement - «il n’y a pas d’ingénieur de mastering à la fois intrépide et
expérimenté». Commencez-vous à voir où nous voulons en venir? Les correcteurs
dynamiques multibandes sont apparus relativement tardivement, même si une
variante a toujours existé sous la forme des processeurs à circuit de détection
(dé-esseur, par exemple) depuis les débuts de la compression et de la correction.
Les ingénieurs de Mastering sont assez conservateurs par nature et utilisent la
compression avec parcimonie (même s’il y a toujours des exceptions !). Les
premiers compresseurs multibandes présentaient des problèmes de déphasage,
donnant une coloration de la réponse en phase. Parfois, l’effet faisait plus de
mal que de bien.
Ces dernières années, les avancées en matière de puissance de calcul et
d’algorithmes DSP ont vu la prolifération de puissants processeurs dynamiques
multibandes. Ils sont capables de résoudre certains problèmes de Mastering
jusque-là très difficiles à gérer. Le correcteur dynamique multibande à phase
cohérente de Samplitude en est la plus belle démonstration. Attention toutefois,
une telle puissance peut s’avérer dangereuse si elle est mal maîtrisée. De
nombreux ingénieurs de Mastering de renom critiquent la course actuelle à
l’hypercompression (où le volume de chaque CD doit être aussi fort que possible)
rendue possible par les compresseurs multibandes et autres «finaliseurs»
logiciels ou matériels. Même si cette critique est en partie fondée, ce ne sont pas
les processeurs qui sont à blâmer – c’est l’opérateur qui détermine comment va
sonner son morceau.

Note: Il est parfois bien difficile d’éviter l’hypercompression, étant donné que
votre client ou employeur exige toujours que le CD sonne très fort lorsqu’il
passe en radio ! Nous le comprenons bien... Faites simplement en sorte que vos
morceaux soient vivants.
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Le correcteur dynamique multibandes de Samplitude bénéficie d’une puissance
incroyable adaptée à toutes les situations (même s’il est préférable de ne l’utiliser
que lorsque cela est nécessaire). Avant d’appliquer de la compression multibande
lors du mixage final d’un projet multipiste, vérifiez si les signaux à corriger se
limitent à une ou deux pistes. Si c’est le cas, autant appliquer le correcteur
dynamique multibande depuis l’éditeur d’objet pour ces pistes/objets, plutôt
que de l’insérer de manière globale sur la section Master. En Mastering,
réfléchissez bien à l’utilité d’insérer le correcteur dynamique multibande. De
même, ne vous précipitez pas lors du réglage de ses paramètres et assurez-vous
qu’ils apportent quelque chose au mixage.
Il peut même arriver que le module Advanced Dynamics soit mieux adapté à
votre projet. En Mastering, on parle de compression de bus car le processeur est
inséré sur le bus de sortie stéréo. Concrètement, c’est la totalité du spectre du
signal de sortie qui est traité.
Le module Advanced Dynamics recrée le son jusque-là inimitable des
compresseurs/limiteurs de bus vintage, qui ont façonné le son de très nombreux
enregistrements de légende. Vous pouvez par ailleurs vous en servir pour
«bidouiller» votre signal et lui faire prendre des formes insoupçonnées (ce qui
intéressera à coup sûr les créateurs sonores et les créateurs multimédia). En
fait, il suffit de bien identifier les traitements nécessaires aux données audio,
puis de paramétrer patiemment l’effet jusqu’au résultat recherché.
Si vous utilisez le module Multi Band Dynamics, il est souvent utile d’insérer à
sa suite le module Advanced Dynamics (configuré en mode limiteur). Si vous
êtes à court de puissance de DSP (ressources de processeur), essayez d’employer
à la place le module Dynamics standard (configuré en mode limiteur).
Pour les opérations de Mastering CD, il est recommandé d’appliquer le module
Multi Band Dynamics au niveau de chaque objet (plage de CD) afin de pouvoir
agir séparément sur chacune des plages du CD.
Le tableau suivant montre à quels niveaux chaque module dynamique est
disponible:

Dynamics…
Choisissez cette option pour ouvrir la fenêtre Compressor/Expander/Noise Gate/
Limiter où vous pouvez régler, de manière destructive, la dynamique de projets
Wave ou bien des objets sélectionnés en fenêtre VIP.
Le compresseur agit sur la plage dynamique des échantillons audio. Ces
algorithmes de traitement fonctionnent de manière anticipée (»prédictive») pour
éliminer les distorsions de crêtes et les autres artefacts. Vous pouvez en
permanence visualiser à l’écran la courbe de dynamique en vigueur. Vous pouvez
également configurer le correcteur dynamique comme expandeur, noise gate ou
limiteur.



361

Menu «Offline Effects»

Note: La table de mixage (raccourci – «M») et l’éditeur d’objet offrent également un
compresseur pour chaque voie et chaque objet. Ce compresseur fonctionne en temps
réel dans l’environnement virtuel – le matériel audio d’origine sur le disque n’est pas
altéré (processus non destructif).

Mode
Le correcteur dynamique peut être configuré comme compresseur, limiteur,
expandeur, ou gate. Sélectionnez le mode voulu dans le menu déroulant Mode
pour appliquer le traitement dynamique spécifié.

Note: Le traitement dynamique est un véritable travail d’orfèvre – son étude complète
dépasse d’ailleurs largement le cadre de ce mode d’emploi. Sachez simplement qu’un
soin tout particulier doit être apporté lors de l’utilisation des compresseurs car ils
peuvent véritablement retirer toute la vie et le caractère d’enregistrements pourtant
parfaits! Nous partons du principe que vous êtes familiarisé avec les traitements
dynamiques ainsi que la terminologie et les méthodes qui leur sont associées.

Compressor: L’algorithme de traitement dynamique est similaire à celui d’un
compresseur «classique».
La dynamique d’une bande de fréquences est limitée, le niveau des passages
forts est réduit (compressé) alors que celui des passages doux n’est pas modifié.
Ce mode permet de colorer légèrement le son sans pour autant relever son
volume.
Réglez le taux de compression avec le paramètre Ratio, le seuil avec Threshold
et l’enveloppe avec les réglages de temps d’attaque (Attack) et de rétablissement
(Release).

Comp Max: Identique au mode Compressor, mais avec un niveau de sortie
normalisé à 0 dB. Cet algorithme limite la dynamique d’une bande de fréquences
: les passages forts restent à un niveau élevé tandis que le niveau des passages
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doux est relevé. Optez pour ce traitement afin de conférer de la présence à vos
données audio, de les faire ressortir ou de relever leur volume. Ce type de
traitement est également baptisé «Maximiseur» ou «Enhancer de niveau sonore».

Limiter: Ce mode limite la dynamique de l’audio à un niveau seuil (Threshold)
prédéfini. Seuls les passages les plus forts (dont le niveau dépasse le niveau de
seuil) sont limités. Les passages doux ne sont pas affectés.
Le taux ou rapport d’action (Ratio) est fixé automatiquement sur l’infini.

Limiter 100: Identique au mode Limiter, mais avec un niveau de sortie normalisé
à 0 dB.
Le taux ou rapport d’action (Ratio) est fixé automatiquement sur l’infini.

Expander: Ce traitement permet d’accroître la dynamique d’un morceau, les
passages forts restent forts et les passages doux (inférieurs au seuil) deviennent
encore plus doux. Ce traitement est très souvent utilisé lors de l’enregistrement
de commentaires souffrant d’un fort niveau de distorsion. Une fois l’expansion
appliquée, le niveau de la voix est relevé au dessus du bruit de fond qui est lui
supprimé.
Ce mode est par ailleurs idéal pour restaurer la dynamique d’anciens
enregistrements ou pour le transfert de vinyles ou de cassettes sur CD.
N’oubliez pas que le signal à traiter doit disposer d’une certaine marge dynamique
pour éviter que l’expandeur ne le fasse saturer!

Gate: Ce traitement permet de réduire ou de supprimer les signaux inférieurs à
un certain niveau de seuil. Les niveaux supérieurs à ce seuil restent par contre
parfaitement intacts. Les passages très doux (inférieurs au niveau de seuil) sont
réduits ou ramenés complètement à zéro. Sachez que la fonction gate fait aussi
partie de tous les autres modes. Utiliser le mode Gate dédié réduit la charge du
processeur si vous ne voulez pas appliquer d’autre correction dynamique à ce
niveau.

Ratio/Threshold
Cette section regroupe les paramètres Ratio (taux ou rapport) et Threshold (seuil)
que vous pouvez régler au moyen de leurs curseurs respectifs ou de leurs champs
numériques. Vous pouvez remarquer que la courbe affichée sur le graphique
de gauche évolue en fonction des réglages de Ratio et de Threshold.

Note: Le bouton «Linear» permet de réinitialiser le paramètre Ratio sur un taux de 1
(compresseur ou expandeur désactivé).

Attack/Release
Cette section regroupe les paramètres Attack (durée d’attaque) et Release (durée
de rétablissement) que vous pouvez régler au moyen de leurs curseurs respectifs
ou de leurs champs numériques.
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Gain
Décale le niveau de sortie général pour compenser la variation de niveau.

Gate
Cette section permet de définir le niveau (seuil) de l’effet gate au moyen du
curseur de réglage ou du champ numérique (dB). Vous pouvez remarquer que
la courbe affichée sur le graphique de gauche évolue en fonction du réglage de
Gate.
Conseil d’utilisation : Vous pouvez configurer un gate dans tous les modes par le biais
de ce réglage.

Play/Stop
Ce bouton permet de lancer l’écoute test en temps réel du correcteur dynamique
sur les données audio sans avoir à quitter sa fenêtre. Toutes les pistes du VIP
sont relues avant que vous puissiez effectuer vos réglages dans le contexte de la
production. Si vous le souhaitez, vous pouvez également isoler les données audio
à traiter au moyen de leur bouton Solo dans le VIP.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement dynamique
configuré sur les données audio. La fenêtre Compressor/Expander/Noise Gate/
Limiter se referme ensuite.

Cancel
Ce bouton referme la fenêtre Compressor/Expander/Noise Gate/Limiter sans
valider les réglages de correction dynamique définis.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!

Bypass
Cliquez sur (activez) cette option pour court-circuiter le processeur dynamique.
Cela vous permet de rapidement désactiver/réactiver le traitement dynamique
afin de permettre une comparaison avec/sans traitement.

Preset
Save: Cliquez sur le bouton «Save» pour sauvegarder sous forme de configuration
(preset) les réglages en vigueur dans le correcteur dynamique. Vous accédez à
une boîte de dialogue Windows standard où vous pouvez donner un nom au
fichier à créer. Nommez le fichier de configuration, puis cliquez sur OK. La
configuration en question est alors sauvegardée.
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Load: Cliquez sur le bouton «Load» pour rappeler en mémoire une configuration
de réglages (preset) du correcteur dynamique préalablement sauvegardée. Vous
passez sur une boîte de dialogue Windows standard où vous pouvez choisir le
fichier à recharger. Sélectionnez la configuration désirée, puis cliquez sur OK.
La configuration est alors rechargée en mémoire.

Delete: Cliquez sur le bouton «Delete» pour supprimer une configuration
(preset) de correcteur dynamique préalablement sauvegardée. Une fenêtre de
dialogue apparaît, demandant si vous voulez vraiment supprimer la configuration
(preset). Cliquez sur «Yes» pour la supprimer. Cliquez sur «Cancel» pour
interrompre la procédure de suppression. Vous pouvez utiliser la liste déroulante
Preset (en haut à gauche de la fenêtre) pour rapidement charger toute
configuration préalablement sauvegardée. Cliquez simplement sur la flèche
dirigée vers le bas, puis sélectionnez la configuration désirée.

Advanced Dynamics

Commandes générales et presets
Hard: Lorsque le bouton Hard est enclenché, le signal de sortie est limité
exactement sur la valeur de volume fixée. Autrement dit, aucun échantillon ne
pourra être plus fort que le niveau affecté au paramètre de seuil du limiteur. Les
signaux ne sont bien évidemment pas tronqués simplement au niveau de la
valeur plafond. Un algorithme amène les signaux jusqu’à cette valeur plafond
aussi délicatement que possible sans répercussions sur le son d’origine. Si le
bouton Hard n’est pas enclenché, l’algorithme se comporte comme un limiteur
analogique et se base sur les caractéristiques de transmission définies.

Soft: Doté d’une plage de réglage de 1 à 20, ce paramètre d’articulation douce
ou «Soft Knee» permet de définir la progressivité des caractéristiques. Avec la
valeur 1.0, les transitions se font directement sans aucune progressivité. Cette
technique est très utile si les variations sont très nettes entre les signaux
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compressés et les signaux non compressés – c’est-à-dire quand le niveau du
signal fluctue autour de l’articulation. Ce paramètre permet de réaliser des
transitions douces.

Portée dynamique: Cette zone (de la forme d’un nuage) apparaît si vous lancez
la lecture. Elle permet de visualiser les niveaux d’entrée et de sortie du signal
durant le traitement dynamique.

Affichage de réduction (Red.): Cet afficheur indique la différence de niveau
moyenne entre le signal d’entrée et le signal de sortie.

Affichage d’entrée (In): Indique le niveau d’entrée en dB.

Affichage de sortie (Out): Indique le niveau de sortie en dB.

Reset: Réinitialise les afficheurs de réduction (Red.), d’entrée (In) et de sortie
(Out).

Mode: les modes sont des applications typiques du module Advanced Dynamics.
Ils constituent des réglages par défaut qui facilitent l’édition graphique des
caractéristiques. Pour cela, le nombre de paramètres éditables peut être réduit
en fonction du mode sélectionné. Par exemple, en sélectionnant Limiter, les
compresseurs 1 et 2 sont masqués car non nécessaires.

Preset: Save, Load, Delete: Cette section permet de sauvegarder (Save), recharger
(Load) et effacer (Delete) des configurations de réglages (presets). Leur extension
de fichier est *.dy2.
Vous pouvez même charger les configurations du correcteur dynamique standard
(*.dyn).. Les paramètres en question seront alors convertis en ceux du module
Advanced Dynamics. Si vous sauvegardez ensuite depuis le module Advanced
Dynamics, le preset sera sauvegardé avec l’extension *.dy2.

OK: Ce bouton valide les réglages effectués.

Cancel: Ce bouton referme la fenêtre sans valider les réglages.

Help: Ce bouton vous donne accès à l’aide en ligne de Samplitude.

Manipulation de la ligne des caractéristiques (sur le graphique)
Pour manipuler la ligne des caractéristiques de traitement à l’écran, cliquez sur
l’une des poignées de cette ligne. Un clic droit sur une poignée affiche la valeur
du paramètre correspondant dans une bulle d’aide. Si vous bougez une poignée
de la ligne, vous changez sa valeur. Il faut savoir que déplacer une poignée peut
avoir dans certains cas un impact sur les valeurs des autres poignées.
Pour placer directement les poignées du graphique sur une position donnée,
cliquez dessus avec le bouton droit de la souris. Un champ s’affiche alors où
vous pouvez indiquer une valeur d’entrée (INPUT) et de sortie (OUTPUT).
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Pour une meilleure distinction des différentes sections de traitement, celles-ci
bénéficient de couleurs différentes. La couleur des poignées vous renseigne sur
la section et les paramètres qui s’y rapportent.
Si le bouton Hard est enclenché, un champ rayé rouge «LIMITED ZONE»
apparaît sur le graphique lorsque le volume du limiteur est inférieur à 0 dB. Ce
champ indique qu’aucun échantillon ne peut venir franchir cette zone; tous les
échantillons ne peuvent avoir qu’un niveau inférieur ou égal à celui défini par le
limiteur.
Pour masquer une poignée, amenez le curseur de seuil (Threshold)
correspondant sur 0 dB. Pour que la poignée soit de nouveau visible sur le
graphique, vous devez abaisser le seuil en question en dessous du seuil du
limiteur.

Manipulation de la ligne des caractéristiques (paramétriquement)
Threshold: Fixe le niveau de seuil d’entrée (en dB) au-dessus duquel se
déclenche le traitement correspondant.

Ratio: Définit le rapport niveau d’entrée / niveau de sortie.

Limiter: Ce réglage de niveau (en dB) détermine le niveau maximum possible
en sortie. Tenez compte du paramètre HARD.

Gate Level: Ce réglage de niveau (en dB) le niveau de seuil en dessous duquel
le signal est ramené à 0 dB.

Gain (compensation): Déplace la totalité de la ligne de caractéristiques (en
dB), sans affecter les réglages de limiteur et de gate.
Toute variation de ces paramètres a un effet direct sur la ligne des caractéristiques
dynamiques du graphique, ainsi que sur les autres paramètres. A titre d’exemple,
un gate rendra inefficaces tous les changements de niveau inférieurs à son propre
niveau.
Tous les réglages de seuil (Threshold) et de niveau (Level) restent tels que réglés.
Les réglages de rapport (Ratio) peuvent être modifiés par les paramètres Gain et
Soft. Si le gain est changé, seul le rapport géométrique du niveau d’entrée et du
niveau de sortie (du point de vue des seuils) est conservé. Le rapport réel sortie/
entrée est le réglage Ratio + Gain.

Paramètres de traitement dynamique
Méthodes de mesure des niveaux: La façon dont le compresseur réagit aux
données sources dépend de ses réglages d’enveloppe (en fonction du temps).

PEAK (niveaux de crêtes): Dans ce mode, le correcteur dynamique est plus
vivant, mais peut en contrepartie être plus agressif.

RMS (niveaux efficaces): Correspond au mode de fonctionnement des
processeurs dynamiques analogiques; le son est relativement rond et équilibré,
mais moins vivant. C’est uniquement le curseur Attack qui détermine la
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constante de temps nécessaire à la détection du signal (pour obtenir le signal de
contrôle). Les deux constantes de temps sont aussi évaluées ici, pour lisser le
signal (avec manipulation dynamique du signal).

Fast Rapide (rapide): La force de cette procédure est son faible recours au
processeur. Ce réglage peut être utilisé pour bien décaler les crêtes de niveau.
Cette fonction est à utiliser si vous arrivez au bout des ressources de votre
processeur et que les objets nécessitent peu de traitement dynamique. Le niveau
maximal en sortie ne peut jamais être supérieur au niveau du limiteur.

Les constantes de temps régulent substantiellement les caractéristiques du son.
Des réglages trop faibles peuvent entraîner des effets de distorsion alors que
des réglages trop élevés peuvent occasionner des phénomènes de «pompage».

Attack: Constante de temps de réaction à l’accroissement du niveau du signal
(en ms). Cela détermine avec quelle rapidité le traitement dynamique réagit à
une crête du niveau d’entrée.

Release: Constante de temps de réaction à la redescente du niveau du signal
(en ms). Cela détermine avec quelle rapidité le traitement dynamique réagit au
retour à la normale du niveau d’entrée.

Preview: Si cette option n’est pas cochée, la section dynamique ne fonctionne
pas en mode pré-écoute, ce qui peut entraîner des artefacts (pompage) et de la
surmodulation. Par ailleurs, si la pré-écoute est désactivée, les attaques très
franches des formes d’ondes ne sont pas atténuées – le son prend alors un
caractère plus vivant et vigoureux. Il est recommandé de désactiver la pré-écoute
si vous souhaitez recréer le comportement sonore des modules de traitement
dynamique analogiques.

L’affichage de portée dynamique
Cette zone apparaît sur le graphique lorsque vous lancez la lecture via le bouton
Play/Stop. Un «nuage de neige» apparaît dans la représentation graphique.
Chaque point de ce nuage représente la différence de valeur de sortie, au dessus
de la valeur d’entrée correspondante (en dB).
Vous allez mieux comprendre le fonctionnement de cette affichage au moyen
de l’exemple suivant:
Sélectionnez le preset 0 - «NULL» - et pressez PLAY. Aucun «nuage de neige»
n’est visible, car tous les niveaux d’échantillon sont sur la ligne droite – c’est-à-
dire que toutes les valeurs de sortie sont égales aux valeurs d’entrée.
Si vous montez le curseur de gain, vous constatez que le « nuage de neige « suit
la ligne des caractéristiques. Si vous sélectionnez des constantes de temps (Attack
et Release) très élevées, cela se fait relativement lentement.
En sélectionnant un temps assez court pour Attack (10 ms), assez long pour
Release (400 ms) et une ligne de caractéristiques très cintrée, il est possible de
créer un phénomène de pompage très net – Essayez! Le mouvement graphique
du nuage reflète le «pompage».
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En sélectionnant de très petites constantes de temps, vous pouvez à présent
visualiser le mode de fonctionnement d’un générateur d’harmonique simple.

Conseils d’utilisation du module Advanced Dynamics
Outre ses caractéristiques sonores, la grande force de cet effet réside dans son
traitement graphique de la dynamique et de ses composantes. Les presets vous
permettront d’arriver rapidement au but recherché, après quelques ajustements
possibles en fonction des données audio à traiter. Tout cela reste toutefois très
simple car vous pouvez isoler précisément chaque composant du signal au moyen
de l’affiche de portée dynamique.
Si le «nuage de neige» bouge de façon saccadée, cela est probablement dû à un
mauvais réglage des constantes de temps (Attack et Release). Vérifiez donc ces
deux curseurs et ajustez-les en fonction du résultat recherché. N’oubliez pas
que vous pouvez sauvegarder vos propres réglages d’effets (presets) et que vous
pourrez les réutiliser ultérieurement.
Pour pouvoir combiner le limiteur «analogique» avec l’algorithme de limiteur
Hard, réglez le niveau du limiteur sur la valeur plafond souhaitée. Vous pouvez
dès lors simuler un limiteur «analogique» en utilisant en réglage extrême du
paramètre Ratio (10.0 pour un compresseur ou 0.1 pour un expandeur).

Multi Band Dynamics

Ce correcteur dynamique multibande vous permet de traiter séparément la
dynamique de quatre bandes de fréquences indépendantes. Le signal – signal
de commande y compris – est divisé en bandes de fréquences séparées, chacune
étant traitée individuellement par un correcteur dynamique.
Une fois traitées, toutes les bandes sont rassemblées sans variation de phase ni
modification de la réponse en fréquences. La technique de filtrage RIF (réponse
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impulsionnelle finie) employée durant le traitement est responsable de la haute
qualité d’effet.
Si vous décidez de réunir les bandes de fréquences sans les traiter, vous retrouvez
le signal d’origine sans aucune dégradation.
Le plus gros avantage du correcteur dynamique multibande (par rapport à un
correcteur dynamique standard) est que les effets secondaires de type «pompage»
et autres sont spectaculairement réduits. Par exemple, la présence d’une crête
dans la bande des graves n’entraînera pas l’atténuation de la totalité du signal
durant le traitement. Ce problème est totalement éliminé grâce à un correcteur
multibande réglé pour ne compresser que les crêtes de basses. Le compresseur
multibande permet un traitement spécifique et  individuel des divers plages de
fréquences.

Characteristics
L’affichage graphique en haut à gauche représente la ligne de référence
dynamique. C’est la relation entre le niveau d’entrée (axe horizontal, en dB) et le
niveau de sortie (axe vertical, en dB).
Les lignes de référence représentent toujours les réglages de dynamique de toutes
les bandes de fréquence de la section de réglage des bandes, chaque ligne ayant
la couleur correspondante. Vous pouvez amener une bande sur le devant du jeu
de courbes pour une meilleure visibilité en sélectionnant une des commandes
d’édition de la bande voulue ou en cliquant au dessus sur son numéro (Band
1..4).
Copy to all: Cliquez sur ce bouton pour copier le traitement dynamique de la
bande sélectionnée. Les réglages de cette bande seront aussi appliqués à TOUTES
les bandes actuellement utilisées.

Réglages de filtrage
La section supérieure droite de la fenêtre regroupe la section de réglage des
filtres. Le graphique  vous représente la réponse en fréquence approchée de
chacune des bandes. Chaque bande a sa propre ligne de couleur. L’ordonnée
(axe vertical) indique l’absorption (réduction) en dB tandis que les chiffres
mentionnés sur l’abscisse (axe horizontal) indiquent les fréquences en kHz.
Cette section gère les fréquences des différentes bandes et leur chevauchement.

1..3: Ces curseurs déterminent la fréquence de coupure des filtres. Celle du
quatrième filtre est automatiquement déterminée par la fréquence (et la largeur
de bande, pour les filtres passe-bande) du filtre adjacent.

Vous pouvez choisir l’échelle des axes de fréquence et d’amplitude (dB) entre Lin
(linéaire) et Log (logarithmique). (Log. donne plus de résolution dans les graves, Lin.
Dans les aigus.) Utilisez ces possibilités d’affichage pour mieux visualiser les différentes
bandes.

Frequency Separation/Gain Enhancement/Reduction
Cet affichage présente la largeur des bandes et la correction de gain appliquée à chaque
bande.
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Setup
Bands
Le module Multi Band Dynamics peut fonctionner comme processeur
dynamique large bande, 2 bandes, 3 bandes ou 4 bandes. Choisissez le nombre
de bandes voulu dans le menu déroulant.

Conseil d’utilisation: Pendant que vous changez ces réglages, vous pouvez noter que
l’affichage graphique évolue pour refléter les réglages actuels.

Band Separation: Ce paramètre permet de choisir le degré de séparation/
chevauchement entre les bandes.

Look ahead: Si cette option est cochée, la section dynamique effectue une
détection prédictive («à l’avance»). Si elle ne l’est pas, du «pompage» ou de la
distorsion peuvent apparaître. Notez que décocher cette option ne nivellera pas
automatiquement les phase d’attaque brutales de la forme d’onde, ce qui peut
donner un matériel audio plus «agressif». Ce réglage affecte toutes les bandes.

Link bands: Cliquez sur (activez) cette option pour associer toutes les bandes
du processeur dynamique. Tout changement apporté à une bande s’appliquera
à TOUTES les bandes actuellement utilisées.

Bypass dyn.: Lors de la lecture audio, le fait de cliquer sur (activer) cette option
désactive la bande sélectionnée (bande rouge).

Bypass all: Lors de la lecture audio, le fait de cliquer sur (activer) cette option
désactive temporairement le correcteur dynamique multibande dans sa totalité.

Note: Si Link bands est activé, cela ne garantit pas pour autant que toutes les bandes
soient réglées sur les mêmes valeurs. Seuls les paramètres modifiés après activation de
l’option Link bands seront réglés identiquement sur toutes les bandes. Si toutes les
bandes doivent avoir leurs paramètres réglés identiquement, utilisez l’option Copy To
All.

Band 1..4
Les paramètres de la section dynamique sont situés dans la moitié basse de la
fenêtre. Les commandes sont fonctionnellement identiques pour les quatre
bandes.

Gain
Cette section gère le gain de compensation pour la bande. Ce paramètre n’est
pas disponible quand la bande sélectionnée utilise le réglage Comp Max ou
Limiter 100.

Ratio: Définit le rapport niveau d’entrée / niveau de sortie.
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Threshold: C’est la valeur du niveau seuil d’entrée (en dB) au dessus de laquelle
la composante concernée traite l’audio.

Attack: Constante de temps de réaction à l’accroissement du niveau du signal
(en ms). Cela détermine avec quelle rapidité le traitement dynamique réagit à
une crête du niveau d’entrée.

Release: Constante de temps de réaction à la redescente du niveau du signal
(en ms). Cela détermine avec quelle rapidité le traitement dynamique réagit au
retour à la normale du niveau d’entrée.

Gate
Cette section permet de définir le niveau (seuil) de l’effet gate au moyen du
curseur de réglage ou du champ numérique (dB). Vous pouvez remarquer que
la courbe affichée sur le graphique évolue en fonction du réglage de Gate.

Mode
Chaque bande du correcteur dynamique peut être configuré comme compresseur,
limiteur, expandeur, ou gate. Sélectionnez le mode voulu dans le menu déroulant
Mode pour appliquer le traitement dynamique spécifié. Les fonctions des
commandes (dans al section dynamique) sont généralement similaires à celles
de la section dynamique standard (compresseur, limiteur, expandeur et gate).
Pour des informations détaillées, référez-vous au chapitre «Dynamics».
En résumé: l’algorithme du compresseur, de l’expandeur et du limiteur est
similaire à celui d’un compresseur, expandeur ou limiteur «classique», les
réglages Comp Max et Limiter 100 appliquent automatiquement un gain de
compensation maximal en normalisant la sortie de la bande à 0 dB. Le gate est
disponible dans tous les modes, mais un mode dédié permet d’économiser les
ressources du processeur pour cette bande.

Solo: Lors de la lecture audio, le fait de cliquer sur ce bouton isole en solo la
bande sélectionnée (bande rouge). C’est une fonction qui peut s’avérer
extrêmement pratique.

Out (All)
Ce paramètre permet de régler le niveau de sortie (gain de compensation) pour
la somme de toutes les bandes. Ce paramètre est très utile pour avoir une idée
claire du résultat obtenu sans ajouter l’amplification de volume du correcteur.
Il est recommandé de placer le curseur à un niveau équivalent à celui du signal
d’entrée.

Limiter On (réservé à la section Master de la table de mixage)
Cette case est grisée lorsque vous accédez au correcteur dynamique multibande
par le biais du menu Offline Effects. Lorsque vous utilisez le correcteur
dynamique multibande en insertion sur la section Master de la table de mixage,
il est possible d’activer et de paramétrer le limiteur directement depuis le
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correcteur dynamique multibande. Ce limiteur va limiter le niveau quand vous
employez le module Multi Band Dynamics, ce qui permet d’accroître le volume
de votre mixage.

Create copy: Comme dans la plupart des autres effets du menu Offline Effects,
cette importante option permet de générer un fichier d’annulation avant le
traitement, ce qui permet de revenir en arrière si le résultat du traitement ne
vous satisfait pas. Comme toujours, nous vous conseillons vivement de toujours
cocher cette case!

Play/Stop
Ce bouton permet de lancer l’écoute test en temps réel du correcteur dynamique
sur les données audio sans avoir à quitter sa fenêtre. Toutes les pistes du VIP
sont relues avant que vous puissiez effectuer vos réglages dans le contexte de la
production. Si vous le souhaitez, vous pouvez également isoler les données audio
à traiter au moyen de leur bouton Solo dans le VIP.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement dynamique
configuré sur les données audio. La fenêtre Compressor/Expander/Noise Gate/
Limiter se referme ensuite.

Cancel
Ce bouton referme la fenêtre Compressor/Expander/Noise Gate/Limiter sans
valider les réglages de correction dynamique définis.

Preset
Save: Cliquez sur le bouton «Save» pour sauvegarder sous forme de configuration
(preset) les réglages en vigueur dans le correcteur dynamique. Vous accédez à
une boîte de dialogue Windows standard où vous pouvez donner un nom au
fichier à créer. Nommez le fichier de configuration, puis cliquez sur OK.

Load: Cliquez sur le bouton «Load» pour rappeler en mémoire une configuration
de réglages (preset) du correcteur dynamique préalablement sauvegardée. Vous
passez sur une boîte de dialogue Windows standard où vous pouvez choisir le
fichier à recharger. Sélectionnez la configuration désirée, puis cliquez sur OK.

Delete: Cliquez sur le bouton «Delete» pour supprimer une configuration
(preset) de correcteur dynamique préalablement sauvegardée. Une fenêtre de
dialogue apparaît, demandant si vous voulez vraiment supprimer la configuration
(preset). Cliquez sur «Yes» pour la supprimer. Cliquez sur «Cancel» pour
interrompre la procédure de suppression.

Conseil d’utilisation: Vous pouvez utiliser la liste déroulante Preset pour rapidement
charger n’importe quelle configuration de processeur dynamique multibande
préalablement sauvegardée. Cliquez simplement sur le menu et sélectionnez le preset
voulu.
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Gestion des très nombreux paramètres
Un correcteur dynamique multibande gère bien évidemment de très nombreux
paramètres – qui peuvent sembler confus aux utilisateurs inexpérimentés. Les
approches suivantes simplifient l’édition de toutes les bandes.
Suivez la procédure suivante si vous désirez modifier le réglage de toutes les
bandes simultanément (vous ne désirez donc pas éditer chacune des bandes
séparément). Les réglages de fréquences sont repris de la configuration standard:

Etape 1 : Préparation générale pour toutes les bandes
1. Sélectionnez le type de Mode de traitement dynamique le plus proche des

résultats recherchés. Par exemple, pour augmenter le niveau sonore d’un
signal audio, optez pour le mode Compressor Max. Préférez le mode
Compressor si vous désirez ajouter de la présence à un signal ou pour conférer
de la transparence à un discours. Ce réglage n’augmente pas le niveau sonore
général du son mais est l’outil idéal pour éclaircir des enregistrements un
peu ternes et pour donner du punch à une basse. Le mode choisi n’agit que
sur la bande sélectionnée (courbe de filtre blanche).  Cliquez sur Copy To All
pour attribuer le même réglage à toutes les autres bandes.

2. Cochez la case Link bands.  A partir de maintenant, toutes les opérations
effectuées sur la bande en cours se répercutent également sur les autres
bandes.

3. Réglez les autres paramètres jusqu’à ce que vous obteniez le son désiré.

Etape 2 : Réglage fin de chacune des bandes
1. Décochez la case Link bands, puis sélectionnez une bande par l’intermédiaire

de son onglet.
2. Ce mode vous permet d’écouter chacune des bandes séparément afin

d’optimiser leur réglage.
3. Si vous n’arrivez pas à obtenir des réglages satisfaisants pour certaines bandes,

modifiez leur fréquence de séparation, puis vérifiez le résultat. Il est parfois
nécessaire de rétrécir les bandes pour éviter l’effet de «pompage» typique.

Si vous ne désirez agir que sur une bande de fréquences bien précise, optez
pour l’approche suivante:

1. Vérifiez que la case Link bands n’est pas cochée. Passez en mode Solo et
sélectionnez la bande désirée au moyen de son onglet. Si vous ne connaissez
pas la bande de fréquences exacte, essayez-en plusieurs.

2. Faites défiler la fréquence de coupure jusqu’à ce que la zone critique soit
filtrée.

Vous êtes à présent prêt à effectuer la correction dynamique. Sélectionnez tout
d’abord le traitement adéquat avec le paramètre Mode.
– Pour limiter des fréquences critiques, comme dans un traitement de type dé-

esseur, vous pouvez utiliser les modes Limiter ou Compressor.
– Cochez/décochez la case Bypass Dyn. pour comparer les bandes avec et sans

traitement.
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– Désactivez le mode Solo. Vous pouvez ainsi comparer le signal d’origine et le

signal traité via les fonctions Bypass Dyn. ou Bypass All.

Il existe une troisième approche qui consiste à comparer des presets. Certains
peuvent être de très bons points de départ. Dans la plupart des cas, de bons
résultats peuvent être obtenus en partant d’un des presets et en le personnalisant
de façon judicieuse.
Les presets n’iront toutefois pas plus loin. Les correcteurs dynamiques sont des
algorithmes dont le résultat dépend grandement des réglages mais également
du type de signal audio traité.
Les réglages diffèrent selon le type de données audio à corriger. La dynamique
et le niveau de volume d’origine du signal et le type de signal ont tous la même
importance. Il faut également prendre en compte la réponse en fréquence de la
source audio et la destination de l’audio traité.

Comparaison à niveaux de volume constants
Si la tâche consiste à comparer des différences de son sans laisser le traitement
dynamique altérer les niveaux de volume, cette méthode peut être employée.
– Réglez le volume au moyen du curseur Out (All) jusqu’à ce que le signal

audio atteigne le même niveau que lorsque la fonction Bypass All est utilisée.
– Comparez les niveaux en cochant la case Bypass, puis réglez le niveau de

sortie en conséquence, et ce autant de fois que nécessaire.

Si le compresseur multibande est employé dans la section Master de la table de
mixage, les crête-mètres peuvent être employés pour vous assister visuellement
dans cette tâche.

Diminution de la charge du processeur
L’algorithme du correcteur dynamique multibande sollicite énormément le
processeur de votre ordinateur selon les réglages de la section de réglage des
filtres. La charge que doit supporter l’ordinateur augmente dans les cas suivant:
– Les fréquences de coupure sont basses
– Le nombre de bandes est élevé
– Le paramètre Separation est réglé sur Normal ou High

Si l’emploi en temps réel (dans la table de mixage ou en lecture Test) entraîne
une surcharge du processeur de votre ordinateur, vous pouvez essayer d’obtenir
les mêmes résultats à l’aide de réglages moins gourmands en ressources:
1. Il n’est utile de régler le paramètre Separation sur Normal ou High que dans

des cas bien précis. Par exemple, pour limiter très fortement une bande par
rapport aux autres afin de ne corriger qu’une zone bien particulière du signal.
En général, réservez ces valeurs à certaines bandes exposées à une correction
dynamique extrême.

 Le traitement dynamique des fréquences basses nécessite souvent un réglage
élevé pour Separation. Néanmoins, ce n’est pas parce que vous choisissez
une faible séparation que la réponse en fréquence du signal source ne sera
pas précise.
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2. Ne réglez pas les fréquences de coupure basses sur des valeurs plus faibles

que nécessaire.
3. N’utilisez que le nombre de bandes dont vous avez réellement besoin. En

général, trois bandes suffisent. Par exemple, pour traiter le registre des graves,
deux bandes suffisent.

Enfin, veillez à ne pas abuser du correcteur dynamique multibande car trop
d’effet peut tuer l’effet. Cette subtilité ne s’obtient qu’avec l’expérience, mais
une bonne règle générale à suivre est «mieux vaut moins»....
Un contrôle soigneux de chaque bande (en utilisant l’option de lecture Solo)
vous y aidera.

De-clipping
Cette fonction unique de Samplitude est un dispositif anti-écrêtage qui permet
de supprimer toute saturation numérique ou analogique. Quiconque enregistre
de l’audio a été au moins une fois confronté à un problème de saturation.

Samplitude fait appel à des algorithmes très puissants qui interpolent les passages
où apparaît la saturation à partir des données audio situées avant et après la
saturation. Après traitement, vous avez la possibilité de diminuer le volume
total du signal afin d’éviter toute nouvelle saturation.
L’algorithme de de-clipping est particulièrement efficace sur les saturations très
nettes mais pas exagérées, comme sur les enregistrements de piano ou de voix.
Il a toutefois des limites – le matériel lourdement saturé ne peut généralement
pas être réparé bien que vous puissiez significativement améliorer l’audio
endommagé.

Clipping Definition (Définition de l’écrêtage)
Min Number of clipped samples (> 1): Indiquez dans ce champ le nombre
d’échantillons saturés consécutifs à partir duquel Samplitude doit déclencher
l’algorithme de de-clipping pour réparer la distorsion. Une valeur de trois
fonctionne bien dans la plupart des cas.
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Min level of clipped samples (< 0dB): Indiquez dans ce champ le volume à
partir duquel Samplitude doit déclencher l’algorithme de de-clipping (en d’autres
termes, c’est un niveau seuil (Threshold), comme celui trouvé dans un
compresseur). Partez d’une valeur de 0,5 dB. Si la saturation persiste, abaissez
cette valeur jusqu’à ce que le problème disparaisse.
Un certain nombre de cartes son ont des comportements différents à l’écrêtage,
aussi ce paramètre est-il très important. Certains magnétophones DAT possèdent
un circuit de protection analogique pour empêcher les niveaux d’entrée
d’atteindre le signal numérique maximal. Dans ces cas-là, une valeur inférieure
ou égale à -0,5 dB est conseillée.
Exemple : Si vous choisissez la valeur –6 dB, Samplitude va considérer comme
saturés et recalculer tous les échantillons qui se trouvent à 50 % de leur niveau
maximum. Cette fonction permet même de retirer la distorsion d’un signal
enregistré en analogique.

Note: Une fois encore, patience et minutie sont essentielles pour réparer l’audio de
cette façon. Si c’est possible, prenez le temps de réparer séparément chacun des
échantillons saturés au lieu de traiter la totalité du fichier en une seule passe.

Get level from height: Ce bouton vous permet de définir la valeur du
paramètre «Min. level of clipped samples (< 0dB)» en fonction de la hauteur
d’une sélection. Peut-être devrez-vous décocher «Fix vertically» dans le menu
View  pour définir des sélections verticales. Cette fonction est très pratique si
vous corrigez des échantillons à la suite, c’est-à-dire un par un (voir paragraphe
précédent)

Number of steady samples after clip (1....10): Indiquez dans ce champ le
nombre d’échantillons «sains» permettant de déterminer la fin du segment
écrêté. En d’autres termes, un nombre d’échantillons qui suivent la section
écrêtée et qui restent à un niveau constant. Cette option est très pratique avec
certaines cartes son d’entrée de gamme (SoundBlaster par exemple) qui
produisent des valeurs chaotiques durant un segment écrêté. Pour de tels
périphériques, la seule façon qu’a Samplitude de déterminer le point de fin du
segment écrêté est d’augmenter la valeur de ce paramètre entre 5 et 10. Si votre
carte son est plus efficace lors de la lecture d’un segment écrêté, vous pouvez
ramener ce paramètre à une valeur de 1.

De-clipping Mode
Adjust maximum level to 0dB – (Recommended for 16 bit projects) Cochez cette
case pour que le signal audio soit normalisé après correction par la fonction de-
clipping. Cette procédure est recommandée pour les signaux 16 bits, sinon la
marge de volume ne serait pas suffisante pour corriger la distorsion. S’il s’agit
d’un signal à virgule flottante (projet Wave 24 bits), vous n’êtes pas obligé de
cocher cette case car le format à virgule flottante dispose d’une plage dynamique
illimitée.
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Load
Cliquez sur ce bouton pour charger un preset de de-clipping préalablement
sauvegardé.

Save
Cliquez sur ce bouton pour sauvegarder les paramètres actuels de de-clipping
comme un preset.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!

Preview
Ce bouton vous permet de lancer la pré-écoute de vos réglages actuels de de-
clipping. Le temps de pré-écoute se règle dans Options > System/Audio
(Raccourci: Y) > onglet Program > Preview Time.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement configuré
sur les données audio. La fenêtre De-clipping se referme ensuite.

Cancel
Ce bouton referme la fenêtre De-clipping sans appliquer aucun traitement.

Remove DC Offset
Cette fonction vous permet d’éliminer tout décalage de composante continue
du courant d’un projet Wave ou d’un objet sélectionné en fenêtre VIP. C’est un
phénomène survenant lorsque la forme d’onde audio n’est pas centrée
verticalement sur la ligne d’amplitude zéro. En d’autres termes, la forme d’onde
est alors centrée au-dessus ou au-dessous de la ligne d’amplitude zéro. Cela
peut entraîner des bruits parasites ou d’autres imperfections et les données
audio qui en souffrent doivent toujours être corrigées avant de se voir appliquer
un autre traitement.

Conseil d’utilisation : Certaines cartes son génèrent ce décalage au cours de
l’enregistrement. Pour le supprimer, faites un zoom avant sur la forme d’onde et
vérifiez qu’elle est bien centrée verticalement sur la ligne d’amplitude zéro. Si elle ne
l’est pas, corrigez le problème grâce à l’option Remove DC-offset.

Cet effet agit en deux étapes, d’abord il analyse les données audio puis il supprime
le décalage. Vous pouvez régler un seuil minimum (Threshold) en dB. Si le
décalage analysé est inférieur à cette valeur, aucune action n’est entreprise. Cela
s’avère utile pour le traitement par lots en vue d’économiser du temps de calcul.



378

Menu «Offline Effects»

Get noise sample
Cette commande est l’étape préalable à toute utilisation de l’effet de réduction
de bruit (Noise Reduction).
Pour des informations générales sur la réduction de bruit, lisez le chapitre
correspondant du manuel.
Cette fonction est la première étape du processus de réduction de bruit.
La fonction de réduction de bruit peut être employée pour supprimer
efficacement du bruit gênant dans l’audio, avec un minimum de décoloration
ou autres artefacts. Pour obtenir cela, l’algorithme a besoin au préalable d’un
échantillon du bruit (une empreinte du bruit) que vous désirez supprimer. C’est
plus efficace avec des bruits constants de type: une boucle de masse, un
ronflement d’air conditionné, un sifflement de bande ou un larsen.
Avant d’employer la réduction de bruit, vous devez donc prendre une empreinte
de ce bruit (du bruit que vous désirez supprimer).
Pour cela, faites une sélection temporelle (Range) qui ne contient QUE le bruit
dans le projet Wave ou un objet sélectionné. Puis sélectionnez cette option pour
réaliser la véritable «empreinte de bruit».
Note: Si «l’empreinte de bruit» contient de l’audio (en plus du bruit), cet audio
sera aussi retiré lors du traitement. Aussi.…assurez-vous que «l’empreinte de
bruit» ne contient QUE du bruit!
Elle doit, par ailleurs, être de longueur suffisante, sinon Samplitude vous affichera
un message d’erreur demandant un échantillon plus long.

Noise reduction
(Veuillez vous référer à l’élément précédent – Get noise sample avant de
poursuivre)
Cette option ouvre la fenêtre Noise reduction qui vous permet d’appliquer une
réduction de bruit de type «Empreinte de bruit» graphique à un projet Wave ou
à des objets sélectionnés dans la fenêtre de VIP.
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Important: Vous devez d’abord utiliser l’option Get noise sample pour obtenir une
«Empreinte du bruit» (du bruit à supprimer) avant d’utiliser la réduction de bruit
(voir élément précédent).

Voici un rapide résumé des étapes à suivre:
1. Sélectionnez une empreinte de bruit ou «bruit témoin» comme expliqué ci-

dessus.
2. Délimitez ensuite la sélection du projet Wave (ou sélectionnez l’objet VIP) à

traiter contre ce bruit.
3. Ouvrez la fenêtre Noise Reduction via le menu Offline Effects.
4. Dans le champ Noise sample, sélectionnez l’échantillon de bruit. Ce fichier

contient l’empreinte du bruit.
5. Vous pouvez vérifier les résultats qui seront obtenus avant d’affecter vraiment

le matériel audio en cliquant sur le bouton Preview.
6. Faites ensuite tous les réglages nécessaires ou chargez un preset, puis cliquez

sur OK pour lancer l’opération sur les données audio.

Noise sample
 «L’empreinte de bruit» créée avec l’option Get noise sample sera
automatiquement affichée (sélectionnée) dans cette liste déroulante.

Conseil d’utilisation : Vous pouvez utiliser n’importe quel projet Wave chargé dans
Samplitude comme «empreinte de bruit». Imaginons le scénario suivant : Vous avez
enregistré plusieurs pistes de guitare par le biais d’un amplificateur souffrant d’un
fort ronflement à 60 Hz.
Au lieu de capturer une «empreinte de bruit» pour chacune des pistes, délimitez une
sélection sur l’une des pistes (veillez à ce que cette sélection ne couvre que le ronflement
à supprimer), puis copiez cette «empreinte de bruit» dans un nouveau fichier audio
(projet Wave). Vous pouvez dès lors utiliser ce fichier audio («empreinte de bruit»)
sur toutes les pistes de guitare enregistrées par le biais de l’amplificateur incriminé et
ainsi supprimer le ronflement à 60 Hz. Vous pouvez même vous constituer des banques
avec les «empreintes de bruit» fréquentes pour accélérer les processus répétitifs de
réduction de bruit.

Play
Cliquez sur ce bouton pour lancer la lecture de votre «empreinte de bruit».
Vérifiez ainsi qu’elle ne contient pas de données audio à conserver. Si vous
entendez des données audio que vous ne voulez pas supprimer, créez une
nouvelle empreinte de bruit.

View Mode
Dans le premier mode, la réponse en fréquence s’affiche sous la forme d’une
courbe pleine. Dans le second, elle prend la forme d’une ligne.

Freq lin / log
Sélectionne le mode d’affichage logarithmique ou linéaire pour les fréquences.
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L’affichage linéaire offre une meilleure lisibilité du registre des aigus alors que
l’affichage logarithmique offre une meilleure lisibilité du registre des graves.

dB lin / log
Sélectionne le mode d’affichage des niveaux (mode logarithmique ou linéaire).
L’affichage linéaire offre une meilleure lisibilité du registre élevé alors que
l’affichage logarithmique offre une meilleure lisibilité du registre bas.

Presets
(Typ) noise: Pour accélérer/faciliter le processus de réduction du bruit, vous
pouvez sélectionner des presets qui spécifient le type de bruit à supprimer.
Samplitude règlera les paramètres de réduction de bruit en conséquence.

Medium Tonal noise (e.g.: hum): Permet de réduire efficacement un
ronflement à 60 Hz et les autres bruits à hauteur fixe.

Hard Tonal noise (e.g.: hum): Permet de réduire efficacement un ronflement
à 60 Hz et les autres bruits à hauteur fixe d’un niveau plus élevé.

Low broadband noise: Permet de réduire efficacement les bruits de souffle de
faible niveau et les autres bruits large bande de faible niveau.

Medium broadband noise: Permet de réduire efficacement les bruits de souffle
de niveau moyen et les autres bruits large bande de niveau moyen.

Hard broadband noise: Permet de réduire efficacement les bruits de souffle
de niveau élevé et les autres bruits large bande de niveau élevé.

Gramophone 1 (Medium): Permet de réduire efficacement les bruits de surface
des disques vinyle.

Gramophone 2 (Hard): Permet de réduire efficacement les bruits de surface
particulièrement marqués des disques vinyle.

(Typ) Audio Material: Pour accélérer/faciliter le processus de réduction du
bruit, vous pouvez sélectionner des presets qui spécifient le type d’audio (duquel
le bruit sera supprimé). Samplitude règlera les paramètres de réduction de bruit
en conséquence.

Speaking Voice: Utilisez ce preset si le signal à traiter est une voix parlée.

Singing Voice: Utilisez ce preset si le signal à traiter est une voix chantée.

Fast Beats / percussion: Utilisez ce preset si vous devez traiter des percussions
ou des sons courts.

Songs: Utilisez ce preset si le signal à traiter est un morceau complet.
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Orchestral Instruments: Utilisez ce preset si vous devez traiter un instrument
spécifique.

Conseil d’utilisation : Servez-vous de ces presets. Samplitude sera ainsi instantanément
optimisé pour la réduction de bruit correspondante et entraînera le moins d’effets
secondaires possible.

Paramètres internes de l’algorithme de réduction de bruit
Resolution: Vous avez le choix entre trois niveaux de résolution (Low, Medium
et High) pour l’algorithme de réduction de bruit. Avec l’option High, la résolution
est élevée, mais les calculs durent plus longtemps. Faites quelques essais
préalables car une résolution plus élevée ne donne pas forcément de meilleurs
résultats. Ainsi, une résolution basse (Low) fonctionne souvent mieux quand la
réduction de bruit est appliquée à de courts sons percussifs ou à des paroles.

Precision: Ce paramètre permet de régler la précision de la réduction de bruit.
Low, Normal et High sont les trois choix, High offrant la meilleure qualité,
mais nécessitant en contrepartie les temps de traitement les plus longs.

Precision Real-time: Ce paramètre permet de choisir le niveau de qualité utilisé
pour la pré-écoute en temps réel de la réduction de bruit. Test, Low, Normal et
High sont les quatre choix, High offrant la meilleure qualité, mais nécessitant
en contrepartie le plus de ressources du processeur.

Conseil : Si votre machine n’est pas assez puissante pour effectuer une écoute-test en
temps réel en précision High, essayez un degré de précision moindre. La qualité de la
pré-écoute sera affectée, mais pas celle du résultat final lorsque la réduction de bruit
sera appliquée au fichier audio.

Absorption
Ce paramètre définit l’intensité (Low, Medium ou High) de l’algorithme de
réduction de bruit. Vous pouvez utiliser le curseur pour affiner le réglage.
Les réglages Low (faible), Medium (moyenne) et High (élevée) déterminent
l’intensité du traitement. Le curseur à leur droite permet d’ajuster précisément
le réglage dans la plage sélectionnée. Ce paramètre définit le niveau d’absorption
(ou d’amplification) de l’empreinte de bruit. Il s’affiche dans le graphique. La
courbe jaune représente le spectre d’origine de l’empreinte de bruit et la courbe
bleue le spectre corrigé que Samplitude emploie pour retirer le bruit du signal
audio.

Conseil d’utilisation : Ne fixez pas une valeur Absorption extrême sous peine de créer
des artefacts. Limitez-vous à l’absorption nécessaire.
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Mix (Reduction)
Ce paramètre vous permet de régler l’atténuation du bruit en -dB.

Conseil d’utilisation : Il est parfois intéressant de laisser un peu de bruit dans le
signal. La suppression totale du bruit sans endommager l’audio restant est en général
impossible. De tels dommages comprennent des artéfacts comme des effets étranges de
flanger et de sifflements. Pensez en terme de réduction, et pas en terme d’élimination
à 100 %. Comme toujours, faites preuve de patience et essayez toujours différents
réglages avant de décider de la réduction de bruit à appliquer.

Artifact Suppression
Les fortes réductions de bruit entraînent souvent l’apparition d’artefacts (voir
ci-dessus). Il ne s’agit pas d’un point faible de Samplitude, mais plutôt d’un
effet secondaire des techniques de réduction de bruit actuelles. Si des artefacts
apparaissent après une réduction de bruit, vous pouvez les atténuer au moyen
des trois paramètres suivants (en plus de réduire les paramètres Absorption et
Mix).

Smooth Attack: Ce paramètre définit l’attaque du réducteur de bruit. Une
valeur élevée réduit effectivement les bruits parasites mais le temps de réaction
du signal audio risque d’en pâtir légèrement. En général, ce paramètre est le
plus efficace pour diminuer les artefacts sur des pistes musicales.

Smooth Release: Ce paramètre permet d’ajuster le temps de retour à la normale
du son lors de l’emploi du réducteur de bruit. Une valeur élevée va diminuer les
artefacts mais va également modifier le déclin du son. En général, ce paramètre
donne des résultats optimaux sur les sons percussifs (sons à déclin rapide).

Static Filter Smooth: Ce paramètre «nivelle» le spectre de l’échantillon de
bruit (pour mieux comprendre l’action de ce paramètre, jetez un œil sur la courbe
bleue du graphique). C’est ce spectre «nivelé» qui est ensuite utilisé par le
réducteur de bruit. En général, ce paramètre donne des résultats optimaux sur
les voix et les sons doux.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!

Play/Stop
Cliquez sur ce bouton pour entendre en stéréo l’effet de la réduction de bruit.
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Preview
Ce bouton vous permet de lancer la pré-écoute (calculée) de vos réglages actuels
de réduction de bruit. Cette option doit être employée si votre machine n’est pas
suffisamment rapide pour une pré-écoute en temps réel. Le temps de pré-écoute
se règle dans Options > System/Audio (Raccourci: Y) > onglet Program > Preview
Time.

Play Orig
Quand vous utilisez les fonctions de pré-écoute, cliquez sur ce bouton pour
reproduire l’audio d’origine (sec).Cela vous permet de rapidement comparer
l’audio traité et l’audio non traité.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement configuré
sur les données audio. La fenêtre Noise reduction se referme ensuite.

Cancel
Ce bouton referme la fenêtre Noise reduction sans appliquer aucun traitement.

Load (Preset)
Cliquez sur ce bouton pour charger un preset (jeu de réglages de paramètres)
de réduction de bruit préalablement sauvegardé.

Save (Preset)
Cliquez sur ce bouton pour sauvegarder les paramètres actuels de réduction de
bruit comme un preset.

Utilisation du réducteur de bruit:
1. Si vous devez appliquer le réducteur de bruit directement à un projet Wave ou

fichier RAP, passez sur sa fenêtre (projet Wave) afin d’en faire la fenêtre
active. S’il doit être appliqué à un objet de VIP, sélectionnez cet objet (en
cliquant dans sa moitié inférieure).

2. Pour notre exemple, nous allons réduire le ronflement à 50/60 Hz d’une
piste de guitare. Délimitez donc une sélection (dans le projet Wave ou RAP
ou dans l’objet de VIP sélectionné) contenant UNIQUEMENT le ronflement
à 50/60 Hz.

Conseil d’utilisation: Cliquez et glissez avec la souris dans la fenêtre de projet Wave
pour définir une sélection temporelle (Range). Cliquez et glissez (en partant de la
moitié haute de la piste) pour définir une sélection temporelle (Range) dans la fenêtre
VIP.

3. Sélectionnez Offline Effects > Get noise sample pour obtenir une «empreinte du
bruit» de ronflement à 50/60 Hz.

4. Si vous devez appliquer le réducteur de bruit directement à un projet Wave,
faites la sélection temporelle (Range) désirée dans la fenêtre de projet Wave
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(cliquez et glissez avec la souris dans la fenêtre de projet Wave pour définir
une sélection temporelle). S’il doit être appliqué à un objet de VIP, passez à
l’étape 5.

4. Depuis le menu Offline Effects, ouvrez la fenêtre Noise reduction.
5. Dans le cadre Typ, sélectionnez Medium Tonal noise pour le paramètre Noise

et Songs ou Orchestral Instruments pour le paramètre Audio Material.
6. Lancez ensuite une écoute-test en temps réel de la réduction de bruit via l’un

des boutons Play. Si votre machine est trop lente pour gérer la pré-écoute en
temps réelle, servez-vous du bouton Preview et Samplitude calculera la pré-
écoute.

7. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin
d’appliquer le traitement sur le fichier audio. Si vous n’êtes pas satisfait du
résultat, modifiez les réglages de résolution, d’absorption et d’élimination
des artefacts, puis répétez les étapes 6 et 7.

 Conseils d’utilisation du réducteur de bruit
Pour des réglages optimaux veuillez suivre ces étapes:
1. En période de familiarisation avec le processeur de réduction de bruit,

commencez toujours par sélectionner un preset adapté au type de données
audio et au type de bruit à traiter.

2. Testez le paramètre Absorption. Attention toutefois à ne pas choisir une valeur
trop élevée sous peine de perdre les caractéristiques d’ambiance.

3. Pour réduire d’éventuels artefacts, augmentez la valeur des paramètres Smooth
Attack et/ou Static Filter Smooth. La méthode dépendra du matériel audio à
traiter.

4. N’oubliez pas qu’il existe une relation entre les paramètres de la section Artifact
Suppression et le paramètre Absorption. Cherchez donc toujours le juste
milieu entre ces réglages afin de réduire le bruit sans faire apparaître trop
d’artefacts.

5. C’est une bonne habitude que de rechercher un éventuel décalage de
composante continue du courant (DC Offset) et de le supprimer (s’il y en a
un) avant d’appliquer la réduction de bruit (Offline Effects > Remove DC
offset).

6. La coloration des données audio d’origine  peut être réduite par l’emploi
répétitif (c’est-à-dire en plusieurs passages) de l’algorithme de réduction de
bruit. Fixez un niveau d’absorption peu élevé (paramètre Absorption). Une
fois que vous avez appliqué une première réduction de bruit, il suffit de
sélectionner le bruit persistant comme empreinte du bruit à éliminer la fois
suivante.

7. Il peut être ardu de supprimer un bruit large bande de niveau élevé. Dans ce
cas-là, appliquez un filtre sur vos données audio avant de passer à la réduction
du bruit. Servez-vous par exemple des correcteurs pour atténuer les fréquences
qui ne font pas partie des données d’origine (désirées). Par exemple, il est
possible d’atténuer en toute sécurité les fréquences inférieures à 200 Hz et
supérieures à 8000 Hz pour une voix de femme (n’effectuez toutefois
l’opération QUE si cela s’avère nécessaire!).

  Pour les instruments, toutes les fréquences qui se trouvent en dessous de la
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note la plus basse jouée peuvent être atténuées. Si par exemple, la note la
plus basse que vous jouez est un LA à 440 Hz, vous pouvez atténuer toutes
les fréquences inférieures à 440 Hz. Vous perdrez bien évidemment des
harmoniques, mais sachez qu’il y a toujours des compromis à faire. Utilisez
pour cela le correcteur/analyseur FFT (Offline Effects > FFT Filter/Analyzer)
qui est parfaitement adapté à cette tâche.

8. La perceptibilité des artefacts dépend du volume de diffusion et de la bande
passante du support de diffusion. Si vous connaissez l’endroit où les données
audio seront jouées (salle de cinéma, TV, radio, etc.), essayez de les réparer
dans ces conditions de diffusion.

9. Le réducteur de bruit peut être un outil de création sonore. Il permet d’obtenir
des dénaturations intéressantes, tout particulièrement si l’empreinte de bruit
sélectionnée n’est pas un signal de bruit.

10. Le réducteur de bruit permet également de supprimer des fausses notes
d’un enregistrement si les notes/les sons sont riches en harmoniques. Pour
cela, il faut un échantillon ne contenant que la fausse note. Celle-ci est alors
prise comme empreinte de bruit.

Comme pour la majorité des effets, veillez à ne pas «surtraiter» vos données
audio. A l’instar de n’importe quel ingénieur du son, vous êtes plus sensible au
bruit de fond qu’un auditeur lambda. Contrairement au bruit de fond, les artefacts
de type ondulation ou sifflement sont beaucoup plus remarqués par l’auditeur
moyen, tout spécialement sur la voix. Par conséquent, n’oubliez pas qu’il vaut
mieux qu’un peu de bruit de fond subsiste plutôt que de le remplacer par des
artefacts parasites.

De-hissing
Cette option ouvre la fenêtre de l’éliminateur de souffle, agissant en destructif
sur les projets Wave sur disque dur et en RAM (RAP) ainsi que sur les objets
sélectionnés dans le VIP.
Cet effet fonctionne en complément du réducteur de bruit. Il permet de retirer
de tout signal sonore le bruit blanc constant de faible niveau (souffle). On trouve
en général ce bruit de fond sur les signaux sonores enregistrés au moyen d’un
préamplificateur micro ou de cartes son analogiques de faible qualité.
Il ne nécessite pas d’empreinte de bruit contrairement au DSP de réduction de
bruit. Cela le rend idéal pour l’emploi en temps réel en section Master de la
table de mixage.
La fenêtre qui s’affiche lorsque vous appelez l’effet De-hissing en temps réel est
différente de celle à laquelle vous avez accès lorsque vous l’utilisez en temps
différé (menu «Offline Effects»).
Cet effet est associé à un simple filtre FFT (Transformée de Fourier rapide)
pour l’emploi en section Master de la table de mixage. Comme les algorithmes
du de-hisser font appel aux fonctions FFT, l’audio n’est traité qu’une fois, pour
les deux étapes du DSP.
Lorsque vous utilisez la version en temps différé (Offline Effects > de-hissing),
vous disposez de paramètres supplémentaires.
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Courbes affichées sur le graphique
Trois courbes de couleurs différentes s’affichent sur le graphique.

Courbe bleu clair: La courbe bleu clair représente le spectre du signal après
traitement (après élimination du souffle).

Courbe jaune: La courbe bleu clair représente le spectre du signal après
traitement (après élimination du souffle).

Courbe bleu foncé: La courbe bleu foncé représente la valeur de seuil fixée
par le paramètre Absorption.

Draw mode
Le graphique peut s’afficher sous la forme de lignes ou de courbes pleines.
Passez d’un mode à l’autre en cochant la case correspondante.

Freq. lin / log
L’affichage linéaire des fréquences offre une meilleure lisibilité du registre des
aigus. L’affichage logarithmique des fréquences offre une meilleure lisibilité du
registre des graves.

dB lin / log
L’affichage linéaire de l’amplitude offre une meilleure lisibilité du registre haut.
L’affichage logarithmique de l’amplitude offre une meilleure lisibilité du registre
bas.

Absorption
Le paramètre Absorption détermine l’intensité de l’élimination du souffle. Vous
pouvez le définir au moyen de son curseur ou saisir directement la valeur
souhaitée dans le champ numérique prévu à cet effet.



387

Menu «Offline Effects»
Concrètement, ce paramètre permet de fixer le niveau de seuil entre le signal de
souffle et le signal audio. C’est le paramètre le plus important dans la réussite
de la suppression du souffle. Contrairement au réducteur de bruit qui fixe
automatiquement une valeur d’absorption, vous devez ici fixer par vous-même
la valeur d’absorption car elle dépend grandement du signal sonore à traiter.
Des valeurs trop faibles risquent de ne pas supprimer totalement le souffle ou
de faire apparaître des bruits parasites. A l’inverse, des valeurs trop élevées
risquent de dénaturer le signal audio. Plus le volume du bruit est élevé, plus la
précision de ce réglage est importante.

Conseil d’utilisation : Ne fixez pas une valeur Absorption extrême sous peine de créer
des artefacts. Limitez-vous à l’absorption nécessaire.

Reduction
Ce paramètre détermine la quantité de r»éduction de souffle désirée (en dB).
Vous disposez d’un curseur de réglage ainsi que d’un champ numérique où
vous pouvez saisir directement la valeur désirée.
La valeur maximale s’élève à –30 dB. Attention : Si la valeur de réduction est
faible, le risque de voir apparaître des bruits parasites (artefacts) reste faible.
Ces artefacts peuvent apparaître lorsque le bruit est relativement fort ou lorsque
le paramètre Absorption n’est pas réglé correctement.
Les passages au volume très bas sont souvent délicats (lors du fondu de sortie
d’un instrument, par exemple), car il arrive que le niveau du souffle dépasse
celui du signal audio. Dans ce cas, il est préférable de diminuer la valeur du
paramètre Reduction (-10 à –15 dB) , ce qui peut, par ailleurs, réduire les éventuels
artefacts et mener à un bon compromis.

Resolution
Vous avez le choix entre trois niveaux de résolution (Low, Medium et High)
pour l’algorithme de réduction de souffle. Avec l’option High, la résolution est
élevée, mais les calculs durent plus longtemps. Faites quelques essais préalables
car une résolution plus élevée ne donne pas forcément de meilleurs résultats.
Ainsi, une résolution basse (Low) fonctionne souvent mieux quand la réduction
de bruit est appliquée à de courts sons percussifs ou à des paroles.

Overlap
Ce paramètre sélectionne le type de «chevauchement» utilisé par l’algorithme
de De-hissing (Smooth, Normal ou High).

Smooth: En général, choisissez ce réglage si les données à traiter sont des pistes
musicales (ou audio à attaque lente).

Normal: En général, choisissez ce réglage si les données à traiter sont de type
percussif (instruments à déclin court).

High: En général, choisissez ce réglage si les données à traiter sont des pistes
mixées (multiples instruments).
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Bypass
Cette option permet de désactiver temporairement l’action du Dehisser durant
la reproduction audio.

Inverse de-hissing
Cochez cette case pour pouvoir entendre la portion de souffle retirée par
l’algorithme. Vous pouvez ainsi vérifier qu’aucune portion des données audio
n’est également éliminée par l’effet. Si vous entendez une portion de signal en
plus du souffle, modifiez les réglages des paramètres Absorption et Reduction.

Note: Cette option devient vite indispensable.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!
Quand cette case est cochée, Samplitude crée une copie de la sélection temporelle
(Range) dans le même fichier audio que le matériel d’origine. Cela vous permet
de comparer vos résultats avec le matériel d’origine. Faites attention à la longueur
de la sélection et à l’espace disponible sur le disque dur ou en mémoire RAM.

Play/Stop
Cliquez sur ce bouton pour entendre en stéréo l’effet de la réduction de souffle.

Preview
Ce bouton vous permet de lancer la pré-écoute (calculée) de vos réglages actuels
de réduction de souffle. Cette option doit être employée si votre machine n’est
pas suffisamment rapide pour une pré-écoute en temps réel.

Conseil d’utilisation: Le temps de pré-écoute se règle dans Options > System/Audio
(Raccourci: Y) > onglet Program > Preview Time.

Bypass.
Cliquez sur ce bouton pour reproduire l’audio d’origine (sec) quand vous utilisez
les fonctions de lecture. Cela vous permet de rapidement comparer l’audio traité
et l’audio non traité.

Save
Cliquez sur ce bouton pour sauvegarder les paramètres actuels de réduction de
souffle comme un preset.

Load
Cliquez sur ce bouton pour charger un preset (jeu de réglages de paramètres)
de réduction de souffle préalablement sauvegardé.
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OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement configuré
sur les données audio. La fenêtre Dehisser se referme ensuite.

Cancel
Ce bouton referme la fenêtre Dehisser sans appliquer aucun traitement.

Utilisation du Dehisser:
1. Si vous devez appliquer le Dehisser directement à un projet Wave, passez sur

sa fenêtre (projet Wave) afin d’en faire la fenêtre active. S’il doit être appliqué
à un objet de VIP, sélectionnez cet objet (en cliquant dans sa moitié inférieure).

2. Si vous devez appliquer le Dehisser directement à un projet Wave, faites la
sélection temporelle (Range) désirée dans la fenêtre de projet Wave (cliquez
et glissez avec la souris dans la fenêtre de projet Wave pour définir une
sélection temporelle). S’il doit être appliqué à un objet de VIP, passez à l’étape
3.

3.  Depuis le menu Offline Effects, sélectionnez De-hissing et la fenêtre Dehisser
s’ouvrira.

4. Réglez le paramètre Absorption sur la valeur 40.
5. Réglez le paramètre Reduction sur la valeur 12.
6. Cliquez sur le bouton Play/Stop et Samplitude calculera une pré-écoute du

traitement.
7. Une fois que vous êtes satisfait du résultat obtenu, cliquez sur OK afin

d’appliquer le traitement au fichier audio.

Si vous n’êtes pas satisfait du résultat, relevez les paramètres Réduction et
Absorption en veillant toutefois à ne pas générer d’artefacts. Vous pouvez
également agir sur les paramètres Resolution et Overlap. Répétez ensuite les
étapes 6 et 7.

Conseil d’utilisation : Comme nous l’avons déjà mentionné, pensez à cocher la case
Inverse de-hissing (pour vérifier que vous ne supprimez pas trop du signal désiré)
avant d’appliquer vos réglages de Dehisser.

La procédure ci-dessous vous permet d’arriver aux réglages optimaux
du paramètre Absorption:
1. Pour la pré-écoute, localisez une portion de vos données audio qui contient

un signal (musique ou discours) de bas niveau. D’autres sections pouvant
convenir sont celles contenant un niveau de bruit relativement élevé par
comparaison au signal audio, ou de l’audio similaire à des types de bruit
particuliers. Par exemple, le son «aérien» d’un saxophone peut avoir les mêmes
caractéristiques qu’un signal de bruit. Autre exemple, les sibilantes des mots
parlés. L’algorithme arrive plus facilement à distinguer le bruit par rapport à
des sons riches en harmoniques et aux consonnes.

2. Réglez le paramètre Reduction sur la valeur maximale (-30 dB).
3. Relevez progressivement la valeur du paramètre Absorption. Vous pouvez le

faire au cours de l’écoute test en temps réel.
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Selon le réglage, le signal audio peut passer par quatre paliers:
Palier 1: Si la valeur est très faible, le bruit n’est pas retiré du signal.
Palier 2: Le bruit est retiré en partie du signal audio. Selon la quantité de bruit
du signal audio d’origine, quelques artefacts risquent d’apparaître si le bruit
n’est pas totalement supprimé.
Palier 3: Le bruit est complètement supprimé.
Palier 4: Si la valeur est très élevée, l’algorithme supprime non seulement le
bruit, mais également des portions du signal audio. (Vérifiez la portion du signal
qui a été retirée à l’aide de la fonction Inverse Dehissing. Si vous entendez alors
certaines portions du signal audio, cela signifie que le paramètre Absorption est
réglé sur une valeur trop élevée). Le signal audio perd de sa définition et le son
se brouille, dû à la perte des caractéristiques d’ambiance.
Le but est d’atteindre le palier 3.

Conseil : Pensez à vérifier les résultats en augmentant le volume d’écoute et en
accentuant les fréquences aiguës via le correcteur de votre console de mixage ou de
votre amplificateur (n’oubliez pas ensuite de ramener le correcteur en position neutre).
Nous vous recommandons d’employer également un système d’écoute doté d’un rapport
signal/bruit élevé.

4. S’il est impossible de retirer le bruit sans dénaturer la musique ou le discours,
diminuez la valeur du paramètre Reduction jusqu’à ce que vous trouviez le
meilleur compromis entre la réduction du bruit et la non dénaturation du
signal audio.

 Il est plus simple d’utiliser le Dehisser en destructif sur une piste spécifique
d’un projet VIP que de l’utiliser en mode virtuel sur la section Master de la
table de mixage. Si les niveaux de souffle sont très élevés, utilisez de préférence
le Dehisser depuis le Menu «Offline Effects» et traitez chacune des pistes
séparément.

Note: Quand vous travaillez sur des projets multipistes, si le souffle est limité à une ou
deux pistes, vous obtiendrez sans doute de meilleurs résultats en traitant les pistes
individuellement qu’en insérant le Dehisser en temps réel dans la section Master de la
table de mixage. Il est de loin préférable de ne changer que les pistes affectées par le
souffle.

Une fois encore, veillez à ne pas «surtraiter» vos données audio. A l’instar de
n’importe quel ingénieur du son, vous êtes plus sensible au souffle qu’un
auditeur lambda. Contrairement au souffle, les artefacts de type ondulation ou
sifflement sont beaucoup plus remarqués par l’auditeur moyen, tout
spécialement sur la voix. Par conséquent, n’oubliez pas qu’il vaut mieux dans la
plupart des cas qu’un peu de souffle subsiste plutôt que de le remplacer par des
artefacts parasites.

Note: Lorsque vous utilisez le Dehisser en temps réel depuis la section Master de la
table de mixage, la mémoire tampon VIP Buffer de Samplitude doit être réglée sur
une valeur minimum de 16000. Ce réglage s’effectue avec Options > System/Audio
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(Raccourci: y). Si la mémoire tampon n’est pas au moins sur cette valeur, le Dehisser
ne fonctionnera pas. En fait, la fenêtre du Dehisser refusera de s’ouvrir.

Manual de-clicker
Cette fenêtre de dialogue permet l’élimination destructive des clics
individuellement dans des objets. Elle contient le de-clicker, un bouton d’accès
direct Wave Editing ainsi que la prise en charge d’Algorithmix reNOVAtor.

Les réglages peuvent être sauvegardés et rechargés. Les réglages personnels
sauvegardés dans le répertoire FX_presets s’affichent dans la liste des presets.

Spectral Editor - Algorithmix reNOVAtor
Samplitude fournit une version de démonstration d’Algorithmix reNOVAtor.
Cet effet de haute qualité convient bien à l’élimination des bruits de toux, soupirs
ou autres interférences.
En marquant l’interférence dans le spectre visible, celle-ci est «effacée» grâce à
un algorithme sophistiqué. «Algorithmix reNOVAtor» doit aussi être
déverrouillé.
Vous en saurez plus sur l’application de cet effet en lisant le manuel de prise en
main de l’Algorithmix reNOVAtor.

Convolution
Choisissez cette option pour ouvrir la fenêtre Convolution qui vous permet
d’appliquer (destructivement) les «caractéristiques» d’un segment audio à un
autre projet Wave ou à des objets sélectionnés en fenêtre VIP. On peut considérer
ce processeur comme une version simplifiée du Room Simulator (ce sont tous
deux des filtres à convolution).
Lors de la convolution de deux échantillons audio, l’échantillon d’origine est
amalgamé (par une méthode de filtrage compliquée) avec l’échantillon de
convolution. Les harmoniques communes sont amplifiées, les harmoniques
différentes sont atténuées alors que certaines harmoniques d’ambiance sont
transférées.
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Note: Vous pouvez obtenir le même résultat avec le correcteur/analyseur FFT. Il suffit
pour cela de filtrer un échantillon par la réponse en fréquence d’un autre. Cette
deuxième méthode n’agit toutefois que sur la réponse en fréquences des deux
échantillons.

Cette fonction vous permet de réaliser des effets de réverbération, de retard, de
filtre et de morphing incroyables. Des résultats inattendus peuvent amener votre
projet dans de nouvelles directions!
Le principe de la convolution est identique à celui du simulateur d’espace (Room
Simulator). Par contre, alors que pour le simulateur d’espace, ce n’est qu’une
convolution optimisée pour le calcul des réponses de réverbération qui est
utilisée, c’est l’exacte convolution mathématique qui est employée pour la
convolution. L’échantillon de convolution (Convolution Sample) peut être jusqu’à
deux fois plus long que l’échantillon utilisé par le simulateur d’espace.

Convolution sample
Sélectionnez dans la liste déroulante le segment audio dont vous désirez
appliquer les «caractéristiques» au projet Wave actuel ou à un objet sélectionné
dans la fenêtre VIP. Lorsque vous utilisez des fichiers de plus de 1048576
échantillons, seuls les 1048576 premiers échantillons sont utilisés.

Important : Il faut toujours charger le segment audio (Convolution sample) dans
Samplitude (sous forme de projet Wave) avant de pouvoir le sélectionner parmi cette
liste.

Mix
Original (%): Indiquez la proportion du signal d’origine dans le résultat final.
Vous pouvez saisir directement la valeur de votre choix dans le champ numérique
conçu à cet effet.

Result (dB): Permet de doser le niveau de l’effet de convolution par rapport au
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signal d’origine. Vous pouvez saisir directement la valeur souhaitée dans le
champ numérique. Les valeurs supérieures à -10 dB produisent parfois de la
distorsion ou de la saturation (écrêtage). Ramenez dans ce cas les paramètres
sur une valeur inférieure.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case!

Save Setup
Cliquez sur ce bouton pour sauvegarder sous forme de configuration (preset)
les réglages de convolution.

Load Setup
Cliquez sur ce bouton pour recharger un preset de convolution préalablement
sauvegardé.

Preview
Ce bouton vous permet de lancer la pré-écoute de vos réglages actuels de
Convolution. Le temps de pré-écoute se règle dans Options > System/Audio
(Raccourci: Y) > onglet Program > Preview Time.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement configuré
sur les données audio. La fenêtre Convolution se referme ensuite.

Cancel
Ce bouton referme la fenêtre Convolution sans appliquer aucun traitement.

Distortion
Cet effet permet d’appliquer de la distorsion au signal audio par le biais d’une
courbe de référence à transfert non linéaire. Le signal est relevé et se voit doté de
nouvelles harmoniques.
En réglant le point de départ ou seuil de la distorsion (Threshold), une distorsion
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douce à couleur analogique (c’est-à-dire Threshold à –40 dB) peut être créée
(saturation). Par contre, en réglant ce seuil sur 0 dB, vous produisez une
distorsion agressive de type numérique. C’est le réglage de niveau (Level) qui
définit l’intensité de la distorsion.

Amp simulation
Ce simulateur d’ampli est un effet en temps réel qui simule les propriétés sonores
d’un amplificateur à lampes. Il convient particulièrement pour les sons de guitare
mais peut aussi être utilisé pour les enregistrements d’orgue ou de voix.

Amplifier: Ici, vous avez le choix d’une sélection d’amplificateurs dont le son
peut être simulé.
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Speaker: Ici, vous avez le choix d’une sélection de baffles dont le son peut être
simulé.

Equalizer: Un correcteur à 3 bandes pour régler les graves, les médiums et les
aigus.

Bright: Le bouton Bright (filtre d’impédance) sert à donner un son
particulièrement aigu qui peut vibrer quand il est utilisé avec les contrôleurs
automatiques suivants:

Distortion: Crée une distorsion typique d’un amplificateur analogique.

Volume: Règle le volume général du module d‘amplification.

Vocoder
Description de l’effet Vocoder en quelques mots : Un son de porteuse (par
exemple, une nappe de cordes ou un accord de synthé) est affecté par un
modulateur (par exemple, un dialogue, un chant voire une boucle de batterie)
afin de donner l’impression que la porteuse «parle» ou «chante».
Pour obtenir ce résultat, les caractéristiques spectrales du modulateur sont
transmises à la porteuse. Le signal du modulateur est découpé en un certain
nombre de bandes de fréquences organisées à intervalles réguliers. Ces mesures
pilotent un filtre affecté à la porteuse correspondant aux mêmes bandes de
fréquences.

Normalement, un vocodeur a deux entrées et une sortie. Comme les effets de
Samplitude n’ont qu’une seule entrée, la porteuse est «prélevée» de l’effet qui
peut ensuite la mixer précisément avec un bruit blanc ou n’importe quel fichier
WAV. Vous pouvez également utiliser le Vocoder comme un effet mono dans
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lequel le canal d’entrée sert de porteuse et l’autre de modulateur.
L’effet Vocoder intègre par ailleurs un filtre FFT en temps réel permettant
l’édition des signaux de l’effet.

Paramètres de réglage du Vocoder
Courbes de filtre: La ligne jaune représente les propriétés spectrales du
modulateur. La ligne bleu clair représente les propriétés spectrales de la porteuse.
La ligne rouge est un filtre FFT librement dessinable. Vous pouvez ainsi dessiner
n’importe quelle fréquence et optimiser l’action du Vocoder. La ligne bleue est
la courbe de filtre finale du Vocoder. Pour plus de détails sur les paramètres de
zoom et sur le graphique du filtre, veuillez vous reporter aux fichiers d’aide
consacrés au filtre FFT.

Reset (sous l’affichage graphique): ramène la courbe de filtre rouge à son
état par défaut.

Dynamic filter parameters (Paramètres de filtrage dynamique)
Timing (Release): Détermine le temps de réponse du filtre dynamique pour
s’ajuster sur le spectre du modulateur. Plus la valeur est élevée, moins le Vocoder
suit rapidement le modulateur et plus es variations sonores de la porteuse sont
douces. Pour des résultats optimaux, réglez ces paramètres sur une valeur peu
élevée.

Dynamic reduction: Agit sur la dynamique du signal modulateur afin de
réduire une trop grande modulation du filtre dynamique.
Cela élimine deux effets secondaires liés à la modulation. Tout d’abord, le réglage
du volume du signal modulateur est transmis en sortie sous une forme moins
complexe. Le son du Vocoder ressort ainsi mieux dans le mixage. Deuxièmement,
les portions graves du signal modulateur sont ignorées, ce qui permet d’éviter
la modulation de la porteuse par des sons de respiration ou des interférences de
signal.
Ce paramètre n’est utile que si le signal modulateur est parfaitement contrôlé.
Au lieu d’utiliser les réglages de dynamique du Vocoder, vous pouvez aussi
régler la dynamique du signal modulateur (ou son résultat) par le biais des outils
intégrés au programme.

Resolution (Filter bands): Résolution du filtre dynamique (ce qui correspond
en quelque sorte au nombre de bandes de filtrage). Pour un résultat optimal,
choisissez une résolution moyenne à forte.

Pitch (Filter shift): Le filtre dynamique du Vocoder permet de relever ou
d’abaisser la fréquence et ainsi de créer des effets de hauteur. Pour un résultat
optimal, ne modifiez pas ce paramètre.

Formant: Le filtre dynamique du Vocoder permet de relever ou d’abaisser la
fréquence et ainsi créer des effets de hauteur. Pour un résultat optimal, ne
modifiez pas ces paramètres.
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Overlap Mode (Smooth/Normal): Paramètre interne modifiant la durée de
chevauchement (qui calcule le spectre du signal modulateur).
En mode «Smooth», le son du Vocoder est plus doux et plus mélodique aux
dépens de la qualité.

Carrier (porteuse)
Liste de sélection des échantillons: Cette liste donne le choix entre les
différents signaux de porteuse. Tous les projets Wave ouverts sont répertoriés
en compagnie d’échantillons de porteuse spécifiques chargés automatiquement
depuis le dossier du Vocoder. Les échantillons de porteuse préfèrent les signaux
à fréquences régulières comme par exemple des accords d’orchestre, de larges
nappes de synthétiseur, des bruits de vent etc.

Sample (dB): Fixe le niveau d’échantillon de porteuse.

Noise(dB): Paramètre automatique qui mélange du bruit blanc à la porteuse. Il
est avant tout utilisé si la porteuse ne peut pas être modulée correctement ou ne
sonne pas bien. Il est d’ailleurs possible de produire des sons de type
chuchotement de cette façon. Vous pouvez même vous en servir pour remplir
de trop grands intervalles entre les différents temps des boucles de batterie.

Modulator Carrier: Permet de permuter les signaux du modulateur et de
la porteuse. Cette fonction est particulièrement utile si l’option «Stereo

Channel  Carrier» est employée.

Stereo Channel  Carrier: Si cette option est cochée, la porteuse de la liste
n’est plus utilisée et est remplacée par une version stéréo du signal d’entrée
(l’autre canal sert de modulateur). L’avantage est que la synchronisation entre la
porteuse et le modulateur est alors parfaitement précise et la position de lecture
n’a plus d’incidence sur le résultat.

Voici quelques suggestions: 
Créez 2 pistes incluant chacune un modulateur et une porteuse. Puis créez une
piste submix incluant le Vocoder comme effet avec l’option « Stereo Channel

 Carrier » cochée. Dirigez les sorties des pistes de modulateur et de porteuse
(menu «Track») vers cette piste submix puis réglez le panoramique du
modulateur à gauche et celui de la porteuse à droite. A la place de fichiers audio,
vous pouvez aussi utiliser des instruments VST ou bine combiner des fichiers
audio avec des instruments VST.

Volume: Règle le niveau de sortie du Vocoder.
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Room Simulator

Description générale
Cette fonction de simulateur d’espace permet de simuler les caractéristiques
réverbérantes de n’importe quel lieu ou espace. Samplitude calcule la réponse
impulsionnelle de la réverbération et l’applique au signal audio dans la zone
délimitée de l’objet de la piste VIP. Une réponse impulsionnelle représente
l’évolution naturelle d’un son soudain à fort impact comme un coup de feu. Elle
contient toutes les informations nécessaires pour récréer exactement la
réverbération d’une pièce. La réponse impulsionnelle peut être influencée par
les paramètres de réglage proposés. Les caractéristiques de la réverbération
peuvent être modifiées très facilement. En outre, le caractère de la réverbération
peut être déterminé par le choix du type de réponse impulsionnelle. Une
représentation graphique de la réponse impulsionnelle et des courbes de fondu
supplémentaires vous donne un aperçu global de la manipulation de réponse
impulsionnelle via la fenêtre Room Simulator (simulateur d’espace). Dans
Samplitude professional, le simulateur d’espace est applicable en temps réel
sur les objets, les pistes, les bus auxiliaires et les voies Master.

Paramètres de réglage
Bank
Pour sélectionner la banque répertoire dans laquelle la liste des réponses
impulsionnelles est transférée.

Preset (Réponse impulsionnelle et paramètres)
Lorsque vous chargez un preset, le simulateur d’espace recharge les paramètres
de réglage ainsi que la réponse impulsionnelle qui y est associée. La réponse
impulsionnelle peut être n’importe quel échantillon sauvegardé sur le disque
dur sous forme de projet WAV, HDP ou fichier RAP. Si le fichier a été déplacé
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ou supprimé, le simulateur d’espace affiche un message d’erreur. Un fichier
*.imp spécial est alors créé pour les impulsions standards.
Lorsque vous sauvegardez un preset, seul le chemin d’accès vers la réponse
impulsionnelle choisie est sauvegardé, pas la réponse impulsionnelle elle-même.

Load/Save/Delete (preset: réponse impulsionnelle et paramètres)
Ces boutons permettent respectivement de charger, sauvegarder et supprimer
les presets. La fonction Load (charger) n’est nécessaire que si les fichiers de
presets ne sont pas placés dans le dossier «RoomSim» (Les presets se trouvant
dans ce dossier sont automatiquement chargés et affichés dans la liste de sélection
de la fenêtre). Les presets portent l’extension *.rms.

File (Impulse response)
Sélectionnez avec ce paramètre une réponse impulsionnelle depuis les dossiers
«RoomSim» et Bank ainsi que depuis le projet Wave ouvert. Si le projet Wave
ne contient pas de réponse impulsionnelle, aucun effet de réverbération n’est
produit.
Si vous avez désactivé l’option «Install Impulse Responses» (installer les réponses
impulsionnelles) lors de l’installation du programme, le dossier reste vide. Si
vous avez sauté cette étape de l’installation, vous pouvez revenir en arrière et
effectuer uniquement cette partie de l’installation de Samplitude.

Load (Impulse response)
Permet de charger une réponse impulsionnelle. Il peut s’agir de n’importe quel
échantillon sauvegardé sur le disque dur sous forme de fichier WAV, HDP ou
RAP.

Play (Impulse response)
Lance la lecture de la réponse impulsionnelle afin d’en vérifier le contenu. Les
réponses impulsionnelles de type IMR sont lues exclusivement en 16 bits, même
si elles sont au format 32 bits à virgule flottante.

Représentation graphique
dB lin
Dans ce mode, le graphique reprend l’affichage habituel des échantillons basé
sur une échelle d’amplitude linéaire.

dB log
L’échelle d’amplitude de l’affichage est logarithmique. C’est le mode qui se
rapproche le plus de la perception des variations de volume par l’oreille humaine.
Options de zoom: Min, Max, +, –.

Courbes:
Rouge: Évolution de la réponse impulsionnelle

Bleu clair: Courbe d’enveloppe à 2 segments permettant de supprimer les
premières réflexions et la post-réverbération.
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Jaune: Courbe d’enveloppe librement dessinable.

Parameters
Preset
Cette section vous permet de charger, sauvegarder et supprimer des
configurations de réglages de la fenêtre (courbe de réponse, réponse en
fréquence, mixage). Cette fonction est très pratique pour comparer différents
réglages avec la même réponse impulsionnelle.

Save/Load/Delete
La fonction Load n’est nécessaire que pour charger des fichiers de preset ne se
trouvant dans le dossier «FX-preset». Les presets placés dans le sous-dossier
«FX-preset» sont automatiquement chargés et listés dans le menu déroulant.
Les presets de paramètres portent l’extension *.rsp.

Paramètres d’édition des temps de réponse de réverbération
Courbes d’enveloppes dessinables: L’échelle de la réponse impulsionnelle
peut être manipulée au moyen d’une courbe d’enveloppe jaune. En général,
cette enveloppe permet de retirer ou supprimer les premières réflexions. Servez-
vous de l’option de zoom pour plus de confort.

Reset Freehand Envelope: ramène la courbe à son état initial.

Pre-delay: Permet de retarder la totalité de la réponse impulsionnelle d’un temps
réglable entre 1 et 100 ms.

Impulse I.R.
Early Reflect: Définit le degré de réflexions premières en relevant ou abaissant
la première partie de la réponse impulsionnelle.

Late Reverb: Permet d’amplifier ou d’atténuer la portion de fin de la
réverbération. Ce paramètre agit sur la portion finale de la réponse
impulsionnelle.

Length: Ce paramètre permet de raccourcir la réverbération jusqu’à 5 % de sa
durée d’origine par réduction du motif de réponse impulsionnelle. N’oubliez
pas que la réverbération risque alors de s’arrêter de manière plutôt abrupte, ce
qui peut entraîner un motif de déclin peu naturel. Vous pouvez compenser cela
en appliquant un réglage plus faible pour Late Reverb afin d’atténuer
progressivement la réponse impulsionnelle au moyen de la courbe d’enveloppe
à 2 segments. Servez-vous du graphique pour vérifier visuellement l’enveloppe.

Env. Time: Définit la durée du premier segment de la courbe d’enveloppe.

Paramètres d’édition des fréquences de la réverbération
High: Permet d’atténuer les hautes fréquences de la réverbération.
Low: Permet d’atténuer les basses fréquences de la réverbération.
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FFT-EQ: Le pourcentage de réverbération peut être retravaillé avec un filtre FFT
supplémentaire. Le spectrogramme en temps réel du pourcentage de reverb
dans le filtre FFT permet un contrôle graphique des fréquences de la pièce par
enregistrement de la réponse impulsionnelle. Les résonances parasites peuvent
ainsi être facilement identifiées et supprimées. Le filtre FFT n’est pas disponible
si le réglage de latence des paramètres ne dépasse pas 4096 échantillons
(samples) car il entraîne une plus grande latence en raison de sa fonction de
phase linéaire.

Mix
Dry.: Fixe le niveau du signal d’origine en dB

Wet: Fixe le niveau de l’effet de réverbération en dB

Out: Définit le niveau de sortie en dB

Bypass: Permet de faire passer directement le signal d’entrée en sortie pour
comparaison.

Performance Options
Quality: Dans les deux modes normaux, la simulation d’espaces est calculée
uniquement à la moitié de la fréquence d’échantillonnage. Cela suffit
parfaitement pour la plupart des cas car les réponses impulsionnelles naturelles
ou numériques possèdent principalement des composantes de moins de 10 kHz
(vous pouvez vérifier ce point à l’aide de l’éditeur spectral du filtre FFT intégré).
Beaucoup d’anciens modules de réverbération fonctionnent eux aussi à la moitié
de la fréquence d’échantillonnage – les calculs au-delà de la plage de fréquence
utile consommant inutilement des ressources CPU.
Les deux modes normaux diffèrent uniquement en terme de qualité du
rééchantillonnage utilisé lors la baisse de fréquence d’échantillonnage. La qualité
de rééchantillonnage «normal resampling quality» reste toutefois assez élevée.
Réservez le mode «high resampling quality» (aux cas exceptionnels (à cause du
surplus de calculs arithmétiques demandés).

En mode High, c’est la totalité de la plage de fréquences qui est calculée ce qui
double la charge du processeur par rapport au mode normal.

Latency: Paramètre gérant la latence, c’est-à-dire la longueur par défaut des
blocs à partir desquels les opérations sont calculées en interne.
Plus les blocs sont petits, plus il faut d’opérations arithmétiques, ce qui augmente
la charge du processeur. Avec des blocs plus gros, la charge du processeur est
plus irrégulière. Pour un traitement en temps réel optimal, optez pour une valeur
de 32768 échantillons (samples).
Sur les bus AUX, les pistes ou la section Master (où la latence doit être faible),
une valeur de 40 % est recommandée sur les systèmes rapides.
La qualité du résultat dépend de ce réglage.
Avec une latence inférieure ou égale à 40 %, le filtre FFT n’est plus utilisable.
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Les réponses impulsionnelles que vous avez créées peuvent appliquer le filtre
FFT sur la réponse impulsionnelle avant la simulation destructive du Room
Simulator.
Par défaut, la latence est relevée lors de l’utilisation du Room Simulator, car
une latence faible augmenterait sans raison la charge du processeur.

Set/Get: avec le bouton Get, vous pouvez ramener ces options à leurs valeurs
par défaut. Avec le bouton Set, vous pouvez en définir de nouvelles.

Description: charge du processeur en fonction des réglages des
paramètres impulsionnelles
Qualité
Réglage «High Quality» Double (facteur 2:1)

Latence
Latence faible (2048 échantillons): hausse d’environ 50 % (facteur 1,5)
Latence très faible (128 échantillons): hausse d’environ 150 à 200 %
(facteur 3 - 4)

Durée des réponses impulsionnelles
Si la longueur de l’échantillon utilisé comme réponse impulsionnelle dépasse
une puissance 2, la charge du processeur double (facteur 2,1).
Les ressources nécessaires doublent à chaque fois que la durée de la réponse
impulsionnelle double:

11.88 s
5.944 s
2.97 s
1.48 s
0,74 s
0.37 s
etc.

Vérifiez que vos réponses impulsionnelles sont plus courtes que la valeur suivante
— en particulier si les réponses impulsionnelles font plus d’une seconde, car la
durée de ces «intervalles de charge continue du processeur» augmente
exponentiellement avec chaque accroissement de longueur.

Fréquences d’échantillonnage des réponses impulsionnelles
La charge du processeur augmente proportionnellement à la fréquence
d’échantillonnage.

Résolution des réponses impulsionnelles
La charge du processeur ne dépend pas de la résolution car les calculs sont
toujours effectués avec une précision à la virgule flottante.

Conseils d’utilisation du simulateur d’espace (Room Simulator)
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Le simulateur d’espace permet de récréer les caractéristiques d’une multitude
de réverbérations. La simple édition de la réponse impulsionnelle permet
d’obtenir une large variété d’effets. Voici quelques suggestions:
– En appliquant la fonction Reverse sur la réponse impulsionnelle, vous obtenez

une réverbération inversée.
– En utilisant la fonction Timestretching, vous pouvez agir sur la taille de la

pièce sans en modifier la résonance.
– En utilisant la fonction dessin en fenêtre d’onde, vous pouvez retirer des

réflexions premières de la pièce ou en ajouter.
– Faites des essais avec de courts échantillons de vos propres données audio

auxquelles vous aurez appliqué un fondu de sortie. Vous pouvez ensuite
reprendre ces échantillons comme réponses impulsionnelles. Vous risquez
d’obtenir des effets intéressants et parfois surprenants.

– Vous pouvez également recréer des réverbérations intéressantes en vous
servant d’un échantillon d’impact comme réponse impulsionnelle sur une
percussion.

Problèmes et solutions
Le son de la réverbération est trop dur.
Le paramètre Late Reverb permet d’atténuer progressivement la réponse
impulsionnelle jusqu’à zéro. Vérifiez l’effet obtenu sur le graphique. Si le
graphique est affiché en mode dB log, il est très facile de contrôler la réponse et
de voir si l’amplitude décroît véritablement jusqu’à zéro.

Le fichier obtenu souffre d’un décalage prononcé de la composante continue du courant
(DC offset).
La réponse impulsionnelle doit être dépourvue de tout décalage de composante
continue du courant. Veuillez donc y remédier avec la commande Offline Effects-
> Remove DC Offset.

Forte activité du disque dur ou affichage d’un message d’erreur indiquant un manque
de mémoire.
L’algorithme nécessite un très gros espace de stockage, tout spécialement avec
des réponses impulsionnelles longues. Tous les traitements en tâche de fond
doivent être terminés et tous les projets Wave en RAM non nécessaires doivent
être refermés.

La charge du processeur est trop élevée.
– Vérifiez le réglage du paramètre Latency en suivant les conseils donnés dans

la description de ce paramètre.
– Sélectionnez la qualité «Normal ».
– Raccourcissez la réponse impulsionnelle (sans oublier le conseil donné à

propos des intervalles de charge continue du processeur).

Problèmes survenant avec les réponses impulsionnelles longues.
En temps réel, des réponses impulsionnelles atteignant 11,88 secondes (avec
une fréquence d’échantillonnage de 44,1 kHz) peuvent être utilisés sur des
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ordinateurs récents (2002).
La longueur n’est limitée que par la capacité du processeur.
Lors de calculs destructifs, la limite monte à 380,4 secondes (avec une fréquence
d’échantillonnage de 44,1 kHz).
Si ce plafond est dépassé, les échantillons ultérieurs sont ignorés.
Des réponses impulsionnelles de cette durée ne sont toutefois pas adaptées à la
simulation d’espace.
Si vous souhaitez faire des essais avec des réponses impulsionnelles extrêmement
longues (supérieures à 1 minute), sachez que l’algorithme va consommer
énormément de mémoire (plus de 500 Mo).
Si vous chargez de longs projets Wave comme réponses impulsionnelles, un
message d’avertissement s’affiche vous permettant d’annuler l’opération afin
de vous éviter une longue attente de chargement.

Echo/Delay/Reverb
Cet effet permet d’appliquer de manière destructive des effets de retard sur des
projets Wave.

Note: Lorsque vous l’utilisez depuis le menu Offline Effects, cet effet est destructif.
Vous pouvez par contre en trouver une réplique pour usage en temps réel dans la
fenêtre VIP. Pour utiliser la version en temps réel, ouvrez la table de mixage (touche
m) et faites un clic droit sur le bouton Delay (sur chaque voie).

Mode
Mode détermine le mode d’action de l’effet et donc les paramètres offerts par la
fenêtre.
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1 Delay: Dans ce mode, le processeur génère un seul écho.

Feedback: Dans ce mode, le processeur génère un écho répétitif dont le volume
baisse progressivement jusqu’au silence. Le temps de retard (espacement entre
les échos) se définit avec le paramètre Echo Delay (Millisec.). Le déclin de l’écho
s’applique aux répétitions – sous forme d’un pourcentage de la précédente – en
fonction du réglage Decay.

Multi Tap: Dans ce mode, le processeur génère un retard multi Tap (retard à
intervalles multiples). Le retard multi Tap répète des portions de l’événement
retardé entre les échos majeurs déterminé par le réglage Echo Delay. Vous pouvez
ainsi créer toute une variété d’effets répétitifs où des échos se répètent et se
multiplient, tandis que des événements antérieurs déclinent progressivement.

Hall: Dans ce mode, le processeur fonctionne comme un module de
réverbération. Même s’il ne cherche pas à concurrencer un module de
réverbération haut de gamme, cet algorithme consomme très peu de ressources
du processeur et est d’une fidélité amplement suffisante pour les réverbérations
simples.

Echo Delay / Rev. Time
Cette section permet de définir dans l’unité de mesure choisie l’espacement
entre les échos (temps de retard) et entre le signal d’origine et la première
répétition. L’unité de mesure se choisit en cliquant dessus et en la sélectionnant
dans le menu qui apparaît.
En mode Hall, cela contrôle le temps de réverbération.

Decay
C’est ici que se règle le temps de déclin de l’effet de retard/retard multi tap. Le
curseur contrôle en réalité le pourcentage de signal traité réinjecté dans l’effet,
de 0 à 100 %, selon le déclin rapide ou lent voulu pour le retard.
Ping-Pong: Applique au retard un effet stéréo en échangeant les canaux sur le
trajet de la réinjection. Pour entendre cet effet, le signal d’entrée doit être stéréo.

Reverb Properties
Large / Small: Ce curseur règle la taille globale de la chambre de réverbération.
Vous pouvez aussi saisir la taille numériquement (au clavier) dans le champ de
saisie adjacent.

Dark / Bright: Ce curseur règle la couleur tonale globale de la chambre de
réverbération. Vous pouvez aussi la saisir numériquement (au clavier) dans le
champ de saisie adjacent.

Mix Balance in %
Dry: Ce fader gère le niveau du signal d’origine (sec).
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Wet: Ce fader gère le niveau du signal de retard (exprimé en pourcentage du
niveau du signal d’origine). Vous pouvez utiliser le fader pour modifier le réglage
actuel ou saisir directement la valeur souhaitée dans le champ numérique.
Remarquez que l’affichage graphique (moitié haute de la fenêtre) change pour
refléter le niveau actuel de l’effet.

Link: Couplage du niveau de son sec d’origine (dry) et du niveau de son d’effet
(wet) pour maintenir un niveau de signal relativement quand un des curseurs
est bougé.

Create Copy
Comme dans la plupart des autres effets du menu Offline Effects, cette
importante option permet de générer un fichier d’annulation avant le traitement,
ce qui permet de revenir en arrière si le résultat du traitement ne vous satisfait
pas. Comme toujours, nous vous conseillons vivement de toujours cocher cette
case.
Quand cette case est cochée, Samplitude crée une copie de la sélection temporelle
(Range) dans le même fichier audio que le matériel d’origine. Cela vous permet
de comparer vos résultats avec le matériel d’origine. Faites attention à la longueur
de la sélection et à l’espace disponible sur le disque dur ou en mémoire RAM.

Load
Cliquez sur ce bouton pour charger un preset (jeu de réglages de paramètres)
d’effet Echo / Delay / Reverb préalablement sauvegardé.

Save
Cliquez sur ce bouton pour sauvegarder les paramètres actuels d’effet Echo /
Delay / Reverb Effect.

Play/Stop
Ce bouton permet d’entendre le fichier audio traité.

OK
Cliquez sur le bouton OK pour valider les réglages et figer le traitement configuré
sur les données audio. La fenêtre Echo/Delay/Reverb se referme ensuite.

Cancel
Ce bouton referme la fenêtre Echo / Delay Effect sans appliquer aucun traitement.

Resample / Timestretching
Note: Si vous souhaitez uniquement changer la fréquence d’échantillonnage d’un
fichier audio, préférez la commande Change Sample Rate du menu Offline Effects.

Tous les algorithmes de cette fenêtre de dialogue utilisent le paramètre de facteur
temps et la hauteur comme paramètre d’entrée.
Les calculs de facteur temps (de la durée/vitesse d’origine à la durée/vitesse
souhaitée) s’activent très simplement sur la droite de la fenêtre (Time Factor
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Calculation).

Resampling
C’est par cette technique, appelée rééchantillonnage en français, que les
échantillonneurs et les synthétiseurs à base de PCM transposent les échantillons.
Le facteur temps et la hauteur dépendent l’un de l’autre : plus le signal audio est
court, plus sa hauteur est élevée. C’est comme si vous changiez la vitesse de
lecture d’une platine vinyle ou d’un magnétophone.
L’effet n’agit pas vraiment sur la qualité sonore. La perte de qualité est moins
sensible qu’avec toutes les techniques de Timestretch/transposition. Si ce n’est
pas un problème que la hauteur change avec la vitesse (ou inversement), utilisez
cet algorithme.
Lorsque vous rallongez un signal audio par rééchantillonnage, de très courts
effets d’aliasing peuvent survenir, effets qui peuvent être atténués par le filtre
anti-aliasing. Sinon, comme ce filtre nécessite une charge supplémentaire du
processeur, il peut être activé pour le calcul et la pré-écoute en temps réel en
cochant «High Quality Resampling». Ce filtre est également disponible avec les
autres algorithmes de transposition par rééchantillonnage.

Pitch-Shifting/Timestretching (transposition/compression
temporelle)
Avec tous les autres algorithmes, les variations de hauteur et de durée sont
indépendamment réglables. Ces algorithmes engendrent des artefacts, et selon
la nature des données audio, vous pouvez obtenir de meilleurs résultats avec
d’autres algorithmes. L’algorithme utilisé en mode Timestretching/Pitchshifting
comme effet par défaut de l’objet peut être sauvegardé pour un projet Wave au
moyen du Timestretch/Pitchshift Patcher.

Algorithmes de Pitchshifting/Timestretching
Standard
Cet algorithme donne en général de très bons résultats. Il utilise des facteurs
(de 0.9 à 1.1) et des phases fixes, qui permettent de conserver l’impression
d’espace des signaux stéréo. Pour les boucles de batterie et autres signaux
rythmiques, cet algorithme ne sera pas toujours optimal car il peut modifier le
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groove et – dans de rares cas – doubler, voire supprimer certains temps.
La compression temporelle (réduction de la longueur d’échantillon) fonctionne
généralement mieux que l’expansion temporelle. Si vous devez combiner deux
échantillons, raccourcissez plutôt l’échantillon le plus long que l’inverse.

Usage recommandé:
– sur les signaux audio complexes (mixages)
– en cas d’échec des autres algorithmes

Sollicitation du processeur: faible

Smooth
C’est un algorithme beaucoup plus complexe qui demande davantage de calcul.
Les données audio peuvent être traitées avec de très grands facteurs (de 0,2 à
50) sans générer d’artefacts importants. En effet, les données audio sont «lissées»,
ce qui adoucit le son et change la phase. Ce lissage est à peine audible sur les
pistes de dialogue, de chant ou d’instruments solo. Avec des signaux au spectre
plus complexe – mixage de différents instruments ou mixages définitifs – vous
risquez de rencontrer quelques problèmes. Cet algorithme ne convient pas aux
boucles de batterie et aux autres signaux présentant des transitoires marquées.
Le groove reste intact, mais les variations de phase altèrent les «attaques». Dans
ce cas, une légère correction (facteur 0,9 à 1,1 environ) permet souvent de
résoudre le problème. Vous pouvez choisir parmi cinq degrés de lissage (Smooth
degree).

Usage recommandé:
– sur les instruments orchestraux
– sur les pistes de dialogue avec bruit de fond (enregistrements vidéo, par
exemple)
– nappes de synthés, guitares…

Usage non recommandé:
– mixages stéréo
– boucles de batterie, percussions

Sollicitation du processeur: très élevée

Beat marker slicing
À l’origine, ce mode de découpage par marqueurs de temps est conçu pour les
boucles de batterie mais peut servir pour d’autres types de signaux audio comme
les lignes de basse monophoniques ou les lignes de séquenceur. Cet algorithme
découpe le signal en divers éléments – notes individuelles ou temps repérés par
des marqueurs de temps.
Ces «fragments» sont ensuite réorganisés selon la règle temporelle : les différents
temps se chevauchent en cas d’augmentation du tempo. De courtes pauses sont
insérées entre les temps en cas de diminution du tempo.
Si vous avez la possibilité d’utiliser cet algorithme, faites-le. Il vous permet de
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modifier le tempo sans perte de qualité avec une charge de processeur minimale.

Usage recommandé:
– échantillons devant être découpés en notes ou mesures séparées (temps)
– boucles de batterie mais uniquement si les temps ne se chevauchent pas et
en présence d’une faible réverbération

Usage non recommandé:
– tous les autres types de données audio

Sollicitation du processeur: très faible

Beat marker stretching
Cet algorithme de Timestretching par marqueurs de temps fonctionne sur le
même principe que l’algorithme Standard, mais synchronise les données étirées
sur les marqueurs de temps. Le groove est donc légèrement modifié et certains
temps peuvent être dupliqués, voire supprimés. Par rapport à l’algorithme «Beat
marker slicing» (qui peut engendrer la disparition ou le mauvais positionnement
de certains marqueurs), cet algorithme présente une plus grande imprécision
en matière de synchronisation. En pratique, la création automatique des
marqueurs donne presque toujours de bons résultats. Évitez seulement de placer
les marqueurs de temps trop près les uns des autres (< 1000 échantillons)
«Long overlap»: Cette option donne des sons moins «ébouriffés», mais des
échos peuvent par contre apparaître. Cela convient particulièrement aux boucles
de batterie avec de très petits changements.

Usage recommandé:
– Tous les types d’échantillons rythmiques ne pouvant pas être découpés en

mesures ou notes individuelles (temps)
– Boucles de batterie complexes à chevauchement
– S’il n’est pas possible d’utiliser l’algorithme «Beat marker slicing» ou si vous

ne parvenez pas à trouver le bon emplacement des marqueurs de temps.

Sollicitation du processeur: faible

Beat marker slicing et Beat marker stretching – Réglage et estimation
des marqueurs de temps
S’il n’y a pas de marqueurs de temps placés manuellement («patched», voir ci-
dessous) dans le projet Wave, il sont déterminés automatiquement en temps
réel. S’il y a des marqueurs de temps, vous pouvez déterminer avec l’option
«patched» s’ils sont ou non utilisés.
Dans l’option Timestretching du menu Offline effects, vous pouvez
temporairement créer de tels marqueurs pour le traitement offline. Pour
sauvegarder de façon permanente ces marqueurs dans le projet Wave et pour
une édition plus confortable, utilisez le Timestretch/Pitchshift patcher (menu
Tools).
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Création de marqueurs — Options:
Find beat marker: L’algorithme recherche et marque les temps dans les données
audio.

Beat recognition threshold: Seuil de détection de temps. Quand le projet
Wave est affiché, vous pouvez suivre le placement des temps. Cela fonctionne
aussi avec des objets si le projet Wave reste simultanément ouvert.

Reset Beat markers: Tous les marqueurs de temps sont effacés.

Il est possible de déplacer, copier, supprimer, etc. les marqueurs de temps au
moyen des commandes de marqueurs adéquates.
Lors de l’insertion de nouveaux marqueurs, il faut donner aux marqueurs le
nom «Beat Marker». Avant l’édition, nous vous recommandons de fixer le seuil
de détection des temps suffisamment haut, puis de supprimer les marqueurs
redondants. Cette méthode prend moins de temps que l’insertion manuelle des
marqueurs.
L’édition des marqueurs n’est possible que tant que la fenêtre est ouverte et au
moyen du Timestretch Patcher. Celui-ci permet de vérifier les résultats sans
avoir à refermer la fenêtre (fenêtre non modale).
Plus encore, vous pouvez sauvegarder le tempo (BPM) et la méthode préférée
de timestretching pour l’objet directement dans le projet Wave.

Monophonic Voice
C’est le mode de Timestretching et de Pitchshifting à préférer pour les voix
solo, les discours et les instruments solo. Le signal audio doit être dépourvu de
bruit de fond et de réverbération. Avec un signal audio répondant à ces critères,
le résultat est de très grande qualité. L’option «Formant Factor Correction» assure
le maintien des formants lors de la transposition afin d’éviter l’effet «voix de
Mickey Mouse». Vous pouvez ainsi «composer» un chœur d’accompagnement
à partir d’une voix solo. Les formants peuvent par ailleurs être transposés sur
une plage de + - 12 demi-tons pour créer de la distorsion vocale.

Usages typiques:
– Correction de l’intonation (les fausses notes doivent être extraites comme

des objets pour pouvoir être manipulées séparément si vous ne travaillez pas
avec la fonction ElasticAudio)

– Effets d’harmonisation : en copiant, puis en transposant vers le bas un objet
couvrant une partie chantée. Le fait de modifier la hauteur crée ainsi une
seconde voix.

– Création d’accompagnements vocaux à partir d’échantillons de voix existants
– Timestretching
– Distorsion d’échantillon de voix

Usages recommandés:
Voix solo, discours ou instruments solo sans chevauchement, peu ou pas de
bruit de fond et de réverbération.
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Usages non recommandés:
Tout le reste

Sollicitation du processeur: élevée

Change Sample Rate
Cette fonction vous permet de modifier la fréquence d’échantillonnage d’un
projet Wave. Cela est nécessaire pour pouvoir par exemple convertir un
enregistrement sur DAT à 48 kHz en 44,1 kHz en vue de la gravure d’un CD
audio. Lors de la procédure, une copie du projet Wave est créée et c’est sur cette
copie que s’effectue la conversion de fréquence d’échantillonnage. Autrement
dit, le fichier audio d’origine reste toujours intact.

Important: Seuls les projets Wave peuvent voir leur fréquence d’échantillonnage
convertie! Si vous souhaitez convertir la fréquence d’échantillonnage d’un objet en
fenêtre VIP, cliquez sur l’objet en question avec le bouton droit de la souris, puis
sélectionnez l’option Wave Editing du menu contextuel qui s’affiche. Cela ouvrira la
fenêtre du projet Wave auquel cet objet fait référence.

New Sample Rate
Indiquez ici la fréquence d’échantillonnage à laquelle la copie du projet Wave
doit être convertie. Vous pouvez cocher une case de fréquence prédéfinie ou
saisir manuellement la fréquence souhaitée dans le champ prévu à cet effet. Il
faut OBLIGATOIREMENT que votre carte son soit compatible avec la fréquence
d’échantillonnage choisie pour que le fichier audio converti puisse être relu!

Quality
Ce paramètre définit d’une part la qualité des filtres anti-repliement et d’autre
part de l’interpolation utilisée lors de la conversion de fréquence
d’échantillonnage. Plus la qualité est élevée, plus la conversion de fréquence
d’échantillonnage prend du temps.
Vous avez le choix entre cinq algorithmes de conversion, de Standard à Ultra
High 2 par ordre croissant de qualité, afin de répondre à tous les besoins et à
toutes les situations:
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Standard
Fait appel à l’algorithme d’interpolation qui est appliqué au cours du
rééchantillonnage en temps réel. Optez pour ce réglage si un haut niveau de
qualité n’est pas nécessaire et que vous êtes pressé.

High
Fait appel à un filtre pour atténuer les fréquences qui provoquent le repliement
(Aliasing) ou pour améliorer la reconstruction (Interpolation). Choisissez ce
réglage tout particulièrement avec des rapports très élevés (pour par exemple
convertir un signal 48 kHz en 22 kHz).

Very High
Ce réglage fait appel à un nouvel algorithme qui utilise une fréquence
d’échantillonnage interne plus élevée. Les fréquences d’échantillonnage d’entrée
et de sortie sont des multiples de cette fréquence d’échantillonnage interne
(exemple: La conversion de 48 à 44,1 kHz est effectuée par une fréquence
d’échantillonnage interne de 7,056 MHz). Ce système permet d’obtenir la
meilleure qualité finale possible. Cette méthode s’applique à la fonction de
prémixage des pistes pour CD si la fréquence d’échantillonnage du projet ne
correspond pas à 44,1 kHz.

Ultra High 1
Identique à Very High, mais avec un filtre interne d’ordre plus élevé. La charge
du processeur s’accroît spectaculairement.

Ultra High 2
Identique à Very High, mais avec un filtre interne de haute qualité d’ordre très
supérieur. La charge du processeur s’accroît encore. Cet algorithme n’est utile
que pour les fichiers 32 bits à virgule flottante parce que les artefacts éventuels
sont relégués en dessous de -96 dB.

Note: Toute conversion vers une fréquence d’échantillonnage inférieure entraîne une
perte dans les aigus des données audio. Passer d’une fréquence de 48 kHz à une
fréquence de 44,1 kHz a peu d’incidence et de toute façon au-delà de la plage audible,
mais ramener un échantillon de 44,1 kHz à 22,05 kHz entraîne une différence audible.
La plus haute fréquence que des données audio puissent produire équivaut à la moitié
de la fréquence d’échantillonnage. Autrement dit, si la fréquence d’échantillonnage
est de 22,05 kHz, la fréquence la plus aiguë qui puisse être reproduite est de 11,025 kHz.

OK
Cliquez sur ce bouton pour convertir la fréquence d’échantillonnage du fichier
audio (selon les réglages faits), et fermer la fenêtre Change Sample Rate.

Cancel
Cliquez sur ce bouton pour fermer la fenêtre Change Sample Rate sans effectuer
de conversion.



413

Menu «Offline Effects»
Remarques sur la conversion de fréquence d’échantillonnage:
Le principe de la conversion de fréquence d’échantillonnage est en général flou
pour les novices en matière d’audionumérique. Ils confondent souvent
fréquences d’échantillonnage et résolution (16/24/32 bits). Voici quelques
principes qui sous-tendent les principaux problèmes:
1. La bande passante est essentiellement liée à la fréquence d’échantillonnage

(selon le théorème de Nyquist), tandis que la dynamique est essentiellement
liée à la résolution. En d’autres termes, la dynamique d’un fichier audio n’a
aucun rapport avec sa fréquence d’échantillonnage.

2. Lors d’une conversion de fréquence d’échantillonnage, les filtres anti-
repliement (anti Aliasing) servent à réduire les distorsions parasites. Le
Dithering, utilisé quant à lui lors d’une réduction de la résolution, vise à
réduire (masquer) les bruits de quantification générés par la troncature
(suppression de certains bits du flux de données, pour par exemple passer de
24 bits à 16 bits).

3. Récapitulatif simple : Fréquence d’échantillonnage > Bande passante > Anti
Repliement. Résolution en bits > Plage dynamique > Quantification >
Dithering.

4. En raison des calculs mathématiques complexes survenant lors des
conversions de fréquence d’échantillonnage, il fallait, il y a encore peu, faire
des compromis sur la qualité finale. L’association d’algorithmes
d’interpolation de faible qualité et de filtres pentus nécessaires à la suppression
de la distorsion parasite entraînait une différence notable entre le fichier
d’origine et le résultat après conversion. Depuis ces dernières années, les
avancées en matière d’algorithme ont permis de réduire fortement ces
phénomènes parasites. Les algorithmes de Samplitude (et tout
particulièrement les réglages Ultra) offrent une conversion de très haut niveau
capable d’impressionner les ingénieurs du son les plus pointilleux!

5. Dans le passé, pour éviter les problèmes occasionnés par les conversions de
fréquence d’échantillonnage, certains ingénieurs du son préféraient une
méthode détournée en réenregistrant le signal audio à la fréquence
d’échantillonnage désirée en passant par l’analogique. Prenons l’exemple d’un
mixage en 48 kHz devant être converti en 44,1 kHz afin d’être masterisé sur
CD. L’ingénieur du son faisait lire le mixage en 48 kHz sur des convertisseurs
analogiques, tout en réenregistrant le signal audio analogique en 44,1 kHz
sur un autre appareil.

Cette méthode permet d’éviter les conversions numériques et donc la distorsion
parasite (même si les filtres des convertisseurs AN/NA engendrent eux aussi de
la distorsion autour de la fréquence de Nyquist).
Ce mode de conversion reste bien entendu toujours valable, surtout si vous êtes
équipé de convertisseurs AN/NA de grande qualité. Cependant, si vous utilisez
cette méthode, nous vous conseillons vivement d’essayer les algorithmes de
conversion de Samplitude dont les performances vous laisseront sûrement sans
voix (et en plus vous gagnez énormément de temps pour vos conversions).
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Sample Manipulation
Sample Manipulation > Sample Data /2
Cette commande de manipulation d’échantillon supprime un échantillon sur
deux de vos données audio, ce qui revient à réduire de moitié la longueur de
l’échantillon. La hauteur est doublée, c’est-à-dire relevée d’une octave. Lorsque
vous divisez par deux la fréquence d’échantillonnage, vous pouvez constater
que vous perdez des harmoniques aiguës. Cette commande est uniquement
disponible en mode d’édition destructive sur les projets HD Wave.
La bande passante se réduit (c’est-à-dire 0-22,05 kHz à une fréquence
d’échantillonnage de 44,1 kHz devient 0-11,025 kHz à une fréquence
d’échantillonnage de 22,05 kHz).

Sample Manipulation > Sample Data *2
Cette commande insère un nouvel échantillon après chacun des échantillons
de vos données audio. Samplitude fait la moyenne des deux échantillons qui
l’entourent pour fixer sa valeur.
Le fichier audio obtenu est deux fois plus long et sa hauteur est diminuée de
moitié. Il faut alors doubler la fréquence de lecture pour retrouver la hauteur
précédente.
Attention : Ce n’est pas parce que vous augmentez la fréquence d’échantillonnage
d’un fichier audio que vous créez des harmoniques aigus – la bande de fréquence des
données audio reste la même.
Cette commande est uniquement disponible en mode d’édition destructive sur
les projets HD Wave.

Sample Manipulation > Reverse
Les données audio se trouvant dans la sélection sont inversées sur l’axe temporel.
Elles sont alors lues de la fin vers le début, l’ancienne position de fin devenant
celle du début et vice-versa. Grâce à cette fonction, vous pouvez créer des effets
hors du commun, sans parler des messages cachés dont la rumeur dit qu’ils
sont intégrés dans de nombreuses chansons...
Cette fonction est réversible. Si vous ne délimitez pas d’autre sélection, il suffit
de relancer la commande pour revenir à l’état précédent.
Cette commande est uniquement disponible en mode d’édition destructive sur
les projets HD Wave.

Build Physical Loop
Cette fonction fait appel à un algorithme complexe qui optimise la réalisation
de boucles dans les projets Wave. Cette fonction très pratique permet de
manipuler des échantillons qui seront ensuite employés comme sons ou comme
table d’ondes pour un synthétiseur. Cette méthode permet de créer en toute
simplicité des boucles intégrant des sons de types cordes, drones, nappes et
effets d’ambiances (en général difficiles à boucler)!
Avant de traiter l’échantillon, il faut délimiter une sélection (Range) qui définisse
les bordures approximatives de la boucle. Pour ce faire, passez en mode d’édition
d’onde afin de travailler directement sur le fichier HD Wave (menu Object >
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Wave Editing si vous travaillez depuis une fenêtre VIP)

N’oubliez pas qu’il est possible de décaler une sélection (Range) et de changer sa
longueur au cours de la lecture afin de trouver le point de bouclage optimal. Pour
davantage de confort et de facilité, vous pouvez activer le mode Split Range (Raccourci:
B). Samplitude vous affiche alors 3 vues de l’échantillon.
Pour obtenir une boucle transparente, sans coupure, nous allons régler chacun
des bords de la sélection sur une amplitude de valeur zéro. Le fait d’appliquer
un fondu sur les données situées à la fin et au début de la boucle crée une
transition douce lors de la lecture en boucle.
Insérez un marqueur (point de repère) avant la sélection délimitée (Range). La
plage séparant ce marqueur du début de la boucle servira à établir le fondu-
enchaîné. C’est une caractéristique que l’on ne rencontre que sur les
échantillonneurs professionnels. Pour créer un petit fondu-enchaîné, placez le
point de repère à proximité du début de la sélection. Pour obtenir un long fondu-
enchaîné, éloignez-le.

Note: Il faut tout de même que la distance entre le marqueur et le début de la boucle
reste inférieure à la longueur de la sélection (et par conséquent de la boucle) pour que
le Crossfade puisse se réaliser.

Direct X / VST Plug-ins
Cette fonction vous offre la possibilité d’utiliser des plug-ins compatibles
Microsoft DirectX et VST 2.2 dans Samplitude afin de pouvoir compléter les
superbes effets internes par un nombre illimité d’effets de tierces parties.
La table de mixage et l’éditeur d’objet de Samplitude sont aussi compatibles
avec les plug-ins (vous pouvez vous servir de ces derniers comme effets en temps
réel). Toutefois, il faut que ces plug-ins puissent traiter les blocs de données
audio de manière immédiate et complète sans modifier leur longueur. C’est le
cas de la plupart des plug-ins. Par contre, certains autres algorithmes ne
fonctionneront pas, comme les plug-ins de time stretch, car ils agissent sur la
longueur des données audio.
Le menu Offline Effects ne pose pas ce genre de limitations. Tous les plug-ins
disponibles devraient fonctionner même s’ils modifient la longueur des données
audio ou surchargent momentanément les blocs de données.

Travail avec les plug-ins
Lorsque vous ouvrez la fenêtre des plug-ins, la liste des plug-ins installés s’affiche.
Double-cliquez sur un plug-in pour le faire passer dans la liste de gauche. Cette
liste de gauche répertorie tous les plug-ins actifs. En même temps que le plug-
in est déplacé dans la liste des plug-ins actifs, sa fenêtre de réglage s’ouvre. Elle
vous permet de faire les réglages de l’effet. Double-cliquez sur tous les plug-ins
désirés de la liste de droite pour les activer (ils passent alors dans la liste de
gauche). Veillez toutefois à ce que les plug-ins activés soient compatibles entre
eux. Les plug-ins mono et stéréo ne peuvent, par exemple, pas être utilisés
conjointement – Samplitude affiche alors un message d’erreur. Dans ce cas,
vous pouvez «forcer le traitement mono ».
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Section Pre/Post (table de mixage seulement)
Dans la table de mixage, la liste des plug-ins actifs est divisée en deux sections,
pre et post. Dans la page FX routing de la piste ou de la section Master, il existe
quatre options correspondantes, DirectX plug-in Pre et Post, et VST Plug-in pre
et post. Vous pouvez donc employer un plug-in (ou plusieurs) à deux endroits
différents dans la chaîne d’effets. Tous les plug-ins chargés sous la ligne pre
dans la liste sont insérés dans la chaîne d’effets en position pre, tous ceux sous
la ligne post en position post.

Note: pour des raisons techniques, il n’est pas possible de placer des Plug-ins DirectX
après des Plug-ins VST, s’ils doivent être employés ensemble en position pre ou post.
Pour obtenir cela, placez le Plug-in VST en position pre et le Plug-in DirectX en
position post.

Eléments de la fenêtre de dialogue
Play/Stop: Ce bouton lance l’écoute test en temps réel du plug-in activé référencé
dans la liste de gauche. Vous pouvez ainsi vérifier ses réglages si votre ordinateur
est suffisamment puissant pour le calcul en temps réel.

Preview (seulement dans le menu Offline Effects): Cette fonction applique
les réglages du plug-in actif sur un petit segment des données audio, puis relit
le segment audio traité. Optez pour cette fonction si votre système n’est pas
suffisamment puissant pour exploiter l’écoute test en temps réel (bouton «Play/
Stop»). La longueur du segment traité se règle avec Options -> System/audio
(Raccourci: y)-> Advanced Buffer Settings ->Test buffer.

Create Copy (seulement dans le menu Offline Effects): Cochez cette case
pour que Samplitude crée une copie des données audio d’origine. Cette copie
vient se placer à la fin du fichier audio d’origine (à la suite des données) et l’effet
traite la copie et non pas l’original. Cette fonction permet ainsi d’utiliser la
commande d’annulation Undo et de revenir en arrière si l’édition ne vous plait
pas. Nous vous recommandons très fortement de toujours cocher cette case!
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Solo: seul le plug-in sera utilisé.

Mute: le plug-in sélectionné sera coupé (fonction bypass). Vous pouvez aussi
court-circuiter un plug-in en décochant la case qui le précède.

Remove: le plug-in sélectionné sera retiré de la chaîne d’effets.

Flèches: déplacent le plugin en amont ou en aval dans la chaîne d’effets.

Latence du plug-in: affiche la latence rapportée d’un plug-in. Avec la case
Force Latency, vous pouvez  changer cette valeur au cas où une latence erronée
serait rapportée par le plug-in.

Setup
Write DirectX log file: pour résoudre les problèmes associés à un plug-in
particulier, vous pouvez ici activer la demande de rapport ou «journal».

Start all Object related Plug-Ins at play start: Cette option de lancement à
la lecture de tous les plug-ins liés aux objets n’est nécessaire que si vous utilisez
des plug-ins avec l’éditeur d’objet. Certains plug-ins provoquent des erreurs de
lecture lorsqu’ils sont lancés indépendamment. Ces erreurs surviennent lors de
la lecture de l’objet auquel est attribué le plug-in. Cochez cette option pour éviter
tout risque de ce type. Par contre, les performances seront significativement
abaissées car Samplitude doit alors calculer tous les plug-ins, que l’objet qui les
utilise soit ou non actuellement lu.

Disable all DirectX effects while Scrubbing/Jogging: Cette option de
désactivation de tous les effets DirectX en mode Scrub est cochée par défaut car
certains plug-ins très courus causent des problèmes en mode scrub.

Presets
Save et Load: Ces deux boutons situés dans la section supérieure droite de la
fenêtre permettent respectivement de sauver et de recharger des configurations
(presets) de plug-ins. Un preset préalablement sauvegardé dans le dossier
standard des presets d’effet sera listé dans la case de sélection. Un preset de
plug-in contient les informations sur les plug-ins utilisés, tous les paramètres et
l’ordre de placement des plug-ins.
Cela vous permet de transférer des réglages personnels entre plusieurs instances
et projets dans Samplitude (table de mixage, éditeur d’objet, édition d’onde (Wave
editing) dans le menu Offline Effects).

Boutons à icône copier/coller: Avec les boutons copier/coller du coin
supérieur droit, vous pouvez transférer encore plus rapidement les réglages de
plug-in entre différentes instances d’une chaîne de plug-ins.
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Conseils d’utilisation des plug-ins depuis le menu Offline Effects
1. Avec les plug-ins nécessitant un signal d’entrée mono (Antares Autotune, par

exemple), si le fichier à traiter est stéréo, il devra être au préalable converti en
mono avant de pouvoir utiliser le plug-in (File > Convert Audio > Save In
Format). Après la conversion en un ou deux fichiers mono (un piano enregistré
en stéréo, par exemple), vous pouvez ouvrir ces fichiers mono, les traiter avec
le plug-in, puis réimporter le résultat obtenu dans le projet (en général par
glisser-déposer du fichier désiré dans une piste).

Note: Le processus est légèrement différent si vous devez utiliser DirectX dans le VIP
(c’est-à-dire en temps réel). Dans ce scénario, la case Force Mono Processing doit
aussi être cochée.

2. Une fois que vous êtes arrivé au réglage de plug-in désiré, il n’est pas nécessaire
de laisser la fenêtre du plug-in ouverte. Exemple : Si vous appliquez plusieurs
plug-ins à un fichier, vous risquez d’encombrer votre écran. Pour éviter ce
problème, refermez simplement la fenêtre de chaque plug-in DirectX une
fois que vous l’avez configuré. Samplitude conserve les réglages de plug-in
en mémoire. Vous pouvez ensuite revenir quand vous le souhaitez sur la
fenêtre d’un plug-in en double cliquant sur son nom dans la colonne de gauche
de la liste des plug-ins de Samplitude. Une fois que tous les réglages ont été
finalisés, cliquez sur le bouton OK.

Process only left/right stereo channel
Quand l’option «Left/Right processing only» est employée, seul le canal gauche
(Left) ou droit (Right) d’un projet Wave stéréo sera affecté par les effets. Cette
option n’est disponible qu’en mode d’édition destructive d’onde.
Les boutons L/R (dans le coin inférieur gauche de la fenêtre de projet Wave) ont
la même action.
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Le menu Range («sélection temporelle») regroupe les fonctions vous permettant
de sélectionner (délimiter) des sections d’un projet selon des modalités diverses.
Ces fonctions sont opérationnelles dans les pistes VIP et lorsque vous travaillez
directement sur des fichiers Wave.
Dans Samplitude, de nombreuses options de traitement nécessitent de délimiter
une sélection avant d’appliquer le traitement en question. Familiarisez-vous
avec les nombreuses méthodes de délimitation des sélections offertes par
Samplitude, vous gagnerez ainsi un temps considérable lors de l’édition de vos
données.

Note: Lorsque vous délimitez une zone de lecture (pour la mise en boucle d’une section
spécifique afin de vous entraîner à une prise, par exemple), il n’est pas nécessaire de
faire glisser la sélection verticalement vers le bas sur toutes les pistes. La sélection d’une
piste suffit à mettre en lecture toutes les pistes.

Range all
Cette commande permet de délimiter rapidement une sélection recouvrant la
totalité du projet (projet Wave ou VIP).

Raccourci: a

Move play cursor > to Beginning
Cette commande ramène la tête de lecture au début du projet (projet Wave ou
VIP).

Raccourci: Home

Move play cursor > to end
Cette commande amène la tête de lecture à la fin du projet (projet Wave ou
VIP).

Raccourci: Fin

Move play cursor > to Range start
Cette commande ramène la tête de lecture au début de la sélection en cours.

Move play cursor > to Range end
Cette commande amène la tête de lecture à la fin de la sélection en cours.

Move play cursor > to Section start
Cette commande amène la tête de lecture au début de la section affichée à l’écran.

Move play cursor > Left/Right Move in Page/Scroll mode
Avec cette commande, vous déplacez la tête de lecture à gauche et à droite. En
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mode Page, la fenêtre du projet défile par pages. Quand la tête de lecture arrive
au bord de la fenêtre de projet, la section est décalée, la tête de lecture parcourt
la nouvelle section en partant du bord opposé. En mode Scroll (défilement), la
tête de lecture ne bouge pas, c’est le projet qui défile sous la tête de lecture.
Lorsqu’une sélection (Range) est délimitée, déplacer la tête de lecture en mode
Page déplace aussi le début de la sélection.

Raccourci: Déplacement gauche en mode page Flèche gauche
Déplacement gauche en mode défilement Alt + Flèche gauche
Déplacement droit en mode page Flèche droite
Déplacement droit en mode défilement Alt + Flèche droite

Note: Les fonctions ci-dessus fonctionnent mieux à partir des raccourcis-clavier.

Move play cursor > Object border left/right
Cette commande déplace la tête de lecture sur le bord gauche (left)/droite (right)
de l’objet sélectionné.

Raccourci: Bord gauche de l’objet Ctrl + q
Bord droit de l’objet Ctrl + w

Move play cursor > Marker left
Cette commande déplace la tête de lecture à gauche sur le marqueur le plus
proche (marqueur précédent).

Raccourci: F2, Alt + q

Move play cursor > Marker right
Cette commande déplace la tête de lecture à droite sur le marqueur le plus proche
(marqueur suivant).

Raccourci: F3, Alt + w

Edit Range > Move Range start left
Cette commande étend la sélection en cours en déplaçant son début d’un pixel
vers la gauche dans la fenêtre VIP. La distance est donc déterminée par le facteur
de zoom. Plus grand est le facteur de zoom, plus courte est la distance.

Si la lecture n’est pas lancée, cette commande est la même que Move play cursor Left/
Right. Utilisez-la quand la lecture est lancée pour déplacer le début de la sélection
(Range) sans affecter la position actuelle de la tête de lecture!

Raccourci: Alt + «/» (pavé numérique)

Edit Range > Move Range start right
Cette commande réduit la sélection en cours en déplaçant son début d’un pixel
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vers la droite dans la fenêtre VIP. La distance est donc déterminée par le facteur
de zoom. Plus grand est le facteur de zoom, plus courte est la distance.

Si la lecture n’est pas lancée, cette commande est la même que Move play cursor Left/
Right. Utilisez-la quand la lecture est lancée pour déplacer le début de la sélection
(Range) sans affecter la position actuelle de la tête de lecture!

Raccourci: Alt + «*» (pavé numérique)

Edit Range > Move Range end left
Cette commande réduit la sélection en cours en déplaçant sa fin d’un pixel vers
la gauche dans la fenêtre VIP. La distance est donc déterminée par le facteur de
zoom. Plus grand est le facteur de zoom, plus courte est la distance.

Raccourci: Alt + «-» (pavé numérique); Shift + <- (flèche gauche)

Edit Range > Move Range end right
Cette commande étend la sélection en cours en déplaçant sa fin d’un pixel vers
la droite dans la fenêtre VIP. La distance est donc déterminée par le facteur de
zoom. Plus grand est le facteur de zoom, plus courte est la distance.

Raccourci: Alt + «+» (pavé numérique); Shift + -> (flèche droite)

Edit Range > Range to beginning
Cette commande étend rapidement le début de la sélection en cours jusqu’au
début du projet (projet Wave ou VIP).

Edit Range > Range to end
Cette commande étend rapidement la fin de la sélection en cours jusqu’à la fin
du projet (projet Wave ou VIP).

Edit Range > Flip Range Left
La sélection en cours pivote vers la gauche. Sa fin correspond à présent à son
ancien point de départ.

Raccourci: Ctrl + Shift + flèche gauche

Edit Range > Flip Range Right
La sélection en cours pivote vers la droite. Son début correspond à présent à son
ancienne fin.

Raccourci: Ctrl + Shift + flèche droite

Edit Range > Beginning of Range > 0
Cette commande déplace sur sa droite le début de la sélection en cours jusqu’à
la position d’amplitude zéro suivante la plus proche.
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Conseil : Choisissez des positions d’amplitude zéro pour vos coupures afin d’éviter la
production de clics. Sachez cependant que la fonction de fondu-enchaîné automatique
de Samplitude empêche généralement ce genre de problème de survenir lors de l’édition
des données dans Samplitude. Si vous coupez des données audio destinées à être
utilisées dans un autre logiciel, veuillez par contre à placer vos coupures sur des positions
d’amplitude zéro.

Raccourci: Ctrl+Page Préc.

Edit Range > End of Range > 0
Cette commande déplace sur sa droite la fin de la sélection en cours jusqu’à la
position d’amplitude zéro suivante la plus proche.
Cette position «zéro» est la prochaine valeur d’échantillon nulle ou encadrée
par une valeur d’échantillon négative et une positive (ou vice versa).
Cela fonctionne aussi dans les VIP, mais les objets doivent être présents quelque
part dans la sélection (Range) du VIP.

Conseil : Choisissez des positions d’amplitude zéro pour vos coupures afin d’éviter la
production de clics. Sachez cependant que la fonction de fondu-enchaîné automatique
de Samplitude empêche généralement ce genre de problème de survenir lors de l’édition
des données dans Samplitude. Si vous coupez des données audio destinées à être
utilisées dans un autre logiciel, veuillez par contre à placer vos coupures sur des positions
d’amplitude zéro.

Raccourci: Ctrl+Page Suiv.

Edit Range > Beginning of Range < 0
Cette commande déplace sur sa gauche le début de la sélection en cours jusqu’à
la position d’amplitude zéro précédente la plus proche.
Cette position «zéro» est la précédente valeur d’échantillon nulle ou encadrée
par une valeur d’échantillon négative et une positive (ou vice versa).
Cela fonctionne aussi dans les VIP, mais les objets doivent être présents quelque
part dans la sélection (Range) du VIP.

Conseil : Choisissez des positions d’amplitude zéro pour vos coupures afin d’éviter la
production de clics. Sachez cependant que la fonction de fondu-enchaîné automatique
de Samplitude empêche généralement ce genre de problème de survenir lors de l’édition
des données dans Samplitude. Si vous coupez des données audio destinées à être
utilisées dans un autre logiciel, veuillez par contre à placer vos coupures sur des positions
d’amplitude zéro.

Raccourci: Shift + Page Préc.

Edit Range > End of Range < 0
Cette commande déplace sur sa gauche la fin de la sélection en cours jusqu’à la
position d’amplitude zéro précédente la plus proche.
Cette position «zéro» est la précédente valeur d’échantillon nulle ou encadrée
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par une valeur d’échantillon négative et une positive (ou vice versa).
Cela fonctionne aussi dans les VIP, mais les objets doivent être présents quelque
part dans la sélection (Range) du VIP.

Conseil : Choisissez des positions d’amplitude zéro pour vos coupures afin d’éviter la
production de clics. Sachez cependant que la fonction de fondu-enchaîné automatique
de Samplitude empêche généralement ce genre de problème de survenir lors de l’édition
des données dans Samplitude. Si vous coupez des données audio destinées à être
utilisées dans un autre logiciel, veuillez par contre à placer vos coupures sur des positions
d’amplitude zéro.

Raccourci: Shift + Page Suiv.

Edit Range > 0 > Range < 0
Cette commande déplace sur sa droite le début de la sélection en cours jusqu’à
la position d’amplitude zéro suivante la plus proche et déplace sur sa gauche la
fin de la sélection en cours jusqu’à la position d’amplitude zéro précédente la
plus proche.

Raccourci: Suppr

Note: Si votre clavier ne dispose pas de touche Suppr, vous pouvez aisément affecter
votre propre raccourci clavier à cette commande. Suggestion : Ctrl+Shift+flèche haut,
par défaut non utilisé. Pour modifier le raccourci clavier, sélectionnez Options >
System/Audio > onglet Program > bouton Keyboard Shortcuts and Menu.

Edit Range > Range start to left marker
Cette commande étend la sélection en cours en déplaçant son début sur la gauche
jusqu’au marqueur précédent le plus proche.

Raccourci: Shift + F2

Edit Range > Range start to left Object border
Cette commande étend la sélection en cours en déplaçant son début sur la gauche
jusqu’au bord gauche de l’objet.

Edit Range > Range end to right marker
Cette commande étend la sélection en cours en déplaçant sa fin sur la droite
jusqu’au marqueur suivant le plus proche.

Raccourci: Shift + F3

Edit Range > Range end to right Object border
Cette commande étend la sélection en cours en déplaçant sa fin sur la droite
jusqu’au bord droit de l’objet.
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Edit Range > Range over all selected Objects
Cette commande étend la sélection à tous les objets sélectionnés.

Range length to
Les options suivantes vous permettent de régler la sélection en cours sur un
nombre de temps précis.

Note: Pour définir la longueur d’une mesure (Bar); sélectionnez View > Snap and
Grid setup.... Vous pouvez alors saisir le format de mesure, le tempo (en battements
par minute ou BPM), et la résolution par noire (PPQ).

1- 16 Beat(s): Sélectionnez cette option pour régler la sélection en cours sur
une durée de 1, 2, 4, 8 ou 16 temps.

Conseil : La commande Grid (dans le menu View) permet d’afficher les mesures et les
temps, et la fonction de magnétisme (Snap) peut être réglée sur «snap to bars»
(magnétisme sur les mesures).

Split Range
Cette commande affiche à l’écran trois vues différentes du projet en cours (projet
Wave ou VIP). La vue supérieure affiche le projet (projet Wave ou VIP) dans sa
totalité, la vue inférieure gauche affiche les données audio situées à côté du
début de la sélection, et la vue inférieure droite affiche les données audio situées
à côté de la fin de la sélection. Chaque vue dispose de ses propres réglages de
zoom et peut servir à manipuler la sélection en cours.

Note: Pour revenir en affichage normal, appuyez sur Shift + B.
Conseil : Cette commande simplifie la création de boucles ! Les vues inférieures
permettent de visualiser précisément l’endroit où commence et où se termine la sélection
en cours. Vous pouvez ainsi visualiser très précisément les bords de la sélection sans
avoir à effectuer constamment des zooms avant et arrière.

Raccourci: B

Split Range for Video
Cette commande est quasiment identique à la commande Split Range ci-dessus,
mais elle est destinée au travail sur les fichiers AVI (vidéo).

Note: Pour revenir en affichage normal, appuyez sur Shift + B.

Store Range
Dans Samplitude, vous pouvez définir et mémoriser différentes sélections
(Ranges) pour un rappel ultérieur. Un nombre illimité de sélections peuvent
être définies. Vous pouvez par exemple spécifier différentes boucles et les
comparer en rappelant leurs sélections.
Toutes les sélections d’un projet peuvent être affichées par le gestionnaire de
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sélections (menu Tools-> Manager->Range Manager). Là, toutes les sélections
peuvent être renommées ou reproduites.
Quand vous sélectionnez cette option de menu, la sélection (Range) doit être
mémorisée par saisie d’une valeur numérique qui lui est associée.

Raccourcis clavier: Alt + F2 ... F10

Other....
Vous pouvez définir d’autres sélections (Ranges) en utilisant le sous-menu
«Other». Vous devrez spécifier un nom pour la sélection définie.

Raccourci: Alt + F11

Note: Les sélections sauvegardées sous un nom spécifique ne peuvent être rappelées
que par le gestionnaire de sélection (Range Manager, menu Tools).

Get Range
En sélectionnant cette option, vous pouvez choisir comme sélection actuelle
une des sélections sauvegardées.
Samplitude vous permet même de définir une sélection (Range) durant la lecture.
Celle-ci entre en vigueur et est audible. Avec cette méthode, vous pouvez alterner
entre deux sélections pour les comparer.
Les sélections peuvent aussi être nommées et rappelées avec le gestionnaire de
sélections (menu Tools-> Manager->Range Manager).

Raccourcis: Ctrl+F2 ... F10

Get Range length
Les commandes suivantes sont similaires aux commandes Get Range, mais
seule la durée de la sélection sauvegardée est réutilisée (et non la sélection elle-
même). Une nouvelle sélection reprenant la durée de la sélection sauvegardée
est délimitée à partir de la position en cours de la tête de lecture.

Raccourcis: Ctrl + Shift + F2....F10

Store marker
Les commandes suivantes permettent de placer des marqueurs et de sauvegarder
leur position afin d’y rappeler ultérieurement la tête de lecture.

Marker with Name....
Cette commande insère un marqueur (et sauvegarde sa position) sous un nom
spécifique.

Note: Les marqueurs sauvegardés sous un nom spécifique ne peuvent être rappelés que
par le gestionnaire de marqueurs (Marker Manager, menu Tools).
Raccourci: Touche «?»
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Auto Number
Cette commande place un marqueur auquel est automatiquement attribué un
numéro (et dont la position est sauvegardée).

Raccourci Touche «‘»

Marker on Record Position
Avec cette option, activée par défaut, vous pouvez placer des marqueurs sur la
position d’enregistrement actuelle durant l’enregistrement. Vous pouvez
désactiver ici ce comportement, auquel cas même en enregistrement les
marqueurs seront placés sur la position actuelle de la tête de lecture. Gardez à
l’esprit que la lecture et l’enregistrement sont des fonctions indépendantes, ce
qui signifie que vous pouvez lire le début d’un objet qui vient juste d’être
enregistré tout en continuant à l’enregistrer!

1 – 10
Choisissez cette option pour placer un marqueur (et mémoriser sa position pour
un rappel ultérieur) sur une touche 1....0.

Raccourcis: Shift + 1....0

Note: tous les marqueurs peuvent être placés en temps réel durant la lecture!

Les marqueurs définis peuvent être vus au dessus de la section des données
d’échantillons dans la fenêtre de projet au sein de la barre des marqueurs et
peuvent être déplacés à la souris. Faites un clic droit sur un marqueur pour
ouvrir un menu contextuel avec les options les plus importantes concernant les
marqueurs. Double cliquez sur la barre des marqueurs entre deux marqueurs
pour définir une sélection (Range) entre ces deux marqueurs.

Get marker
Les options suivantes permettent de rappeler en temps réel des marqueurs.
Vous pouvez aussi rappeler des positions de marqueur à l’aide du gestionnaire
de marqueurs/plages de CD ou du gestionnaire de marqueurs audio (Marker
Manager: menu Tools).

1 – 10
Choisissez cette option pour rappeler les positions de marqueurs mémorisées
sur les touches numériques 1…0. Le curseur se placera sur cette position.

Raccourcis: 1....0

Marker on Range Borders
Cette commande insère un marqueur au début (S) et un à la fin (E) de la sélection
en cours.
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Set markers on silence....
Cette commande ouvre la fenêtre Set Markers on Silence... qui permet de faire
détecter automatiquement les silences par Samplitude et de créer/placer un
marqueur à chaque fois que du silence est rencontré. Le seuil de silence
(«Threshold») peut être défini. Lorsque vous travaillez dans un VIP, vous pouvez
configurer Samplitude de façon à fractionner les objets sur les silences détectés.

Conseil important : Samplitude recherche les silences uniquement dans les données
audio situées à droite de la tête de lecture ou à l’intérieur d’une sélection ! Pour étendre
la recherche à la totalité du fichier audio, appuyez sur la touche Orig («Home») afin
de ramener la tête de lecture au début du fichier.

Min. Time (ms): Ce paramètre détermine la durée minimale des parties
silencieuses pour qu’elles soient considérées comme des «silences» et qu’un
marqueur soir créé/placé.

Threshold (dB): Ce paramètre détermine le niveau seuil à partir duquel l’audio
est considéré comme du silence.

Conseil : Pour visualiser rapidement toutes les positions en dessous d’un certain niveau
de seuil, utilisez ce paramètre en association avec le bouton Test (voir ci-après).

Start Number: Ce paramètre définit le numéro de départ utilisé lors de
l’insertion des marqueurs. Exemple : si vous réglez ce paramètre sur la valeur 5,
le premier marqueur qui sera inséré portera le numéro 5, le second le numéro 6,
etc.

Prefix: Ce paramètre vous permet de saisir un préfixe qui sera placé avant
chaque numéro de marqueur. Exemple : si vous saisissez le préfixe «ref» pour
ce paramètre (et 5 pour le paramètre Start Number), le premier marqueur inséré
portera le nom ref5, le second portera le nom ref6, etc.

Add Time: Après détection du silence, le marqueur est déplacé avant ou après
le point de détection, d’un intervalle de temps positif ou négatif exprimé en ms
et déterminé par ce paramètre.
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Delete Matching markers: Cliquez sur ce bouton afin de supprimer tous les
marqueurs correspondant à la valeur des paramètres Min. Time et Threshold.
Supposons que des marqueurs ont été insérés lors d’une précédente recherche.
Si vous saisissez les mêmes critères de recherche (déterminés par les paramètres
Min. Time et Threshold) et cliquez sur ce bouton, ces marqueurs sont alors
supprimés.

Delete all markers: Cliquez sur ce bouton afin de supprimer tous les marqueurs
de la fenêtre ou de la sélection.

OK: Cliquez sur ce bouton afin de lancer la recherche, insérer les marqueurs,
puis refermer la fenêtre.

Cancel: Cliquez sur ce bouton afin de refermer la fenêtre sans lancer de
recherche ni insérer de marqueurs.

Split VIP Objects: Lorsque vous travaillez dans un projet VIP, sélectionnez
cette option afin que Samplitude fractionne les objets sélectionnés sur les
marqueurs de silence insérés.

Test: Cliquez sur ce bouton afin de pré-écouter les résultats de la fonction avant
exécution de la commande. Vous pouvez ainsi vérifier si les réglages de niveau
de seuil conviennent. Lorsque vous êtes satisfait des réglages de seuil, cliquez
sur le bouton OK afin d’effectuer les modifications.

Note: Les objets segmentés ne sont pas affichés tant que les modifications ne sont pas
effectuées.

Conseil à propos des marqueurs : Vous pouvez déplacer les marqueurs par glisser/
déposer. Vous pouvez également les régler et les configurer par le biais du bouton
Marker en haut du panneau des propriétés des pistes  ou en appliquant un clic droit
sur les marques.

Comparisonics Audio Search
Cette fonction repose sur l’algorithme breveté Comparisonics. Elle vous permet
de localiser très rapidement des régions identiques ou similaires d’un fichier
audio – une véritable révolution!
Cette fonction permet notamment de:
– localiser rapidement certains sons répétés dans un enregistrement.
– réaliser des recherches audio dans le domaine légal.
– localiser des bruits d’animaux (ou autres) récurrents sur des enregistrements

très longs sur le terrain.
– localiser les occurrences d’un instrument spécifique dans un enregistrement

classique (une cymbale, par exemple)
– localiser des exemples d’effets sonores répétés ou autres sons distinctifs lors

de l’édition de données audio prémixées pour le cinéma ou la vidéo.
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L’utilisation de cette fonction suppose qu’un projet HD Wave est déjà ouvert.
Sinon, depuis la fenêtre VIP, sélectionnez un objet que vous souhaitez inspecter
dans la piste, puis sélectionnez Wave Editing dans le menu Object.
Avant de sélectionner la commande par le menu, vous devez délimiter une
sélection (Range) sur laquelle vous souhaitez rechercher des régions similaires,
puis copier la sélection dans le presse-papiers (touche «C»). Vous pouvez
délimiter une sélection de n’importe quelle durée, mais vous obtiendrez de
meilleurs résultats en choisissant une durée comprise entre 5 ms et 5 s, en
fonction de la fréquence dominante des données audio que vous recherchez.

Note: Il n’est pas nécessaire de régler les formes d’ondes sur les couleurs Comparisonics
(View > VIP Display mode > Definitions > Comparisonics Colors) pour utiliser cette
fonction. En fait, si vous affichez les couleurs Comparisonics, vous ne serez amené
que très rarement à utiliser cette fonction puisque les régions similaires sont dans ce
cas identifiées par les couleurs!

Une fois la sélection délimitée et copiée dans le presse-papiers, ouvrez la boîte
de dialogue par le menu Range > Comparisonics Audio Search.
La fenêtre de dialogue vous permet de modifier la sensibilité de l’algorithme.
Pendant le réglage du niveau de sensibilité, Samplitude insère des marqueurs
de similitude sur les positions identifiées par l’algorithme comme similaires
aux données copiées dans le presse-papiers.
Dans l’exemple ci-dessus, l’algorithme a trouvé 4 emplacements contenant des
données audio similaires à celles du presse-papiers (qui contenaient dans ce cas
un spectre de fréquences très large avec guitare basse, grosse caisse et cymbale
Crash). Notez que la sélection d’origine a été correctement identifiée par
l’algorithme.
Le fader Sensitivity permet de régler le niveau de seuil appliqué par l’algorithme
dans la recherche d’une similitude relative par rapport aux données audio du
presse-papiers. Il vous faudra vraisemblablement tester différents niveaux de
sensibilité afin de déterminer le réglage approprié.
Dans l’exemple ci-dessus, l’algorithme a correctement identifié le spectre de
fréquences complexe des données audio du presse-papiers et a correctement
identifié les quatre occurrences de la section audio spécifiée dans le fichier (un
échantillon de quatre mesures d’une section rythmique). D’autres sections du
fichier présentaient des différences insignifiantes (le fichier est constitué de
quatre mesures de guitare basse et de batterie), mais l’algorithme a réussi à
sélectionner les sections correctes.

Note: Les données audio copiées sur le presse-papiers peuvent également servir de
modèle pour la recherche de sections audio similaires dans d’autres projets Wave. Il
suffit d’ouvrir l’autre ou les autres fichiers à analyser et d’exécuter la fonction.

Copying Wave project Marker to VIP
Cette commande crée dans le VIP des copies de tous les marqueurs audio de
l’objet sélectionné. Les marqueurs audio du projet Wave correspondant ne sont
repris que dans les limites de l’objet.
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Copying VIP marker to Wave project
Cette commande copie dans le projet Wave les marqueurs du VIP sur les
positions correspondantes de l’objet. Les marqueurs du VIP ne sont repris que
dans les limites de l’objet.

Delete Marker
Cette fonction supprime le marqueur sélectionné. Pour sélectionner un
marqueur, utilisez l’une des commandes «Get marker» ou placez le curseur de
la souris sur le marqueur jusqu’à ce que le curseur prenne la forme d’une flèche
bidirectionnelle, puis cliquez sur le marqueur.

Note: La méthode la plus rapide pour supprimer un marqueur sélectionné à l’aide de
la souris consiste à appuyer sur la touche Suppr du clavier. Vous pouvez également
appliquer un clic droit sur le marqueur sélectionné et utiliser la commande Delete
Marker.

Delete all Markers
Cette fonction supprime tous les marqueurs du projet actif, mais elle n’agit pas
simultanément sur le VIP et sur tous les projets qui sont rattachés aux objets du
VIP – vous devez appliquer la fonction séparément à chaque projet Wave.
Autrement dit, le fait de supprimer les marqueurs d’un projet VIP ne supprime
pas aussi les marqueurs des projets Wave.

Recall last Range
Cette commande restaure la dernière sélection (Range) délimitée dans un projet
Wave ou une fenêtre de VIP. Par exemple, si vous avez supprimé par erreur une
sélection, vous pouvez la restaurer en sélectionnant cette commande.

Raccourcis: Shift + Ret. Arr.

Range Editor

Cette commande ouvre la fenêtre de l’éditeur de sélection (Range Editor) à partir
de laquelle vous pouvez spécifier le début, la fin et la durée (en échantillons, en
millisecondes, au format SMPTE ou en mesures) de la sélection en cours.
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Si vous modifiez l’une des valeurs dans les sections «Range Start» (début de la
sélection), «Range Length» (durée de la sélection) ou «Range End» (fin de la
sélection), toutes les autres valeurs se mettent automatiquement à jour aux
exceptions suivantes près:
Modification de valeur dans la section Range Start – la fin est conservée.
Modification de valeur dans la section Range End – le début est conservé.
Modification de valeur dans la section Range Length – le début est conservé.
Veuillez noter le format du champ «Bar» (mesure). Le format est affiché sous
forme d’une mesure en 4/4 avec 96 clics à la noire. Sont indiqués la mesure, le
temps et le nombre de clics.
Le nombre de battements par minute (BPM) peut être défini dans le champ
BPM accessible par menu View > Snap and Grid Setup.

Range Manager
Veuillez vous reporter au chapitre «Les gestionnaires (Managers)»

Object Lasso
La façon normale de sélectionner plusieurs objets d’un coup consiste à cliquer
sur l’espace libre à droite d’un objet en partie basse de la piste et de dessiner un
cadre englobant les objets à sélectionner.
Quelquefois cependant, il n’y a pas assez d’espace entre les objets. Cette
commande résout le problème.
Une fois activée, elle vous permet de cliquer sur un objet et de dessiner un cadre
de sélection sans déplacer l’objet sur lequel vous avez cliqué (ce qui serait le cas
en mode standard). Une fois le bouton gauche de la souris relâché, la souris
retourne au mode de souris précédemment sélectionné.

Edit Time Display
Affiche ou masque une fenêtre de compteur temporel.
Cette fenêtre affiche la position temporelle actuelle au format actuel. Vous pouvez
changer ce format avec l’option «Units of Measurement» du menu contextuel
des compteurs. Nous vous recommandons le format SMPTE:
heures:minutes:secondes:frames (images). Les couleurs et la police de caractères
utilisées pour l’affichage peuvent être changées dans Options->Program
Preferences.
Cliquez avec le bouton droit de la souris sur un compteur temporel pour ouvrir
un menu contextuel vous permettant de choisir les préférences pour le compteur
temporel.
Ce menu contient plusieurs raccourcis pour des options du programme
permettant entre autres de sélectionner l’unité de temps («Units of
Measurement») qui est la même que celle définie dans le menu View.
Vous pouvez configurer de un à cinq compteurs avec «Number of Fields».
Chaque compteur peut afficher une des valeurs suivantes, que vous pouvez
sélectionner dans le menu contextuel.
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Pos - Position/Range start
Ce compteur affiche le début de la sélection (Range) actuelle ou la position du
curseur en temps réel.

Len - Range Length
Si une sélection (Range) est définie, ce compteur affiche sa longueur.

End - Range End
Si une sélection (Range) est définie, ce compteur affiche sa position de fin.

CD Positions
Affiche plusieurs positions temporelles relatives au CD dont Position from CD
start (CD Pos: premier marqueur de plage), Position to CD end (CD End: distance
du marqueur de fin de CD), Position from current CD track (CD Trk: position à
l’intérieur de la plage actuelle) et Position to CD track end (TrkEnd: position de
la fin de la plage actuelle).

Mouse - Mouse Position (not editable)
Ce compteur affiche la position actuelle de la souris (non éditable).

Mixer –Mixer Value (not editable)
Ce compteur affiche la valeur de la dernière commande sélectionnée en table de
mixage (non éditable).

RecPo- Record position (not editable)
Ce compteur affiche la position d’enregistrement actuelle (non éditable).

RecSp- Remaining Record Time (free disc space)
Ce compteur affiche l’espace restant pour l’enregistrement (non éditable).

Il est aussi possible d’éditer les valeurs manuellement en double cliquant dans
le champ correspondant. Vous pouvez y employer des valeurs relatives, ainsi en
saisissant par ex. «+2:00» dans un compteur temporel, vous augmentez la valeur
du champ de 2 unités (secondes, temps...selon l’unité de mesure employée).
Vous pouvez aussi accéder à cette fonction par le raccourci clavier alt+ touche
numérique 1..5 ou avec les éléments de menu correspondants «menu
Range�Edit Time Display� Field 1..5».
En résumé, vous pouvez accéder aux compteurs:
1. En double-cliquant dans la case correspondante.
2. En sélectionnant la case par menu  Range > Edit Time Display.
3. En utilisant les raccourci-clavier (Alt+touches numériques 1-5).
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Comme vous pouvez le supposer, les commandes de ce menu sont destinées à
la préparation et à la gravure de CD/DVD.
Si votre ordinateur est suffisamment puissant et correctement configuré, vous
pourrez aisément graver des CD à la norme Red Book en temps réel lors du
mixage d’un morceau ou du Mastering d’une piste déjà mixée.

Note: Dans la mesure où de nouveaux graveurs de CD /DVD arrivent en permanence
sur le marché, MAGIX ne peut pas garantir que votre graveur soit reconnu par les
fichiers *.dll existants de la fonction de gravure de CD/DVD de Samplitude. Qui plus
est, certains graveurs de CD/DVD souffrent de diverses limitations matérielles ou de
leur logiciel interne (firmware). C’est pourquoi, avant d’acheter un graveur de CD /
DVD destiné à être utilisé avec Samplitude, veuillez télécharger le tout dernier correctif
CD Burner DLL depuis la zone d’assistance de Samplitude (www.samplitude.com,
naviguez jusqu’à «Support»). Après l’avoir installé, vous trouverez un document
CDR_Readme.txt dans le dossier de l’installeur, qui décrit tous les graveurs dont la
compatibilité a été testée.

Si vous détenez déjà un graveur de CD /DVD, veuillez suivre la procédure ci-
dessous avant de l’utiliser avec Samplitude:
1. Assurez-vous d’avoir installé la dernière version du logiciel interne (firmware)

offerte par le fabricant du graveur.
2. Téléchargez et installer les derniers fichiers *.dll pour graveurs sur

www.magix.com

Samplitude vous permet de graver des CD audio directement depuis des projets
virtuels et tout projet Wave stéréo, quel que soit leur nombre de pistes dans le
VIP.
Les objets au format 32 bits à virgule flottante/24 bits sont convertis en 16 bits
au cours de la gravure du CD ou au cours du prémixage de pistes (report de
pistes ou «track bouncing»). Le seul impératif est que le projet ait une fréquence
d’échantillonnage de 44,1kHz.
Lorsque vous sélectionnez le mode spécial «CD Arrange mode», quelle que soit
la sélection délimitée, les projets Wave sont chargés automatiquement avec un
espace prédéterminé entre les morceaux ou les objets. Fixez la durée de cet
espace avec menu CD > Set Pause Time.
Si la totalité de votre projet VIP multipiste ne doit représenter qu’une seule
plage du CD, servez-vous de la fonction Track Bouncing pour réduire la totalité
du projet en un seul projet Wave.

Load Audio CD Track(s)
Cette commande permet d’importer des CD audio ou de simples plages de CD
dans un projet. Toutefois, contrairement aux données normales, les CD audio
doivent d’abord être lus (ses données audio doivent être extraites). L’importation
se fait en numérique, donc sans perte de qualité sonore.



434

Menu «CD/DVD»
Si vous voulez importer des plages de CD audio, suivez juste ces étapes:
1. Insérez un CD audio dans votre lecteur de CD-ROM et sélectionnez «Load

CD audio track» dans le menu CD/DVD. Une fenêtre de dialogue avec une
liste de plages de CD apparaîtra. Si vous avez plusieurs lecteurs de CD (ou
par exemple un graveur de CD supplémentaire), vous devez d’abord choisir
celui duquel sera chargé le CD. Vous pouvez faire cela avec le bouton CD
Drive Options.

2. Sélectionnez les titres voulus (en pressant Shift + le bouton de la souris ou
Alt + touches flèches).

3. Cliquez sur «Copy selected Tracks...»
4. La fenêtre «Import Audio» apparaîtra. Vous pouvez y choisir un nom et un

dossier pour le fichier.
5. Le matériel audio sera ensuite copié du CD sur le disque dur. Une fenêtre de

progression vous tient informé de l’avancée du transfert.
6. Une fois les données audio transférées, toutes les fenêtres de dialogue se

fermeront et les plages seront ajoutées à votre piste comme des objets simples.

La fenêtre CD Track List

Toutes les plages du CD s’affichent avec leur position de départ (Start Time) et
leur longueur (Length). Dans la colonne Name, le nom de la plage s’affiche, tiré
des informations de type CD Text si le CD en contient et si le lecteur de CD peut
les lire. Sélectionnez une plage en cliquant dessus avec le bouton gauche de la
souris, sélectionnez une suite de plages avec SHIFT + clic de souris, sélectionnez
plusieurs pistes non adjacentes avec CTRL + clic de souris.

Copy selected Tracks: Ce bouton lance le processus de copie audio. Pour chaque
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plage, un nouvel objet et le marqueur de plage correspondant sont créés dans
l’arrangement.

Commandes de transport: S’emploient comme les boutons de transport d’un
vrai lecteur de CD pour lire, mettre en pause et arrêter la lecture ou sauter d’une
plage à l’autre.
En dessous sont affichées des informations sur le nombre, la longueur totale et
les besoins en mémoire des plages sélectionnées.

Select all Tracks: Toutes les plages audio sont sélectionnées (par exemple, si
vous voulez copier toutes les plages d’un CD). Presser Ctrl et cliquer avec la
souris vous permet de sélectionner plusieurs plages.

Read ISRC: Lit le code ISRC des plages (s’il est fourni).

Options du lecteur de CD: Dans la case de sélection de droite, vous pouvez
choisir la vitesse de lecture, dans celle de gauche le mode de sélection (voir la
fenêtre de configuration du lecteur de CD)
CD Drive Options: Ici, vous pouvez faire certains réglages pour le lecteur de
CD que vous utilisez et choisir le lecteur pour «extraire» les données audio d’un
CD si vous avez plusieurs lecteurs de CD installés dans votre système (voir la
fenêtre de configuration du lecteur de CD)
Text file: Crée un fichier texte avec les informations récupérées du CD telles
qu’affichées dans la liste des plages du CD.

La fenêtre de dialogue «Import Audio»
La fenêtre de dialogue «Import Audio» apparaît après sélection de l’option «Copy
selected tracks». Saisissez dedans un nom et un dossier de destination pour les
nouveaux fichiers audio. Les fichiers audio recevront un numéro en plus du
nom choisi («nom» -> nom_1.wav, nom_2.wav...).
Le format préréglé pour les plages audio (fichiers CDA) est le format WAV.
Vous êtes toutefois libre de faire la conversion en un format compressé, comme
le MP3, durant l’extraction des données. Choisissez simplement votre format
audio dans la fenêtre «Import Audio» en cliquant sur le bouton «Format settings»
pour accéder à la fenêtre permettant de faire vos changements (pour plus
d’informations concernant les formats audio, voir Import Audio)

La fenêtre de configuration du lecteur de CD (CD Drive Options)
Pour choisir et configurer votre lecteur de CD. Le gestionnaire de CD permet
l’import de données audio à l’aide de la plupart des lecteurs de CD-ROM et
graveurs de CD/DVD SCSI et ATAPI. En cas de doute, demandez à notre
assistance technique quels lecteurs sont compatibles. Si vous rencontrez des
problèmes lors de la lecture de plages audio, vous pouvez changer de processus
de lecture dans la fenêtre qui s’ouvre en cliquant sur le bouton Configuration,
chaque processus différant par la façon dont les données sont lues ou «extraites».
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Configuration: Ce bouton ouvre la fenêtre de configuration où choisir
différentes fonctions spéciales, les identifiants SCSI etc.

Reset: Rétablit la configuration de lecteur initiale.

Add drive: Ajoute un nouveau lecteur à la liste. Toutefois, vous devrez faire des
réglages spécifiques.

Delete: Supprime de la liste le lecteur sélectionné.

Save setup: Sauvegarde la liste actuelle de lecteurs avec toutes les données de
configuration dans un fichier *.cfg.

Load setup: Recharge la liste de lecteurs avec toutes les données de configuration
depuis un fichier *.cfg.

Configuration du lecteur de CD
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Drive Name: Vous pouvez y modifier le nom du lecteur sélectionné dans la
liste, ce qui s’avère pratique pour créer plusieurs entrées donnant accès au même
lecteur physique.

Host Adapter Number: Permet de spécifier le numéro de votre adaptateur
SCSI (en temps normal 0).

SCSI-ID: Permet de spécifier le numéro d’identifiant du lecteur de CD ROM.
Veillez à indiquer le bon numéro car il n’y a pas de contrôle d’erreur!

SCSI-LUN: Permet de sélectionner le paramètre SCSI LUN, en temps normal
0.

Alias: Permet de sélectionner le type de fabricant du lecteur de CD ROM.

Copy mode Normal: Copie les données audio sans aucune correction logicielle.

Copy mode Sector Synchronization: Copie les données audio à l’aide d’un
algorithme de correction logicielle. Ce mode est pratique car certains lecteurs
de CD ROM n’arrivent pas à rechercher précisément la même position entre
deux accès en lecture. Samplitude sait corriger ces différences grâce à cet
algorithme.

Copy mode Burst Copy: Optimise la vitesse de copie, aucune correction logicielle
n’est appliquée.

Sectors per Read: Définit le nombre de secteurs audio par cycle de lecture.
Plus ce nombre est élevé, plus la copie est rapide. Les adaptateurs SCSI ne
peuvent pas tous fonctionner à plus de 27 secteurs!

Sync Sectors: Définit le nombre de secteurs audio utilisés pour la
synchronisation sectorielle. Plus ce nombre est élevé, plus la synchronisation
est fiable, mais plus la copie est lente.

Set Track (Set CD Track Index )
Cette commande insère un marqueur de plage sur la position actuelle de la tête
de lecture. Tous les marqueurs suivants sont renumérotés en conséquence.

Important : Il FAUT insérer un marqueur de plage sur chacune des plages du CD !
Ils s’insèrent au début de chaque plage audio (légèrement avant le début de l’audio).
Les marqueurs de plage permettent aux lecteurs de CD de se caler sur chaque plage
audio individuelle.
Conseil : Cette commande est également accessible depuis la barre d’outils.

Set Sub index (Set CD Sub index)
Cette commande insère un marqueur de sous-index sur la position actuelle de
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la tête de lecture. Tous les sous-index suivants sont re-numérotés en conséquence.

Note: Les sous-index ne sont pas obligatoires, mais ils permettent aux lecteurs de CD
de repérer certains points dans une plage. Les CD d’échantillons contenant de
nombreuses boucles divisées en plusieurs éléments utilisent souvent les sous-index.
Conseil : Cette commande est également accessible depuis la barre d’outils.

Set Pause (Set CD Pause index)
Cette commande insère un marqueur de pause sur la position actuelle de la tête
de lecture.

Note: Le signal du lecteur de CD est alors coupé jusqu’à ce que la lecture atteigne le
marqueur de plage suivant.

Set CD End (Set CD end Marker)
Marque la fin du CD. Cela est important pour la gravure d’un CD, lorsque le
projet continue à délivrer un signal audio après la fin des derniers objets (cas
d’une fin de réverbération, par exemple). Pour empêcher Samplitude de couper
ces données audio, vous pouvez insérer le marqueur de fin de CD à la distance
souhaitée après le dernier objet. Les marqueurs de fin de CD servent également
à graver partiellement un projet sur un CD. La gravure du CD commence toujours
au niveau du premier marqueur de plage et se termine au niveau du marqueur
de fin. Il suffit simplement de supprimer tous les marqueurs de plage précédant
la première plage que vous souhaitez graver. Ainsi, toutes les données audio
situées avant le premier marqueur de plage ne seront pas gravées sur le CD. La
gravure s’arrête au niveau du marqueur de fin du CD. Vous pouvez donc insérer
le marqueur de fin de CD à l’intérieur du projet afin d’arrêter la gravure avant la
fin du projet.

Set Track Indices on Silence
Cette commande insère des marqueurs de plage sur les portions silencieuses
d’un objet sélectionné.
Après l’enregistrement d’une bande DAT, par exemple, il est pratique d’insérer
des marqueurs entre chaque titre.

Set Track Indices on Object Edges
Cette commande insère automatiquement un marqueur de plage au début de
chaque objet de la première piste du projet. Dans de nombreux cas, cette
commande constitue la manière la plus rapide d’insérer des marqueurs de plage
pour votre CD.
Il faut tout d’abord supprimer tous les marqueurs de plage déjà insérés à l’aide
de la fonction «Remove all Indices» pour éviter toute redondance.
Si votre piste ou titre contient plusieurs objets, vous avez la possibilité de les
mélanger grâce à la fonction de prémixage des pistes ou «bouncing» (report des
pistes pour combiner les objets), afin de garantir le bon placement des index.

Conseil : Cette commande est également accessible depuis la barre d’outils.
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Set track Indices on Object edges – Options
Set also Pause indices on Object ends
Cette option place automatiquement des marqueurs de pause sur les fins d’objet.

Time Offset for indices on Object Edges
Cette option vous permet de définir un décalage pour les marqueurs de plage
générés automatiquement.

No indices on Object Crossfades
Cette option empêche les marqueurs de plage d’être insérés entre deux objets
qui se chevauchent en raison d’un fondu-enchaîné. Cela permet d’utiliser la
fonction de création automatique de marqueurs de plage même si des fondus-
enchaînés sont utilisés sur chaque piste.

Remove index
Cette commande permet de supprimer un marqueur de plage ou un sous-index.
Cliquez d’abord sur le marqueur, puis sélectionnez cette commande pour le
supprimer.

Conseil : Après avoir cliqué sur un marqueur de plage ou un sous-index, vous pouvez
appuyer sur la touche Suppr pour le supprimer.

Remove all indices
Cette commande permet de supprimer tous les marqueurs de plage ou sous-
index insérés. Il est pratique de l’appliquer avant de lancer la fonction «Set Track
Indices on Object Edges».

Make CD…
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Cette commande ouvre la fenêtre Make CD depuis laquelle vous pouvez lancer
la gravure d’un CD audio. Samplitude intègre des routines de gravure de CD de
très haut niveau qui sont constamment mises à jour. Le code du logiciel est
sous licence Point Software & Systems.
Vous pouvez trouver la liste des graveurs de CD-R reconnus par Samplitude
dans le fichier «CDR_Readme.txt» situé dans le répertoire d’installation ou sur
notre site Internet à l’adresse www.samplitude.com.
Samplitude crée le fichier TOC (Table des matières) avant de lancer la gravure
du CD. C’est le nom du projet VIP en cours qui est utilisé et l’extension *.tcx est
ajoutée au fichier. Ce fichier TOC est placé dans le même répertoire que le
projet VIP en cours. Il est par conséquent très important de sauvegarder le projet
VIP sur le disque dur avant de lancer la gravure.

Burn «On The Fly»: Ce mode de «gravure à la volée» grave directement le CD
depuis la fenêtre VIP. Tous les calculs nécessaires sont effectués en temps réel
au cours de la gravure, il n’est donc pas nécessaire de créer un fichier image, ce
qui représente un gain de temps et d’espace disque précieux!
Les opérations ci-dessous sont calculées en temps réel au cours de la gravure:
– Réglages d’effets, de volume et de panoramique des objets
– Fondus et fondus-enchaînés
– Mixage des pistes
– Effets de chaque voie de la table de mixage
– Effets de la section Master de la table de mixage
– Conversion du format 32 bits à virgule flottante en 16 bits et Dithering

La procédure ci-dessous vous permet de savoir si votre ordinateur est
suffisamment puissant pour pouvoir effectuer toutes ces opérations en temps
réel:
Reproduisez les sections du VIP qui contiennent le plus grand nombre de pistes
et/ou qui utilisent le plus d’effets en temps réel. Observez le témoin de charge
du processeur (CPU en bas à gauche). Voici les performances possibles en
fonction de la charge du processeur:
– En dessous 25%: Gravure du CD jusqu’à 4 x la vitesse normale
– En dessous 50%: Gravure du CD jusqu’à 2 x la vitesse normale e
– En dessous 90%: Gravure du CD à 1x la vitesse normale
– Au dessus de 90%: Impossible de graver le CD en temps réel. Optez pour le

second mode («Generate a complete new file»)

Generate a complete new file: Optez pour ce mode si votre ordinateur n’est
pas suffisamment puissant pour réaliser une gravure à la volée (voir ci-dessus).
Dans ce mode, tous les fichiers .WAV (avec les réglages de fondus, de fondus-
enchaînés, d’automation de volume, etc) et tous les autres traitements en temps
réel sont intégrés dans un nouveau fichier audio. Vérifiez que vous disposez
d’assez d’espace disque avant de lancer la procédure (environ 700 Mo pour un
CD complet).
Les fichiers .WAV d’origine utilisés dans le projet VIP restent intacts. Cette
édition est non destructive !
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Use Uni Code for TOC: C’est le réglage par défaut. Il est utilisé par les fonctions
de gravure de CD internes de Samplitude et par la version 32 bits de Point
CDAudio.

Use ASCII Code for TOC: Ne sélectionnez ce format que si vous possédez la
version 16 bits de Point CDAudio.

Call external CDAudio Software: Cela vous permet de déterminer si vous
voulez lancer automatiquement l’application de création de CD «CDAudio».
Les informations actuelles de TOC sont alors transférées à l’application, pour
que la création de CD puisse immédiatement commencer dans le programme
externe. Tous les projets de Samplitude sont fermés et l’application elle-même
se ferme pour éviter tout type de conflit d’accès aux fichiers.
Si CD-Audio est installé dans tout autre dossier que «C:\CDAUDIO», vous devrez
indiquer l’emplacement de l’application.
Sélectionnez cette option uniquement si vous ne souhaitez pas utiliser les
fonctions de gravure de CD internes de Samplitude et désirez utiliser un
programme externe.

Burn CD: Lance l’utilitaire MAGIX de gravure de CD pour graver tout type de
fichier de données, par ex. des fichiers mp3 sur CD.

Show TOC: Cliquez sur ce bouton pour afficher le contenu de la TOC dans une
fenêtre de texte. Vous pouvez copier et coller vers/depuis cette fenêtre et utiliser
un éditeur de texte externe (External Editor).

Export TOC: Cette fonction vous permet de sauvegarder un fichier TOC (*.TOC,
*.TCX). Un projet Wave est créé par report de pistes du VIP, auquel le fichier
TOC fait référence.

Troubleshooting: Ouvre le CD Burn Profiler qui contrôle le système à la
recherche de pilotes incompatibles pour votre équipement de gravure de CD.

Create DVD-Audio
Introduction
Samplitude peut graver des DVD audio à l’aide de n’importe quel graveur de
DVD. Vous pouvez graver les formats de disque suivants: +R/-R/+RW/-RW.
Les DVD audio ne peuvent être lus que sur des lecteurs compatibles DVD audio
! Ceux-ci se repèrent à leur logo DVD-Audio.
Le lecteur doit avoir jusqu’à six sorties analogiques individuelles pour la
reproduction multicanal.
Samplitude grave actuellement des DVD sans menu graphique, mais incluant
simplement des marqueurs de plage, qui peuvent être contrôlés comme un CD
audio. Toutefois, pour créer des DVD audio/vidéo avec menus, vidéos et
diaporama, le programme de montage vidéo et de création de DVD «MAGIX
video deluxe pro» sera bientôt disponible et pourra être intégré à Samplitude.
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Vous pouvez sauvegarder de l’audio en 16 et 24 bits sur un DVD audio; des
fréquences d’échantillonnage de 44,1 et 48kHz ainsi que leur double et leur
quadruple sont possibles. Jusqu’à 6 canaux audio sont acceptés en surround 5.1
ainsi que d’autres configurations (stéréo, 4.0, etc).
La seule limitation est qu’il ne faut pas dépasser le débit de transmission
maximum garanti d’environ 10Mbits/s pour les lecteurs de salon. Par
conséquent, la fréquence d’échantillonnage de 48kHz est un maximum pour le
son surround 5.1. La limite des 10Mbits/s serait dépassée en 96 kHz.
Par exemple, les durées de lecture suivantes correspondent à la capacité de
stockage d’un DVD-R simple couche (à une fréquence d’échantillonnage de
44,1kHz):
Stéréo 16 bits: environ 7 h
Stéréo 24 bits: environ 4,5 h
Surround 5.1 et 24 bits: environ 1,5 h

Création d’un DVD audio
Dans le VIP, les marqueurs (index) de plage sont placés comme pour un CD.
Un CD audio et un DVD audio peuvent donc être tour à tour gravés à partir du
même projet.
Lancez la création d’un DVD audio via le bouton «Create DVD-Audio» dans la
barre d’outils pour CD.
La fenêtre «Trackbouncing» s’ouvre. Vous pouvez choisir entre 16 bits et 24
bits pour l’audio. Le réglage initial est 24 bits. La case «Create DVD-Audio» doit
être cochée.
Un programme externe de gravure de DVD audio s’ouvre. Son chemin d’accès
(Path) est prédéfini mais peut être changé si nécessaire.
Sinon, vous pouvez aussi ouvrir ici «Video deluxe pro» qui permet la création
perfectionnée de DVD (avec menus).
«OK» lance le processus de report. L’application de gravure de DVD audio est
lancée et les fichiers sont automatiquement transmis.
Note: Un espace de stockage double de celui d’un DVD est nécessaire sur le
disque dur, car le VIP est d’abord reporté puis l’image du DVD est créée à partir
des données audio complètes, et est ensuite gravée.
La liste des plages est affichée dans l’outil DVD audio. D’autres plages peuvent
être ajoutées manuellement, et le format surround peut être changé (stéréo,
4.0, 5.0, 5.1).
Le bouton «Burn» ouvre la fenêtre de gravure où le graveur et la vitesse de
gravure peuvent être sélectionnés.
L’image du DVD est d’abord créée après avoir pressé le bouton «Start». Le
processus de gravure suit.

Show CDR drive Information....
Cette fenêtre vous renseigne notamment sur le fabricant, le nom du graveur, sa
version matérielle, la taille de sa mémoire cache et les caractéristiques du
mécanisme du graveur.
L’option «Disc At Once» est extrêmement importante car elle est obligatoire
pour graver des CD audio à la norme Red Book qui puissent être utilisés ensuite
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comme Masters par les usines de pressage.

Show CDR Disc Information…
Cette commande affiche des renseignements sur le CD inséré dans le graveur.
Le renseignement le plus important est la longueur maximale disponible en
enregistrement et qui ne peut donc être dépassée en production (74 minutes et
5 secondes, par exemple).

CD Track/Index Manager
Dans cette fenêtre de dialogue, toutes les plages du CD et tous les sous-index du
VIP actuel sont affichés sous forme de liste.

Tous les marqueurs actuellement sauvegardés dans le projet actif sont affichés
dans cette fenêtre avec leur nom et leur position. Sélectionnez les marqueurs à
la souris, et vous pourrez changer leur position dans le champ de saisie sous la
liste. Vous pouvez aussi les nommer et les renommer grâce au champ
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immédiatement à droite. Le bouton Play Marker lance la lecture depuis le
marqueur sélectionné, Play Loop reproduit une boucle d’une seconde autour
du marqueur. Stop arrête la lecture. CD Text ouvre une autre fenêtre pour saisir
des informations de CD Text.
La tête de lecture est déplacée sur la position d’un marqueur en double cliquant
sur celui-ci.
Create: avec les boutons correspondants, vous pouvez créer des marqueurs, des
plages de CD, des sous-index de CD ou des marqueurs de pause de CD sur des
positions temporelles que vous aurez définies. Vous devez saisir cette position
dans le champ de temps sous la liste des marqueurs.
D’autres réglages tels que des balises de préaccentuation (Preemphasis), de
protection anti-copie (Copy Protection) et de protection anti-copie de seconde
génération (Sec. Gen. Prot.) peuvent être faits pour chacune des plages.
Le bouton Apply to all vous permet d’utiliser les balises actuelles à toutes les
plages.
L’autre champ concerne les codes ISRC pour chaque plage de CD.

CD Text/MP3 ID Editor
Ici, vous pouvez saisir les informations de CD text pour le CD. Les noms des
plages du CD sont copiés à partir des noms de marqueurs de plage de CD dans
le VIP. Toutes les informations présentes ici sont aussi contenues dans le VIP,
mais vous avez en plus la possibilité de sauvegarder et de recharger toutes les
entrées saisies ici dans un fichier indépendant (*.cdt).
Cette fonction vous permet de fournir des données concernant un morceau ou
un CD – comme album, artiste etc.
Les fichiers MP3 ne transportent pas que des données audio, mais aussi des
informations sur le morceau de musique codé au travers de ce que l’on nomme
les balises ou «tags» ID3. Ce sont des appendices de fichier dans lesquels un
encodeur peut inscrire des informations standardisées. Les balises ID3 sont
reconnues par les décodeurs et affichées comme données musicales par le lecteur
de MP3.

CD Disc Options....
Cette commande ouvre la fenêtre CD Disc Options depuis laquelle vous pouvez
configurer différents paramètres pour le CD.
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CD Title: Saisissez dans ce champ le titre que vous souhaitez donner au CD.
Ce titre est enregistré sur le CD et repris dans la TOC.

UPC/EAN Code: Saisissez dans ce champ le code UPC/EAN que vous souhaitez
attribuer au CD. Ce code est également enregistré sur le CD et est obligatoire
pour pouvoir le relire sur certains lecteurs de CD spéciaux.

Number of first CD Track: Dans certains cas (gravure en mode Track-At-
Once, par exemple), il est nécessaire de fixer le numéro de la première plage.
Comme Samplitude grave les CD audio à la norme Red Book en une passe (Disc
At Once), vous n’aurez vraisemblablement jamais à utiliser ce réglage (ce réglage
n’a aucune importance en mode Disk at Once).

Allow Bonus Tracks before Track 1: Cette option vous permet d’insérer des
plages «cachées» ou bonus avant la première plage.

Set Pause Time....
Cette commande permet de définir le temps de pause par défaut entre deux
plages. Cette durée peut être saisie en échantillons (Samples), en millisecondes,
au format SMPTE, ou mesures:temps:clics.
Le temps de pause est nécessaire à la fonction de grille, qui permet aux objets de
«se caler» sur le bord des autres objets additionné du temps de pause choisi. On
laisse, en général, une pause de 2 secondes.

Note: L’unité peut être choisie dans le menu contextuel qui s’affiche quand on clique
sur l’unité (cadre grisé).

Set Start Pause Time....
Cette commande permet de définir la durée par défaut de la pause avant la
première plage du CD. Ce temps de pause peut être saisi en frames de CD
(75 frames = 1 seconde). Important !!! Réglez ce paramètre sur 150 frames
(2 secondes) pour satisfaire aux critères des CD audio à la norme Red Book ! Il est
conseillé de régler et de laisser ce paramètre sur la valeur 150 frames
(deux secondes).

CD Arrange mode
Lorsque vous activez ce mode, Samplitude réarrange les nouveaux objets insérés
et insère des pauses (conformément à la norme Red Book) entre les objets.
Nous vous recommandons de suivre la procédure ci-dessous:
– Ouvrez un nouveau projet VIP contenant 4 pistes de façon à pouvoir effectuer

son mixage final plus tard si nécessaire.
– Activez CD Arrange Mode via le menu CD/DVD.
– Ouvrez un nouveau VIP.
– Chargez les fichiers audio, les pistes audio ou effectuez un enregistrement à

l’aide d’un microphone.
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Dans le projet VIP, vous pouvez voir des espaces vides entre les objets
individuels– il s’agit des pauses qui ont été insérées. La durée des pauses insérées
peut-être définie dans la fenêtre de dialogue «Set Pause Time».
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Track Bouncing....
Cette commande ouvre la fenêtre de dialogue Track bouncing (prémixage ou
report de pistes).

Depuis cette fenêtre, vous pouvez «prémixer» un projet virtuel multipiste (VIP)
en un seul ou plusieurs fichiers audio stéréo. C’est essentiellement la même
chose que d’exporter le VIP via la commande Export Audio du menu File, mais
avec beaucoup plus de possibilités. Vous pouvez aussi exporter un ou plusieurs
objets ou pistes, restreindre le processus d’export aux sélections (Ranges) et
exclure les effets de piste et les effets Master. Le fichier qui en résulte peut alors
être automatiquement ouvert dans un nouveau VIP ou remplacer les objets
dans le projet actuel. Toutes les pistes du projet VIP sont mélangées dans le
nouveau fichier audio y compris les traitements en temps réel (fondus, effets,
automations de volume et de panoramique, effets d’objets, etc.). Si vous effectuez
ce report de pistes en format 32 bits à virgule flottante, aucune distorsion ne
peut se produire.
Il est conseillé d’utiliser la fonction de normalisation du master de la table de
mixage pour créer un fichier ayant une atténuation exacte.

Réglages de report de pistes
Source:
Only marked Range: Le prémixage porte uniquement sur la sélection en cours.

From VIP Start to last Object End:  La plage de prémixage s’étend du début du
VIP jusqu’à la fin du dernier objet avec sa fin de reverb (voir menu Options >
System/Audio > onglet Program).
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Complete Project: Le prémixage porte sur la totalité du projet.

Note: Lorsque vous cochez cette option, assurez-vous qu’aucun espace vide (blanc)
excessivement long n’existe à la fin du VIP (après la fin du dernier objet). Si vous
laissez ce blanc, il sera inclus dans le prémixage et risque de rendre la procédure
extrêmement longue. Pour supprimer cet espace vide, il suffit de le délimiter comme
une sélection, puis d’appuyer sur la touche Suppr.

Objects: Bounce selected: Tous les objets sélectionnés sont reportés, c’est-à-
dire que tous les effets d’objet s’appliquent et que des projets Wave sont créés,
un par objet. Les objets sont remplacés par d’autres se référant aux nouveaux
projets Wave. Cela permet une exportation rapide d’un grand nombre d’objets
en fichiers séparés (par exemple pour des archives d’échantillons).

Objects: Glue selected: Tous les objets sélectionnés dans une piste sont inclus
dans un nouveau fichier avec tous les effets d’objet.
Ces options ont la même fonction que «Glue Objects» dans le menu «Object»;
vous pouvez saisir un nom de fichier personnalisé, mais il n’y a pas ici de
mécanisme de gel/dégel («Freeze/Unfreeze»).

Options
Process only active track: Seule la piste sélectionnée est reportée. Si «Only marked
range» est aussi activé, seule la sélection faite dans la piste sélectionnée est reportée.
Si la piste sélectionnée est un bus submix, toutes les pistes dirigées vers ce bus
sont aussi reportées. Cela fonctionne aussi de façon récursive, c’est-à-dire si ces
pistes sont elles-mêmes des bus. Cela permet de mixer rapidement des groupes.

Multi-track bounce: Chaque piste (y compris les auxiliaires) est reportée dans
un fichier séparé, pour traitement ultérieur dans un environnement multipiste
externe.

Show maximum Amplitude: Cochez cette option et (quand le report est
terminé), Samplitude affichera l’amplitude maximale atteinte par le fichier audio
issu du report.

Effects:
Exclude Master Effects from Bouncing: Les effets master ne sont pas inclus
durant le report.

Exclude Track Effects of the Target Track: Les effets de piste de la piste
visée (si elle n’est pas identique à la piste source) ne sont pas inclus.

Ces options sont importantes en combinaison avec «New separate Object in
current VIP/Replace Objects in current VIP» pour que les effets de piste ne
soient pas appliqués deux fois. Elles sont automatiquement réglées quand vous
changez d’option dans le cadre «Generating Options».
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Generating Options
Only a Wave Project: Le fichier issu du report est sauvegardé comme projet
Wave. Aucun nouveau projet VIP n’est généré.

New separate Object in current VIP: Le fichier issu du report est sauvegardé
comme projet Wave et un nouvel objet faisant référence à ce projet est créé et
placé sur une piste séparée du VIP en cours.

Replace Objects in current VIP: Le fichier issu du report est sauvegardé
comme projet Wave et un nouvel objet faisant référence à ce projet est créé en
remplacement du ou des objets d’origine dans le VIP en cours.

New VIP: Le fichier issu du report est sauvegardé comme projet Wave et un
nouvel objet faisant référence à ce projet est créé et placé dans un nouveau VIP.

Note: Dans tous les cas, les projets Wave d’origine restent intacts. Cependant, comme
certaines de ces options modifient le VIP, nous vous recommandons d’en faire une
sauvegarde avant de lancer la commande.

Format
Le format obtenu peut être choisi de façon souple. Les formats WAV et AIFF 8/
16/24/32 bits mono/stéréo sont pris en charge à diverses fréquences
d’échantillonnage, ainsi que le format mp3 à divers débits et le format WAV
avec tout codec ACM installé.

Note: Toutes les pistes résultant du report sont ouvertes (même si seulement l’option
«Only a Wave Project» a été sélectionnée dans Generating Options). Cela signifie
que:

1. Vous ne pouvez pas reporter le même projet une seconde fois de suite s’il est
toujours ouvert suite au premier report. Il doit d’abord être fermé. Si vous
faites souvent des reports et n’avez plus besoin d’options spéciales (comme
pour le mastering), vous irez plus vite en sélectionnant «Export Audio» dans
le menu «File» plutôt qu’en utilisant la fenêtre «Trackbouncing».

2. Tous les formats qui ne peuvent pas être directement ouverts par Samplitude
ne peuvent pas être créés via la fenêtre de report de pistes «Trackbouncing».
Par exemple, pour un report au format Real ou WMA, vous devez utiliser File
> Export Audio.

Presets
Vous pouvez sauvegarder tous les réglages de cette fenêtre dans des presets.
Ainsi, vous pourrez rappeler vos réglages spéciaux pour par exemple produire
une pré-écoute mp3, un report multipiste ou un objet.

Surround Trackbouncing:
Ce bouton active la fonctionnalité de report de pistes surround. Les autres options
de cette section ne seront pas accessibles tant que la case «Active» ne sera pas
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cochée. Cela n’est possible que si le projet est configuré pour un mixage surround.
Lisez la section correspondante sur le report de pistes surround dans le chapitre
Surround.

OK
Cliquez sur ce bouton afin de lancer le report (prémixage) des pistes.

Cancel
Cliquez sur ce bouton afin de refermer la fenêtre Track Bouncing sans accomplir
le report.

Report (prémixage) de bus Submix
Vous avez également la possibilité de prémixer un bus Submix (sous-groupe).
Chaque piste affectée au bus Sub Mix est alors incluse dans le processus de
report, même si la piste affectée au bus est elle-même un bus.
Cela s’avère particulièrement pratique pour mixer toutes les pistes affectées à
un groupe spécifique (pupitre de cordes, ensemble de batterie etc.).
Si vous sélectionnez plusieurs pistes ou uniquement la piste active (Option:
only marked range/Process only active track) avec les options «New separate
Object in current VIP» ou «Replace Objects in current VIP» – et si cette sélection
comporte un bus Sub Mix - il est alors possible que le nouvel objet créé soit
placé précisément sur ce bus Sub Mix. Cela est fort probable sachant que les
bus ne contiennent, en général, aucun objet (bien que cela ne soit pas exclu) et
que le nouvel objet créé est placé sur la première piste vide disponible. Dans ce
cas, les effets de piste (dont l’automation par courbe de panoramique/volume)
du bus Sub Mix sont exclus du report afin d’éviter qu’ils ne soient appliqués
deux fois (une fois par le biais du report et une fois par le biais des effets en
temps réel de la piste).
Il est impossible de prémixer les bus auxiliaires de cette manière. Vous devez
impérativement inclure les pistes affectées aux bus auxiliaires afin d’obtenir le
résultat souhaité.

Range Bouncing
Utilisez cette fonction pour convertir les objets d’une sélection temporelle
(Range) en un nouveau fichier .WAV. Les objets sélectionnés dans le VIP sont
remplacés par la version prémixée. Cela s’avère très pratique pour combiner
plusieurs objets en un seul de façon à pouvoir utiliser la fonction de création
automatique de marqueurs de plage.
Si le VIP contient des objets 32/24 bits, une fenêtre de dialogue s’ouvre à l’écran
et vous demande si vous souhaitez que le nouveau fichier soit créé au format
32 bits à virgule flottante ou 16 bits.

Remove unused Samples
Cette fonction supprime des projets Wave appartenant au VIP actuel tout le
matériel audio qui n’est utilisé par aucun des objets du VIP. Les objets du VIP
pointeront sur les sélections audio idoines dans les fichiers audio associés. Cela
laisse intact le VIP lui-même.
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Cette fonction supprime physiquement des données et ne peut pas être annulée,
aussi employez-la avec précaution!
Si plusieurs VIP utilisent le même projet Wave, tous ces VIP devront être ouverts
afin d’éviter des pertes de données pour certains d’entre eux.
Cette fonction peut faire gagner beaucoup d’espace de stockage. Toutefois, la
contrepartie de cette option est qu’après l’avoir exécutée, les objets ne peuvent
plus être que raccourcis, et pas rallongés puisque toutes les données audio
extérieures aux limites de l’objet ont été supprimées. Pour cette raison, vous
pouvez aussi définir une marge de sécurité pour les échantillons. Cette quantité
d’échantillons sera conservée dans le projet Wave de part et d’autre de l’objet
pour pouvoir bénéficier d’une certaine réserve de données au cas où vous
voudriez changer un fondu d’entrée/sortie pour l’objet qui s’y réfère. La valeur
par défaut est 22050 (= 500ms pour une fréquence d’échantillonnage de 44,1
kHz).
La fenêtre de dialogue référence touts les projets Wave auxquels fait appel le
VIP et la taille de l’espace disque occupé au total par le projet Wave et combien
est actuellement inutilisé par le VIP. Chaque fichier a une case à cocher, pour
l’inclure ou non dans la procédure. Seuls les fichiers ayant des échantillons non
utilisés sont cochés par défaut, mais vous pouvez décocher tout projet Wave
que vous désirez conserver dans sa totalité.

Notez que la liste contient aussi des fichiers auxquels le VIP ne fait pas actuellement
référence mais qui sont requis par l’historique d’annulation du VIP. Ces fichiers sont
à 100% non utilisés et seront donc totalement effacés s’ils sont cochés!

Cela peut être acceptable (en cas de session d’enregistrement non voulue), mais
il y a aussi des cas où vous avez juste importé du matériel audio d’une autre
session ou de votre bibliothèque personnelle d’échantillons et avez décidé par la
suite de ne pas l’utiliser.

Conseil: Si vous avez besoin de tout le contenu des fichiers audio pour d’autres projets
de production, il est recommandé d’archiver le projet fini de la façon suivante.
Sauvegardez la totalité du projet dans un nouveau dossier (File->Save Complete VIP
in). Le VIP se trouve maintenant avec tout son contenu, c’est-à-dire tous les fichiers
audio, sous une forme non altérée (WAV, RAP, etc.) dans le même dossier. Ensuite,
utilisez la commande Remove unused Samples. Ce même dossier ne contiendra plus
que les données audio ou échantillons réellement nécessaires au VIP archivé. Une
copie de sauvegarde du contenu peut facilement être effectuée sur tout support de
sauvegarde tel que CD-R, DAT de données ou autre.

Delete Freeze Data
Veuillez vous reporter au chapitre «Freeze».

Collect Project Files
Si un projet utilise des données audio venant de différentes sources, de CD
d’échantillons ou d’autres projets, ces fichiers se trouvent souvent dans des
dossiers différents. Il est judicieux de réunir tous les fichiers ayant trait au projet
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dans le dossier du projet pour s’assurer que rien ne manque quand vous faites
une copie de sauvegarde du projet.
Vous pouvez copier ou déplacer le fichier. Si vous le déplacez, vérifiez qu’il
n’est pas nécessaire à un autre projet.

Waveform Generator
Cette fenêtre de dialogue donne accès à un puissant générateur de formes d’onde
(tonalités de test).

La forme d’onde produite peut prendre pour propriétés celles du projet Wave
ouvert. La tonalité de test est automatiquement chargée dans le VIP actif.

Format new Wave Project
Ces options vous permettent de sélectionner le type, la résolution et la fréquence
d’échantillonnage du nouveau projet Wave qui contiendra le son produit.

Waveform
Vous avez le choix entre six formes d’ondes – Rectangle (rectangulaire), Triangle
(triangulaire), Sine (sinusoïdale), Saw up (dents de scie montantes), Saw down
(dents de scie descendantes) et White Noise (bruit blanc).

Length
Utilisez ces champs afin de programmer la durée voulue pour la tonalité produite.

Waveform Parameters
Utilisez ces champs afin de programmer la fréquence et l’amplitude (niveau ou
Level) voulues pour la tonalité produite.

SMPTE Generator
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Cette fenêtre de dialogue de générateur SMPTE vous permet de créer des fichiers
audio contenant un Timecode SMPTE. Ces fichiers peuvent ensuite être placés
dans les pistes du VIP et être affectés à n’importe quelle sortie audio de votre
PC. Ainsi, vous obtenez en sortie un signal SMPTE très stable calé à l’échantillon
près sur les données audio de votre VIP.

New Manager…
Cette commande ouvre une nouvelle fenêtre de gestionnaire (Manager). Le
bouton Manager de la barre de boutons affiche/masque tous les gestionnaires
ou «Managers».
Cette fenêtre a plusieurs onglets pour représenter les différents gestionnaires.

Veuillez vous référer au chapitre sur les gestionnaires («Managers»).

Manager > File Browser/Object Manager/Track Manager/
Marker Manager/Range Manager
Veuillez vous référer au chapitre sur les gestionnaires («Managers»).

Take Manager…
Ouvre la fenêtre du gestionnaire de prises (Take Manager). Celui-ci est
spécifiquement conçu pour les utilisateurs qui travaillent avec un grand nombre
de prises d’enregistrement.
Samplitude note la position du matériel audio enregistré dans le VIP. Cet
«horodatage» est conservé sur le disque dur ou dans le projet RAM Wave, et
permet de ramener l’objet enregistré à sa position d’origine.



454

Menu «Tools»

Display Filter (filtre d’affichage)
Same file only: Seules sont affichées les prises appartenant au même fichier
audio que l’objet sélectionné.
Same track only: Seules sont affichées les prises positionnées sur la même
piste audio que l’objet sélectionné.

Match time: Seules sont affichées les prises dont la position temporelle d’origine
correspond à celle de l’objet sélectionné.

Play/Stop
Lance/arrête la lecture. Pensez à placer la tête de lecture sur la position à
reproduire avant d’ouvrir le gestionnaire de prises (Take Manager).

Replace!
Remplace l’objet sélectionné par les prises sélectionnées dans la liste.

Statistic (verbose)
Crée un nouveau VIP avec les prises actuellement visibles dans la liste. Chaque
prise est référencée dans une nouvelle piste. Le VIP peut servir à écouter
individuellement les prises, grâce aux fonctions solo et mute de chaque piste.
Cette facilité peut être utile dans les situations où l’appellation des prises est
confuse, durant les sessions sous pression (dans l’urgence).

Statistic (brief)
Crée un nouveau VIP avec les prises actuellement sélectionnées dans la liste.
Toutes les prises sont alignées dans la même piste.
Cette facilité peut être utile pour graver un CD des prises en vue d’une écoute
ultérieure, ou dans un but général d’archivage.

Liste des prises
La liste des prises affiche les objets, vous permettant de rechercher d’autres
objets allant avec celui sélectionné. La liste donne le nom de la prise (Name), sa
position dans le temps, le fichier (File) qui lui est associé et les données
d’horodatage.

Note: Vous vous féliciterez plus tard d’avoir passé du temps à bien nommer les prises
et projets Wave durant les sessions d’enregistrement. Nous comprenons bien que le
processus créatif l’empêche parfois, mais plus vous vous y entraînerez, plus vous
deviendrez rapide.

Utilisation du gestionnaire de prises
Pour cet exemple, considérons que vous avez un objet du VIP qui ait été traité
(de façon non destructive – l’option «Create copy» étant cochée) avec le Room
Simulator. Dans cette situation, le signal traité a été mis à la suite de
l’enregistrement d’origine (signal sec). Après une écoute soigneuse, vous décidez
que l’objet sonnait mieux sans effet, et direz maintenant remplacer l’objet traité



455

Menu «Tools»
par l’effet par la prise d’origine (objet) sans effet.
Voici comment cela se fait:
1. Sélectionnez l’objet que vous aimeriez remplacer (échanger) en cliquant dessus

(dans la moitié basse de la piste).
2. Délimitez une sélection temporelle (Range) qui englobe l’objet sélectionné.

Cela est destiné à s’assurer que la lecture se fera dans la zone désirée, tandis
que l’écoute changera.

3. Ouvrez le gestionnaire de prises (Tools > Take Manager, ou Object > Take
Manager)

4. Dans le coin inférieur gauche de la fenêtre Take Manager (sous Display Filter),
vérifiez que «Same Track only» est la SEULE option cochée.

5. Regardez la liste des prises, vous devriez maintenant y voir deux prises. La
prise portant le «O» rouge est l’objet actuellement sélectionné.

6. Cliquez sur la prise d’origine (son sec), qui ne porte pas de «O» rouge, et
cliquez sur le bouton Replace!. Samplitude remplacera l’objet (prise) avec effet
par l’objet d’origine (prise) sans effet.

7. Cliquez sur le bouton PLAY/STOP pour entendre le changement fait à l’étape
6.

8. Cliquez sur le bouton PLAY/STOP une seconde fois pour arrêter la
reproduction.

9. Cliquez sur le bouton OK pour accepter le changement fait et fermer le
gestionnaire de prises.

Note: Samplitude «horodate» chaque projet Wave qu’il enregistre. Cela permet à
l’objet (associé à ce projet Wave) de retourner à sa position de départ d’origine en cas
de déplacement accidentel.

La première étape lors du travail avec le gestionnaire de prises est de sélectionner
un objet. Cela pourrait être par exemple le dernier objet créé, suite à un
enregistrement par punch-in. Cet objet (sélectionné) est identifié par un «O»
coloré dans la liste des prises.

Note: La fenêtre Take Manager ne fonctionnera pas sur des objets qui n’ont pas été
enregistrés par Samplitude! C’est le cas par exemple, des fichiers .WAV importés via
l’option File > Convert Audio > Import Audio, ou des plages de CD chargées via
l’option CD/DVD > Load Audio CD Track(s). Si vous sélectionnez un objet qui n’a
pas été enregistré dans Samplitude et choisissez l’option Object > Set original position,
Samplitude horodatera l’objet, lui permettant d’être employé dans le gestionnaire de
prises.

Voici quelques exemples d’application du gestionnaire de prises:
– Sélection de la meilleure prise parmi plusieurs effectuées par passages

successifs lors d’un enregistrement en boucle.
– Repérage des meilleures prises entre les mesures 32 et 34 parmi les 12 prises

d’une production classique.
– Présentation claire de toutes les prises disponibles sur une période SMPTE

spécifique (par ex. 30:00 à 35:00).
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Start Windows Explorer
Cette commande ouvre l’Explorateur Windows. Si vous disposez l’Explorateur
à gauche ou à droite de la fenêtre de Samplitude, vous pouvez faire directement
glisser des fichiers WAV dans les projets de Samplitude. Cela permet une gestion
facile de fichiers nombreux (comme des effets sonores). Il est même possible
de faire glisser à la fois plusieurs fichiers.
Tout type de fichier portant l’extension WAV, OBJ (pour les objets), HDP et
RAP peut être déposé dans le VIP.
Cela fonctionne aussi durant la lecture.
C’est une commande obsolète conservée dans Samplitude pour ceux qui ont
l’habitude de l’utiliser. Vous pouvez naviguer beaucoup plus confortablement
dans votre disque dur avec le navigateur de fichiers de la fenêtre Manager (onglet
File Browser). Il comprend une fonction de recherche de texte et des dossiers
favoris.

Timestretch/Pitchshift Patcher
Description
Cet outil permet d’insérer des informations de temps et de hauteur de plages
audio au sein même des fichiers audio utilisés dans Samplitude et dans d’autres
programmes MAGIX (MAGIX music maker, par exemple). Des renseignements
et des réglages supplémentaires sont ainsi inscrits («patchés») dans les projets
Wave, ce qui permet d’optimiser les opérations de Timestretching ou de
Pitchshifting.
Paramètres pouvant être inscrits dans les fichiers Wave:
– Algorithmes de Timestretching/Pitchshifting
– Tempo
– Marqueurs de temps

Algorithmes de Timestretching/Pitchshifting
Certains algorithmes autres que l’algorithme Standard peuvent donner de
meilleurs résultats pour le Timestretching et/ou le Pitchshifting en temps réel.
Consultez Resampling/Timestretching/Pitchshifting pour plus de détails. Le
Patcher vous permet de sauvegarder l’algorithme de Timestretching optimal
avec chaque projet Wave. Vous êtes ainsi sûr que l’algorithme «correct» sera
automatiquement utilisé quand le Timestretching/Pitchshifting sera employé
comme effet d’objet sur ces projets (par exemple avec le mode de souris
Timestretch).

Beat marker (Marqueur de temps)
Les marqueurs de temps sont également sauvegardés avec le projet Wave si
l’algorithme utilisé les exploite.
Par rapport à la fenêtre Timestretching, le Patcher fonctionne en mode non
modal, autrement dit, si le Patcher est ouvert, vous pouvez déplacer les marqueurs
de temps d’un projet Wave tout en vérifiant le résultat du Timestretching.

BPM
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Sauvegarde la valeur de tempo en BPM (battements par minute). Cette
information est utile si vous devez régler ultérieurement le facteur de
Timestretching afin d’adapter le projet Wave au tempo d’un arrangement
existant.

Les Patches en bref
Les réglages mémorisés au sein des projets Wave (Patches) ne sont pris en
compte que si vous avez ouvert le projet Wave en mode destructif (Wave Editing)
et s’il n’est pas ouvert simultanément dans un VIP.
Sur la gauche de la fenêtre (Patch), vous pouvez sélectionner l’algorithme à
employer ainsi que le tempo du fichier audio. Sur la droite (Test) se trouve les
paramètres de réglage de la fenêtre Timestretching/Pitchshifting.
Cela vous permet de tester l’algorithme sélectionné en association avec les
boutons Play/Stop et Play Original. Les informations sont inscrites directement
dans le fichier Wave sous forme de Patch.
Les échantillons de la gamme de produits MAGIX music maker contiennent
des informations de patch depuis la version 2003.

Remix Agent
Veuillez vous référer au chapitre «Effets et plug-ins d’effets»!
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Play Once
Cette commande lit le projet actuel (projet Wave ou VIP) une seule fois. La
lecture commence à la position actuelle de la tête de lecture.

Raccourci: Barre d’espace

Play Loop
Cette commande lit en boucle le projet actuel (projet Wave ou VIP). La lecture
commence à la position actuelle de la tête de lecture.

Raccourci: Barre d’espace

Play With Preload
Si vous souhaitez que la lecture démarre instantanément, sélectionnez cette
commande afin de précharger les mémoires tampons audio, puis cliquez sur
OK pour lancer la lecture. Cette fonction est utile quand vous voulez synchroniser
quelque chose ‘manuellement’ et qu’il vous faut un démarrage précis de la
lecture.

Raccourci: Shift + Barre d’espace

Play In Range / Loop
Cette commande fait démarrer la lecture au début des pistes audio ou sur la
position actuelle dans le morceau et la poursuit jusqu’à la fin de la sélection
temporelle (Range) définie. Une fois la fin de la sélection atteinte, la lecture
reprend au début de la sélection. C’est aussi un moyen rapide de tester des
bouclages.

Raccourci: Shift + P

Play only selected Objects
Seuls les objets sélectionnés seront lus. Tous les objets non sélectionnés seront
temporairement coupés. Si la tête de lecture n’est pas située sur la position
temporelle du premier objet sélectionné, elle se déplace à cette position.

Raccourci: Ctrl + Espace

Play cut > Play to Cut start
Une zone dite de prédéfilement ou Preroll allant jusqu’au début de la sélection
temporelle (Range) définie sera lue. La durée de cette zone se règle avec Options
> Program Preferences > Set Preroll Time ou dans l’éditeur de fondu-enchaîné.
Les réglages sont constants.

Raccourci: F5
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Play Cut > Play from Cut start
Quand vous simulez une édition sur une sélection (Range), choisissez cette
option pour lire une courte zone audio partant du début de la sélection. La durée
de cette zone se règle avec Options > Program Preferences > Set Preroll Time
ou dans l’éditeur de fondu-enchaîné. Les réglages sont constants.

Raccourci: F6

Play Cut > Play to Cut end (OutPoint)
Choisissez cette option pour lire une courte zone audio allant jusqu’à la fin de la
sélection (Range) définie. La durée de cette zone se règle avec Options > Program
Preferences > Set Preroll Time ou dans l’éditeur de fondu-enchaîné. Les réglages
sont constants.

Raccourci: F7

Play Cut > Play from Cut end (OutPoint)
Choisissez cette option pour lire une courte zone audio partant de la fin de la
sélection (Range) définie. La durée de cette zone se règle avec Options > Program
Preferences > Set Preroll Time ou dans l’éditeur de fondu-enchaîné. Les réglages
sont constants.

Raccourci: F8

Play Cut > Play over Cut/Crossfade
VIP: Une coupure est simulée. La lecture démarre légèrement avant la sélection
(Range) définie, puis saute celle-ci (coupure) et s’arrête après. La durée de la
lecture se règle avec Options > Program Preferences > Set Preroll Time ou dans
l’éditeur de fondu-enchaîné. Les réglages sont constants.

Raccourci: F4

Stop
Choisissez cette option pour arrêter la lecture (ou l’enregistrement). La tête de
lecture retournera au point où la lecture a commencé. Ce point peut être réglé à
l’aide des paramètres de lecture (P).

Raccourci: Espace

Stop and Go to Current Position
Cette commande arrête la lecture (ou l’enregistrement) et maintient la tête de
lecture sur la position d’arrêt de la lecture.

Raccourci: «,» ou «décimale» (pavé numérique)
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Restart Play
Cette commande permet de relancer la lecture depuis la position d’origine de la
tête de lecture.

Astuce : Vous pouvez sélectionner cette commande pendant la lecture des données
audio.

Raccourci : Ret. Arr.

Playback Options
Cette commande ouvre la fenêtre Play Parameter (paramètres de lecture).

Sample Rate
Ce paramètre vous permet de sélectionner la fréquence d’échantillonnage
souhaitée pour la lecture, à condition que votre carte son soit bien capable de
relire cette fréquence. Utilisez cette possibilité pour reproduire un projet dont
la fréquence d’échantillonnage est incompatible avec votre carte son. Vous pouvez
changer ici la fréquence d’échantillonnage puis compenser le changement de
tempo qui en résulte avec la fonction varipitch.

Options
Ouvre une fenêtre de propriétés, qui affiche les caractéristiques de lecture
(fréquence d’échantillonnage, résolution, transposition matérielle ou «hardware
pitching» ...) que le pilote sélectionné accepte. Il y a aussi un bouton Open
Windows Mixer pour ouvrir le mélangeur multimédia Windows en mode de
lecture (si votre carte son le permet) afin de rapidement régler le niveau de
sortie.

Device
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Ce champ vous permet de définir le périphérique utilisé pour la lecture des
projets Wave et le périphérique master stéréo pour les VIP. Les périphériques
qui apparaissent dans la liste se configurant dans le menu Options -> System/
Audio

Autoscroll
La section ‘Autoscroll’ vous permet d’activer la fonction de défilement
automatique, particulièrement utile lors du travail sur des fichiers longs. La
fenêtre du projet Wave suit la tête de lecture (défile) au cours de la lecture.
Ce mode fonctionne également lorsque vous travaillez en mode à 2 ou 3 vues
d’un échantillon. Si vous avez fait un zoom avant dans l’une des vues, la tête de
lecture avance plus rapidement dans la vue, ce qui a pour effet d’actualiser plus
rapidement les formes d’ondes.
Le défilement automatique peut s’effectuer en deux modes:

Soft: L’option ‘Soft’ offre un défilement fluide de la totalité de la forme d’onde,
la tête de lecture restant au centre de l’écran. N’optez pour ce mode que si vous
disposez d’une carte graphique rapide parce que c’est la totalité de l’écran qui
défile entre les marqueurs.

Page: L’option ‘Page’ donne un défilement page par page.

Sachez que les ressources nécessaires au défilement automatique dépendent de votre
processeur, de votre carte graphique et de la résolution d’affichage. Pour cette raison,
vous risquez de rencontrer certaines interruptions de la lecture des fichiers audio. Si
cela se produit, désactivez le défilement automatique ou augmentez la taille de la
mémoire tampon ( ‘Options > Program Preferences > Advanced Buffer Settings’).

Vous pouvez commuter on/off le mode de défilement automatique via l’option
de menu «AutoScroll» (touche «Défilement»). L’option «AutoScroll Soft» (Shift
+ touche «Défilement») permet d’alterner le défilement entre mode «page» et
mode «soft».

Scrubbing
Le fait de maintenir enfoncée la touche 0 du pavé numérique (pavé numérique
activé) tout en déplaçant la souris sur l’axe gauche/droite vous permet d’effectuer
un repérage audio («scrub») à l’intérieur des projets. La lecture commence à
très basse vitesse, la position de la souris – par rapport à la tête de lecture –
déterminant la vitesse de repérage.
Il y a trois modes de repérage disponibles via cette fenêtre de dialogue:

Jogging: C’est la distance entre la tête de lecture et la souris qui détermine la
vitesse de lecture.

Two Speed: Le repérage se fait à deux vitesses. La vitesse de lecture normale
s’obtient en faisant rapidement glisser la souris sur le projet. Quand vous la
faites glisser lentement, la seconde vitesse est employée. Vous pouvez spécifier
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un facteur de vitesse de lecture (pour la seconde vitesse) dans le champ
numérique prévu à cet effet en fenêtre Playback Options. La valeur par défaut
est 0.125, c’est-à-dire 1/8ème de la vitesse normale.

Absolute: C’est la position de la souris dans la fenêtre qui détermine la vitesse
de lecture : Lorsque la souris est placée complètement à gauche, les données
audio sont lues en sens inverse à 2 fois la vitesse normale. Lorsque la souris est
placée complètement à droite, les données sont lues à 2 fois la vitesse normale.
Lorsque la souris est placée au centre de la fenêtre, la lecture des données
s’interrompt.
Le rééchantillonnage en temps réel s’accomplit quand on change la fréquence
d’échantillonnage de lecture. Cela se fait sans changer la fréquence
d’échantillonnage de la carte son. Pour les meilleures performances, utilisez
des buffers de lecture de petite taille et un processeur rapide.

Note: Le défilement est plus «fluide» lorsque vous diminuez la taille de la mémoire
tampon (4000, 2000 échantillons). Faites quelques essais préalables afin de connaître
les performances de votre ordinateur et, ainsi, de ne pas risquer d’interruption de la
lecture causée par un mauvais réglage des mémoires tampons.

Varipitch
Samplitude vous permet de modifier la hauteur des données audio (y compris
les projets multipistes) au cours même de la lecture.
Activez le mode varipitch (avec le bouton ‘active’). Cela vous permettra de régler
la vitesse de lecture des manières suivantes:

Curseur vertical: Permet de modifier la vitesse de lecture de -200 % à +200 %.

Pitch: Ce champ vous permet d’indiquer manuellement le facteur de variation
de vitesse.

Halftones: Indiquez ici le nombre de demi-tons souhaité pour la transposition.

Internal Rate: Ce champ affiche la fréquence d’échantillonnage interne utilisée
pour le calcul de varipitch. Si vous souhaitez lire un fichier WAV ayant une
fréquence d’échantillonnage de 48 kHz alors que votre carte son ne reconnaît
que le 44,1 kHz, réglez simplement la fréquence interne sur 48 kHz, puis activez
le variateur de vitesse. Vous entendez alors le fichier audio comme s’il était
réellement à la fréquence de 48 kHz.
Cette fonction est très utile pour  la lecture numérique de DAT à 44,1 kHz et
vice-versa.

BPM: Vous disposez de deux champs BPM. Indiquez le tempo de vos données
audio dans le champ BPM Orig et le tempo de destination souhaité dans le
champ BPM Out. Cette dernière valeur sera obtenue via la fonction varipitch.

Raccourci: P
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Playback Mode > Loop Mode
La lecture se fait en boucle, c’est-à-dire qu’elle reprend au début de la sélection
après avoir atteint la fin de celle-ci ou du projet.
Cet élément de menu est principalement présent pour y associer un raccourci
clavier. Vous pouvez aussi commuter on/off le mode de bouclage (Loop Mode)
via le bouton LOOP du panneau de transport.

Playback Mode > Change Play Direction
Cette commande permet de changer (inverser) le sens de la lecture.

Playback Mode > O-Tone Mode
Le mode O-Tone est un mode de lecture live spécial qui répond aux besoins des
éditeurs radio, mais qui est aussi utile dans d’autres situations.
Quand ce mode est activé, les objets de la première piste du VIP sont lus à la
suite. Au démarrage de la lecture, une zone comprenant (précisément) le premier
objet de la piste est sélectionnée et reproduit.
Quand la lecture s’arrête, c’est l’objet suivant qui est sélectionné. Quand la lecture
redémarre, c’est l’objet suivant qui est pareillement reproduit. Après la lecture
du dernier objet, c’est le premier qui est à nouveau sélectionné.
Cette facilité permet à des objets audio placés sur la piste (et séparés par des
pauses) d’être lus les uns après les autres, à la pression d’un bouton.
Il est également possible de lire des projets multipistes en mode O-Tone - des
sons Surround pour les salles de cinéma ou autres projets en temps réel, par
exemple. Seuls les objets de la première piste sont pris en compte, aussi veuillez
vous assurer que les objets sont placés sur la première piste.
En outre, le mode O-Tone Mode peut être utilisé lorsque le gestionnaire d’objets
est activé. Dans ce cas, l’objet suivant à mettre en lecture peut être rapidement
sélectionné via la liste des objets.
Ce mode de lecture est idéal pour mixer un discours en temps réel avec des
données préenregistrées.

Playback Mode > Auto scroll
Active/désactive le défilement automatique. Pour plus d’informations sur le
défilement automatique, veuillez lire la section «Autoscroll», dans le chapitre
Playback Options.

Raccourci: Défilement

Playback Mode > Autoscroll soft
Fait alterner le mode de défilement automatique entre mode «page» et mode
«soft». Pour plus d’informations sur le défilement automatique, veuillez lire la
section «Autoscroll», dans le chapitre Playback Options.

Raccourci: Shift + Défilement
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Scrubbing active
Active/désactive le repérage audio (scrub). Pour plus d’informations sur le
repérage audio, veuillez lire la section «Scrubbing», dans le chapitre Playback
Options.

Raccourci: Alt + Shift + Flèche vers le bas

Jog/Two Speed/Shuttle
Permettent de choisir l’un des trois modes de repérage audio (scrub). Ces
éléments de menu sont principalement destinés à être associés à des raccourcis
clavier. Pour plus d’informations sur le repérage audio, veuillez lire la section
«Scrubbing», dans le chapitre Playback Options.

Scrub left /right
Pour un repérage audio sur la gauche (left) et sur la droite (right) à l’aide du
clavier.

Raccourci: Scrub left Alt + Shift + Flèche vers la gauche
Raccourci: Scrub right Alt + Shift + Flèche vers la droite

Record
Cette commande lance immédiatement l’enregistrement.

Précision concernant l’enregistrement multipiste : Samplitude est capable d’enregistrer
simultanément autant de fichiers (pistes) que votre ou vos cartes son et votre ordinateur
le permettent.
Avant de lancer l’enregistrement, attribuez à chaque piste la carte son appropriée via
la fenêtre de dialogue Track Information ou par clic droit sur le bouton ‘R’ de la piste
de VIP.
Sélectionnez les pistes à enregistrer d’un clic gauche de souris.
L’enregistrement se déroule ensuite comme pour un enregistrement stéréo/mono.

Raccourci : R

Record Options
Cette commande ouvre la fenêtre paramètres d’enregistrement. Tous les réglages
d’enregistrement peuvent être faits ici. Une fois faits, vous n’avez plus à rouvrir
cette fenêtre, et vous pouvez enregistrer en pressant le bouton d’enregistrement
(Record) du panneau de transport ou en cliquant sur l’icône correspondante de
la barre d’outils.
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L’enregistrement et la lecture sont deux domaines indépendants qui sont mis en oeuvre
indépendamment. Cela vous permet de refermer la fenêtre d’enregistrement après que
l’enregistrement ait commencé. Quand la case «Update object during recording» est
cochée, vous voyez le matériel audio enregistré apparaître en temps réel dans le VIP.
Vous pouvez librement lire et éditer votre projet, pendant que l’enregistrement s’effectue
!
Attention: Comme vous pouvez lancer/arrêter la lecture du VIP, indépendamment
de l’enregistrement en tâche de fond, vous ne pouvez donc plus vous servir de la barre
d’espace pour arrêter l’enregistrement ! Pour cela, vous devez à nouveau cliquer sur
l’icône/bouton d’enregistrement (Record), ou rouvrir la fenêtre Record options et cliquer
sur «Stop» !

Raccourci: Shift +R

Tous les réglages nécessaires pour la majorité des opérations d’enregistrement
se configurent dans cette fenêtre.

Format
Vous pouvez choisir le format dans lequel enregistrer. Cela vous permet
d’enregistrer directement en format mp3 ou AIFF, par exemple. Le bouton
Format Options vous permet de sélectionner le format de données dans lequel
vous voulez sauvegarder – par exemple le débit ou la résolution d’échantillonnage.
Certains formats Internet (par ex. Real audio) ne peuvent être enregistrés que
tels quels – c’est-à-dire qu’ils sont «non éditables». Normalement, vous
n’utiliserez pas ces formats non éditables dans des projets, vous enregistrerez
l’audio au format wave et l’exporterez au format compressé après coup. En
enregistrant à un format compressé (par ex. «.wma»), vous évitez l’étape de
conversion supplémentaire. Il n’est pas possible de faire un enregistrement
multipiste en format compressé.
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Record Mode
Indiquez si vous souhaitez enregistrer en mono ou stéréo, si vous souhaitez
enregistrer vos données audio dans un projet RAM Wave ou sur le disque dur
sous forme de projet Wave. Indiquez enfin si vous souhaitez enregistrer en
mode 32 bits à virgule flottante, en mode 24 bits ou en mode 16 bits.

16 Bit: Cochez cette option pour enregistrer au format 16 bits.

24 Bit: Cochez cette option pour enregistrer au format 24 bits.

32 Bit Float: Cochez cette option pour enregistrer au format 32 bits à virgule
flottante (IEEE).

Stereo: Cochez cette option pour enregistrer une entrée stéréo dans un projet
Wave stéréo.

Mono: Cochez cette option pour enregistrer dans un projet Wave mono. Si
vous sélectionnez cette option, le sélecteur de périphérique d’enregistrement
audio passe aux périphériques mono, soit en réalité le canal gauche ou droit
d’une paire d’entrées stéréo. Veillez à sélectionner le bon (canal gauche ou droit)

Mono (Mix): Cochez cette option pour enregistrer une entrée stéréo dans un
projet Wave mono par addition des deux canaux et application d’une atténuation
de -6 dB.

Preload: Cochez cette option pour charger tous les buffers avant de débuter
l’enregistrement. Cela permet d’instantanément lancer l’enregistrement dès que
le bouton d’enregistrement Record est cliqué. Si cette option n’est pas cochée, il
y aura une courte pause (dépendant de la taille des buffers) avant que
l’enregistrement ne commence vraiment.

Sample Rate
Cette option vous permet de sélectionner la fréquence d’échantillonnage du
fichier audio à enregistrer. Les fréquences d’échantillonnage les plus
couramment utilisées sont proposées sous forme de boutons d’option. Vous
pouvez également saisir directement la fréquence d’échantillonnage souhaitée
dans le champ prévu à cet effet.

Important: Votre carte audio DOIT impérativement être capable d’enregistrer à la
fréquence d’échantillonnage sélectionnée ou l’enregistrement ne fonctionnera pas.

Resamp. to 44.1: Cochez cette option pour que Samplitude effectue une
conversion en temps réel à 44,1 kHz. Exemple : Une bande DAT est enregistrée
à la fréquence d’échantillonnage de 48 kHz. Pour masteriser la bande et la rendre
conforme à la norme Red Book en vue de la gravure d’un CD, il faut convertir la
bande DAT à 44,1 kHz. Samplitude vous permet d’effectuer cette conversion
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en temps réel au cours de l’enregistrement du DAT dans Samplitude.

Note: Le rééchantillonnage en temps réel n’est pas nécessairement la meilleure solution
à adopter.
Il faut savoir que Samplitude dispose d’algorithmes de plus haute qualité effectuant
de manière destructive une conversion de la fréquence d’échantillonnage une fois que
le fichier a été enregistré (ces algorithmes sont trop gourmands pour pouvoir être utilisés
en temps réel en cours d’enregistrement).

Record Start /Length
Le champ Record Length permet de choisir la durée de l’enregistrement en
heures, minutes, secondes et millisecondes. La prise s’arrêtera automatiquement
une fois la durée spécifiée écoulée. Pour activer cette fonction, cochez la case
«active», et saisissez la durée voulue dans le champ numérique.

Record Device and File path
Périphérique d’entrée: Dans la liste déroulante, sélectionnez le périphérique
(carte son) que vous souhaitez utiliser pour l’enregistrement. Plusieurs entrées
de carte son s’afficheront. Si nécessaire, cliquez sur le bouton «Info» pour afficher
les capacités d’enregistrement de la carte son sélectionnée. Cela vous donnera
des informations sur le pilote de la carte son et sur ses possibilités.
Fenêtre Record Devices: Vous pouvez personnaliser les noms des périphériques
ou désactiver des périphériques que vous n’utilisez jamais (menu Options >
System/Audio > onglet Record Devices).

Note: Si votre carte son n’apparaît pas dans la liste déroulante, allez dans System/
Audio (touche y) et vérifiez si le bon modèle de pilote est utilisé et si le périphérique est
activé. Il peut aussi être utile de presser ici le bouton Reset !

Chemin d’accès (icône de dossier): La fenêtre de dialogue qui s’ouvre permet
à l’utilisateur de déterminer le nom du projet Wave et sa destination sur le
disque dur. Le chemin d’accès à gauche du bouton indique la destination du
fichier audio à enregistrer. Si vous cliquez sur le bouton à dossier jaune, vous
pouvez choisir un nouveau nom ou un nouvel emplacement pour le fichier.
C’est une façon facile de redéfinir un dossier ou un disque dur de destination
pour le nouveau fichier audio. Si vous créez un nouveau nom, un nouveau
projet Wave avec ce nom sera initialisé. Habituellement, vous n’avez pas à
changer cela car vous pouvez définir des règles d’appellation automatique dans
la fenêtre Track Information.

Info (Fenêtre Record Capabilities)
Cette fenêtre vous permet de déterminer les capacités d’enregistrement du
périphérique d’enregistrement sélectionné.

Sample Rate/Resolution: Les cases des fréquences d’échantillonnage /
résolutions acceptées sont cochées. Pour les pilotes WDM, les capacités recensées
dépendant de l’activation ou non du mode de compatibilité WDM (dans les
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options System/Audio - Raccourci: y).

Zero Latency Monitoring (ZLM): Presser le bouton «Test ZLM Support»
indiquera si votre périphérique accepte ou non l’écoute de contrôle (monitoring)
sans latence (ZLM).

Device Info: Indique le nom du périphérique d’enregistrement. Vous pouvez
aussi changer le nom (employé par Samplitude) du périphérique
d’enregistrement, référencé dans les listes des fenêtres Track Information et
dans la table de mixage. (menu Options > «System/Audio» - Raccourci: y). La
version du pilote et des informations sur lui sont aussi affichées.

Open Windows Mixer: Ouvre le mode d’enregistrement de la table de mixage
multimédia Windows (si votre carte son en a une), vous permettant de
rapidement régler le niveau d’entrée.

Monitoring Mode / Monitor
La plupart des cartes son vous permettent de pré-écouter le signal audio que
vous allez enregistrer et (selon les caractéristiques de la carte son) vous pourrez
entendre le signal enregistré durant l’enregistrement. Pour plus d’informations
sur l’écoute de contrôle (monitoring), lisez le chapitre correspondant ci-dessous
(Menu Play/Rec ->Monitoring)

Playback while Recording
Cochez cette case pour enregistrer le projet Wave tout en écoutant les pistes
enregistrées auparavant.

Record Offset
Si vous avez défini un offset (décalage) d’enregistrement, Samplitude
compensera automatiquement ce décalage. Le champ numérique Record Offset
(Samples) vous permet de spécifier un offset calculé en nombre d’échantillons.
Dans de très rares cas et sur certains systèmes, il est nécessaire de compenser
certains retards dus à la lenteur de traitement ou à d’autres facteurs, comme la
capacité de la carte son à alterner entre lecture et enregistrement. Des retards
peuvent survenir entre l’enregistrement et la reproduction des données audio
lorsque l’option Playback while Recording est cochée. L’option Offset vous permet
alors de compenser ces retards. La plupart des retards se comblent avec des
valeurs comprises entre 20 et 2000 échantillons. Faites plusieurs tests afin de
déterminer le réglage le mieux adapté à votre périphérique/système.

Create Vip Object
Cochez cette option afin de créer automatiquement un objet (dans le VIP) après
avoir enregistré un nouveau projet Wave. Si vous cochez cette case, un nouvel
objet est créé après chaque prise et inséré sur la position de la tête de lecture
dans la ou les pistes activées en enregistrement. Si vous ne cochez pas cette
case, Samplitude ne crée aucun objet.
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Update Object during recording:
Permet la mise à jour en temps réel de l’objet enregistré dans le VIP. SI cette
option n’est pas cochée, l’objet n’est créé qu’une fois l’enregistrement terminé.

Read CD/DAT Marker
Si votre périphérique audio accepte l’entrée de marqueurs de CD ou DAT,
Samplitude notera leur position dans le projet enregistré. Cochez cette case
pour permettre la capture des marqueurs de CD/DAT.

Record Options > Extended Options
Plusieurs options supplémentaires sont offertes en cliquant sur le bouton
«Extended options»:

«Show small record window during recording/punch in recording»
Vous pouvez afficher une petite fenêtre d’enregistrement non modale avec les
commandes d’enregistrement principales durant l’enregistrement. Décochez
cette option si vous ne la voulez pas (comportement de la V.6).

«Each Record Take in a new file»
Cochez cette case pour que Samplitude crée un nouveau fichier pour chaque
prise. Ces projets Wave créés automatiquement portent le nom du projet Wave
d’origine et un suffixe «_Txxx», où XXX est l’identifiant de prise.

Set cursor to record end position
A la fin d’un enregistrement, la tête de lecture se déplacera à la fin de la partie
enregistrée. L’enregistrement suivant démarrera donc de cette position. Cela
simule l’enregistrement sur une machine à bande.
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Record button in Record Options can stop recording
Désactivez cette option si vous rencontrez des problèmes dus à un double clic
accidentel sur le bouton d’enregistrement (Record).

Show confirmation dialog (OK, delete) after record
Vous pouvez désactiver le message de confirmation «Use the recording or not?»
(Utiliser ou non l’enregistrement?) en décochant cette option si ce message
vous ennuie.

Resampling Quality
Accès rapide aux réglages de qualité de rééchantillonnage qui peuvent être
nécessaires pour le rééchantillonnage en temps réel, par exemple lors de
l’enregistrement d’un DAT dans un VIP à 44,1kHz.

Visualizer
Cliquez sur ce bouton pour ouvrir la fenêtre de visualisation (voir dans le menu
Window une description détaillée).
Afin d’économiser vos ressources système, vous pouvez désactiver cette fonction
si elle n’est pas cruciale pour l’enregistrement que vous avez à effectuer. Cela
peut être nécessaire si vous atteignez les limites de votre système.
Lors de l’enregistrement, les indicateurs de niveau réagissent assez lentement
parce qu’ils ne sont pas prioritaires. La tâche la plus importante consiste à ne
pas provoquer d’erreur d’enregistrement. Pour cette raison, les indicateurs de
niveau ne sont pas prioritaires afin de ne pas surcharger le système. Néanmoins,
toutes les valeurs affichées sont parfaitement correctes. Par ailleurs, plus vous
diminuez la taille de la mémoire tampon, plus les indicateurs de niveau sont
fréquemment actualisés (ils réagissent donc plus vite).

Conseil : Réglez le niveau du signal d’entrée de sorte que le segment 0 dB soit presque
atteint sur les passages les plus forts. Le niveau du signal d’entrée doit être réglé à la
source ou depuis une console de mixage. Certaines cartes son vous permettent de
régler le niveau du signal d’entrée.

Comme pour tous les signaux audionumériques, les signaux de niveau supérieur
à 0 dB sont victimes d’un écrêtage, produisant une distorsion affreuse. Si cela
se produit durant l’enregistrement, vous devrez probablement refaire la prise.
Cependant, si l’enregistrement de la prise est fini, nous vous conseillons d’écouter
le fichier avant de le supprimer –la section saturée peut s’avérer exploitable.

Note: Samplitude offre une excellente fonction de-clipping (suppression d’écrêtage)
dans le menu Offline Effects qui permet de réparer les données audio dans les cas où il
n’est pas possible de procéder à un réenregistrement des données. Toutefois, cette fonction
ne doit être utilisée qu’en dernier recours – dans la mesure du possible, mieux vaut
toujours éviter tout écrêtage du signal en cours d’enregistrement !

Reset Pk
Cliquez sur ce bouton pour réinitialiser les diodes des crête-mètres sur off.
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Record Information
Cette section contient 3 compteurs numériques indiquant les informations
suivantes:

Record Time: Ce compteur vous indique la durée de l’enregistrement en cours
en heures, minutes, secondes et millisecondes.

Remain. Time: Ce compteur indique l’espace encore disponible sur le disque
dur en termes d’unités de temps. Ce compteur est actualisé en temps réel durant
l’enregistrement.

Disk Space: Ce compteur indique l’espace disponible pour l’enregistrement
sur la partition spécifiée en heures, minutes, secondes et millisecondes.

Take
Un nom de prise («Take») peut être donné à l’objet avant de lancer
l’enregistrement. Cela peut se faire en saisissant un nom dans le champ de
texte situé immédiatement à droite du bouton «Take ». Chaque prise portera
ce nom et un numéro de prise croissant. Quand on clique sur le bouton Take +
situé à gauche de la case de texte, le numéro de prise augmente d’une unité.

Marker
Vous pouvez placer des marqueurs dans le projet durant l’enregistrement. La
position actuelle du curseur est utilisée pour insérer des marqueurs là où vous
pourrez par la suite les sélectionner pour des nettoyages ou tâches similaires.
Chaque marqueur peut être nommé (si vous en avez le temps !) en saisissant un
nom dans le champ de texte adjacent.

Bouton Record
Ce bouton lance l’enregistrement.

Bouton Record Pause
Ce bouton met en pause l’enregistrement jusqu’à ce qu’il soit à nouveau pressé.

Bouton Stop
Ce bouton arrête l’enregistrement. Samplitude vous demande alors si vous
souhaitez conserver l’enregistrement effectué ou le supprimer.
En cas de surcharge de votre ordinateur due à l’échange des données ou aux
accès disque, arrêtez simplement l’enregistrement par un clic sur le bouton
droit de la souris ou en appuyant sur la barre d’espace.

Track
Vous pouvez passer d’une piste à l’autre et ainsi régler les paramètres
d’enregistrement pour toutes les pistes d’un coup.
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Close
Ce bouton ferme la fenêtre. Vous pouvez ouvrir et fermer cette fenêtre sans que
cela n’affecte l’enregistrement en cours !

Record Mode/Punch In > Record without Playback / Playback
while Recording
Permet de faire alterner l’enregistrement avec ou sans lecture des autres pistes
(non armées pour l’enregistrement).
Cet élément de menu est principalement présent pour y associer un raccourci
clavier. Vous pouvez aussi changer le mode d’enregistrement via le menu Audio
du panneau de Transport.

Record Mode/Punch In> Punch In Mode
Cette commande active le mode d’enregistrement à la volée (Punch-In/Out). Ce
mode permet le déclenchement et la suspension en temps réel ou automatique
de l’enregistrement en des points spécifiques sur la ligne de temps (timeline).
Lorsque vous êtes en mode d’enregistrement à la volée, la commande Punch-In
Record permet de basculer automatiquement en enregistrement au cours de la
lecture.
La possibilité de prédéterminer puis d’automatiser la procédure d’enregistrement
est très utile pour les musiciens ou compositeurs qui travaillent seuls. En outre,
la sélection des points de Punch-In et de Punch-Out peut être faite à l’échantillon
près, permettant une extrême précision du déclenchement et de l’arrêt de
l’enregistrement.
La barre d’outils du mode d’enregistrement à la volée représentée ci-dessous est
très utile lorsque vous travaillez en mode d’enregistrement à la volée.
Le mode d’enregistrement à la volée nécessite que vous armiez une ou plusieurs
pistes en enregistrement. Les pistes doivent être ensuite configurées comme
pour un enregistrement multipiste – attribuez à chacune des pistes un pilote de
carte son différent. Cliquez avec le bouton droit de la souris sur le bouton ‘R’ de
chaque piste pour accéder aux réglages correspondants.
L’enregistrement à la volée peut se faire de deux façons:

Enregistrement à la volée ‘en direct’
Dans ce mode, vous pouvez lancer l’enregistrement à la volée (punch in) à
n’importe quel moment de la lecture. Une fois que vous êtes en enregistrement,
vous pouvez l’arrêter à tout instant (punch out). L’enregistrement s’arrête alors,
mais la lecture continue.
Cette méthode se rapproche beaucoup des magnétophones multipistes à bandes
qui permettent de corriger les erreurs éventuelles en réenregistrant certains
passages de la bande.
Activez Punch-in Mode. Lancez simplement la lecture à l’aide de la barre
d’espace. Il suffit de lancer l’enregistrement à la volée via le bouton Punch In
Record de la barre d’outils. Cliquez une seconde fois sur ce même bouton pour
arrêter l’enregistrement et repasser en lecture. Pour arrêter la lecture, appuyez
sur la barre d’espace.
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(La même fonction est obtenue en cliquant sur le bouton Punch-In Record dédié,
qui est maintenant obsolète mais reste conservé par commodité)

Enregistrement à la volée par le biais de marqueurs
Ce second mode permet de basculer automatiquement en enregistrement lorsque
la tête de lecture atteint le marqueur d’entrée et de rebasculer automatiquement
en lecture au niveau du marqueur de sortie. Ce mode d’enregistrement à la
volée est davantage automatisé et très utile pour les musiciens ou compositeurs
qui travaillent seuls.
En prédéterminant les points d’entrée/sortie (In/Out), cette méthode élimine
aussi les risques liés à des déclenchements manuels mal placés. Le travail avec
les marqueurs vous permet de spécifier (à l’échantillon près) les points exacts
où l’enregistrement doit démarrer et s’arrêter.
Comme l’enregistrement se fait de façon non linéaire et non destructive, vous
avez l’entière possibilité d’annuler ou de reprendre n’importe quelle erreur sans
aucun problème et de retrouver les données précédentes.
Pour effectuer un enregistrement dans ce mode, commencez par délimiter une
sélection temporelle (Range) dont le début et la fin fixeront seront le point de
départ et le point de fin de l’enregistrement. Samplitude arrêtera ainsi la lecture
au niveau de la fin de la sélection (si aucune sélection n’est délimitée, vous
devrez arrêter manuellement la lecture après la sortie du mode d’enregistrement).
Les fonctions Set Punch-In et Set Punch-Out indiquent à Samplitude où basculer
en enregistrement et où repasser en lecture.
Amenez ensuite la tête de lecture à l’endroit souhaité avant le marqueur d’entrée
(établi avec Set punch-In) et lancez la lecture/enregistrement à l’aide du bouton
Punch Record se trouvant dans la barre d’outils Punch.
Note: Avant d’effectuer un enregistrement à la volée, il est très utile d‘activer le mode
Auto Crossfade (en cliquant sur le bouton correspondant de la barre d’outils de
Samplitude). Le fondu-enchaîné automatique créera automatiquement des transitions
douces entre les prises.

Suppression ou réaffectation des marqueurs d’entrée/sortie
Pour réaffecter les marqueurs d’entrée/sortie, il suffit de placer la tête de lecture
à l’endroit souhaité, puis de cliquer sur le bouton correspondant de la barre
d’outils. Pour supprimer les marqueurs d’entrée/sortie, cliquez sur le bouton
Remove Punch In / Out Marker de la barre d’outils ou sur l’option Play/Rec >
Remove Punch In/Out Markers décrite ci-dessous.

Enregistrement à la volée en boucle
Il est également possible d’effectuer un enregistrement à la volée en boucle.
Délimitez simplement une sélection au-dessus de la région que vous souhaitez
enregistrer. Cette sélection est lue en boucle jusqu’à ce que vous l’arrêtiez avec
la barre d’espace.
À chaque passage une nouvelle prise s’enregistre entre les marqueurs. Servez-
vous ensuite du gestionnaire de prises (Take Manager) pour choisir la meilleure
prise une fois l’enregistrement terminé.
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Record Mode/Punch In > Set Start/End Marker, Remove Punch
In/Out Markers
Pour réaffecter les marqueurs d’entrée/sortie, il suffit de placer la tête de lecture
à l’endroit souhaité, puis de cliquer sur le bouton correspondant de la barre
d’outils. Pour supprimer les marqueurs d’entrée/sortie, cliquez sur le bouton
Remove Punch In / Out Marker de la barre d’outils.
Ces éléments de menu sont principalement présents pour y associer un raccourci
clavier. Vous pouvez aussi placer des marqueurs d’enregistrement à la volée en
cliquant sur les boutons In et Out du panneau de transport.

Record Mode/Punch In > Additional Punch Start/End Marker,
Remove Additional Punch Markers
Vous pouvez définir plusieurs plages d’enregistrement à la volée dans le projet,
pour pouvoir faire plusieurs enregistrements à la volée d’un coup. Ces éléments
de menu sont principalement présents pour y associer un raccourci clavier. Vous
pouvez placer des marqueurs supplémentaires pour d’autres enregistrements à
la volée en pressant Alt et en cliquant sur les boutons In et Out du panneau de
transport.
Ou bien placez des marqueurs supplémentaires pour d’autres enregistrements
à la volée en plaçant la tête de lecture à l’endroit souhaité, puis en cliquant sur
les boutons In/Out (panneau de transport) tout en pressant la touche Alt.

Record Mode/Punch In > Live Input Mode
Voici encore une fonction très puissante de Samplitude – le mode d’entrée directe
(Live Input Mode).
Il vous permet de mixer les entrées directes de la carte son via la table de mixage
en temps réel.
Cette commande transforme Samplitude en véritable console de mixage
numérique complète en temps réel,  dotée d’un nombre de voies illimité, d’un
traitement interne en 32 bits, d’entrées/sorties externes 24 bits (vous avez besoin,
pour cela, de cartes son compatibles) et d’effets, y compris des plug-ins de tierces
parties !

Principes
Le mode entrée directe (Live Input Mode) est assez similaire à l’enregistrement
avec plusieurs entrées de carte son. Toutes les voies/pistes à utiliser pour le
mixage en direct doivent être armées en enregistrement – configurez chacune
des pistes sur la carte son souhaitée et activez sur leur bouton d’armement «R».
Dès que vous lancez la lecture du VIP, les signaux connectés aux entrées de
votre ou vos cartes son sont dirigés vers la table de mixage. Servez-vous alors
des commandes de la table de mixage pour faire vos réglages de mixage. Il est
en outre possible de relire n’importe quel objet de VIP simultanément au mixage
des signaux directs.

Latence
Le traitement des signaux audio prend bien évidemment du temps. Vous risquez
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de rencontrer certains problèmes de décalage (ou retard) entre le signal de sortie
et le signal d’entrée. Ce temps de retard (latence) dépend principalement de la
taille de la mémoire tampon VIP Buffer. Diminuez cette taille pour réduire les
problèmes de latence.
Indiquez des valeurs qui permettent au logiciel de traiter en temps réel les signaux
audio sans provoquer d’erreur, ou d’artefacts audio. 4 mémoires tampons d’une
taille de 8000 échantillons stéréo entraînent un retard de 0,7 seconde. Le fait
de réduire cette taille à 2000 échantillons ramène ce retard à seulement
0,2 seconde.
Faites des tests avec différentes tailles et nombres pour optimiser ces réglages
selon les performances de votre ordinateur.
Sur certains systèmes, la latence peut être telle qu’elle ne permet pas d’utiliser
le mode d’entrée directe (Live Input Mode) comme remplacement d’une console
de mixage analogique.

Applications
Voici certaines applications que vous propose le mode entrée directe (Live Input
Mode):

Console de mixage numérique pour ADAT (ou tout autre
magnétophone multipiste).
Lors de la lecture d’une bande ADAT, les 8 pistes sont transférées via une carte
audionumérique et traitées par la table de mixage en temps réel de Samplitude.
Comme le transfert se fait en numérique, les données audio ne subissent aucune
dégradation et le temps de latence n’a pas d’importance car la bande ADAT n’a
aucune fonction « temps réel».

Application d’effets et mixage en cours d’enregistrement
Utilisez la fonction «Mix in File» de la table de mixage pour créer un nouveau
fichier WAV à partir du signal Master. Cela permet à Samplitude d’enregistrer
un fichier audio via la table de mixage. N’oubliez pas de renommer ensuite le
fichier audio obtenu, sinon vous allez effacer les données qu’il contient lors du
mixage suivant.

Utilisation de Samplitude comme processeur d’effets
Si vous recherchez des traitements que votre rack d’effets ne peut pas fournir,
vous pouvez employer les effets intégrés de Samplitude. Il est possible de traiter
en direct un signal «live» par le correcteur FFT, le correcteur de dynamique
multibande, l’Enhancer stéréo ou bien les nombreux plug-ins disponibles.

Monitoring
La compatibilité avec les pilotes ASIO offre désormais une plus grande souplesse
en matière d’écoute des signaux d’entrée.

Input monitoring
Active/désactive l’écoute des entrées (en fonction de l’état du bouton «REC M»
du panneau de transport). Sont audibles les signaux audio des pistes armées en
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enregistrement (bouton REC allumé dans le VIP) en fonction du type d’écoute
choisi pour le signal de sortie. Les crête-mètres à DEL du VIP et de la table de
mixage réagissent alors au signal d’entrée.

Tape monitoring
Mode d’écoute par défaut de type magnétophone, utilisé sur les anciennes
versions de Samplitude:
À l’arrêt, c’est le signal d’entrée qui est audible. En lecture, c’est le signal des
pistes qui est joué. En enregistrement, c’est le signal d’entrée qui est audible,
sauf si l’enregistrement s’effectue à la volée (Punch-In), auquel cas c’est
uniquement entre les marqueurs d’enregistrement à la volée que le signal
d’entrée est audible; sur le reste du morceau, c’est le signal des pistes qui est
relu). Si l’option est désactivée, c’est à l’utilisateur de choisir si le signal d’entrée
doit être affiché. Servez-vous du bouton «Force monitoring» (petit bouton en
forme de haut-parleur situé à côté/au-dessous du crête-mètre dans le VIP/ la
table de mixage).

Hardware Monitoring / Software Monitoring / Software FX
Monitoring
Le signal d’entrée n’est donné que pour le mode d’écoute en vigueur. Néanmoins,
le crête-mètre fonctionne toujours. Le fait de choisir un mode d’écoute active
l’écoute audio.

Hardware Monitoring
Avec des pilotes MME, c’est le seul mode d’écoute possible dans Samplitude. Il
faut en outre que le périphérique audio autorise le monitoring direct sans latence
(ZLM: Zero Latency Monitoring). Vous pouvez bien entendu décaler un signal
d’écoute dans le mélangeur multimédia de Windows hors de Samplitude.
Toutefois, ce mode est incompatible avec les fonctions d’enregistrement à la
volée (punch-in).

Software Monitoring / Software FX Monitoring
Sur les cartes dotées de pilotes ASIO, il est possible d’utiliser le mode d’écoute
logicielle (software monitoring) si la carte ne permet pas écoute matérielle
(hardware monitoring) ou monitoring direct ASIO (ASIO Direct Monitoring).
Le mode Software FX monitoring calcule et intègre les effets de la piste dans le
signal d’écoute à l’exception de tous les effets à haute latence comme le filtre
FFT, le Dehisser ou le Vocoder. Le simulateur d’ampli est par contre pris en
compte. Samplitude peut donc servir de module d’effets utilisable en temps
réel.
Si vous avez besoin d’entendre tous les effets de la table de mixage, servez-vous
du mode entrée directe traditionnel (Live Input mode), qui fonctionne sans ASIO,
mais qui souffre de latences plus élevées.
Sachez également que le mode software FX monitoring doit être activé avant de
pouvoir jouer des instruments VST en temps réel via le port MIDI IN.
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New MIDI Object
Un nouvel objet MIDI est créé sur la piste sélectionnée. Après avoir utilisé cette
commande, vous pouvez choisir un modèle MIDI pré-établi (dans le sous-dossier
«Templates» du dossier Samplitude) dans le petit menu contextuel qui s’affiche.
Il répertorie les fichiers MIDI standards (SMF) qui peuvent être copiés dans ce
dossier ou directement exportés depuis Samplitude comme modèle ou
«template». S’il n’y a qu’un fichier dans la liste des modèles, aucun menu
n’apparaît – l’objet est immédiatement créé.

MIDI Editor
Cette commande ouvre l’éditeur MIDI. Ici, vous pouvez visualiser et éditer le
contenu de l’objet MIDI sélectionné dans le VIP.
Si aucun objet MIDI n’est sélectionné, il vous sera demandé si vous désirez en
ajouter un. Confirmez avec «OK» pour ajouter un objet MIDI dans la piste à la
position actuelle du curseur ou au début d’une sélection.

Pour plus d’informations sur l’éditeur MIDI, référez-vous au chapitre «Travail avec
l’éditeur MIDI».

Object Editor
Veuillez vous référer à la section correspondante du chapitre «Menu Object».

Raccourci clavier: Ctrl+O

Glue MIDI Objects
Cette commande vous permet de coller ensemble deux objets MIDI consécutifs
ou plus dans une piste. Comme pour la version audio de cette commande (Glue
Objects du menu «Object»), tous les effets d’objet des objets suivants sont perdus.
Ainsi, un objet bouclé peut être transformé en un nouvel objet MIDI. Par
exemple, vous pouvez créer de «vraies» données MIDI à partir d’un pattern de
batterie mis en boucle pour travailler plus en détail sur ces données.

Trim MIDI Objects
Si un objet MIDI ne se réfère qu’à une section d’un fichier ou d’un
enregistrement MIDI, cela est représenté graphiquement dans l’éditeur MIDI
par du grisé; les zones non utilisées restent disponibles dans l’objet MIDI et
permettent par exemple de changer ultérieurement la longueur de l’objet.
Cette commande supprime les données MIDI non utilisées pour accroître la
vue d’ensemble dans le projet.

MIDI Bouncing
Tous les objets MIDI sélectionnés sont reportés dans un nouvel objet MIDI
incluant tous les effets d’objet et de piste.
Vous pouvez choisir entre «whole Project» (tous les objets du projet) et «Sel. In
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Range» (seulement les objets appartenant à la sélection).

Whole Project: Toutes les données MIDI sont mixées ensemble. Les effets de
piste et d’objet sont pris en compte. Un nouvel objet MIDI est créé dans la piste
sélectionnée. Les objets reportés sont ensuite supprimés.

Sel. In Range: Tous les objets sélectionnés dans la sélection temporelle (Range)
actuelle sont reportés. Les effets de piste et d’objet sont pris en compte. Un
nouvel objet MIDI est créé dans la piste sélectionnée. Les objets reportés ne
sont pas supprimés.

Track Information
Veuillez vous référer à la section correspondante du chapitre «Menu Track».

Raccourci clavier: Alt+i

Track MIDI Record
Le mode d’enregistrement MIDI est activé pour la piste sélectionnée.

MIDI Controllers
Veuillez vous référer au chapitre «MIDI».

Raccourci clavier: Ctrl+Alt+A

VST-Instrument Editor
Veuillez vous référer à la section correspondante du chapitre «Menu Track».

Tempo/Beat markers
Lisez le paragraphe « Changements de tempo et de mesure» du chapitre «MIDI».

Place new tempo marker
Lisez le paragraphe « Changements de tempo et de mesure» du chapitre «MIDI».

Place new beat marker
Lisez le paragraphe « Changements de tempo et de mesure» du chapitre «MIDI».

Place new beat position marker
Lisez le paragraphe « Changements de tempo et de mesure» du chapitre «MIDI».

Ignore all Tempo markers, use project tempo
Cette commande invalide temporairement tous les réglages de marqueurs de
tempo. Pour tous les affichages dépendants du tempo (magnétisme et grille),
seul le tempo du projet est utilisé.

Metronome active
Active/désactive le métronome audio/MIDI. Vous pouvez aussi cliquer sur le
bouton Click du panneau de transport.
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Metronome Options
Veuillez vous référer à la section correspondante du chapitre «Menu Options».

MIDI Options
Veuillez vous référer à la section correspondante du chapitre «Menu Options».

MIDI Record Mode
Cette commande choisit le mode d’enregistrement MIDI qui définit comment
les nouvelles données MIDI enregistrées seront insérées dans le VIP s’il existe
déjà des objets MIDI sur la position d’enregistrement.

Normal
Le mode d’enregistrement correspond à l’enregistrement audio, c’est-à-dire qu’un
nouvel objet MIDI est créé par dessus l’objet existant à chaque enregistrement.
Les anciens objets sont conservés. Ainsi vous pouvez enregistrer plusieurs prises
d’un passage et les comparer après coup.

Overdub
Les données MIDI sont enregistrées dans l’objet existant; les nouvelles données
sont mélangées avec les données existantes. Si un enregistrement s’étend sur
plusieurs objets MIDI, ceux-ci sont alors réunis en un seul.

Multi-Overdub
Les nouvelles données sont aussi mélangées avec les données existantes;
toutefois, chaque objet est conservé.

Replace
Les données MIDI des objets existants sont remplacées. Si un enregistrement
s’étend sur plusieurs objets MIDI, ceux-ci sont alors réunis en un seul.
Contrairement à l’enregistrement audio, les objets MIDI déjà présents sur la
piste d’enregistrement sont lus en mode «Playback while recording». Cela signifie
que vous pouvez toujours choisir un des modes d’enregistrement après avoir
terminé un enregistrement réussi.
Note: Le mode d’enregistrement MIDI (MIDI Record Mode) est aussi visible
dans le panneau de transport développé et peut y être sélectionné.

MIDI Panic – All notes off
Cette commande envoie un message de relâchement (note off) pour les 128
notes des 16 canaux, à l’exclusion de tous les périphériques MIDI désactivés
dans les options MIDI. De plus, le sustain (commande 64) est désactivé et le
pitch bend comme la modulation sont ramenés à 0. Une commande all-notes-
off est aussi envoyée à tous les VSTi utilisés par le projet.
Si des pistes ou objets MIDI sont disponibles dans le projet, la même fonction
est accessible en cliquant sur le bouton «Stop» dans le panneau de transport ou
la barre d’outils (si le projet est à l’arrêt).
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Project Properties

Cette commande vous permet de configurer facilement différents modes,
paramètres et options.

Project Properties > Mixer Setup
Cette commande ouvre la fenêtre Project Mixer Setup (configuration de la table
de mixage), où vous pouvez définir l’architecture de mixage. Veuillez vous
reporter au chapitre consacré à la table de mixage pour obtenir de plus amples
détails.
Cette fenêtre vous permet de facilement configurer, sauvegarder et recharger
les réglages de VIP et de table de mixage.
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Project and Mixer Configuration:
Utilisez ce cadre pour établir le nombre de pistes, bus AUX et bus submix.
Vous pouvez aussi définir le routage des effets et du signal pour les pistes et
pour le Master.
La fenêtre de la première piste est toujours ouverte pour le routage d’effets des
pistes/bus individuels (FX Routing). Pour réinitialiser les réglages de toutes les
pistes, vous devez cliquer sur le bouton «All Tracks» correspondant dans la
fenêtre «Effect Routing».
Il existe deux autres options à côté des boutons de routage:
– use Advanced Dynamics for Mixer «Dyn.Limiter»: Dans la section Master de

la table de mixage, le processeur de dynamique «normal», moins gourmand
en ressources, peut être utilisé (case non cochée) comme processeur Dyn./
Limiter à la place du processeur Avanced Dynamics de meilleure qualité.

– automatic latency compensation: Active la compensation automatique de
latence pour les plug-ins DirectX et VST. Cette option est cochée par défaut.

Routage de sortie du signal pour la section Master
– Keep current setting: Chaque piste est assignée à un périphérique audio (ou

à un bus submix). Le mixage final prend alors place dans un équipement
externe ou sur la carte son.

– Stereo Master: Le mixage normal se fait dans la section Master stéréo de
Samplitude. Si votre carte son propose plusieurs périphériques, sélectionnez-
en un dans la table de mixage (sous les faders de volume) ou dans les
paramètres de lecture (Raccourci: «P»).

– Surround Master: Si ce réglage est choisi, les canaux Master sont fournis
pour un mastering en surround 5.1. Lisez le chapitre «Son Surround» pour
plus d’informations.

Keep current number (tracks, Submix busses et AUX busses)
En cochant cette case, vous pouvez empêcher les réglages actuels d’être écrasés
lors du chargement d’un preset de table de mixage. L’état de ces cases à cocher
est aussi enregistré quand vous sauvegardez un preset. Par conséquent, si vous
voulez rapidement ajouter quelques pistes, (par ex. 4 bus AUX et 4 bus submix),
il vous suffit de charger le preset «4 Busses +4 Auxes».
Ainsi, lors du chargement d’un preset, des pistes et bus sont ajoutés si  leur case
n’est pas cochée. En d’autres termes: cochez avant de sauvegarder ceux des
réglages qui ne doivent pas être inclus dans le preset.

Device Setup (track in/output assignment, routing)
Dans cette section, vous pouvez de façon pratique sélectionner le périphérique
d’entrée et de sortie pour plusieurs pistes simultanément.

I/O Devices: Définit le routage pour la lecture (Playback), l’enregistrement
(Record) ou les deux.
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Track number (0 for all): Start with track (0 for active track):
Ces options permettent un changement du routage d’entrée/sortie pour un
certain nombre de pistes. Si vous réglez le numéro de piste (track number) sur
4 et le démarrage (start with track) sur 8, la configuration de routage sélectionnée
est appliquée aux pistes 8-12.

Routing
Keep current setup: Aucune assignation de routage n’entre en oeuvre si un
preset est chargé.

Assign all tracks to stereo master: Toutes les pistes (dont les bus AUX et
Submix) sont dirigées vers le Master. Les réglages de panoramique sont
alternativement faits sur gauche et droite avec L/R panning. Utilisez ce choix si
vous enregistrez des sources stéréo comme paires mono.

Assign all tracks to different mono/stereo devices: Toutes les pistes sont
assignées aux différents périphériques de sortie. En fenêtre System/Audio
(Raccourci: «Y»), vous pouvez définir quels périphériques sont disponibles dans
Samplitude et lesquels ne le sont pas. En cas de routage vers des périphériques
mono, les pistes sont aussi placées alternativement à gauche/droite dans l’espace
panoramique.

Use saved setup or preset: Les réglages sauvegardés dans le preset sont utilisés.

Project Properties > Playback Options
Cette commande ouvre la fenêtre Play Parameter des réglages de lecture
(Raccourci: «P»). Veuillez vous référer à la section correspondante du menu
Play/Rec pour plus de détails.

Project Properties > Media Link
Quasiment tous les fichiers de média peuvent être associés aux projets de
Samplitude. Ce peut être, par exemple, des morceaux ou des séquences MIDI
complètes (fichiers *.MID), des clips vidéo (fichiers *.AVI ou MPEG) ou tout
autre fichier disposant d’un pilote MCI sous Windows, soit pratiquement tous
les formats que le lecteur Windows Media peut reproduire.
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Le lien («Link») signifie que les fichiers média liés sont lus simultanément au
projet de Samplitude et qu’aucune synchronisation ne s’effectue. La position
temporelle n’est pas directement vérifiée. Samplitude utilise le lecteur Windows
Media pour la lecture, qui lance et arrête simplement le fichier sélectionné.
Quand le lecteur reproduit le fichier AVI ou MIDI, le fichier doit être sauvegardé
sur votre poste de travail.
Cette option ne vous permet pas de synchroniser des appareils externes avec
Samplitude. S’il vous faut cette synchronisation, veuillez vous reporter au chapitre
intitulé «Synchronisation» pour toute information sur les fonctions
conventionnelles de synchronisation par SMPTE, MMC et MTC.
Samplitude peut charger des fichiers MIDI et apporter de pratiques fonctions
d’édition. Il n’est plus nécessaire de lier les fichiers MIDI, même si c’est toujours
possible. La lecture n’est alors pas effectuée par Samplitude, mais par le sous-
système multimédia de Windows. Le périphérique de sortie est réglé dans le
panneau de configuration. Sachez que le synthétiseur GS Microsoft
fréquemment employé en standard pour la sortie MIDI empêche l’emploi de
pilotes ASIO pour de nombreuses cartes son.

Liaison des projets de Samplitude à des vidéos
Media Link permet d’ajouter des bandes son à des vidéos en temps réel avec
Samplitude sans recours à un équipement de synchronisation supplémentaire.
En théorie, il est possible de travailler directement avec des vidéos numériques
à leur résolution d’origine. Toutefois, pour assurer une synchronisation optimale
et un flux de production régulier, la procédure suivante est recommandée:
1. Numérisez votre matériau source avec le logiciel d’édition vidéo «MAGIX

Move Edit Pro» (fourni avec Samplitude Professional) et exportez une vidéo
pilote de petite taille, à l’aide d’un codec adapté nécessitant peu de ressources
pour la décompression, ne contenant si possible que des images principales
ou «key frames» (le DiVX ou le MPEG ne conviennent pas). Le format MXV
de MAGIX est recommandé, car il est optimisé pour le traitement en temps
réel.

2. Liez la vidéo à Samplitude et appliquez la bande originale.
3. Supprimez la liaison après le report de pistes.
4. Remplacez ou intégrez le projet Wave fini dans la vidéo avec la fonction

«Replace Audio in Video». Vous pouvez alors sauvegarder le son dans le film
d’origine en haute résolution sans recompression (la bande son doit juste
être échangée). Vous trouverez plus de détails dans menu «File» -> Export
video sound...

File Name: Vous permet de spécifier le nom de fichier, et le dossier source du
fichier média que vous désirez lier au projet. Cliquez sur le bouton en forme de
dossier pour afficher une fenêtre de sélection vous permettant de naviguer dans
vos disques durs et de spécifier le type de fichier média. Une fois que vous avez
trouvé le fichier média désiré, cliquez sur OK pour que Samplitude fasse le lien.
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SMPTE Offset: Ce champ vous permet d’indiquer une heure de départ différente
pour le fichier média. La position zéro est la position par défaut. Autrement dit,
le fichier média démarre au point zéro, ce qui correspond au début du fichier. Si
vous indiquez une valeur d’offset différente de zéro, la lecture du fichier média
démarre à la position correspondante.
Par exemple, imaginons que vous travaillez sur la bande-son d’un fichier AVI et
cette bande son ne commence que 15 minutes après le début du fichier AVI. Il
n’est pas nécessaire de créer un espace de 15 minutes au début du projet VIP
pour caler les images AVI et les données audio.
La meilleure alternative consiste à saisir un offset (ou décalage) de 15 minutes.
Ainsi, le fichier AVI démarre 15 minutes après le début du fichier audio alors
que les données audio de Samplitude commencent, quant à elles, à la position
zéro.
Afin de faciliter votre travail, pensez à toujours noter par écrit les réglages d’offset
de chaque projet.

Play file always: Cochez cette case pour que la lecture du fichier média
redémarre à chaque fois que vous lancez l’enregistrement ou la lecture dans
Samplitude. Si cette case n’est pas cochée, Samplitude ne relit pas le fichier
média (c’est une méthode simple et rapide de couper la lecture du fichier média).

Load file always new: Cochez cette case pour que Samplitude charge toujours
le fichier média sélectionné à chaque lecture ou enregistrement de votre VIP ou
projet Wave. Si cette case n’est pas cochée, seules les données en mémoire du
fichier média sont lues. Si le fichier média est trop volumineux pour les mémoires
tampons, il est lu directement depuis le disque dur.

Synchronization to Audio playback: Lorsque cette case est cochée,
Samplitude synchronise le fichier média lié (fichier AVI, par exemple) au VIP
existant.

Extract Audio from Video: Si le fichier média est de type AVI comportant
audio et vidéo, ce bouton permet d’extraire la bande-son du film et de la
transformer en projet Wave. Ceci vous permet de modifier ensuite la bande–
son du film sans toucher au reste du fichier.
Vous pouvez aussi directement éditer les données audio dans un fichier vidéo
(sans créer de projet Wave représentant une copie des données audio du fichier
vidéo). Ouvrez juste un fichier AVI avec menu File –> Open Project –> HD
Wave....

Replace Audio in Video: Ce bouton lance la fonction Export Video Sound
pour remplacer les données audio du fichier AVI existant ou pour créer un
nouveau fichier AVI avec les nouvelles données audio.

Play Video Without Sound: Cette option ne porte que sur les fichiers AVI.
Elle permet de couper la bande son des fichiers AVI, si celle-ci perturbe la lecture
audio de Samplitude. Pour cette raison, nous vous recommandons de couper le
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son du fichier AVI.

Video in Samplitude Window: Cette fonction ne s’applique qu’aux fichiers
AVI. En temps normal, le fichier AVI est lu dans une fenêtre complètement
indépendante. Autrement dit, vous ne pouvez pas voir le film si la fenêtre de
Samplitude occupe tout l’écran. Il faut alors réduire la fenêtre de Samplitude ou
la redimensionner.
Par contre, en cochant cette case, le film AVI est lu dans une fenêtre située à
l’intérieur de Samplitude et placée au-dessus de toutes les pistes audio. Cette
méthode permet de toujours afficher le film AVI en lecture comme en
enregistrement.

Show Video Track: Cette option vous permet d’afficher à l’intérieur de la fenêtre
VIP une piste vidéo indiquant chaque image du fichier AVI.
Dans le coin supérieur gauche de la fenêtre VIP, l’image affichée est celle
correspondant à l’emplacement où le curseur de lecture est cliqué/positionné
dans les pistes du VIP. Cela vous permet de placer précisément les événements
audio et autres éléments, sur des positions d’image exactes.
Si vous faites un zoom avant dans la fenêtre, vous constatez que la piste vidéo
s’agrandit également, affichant les images vidéo à un plus bas niveau de
résolution. Avec un zoom maximum, chaque image apparaît dans la piste vidéo.

Correction factor for exact positioning: Cette vous permet de compenser
les légers retards qui peuvent survenir si votre ordinateur n’est pas très rapide.
La liaison d’un fichier média à un VIP ou projet Wave est basée sur deux lectures
séparées : celle de la fenêtre de Samplitude et celle de la fenêtre du fichier média.
En fait, les données ne sont pas synchronisées au cours de la lecture. Par
conséquent, si votre ordinateur n’est pas suffisamment puissant ou rapide, les
pistes audio numériques et le fichier média risquent de se désynchroniser. Cette
option vous permet d’indiquer un facteur utilisé pour la conversion de fréquence
d’échantillonnage interne.
Principes de cette fonction:
Comme il n’est pas possible d’influer sur la vitesse de lecture du fichier média,
c’est sur la vitesse de lecture des pistes audionumériques que nous allons agir.
Imaginons que la vitesse de lecture normale corresponde à un facteur 100. Si
les pistes audionumériques vont trop vite par rapport au fichier AVI, il faut
réduire leur vitesse de lecture.
Il suffit alors de multiplier la vitesse de lecture normale 100 par un facteur de
correction légèrement inférieur à 1, par exemple 0,998. La vitesse de lecture
obtenue est de 99,8, ce qui est légèrement plus lent que la vitesse normale.
Faites ainsi quelques essais jusqu’à ce que les pistes audionumériques se calent
sur le fichier média.
Par contre, si les pistes audionumériques sont en retard sur le fichier média,
vous devez indiquer un facteur supérieur à 1 (1,002 par exemple).
La «règle de base» est d’utiliser de petites variations pour ce facteur. Les valeurs
doivent rester proches de 1. Vous aurez sans doute besoin de faire quelques
essais avant de trouver la valeur correcte car il n’y a aucune règle universelle qui



486

Menu «Options»
puisse être appliquée ici.
Si vos pistes audionumériques se calent d’office parfaitement sur le fichier média,
n’indiquez rien dans ce champ !

Remove Link: Ce bouton permet de rompre le lien existant entre le fichier média
et la fenêtre de Samplitude. Le fait de cliquer sur ce bouton rompt toute
association avec le fichier média. Servez-vous de cette fonction si vous n’avez
plus besoin de faire appel à ce fichier média.

Preview: Le bouton «Preview» vous permet de tester le lien effectué. Il suffit de
cliquer sur le bouton pour lancer la lecture du fichier média chaîné. Si le fichier
AVI ne se lit pas dans la fenêtre de Samplitude, cochez la case «Video in
Samplitude window». Les autres fichiers média doivent être lus par l’extension
multimédia de Windows, dans des utilitaires comme le lecteur MIDI.

Show current Video Frames: Cette option affiche les images vidéo actuelles
dans la fenêtre de prévisualisation de la piste vidéo.

Project Properties > Text Comments
Sélectionnez cette option pour afficher des informations (une «vue générale»)
sur le projet actuellement actif (HD Wave, RAP ou VIP).
Cela comprend la date de création, la taille en mémoire, le chemin d’accès et les
noms de fichier.
Pour les projets virtuels, une liste de tous les fichiers physiques inclus (dont les
projets Wave liés) est affichée.

Cette fenêtre Project Info affiche les informations selon une des deux façons
suivantes:

1. Fenêtre Project Info (HD Wave, RAP)
Pour les projets sur disque dur et en RAM (HD Wave, RAP), la fenêtre Project
Info affichera: Chemin d’accès (emplacement des fichiers sur le disque dur),
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nom du fichier, nombre de sélections, nombre de marqueurs, date de création
du fichier, date de dernière modification du fichier, taille du fichier (en
échantillons) et taille mémoire du fichier. Vous pouvez également ajouter d’autres
renseignements dans les champs: Name (nom), Comment (commentaire),
Subject (sujet), Artist (artiste), Engineer (ingénieur), Technician (technicien),
Keywords (mots-clés), Software (logiciel) et Copyright.

Note: C’est une option très utile pour les utilisateurs qui travaillent avec des banques
de boucles, des sons de bibliothèques d’effets sonores, des identifiants de station etc.
Ces «bibliothèques sonores» peuvent souvent apparaître dans plusieurs VIP et peuvent
aussi être employées par de multiples ingénieurs/producteurs. En cochant Read Only
(lecture seule) pour les fichiers importants, de multiples utilisateurs peuvent travailler
sans risque de modifier des fichiers importants ou des fichiers appartenant à une
bibliothèque. De plus, quand l’option de suppression des échantillons non utilisés (Tools
> Remove unused Samples) est demandée, les fichiers dont Read Only est coché ne
seront pas supprimés.

2. Fenêtre Project Info (VIP)
Avec les projets virtuels (VIP), la fenêtre Project Info affichera: Chemin d’accès
(emplacement des fichiers sur le disque dur), nom du fichier, nombre de
sélections, nombre de marqueurs, date de création du fichier, date de dernière
modification du fichier, nombre d’objets du VIP, et liste de TOUS les projets
Wave utilisés.
Vous pouvez également ajouter d’autres renseignements dans les champs: Name
(nom), Comment (commentaire), Subject (sujet), Artist (artiste), Engineer
(ingénieur), Technician (technicien), Keywords (mots-clés), Software (logiciel)
et Copyright. La fenêtre propose également le réglage d’options de sauvegarde
automatique quand le projet est ouvert.

Set Global: Cliquez sur ce bouton pour sauvegarder les informations que vous
avez ajoutées (saisies) comme réglages généraux.

Get Global: Cliquez sur ce bouton pour rappeler les informations sauvegardées
(réglages généraux), et les ajouter au projet actif en cours. Vous pouvez ainsi
toujours ajouter les mêmes renseignements à vos projets.

Cancel: Ce bouton referme la fenêtre Project Info sans valider les réglages qui
y ont été effectués.

OK: Ce bouton referme la fenêtre Project Info après avoir validé les réglages qui
y ont été effectués.

Read Only: Cliquez sur cette option de «lecture seule» pour que le projet HD
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Wave ou RAP en question ne puisse être que lu. Le fichier audio peut ainsi être
lu, mais pas modifié.

Project Status

Sélectionnez cette option pour afficher des informations (une «vue générale»)
sur le projet actuellement actif (HD Wave, RAP ou VIP). Cela comprend la date
de création, la taille en mémoire, le chemin d’accès et les noms de fichier.

Project Information
Pour les projets virtuels, une liste de tous les fichiers physiques inclus (dont les
projets Wave liés) est affichée. Cette fenêtre vous donne aussi le nombre de
marqueurs et de sélections mémorisées qui sont employés. Les informations
sur la date de création et de dernière édition sont affichées ainsi que le nombre
d’objets contenus dans le VIP.
Pour les projets sur disque dur et en RAM (HD Wave, RAP), la fenêtre Project
Info affichera: Chemin d’accès (emplacement des fichiers sur le disque dur),
nom du fichier, nombre de sélections, nombre de marqueurs, date de création
du fichier, date de dernière modification du fichier, taille du fichier (en
échantillons) et taille mémoire du fichier.

Original Time Position (seulement pour les projets Wave)
Quand vous enregistrez ou importez du matériel audio dans votre VIP, un projet
Wave est créé, qui contient les données audio. Samplitude sauvegarde et affiche
ici cette position temporelle à laquelle l’objet a été créé.

List of used Wave Projects
Tous les projets Wave utilisés sont référencés ici. Vous pouvez ouvrir la fenêtre
d’un projet Wave en double-cliquant sur son nom dans la liste ou en le
sélectionnant puis en cliquant sur le bouton Open file.

Exchange file: Vous pouvez échanger un projet Wave d’un coup dans tous les
objets qui y font référence.
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Select Objects: Sélectionne tous les objets se référant au projet Wave
sélectionné.
Vous pouvez activez des alertes durant le chargement (Warning during Loading)
ou la sauvegarde (Warning during Saving) quand le projet contient des projets
Wave qui résident en dehors du dossier du projet.

Le bouton Copy files ouvre la fenêtre «Collect project files» servant à copier
les fichiers épars dans le dossier du projet.

Project Properties > Broadcast Wave Manager
L’extension Broadcast Wave (BWF) vous permet de sauvegarder dans un fichier
audio des informations nommées méta-données, dans un segment du fichier
BWF. Ces méta-données ont en général un emploi exclusif. Toutefois, nous
vous recommandons de respecter les directives émises respectivement par l’EBU
et la SMPTE.

Menu: Options>Project Properties>Broadcast Wave Manager.
Par défaut, vous pouvez ouvrir cette fenêtre via le raccourci clavier Alt+Shift+B ou
par le sous-menu Project Properties.
 
Wave Project (moitié gauche de la fenêtre)
C’est une liste des données incluses dans le VIP. Sélectionnez un fichier à la
souris pour afficher des informations individuelles le concernant. Les
informations BWF correspondantes sont alors affichées dans la moitié droite
de la fenêtre.
La principale application du Broadcast Wave Manager est toutefois de définir
les méta-données qui seront incluses dans l’extension Broadcast Wave du
matériel à enregistrer.
Ces méta-données seront alors disponibles pour tous les futurs utilisateurs du
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fichier audio. Certaines applications peuvent lire ou extraire ces méta-données
dans des buts particuliers, comme la gestion des données audio dans les bases
de données.

Liste des différents champs (moitié droite de la fenêtre)
Toutes les valeurs réglées par l’utilisateur sont sauvegardées avec référence au
VIP et sont appliquées aux nouvelles données audio.

File Description: Champ de texte qui accepte toute saisie. Vous pouvez saisir
ici un titre long et un titre court. Un maximum de 256 caractères ASCII peuvent
être saisis.

Originator: Contient des détails sur l’origine du fichier, par ex. la description
du producteur. 32 caractères max.

Originator Reference: Déterminé par le remplissage du champ Originator.
Cela peut être un numéro de référence interne. Dans le cadre de l’EBU, la
recommandation EBU R99-1999 sur la façon de structurer ce champ s’applique
ici. Cochez l’option «USID Format» pour appliquer cette propriété à ce champ.
Le champ peut alors être formaté conformément à la recommandation EBU (32
caractères max.).

Origination Date: Affiche la date à laquelle le fichier a été créé. Elle peut être
éditée. C’est utile par exemple quand un matériel a été enregistré dans le fichier
bien après la date de l’enregistrement alors que c’est cette dernière date que
vous voulez comme référence. Si la saisie est éditée ici, la valeur obtenue est
indépendante des propriétés du fichier.

Origination Time: L’heure à laquelle le fichier a été créé s’affiche ici. Comme
la date, elle est automatiquement titrée des propriétés du fichier mais peut aussi
être éditée pour les mêmes raisons que celles mentionnées ci-dessus.

Timestamp: L’horodatage sauvegardé dans l’extension Broadcast Wave s’affiche
ici. C’est le timecode pour l’enregistrement du fichier, qui est identique au
timecode du premier enregistrement si celui-ci était synchrone. Pour d’autres
applications, cette valeur peut fournir des informations sur l’heure et le jour de
l’enregistrement.
 
Unique Material Identifier (UMID): La gestion de l’identifiant UMID est
réglementée par la SMPTE. Un document approprié est disponible auprès de la
SMPTE. Le numéro de code est SMPTE 300M-2000. Nous vous recommandons
de suivre ces directives ainsi que les accords concernant l’emploi de l’UMID
avant d’employer cette caractéristique, qui doit convenir à votre cas particulier.
L’emploi de l’UMID n’est pas absolument nécessaire pour créer un fichier BWF
valable.

Coding History: En dehors des détails sur le format de fichier (A: codage, par
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ex. PCM; F: fréquence d’échantillonnage; W: résolution; B: débit numérique;
cette valeur n’est utilisée que pour un codage non transparent comme le MPEG
ou le MP3; M: nombre de canaux), chaque entrée de ce champ contient la valeur
T:. C’est une chaîne de texte sans virgule qui, par exemple, permet l’entrée du
numéro de série d’un magnétophone à bande analogique, de codecs, de types
de dithering, de convertisseurs A/N ou d’un traitement spécial du signal appliqué
au fichier comme une réduction de bruit.
Une entrée est créée quand un fichier est enregistré dans Samplitude. Si ce
fichier est alors à nouveau traité (par ex. si la résolution a été réduite ou en cas
d’encodage en MPEG), une autre entrée est ajoutée.
L’emploi de cet historique de codage est réglementé par la recommandation
EBU R98-1999.
 
Project Properties > CD Arrange Mode
Samplitude réarrange les nouveaux objets insérés et insère des pauses
(conformément à la norme Red Book) entre les objets.
Veuillez vous référer à la section CD/DVD > CD Arrange Mode pour plus de
détails.

Project Properties > Destructive Wave Editing Mode
Ce choix de menu active ou désactive le mode édition destructive en fenêtre de
projet Wave. S’il est désactivé, alors Samplitude est mode «virtuel» d’édition
d’onde.

Project Properties > Units of Measurement
Ce sous-menu détermine l’unité de mesure temporelle utilisée pour l’affichage/
grille.
Veuillez vous référer à la section View > Units Of Measurement pour plus de
détails.

Project Options
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Project Sample Rate/Volume Damping
Sample Rate
Détermine la fréquence d’échantillonnage du projet virtuel. Si vous voulez ou
devez utiliser une fréquence d’échantillonnage que votre carte son n’accepte
pas, utilisez la fonction de variation de vitesse/hauteur (varipitch) qui peut être
réglée dans la fenêtre des paramètres de lecture (Play/Rec > Playback Options).
Quand vous chargez des projets Wave ayant une fréquence d’échantillonnage
différente de celle du VIP, les objets obtenus sont automatiquement
rééchantillonnés pour correspondre à la fréquence d’échantillonnage du VIP.
C’est un effet en temps réel non destructif.
Volume
Lorsque vous cumulez plusieurs pistes audio dont les crêtes sont proches de
0 dB, le niveau de sortie général peut très facilement dépasser 0 dB. Servez-
vous alors du paramètre Volume afin d’atténuer le niveau de sortie et éviter que
la limite 0 dB ne soit franchie.
Vous avez le choix entre quatre niveaux d’atténuation différents en cliquant sur
les boutons radio suivants:
0dB: Aucune atténuation n’est appliquée à l’entrée; peut être considéré comme
le réglage «Off».
-6dB: Une atténuation de 6 dB est appliquée à l’entrée.
-12dB: Une atténuation de 12dB est appliquée à l’entrée.
-18dB: Une atténuation de 18dB est appliquée à l’entrée.

En théorie, chacune des pistes d’un projet stéréo à 4 pistes doit être réduite de
2 bits (12 dB). En pratique, il arrive souvent que les pistes ne soient pas lues, ni
enregistrées à leur niveau optimal. Il faut donc ajuster l’atténuation de volume
en conséquence. Toutefois, le fait de relever le réglage d’atténuation de volume
peut entraîner de la distorsion.
N’oubliez pas que Samplitude ramène le volume des projets Wave sur le réglage
du projet virtuel auquel ils sont rattachés. Ce système permet de passer du projet
VIP aux différents projets Wave sans rencontrer de problème de différence de
niveau. Si vous ouvrez un projet Wave seul (sans passer par le projet Wave
rattaché à un projet VIP), Samplitude sélectionne automatiquement le niveau
de lecture maximum.

Snap/Grid
Vous trouverez les détails concernant la fonction Snap to Grid dans le chapitre «Menu
View».
Snap to: Quand cette case est cochée, le magnétisme est activé.

Objects: Cette option active le magnétisme d’objet.

Range: Cette option active le magnétisme de sélection (Range) et vous permet
d’utiliser la sélection actuellement définie comme base de magnétisme en
cliquant sur Get current Range for snap. Cela peut être une forme simplifiée
du magnétisme de grille/mesure (Grid/Bars). Le principe est le même, les limites
de la sélection deviennent des points de référence de magnétisme (de calage) et
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ces points sont reproduits dans les deux directions à des intervalles correspondant
à la longueur de la sélection. Définissez une sélection (Range) correspondant à
la plus petite fraction temporelle (par ex. double-croche) et vous obtenez un
magnétisme à la double croche. Utilisez cette option quand vous voulez vous
caler sur des positions temporelles distinctes sans changer le tempo du projet.

Grid/Bars: Active un magnétisme basé sur les mesures. Vous pouvez saisir le
tempo en BPM et des attributs de mesure supplémentaires dans le cadre Bar/
BPM. Le tempo peut aussi être détecté à partir de la sélection (Range) actuelle
en cliquant sur «Get BPM from current range». Vous pouvez définir le nombre
de temps contenus par la sélection – par ex. 4 si la sélection englobe une mesure
4/4 complète. Le programme affiche alors automatiquement le tempo (BPM)
pour la sélection définie. Des partitions servent à définir le nombre de points
de magnétisme (calage) par temps, c’est-à-dire qu’une valeur 4 correspondra à
des doubles-croches dans une mesure en 4/4.

Grid/Frames: Active un magnétisme basé sur la longueur d’image (frame).
Cette longueur exacte dépend du format SMPTE sélectionné (Options >
Synchronization Setup).

Snap Offset to project start: Vous permet de choisir un décalage définissant
un point de départ pour le magnétisme.

Use Snap Offset also for Grid: Quand cette case est cochée, le décalage de
magnétisme (s’il y en a un) est aussi appliqué à la grille.

Raccourci: Ctrl+ Shift + R

Recording
Lock Recorded Objects: Cette option verrouille les nouveaux objets enregistrés
dès que l’enregistrement est terminé. C’est utile si vous ne désirez pas risquer
d’accidentellement déplacer les nouveaux objets dans un VIP.

Note: Un objet peut être déverrouillé en le sélectionnant (clic sur l’objet dans la moitié
basse de la piste), puis en sélectionnant Object > Lock Objects > Unlock Objects.

Group objects after multirecord: Les objets qui sont créés quand vous
enregistrez plusieurs canaux à la fois seront groupés. Vous pouvez à tout moment
les dégrouper.

Editing
Destructive Mode: Seulement pour les projets Wave (voir le chapitre «Wave
Editing«)

Auto Crossfade Mode: Quand vous accomplissez une édition ou déplacez un
objet sur un autre, un fondu-enchaîné (crossfade) est automatiquement effectué.
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CD Arrangement Mode: Quand vous cochez cette option, Samplitude réarrange
les nouveaux objets insérés et insère des pauses (conformément à la norme Red
Book) entre les objets.
Veuillez vous référer à la section CD/DVD > CD Arrange Mode pour plus de
détails.

AutoSave Mode:
Ce groupe de réglages active le mode de sauvegarde automatique (AutoSave) de
Samplitude pour les VIP. C’et un outil très utile qui crée automatiquement des
copies de sauvegarde du VIP ouvert durant une session avec Samplitude.
Samplitude n’interrompra pas la lecture ou l’enregistrement pour initier une
sauvegarde ! La procédure de sauvegarde automatique est activée durant les
brèves périodes d’inactivité, et ne sauvegarde que le VIP lui-même (généralement
un très petit fichier).
L’outil de sauvegarde peut être réglé pour remplacer le fichier ouvert ou pour
sauvegarder séquentiellement des copies du fichier ouvert. Samplitude nommera
automatiquement les sauvegardes du VIP, et les placera dans le dossier du projet.
L’espacement des sauvegardes peut aussi être réglé par l’utilisateur. Nous ne
voyons pas pour quelle raison vous voudriez désactiver le mode de sauvegarde
automatique mais si vous le voulez, vous le pouvez !

Bar/BPM
Vous réglez ici la mesure (numerator/denominator), le tempo en battements
par minute (BPM) et la résolution en clics par noire (souvent identifiée par
PPQN).

Track information
Veuillez vous référer au «Menu Track» -> Track information.

Synchronization active
Cette commande existe essentiellement afin de pouvoir y affecter un raccourci
clavier. Vous pouvez activer ou désactiver la synchronisation par le biais du
bouton SYNC de la barre de transport. Un clic droit sur ce bouton ouvre la
fenêtre de configuration de la synchronisation (Synchronization Setup).

Raccourci: «G»

Synchronization Setup
Lisez le chapitre «Synchronisation» pour une introduction à la façon de synchroniser
Samplitude avec d’autres programmes ou équipements MIDI externes.

Raccourci: Shift + G
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MIDI Clock Input
Si Samplitude doit se synchroniser en esclave sur un signal d’horloge MIDI
Clock, utilisez cette section d’entrée d’horloge MIDI. Sélectionnez le périphérique
MIDI chargé de transmettre les messages d’horloges MIDI (départ, arrêt, reprise,
position dans le morceau) à Samplitude. Cochez la case «MC Input active» si
vous souhaitez utiliser ce format.

Note: Comme l’horloge MIDI ne véhicule aucun flux continu d’information temporelle,
Samplitude n’a pas de référence pour comparer sa propre position interne. Optez
pour le format SMPTE/MMC si votre projet nécessite une synchronisation
extrêmement précise.

Device: Utilisez la liste déroulante pour sélectionner le périphérique sur lequel
Samplitude doit recevoir les messages d’horloge MIDI. Ce sera un port MIDI
actif (virtuel ou physique).

BPM: Indiquez le tempo, en battements par minutes (BPM) de l’audio avec
lequel vous désirez vous synchroniser. Ce paramètre n’affecte pas la vitesse de
lecture des pistes audionumériques. Il agit uniquement sur l’affichage de la
grille.
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MC Input active: Cochez cette case pour que Samplitude puisse se synchroniser
sur les messages d’horloge MIDI reçus.

MIDI Clock Output
Si vous voulez que Samplitude produise une horloge MIDI en tant que maître,
utilisez cette section de sortie d’horloge MIDI. Quand elle est activée, Samplitude
devient le maître de l’horloge MIDI, ce qui signifie qu’il est chargé de transmettre
les messages d’horloge MIDI suivants: départ, arrêt, reprise, et position dans le
morceau. Aucune information de type temporel n’est transmise dans ce mode
de synchronisation. Optez pour ce format si la synchronisation entre les éléments
ne nécessite pas une précision absolue et doit être configurée rapidement.

Device: Utilisez la liste déroulante pour sélectionner le périphérique qui enverra
les messages d’horloge MIDI. Ce sera un port MIDI actif (virtuel ou physique).

BPM: Indiquez le tempo, en battements par minutes (BPM) que Samplitude
doit donner à l’horloge MIDI qu’il envoie. Ce paramètre détermine le tempo de
l’appareil esclave. Autrement dit ; Si vous réglez ce paramètre sur 120, tout
séquenceur relié en esclave à Samplitude jouera à un tempo de 120 BPM.

MC Output active: Cochez cette case pour que Samplitude produise des
messages d’horloge MIDI.

MTC Input
Si Samplitude doit se synchroniser en esclave sur un signal SMPTE/MTC,
utilisez cette section d’entrée de MTC. Lorsque cette section est active, Samplitude
devient un esclave SMPTE/MTC. Il recherche tout signal de time code (y compris
des données temporelles) reçu sur le périphérique d’entrée MIDI sélectionné.
Activez en plus l’option de synchronisation continue Chase Lock Sync de la
fenêtre si vous avez besoin d’une précision de synchronisation absolue.

Note: Samplitude reconnaît uniquement le MTC (équivalent numérique du SMPTE).
Il faut donc que votre interface MIDI soit capable de convertir les signaux SMPTE
éventuels en MTC (MIDI Time Code).

Device: Utilisez la liste déroulante pour sélectionner le périphérique sur lequel
Samplitude doit recevoir les messages de synchronisation SMPTE/MTC. Ce
sera un port MIDI actif (virtuel ou physique).

Active: Cochez cette case pour que Samplitude puisse se synchroniser sur les
messages SMPTE/MTC reçus.

MTC Output
Si vous voulez que Samplitude produise du MTC en tant que maître, utilisez
cette section de sortie de MTC. Samplitude peut produire des messages de MTC,
ce qui en fait le maître dans une installation avec synchronisation. Les messages
MTC sont envoyés au périphérique de sortie spécifié quand Samplitude lance/
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arrête la lecture ou l’enregistrement.

Device: Utilisez la liste déroulante pour sélectionner le périphérique qui enverra
les messages de synchronisation MTC. Ce sera un port MIDI actif (virtuel ou
physique).

MTC Output active: Cochez cette case pour que Samplitude produise des
messages de synchronisation MTC.

SMPTE Settings
Ces paramètres indiquent à Samplitude le format de synchronisation à adopter.
Vous avez le choix entre différents réglages en fonction de l’application finale
(formats vidéo et cinéma en Europe et en Amérique).
Sélectionnez le bon nombre d’images. Le format 24 images est réservé au
cinéma, le format 25 images est destiné à la synchronisation audio et vidéo PAL
alors que le format 30 images est réservé à la vidéo NTSC.
Vous pouvez également remarquer la présence d’options 29,97 images (Drop
et Non Drop) !
Utilisez le paramètre Preroll Frames (prédéfilement d’images) pour compenser
le retard de verrouillage sur le time code des équipements externes.

Type: Sélectionnez le format de synchronisation SMPTE/MTC désiré.

Preroll Frames: Ce paramètre vous permet de spécifier le nombre d’images
que Samplitude doit ignorer avant que la synchronisation ne s’effectue. Beaucoup
d’appareils nécessitent un temps pour «se verrouiller» sur le signal de
synchronisation, et ce paramètre vous permet de compenser ce retard.

SMPTE Offset
Ce paramètre vous permet de spécifier un temps de décalage ou offset SMPTE,
en millièmes de secondes ou en format SMPTE. Exemple : Si un time code
SMPTE est déjà couché sur la bande d’un magnétophone multipiste (utilisé en
maître) et si vous souhaitez que Samplitude démarre en esclave exactement
30 minutes après le début de la bande, indiquez simplement la valeur 30:00:00
dans le champ SMPTE.
La valeur d’offset est retranchée du signal de time code SMPTE afin de supprimer
toute différence entre les données de la bande et les échantillons enregistrés
dans Samplitude. Avec un offset de ’01:00:00:00' (1 heure), la synchronisation
démarre 1 heure après le début de la bande, si le point de départ de la lecture/
enregistrement commence à 1 heure. Samplitude démarre, pour sa part, au bon
point de départ.

Millisec.: Ce champ numérique indique la durée de l’offset SMPTE en
millisecondes.

SMPTE: Ce champ numérique indique la valeur d’offset SMPTE au format
SMPTE en vigueur (Heures : Minutes : Secondes : Images).
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FX: Ce paramètre, similaire au paramètre Pitch (facteur de multiplication) du
variateur de vitesse (Varipitch, fenêtre Playback Options) permet de résoudre
les imprécisions qui pourraient survenir au cours du positionnement des
échantillons longs. Cette fonction multiplie la vitesse de lecture audio par le
facteur indiqué. Les valeurs supérieures à 1 accélèrent la vitesse de lecture alors
que les valeurs inférieures à 1 la ralentissent.

Chase Lock Sync
Samplitude peut se verrouiller en synchronisation sur les signaux de
synchronisation MTC qu’il reçoit afin de s’adapter aux fluctuations de temps
transmises par le maître. Cette synchronisation continue est obtenue par
manipulation à la volée de la fréquence d’échantillonnage de lecture des
échantillons.

Note: Cette fonction est très pratique pour synchroniser un magnétophone ou un
magnétoscope (maître) à Samplitude (esclave), car la plupart des appareils à bandes
produisent de légères variations de vitesse (qui provoqueraient des retards entre la
bande et Samplitude si ce dernier n’était pas équipé d’une fonction de synchronisation
continue). Si les variations sont trop importantes, Samplitude modifie grandement
la vitesse (vous pouvez atténuer ce phénomène en indiquant une valeur faible dans le
champ Sync Velocity (voir ci-dessous). Essayez des valeurs de 200 ou plus lorsque
vous désirez que Samplitude réagisse rapidement aux variations de vitesse. La barre
d’information située en bas à droite vous indique la variation de hauteur en cours/
maximale en centièmes (1 centième = 1/100ème de demi-ton).
La synchronisation continue (Chase Lock Sync) est obtenue par rééchantillonnage en
temps réel (si vous n’êtes pas équipé d’une carte ARC44), ce qui nécessite une certaine
puissance de traitement. Soyez donc prudent si votre ordinateur n’est pas très puissant
!

Sync Velocity: Indiquez dans ce champ la vitesse avec laquelle Samplitude
doit réagir aux variations de vitesse transmises par le maître. La valeur par défaut
est 100, ce qui convient généralement bien. Pour accélérer le temps de réaction
de Samplitude, augmentez cette valeur à 200 voire 300. Pour ralentir son temps
de réaction, abaissez cette valeur à 50 ou 30.

Active: Cochez cette case pour que Samplitude se synchronise en continu sur
les signaux de synchronisation MTC qu’il reçoit.

Use Hardware Pitching (Special cards): Cochez cette option pour utiliser la
synchronisation matérielle de la carte afin de faire varier la fréquence
d’échantillonnage de lecture (si votre carte le permet).

Cancel: Ce bouton referme la fenêtre sans valider les réglages qui y ont été
effectués.

OK: Ce bouton referme la fenêtre après avoir validé les réglages qui y ont été
effectués.
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MMC Setup
Voir le chapitre «Synchronisation».

Program Preferences
Ce sous-menu regroupe de nombreux paramètres vous permettant de
personnaliser Samplitude en fonction de vos méthodes de travail ou de votre
système.

Program Preferences > VIP Mouse Mode
Les options suivantes vous proposent différents modes qui déterminent l’action
de la souris dans les VIP.

Universal Mouse Mode
Cette option active le mode Universel pour la souris. En mode Universel, la
moitié supérieure de la piste vous permet de délimiter les sélections et de déplacer
la tête de lecture alors que la moitié inférieure de la piste permet de sélectionner
et de manipuler les objets. Les réglages des poignées des objets et des courbes
de volume et de panoramique sont prioritaires et peuvent être modifiés à
n’importe quel endroit de la piste. Le mode souris Universel (mode souris par
défaut) est le mode le plus couramment employé.

Conseil d’utilisation : Vous pouvez également passer en mode souris Universel en
cliquant sur l’icône Universal Mode dans la barre d’outils supérieure.
Fonctionnement de la souris en mode Universel :

Bouton droit de la souris : Affiche un menu contextuel.

Bouton gauche de la souris:
1. Moitié supérieure des pistes:
 Sélections : Permet de délimiter et de déplacer des sélections (en tenant la
touche Shift enfoncée).

Tête de lecture : Le fait d’appliquer un clic gauche sur une piste amène
instantanément la Tête de lecture à l’endroit correspondant.

2. Moitié inférieure des pistes:
Sélection des objets : Un clic permet de sélectionner un objet (ou un groupe
d’objets).
Clic + Shift : Le fait de cliquer sur un objet, puis sur un autre en tenant la touche
Shift enfoncée sélectionne tous les objets se trouvant entre les deux premiers.
Clic + Ctrl : Permet de sélectionner plusieurs objets.

Déplacement d’objets : Possibilité de déplacer des objets ou des groupes
d’objets par la technique du glisser-déposer.
Glisser-déposer + Shift : Permet de déplacer des objets ou des groupes d’objets
entre les pistes sans changer leur position dans le temps.
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Glisser-déposer + Ctrl : Permet de dupliquer un ou plusieurs objets.
Glisser-déposer + Shift + Ctrl : Permet de dupliquer un ou plusieurs objets, puis
de déplacer la copie réalisée entre les pistes sans en changer la position
temporelle.

Editeur d’objet : Accès à l’éditeur d’objet par un double-clic sur l’objet

Fonction Lasso : Un clic droit à côté d’un objet sur une zone vide suivi du
dessin d’un cadre de sélection au-dessus de plusieurs objets sélectionne les objets
ainsi encadrés.
Un clic gauche à côté d’un objet sur une zone vide suivi du dessin d’un cadre de
sélection au-dessus de plusieurs objets sélectionne les poignées de volume ou
de panoramique qui s’y trouvent.

3. Pistes dans leur totalité
Poignées d’objets : La poignée centrale détermine le volume de l’objet. La
variation de volume est exprimée en dB dans le coin supérieur gauche du VIP.
Les poignées supérieures gauche et droite gèrent les fondus d’entrée/sortie de
l’objet. Les paramètres de courbe de fondu peuvent être réglés dans l’éditeur
d’objet. Les poignées inférieures permettent d’agrandir ou de raccourcir l’objet.

Courbes d’automation de volume et de panoramique: Un double-clic sur
une courbe d’automation insère une nouvelle poignée. Un double-clic sur une
poignée existante la supprime de la courbe.
Un simple clic sur une poignée la sélectionne.
En tenant la touche Ctrl enfoncée, vous pouvez sélectionner plusieurs poignées
par un clic sur chacune d’elles.
La poignée sélectionnée peut être déplacée par glisser-déposer.
Si vous tenez enfoncée la touche Ctrl, vous pouvez même faire glisser plusieurs
poignées.
Pour supprimer des poignées, sélectionnez les poignées désirées, puis utilisez
Edit- > Delete .... Handle.

Ranges Mode
Sélectionnez cette option pour activer le mode Sélection (Range) pour la souris.
En mode Sélection, le bouton gauche de la souris sert exclusivement à la
délimitation de sélections. Il est possible de délimiter des sélections à n’importe
quel endroit de la piste (moitié inférieure ou supérieure).
L’association de ce mode à deux touches spéciales vous donne accès à d’autres
fonctionnalités:

Touche «point» (.): Si vous tenez enfoncée la touche «point», Samplitude bascule
temporairement en mode Objet. Dans ce mode, vous pouvez alors facilement
sélectionner et manipuler les objets.

Touche «moins» (-): Si vous tenez enfoncée cette touche, Samplitude bascule
temporairement en mode Courbe où vous pouvez changer les courbes
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d’automation de volume, panoramique et VST.
En résumé, vous avez accès à des fonctions spéciales sans risquer de déplacer
accidentellement les objets. C’est pour cela que le mode Sélection est également
appelé «Mode sécurisé».

Conseil d’utilisation : Vous pouvez également passer en mode Sélection en cliquant
sur l’icône Range Mode dans la barre d’outils supérieure.

Fonctionnement de la souris en mode Sélection (Range):
Bouton droit de la souris : Affiche un menu contextuel.

Bouton gauche de la souris:
Sélection : Permet de délimiter les sélections et de les déplacer (lorsque la
touche Shift est enfoncée). Les objets et les courbes d’automation ne peuvent
pas être déplacés par accident dans ce mode (c’est pour cela qu’il est baptisé
«Mode sécurisé»).

Tête de lecture : Un clic gauche sur une piste amène instantanément la tête
de lecture à l’endroit correspondant.

Passage temporaire en mode Objet: Tenir la touche «point» (.) permet de
basculer temporairement en mode Objet où vous pouvez manipuler les objets.

Passage temporaire en mode Courbe: Tenir la touche «moins» ou «trait
d’union» (-) permet de basculer temporairement en mode Courbe où vous pouvez
manipuler les poignées et les courbes d’automation.

Curve Mode
Sélectionnez cette option pour activer le mode Courbe (Curve Move and Grab
Mode) pour la souris. Dans ce mode, le bouton gauche de la souris sert
UNIQUEMENT à la manipulation (insertion, suppression, déplacement) des
poignées des courbes de volume et de panoramique.

Conseil d’utilisation : Vous pouvez également passer en mode Courbe en cliquant sur
l’icône Curve Move and Grab Mode de la barre d’outils supérieure.

Fonctionnement de la souris en mode Courbe:
Bouton droit de la souris : Affiche un menu contextuel.

Bouton gauche de la souris:
Fonction Lasso : Dessiner un cadre de sélection au-dessus de plusieurs poignées
de volume ou de panoramique sélectionne les poignées encadrées.

Courbes d’automation de volume et de panoramique: Un double-clic sur
une courbe d’automation insère une nouvelle poignée. Un double-clic sur une
poignée existante la supprime de la courbe.
Un simple clic sur une poignée la sélectionne.
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En tenant la touche Ctrl enfoncée, vous pouvez sélectionner plusieurs poignées
par un clic sur chacune d’elles.
La poignée sélectionnée peut être déplacée par glisser-déposer.
Un simple clic + Shift sur une poignée sélectionne toutes les poignées entre
celle-ci et celle sélectionnée précédemment (sert à sélectionner une série de
poignées).
Pour supprimer des poignées, sélectionnez les poignées désirées, puis utilisez
Edit- > Delete .... Handle.

Object Mode
Sélectionnez cette option pour activer le mode Objet pour la souris. Dans ce
mode, le bouton gauche de la souris sert UNIQUEMENT à la sélection et au
déplacement des objets. Il est possible de sélectionner et de déplacer (dans la
piste en question) un objet, quelle que soit la position du pointeur de la souris.

Conseil d’utilisation : Vous pouvez également passer en mode Objet en cliquant sur
l’icône Object Mode dans la barre d’outils supérieure.

Fonctionnement de la souris en mode Objet:
Bouton droit de la souris : Affiche un menu contextuel.

Bouton gauche de la souris:
Sélection des objets : Un clic simple permet de sélectionner un objet (ou un
groupe d’objets)
Clic + Shift : Cliquer sur un objet puis sur un autre en tenant la touche Shift
enfoncée sélectionne tous les objets se trouvant entre les deux objets sur lesquels
vous avez cliqué.
Clic + Ctrl : Permet de sélectionner plusieurs objets.

Déplacement d’objets : Possibilité de déplacer des objets ou des groupes
d’objets par la technique du glisser-déposer.
Glisser-déposer + Shift : Permet de déplacer des objets ou des groupes d’objets
entre les pistes sans changer leur position dans le temps.
Glisser-déposer + touche «K» : Permet de déplacer l’objet situé sous le pointeur
de la souris, ainsi que tous les objets qui le suivent sur la même piste.

Duplication d’objets : Glisser-déposer + Ctrl permet de dupliquer un ou
plusieurs objets.
Glisser-déposer + Shift + Ctrl : Permet de dupliquer un ou plusieurs objets, puis
de déplacer la copie réalisée entre les pistes sans en changer la position
temporelle.

Editeur d’objet : Accès à l’éditeur d’objet par un double-clic sur l’objet.

Fonction Lasso : Un clic droit à côté d’un objet sur une zone vide suivi du
dessin d’un cadre de sélection au-dessus de plusieurs objets sélectionne les objets
ainsi encadrés.
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Un clic gauche à côté d’un objet sur une zone vide suivi du dessin d’un cadre de
sélection au-dessus de plusieurs objets sélectionne les poignées de volume ou
de panoramique qui s’y trouvent.

Poignées d’objets: La poignée centrale détermine le volume de l’objet. La
variation de volume est exprimée en dB dans le coin supérieur gauche du VIP.
Les poignées supérieures gauche et droite gèrent les fondus d’entrée/sortie de
l’objet. Les paramètres de courbe de fondu peuvent être réglés dans l’éditeur
d’objet.
Les poignées inférieures permettent d’agrandir ou de raccourcir l’objet.

Volume/Objects
Sélectionnez cette option pour activer le mode Objet et Courbe (Object and
Curve Mode) pour la souris. Dans ce mode, le bouton gauche sert uniquement
à sélectionner et à déplacer les objets ou les poignées de volume ou de
panoramique. Il est possible de sélectionner et de déplacer un objet quel que
soit l’endroit de la piste où se trouve le pointeur de la souris.

Conseil d’utilisation : Vous pouvez également passer en mode Volume/Objects en
cliquant sur l’icône Object and Curve Mode dans la barre d’outils supérieure.
Fonctionnement de la souris en mode Volume/Objects (Object and Curve Mode):

Bouton droit de la souris : Affiche un menu contextuel.

Bouton gauche de la souris:
Sélection des objets : Un clic simple permet de sélectionner un objet (ou un
groupe d’objets)
Clic + Shift : Cliquer sur un objet puis sur un autre en tenant la touche Shift
enfoncée sélectionne tous les objets se trouvant entre les deux objets sur lesquels
vous avez cliqué.
Clic + Ctrl : Permet de sélectionner plusieurs objets.

Déplacement d’objets : Possibilité de déplacer des objets ou des groupes
d’objets par la technique du glisser-déposer.
Glisser-déposer + Shift : Permet de déplacer des objets ou des groupes d’objets
entre les pistes sans changer leur position dans le temps.

Duplication d’objets : Glisser-déposer + Ctrl permet de dupliquer un ou
plusieurs objets.
Glisser-déposer + Shift + Ctrl : Permet de dupliquer un ou plusieurs objets, puis
de déplacer la copie réalisée entre les pistes sans en changer la position
temporelle.

 Editeur d’objet : Accès à l’éditeur d’objet par un double-clic sur l’objet.

Fonction Lasso : Un clic droit à côté d’un objet sur une zone vide suivi du
dessin d’un cadre de sélection au-dessus de plusieurs objets sélectionne les objets
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ainsi encadrés.
Un clic gauche à côté d’un objet sur une zone vide suivi du dessin d’un cadre de
sélection au-dessus de plusieurs objets sélectionne les poignées de volume ou
de panoramique qui s’y trouvent.

Poignées d’objets: La poignée centrale détermine le volume de l’objet. La
variation de volume est exprimée en dB dans le coin supérieur gauche du VIP.
Les poignées supérieures gauche et droite gèrent les fondus d’entrée/sortie de
l’objet. Les paramètres de courbe de fondu peuvent être réglés dans l’éditeur
d’objet.
Les poignées inférieures permettent d’agrandir ou de raccourcir l’objet.

Courbes d’automation de volume et de panoramique: Un double-clic sur
une courbe d’automation insère une nouvelle poignée. Un double-clic sur une
poignée existante la supprime de la courbe.
Un simple clic sur une poignée la sélectionne.
En tenant la touche Ctrl enfoncée, vous pouvez sélectionner plusieurs poignées
par un clic sur chacune d’elles.
La poignée sélectionnée peut être déplacée par glisser-déposer.
Si vous tenez enfoncée la touche Ctrl, vous pouvez même faire glisser plusieurs
poignées.
Pour supprimer des poignées, sélectionnez les poignées désirées, puis utilisez
Edit- > Delete .... Handle.

Mouse Mode Studio 4.0
C’est le mode de fonctionnement de la souris correspondant à Samplitude Studio 4.0.
Si vous êtes en mode Mouse Mode Studio 4.0 et que vous avez spécialisé l’action
de la souris par le choix d’un mode dédié (Range Mode, Object and Curve Mode,
Draw Volume, Draw Panorama, Object Mode, ou Curve Mode), il suffit de choisir
cette option pour ramener la souris sur un mode de fonctionnement normal. Le
bouton droit sert alors à sélectionner et à déplacer les objets alors que le bouton
gauche permet de délimiter les sélections.
Fonctionnement de la souris en mode Studio 4.0 (Bouton droit activé):

Bouton droit de la souris:
Sélection des objets : Un simple clic permet de sélectionner un objet (ou un
groupe d’objets).
Clic + Shift : Le fait de cliquer sur un objet, puis sur un autre en tenant la touche
Shift enfoncée sélectionne tous les objets se trouvant entre les deux premiers.
Clic + Ctrl : Permet de sélectionner plusieurs objets.

Déplacement d’objets : Possibilité de déplacer des objets ou des groupes
d’objets par la technique du glisser-déposer.
Glisser-déposer + Shift : Permet de déplacer des objets ou des groupes d’objets
entre les pistes sans changer leur position dans le temps.
Glisser-déposer + touche «K» : Permet de déplacer l’objet situé sous le pointeur
de la souris, ainsi que tous les objets qui le suivent sur la même piste.
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Duplication d’objets : Glisser-déposer + Ctrl permet de dupliquer un ou
plusieurs objets.
Glisser-déposer + Shift + Ctrl : Permet de dupliquer un ou plusieurs objets, puis
de déplacer la copie réalisée entre les pistes sans en changer la position
temporelle.

Editeur d’objet : Accès à l’éditeur d’objet par un double-clic sur l’objet.

Fonction Lasso : Un clic droit à côté d’un objet sur une zone vide suivi du
dessin d’un cadre de sélection au-dessus de plusieurs objets sélectionne les objets
ainsi encadrés.
Un clic gauche à côté d’un objet sur une zone vide suivi du dessin d’un cadre de
sélection au-dessus de plusieurs objets sélectionne les poignées de volume ou
de panoramique qui s’y trouvent.

Poignées d’objets: La poignée centrale détermine le volume de l’objet. La
variation de volume est exprimée en dB dans le coin supérieur gauche du VIP.
Les poignées supérieures gauche et droite gèrent les fondus d’entrée/sortie de
l’objet. Les paramètres de courbe de fondu peuvent être réglés dans l’éditeur
d’objet.
Les poignées inférieures permettent d’agrandir ou de raccourcir l’objet.

Courbes d’automation de volume et de panoramique: Un double-clic sur
une courbe d’automation insère une nouvelle poignée. Un double-clic sur une
poignée existante la supprime de la courbe.
Un simple clic sur une poignée la sélectionne.
En tenant la touche Ctrl enfoncée, vous pouvez sélectionner plusieurs poignées
par un clic sur chacune d’elles.
La poignée sélectionnée peut être déplacée par glisser-déposer.
Si vous tenez enfoncée la touche Ctrl, vous pouvez même faire glisser plusieurs
poignées.
Pour supprimer des poignées, sélectionnez les poignées désirées, puis utilisez
Edit- > Delete .... Handle.

Bouton gauche de la souris:
Sélections : Permet de délimiter les sélections et de les déplacer (lorsque la
touche Shift est enfoncée).

Tête de lecture : Un simple clic sur une piste amène instantanément la tête
de lecture à l’endroit correspondant.

Zoom: Un double-clic hors d’une sélection (ou sil n’y a pas de sélection) entraîne
un zoom arrière.
Un double-clic dans une sélection entraîne un zoom avant.
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Accès aux projets Wave : Un double-clic sur un objet VIP ouvre le projet Wave
correspondant sur la sélection référencée.

Cut Mode
Cette option permet à la souris de passer en mode Coupe. Lorsque vous activez
ce mode dans un VIP, le pointeur de la souris se change en paire de ciseaux.
Chaque clic effectué sur un objet divise/découpe ainsi l’objet.

Note: Vous pouvez aussi facilement fractionner un objet à l’endroit où se trouve la
tête de lecture en le sélectionnant puis en appuyant sur la touche T de votre clavier.

Pitchshift/Timestretch Mode
Cette option permet à la souris de passer en mode Pitchshift/Timestretch
(transposition/déformation temporelle). Ce mode de souris vous donne un accès
rapide à la transposition et au Timestretching d’objet en temps réel.
La poignée inférieure droite permet de compresser/étirer temporellement un
objet en l’allongeant ou en le raccourcissant. Avec la poignée médiane située
sur une ligne verticale, la hauteur peut être changée dans une plage de +/- 6
demi-tons.

Conseil d’utilisation: Vous pouvez également passer dans ce mode en cliquant sur
l’icône Pitchshift/Timestretch Mode dans la barre d’outils supérieure.

Draw Volume
Cette option permet d’activer le mode de traçage du volume à la souris. Dans ce
mode, le bouton gauche de la souris sert uniquement à tracer les courbes de
volume. Vous pouvez remarquer que le pointeur de la souris se change alors en
crayon lorsqu’il se trouve au-dessus d’une piste. Il suffit d’un clic, puis de faire
glisser la souris pour tracer une courbe de volume. Plus vous déplacez lentement
la souris, plus le nombre de poignées de volume créées est important.

Conseil d’utilisation: Vous pouvez également passer dans ce mode en cliquant sur
l’icône Draw Volume Mode dans la barre d’outils supérieure.

Draw Panorama
Cette option permet d’activer le mode de traçage du panoramique à la souris.
Dans ce mode, le bouton gauche de la souris sert uniquement à tracer les courbes
de panoramique. Vous pouvez remarquer que le pointeur de la souris se change
alors en crayon lorsqu’il se trouve au-dessus d’une piste. Il suffit d’un clic, puis
de faire glisser la souris pour tracer une courbe de panoramique. Plus vous
déplacez lentement la souris, plus le nombre de poignées de panoramique créées
est important.

Conseil d’utilisation: Vous pouvez également passer dans ce mode en cliquant sur
l’icône Draw Panorama dans la barre d’outils supérieure.
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Scrubbing Mode
Cette option permet d’activer le mode de repérage audio (Scrub). Une icône de
haut-parleur vient alors s’afficher à côté du pointeur de la souris. Dans ce mode,
il est possible d’effectuer un repérage audio (Scrubbing) en cliquant sur les
données audio avec le bouton gauche, puis en faisant glisser la souris dans la
direction souhaitée.
On peut comparer ce mode à une fonction de pré-écoute avec en plus la gestion
du tempo de lecture. Le projet peut être relu dans le sens normal ou en sens
inverse, la vitesse de lecture étant déterminée par l’écart séparant la souris de la
tête de la lecture. Plus la souris et la tête de lecture sont éloignées, plus la vitesse
de lecture est élevée.

Conseil d’utilisation: Vous pouvez également passer dans ce mode en cliquant sur
l’icône Scrubbing Mouse Mode dans la barre d’outils supérieure.

Zoom Mode
Dans ce mode, le pointeur de la souris se change en loupe afin de pouvoir
effectuer rapidement des zooms verticaux et horizontaux dans le VIP. Un clic
gauche entraîne un zoom avant alors qu’un clic droit entraîne un zoom arrière.

Conseil d’utilisation: Vous pouvez également passer dans ce mode en cliquant sur
l’icône Zoom Mouse Mode dans la barre d’outils supérieure.

Program Preferences > Wave (HDP/RAP) Mouse Mode
Range
C’est le mode par défaut de la souris lorsque vous travaillez directement sur une
fenêtre de projet Wave. Dans ce mode, le bouton gauche permet de délimiter
des sélections (Ranges).

Draw Wave
Lorsque vous travaillez directement sur un projet Wave, ce mode permet de
modifier la forme d’onde existante au moyen du bouton gauche de la souris et
ainsi créer un nouveau signal audio. Il permet, par exemple, de retirer des bruits
parasites d’un fichier audio. Faites simplement un zoom avant sur un bruit
parasite de type clic (ce bruit a l’aspect d’une crête), puis tracez une ligne au
niveau de sa base. Autrement dit, le fait de redessiner la forme d’onde permet
de supprimer le clic des données audio.

Note: pour utiliser ce mode, faites un zoom à une résolution où 1 pixel = 1 échantillon.
Vous pouvez rapidement accéder à cette résolution de zoom par le menu View en
sélectionnant Horizontal > 1 Pixel = 1 Sample.

Draw Volume
Lorsque vous travaillez directement sur un projet Wave, ce mode permet de
modifier l’amplitude (volume) d’une très courte portion de la forme d’onde. Il
permet, par exemple, d’atténuer (de manière destructive) le volume d’une plosive.
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Faites simplement un zoom avant sur la plosive en question, puis faites glisser
la souris de gauche à droite (ou inversement) en dessous de la plosive. La hauteur
de la forme d’onde va diminuer, reflétant la baisse de volume.

Conseil d’utilisation : C’est la position du pointeur de la souris au-dessus ou en dessous
de la forme quand vous cliquez et tirez qui détermine le montant d’amplification ou
d’atténuation du volume. Plus le pointeur de la souris est au dessus ou en dessous de
la forme d’onde, plus le changement d’amplitude (volume) est radical. En position
centrale, le volume est à 100 %. Le bas de la fenêtre correspond au volume 0 % alors
que le haut de la fenêtre correspond au volume 200 %.

Note: pour utiliser ce mode, faites un zoom à une résolution où 1 pixel = 1 échantillon.
Vous pouvez rapidement accéder à cette résolution de zoom par le menu View en
sélectionnant Horizontal > 1 Pixel = 1 Sample.

Scrubbing Mode / Zoom Mode
Ces deux modes sont identiques aux modes de souris correspondants pour le
VIP. Veuillez vous reporter à la section VIP Mouse Mode pour plus de détails.

Program Preferences > Object Mode
Cette fonction donne le même résultat que l’option Group Objects (du menu
Object), mais permet de sélectionner tous les objets plus rapidement (que les
objets se trouvent sur une ou plusieurs pistes).

Lock all Audio in Time: Les objets ne peuvent pas être déplacés de leur position
temporelle.

Normal: Si vous avez préalablement choisi l’une des options de liaison (Link),
cette option permet d’annuler les liens définis. La sélection d’objets multiples
est possible.

Link Curves to Objects: Cette option permet de coupler les objets et les courbes
de volume et de panoramique qui s’y trouvent. Ainsi, si vous déplacez un objet,
la portion de courbe de volume et de panoramique qui s’y trouve est également
déplacée. C’est particulièrement pratique si les courbes sont faites pour des
objets spécifiques et doivent donc être déplacées avec eux. Dans les autres modes
de liaison «Link» (voir ci-dessous), les courbes sont aussi liées aux objets. La
sélection d’objets multiples est possible.

Link until Silence: Cette option permet de sélectionner et de déplacer tous
les objets d’une piste situés entre le pointeur de la souris et le premier silence
détecté. Ainsi, les parties d’un projet qui sont séparées par des pauses ne seront
pas affectées par les déplacements effectués avant la pause. La multi-sélection
d’objets est possible sur des pistes différentes.

Link one Track: Cette option permet de sélectionner simultanément tous les
objets d’une piste pour, par exemple les déplacer tous sans perdre leurs écarts
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relatifs. La multi-sélection d’objets est possible sur des pistes différentes.

Link all Tracks: Cette option permet de sélectionner simultanément tous les
objets de toutes les pistes afin, par exemple, de tous les déplacer dans le VIP
sans perdre leurs écarts relatifs. Aucune sélection d’objets multiples n’est
possible.

Program Preferences > Edit Keyboard Shortcuts and Menu
Cette fonction ouvre la fenêtre Edit Keyboard Shortcuts où vous pouvez
personnaliser les raccourcis clavier de toutes les options de menu de Samplitude.
Vous pouvez affecter les commandes que vous utilisez le plus à une touche ou
à une combinaison de touches pour pouvoir y accéder très rapidement.

Les réglages de raccourci sont enregistrés dans le fichier Samplitude.ini placé
dans le dossier du programme quand vous quittez ce dernier et entrent en vigueur
au lancement suivant de Samplitude.
Il est également possible de personnaliser les menus et de masquer les options
de menus que vous n’utilisez jamais (exemple : Importer/Exporter pour des
formats de fichiers peu fréquents ou les fonctions Surround). Vous pouvez même
sauvegarder vos propres raccourcis claviers dans un fichier (*.syc; *.men) afin
de les recharger ultérieurement.
L’aspect le plus important de la fenêtre est l’arborescence des menus de
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Samplitude. Cliquez sur l’option de menu à laquelle vous désirez affecter une
nouvelle touche, puis dans le champ «New Shortcut».
Appuyez ensuite sur la ou les touches désirées ou cliquez sur «Assign new
Shortcut». Vous pouvez combiner n’importe quelle touche avec les touches Shift,
Alt et Ctrl.

Note: N’utilisez pas la barre d’espace, la touche Echap, ni la touche Insert car celles-
ci ont déjà une fonction fixe dans Samplitude et cela ne peut pas être changé !

En haut à gauche de la fenêtre se trouve la liste de TOUTES les options de
menu. Servez-vous de la barre de défilement verticale pour parcourir les
différentes options. Vous pouvez sélectionner (surligner) n’importe quelle option
de menu en cliquant sur son nom dans la liste.

Description: Ce champ donne la description de l’option de menu sélectionnée
dans la liste.

New Shortcut: Une fois que vous avez sélectionné l’option de menu désirée,
placez le curseur dans ce champ et saisissez la touche (ou la combinaison de
touches) devant servir de raccourci.

Assign new Shortcut: Après avoir saisi la touche (ou combinaison de touches)
que vous voulez employer comme raccourci, cliquez sur le bouton Assign new
Shortcut pour réellement assigner le raccourci. La ou les touches de raccourci
sont dès lors reprises dans le champ situé au-dessus du bouton «Delete».

Delete: Après avoir sélectionné une option de menu, le fait de cliquer sur le
bouton «Delete» va effacer le raccourci clavier existant.

Shortcut > Save: Permet d’enregistrer les réglages de raccourcis en cours dans
un nouveau fichier. Une fenêtre de dialogue Windows standard apparaît où
vous pouvez donner le nom désiré au fichier de raccourci. Nommez le fichier et
cliquez sur OK. Vos raccourcis sont maintenant sauvegardés

Shortcut > Load: Permet de recharger en mémoire un fichier de raccourcis
préalablement sauvegardé. Une fenêtre de dialogue Windows standard apparaît
où vous pouvez sélectionner le fichier de raccourcis à recharger. Cliquez ensuite
sur OK. Vos raccourcis sont maintenant rechargés.

Show Shortcut List: Affiche une nouvelle fenêtre qui répertorie la liste
complète de tous les raccourcis en vigueur.

Shortcut > Restore Default: Ce bouton permet de rétablir les raccourcis clavier
par défaut de Samplitude.

Show Menu Items: Cliquez sur ce bouton pour que l’option de menu
sélectionnée dans la liste apparaisse dans Samplitude.
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Hide Menu Items: Cliquez sur ce bouton pour que l’option de menu
sélectionnée dans la liste soit masquée dans Samplitude.

Menu > Restore Default: Ce bouton permet de réinitialiser l’affichage des
options de menu (toutes les options sont de nouveau visibles dans le logiciel).

Menu Items > Load/Save: Ces deux boutons fonctionnent comme les boutons
«Load» et «Save» de la section Shortcut (voir ci-dessus)

OK: Ce bouton (situé en haut à droite de la fenêtre) valide les réglages effectués,
puis referme la fenêtre.

Program Preferences > Change Toolbar Style
Cette option permet d’alterner entre l’ancien style d’affichage (non éditable) des
barres d’outils et le nouveau (éditable). Vous devez relancer Samplitude pour
que le changement soit pris en compte.

Program Preferences > Edit Toolbars
Ce sous-menu vous permet de personnaliser le contenu des barres d’outils
visibles dans Samplitude.
La fenêtre de dialogue est simple d’emploi – Choisissez la barre d’outils à
configurer dans le sous-menu, puis ajoutez ou retirez les boutons de votre choix
puis cliquez sur Fermer.
Il est possible de déplacer les différents boutons entre eux sur les barres d’outils
et les séparateurs au moyen des boutons Monter / Descendre, voire de réinitialiser
les barres d’outils sur leur affichage par défaut à l’aide du bouton Réinitialiser.
Toutes les barres d’outils sont flottantes et/ou fixes conformément aux
conventions Windows.
Il suffit de placer le pointeur de la souris au-dessus d’une barre d’outils pour en
afficher le nom et la fonction dans une bulle d’aide.

Raccourci: clic droit directement effectué sur la barre d’outils

Program Preferences > Reset Toolbars
Ce sous-menu vous permet de réinitialiser les différentes barres d’outils
(principale (Main), Positions, Punch, etc.) sur leurs réglages par défaut.

Program Preferences > Grid Lines
Cette option vous permet de sélectionner le type de grille affichée à l’écran lorsque
vous travaillez avec la grille. Pour masquer la Grille, choisissez l’option <None>.

Program Preferences > Video Height
Si un fichier AVI est lié à un projet de Samplitude, sélectionnez cette option
pour définir la hauteur de l’affichage AVI parmi les réglages suivants : 25 Pixels,
50 Pixels, 100 Pixels et 200 Pixels.
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Program Preferences > Font Selection
Sélectionnez ici la police de caractères avec laquelle doivent s’afficher les
différents messages ou textes dans Samplitude.

Note: Si les messages ou les textes sont tronqués, choisissez une autre police de caractère
ou une taille plus petite.

Program Preferences > Font for Time Display
Sélectionnez la police de caractères dans laquelle doit s’afficher le compteur
temporel de Samplitude. Il faut que le Compteur soit ouvert, sinon ce réglage
est sans effet.

Note: Comme il est possible de redimensionner la fenêtre du compteur, le choix de la
taille de police de caractère n’a que peu d’importance. Concentrez-vous plutôt sur la
lisibilité de la police choisie.

Program Preferences > MIDI Options

Vous pouvez accéder aux options MIDI en allant au menu Options -> Program
Preferences -> MIDI Options ainsi que depuis la fenêtre Track Information.

Playback Devices: C’est la liste de tous les périphériques MIDI installés dans
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le système. Vous pouvez ici empêcher les périphériques MIDI non employés
d’apparaître dans la liste des périphériques d’entrée/sortie si vous ne devez jamais
les employer.

Global Play/Record Device: Ces paramètres déterminent les périphériques
MIDI généraux d’entrée et de sortie – pour toute piste MIDI de Samplitude
n’ayant pas été spécifiquement assignée à un périphérique d’entrée ou de sortie.
Ce sont en quelque sorte les ports d’entrée et de sortie MIDI par défaut.

Record Offset: Samplitude vous permet de compenser tout retard pouvant
être introduit par votre configuration MIDI. Il peut parfois être nécessaire de
régler ici de décalage d’enregistrement (Record Offset) si vous constatez de légers
décalages entres vos pistes audio et vos pistes MIDI. Si vous ne rencontrez pas
de problèmes, laissez ce paramètre à 0 ms.

Audio/MIDI Synchronisation: Ce paramètre vous permet de régler la rapidité
du calage des pistes audio de Samplitude sur les pistes MIDI. Sur les ordinateurs
puissants et rapides, vous pouvez indiquer une valeur proche de 100 % afin
d’obtenir une parfaite synchronisation. Par contre, si votre ordinateur ne semble
pas pouvoir tenir une valeur aussi élevée, réduisez-la. Plus la valeur du paramètre
Sync Velocity, est faible, moins le calage des pistes MIDI et audio est précis.

Automatic Volume Fader mode for MIDI Tracks
La réaction du fader de volume de piste peut être changée manuellement à tout
moment (clic droit sur le fader de volume). Quand vous basculez une piste en
mode MIDI ou audio, le fonctionnement du fader de volume de piste peut
toutefois être automatiquement réglé. Le changement automatique des pistes
MIDI pour le contrôleur de volume MIDI est activé par défaut.
Sélectionnez le mode de commande que vous aimeriez activer quand vous faites
passer une piste en mode MIDI (à l’aide du bouton MIDI). Vous pouvez choisir
«Controller 7» (volume MIDI) et «MIDI Velocity scaling». Sélectionnez «Don’t
Change Volume Fader mode» si vous désirez régler le fader de volume de façon
exclusivement manuelle.

Note: Quand vous revenez en mode audio, l’assignation de volume audio initiale est
rappelée.

Info: Cette section vous renseigne sur le moteur MIDI chargé de la reproduction
des pistes MIDI de Samplitude. La plupart des systèmes acceptent le 16 bits.
Les tout nouveaux séquenceurs adoptent aujourd’hui des moteurs MIDI 32 bits
qui offrent une bien meilleure précision sous les environnements 32 bits comme
Windows NT.
Enfin, si vous rencontrez quelques problèmes de fonctionnement, vous pouvez
toujours couper la partie MIDI de Samplitude via l’option «Deactivate all MIDI

functions» afin de voir si le problème vient de là. Samplitude ne peut alors
plus produire de données MIDI dans ses fenêtres de projet.
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Program Preferences > MIDI Options > Hardware Controller
Setup
Samplitude facilite beaucoup le branchement d’un contrôleur physique. Nous
avons préparé quelques pré programmations (presets) pour des contrôleurs
physiques. Vous pouvez les modifier ou totalement les reconfigurer. Prenez
votre temps pour faire cela, car cela nécessite de la concentration.
Vous aurez aussi besoin d’une interface MIDI (pour les contrôleurs fonctionnant
en MIDI) ou d’une interface USB (pour les contrôleurs USB).

Votre contrôleur est-il dans la liste des presets?
Pour savoir, ouvrez la fenêtre MIDI Controller Setup. Pour cela, appuyez sur la
touche «Y». Cliquez ensuite sur l’onglet «MIDI» (ou sélectionnez Program
Preferences > MIDI Options dans le menu Options). Le bouton «Hardware
controller Setup» ouvre la fenêtre de dialogue.
Section «MIDI connection to controller»: Dans le menu déroulant du haut, vous
trouverez une liste des contrôleurs physiques pour lesquels des presets existent.
Parmi eux, vous trouverez les réglages des ports MIDI. Les contrôleurs USB
offrent généralement leurs propres ports MIDI. Les contrôleurs fonctionnant
au travers d’une interface MIDI normale doivent avoir leur port MIDI réglé.
Peu importe que l’équipement soit ou non référencé dans la liste des presets.

Configuration des contrôleurs physiques/Création de vos propres
configurations
Si votre équipement n’est pas dans la liste ou si vous n’aimez pas certains presets
– pas de problème. Samplitude est adaptable ! Dans la section «Samplitude/
Sequoia Function», vous trouverez un menu déroulant avec toutes les fonctions
télécommandables de Samplitude – chacune d’entre elles pouvant être assignée
aux messages du contrôleur. Si vous sélectionnez un élément (par exemple fader
1 pour le premier fader visible dans la table de mixage de Samplitude), activez la
commande à lui appliquer sur votre contrôleur physique et cliquez sur le bouton
«Learn» (apprentissage).

Note: Les contrôleurs physiques dont les faders sont sensibles au toucher envoient des
messages à Samplitude quand le fader est touché (ou relâché), ce qui signifie que le
bouton «Learn» doit être pressé après avoir commencé à déplacer le fader et avant de
l’avoir relâché.

Vous trouverez une explication de chaque paramètre télécommandable dans
Samplitude au bas de la page.
C’est la façon de placer chaque commande de votre contrôleur physique dans
Samplitude. Quand vous avez fini une configuration, sauvegardez-la sous le
nom du contrôleur physique. Dès lors, elle apparaîtra toujours dans la liste des
presets.
Note: Vous pouvez utiliser n’importe quel autre contrôleur MIDI pour
commander Samplitude (par ex. un boîtier de faders MIDI pour contrôler le
volume individuel de chaque piste).
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Voici la liste des paramètres de Samplitude qui peuvent être
télécommandés:
Key 1...8 Clic: Mute on/off

Double clic: Solo on/off
Avec Shift Mode 1: Automation pour les pistes
Avec Shift Mode 2: Plug-ins dans chaque piste
Avec Shift Mode 3: Couplage de paires de

pistes
Avec Shift Mode 4: Enregistrement

d’automation on/off
Link Master Volume Bouton Link on/off en section Master de la
table de mixage
Master Normalize Normalisation du Master
Shift Mode 1 Touche tenue enfoncée: Automation des
pistes on/off via les touches 1...8
Shift Mode 2 Plug-ins on/off via les touches 1...8 (dialogue
si aucun plug-in n’est installé)
Shift Mode 3 Couplage de pistes
Shift Mode 4 (agit comme un commutateur) E n r e g i s t r e m e n t
d’automation (Lecture; l’automation des pistes doit être activée)

1er clic: Enregistrement des mouvements de
faders;

2ème clic: Fin de l’enregistrement
Contrôle les fréquences des 4 bandes du

correcteur Master, le fader servant au réglage du gain
1er clic: Contrôle des fréquences
2ème clic: Retour au contrôle de gain

Stop at position Arrêt à la position actuelle
Play/Stop Reprise depuis la position actuelle /arrêt
Fader 1...8 Commande de volume des 8 premières voies
visibles dans la table de mixage – ou le fader d’éditeur de fondu-enchaîné en
mode Crossfade Editor
Master Vol. left/right Commande le volume Master gauche/droit

Master EQ
Lo/LM/HM/Hi
Gain/Freq. Contrôle le gain des 4 bandes du correcteur
Master. Avec Shift Mode 4: Contrôle les fréquences des 4 bandes du correcteur
Master
Master Stereo Enhancer Contrôle l’enhancer stéréo multibande du
Master
Pitch Factor Facteur de hauteur – sert au repérage (scrub)
durant la lecture. Les changements sont pris en compte même en mode Stop.
La lecture suivante reflète le nouveau facteur de hauteur.
Mute 1...8 Mute des 8 premières voies visibles de la table
de mixage de Samplitude
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Solo 1...8 Solo des 8 premières voies visibles de la table
de mixage de Samplitude
Record Ready 1...8 Armement de voie dans la table de mixage de
Samplitude.
Pot 1...8 Règle la valeur assignée visible de la table de
mixage de Samplitude
Select 1...8 Sélectionne une piste de VIP.
Fadertouch 1...8 Active l’enregistrement d’automation de
volume quand l’automation individuelle de piste est activée. Requis seulement
pour les faders sensibles au toucher.
Shift Touche Shift de modification de fonction des
touches du contrôleur.
Fader Master Détermine le volume Master.
Scrub Mode Scrub on/off.
Scrubwheel FWD Repérage audio (Scrub) vers l’avant
Scrubwheel REW Repérage audio (Scrub) vers l’arrière
Pot Touch 1...8 Pression des VPots sur la Mackie Control
Play Lancement de la lecture
Stop Arrêt de la lecture
Fast FWD Avance rapide
Rewind Retour rapide
Marker Mode: Saut au marqueur précédent/suivant
Object Mode: Sélectionne l’objet précédent/suivant dans la
piste sélectionnée.
Record Lance immédiatement l’enregistrement.
Mixertrack 1 UP Décalage de 2 voies sur la droite.
Mixertrack 1 DOWN Décalage de 2 voies sur la gauche.
Mixertrack 8 UP Décalage de 8 voies sur la droite.
Mixertrack 8 DOWN Décalage de 8 voies sur la gauche.

La manipulation des voies se décale aussi. Toutes les voies de la table de mixage
peuvent être pilotées par le contrôleur physique.

Zoom Zoom contrôlé au curseur (autrement, le VIP
défile verticalement et horizontalement)
Zoom left Zoom vertical arrière
Zoom right Zoom vertical avant
Zoom up Zoom horizontal arrière
Zoom down Zoom horizontal avant

(ne fonctionne que quand la touche Zoom est
activée)
Assig. Pan Les potentiomètres de panoramique (VPots)
1...8 sont assignés.
Assig. Eq Les potentiomètres de correcteur 1...8 sont
assignés.
Assig. Aux Les potentiomètres de niveau de départ AUX
1...8 sont assignés.
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Marker 1...8 Placer les marqueurs 1-8. La tête de lecture
saute à la position du marqueur actuel.
Marker Mode Passage en mode marqueur.
Loop On/Off Bouclage on/off.
Enter Confirmer les changements (OK/Entrée)
Cancel Annuler les changements
Save Sauvegarder les projets ouverts
Undo/Redo Annuler (Rétablir avec «Shift» + «Undo/
Redo»)
Automation Read Diode REC/RDY de MACKIE control –
contrôle visuel de l’enregistrement d’automation.
Automation Signale les courbes d’automation de volume
dans la MACKIE control.
Automation Pan Touch Enregistre l’automation de panoramique
quand la touche est gardée enfoncée
Cursor left Défilement gauche dans un projet ouvert
Cursor right Défilement droit dans un projet ouvert
Cursor up Passage à la piste précédente du VIP actuel

Cursor down Passage à la piste suivante du VIP actuel
Mixer Ouvre la table de mixage
CF Mode Lance l’éditeur de fondu-enchaîné (Crossfade
Editor) de Samplitude
Cut Coupe l’objet sélectionné en deux sur la
position actuelle du curseur
Option Maintenir les touches F1-F4 de la Mackie
control ou une des touches qui leur sont assignées (correspondance F1-F4) pour
changer de mode de crête-mètre.

Program Preferences > Metronome Options
Dans cette fenêtre de dialogue, vous pouvez activer un clic de métronome qui
vous aidera à jouer en mesure pendant l’enregistrement. Vous pouvez choisir
entre un métronome MIDI (nécessitant un générateur de sons MIDI externe
ou interne) et un métronome audio, qui est alors produit par les canaux Master
de la table de mixage.

Active while Playback/Record: Vous pouvez activer le clic pour la lecture
(Playback), l’enregistrement (Record) ou les deux.

Precount for recordings (Measures): Saisissez ici le nombre de mesures
que le métronome battra avant que ne commence l’enregistrement (pré-compte).
Si l’option «Precount clicks only» est cochée, le clic s’arrêtera après le pré-compte
dès que l’enregistrement commencera.
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Audio Metronome
First Beat/Beats: Choisissez ici les échantillons servant au premier temps de
la mesure (First Beat) et aux autres temps de celle-ci (Beats). L’échantillon destiné
au premier temps doit être plus «présent» que l’autre. Le curseur Volume règle
le volume général du métronome. Avec Device, vous pouvez sélectionner le
périphérique de sortie.

Midi metronome
Ici se font les réglages pour le métronome MIDI: le métronome fonctionne
alors par envoi de notes MIDI (généralement sur le canal destiné à la batterie) à
un générateur de sons MIDI interne ou externe, qui est indispensable à la
production de tout clic de métronome. Vous pouvez assigner le port MIDI du
périphérique de sortie (MIDI output device), le canal MIDI (MIDI Channel) et
les valeurs de note et de dynamique (Velocity) pour le premier temps accentué
(First Beat) et les autres temps normaux. Le temps accentué dépend du paramètre
de numérateur dans le réglage de format de mesure en fenêtre Bars/Beats.

Program Preferences > Draw Setup
Veuillez vous référer à «Menu View», «VIP Display Mode > Definition».

Raccourci: Shift + Tab

Program Preferences > Color Setup
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Sélectionnez cette option pour changer les couleurs dans divers affichages de
Samplitude.
Il est possible de choisir la couleur d’affichage de la forme d’onde ou de l’arrière-
plan des objets, des courbes, du fond des pistes, de l’oscilloscope, etc.

Les couleurs d’affichage par défaut de Samplitude offrent une parfaite lisibilité
dans la plupart des situations, mais rien ne vous empêche de les modifier selon
vos goûts. Prenez le temps de tester les différentes couleurs afin d’optimiser
votre environnement de travail.
N’oubliez pas que certaines variations sont également disponibles depuis le
menu View > VIP Display Mode > Definition.

Note: Attention aux couleurs personnalisées qui peuvent parfois s’avérer illisibles à
l’écran. Si par exemple les couleurs de texte et de fond sont identiques, vous ne pourrez
pas voir les informations dans la fenêtre.

Vous pouvez revenir à tout moment sur le code couleur par défaut en cliquant
sur le bouton Restore Original Setup.

Program Preferences > Undo Definitions
Cette commande ouvre la fenêtre Undo Options où vous pouvez définir le
nombre de niveaux d’annulation possibles (Undo Steps) et activer/désactiver la
fonction d’annulation (Undo enabled).
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Vous pouvez indiquer un nombre de niveaux d’annulation différents pour les
VIP (Virtual Actions) et pour les projets Wave. Si vous indiquez la valeur «20»,
les 20 dernières opérations restent en mémoire pour pouvoir être éventuellement
annulées.

Virtual Actions: L’annulation (Undo enabled) et le nombre de niveaux
d’annulation (Undo Steps) peuvent être définis. Il est aussi possible de désactiver
la création de niveau d’annulation quand ce sont des réglages de plug-in DirectX
qui sont modifiés (décocher «Undo for DirectX plugin settings»). Cela améliorera
énormément les performances graphiques lors de l’édition de grands projets
où de nombreux plug-ins DirectX sont employés.

Wave (Destructive): L’annulation (Undo enabled) et le nombre de niveaux
d’annulation (Undo Steps) peuvent être définis. Il est aussi possible de désactiver
la création de fichiers d’annulation à base HDP pour les projets RAM en vue
d’améliorer les performances (décocher «Create temporary Undo file for RAM
wave projects»).

Cancel: Ce bouton referme la fenêtre sans valider les réglages qui y ont été
effectués.

OK: Cliquez sur ce bouton pour valider les réglages de la fenêtre et refermer
cette dernière.

Program Preferences > Dithering Options
Cette commande vous donne accès à la fenêtre Dithering Options. Le Dithering
est utilisé (en temps réel) lors de la conversion d’un fichier de résolution élevée
en un fichier de résolution plus basse, par exemple de 24 bits en 16 bits (en
général pour la gravure d’un CD audio à la norme Red Book). Le dithering ajoute
une toute petite quantité de bruit au signal audio, ce qui empêche les signaux
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audio de bas niveau de souffrir de distorsion due aux erreurs de quantification
(artefacts de troncature). Le très faible bruit introduit par ce processus est moins
gênant à l’oreille que les erreurs de quantification, et c’est donc un bon
compromis.

Dithering Mode (Real-time conversion from float to 8/16/24 Bit)
No dithering, 16bit internal resolution: Tous les calculs en temps réel
sont effectués à une résolution interne de 16 bits. Le Dithering n’est donc pas
requis. Par rapport à la résolution interne normale de 32 bits, cela apporte de
légers avantages en matière de vitesse pour les processeurs lents. Toutefois,
dans ce mode, Samplitude est beaucoup plus susceptible d’écrêter en interne.
Cette option ne doit pas être choisie pour un mixage. Une utilisation possible
est la gravure à haute vitesse et à la volée de fichiers MP3 sur un CD, sans
traitement d’effet. Dans ce mode, il n’est pas possible de travailler avec des
formats Surround.

No Dithering math rounding of sample value: Dans ce mode, aucun
Dithering n’est appliqué et les données audio sont arrondies selon un calcul
mathématique. Même en l’absence de Dithering, ce mode offre une qualité
sonore bien plus avantageuse qu’une troncature pure et simple des bits
excédentaires.
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Dithering with linear spread noise: Dans ce mode, les données audio sont
converties au moyen d’un bruit de très faible niveau réparti sur toutes les valeurs
d’échantillons. Il est possible de régler le niveau de ce bruit au moyen du
paramètre Dithering Depth in Bits (dessous).

Dithering with triangular spread noise: Dans ce mode, les données audio
sont converties au moyen d’un bruit de très faible niveau réparti sur toutes les
valeurs d’échantillon selon un motif triangulaire. On obtient en général un bruit
plus «décentralisé» qu’avec un Dithering linéaire et un résultat plus doux et
plus régulier. Comme le bruit n’est pas modulé par le signal, on obtient un
fondu entre le bruit et le signal atténué. Il est possible de régler le niveau de ce
bruit au moyen du paramètre Dithering Depth in Bits (dessous).

Dithering depth in bits (0.01 - 16.0): Ce paramètre vous permet de régler le
niveau du bruit (en bits) appliqué lors du Dithering. Une valeur située dans la
plage 0.5 – 2.0 donne en général de bons résultats. Mais comme toujours, seules
vos oreilles sont juges !

Conseil d’utilisation : Pour appliquer le Dithering, utilisez le moins de bruit nécessaire
sous peine de générer des artefacts de quantification audibles.

Dithering POW-r
POW-r offre trois modes distincts de dithering.

POW-r #1 (Dithering): utilise une courbe de dithering spéciale pour minimiser
le bruit de quantification.

POW-r #2: (Noise Shaping): utilise une mise en forme du bruit supplémentaire
sur une large plage de fréquences qui peut accroître la dynamique de 5-10 dB.

POW-r #3: (Noise Shaping): utilise une mise en forme du bruit supplémentaire
optimisée qui peut accroître la dynamique de 20 dB dans la plage 2-4 kHz –
plage à laquelle l’oreille humaine est la plus sensible.

Note: La mise en forme du bruit minimise les effets secondaires causés par la réduction
de résolution, en déplaçant le bruit de quantification dans le spectre au dessus de 10
kHz – c’est-à-dire dans la plage à laquelle l’oreille humaine est la moins sensible.

Le mode qui vous semblera sonner le mieux est principalement dépendant du
type de signal et de vos goûts personnels. Le «bon» réglage se déterminera en
écoutant le matériel audio avec chacun des modes de Dithering.

Comment fonctionne le Dithering?
Lorsqu’un signal audio est quantifié, il prend la forme d’un «escalier» dû à la
réduction du nombre des valeurs d’amplitude possibles. C’est ce qui se produit
lors d’une conversion A/N (analogique/numérique) et lors de la conversion d’un
signal vers une résolution inférieure. Un signal 8 bits ne contient que 256 valeurs
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d’amplitude. Cette forme en escalier dénature le signal et provoque par
conséquent de la distorsion sur le signal.
Le fait d’ajouter un bruit de faible niveau au signal audio permet de réduire
sensiblement notre perception de la dégradation du signal.
Vous pourrez trouver de plus amples renseignements sur le Dithering sur le
site www.digido.com
POW-R signifie «Psychoacoustically Optimized Wordlength Reduction»
(réduction de résolution optimisée d’un point de vue psycho acoustique). Pour
plus d’informations sur POW-r, consultez:
http://www.mil-media.com/docs/articles/powr.shtml

Quand employer le Dithering dans Samplitude?
Le Dithering est toujours appliqué lors de la conversion d’un fichier 32 bits à
virgule flottante en 16 bits. Cela se produit dans les cas suivants:
1. Lecture de projets virtuels sur des cartes son 16 bits alors que la précision

interne est réglée sur 32 bits.
2. Lecture de projets Wave haute résolution sur des cartes son 16 bits.
3. Gravure d’un CD audio en temps réel en utilisant une précision interne de 32

bits à virgule flottante.
4. Report de pistes de projets virtuels contenant des données de n’importe quelle

résolution  alors que la précision interne est réglée sur 32 bits à virgule flottante
et que le format de destination a une moindre résolution.

5. Conversion de projets Wave en projets Wave de résolution inférieure.

Program Preferences > Advanced Buffer Settings
Veuillez vous référer à «Menu Options», «System/Audio», «Playback Devices».

Resampling Quality Options
Cette fenêtre vous permet de régler la qualité de rééchantillonnage (resampling)
employée lorsque ce dernier sert dans le programme.

Le rééchantillonnage peut créer de l’Aliasing. Pour éviter cela dans les situations
délicates, vous pouvez activer un algorithme de rééchantillonnage de haute
qualité, mais cela entraîne une charge importante pour le processeur, souvent
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indésirable.
Les réglages de qualité de rééchantillonnage peuvent être faits pour
l’enregistrement (Record), la lecture (Playback) ou les objets (Object):
Record Resampling: Le rééchantillonnage sert lors de l’enregistrement depuis
un DAT (dont la fréquence d’échantillonnage est 48 kHz) dans un projet Wave
standard à 44.1 kHz. Par défaut le réglage est High (haute qualité).

Playback Resampling: Sert au repérage audio (Scrub) et à la fonction Varipitch.
Par défaut le réglage est Normal, car l’audio rééchantillonné n’est destiné qu’à
un contrôle auditif.

Object resampling for new objects: Le rééchantillonnage sert lors du
chargement d’un projet Wave ayant une fréquence d’échantillonnage différente
de celle du VIP. Par défaut le réglage est High (haute qualité). Vous pouvez
changer le niveau de qualité dans l’éditeur d’objet (Object Editor> onglet
Timestretching > Edit >Anti Aliasing Filter).

Program Preferences > Object Lock Definition
Cette commande vous donne accès à la fenêtre Object Lock Definitions servant
aux définitions de verrouillage des objets. Veuillez vous référer au menu Object
> Lock Objects > Lock Definitions pour plus de détails.

Program Preferences > Set PreRoll Time
Cette option règle la durée de pré-défilement pour les opérations de simulation
de montage (les fonctions de simulation sont situées dans la barre d’outils
d’enregistrement à la volée ou Punch-In).
Ce temps de pré-défilement détermine combien de temps avant le début de la
sélection démarre la lecture.

Program Preferences > Destructive effect calculation
Veuillez vous référer au chapitre sur le menu «Offline Effects».

System/Audio
Cette commande vous permet d’accéder directement à certains éléments du
menu «Options».

Raccourci: «Y»
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System/Audio > Playback Devices

Les cartes son/sorties de cartes son installées sont affichées dans la grande fenêtre
du haut. Une petite fenêtre s’ouvre quand on clique sur le bouton Device Info.
Cette nouvelle fenêtre affiche des informations (fréquences d’échantillonnage
acceptées, fabricant, etc.) sur la carte son sélectionnée dans la fenêtre adjacente.
Les périphériques non nécessaires peuvent être désactivés en décochant leur
case. Ils ne seront alors plus affichés dans la liste des périphériques dans les
propriétés de piste ni dans la table de mixage. L’ordre dans lequel les sorties
apparaissent dans la liste peut aussi être changé avec les boutons flèches sous
l’intitulé Order; les périphériques peuvent être renommés avec le bouton
Rename.

Driver Resolution/Driver Communication
Sélectionnez la résolution voulue pour les échanges avec le pilote audio durant
la lecture et l’enregistrement. La sélection de la résolution se fait en général
automatiquement. Si le périphérique de sortie ne peut pas produire la résolution
requise (par ex. 24 bits), la résolution inférieure correspondant est alors
automatiquement créée par Samplitude (avec Dithering) et transmise aux pilotes.
Dans certaines circonstances, par ex. si le pilote produit des messages d’erreur
(car il indique accepter certaines résolutions mais ne peut en fait pas les lire/
enregistrer), vous pouvez forcer la résolution en 16 bits.

Driver System
Vous pouvez choisir entre MME, WDM (Multichannel) et ASIO.
MME est le système Windows de pilote multimédia.
WDM (Multichannel): essayez d’employer ce pilote si votre carte son accepte la
lecture en 24/32 bits et que des problèmes surviennent quand vous reproduisez
des fichiers audio à haute résolution.

ASIO
Les pilotes ASIO ont certains avantages sur les pilotes MME (à condition que
votre carte son soit fournie avec des pilotes ASIO):
– Faible latence du pilote: Cela donne des temps de réponse considérablement

plus courts pour le traitement en temps réel. Cela permet l’écoute logicielle
des entrées (et des instruments VST). La charge imposée au processeur
diminue et des effets de plus haute qualité sont possibles sans opérations de
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report de pistes.

– La synchronisation entre l’enregistrement et la lecture se fait au niveau du
pilote. Cela assure une parfaite synchronisation des enregistrements
supplémentaires (overdubs). Cela autorise aussi des mécanismes de
compensation de latence pour les effets, permettant une écoute des effets
logiciels.

– De plus, l’ASIO offre une méthode générale de traitement de l’audio
multicanal. Tous les problèmes de résolution et d’audio multicanal qui
surviennent avec des pilotes WDM sous Windows 2000/XP sont évités.

– Des options perfectionnées d’écoute matérielle sont possibles grâce au
monitoring direct ASIO (routage flexible incluant panoramique et niveau).

ASIO Setup
ASIO Device: Les pilotes des périphériques ASIO actuellement disponibles dans
le système sont référencés ici. Le bouton Control Panel ouvre le dialogue de
configuration (Setup) du pilote de la carte son. Vous trouverez plus
d’informations dans le manuel de la carte son.

Buffer Settings
VIP Buffer: Comme une lecture sans erreur est généralement plus importante
que des temps de réponse courts, cette valeur doit être montée à environ 8000
lorsque de nombreuses pistes doivent être reproduites.

Buffer Number: Vous pouvez déterminer ici combien des buffers (mémoires
tampons) décrits ci-dessus doivent être utilisés. Plus de buffers augmentent la
sécurité, mais aussi les besoins en mémoire et les temps de réponse. L’utilisation
actuelle des buffers durant la lecture s’affiche en bas à droite de la barre d’état.
Ce sont les seuls réglages intervenant lors de la lecture de projets virtuels et lors
du travail avec la table de mixage.

Advanced Buffer Settings
Cette fenêtre donne accès aux réglages poussés des buffers et permet leur
optimisation pour le VIP, le cache de disque dur et les plug-ins. Il n’est
normalement pas nécessaire de les changer. Si vous rencontrez des problèmes,
essayez les presets fournis.

Program Buffer (in Stereo Samples)
Ce sont les réglages des buffers du programme, exprimés en échantillons

stéréo.

VIP Buffer: Comme une lecture sans erreur est généralement plus importante
que des temps de réponse courts, cette valeur doit être montée à environ 8000
lorsque de nombreuses pistes doivent être reproduites.

HD/Scrub Buffer: Cette mémoire tampon est réservée à la lecture directe des
projets HD Wave. Pour un meilleur temps de réaction, essayez des valeurs plus
faibles !
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Test Buffer: Cette mémoire tampon est réservée uniquement aux opérations
de pré-écoute en temps réel des effets.

Buffer Number: Vous pouvez déterminer ici combien des buffers (mémoires
tampons) décrits ci-dessus doivent être utilisés. Plus de buffers augmentent la
sécurité, mais aussi les besoins en mémoire et les temps de réponse. L’utilisation
actuelle des buffers durant la lecture s’affiche en bas à droite de la barre d’état.

HD Performance (Track Speed)
Preview time for caching: Nombre de secondes du VIP qui doivent être
préchargées dans le cache.

Preload at Play Start: Détermine le pourcentage du cache à charger au
démarrage de la lecture. Des valeurs élevées retardent le démarrage mais
accroissent la stabilité quand la lecture implique un grand nombre de pistes.

Preload File Cache during Play Stop: Quand cette option est cochée et que
vous positionnez le curseur de lecture, le cache du fichier est toujours préchargé.
Dans la ligne d’état, le message «Cache Preloaded» apparaît. La lecture démarre
très vite puisque toutes les données audio nécessaires sont déjà en RAM.

Plug-in Buffer
Les quatre champs de saisie numérique définissent indépendamment les tailles
de buffer des deux types de plug-in ainsi que la résolution (en échantillons)
pour l’automation de plug-in VST. Toutes les tailles de buffer peuvent être réglées
comme le pilote ASIO en choisissant «-1» comme valeur. Choisir «0» signifie
qu’il n’y a pas de limite pour la taille de buffer.

DirectX preload buffer size: Si aucune valeur n’est saisie ici, la totalité de la
taille du buffer sert à l’initialisation du démarrage de DirectX.

System/Audio > Record Devices
Les cartes son installées ou périphériques d’enregistrement disponibles sont
affichés dans la grande fenêtre du haut. Une petite fenêtre s’ouvre quand on
clique sur le bouton «Device Info». Cette nouvelle fenêtre affiche des
informations (fréquences d’échantillonnage acceptées, fabricant, etc.) sur la carte
son sélectionnée dans la fenêtre adjacente.

Monitoring Settings (Record Devices)
Il existe plusieurs possibilités d’écoute de contrôle ou «monitoring». Ces réglages
concernent les nouveaux projets. Vous trouverez plus d’informations sur le
monitoring dans le chapitre «Menu Play/Rec«.

System/Audio > MIDI/Metronome Options
Veuillez vous référer à «Menu Options > Program Preferences > MIDI/
Metronome Options».
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System/Audio > Program Options
Opens VIP and Record Window on Program Start: Cochez cette option et
Samplitude ouvrira automatiquement un VIP et une fenêtre d’enregistrement
au démarrage du programme.

Open Wave Projects in destructive editing mode: Samplitude propose un
mode d’édition non destructif sélectionné par défaut pour ouvrir
indépendamment les projets. Autrement dit, toutes les opérations d’édition et
tous les réglages d’effets, de volume, de fondu et les autres restent totalement
virtuelles dans les projets VIP et les projets Wave (WAV, RAP, HDP) - les données
audio ne sont donc pas altérées. Vous pouvez ainsi choisir tranquillement le
bon point de coupure, le bon réglage de niveau ou d’effet, etc. sans risquer de
perdre vos données audio ou de les modifier irrémédiablement. Servez-vous du
menu «workspace» (environnement de travail) situé en bas à gauche de la fenêtre
des projets Wave pour sélectionner le mode «destructive editing» (édition
destructive) ou «Wave editing» (édition non destructive).
Si vous préférez le mode d’édition destructive, cochez cette case pour que
l’ouverture des projets Wave se fasse en mode d’édition destructive.
Notez que l’ouverture de projets Wave directement depuis le VIP, donc dans le
contexte d’un objet, entraînera dès lors le travail en en mode d’édition destructive.

Check Space key for playback stop also in background: Cochez cette case
pour que la barre d’espace puisse tout de même lancer/arrêter la lecture de
Samplitude même si vous vous trouvez sur la fenêtre d’un autre logiciel. Si
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vous souhaitez utiliser la barre d’espace dans l’autre programme (sans
interrompre la lecture de Samplitude) veillez à ce que cette case ne soit PAS
cochée.

Performance Display: Lorsque cette option est cochée, un témoin indique la
consommation des ressources DSP dans le coin inférieur gauche de l’écran.
Assurez-vous de ne jamais atteindre les 100 % pour éviter que la lecture ne se
bloque.
Si un projet sollicite trop de ressources système, vous pouvez:
– Réduire le nombre d’effets DSP en vigueur dans la table de mixage et dans

l’éditeur d’objet.
– Réduire le nombre de pistes comportant des objets audio.
– Augmenter la taille du VIP Buffer à 16000 ou 32000 échantillons (Menu

Options > Système/Audio >Playback Devices).

Des suggestions vous sont toujours proposées dans la barre d’état de Samplitude
en cas de problèmes si les limites de votre processeur sont dépassées (lors de
l’utilisation du réducteur de bruit ou du correcteur/analyseur FFT, par exemple).

Show Project ToolTips: Cette option permet d’activer/désactiver l’affichage
des bulles d’aide de Samplitude en fenêtre VIP. Vous pouvez choisir une
première option simple ou une seconde option dite «extended». Cette dernière
affiche des informations détaillées sur l’élément sélectionné et sur les raccourcis-
clavier qui s’y rapportent.

Disable Menus and Buttons if Function is not available: Lorsque cette
case est cochée, seules les options de menus disponibles s’affichent. Les options
non disponibles sont, quant à elles, grisées. Certaines fonctions du menu Offline
Effect ne sont pas disponibles depuis la fenêtre VIP (ces effets sont applicables
uniquement en édition destructive). Dans ce cas, les fonctions non disponibles
sont grisées à l’écran. Si cette case n’est pas cochée, TOUTES les fonctions
s’affichent normalement, même si elles ne sont pas accessibles. Nous vous
recommandons de laisser cette case cochée.

Pentium III Optimizations: Samplitude est optimisé pour les extensions
d’algorithmes du processeur PIII. Activez cette option si votre PC est équipé
d’un processeur Pentium III.

Preview Time (Seconds): Fixe la durée de la pré-écoute de TOUS les traitements
et calculs effectués en différé/Offline. Exemple : Si vous réglez ce paramètre
sur 10 secondes, cliquer sur le bouton Preview du simulateur d’espace (room
simulator) fera calculer à Samplitude une portion de 10 secondes du signal audio
résultant de l’effet.

Treat knobs like faders: Quand cette option est cochée, vous pouvez régler
une commande rotative en cliquant dessus et en tirant la souris vers le haut et le
bas (comme avec les faders). Si elle ne l’est pas, vous pouvez «tourner» une
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commande rotative en cliquant dessus et en tirant la souris en cercle autour
d’elle. Pour une meilleure résolution de commande, vous pouvez augmenter le
rayon du cercle ainsi décrit.

Hide Wave Projects loaded into virtual Projects: Les fenêtres des projets
Wave Chargés directement dans le VIP sont par défaut masqué car cette case
est cochée (pour maintenir la lisibilité sur le bureau du programme, car le
programme considère que vous ne désirez travailler avec eux que dans le VIP).
Vous pouvez changer ce comportement en décochant cette case.
Vous pouvez afficher tous les projets Wave avec la commande «Window>Iconise
all Wave Projects» et les masquer à nouveau avec «Window>Hide all Wave
Projects».

Reset all «Don’t show this message again» boxes: Après son installation,
Samplitude affiche beaucoup de questions de sécurité en plusieurs endroits
dans le programme. Vous pouvez les désactiver un par un en cochant la petite
case «Don’t show this message again!» (ne plus afficher ce message) qui apparaît
en bas de chacune de ces fenêtres. Si vous désirez à nouveau voir ces messages,
cliquez sur ce bouton.

Preroll time: Quand vous accomplissez des simulations d’édition (Play from/
to Cut start/end, Play over Cut dans le menu «Play/Rec»), alors la lecture
démarrera/s’arrêtera de part et d’autres de cet sélection à une distance déterminée
par la valeur choisie ici.

Maximum Reverb time for objects without fadeouts: Le temps réglé ici
correspond à la durée du calcul d’effet après la fin de l’objet pour éviter une
coupure artificielle de la reverb. Assurez-vous que le volume de l’objet est placé
avant la reverb dans la chaîne des effets ou cela ne fonctionnera pas avec les
objets qui ont un fondu de sortie.

Preview time: Détermines la durée de la fonction de pré-écoute test dans diverses
fenêtres de dialogue.

Dithering Options/Advanced Buffer Settings/Undo Definitions/Object

Lock Definitions …: Vous disposez d’accès directs à ces éléments de menu.
Veuillez vous référer aux chapitres correspondants dans le menu «Options»!

OK: Cliquez sur ce bouton pour accepter les réglages actuels et fermer cette
fenêtre.
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System/Audio > Path/Skins

Chemins d’accès (Paths)
New Virtual Projects: Définit où sont sauvegardés tous les nouveaux VIP et
les fichiers Wave nouvellement enregistrés et importés.

Project Files: Tous les autres fichiers WAV qui ne sont pas sauvegardés sur le
disque dur et qui ne peuvent pas être assignés à un VIP concret sont sauvegardés
ici.

FTP Download: Tous les fichiers téléchargés via le client FTP intégrés arrivent
ici.

Temporary files: Dossier par défaut pour les fichiers temporaires. Ce dossier
doit être sur un disque dur/partition ayant suffisamment d’espace de stockage.

VST-Plug-ins: Définit le chemin d’accès aux effets plug-in VST et aux instrument
VST. Au démarrage et si le chemin d’accès VST existe, une analyse de VST est
lancée quand les réglages de piste sont ouverts pour la première fois. Si plusieurs
plug-ins VST sont installés, cela peut prendre plusieurs minutes. Tous les plug-
ins sont alors cochés pour pouvoir être exploités dans Samplitude. Toutefois,
cette analyse ne doit être faite qu’une fois. Tous les plug-ins VST utilisés sont
sauvegardés. Si vous avez plusieurs dossiers de plug-ins VST, vous pouvez définir
un autre dossier qui à son tour ne nécessitera qu’une seule analyse. Samplitude
détecte automatiquement les nouveaux plug-ins installés, à condition qu’ils le
soient à l’emplacement indiqué ici.
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Skin
Vous avez la possibilité d’afficher le projet, la table de mixage et le panneau de
transport sous différentes apparences. Ces apparences ou «Skins» vous
permettent de changer les couleurs et des parties de l’affichage graphique de
Samplitude.
Il y a des Skins particulièrement adaptés à différentes situations de travail, comme
«Multi-Track Mixer», qui aide à conserver une vue générale en enregistrement
à partir de nombreuses sources.
D’autres Skins peuvent être téléchargés sur http://www.samplitude.com
Vous pouvez aussi choisir entre différents Skins sur la gauche de la barre de
titre dans le menu de système de la fenêtre correspondante (table de mixage,
VIP).

System/Audio > View Options
Veuillez vous référer à «Menu View > VIP Display Mode».

System/Audio > Colors
Veuillez vous référer à «Menu Options > Program Preferences > Color setup».
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Cascade
Cette commande cascade toutes les fenêtres ouvertes.

Tile
Cette commande organise toutes les fenêtres ouvertes en mosaïque.

Raccourci: Retour

Untile
(Raccourci: Shift + Retour) - Cette commande ramène les fenêtres dans la position
qu’elles avaient avant d’avoir lancé la commande Tile.

Arrange Icons
Cette commande aligne toutes les icônes (fenêtres réduites) au bas de l’écran.

Main Toolbar
Sélectionnez (activez) cette commande pour afficher la barre d’outils principale.
Désélectionnez (désactivez) cette commande pour masquer la barre d’outils
principale.

Position bar
Sélectionnez (activez) cette commande afin d’afficher la barre de position.
Désélectionnez (désactivez) cette commande pour masquer la barre de position.

Punch/Play bar
Sélectionnez (activez) cette commande afin d’afficher la barre enregistrement/
lecture. Désélectionnez (désactivez) cette commande pour masquer la barre
enregistrement/lecture.

Mouse Mode Toolbar
Sélectionnez (activez) cette commande afin d’afficher la barre de mode souris.
Désélectionnez (désactivez) cette commande pour masquer la barre de mode
souris.

Range bar
Sélectionnez (activez) cette commande afin d’afficher la barre de sélection.
Désélectionnez (désactivez) cette commande pour masquer la barre de sélection.

Workspace bar
Les environnements de travail (»workspaces») sont conçus pour vous aider à
organiser les très nombreuses commandes de menus et les boutons de barres
d’outils afin de mieux visualiser les fonctions de Samplitude. Les menus et barres
d’outils regroupent des commandes que vous n’utilisez jamais ou uniquement
à une certaine étape de votre travail.
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Les versions précédentes de Samplitude offraient déjà la possibilité de masquer
certaines commandes des menus (menu «Options>Program Preferences>Edit
Keyboard shortcuts and menu....») et certaines barres d’outils (menu «Window»)
et de réorganiser les commandes des barres d’outils (»Options>Program
Preferences>Edit toolbars» ou simplement un clic droit sur la barre d’outils).
Un environnement de travail regroupe tout cela et offre la possibilité de
sauvegarder une telle configuration sous un nom particulier.
Plusieurs environnements de travail conçus pour différentes tâches
(enregistrement, édition, Mastering CD) ont été prédéfinis par l’équipe de
développement de Samplitude. L’environnement de travail «Power User» affiche
l’intégralité des commandes des menus et des barres d’outils. Il s’adresse aux
utilisateurs expérimentés ou à ceux qui veulent construire leur propre
environnement de travail personnalisé.

New workspace: Créez un nouvel environnement de travail avec «New
Workspace» (menu contextuel obtenu d’un clic droit sur Workspace en bas à
gauche de la fenêtre). Les réglages actuels sont alors copiés dans cet
environnement de travail et tous les changements faits à partir de maintenant y
sont conservés. Vous n’avez pas à sauvegarder expressément votre nouvel
environnement de travail.

Edit workspace: La partie haute vous permet de sélectionner les barres d’outils
à afficher, la partie moyenne de les personnaliser, tandis que Edit ouvre la fenêtre
autrement obtenue avec «Options > Program Preferences > Edit Keyboard
shortcuts and menu....».

Button bar
Affiche/masque la barre de boutons au bas de l’écran. Les boutons de la barre
de boutons vous permettent d’ouvrir/fermer les fenêtres principales de
Samplitude.

Status bar
Sélectionnez (activez) cette commande afin d’afficher la barre d’état.
Désélectionnez (désactivez) cette commande pour masquer cacher la barre d’état.

Mixer
Cette commande ouvre la fenêtre de la table de mixage.

Raccourci: «M»

Time Display
Cette commande ouvre la fenêtre du compteur horaire.

Voir chapitre «Fenêtre VIP – description détaillée» pour plus d’informations.
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Visualization
Choisissez cette option pour ouvrir la fenêtre de visualisation.

Voir chapitre «Fenêtre VIP – description détaillée» pour plus d’informations.

Transport Control
Choisissez cette option pour ouvrir le panneau de transport flottant.

Voir chapitre «Fenêtre VIP – description détaillée» pour plus d’informations.

Raccourci: Shift + T

Close all Windows
Cette commande referme toutes les fenêtres ouvertes.

Raccourci: «Ctrl + H»

Iconise all Wave Projects
Cette commande réduit au minimum (barre de titre) la fenêtre de tous les projets
HD Wave.

Hide all Wave Projects
Cette commande masque toutes les fenêtres des projets Wave.

Half Height
Cette commande réduit de moitié la taille de la fenêtre de Samplitude. Ceci est
particulièrement utile si vous faites tourner un autre logiciel en multitâche.
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Help
Cette commande ouvre l’aide en ligne de Samplitude. Par défaut, l’aide en ligne
s’ouvre sur une fenêtre d’informations sur les projets (HDP, RAP et VIP) avec
un gros plan sur la fenêtre VIP.

Help Index...
Cette commande affiche la table des matières de l’aide en ligne de Samplitude.

Context Help...
Cette commande active l’aide contextuelle de Samplitude. Le pointeur de la souris
prend la forme d’un point d’interrogation. Il suffit alors de cliquer sur n’importe
quelle commande ou fonction pour afficher la rubrique d’aide correspondante.

Raccourci: Shift + F1

About Help...
Cette commande donne accès à des informations qui vous expliquent comment
utiliser l’aide en ligne de Samplitude.

Start wizard/Tip of the day
Cette commande affiche l’assistant d’ouverture («Start wizard») et l’astuce du
jour («Tip of the Day»).

About Samplitude...
Cette commande vous donne accès à diverses informations sur Samplitude.
Vous y retrouverez votre numéro de licence.

System Information...
Une fenêtre s’ouvre avec des informations sur la mémoire et sur d’autres
paramètres.
L’affichage de l’espace libre sur tous les disques connectés, des ressources du
système consommées par Samplitude et de l’utilisation de la mémoire est
particulièrement utile. Vérifiez que la mémoire de système consommée par
Samplitude ne dépasse jamais la mémoire totale disponible dans le système
(RAM physique). Si cela se produit, les performances de Samplitude seront
réduites à cause du recours à la mémoire virtuelle pour compenser le manque
de mémoire.
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Quand le programme est lancé pour la première fois, seules les barres d’outils
et de mode de souris sont ouvertes en haut à gauche du moniteur. Toutes les
autres peuvent être ajoutées via le menu «Window».
Toutes les barres d’outils peuvent être placées selon vos désirs n’importe où sur
l’écran, et elles sont automatiquement arrangées dans la partie supérieure de
l’écran si vous double-cliquez sur la ligne d’en-tête.

Barre d’outils (gauche)

   1     2    3    4           5    6    7    8    9        10       11    12   13   14   15

1 Nouveau projet virtuel
2 Ouvrir projet virtuel
3 Ouvrir fichier audio
4 Sauvegarder projet
5 Couper
6 Copier
7 Coller
8 Partager  objet
9 Annuler
10 Rétablir
11 Magnétisme
12 Mode fondu-enchaîné automatique
13 Editeur de fondu-enchaîné
14 Grouper objets
15 Dégrouper objets

Barre d’outils (droite)

   1    2    3    4     5    6    7      8   9     10   11    12   13   14

1 Placer marqueur
2 Placer marqueur de plage de CD
3 Placer sous-index de CD
4 Placer index de pause de CD
5 Placer index de fin de CD
6 Index automatiques de plage de CD
7 Graver CD
8 Lecture unique
9 Lecture en boucle
10 Lecture en sélection
11 Stop
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12 Options d’enregistrement
13 Enregistrement
14 Table de mixage

Barre d’enregistrement à la volée/lecture

   1     2      3   4     5     6     7    8    9   10    11

1 Lecture jusqu’au début de sélection
2 Lecture depuis le début de sélection
3 Lecture jusqu’à la fin de sélection
4 Lecture depuis la fin de sélection
5 Lecture hors sélection
6 Mode Punch-In
7 Enregistrement Punch-In
8 Marqueur de début d’enregistrement à la volée (Punch In)
9 Marqueur de fin d’enregistrement à la volée (Punch Out)
10 Supprimer marqueur d’enregistrement à la volée
11 Mode d’entrée directe

Barre de mode de souris
Pour les fonctionnalités des modes de souris, voir «Menu Options > Program Preferences
> VIP Mouse Mode«.

   1     2    3    4    5    6      7     8     9   10   11    12   13    14    15  16  17   18   19

1 Mode universel
2 Mode sélection
3 Mode objet
4 Mode courbe
5 Mode objet et courbe
6 Mode Samplitude 4.0
7 Mode coupe
8 Mode Pitchshift/Timestretch
9 Mode de traçage de volume
10 Mode de traçage de panoramique
11 Mode de dessin à main levée (projets Wave seulement)
12 Mode de repérage audio (Scrub)
13 Mode Zoom
14 Arranger tous les objets
15 Mode objet normal
16 Couplage courbe-objet
17 Sélection des objets avant le silence
18 Sélection des objets d’une piste
19 Sélection des objets de toutes les pistes
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Barre de position

  1     2    3    4      5    6     7   8       9    10   11    12   13   14   15   16   17   18  19

1 – Au début
2 – Demi-section à gauche
3 – Demi-section à droite
4 – A la fin
5 – Bord d’objet gauche
6 – Bord d’objet droit
7 – Vers marqueur précédent
8 – Vers marqueur suivant
9 – Zoom sur tout le projet
10 – Zoom sur sélection
11 – Grossissement 1 pixel pour 1 échantillon
12-15 – Plage de zoom 1 s, 10 s, 60 s ou 10 min
16 – Zoom avant vertical
17 – Zoom arrière vertical
18 – Zoom pour tout afficher verticalement
19 – Zoom vertical sur la sélection
20-21 – Zoom avant/arrière sur l’onde

Barre de sélection

  1    2      3     4      5    6     7    8     9

1 –Tête de lecture au début de la sélection
2 – Tête de lecture à la fin de la sélection
3 – Déplacement d’une longueur de sélection à gauche
4 – Déplacement d’une longueur de sélection à droite
5 – Début de sélection sur le point d’amplitude zéro précédent
6 – Début de sélection sur le point d’amplitude zéro suivant
7 – Fin de sélection sur le point d’amplitude zéro précédent
8 – Fin de sélection sur le point d’amplitude zéro suivant
9 – Editeur de sélection
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A

A, B, C  344
A.R. Capacity  107
A/B/C  342
Abort  124
About Help...  536
About Samplitude...  536
Absolute  85, 462
Absorption  381, 386
AC 3  235
Accentuation ou réduction du registre  354
Accès aux projets Wave   506
Accuracy vs. CPU  119
Act  52
Activate next track  316
Activate previous track  316
Active  496, 498
Active while Playback/Record  517
Actualiser Formes d’Ondes  298
«Adaptive Release»  107
Add drive  436
Add Time  427
Additional Punch Start/End Marker  474
Advanced Buffer Settings  526
Advanced Dynamics  358, 364
Advanced Tempo Mapping  178
Affichage de réduction (Red.)  365
Affichage de sortie (Out)  365
Affichage d’entrée (In)  365
Affichage des événements coupés  165
Affichage des événements filtrés  164
Affichage et masquage des pistes  91
Affichage forme d’onde  302
Affichage temporel L/E  48
Ajout d’effets à un fichier audio  72
Algorithme de réduction de bruit  381
Algorithmes de Pitchshifting/Timestretching  407, 456
Algorithms  131
Alias  437
All  347
All instrument outputs to one track  188
All Tracks  99, 314
All tracks  313, 315
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All tracks with same input device  186
Allow Bonus Tracks before Track 1  445
Alt  324
Alt-clic gauche  141
Alternance Rouge/Bleu   303
Am|pulse  109
Am|track  102
Amp simulation  398
Amplifier  394
Amplitude d’un instrument  354
Amplitude/Normalize > Fade In/Out  338
Amplitude/Normalize > Normalize  336
Amplitude/Normalize > Normalize (quick access)  337
Amplitude/Normalize > Set Zero  339
AmpSimulation  146
Analyse et filtrage de la réponse en fréquences d’  353
Analysis Accuracy Noise  350
Analysis Accuracy Tones  350
Analysis Precision High  350
Analysis Precision Normal  350
Analysis Time(s)  351
Analyze > Filter  348
Analyze all  348
Angle – Mode (Mode angulaire)  230
Annulation (Undo)  101
Append Projects  293, 295
Application de la réponse en fréquences capturée  355
Application de la réponse en fréquences capturée d  355
Application de l’éditeur Elastic Audio  134
Application d’effets et mixage en cours d’enregist  475
Applications  475
Appliquer le tempo de l’Objet à celui de l’arrange  125
Appliquer le tempo de l’objet au VIP  124
Apply Arrangement Tempo to Object tempo  124
Apply Object Tempo to Arrangement Tempo  125
Apply Object Tempo to Arrangement Tempo (Appliquer  125
Arrange Icons  533
Arrêt  47
Arrière-plan   305
Artifact Suppression  382
ASIO  525
ASIO Setup  526
Assign all tracks to different mono/stereo devices  482
Assign all tracks to stereo master  482
Assign MIDI output to VSTi  188
Assign new Shortcut  510
Assignation de réponses impulsionnelles stéréo aux  239
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Index
Assistance  24
Astuces d’emploi de la simulation de bande:  109
Astuces pour le travail créatif avec am|pulse  112
Astuces sur le maniement des instruments virtuels  195
Attack  105, 367, 371
Attack/Release  362
Audio  313
Audio device settings  222
Audio device settings: Save/load in preset  222
Audio File (fichier audio)  64
Audio Metronome  518
Audio/MIDI Synchronisation  513
Auto Crossfade  329
Auto Crossfade Active  296
Auto Crossfade Mode  493
Auto Makeup Gain  107
Auto Number  426
Automate next parameter  190
Automatic Volume Fader mode for MIDI Tracks  513
Automation  144, 235, 261
Automation avec les données audio/MIDI  199
Automation de timbre  135
Automation de timbre sans changement de longueur (  135
Automation d’instrument  194
Automation MIDI  182
Automation/Controller  314
Automation: Instruments et plug-ins VST  199
Automatiquement  184
AutoRec  149
AutoSave Mode:  494
Autoscroll  461
Autres caractéristiques (certains des changements  26
Autres exigences  20
Autres habillages («Skins») de la table de mixage  141
Autres pays  24
Aux  144
AUX Sends (départs auxiliaires)  60
Avance rapide  47
Axe des Y  128, 129

B
Balance  61
Band 1..4  370
Band Separation  341, 370
Bank  190
Bar /Beats (project)  314
Bar/BPM  494
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Index
Barre de défilement horizontal  44
Barre de défilement vertical  44
Barre de grille/marqueurs  261
Barre de mode de souris  538
Barre de position  539
Barre de sélection  539
Barre d’enregistrement à la volée/lecture  538
Barre des boutons  45
Barre d’espace de travail  45
Barre d’état (Status Bar)  50
Barre d’outils  133
Barre d’outils (droite)  537
Barre d’outils (gauche)  537
Barre d’outils de zoom  45
Bases  130
Batch Processing (Traitement par lots)  284
Beat marker (Marqueur de temps)  456
Beat marker slicing  408
Beat marker slicing et Beat marker stretching  409
Beat marker stretching  409
Beat recognition threshold  410
Besoins de stockage  217, 218, 219
Besoins en matière de disque  20
«Bias»  108
Bienvenue  3
Bleu clair  399
Boîte de dialogue Play parameter  85
Bouclage d’objets  74
Bounce selected  448
Bouton -/+  40
Bouton cadenas  261
Bouton clé  261
Bouton de monitoring manuel  40
Bouton Format Settings  280
Bouton In  48
Bouton Link  143
Bouton Lock (verrouillage)  40
Bouton Loop  49
Bouton Marker  48
Bouton MIDI  41
Bouton Mute  40
Bouton Out  48
Bouton Pan  41
Bouton Plug-ins (PL)  43
Bouton Punch  48
Bouton Rec (armement en enregistrement)  40
Bouton Record  471
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Index
Bouton Record Pause  471
Bouton Solo  40
Bouton Stop  471
Bouton Sync  48
Bouton Verrou d’objet   305
Bouton Vol (courbes de volume)  41
Boutons à icône copier/coller  417
Boutons Copier/Coller  99
Boutons de marqueurs 1-12  48
Boutons de masquage  149
Boutons de menu Zoom  44
Boutons de piste: Solo, Mute, Rec, Lock, Vol, Pan  40
Boutons de zoom VIP  43
Boutons flèche basse/flèche haute  223
Boutons pour les options de visualisation globale.  134
Boutons Zoom et Setup  43
BPM  49, 456, 462, 495, 496
Bright  395
Buffer Number  526, 527
Buffer Settings  526
Build Loop Object  325
Build Physical Loop  417
Bulles d’informations  261
Burn CD  441
Burn Project Backup on CD  275
Bus AUX  149, 261
Bus de contrôle surround  237
Bus de prémixage (Submix)  261
Bus de prémixage ou Submix  149
Bus et routage  149
Bus Surround  262
Button bar  534
Bypass  132, 149, 190, 344, 363, 388, 401
Bypass all  370
Bypass dyn.  370
Bypass.  388

C
C-Console  185
Call  235
Call external CDAudio Software  441
Canal de sortie MIDI  161
Canal d’entrée MIDI  161
Cancel

343, 363, 365, 372, 377, 383, 389, 393, 406, 412, 428, 450, 487, 498, 520
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Caractère du champ sonore (Pan Setup)  229, 230
Carrier (porteuse)  397
Cascade  533
Cases à cocher FX  99
CD Arrange mode  445
CD Arrangement Mode  494
CD Disc Options....  444
CD Drive Options  435
CD Positions  52
CD Text/MP3 ID Editor  444
CD Title  445
CD Track/Index Manager  443
Center  227
Center channel damping  152
Ces  45
Champ temporel  262
Champs temporels  44
«Change«  119
Change Sample Rate  414
Changement de la durée et de la position de début  69
Changement de la post-production image  26
Changement de l’affichage de forme d’onde  70
Changement de nom  91
Changement de nom et édition d’objet  90
Changement de nom, suppression et collage de piste  91
Changement de programme (Program) et de banque  161
Changements de tempo et de mesure  177
Channel  176
Channel (Canal)  226
Channel configuration (Configuration des canaux)  222
Channels Both  351
Channels Left  350
Channels Right  351
Characteristics  369
Charge du processeur  374
Chargement de fichiers  88
Charger/Sauver Configuration  51
Check Space key for playback stop  528
Chemin d’accès (icône de dossier)  467
Chemins d’accès (Paths)  531
Chevauchement d’objets  74
Circle  352
Circle/Direct  352
Ciseaux  133
Clic droit sur boutons  142
Clic droit sur des valeurs affichées  142
Clic gauche  141
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Clic gauche sur des valeurs affichées  142
Click  478
Clipping Definition  375
Clipping Definition (Définition de l’écrêtage)  375
Close  472
Close all Windows  535
Close Project  287
Coding History  490
Collect Project Files  451
Colors)  51
Commandes de lecture  132
Commandes de transport  435
Comment fonctionne le Dithering?  522
Commutation on/off de l’affichage de forme d’onde  130
Comp Max  361
Comparaison à niveaux de volume constants  374
Comparaison de 2 VIP  72
Comparisonics Audio Search  428
Complete Project  448
Compressor  361
Compteur temporel  47
Compteur temporel (Time Display)  52
CONFIG MEMORY  120
Configuration  436
Configuration des contrôleurs physiques  514
Configuration informatique nécessaire  20
Configuration nécessaire  20
Configurations (Setups), kits de batterie  117
Connect to the Internet  287
Conseils d’utilisation des plug-ins depuis le menu  418
Conseils d’utilisation du module Advanced Dynamics  368
Conseils d’utilisation du réducteur de bruit  384
Conseils d’utilisation du simulateur d’espace (Roo  402
Console de mixage numérique pour ADAT  475
Const. Max. Sum. Output Level Mode  230
Const. Max. Sum. Output Level Mode (Pan Setup)  232
Context Help...  536
Contour seul   303
Contour smooth (lissage de contour)  132
Contrôleur physique  211
Conversion de fréquence d’échantillonnage  413
Conversion d’un VIP stéréo  221
Convert Audio  277
Convert Audio > 1 Mono > LR Wave  279
Convert Audio > 2 Mono > Stereo/LR Wave  278
Convert Audio > Import Audio  277
Convert Audio > LR Wave > 1 Mono  279
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Convert Audio > LR Wave > 2 Mono  279
Convert Audio > Save In Format  277
Convert Audio > Stereo Wave > 2 Mono  278
Convolution  396
Convolution sample  392
Copier les réglages (à l’extrême droite)  59
Copier/Coller  99
Copy  152, 291
Copy mode Burst Copy  437
Copy mode Normal  437
Copy mode Sector Synchronization  437
Copy only samples used in VIP  274
Copy selected Tracks  434
Copy settings to all tracks  233
Copy to all  369
Copy Track(s)  310
Copying VIP marker to Wave project  430
Copying Wave project Marker to VIP  429
Correcteur  143
Correcteur dynamique multibande  358
Correcteur Master  146
Correcteur/analyseur FFT  357
Correction automatique de la hauteur générale  135
Correction automatique de l’enveloppe de hauteur  136
Correction d’augmentation ou diminution de hauteur  136
Correction de hauteur (correction d’intonation)  135
Correction de la détection de hauteur  137
Correction des limites de tranche  138
Correction d’intonation  135
Correction du tempo  122
Correction factor for exact positioning  485
Correction manuelle de la hauteur générale  135
Correction On-/Offbeat  123
Couleurs  51
Couleurs Comparisonics   303
Couleurs de groupe   304
Couleurs des formes d’Onde  303
Couplage des fenêtres MIDI Editor et VIP  165
Couplage des objets  73
Courbe bleu clair  386
Courbe bleu foncé  386
Courbe bleue   346
Courbe d’automation  262
Courbe jaune   346
Courbe orange  128
Courbe rouge   346
Courbes affichées sur le graphique  386
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Courbes d’automation de volume et de panoramique  500, 501, 504, 505
Courbes de filtre  396
Courbes de panoramique personnalisées  78
Courbes de volume personnalisées  76
Courbes d’enveloppes dessinables  400
Court-circuit (bypass) de groupes ou de canaux  238
Create AVI / Audio Copy  283
Create bar markers within current range  125
Create Copy  344, 349, 363, 377, 382, 388, 393, 406
Create Copy seulement dans le menu Offline Effect  416
Create DVD-Audio  441
Create New Project Subdirectory  271
Create new tracks  188
Create Vip Object  468
Création de courbes d’automation  196
Création de «voix de robot »  136
Création de «voix synthétiques»  136
Création de votre configuration personnelle  207
Création d’Objets Remix  123
Création d’un CD audio  244
Création d’un DVD audio  248, 442
Création d’un nouveau fichier par glisser-déposer  330
Création d’un nouveau VIP  220
Création d’une seconde voix  137
Crête-mètres  42
Crête-mètres à LED  42
Ctrl  323, 500
Ctrl-clic gauche  141
Current track + MIDI channel C-Console mono track  186
Curseur (tête) de lecture  262
Curseur à droite du graphique  347
Curseur à gauche du graphique  347
Curseur de panoramique  42, 78
Curseur de volume (Vol.)  347
Curseurs  347
Curve Mode  501
Curve Numbers  352
Curve smooth (lissage de courbe)  131
Cut  290
Cut Mode  506
Cut Objects  252
Cut Objects > Copy Objects  317
Cut Objects > Cut Objects  317
Cut Objects > Delete Object  318
Cut Objects > Duplicate Objects  318
Cut Objects > Duplicate Objects (in place)  318
Cut Objects > Duplicate Objects multiple....  319
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Cut Objects > Extract Object  318
Cut Objects > Insert Objects  317
Cut Objects > Split Object On Marker Positions  319
Cut Objects > Split Object On Track Marker Positio  319
Cut Track(s)  310

D

Dark / Bright  405
DB lin / log  380, 386
DB lin/log (à droite de Freq lin/log)  348
De-clipping  378
De-clipping Mode  376
De-hissing  389
Deactivate  212
Deactivate all MIDI functions  513
Decay  405
Découpe par hauteur (Pitch Slice)  134
Default Project Length  271
Défilement des bords du VIP   306
Définition de l’écrêtage  375
Définition des sélections  94
Définition des sélections et options de recherche.  94
Définitions des sélections («Ranges»)  94
Dehisser  145
Delay (écho/reverb)  143
Delete  290, 364, 372, 436, 510
Delete all Markers  430
Delete all markers  428
Delete Curve Handles  296
Delete Curve Handles > Delete Panorama Handle  296
Delete Curve Handles > Delete Surround Handle  297
Delete Curve Handles > Delete Volume Handle  296
Delete Freeze Data  451
Delete Marker  430
Delete Matching markers  428
Delete Track(s)  310
Delete Undo Levels  297
Delete Virtual Project  276
Delete Wave Project(s)  276
Delta Time  319
Demi Alternance   302
Départs Aux  142
Déplacement des objets  68
Déplacement d’objets   499, 502, 503, 504
Déplacement sur une position déterminée  72
Déplacez la courbe d’automation  199
Des partitions  493
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Description  456, 510
Description des fonctions et réglages de l’éditeur  160
Description générale  398
Description: charge du processeur en fonction des  402
Dessin  235
Dessin avec quantification  133
Destination files (Fichiers de destination)  287
Destructive  337
Destructive Effect Calculation  335
Destructive Mode  493
Detector Hp Filter  107
Déterminer les réglages par défaut du preset  222
Deux courbes de filtre  356
Device  460, 495, 496, 497
Device Info  468
Device Setup (track in/output assignment, routing)  481
Dialogues Effect Routing (FX)  100
Différences entre les dialogues Effect Routing (FX  100
Différences lors du chargement de fichiers audio  67
Diminution de la charge du processeur  374
Direct  352
Direct X / VST Plug-ins  418
Direct/Match  348
Direction Pan  341
DirectX preload buffer size  527
Disable all DirectX effects while Scrubbing  417
Disable Deleting  322
Disable Fade-In/Out  322
Disable Length Changes  322
Disable Menus and Buttons  529
Disable Moving  322
Disable Volume Changes  322
Disk Space  471
Display Filter (filtre d’affichage)  454
Distortion  145, 395, 398
Dithering depth in bits (0.01 - 16.0)  522
Dithering Mode (Real-time conversion)  521
Dithering Options  278
Dithering Options/Advanced Buffer Settings  530
Dithering POW-r  522
Dithering with linear spread noise  522
Dithering with triangular spread noise  522
Données techniques  113
Double-clic sur chiffres  141
Draw Grid  352
Draw mode  386
Draw Mode (Mode d’affichage)  347
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Draw Panorama  506
Draw Volume  506, 507
Draw Wave  507
Drive Name  436
Driver Resolution/Driver Communication  525
Driver System  525
Drum Editor  174
Dry  401, 405
Duplication d’objets  69, 502, 503, 505
Duration  319
Dynamic End  348
Dynamic filter parameters  396
Dynamic reduction  396
Dynamic Start  348
Dynamics  358
Dynamics…  360
Dynamics (généralités)  358
Dynamics/Limiter  145

E

Each Record Take in a new file  469
Early Reflect  400
Echange de fichiers audio «derrière» l’objet  75
Echelle d’affichage  51
Echo Delay / Rev. Time  405
Echo/Delay/Reverb  408
Ecoute (monitoring)  144
Ecoute (monitoring) solo  193
Ectors per Read  437
Edit  99
Edit (édition)  62
Edit a copy of Wave Content  330
Edit Mode (Mode d’édition)  348
Edit Range  254
Edit Range > 0 > Range < 0  423
Edit Range > Beginning of Range < 0  422
Edit Range > Beginning of Range > 0  421
Edit Range > End of Range < 0  422
Edit Range > End of Range > 0  422
Edit Range > Flip Range Left  421
Edit Range > Flip Range Right  421
Edit Range > Move Range end left  421
Edit Range > Move Range end right  421
Edit Range > Move Range start left  420
Edit Range > Move Range start right  420
Edit Range > Range end to right marker  423
Edit Range > Range end to right Object border  423
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Edit Range > Range over all selected Objects  424
Edit Range > Range start to left marker  423
Edit Range > Range start to left Object border  423
Edit Range > Range to beginning  421
Edit Range > Range to end  421
Edit Root VIP  330
Edit root VIP …  215
Edit Time Display  431
Edit workspace  534
Editeur de batterie (Drum Editor)  174
Editeur de liste (Event List)  170
Éditeur d’objet  100
Editeur d’objet   500, 502, 503, 505
Editeur d’objet (Object Editor)  262
Éditeur d’objet MIDI  159
Editeur MIDI  162
Editing  493
Edition  35
Edition d’automation de son surround  241
Edition de projets gelés  216
Edition d’échantillon ou d’audio simple  21
Edition des courbes d’automation  199
Edition des fondus avec les poignées ou dans l’édi  70
Edition des groupes  237
Edition des paramètres de sélection  94
Edition des paramètres d’objet  90
Edition destructive  263
Edition destructive d’un objet  71
Edition d’événements: Piano Roll  166
Edition d’objets MIDI  158
Edition d’onde  263
Effects (Effets)  285
Effects/Routing  314
Effet harmoniseur ou placement d’une seconde voix  137
Effets dans les projets surround  236
Effets dans l’objet  70
Effets des groupes  237
Effets destructifs (menu Offline Effects)  100
Effets d’objet  96
Effets en temps réel  96
Effets et Plug-ins d’effet  95
Elastic Audio  127, 333
Elastic Audio: Overview of the Keyboard Shortcuts  139
Elastic Audio: problèmes et solutions  137
Elastic Audio: Raccourcis-clavier  138
Eléments affichés  225
Emploi de la commande de transport comme télécomma  203



553

Index
Emploi des effets en temps réel  32
Emploi des réponses impulsionnelles surround  239
Emploi du clavier  141
Emploi du Remix Agent  121
En-tête de piste  263
End - Range End  52
Enhancer stéréo multibande  340
Enregistrement  47, 258
Enregistrement à la volée en boucle  473
Enregistrement à la volée ‘en direct’  472
Enregistrement à la volée par le biais de marqueur  473
Enregistrement de nouvelles pistes  30
Enregistrement de pistes MIDI  156
Enregistrement multipiste avec des séquenceurs MID  21
Entrée  142
Entrelacé   303
Enu de mode d’enregistrement audio  48
Env. Time  400
Environnement de travail (Workspace)  264
«EQ Low/Hi»  108
Equalizer  395
Erreur dans la détection de hauteur  138
Ertical  462
Espace de travail (Workspace)  45
Etape 1  245
Etape 2  245
Etape 3  246
Etape 4  246
Evénement actuel  164
Evénements au-dessus ou au-dessous de la visualisa  165
Exchange file  488
Exclude Master Effect  278
Exclude Master Effects from Bouncing  448
Exclude Track Effects of the Target Track  448
Exemple  54, 214, 339
Exemple 1  80
Exemple 1: Comparaison de 2 VIP  72
Exemple 2  80
Exemple 2: Ajout d’effets à un fichier audio  72
Exemple 3  81
Exemple 4  81
Exemple d’application  2  214
Exemple d’application  3  215
Exemple d’application 1  214
Exemples de synchronisation  203
Exemples d’utilisation des marqueurs  82
Exigences  20
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Exit  287
EXP  339
Expander  362
«Expert»  108
Export Audio  279
Export Audio > 32 Bit Float as 16 / 20 / 24 Bit  282
Export Audio > Aiff  282
Export Audio > AIFF File with QuickTime  281
Export Audio > Export as Dump  282
Export Audio > Export MIDI File  282
Export Audio > MP3  280
Export Audio > MP3 with external Encoder  281
Export Audio > MPEG  281
Export Audio > OGG Vorbis  281
Export Audio > Real Audio (*.ra)  281
Export Audio > Wave  280
Export Audio > Windows Media (*.wma)  281
Export to Video deLuxe pro  284
Export TOC  441
Export video sound  283
Extract  292
Extract Audio from Video  484

F
Fade Curve  338
Fade End in %  338
Fade In  339
Fade Out  339
Fade Start in %  338
Fader  146
Fader (panneau de volume)  61
Fader de volume  42, 77, 144
Fast Beats / percussion  380
Fast Rapide (rapide)  367
Feedback  405
Fenêtre Configuration  118
Fenêtre de réglages AUX  150
Fenêtre VIP – Description détaillée  39
FFT EQ  145
FFT Filter/Analyzer...  345
FFT-EQ  401
File  314
File Description  490
File Name  483
Filter Mode (mode de filtrage)  348
Filtre (Filter)  92
Find beat marker  410
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First Beat/Beats  518
Flèches  417
Flèches de déplacement  99
Fonction de dessin libre  133
Fonction Lasso   500, 501, 502, 503, 505
Fonctionnement:  149
Fonctions et réglages de l’éditeur d’objet MIDI  160
Fondu (Fade)  264
Fondu de sortie  79
Fondu d’entrée (Fade-In)  79
Fondu enchaîné (Crossfade)  264
Fondu enchaîné entre deux courbes de filtre  356
Fondus (Fade In/Out)  264
Fondus et fondus-enchaînés  264
Formant  396
Format  278, 449, 465
Format de destination  286
Format new Wave Project  452
Format Surround  220
Formats de synchronisation  200
Formats stéréo et surround  235
France:  24
Freeze  59, 216, 217
Freeze (Gel)  213
Freeze (Gel):  218
Freeze Objects  321
Freeze Objects > Edit Object Freeze  321
Freeze Objects > Unfreeze Objects  321
Freq lin / log  379
Freq lin/log (à droite de Hz/Notes)  348
Freq.  344
Freq. lin / log  386
Frequency Separation  369
Frequency Separation/Gain Enhancement/Reduction  369
FTP Download  287, 531
FX  144, 146, 498
FX Bypass  59
FX/Routing  59

G
Gain  60, 142, 342, 370
Gain (compensation)  366
Gain Db  344
Gain Enhancement  369
Gate  362, 363, 371
Gate Level  366
Gel de bus/bus auxiliaire  218
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Gel des instruments (Freeze)  195
Gel d’objet  217
General MIDI  185
Généralités  227
Généralités concernant la manipulation dynamique  358
Generate a complete new file  440
Gestion des données gelées  213
Gestion des paramètres d’effets surround  237
Gestion des presets  194
Gestion des très nombreux paramètres  373
Gestionnaire de marqueurs (Marker Manager)  92
Gestionnaire de pistes (Track Manager)  90
Gestionnaire de sélections (Range Manager)  93
Gestionnaire d’objets (Object Manager)  89
Gestionnaires d’archives fichiers  25
Get current Range for snap.  492
Get Default for preset  222
Get Global  487
Get level from height  376
Get marker  426
Get noise sample  381
Get parameters  337
Get position and zoom level  251
Get Range  425
Get Range length  425
Get zoom level  251
Glisser-déposer  500
Global Play/Record Device  513
Glossaire  261
Glue MIDI Objects  477
Glue Objects  320
Glue Objects (Réunion d’objets)  215
Glue selected  448
Gomme  133
Gramophone 1 (Medium)  380
Gramophone 2 (Hard)  380
Gravure du CD  247
Gravure d’un CD audio  38
Gravure d’un DVD audio  248
Grid  176
Grid/Bars  493
Grid/Frames  493
Grille active  300
Grille de mesure  301
Grille de plage   301
Grille on/off  134
Grille on/off   301
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Groove  117
GROOVE PRESET  119
Group  124
Group created Objects  319
Group Objects  327
Group objects after multirecord  493
Groupage et gestion des paramètres  239
Groupage/dégroupage d’objets  73
Groupe de contrôle surround  236
Grouper/Dégrouper  148

H

Half Height  535
Halftones  462
Hall  405
Hard  364
Hard broadband noise  380
Hard Tonal noise  380
Hardware Monitoring  476
HD Performance (Track Speed)  527
HD/Scrub Buffer  526
Heal/Unsplit Objects  320
Help  365, 536
Help Index...  536
HF details  111
Hide all Wave Projects  535
Hide audio output channels  188
Hide Menu Items  511
Hide Track  316
Hide Wave Projects loaded into virtual Projects  530
High  387, 400, 412
Highlight Crossfades   304
Horizontal  251, 308
Host Adapter Number  437
Hum  380
Hz/Notes (à droite de Draw mode)  347

I

I/O Devices  481
Iconise all Wave Projects  535
Ignore all Tempo Markers  181
Ignore all Tempo markers, use project tempo  478
Impératifs  120
Importation de fichiers MIDI  155
Impulse I.R.  400
In  474
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IN Ch  161
Independent normalization  337
Indicateur de cache/piste (Track)  50
Indicateur Sync/MIDI In/Out  49
Indicateurs de niveau In/Out  344
Info  513
Info (Fenêtre Record Capabilities)  467
Informations générales  127, 239
Informations sur la piste (Track Info)  40
Input MIDI Device  203
Input monitoring  475
Insert new Tracks > Add one Track  309
Insert new Tracks > Add several Tracks  309
Insert new Tracks > Insert empty track  309
Insert new Tracks > New AUX Bus  309
Insert new Tracks > New Submix Bus  309
Insert new Tracks > New Surround AUX Bus  310
Insert new Tracks > New Surround Bus  309
Insert Silence  292
Insert Track(s)  310
Inserts  142
Installation de Samplitude  23
Instrument  176
Instruments à multiples canaux de sortie  193
Instruments logiciels  187
Intégration de plages de CD comme objets  67
Intégration d’une section d’un projet Wave  71
Intégration d’unités d’effet externes  151
Internal Rate  462
Introduction  86, 89, 90, 93, 153, 159, 177, 182, 200, 206, 248, 441
Inverse de-hissing  388
Inversion de la sélection  68
Invert Filter  349
Invert Phase  331, 343
Iste des fichiers  277
Itch contour  132

J
Jaune  400
Jeu de pattern/kit de batterie  119
Jeu/écoute des instruments en direct  190
Jobs (Tâches)  284
Jog/Two Speed/Shuttle  464
Jogging  85, 461
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K
Keep current number (tracks, Submix busses et AUX)  481
Keep current setup  482
Key (tonique)  132
Kits de batterie (Drum Kits)  117
Knee  105
Knob mode (mode de contrôle de commande)  120

L

Large / Small  405
Larges Poignées   305
Late Reverb  400
Latence  191, 474
Latence du plug-in  417
Latency  401
Le bouton Copy files  489
Le MIDI dans Samplitude  153
Le panneau Fade-in (fondu d’entrée) et Fade out  63
Le panneau Object Loop (boucle d’objet)  65
Le panneau Pitch Shifting/Time Stretching  65
Le panneau Position/Length (position/durée)  62
L’écoute (monitoring)  48
Lecture de marqueurs  93
Lecture/Pause  47
L’éditeur d’objet (Object Editor)  58
L’édition audio orientée objet  54
Len - Range Length  52
Length  111, 176, 400, 452
L’enregistrement multipiste simplifié  27
Les cadres Gain et AUX Sends  60
Les gestionnaires (Managers)  86
Les panneaux Pan/Mute/Invert et Volume  61
Les panneaux Plug-ins et EQ (égaliseur)  60
Les Patches en bref  457
Les poignées d’un objet  57
Level  108
Level (canal droit)  111
Level (canal gauche)  110
LFE  227
LFE-Filter (Réglages de filtrage pour LFE)  224
Liaison des projets de Samplitude à des vidéos  483
Lick  49
Ligne bleue  129
Ligne des caractéristiques  365
Ligne grise  129
Ligne orange  129
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Ligne rouge  128
Limiter  362, 366
Limiter 100  362
Limiter On  371
LINEAR  339
Link  146, 406
Link all Tracks  509
Link all tracks (coupler toutes les pistes)  232
Link bands  370
Link Curves to Objects  508
Link one Track  508
Link until Silence  508
List of used Wave Projects  488
Liste de sélection des échantillons  397
Liste des différents champs  490
Liste des effets  99
Liste des paramètres  208
Liste des prises  454
Liste des projets  276
Load  353, 364, 372, 377, 388, 406, 510
Load (Preset)  383
Load Audio CD Track(s)  274, 433
Load audio file  273
Load file always new  484
Load Setup  393
Load setup  436
Load/Save  511
Load/Save preset)  51
Load/Save/Select (Routing Preset)  100
Load/Save; Patch Load/Save  190
Lock  40
Lock all Audio in Time  508
Lock channel positions in Surround pan dialog  223
Lock Objects > Lock Definitions  322
Lock Objects > Lock Objects  321
Lock Objects > Unlock Objects  322
Lock Recorded Objects  493
LOG  339
Long overlap  409
Look ahead  106, 370
Low  400
Low broadband noise  380

M
MACHINE GLOBALS  119
MAGIX Analogue Modeling Suite (am|track)  25
MAGIX Elastic Audio  25
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Main Toolbar  533
Maintien de crête  51
Make CD…  439
Manager  255
Manager > File Browser/Object Manager  453
Manipulation de la ligne des caractéristiques  366
Manipulation du signal  97
Manipulation dynamique  358
Manual de-clicker  396
Manuellement  183
Marker  471
Marker on Range Borders  426
Marker on Record Position  426
Marker with Name....  425
Marqueur  93, 265
Marqueur de format de mesure  178
Marqueurs  93
Marqueurs audio  305
Marqueurs de position de mesure  178
Marqueurs de tempo  178, 266
Master  100
Master Surround  266
Mastering  37, 244
Match time  454
Matrix – Mode (mode matrice)  231
Max Range (dB)  351
Maximize Track  316
Maximum Reverb time for objects without fadeouts  530
MC Input active  496
MC Output active  496
Mécanismes de groupage d’effets surround  236
Medium broadband noise  380
Medium Tonal noise (e.g.  380
Mémoriser Position et Zoom  306
Mémoriser Zoom  306
Menu  511
Menu «CD/DVD»  433
Menu contextuel  266
Menu de sélection des périphériques  42
Menu «Edit»  288
Menu «File“  270
Menu «File»  220
Menu File Export audio  329
Menu «Help»  536
Menu Items  511
Menu «MIDI»  477
Menu «Object»  317
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Menu «Offline Effects»  334
Menu «Options»  480
Menu «Play/Rec»  458
Menu Range  419
Menu »Real-time Effects»  331
Menu «Tools»  447
Menu «Track»  309
Menu «View»  298
Menu «Window»  533
Menus de sélection des périphériques de lecture  42
Méthodes de mesure des niveaux  366
Metronome active  478
Metronome Options  479
MIDI  314
MIDI Bouncing  477
MIDI Controllers  478
MIDI Controllers/VST Automation…  315
MIDI Éditeur de batterie  26
MIDI Editor  477
MIDI Importation, enregistrement, édition  155
MIDI Machine Control (MMC)  202
Midi metronome  518
MIDI Options  314, 479
MIDI Panic – All notes off  479
MIDI Record Mode  479
MIDI resolution  185, 199
MIDI Thru active  314
Migration  22
Millisec  497
Min level of clipped samples  376
Min number of clipped samples  375
Min Range (dB)  351
Min. Time (ms)  427
Minimize track  316
Minimize Track / Maximize Track / Minimize none  316
Mise en solo de groupes d’effets surround  238
Mix  53, 392, 401
Mix (Reduction)  382
Mix Balance in %  405
Mix Direct/Comp  107
Mixage dans Samplitude  30
Mixage dans un fichier (Mix in File)  34
Mixage en un fichier stéréo  34
Mixdown  147
Mixer  534
Mixer Setup  270
MMC Input ID  203
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MMC Output ID  203
MMC Setup  499
Mode  50, 361, 365, 371, 404
Mode «arrimé»  134
Mode crayon  175
Mode d’affichage  347
Mode d’Affichage VIP  301
Mode d’enregistrement MIDI  49, 157
Mode dessin (Draw)  242
Mode Direct  128
Mode Gomme  175
Mode loupe  175
Mode objet  266
Mode objet unique  134
Mode Relative  128
Mode surround 2 canaux  242
Mode VCA  103
Mode VINTAGE  103
Modélisation analogique de compresseur  102
Modes d’édition  127
Modes panoramiques  227
Modulator<=>Carrier  397
Module Advanced Dynamics  368
Module de panoramique surround  225, 227
Moins  500
Moitié basse: barre de grille  266
Moitié haute: barre des marqueurs  266
Molette JOG & SHUTTLE / Boutons SCRUB  49
Monitoring  190, 266, 475
Monitoring matériel  259
Monitoring Mode / Monitor  468
Monitoring Settings (Record Devices)  527
Mono  146, 315, 466
Mono (Mix)  466
Mono (Mixdown)  315
Mono (réglage Pan L/R)  233
Monophonic Voice  410
Montrer Grille  299
Montrer/Cacher les Bus  299
More  250
More > Clear  294
More > Copy + Clear  294
More > Copy as...  294
More > Crossfade with Clip  295
More > Cut with Ripple  294
More > Delete with Time/Ripple  293
More > Mix with Clip  295
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More > Overwrite with Clip  294
More > Paste with Ripple  294
Mouse Mode Studio 4.0  504
Mouse Mode Toolbar  533
Mouvement de la souris  228
Mouvement de la souris ou Z  228
Move play cursor  254
Move play cursor > Left/Right Move in Page/Scroll  419
Move play cursor > Marker left  420
Move play cursor > Marker right  420
Move play cursor > Object border left/right  420
Move play cursor > to Beginning  419
Move play cursor > to end  419
Move play cursor > to Range end  419
Move play cursor > to Range start  419
Move play cursor > to Section start  419
Move/Edit Objects > Arrange Objects  325
Move/Edit Objects > Move Objects  322
Move/Edit Objects > Object Move Step 1 et Step 2  323
Move/Edit Objects > Object To Original Time Positi  325
Move/Edit Objects > Object To Play Cursor Position  324
Move/Edit Objects > Object/Fade Step Settings  323
Move/Edit Objects > Set Original Time Position  325
Move/Edit Objects/Crossfades  252
MTC Output active  497
Multi Band  341
Multi Band Dynamics  371
Multi Tap  405
Multi-Overdub  479
Multi-track bounce  448
Multiband Dynamics  145, 358
Multiple object selection  337
Mute  40, 144, 417
Mute Objects  325

N
Name  226, 271
Navigateur de fichiers (File Browser)  86
Navigation avec les marqueurs  81
Navigation avec les sélections («Ranges»)  80
Navigation/Favoris  87
New AUX bus  150
New Manager…  453
New MIDI Controller  185
New MIDI Object  477
New Object  317
New Sample Rate  411
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New separate Object in current VIP  449
New Shortcut  510
New VIP  449
New Virtual Project (VIP)  270
New virtual project (VIP)  220
New Virtual Projects  531
New workspace  534
Niveaux de zoom  269
No dithering, 16bit internal resolution  521
No Dithering math rounding of sample value  521
No Effect«  61
No indices on Object Crossfades  439
Noise reduction  382
Noise sample  379
Noise(dB)  397
Nom de la piste  143
Nom d’Objet  305
Nom du Projet   305
Normal  387, 479, 508
Normal Send  212
Normaliser (N)  146
Normalize to  336
Notes sélectionnées  164
Number of first CD Track  445
Number of Objects  319
Number of steady samples after clip (1....10)  376
Numéro de groupe   305

O
Object Amp Simulation  332
Object Color/Name > Object Background Color  328
Object Color/Name > Object Foreground Color  328
Object Color/Name > Object Name  328
Object Dehisser  332
Object DirectX / VST Plug-ins  333
Object Distortion  332
Object Dynamics / Object Advanced Dynamics  332
Object Edges  439
Object Editor  328, 477
Object Editor/Visualization/Transport/Mixer  45
Object EQ  331
Object FFT Filter  331
Object Lasso  431
Object Manager  329
Object Mode  502
Object Multi-band Enhancer  331
Object resampling for new objects  524
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Object Resampling/Timestretching  333
Object Room Simulator  333
Object Switch Channels  331
Object Vocoder  332
Objects  448, 492
Objet   301
Objets  266, 305
Objets Remix en mode de bouclage (Loop)  124
Obtenir les réglages par défaut du preset  222
Offset  484
Offset (décalage de grille)   301
On The Fly»  440
On/Off  99
Only a Wave Project  449
Only marked Range  447
Only to LFE  227
Only tracks with active option «Record/update MIDI  186
Open new Visualization)  51
Open Project  250
Open Project > Edit List (*.EDL)  272
Open Project > HD Wave (HDP)  272
Open Project > MIDI (*.mid)  272
Open Project > Object (*.Obj)  272
Open Project > RAM Wave (RAP)  272
Open Project > Table Of Contents (*.TOC)  273
Open Project > Virtual Project  271
Open Wave Projects in destructive editing mode  528
Open Windows Mixer  468
Opens VIP and Record Window on Program Start  528
Operation  330
Opération  215
Options de correction automatique de hauteur  132
Options de correction automatique de hauteur:  132
Options de recherche  94
Options de visualisation globale  134
Options du lecteur de CD  435
Options étendues pour effets destructifs  335
Options spectrales  51
Orchestral Instruments  381
Ordre de traitement des effets  97
Orienté objet  267
Original Time Position  488
Origination Date  490
Origination Time  490
Originator  490
Originator Reference  490
Oscillators (oscillateurs)  119
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Out (sortie)  147
OUT Ch  161
Outil de courbure  133
Outil de navigation  134
Outil de sélection (flèche)  133
Outil loupe (  134
Output (périphérique audio)  313
Output (sortie)  62
Output MIDI Device  203
Output note  176
Ouvrir l’éditeur MIDI (MIDI Editor)  162
Ouvrir Nouvel Afficheur  51
Overdub  479
Overlap  387
Overlap Mode  397

P

Page  461
Pan  40, 342
Pan L/R  227
Pan L/R mono  231
Pan L/R Stereo  231
Pan Law  229
Pan Setup (configuration de panoramique)  231
Pan/Surround Editor  312
Panneau d’affichage (VIEW)  130
Panneau de transport  46
Panneau EDIT SLICE OBJECT  131
Panneau EDIT VIP-OBJECT  131
Panning law – Mode (Mode loi de panoramique)  229
Panorama  152
Panoramique  143
Panoramique Surround  41, 224
Panoramique surround  235, 241
Panoramique surround basé sur la piste  225
Panoramique surround basé sur les objets  224
Panoramique surround basé sur les pistes  224
Panoramique surround basé sur l’objet  225
Par la commande de menu  71
Parallel  233
Parameters  400
Paramètres de compression  105
Paramètres de couleurs par défaut   303
Paramètres de filtrage dynamique  396
Paramètres de grille  300
Paramètres de la section des transitoires (Transie  110
Paramètres de réglage  398
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Paramètres de réglage du Vocoder  396
Paramètres de traitement dynamique  366
Paramètres d’édition des fréquences de la réverbér  400
Paramètres d’édition des temps de réponse de réver  400
Paramètres d’effets surround  237
Paramètres des mesures  301
Paramètres internes de l’algorithme de réduction  381
Parametric Equalizer  343
Pas de modification de la taille du VIP  306
Passage temporaire en mode Courbe  501
Passage temporaire en mode Objet  501
Paste/Insert Clip  291
PATTERN/DRUM KIT PLAY  119
Pause indices on Object ends  439
PEAK (niveaux de crêtes)  366
Peak change  337
Peak hold  51
Peak maximum  337
Pentium III Optimizations  529
Performance Display  529
Performance Options  401
Périphérique audio (Audio device)  51
Périphérique d’entrée  467
Périphériques  42
Personnalisation de votre surface de contrôle  207
Phase  152
Phase Correlator  342
Piste  100
Piste (Track)  267
Pitch  176, 462
Pitch (Filter shift)  396
Pitch Automation  135
Pitch Shift/Factor (transposition)  65
Pitch Shifting  135
Pitch Slice  134
Pitch-Shifting/Timestretching  407
Pitchshift/Timestretch Mode  506
PL (plug-ins)  143
Place new beat marker  478
Place new beat position marker  478
Place new tempo marker  478
Plages non reconnues  137
Play  379
Play cut  255
Play Cut > Play from Cut end (OutPoint)  459
Play Cut > Play from Cut start  459
Play Cut > Play over Cut/Crossfade  459
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Play Cut > Play to Cut end (OutPoint)  459
Play cut > Play to Cut start  458
Play file always  484
Play In Range  458
Play Loop  458
Play Once  458
Play only selected Objects  458
Play Orig  383
Play original  349
Play Solo  59, 133
Play Video Without Sound  484
Play With Preload  458
Play/Stop  59, 148, 343, 345, 349, 363, 372, 382, 388, 406, 416, 454
Playback Dev  314
Playback Devices  512
Playback mode  256
Playback Mode > Autoscroll soft  463
Playback Mode > Change Play Direction  463
Playback Mode > Loop Mode  463
Playback Mode > O-Tone Mode  463
Playback Options  460
Playback Resampling  524
Playback while Recording  468, 472
Playback/Thru Parameters  314
Plug-in Buffer  527
Plug-ins  42
Plug-ins Master  145
Poignée  267
Poignées d’objets  503, 504, 505
Poignées d’objets   500
Poignées inférieures:  267
Poignées supérieures:  268
Portée dynamique  365
Position à l’écran et niveau de zoom des fenêtres  45
Position bar  533
Position d’origine  304
Positions et types de marqueurs  93
POW-r #1 (Dithering)  522
POW-r #2  522
POW-r #3  522
Pre-delay  400
Pré-écoute des fichiers  87
Precision  351, 381
Precision Real Time  351
Precision Real-time  381
Précision sur la configuration informatique nécess  20
Precount for recordings (Measures)  517
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Prefix  427
Preload  466
Preload at Play Start  527
Preload File Cache during Play Stop  527
Première piste  27
Prémixage de pistes  34
Preroll Frames  497
Preroll time  530
Présentation générale des effets  95
Preset  363, 365, 372
Presets  222, 233, 380, 449
Presets surround  238
Prevent Clip.  349
Preview  349, 367, 377, 383, 388, 393, 486
Preview (seulement dans le menu Offline Effects)  416
Preview time  530
Preview Time (Seconds)  529
Preview time for caching  527
Principes  474
Prise en main – Débutant  27
Problèmes de compatibilité  22
Problèmes et solutions  403
Problèmes et solutions concernant le correcteur  357
Problèmes et solutions concernant le Remix Agent  126
Process only left/right stereo channel  418
Productions multipistes  21
Productions multipistes avec montage vidéo  22
Produire une modulation de la fréquence  136
Program Preferences  499
Program Preferences > Advanced Buffer Settings  525
Program Preferences > Change Toolbar Style  511
Program Preferences > Color Setup  521
Program Preferences > Destructive effect calculati  526
Program Preferences > Dithering Options  522
Program Preferences > Draw Setup  521
Program Preferences > Edit Keyboard Shortcuts and  509
Program Preferences > Edit Toolbars  513
Program Preferences > Font for Time Display  513
Program Preferences > Font Selection  513
Program Preferences > Grid Lines  513
Program Preferences > Metronome Options  519
Program Preferences > MIDI Options  514
Program Preferences > MIDI Options > Hardware  515
Program Preferences > Object Lock Definition  526
Program Preferences > Object Mode  508
Program Preferences > Reset Toolbars  513
Program Preferences > Set PreRoll Time  526
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Program Preferences > Undo Definitions  522
Program Preferences > Video Height  513
Program Preferences > VIP Mouse Mode  499
Program Preferences > Wave (HDP/RAP) Mouse Mode  507
Project and Mixer Configuration:  481
Project Files  531
Project Information  488
Project Options  270, 491
Project Properties  480
Project properties  256
Project Properties > Broadcast Wave Manager  489
Project Properties > CD Arrange Mode  491
Project Properties > Destructive Wave Editing Mode  491
Project Properties > Media Link  482
Project Properties > Mixer Setup  480
Project Properties > Playback Options  482
Project Properties > Text Comments  486
Project Properties > Units of Measurement  491
Project Sample Rate/Volume Damping  491
Project Status  488
Project Surround Setup  221
Project Template  270
Projet virtuel  268
Projets surround  233
Projets virtuels (VIP):  290, 292
Projets Wave  290, 292
Propriétés d’objet   305
Punch/Play bar  533

Q
Q  344
Quality  278, 401, 411
Quand employer le Dithering dans Samplitude?  523
Quand utiliser le Remix Agent?  120
Quantification  171
Quantification audio (Audio Quantization)  123
Quel module utiliser et quand?  358
Qu’est-ce qu’un objet?  56
Quick Access (Accès rapide)  337
Quoi de neuf dans Samplitude 8?  25

R

Raccourcis clavier standards  250
Raccourcis de l’éditeur MIDI  173
Randomize parameters  190
Range  277, 492, 507
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Range all  419
Range bar  533
Range Bouncing  450
Range Editor  430
Range length to  424
Range Manager  431
Ranges Mode  500
Rappel d’effets surround  236
Ratio  105, 366, 370
Ratio/Threshold  362
Read CD/DAT Marker  469
Read ISRC  435
Read Only  487
Rec  40, 53, 315
REC M  48
Recall last Range  430
Receive MMC commands (Slave)  202
Recherche  93
Recherche de piste  91
Recherche d’objets  90
Record  314, 464
Record (périphérique audio)  313
Record button in Record Options can stop recording  470
Record Controller Curves  314
Record Dev.  314
Record Device and File path  467
Record Information  471
Record Mode  466
Record Mode/Punch In  472, 474
Record Mode/Punch In > Live Input Mode  474
Record Mode/Punch In> Punch In Mode  472
Record Offset  468, 513
Record only to RAM  315
Record Options  464
Record Options > Extended Options  469
Record Resampling  524
Record Start /Length  467
Record Time  471
Record without Playback  472
Recording  493
Red Book  244
Redéfinition libre de la hauteur  136
Redo  289
Réducteur de bruit  383
Reduction  369, 387
Réduction du registre des infra-graves  354
Rééchantillonnage ou automation de transposition  135
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Refresh  130
Réglage de l’amplitude d’un instrument  354
Réglage des paramètres d’instrument  189
Réglage des sorties physiques des bus surround  221
Réglage du Vocoder  396
Réglage du volume et du panoramique en temps réel  30
Réglage et estimation des marqueurs de temps  409
Réglages  226
Réglages d’automation/contrôleur MIDI  199
Réglages de compression «Expert»  106
Réglages de filtrage  369
Réglages de panoramique pour les pistes stéréo  152
Réglages de report de pistes  447
Réglages de report de pistesSource:  447
Réglages de système  268
Réglages globaux  147
Réglages globaux d’automation  185
Réglages MIDI  153
Réglages optimaux du paramètre Absorption  389
Réglages spécifiques de piste  184
Réinitialisation totale (Reset all)  51
Release  105, 367, 371
Remain. Time  471
Remarques sur la conversion de fréquence  413
Remix Agent  120, 457
Remove  99, 417
Remove Additional Punch Markers  474
Remove all indices  439
Remove DC Offset  381
Remove index  439
Remove Link  486
Remove Punch In/Out Markers  474
Remove unused Samples  450
Rename Project  276
Repérage audio  84
Replace  454, 479
Replace Audio in Video  283, 484
Replace Objects in current VIP  449
Réponse de réverbération  400
Réponse en fréquences d’un mixage  353
Réponses impulsionnelles stéréo  239
Report (prémixage) de bus Submix  450
Report de pistes surround  234
Report MIDI global (whole Project)  159
Représentation des notes, déplacement, zoom  163
Représentation graphique  399
Reproduction  258



574

Index
Resamp. to 44.1  466
Resample / Timestretching  410
Resampling  407
Resampling Quality  470
Resampling Quality Options  525
Reset  62, 99, 131, 132, 344, 348, 365, 436
Reset (Effect Order)  99
Reset (Mono)  147
Reset (réinitialisation totale)  132
Reset (réinitialisation)  147
Reset (sous l’affichage graphique)  396
Reset (Stereo)  147
Reset all «Don’t show this message again» boxes  530
Reset Aux  147
Reset AUX Sends  150
Reset Beat markers  410
Reset EQ  148
Reset Freehand Envelope  400
Reset FX  148
Reset Peaks  148
Reset Pk  470
Resolution  381, 387
Resolution (Filter bands)  396
Résolution Précision en Hz  350
Restart Play  460
Restaurer Position et Zoom  307
Restaurer Zoom  307
Restore Default  510, 511
Restore default  120
Restriction  216
Result (dB)  392
Retard de déplacement  306
Retour au Début  47
Retour rapide  47
Réunion d’objets  74
Reverb Properties  405
Rite DirectX log file  417
RMS (niveaux efficaces)  366
Robota Pro  113
Rognage d’objets  75
Room Simulator  401, 402
RoomSimulator  146
Root Projects (projets sources)  214
Rouge  399
Routage de la sortie Master  147
Routage de sortie du signal pour la section Master  481
Routage d’effet  150
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Routage des effets (FX Routing)  97
Routage des instruments  192
Routing  482

S

Same file only  454
Same track only  454
Sample (dB)  397
Sample Manipulation > Reverse  417
Sample Manipulation > Sample Data *2  417
Sample Rate  271, 460, 466
Sample Rate/Resolution  467
Saturation  111
Saut à l’objet précédent/suivant  59
Saut aux marqueurs et pré-écoute  93
Sauvegarde des paramètres d’effets (Presets)  95
Save  353, 363, 372, 377, 388, 406, 510
Save & bar info  126
Save (Preset)  383
Save as default  120
Save complete VIP in  274
Save et Load  417
Save, Load, Delete  343
Save Object  275
Save Project  274
Save Project as  274
Save Project as EDL  275
Save Project as Template  275
Save Setup  393
Save setup  436
Save with current setup  120
Scale  132
Scrub left /right  464
Scrubbing  461
Scrubbing (repérage)  85
Scrubbing active  464
Scrubbing Mode  507
Scrubbing Mode / Zoom Mode  508
SCSI-ID  437
SCSI-LUN  437
Section  268
Section active quand on utilise les niveaux de zoo  269
Section Compresseur  102
Section «CONFIG MEMORY»:  120
Section des transitoires (Transients)  110
Section générale Master   329
Section «GROOVE PRESET»:  119
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Section «MACHINE GLOBALS»:  119
Section Master  145
Section «PATTERN/DRUM KIT PLAY» (jeu de pattern)  119
Section Tape  108
Sections  251, 298
Sections «Saturation» et «HF details»  111
Sel. In Range  478
Select all Tracks  435
Select Objects  254, 489
Select Objects > Deselect Objects  326
Select Objects > Object-Lasso  327
Select Objects > Select All Objects  326
Select Objects > Select next Object  327
Select Objects > Select Objects  326
Select Objects > Select previous Object  327
Select Objects > Switch Selection  326
Sélecteur de périphérique de sortie «Output»  99
Sélecteur de périphérique d’entrée «Input»  99
Sélection  175, 501, 505
Sélection (Range)  269
Sélection de fichier  276
Sélection de marqueur  92
Sélection des événements  165
Sélection des groupes pour l’édition  237
Sélection des objets  90, 499, 504
Sélection des objets   502, 503
Sélection des objets tranchés et des objets VIP  135
Sélection des périphériques  42
Sélection des pistes  91
Sélection d’objets multiples  337
Sélection et assignation des contrôleurs  182
Sélection et désélection d’un objet  68
Sélection et désélection multiples  68
Sélection et édition d’événements  168
Sélectionnez la «note de déclenchement»  119
Sélectionnez le canal de jeu «channel»  119
Sélections  499
Send controller data  186, 200
Send Incoming Back  212
Separated MIDI input and audio output channels  189
Séparer Stéréo   303
Séquence des étapes:  151
Séquenceur  115
Set also Pause indices on Object ends  439
Set CD End (Set CD end Marker)  438
Set cursor to record end position  469
Set Default for current preset  222
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Set Global  487
Set Hotspot  326
Set markers on silence....  427
Set Pause (Set CD Pause index)  438
Set Pause Time....  445
Set Start/End Marker  474
Set Sub index (Set CD Sub index)  437
Set Track (Set CD Track Index )  437
Set Track Indices on Object Edges  438
Set track Indices on Object edges – Options  439
Set Track Indices on Silence  438
Set/Get  402
Settings  349
Settings > Analysis Parameters  350
Settings > Draw Settings  352
Settings > Dynamic Filter Mode  352
Settings > Filter Parameters  351
Settings > Resolution  353
Setup  45, 50, 149, 370
Shift  324
Shift-clic gauche sur des boutons  141
Shift-clic gauche sur des sélecteurs ou des faders  141
Show CDR drive Information....  442
Show confirmation dialog (OK, delete) after record  470
Show current Video Frames  486
Show maximum Amplitude  448
Show Menu Items  510
Show Project ToolTips  529
Show received data automatically  186, 200
Show Shortcut List  510
Show small record window during recording/punch  469
Show TOC  441
Show Video Track  485
Simulateur de bande am|track  102
Simulateur d’espace  402
Simulateur d’espace surround  239
Simulation de bande  109
Simulation d’espace surround  240
Simulation d’espace surround – Théorie et pratique  240
Singing Voice  380
Skin  532
Slots de Plug-in  43
Smooth  387, 408
Smooth Attack  382
Smooth Release  382
Smooth/Normal)  397
SMPTE  497
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SMPTE Generator  452
SNAP  49
Snap Offset to project start  493
Snap to  492
Snap/Grid  492
Snapshots  116
Snapshots (configurations de mixage)  148
Soft  364, 461
Software Monitoring / Software FX Monitoring  476
Sollicitation du processeur par le surround  241
Solo  40, 144, 342, 371, 417
Solo (S)/Mute (M)  149
Solo de groupes d’effets surround  238
Son Surround  220
Son Surround 12-canaux, effets Surround  25
Songs  380
Sorties individuelles  193
Sound field  226
Soundfield – Mode (Mode champ sonore)  228
Soundfield Character  232
Soundfield Offset (décalage du champ sonore)  232
Source files (Fichiers sources)  285
Speaker  395
Speaking Voice  380
Special Options  277
Spectral Editor - Algorithmix reNOVAtor  396
Spectral options)  51
Speed  51
Split Objects  319
Split Range for Video  424
Split VIP Objects  428
St. - Position / Range Start  52
Standard  303, 412
Start all Object related Plug-Ins at play start  417
Start Number  427
Start Track (à gauche des voies)  147
Start Windows Explorer  456
Start wizard/Tip of the day  536
Static  348
Static Filter Smooth  382
Statistic (brief)  454
Statistic (verbose)  454
Status bar  534
Stereo  61, 315, 466
Stereo (largeur de base)  342
Stereo Channel => Carrier  397
Stereo Enhancer  61, 339
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Stereo Enhancer (StE)  146
Stereo Thru  234
Stereo width  152
Stop  459
Stop and Go to Current Position  459
Stop/Play  133
Store marker  425
Store position and zoom level  251
Store Range  424
Store zoom level  251
Stretch Length/Factor (changement de tempo)  65
Strip Silence  292
Suite de modélisation analogique  102
Suivre Fades/Courbes   302
Suppression, changement de nom et édition d’objet  90
Suppression des marqueurs  93
Suppression des marqueurs et changement des noms  93
Suppression du vibrato  136
Suppression et collage de pistes  91
Suppression manuelle des données gelées  214
Suppression ou réaffectation des marqueurs d’entré  473
Surround d’objet  62
Surround Panorama Module  225
Surround Room Simulator  239
Surround Send (départ surround)  62
Surround Trackbouncing:  449
Swing  119
Switch Channels  339
Symboles pour copier les réglages  59
Sync Sectors  437
Sync Velocity  498
Synchronisation  204
Synchronisation du VIP  134
Synchronisation MIDI  201
Synchronization active  494
Synchronization Setup  494
Synchronization to Audio playback  484
Synthèse  114
System Information...  536
System/Audio  526
System/Audio > Colors  532
System/Audio > MIDI/Metronome Options  529
System/Audio > Path/Skins  532
System/Audio > Playback Devices  526
System/Audio > Program Options  529
System/Audio > Record Devices  529
System/Audio > View Options  532
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T
Table de mixage  220
Take  471
Take +  471
Take Manager  329
Take Manager…  453
Tap Tempo  122
Tape monitoring  476
Techniques de travail avec les objets  67
Témoin d’utilisation du processeur et vitesse de g  247
Témoin PL  59
Témoins d’utilisation processeur  46
Tempo Alignment  124
Tempo/Beat markers  478
Temporary files  531
Test  428
Test Buffer  527
Tête de lecture  499
Tête de lecture   501, 505
Text file  435
Threshold  105, 352, 366, 371
Threshold (dB)  427
Tile  533
Time Display  534
Time Offset  439
Time Offset for indices on Object Edges  439
Timeout for user input  186, 199
Timestamp  490
Timestretch/Pitchshift Patcher  456
Tone  132
Touche  500
Tracer Contour   303
Tracer Forme d’onde   302
Track  471
Track Bouncing....  447
Track Effects  311
Track Effects > Aux Sends  312
Track Effects > Copy/Paste Track Effects Settings  311
Track Effects > Reset Track Effects settings  312
Track Effects > Track Dynamics/Distortion/Delay  312
Track Effects > Track Routing Dialog  311
Track Freeze (Gel de piste)  216
Track Freeze/Edit Track Freeze/Track Unfreeze  316
Track Information  313, 478
Track information  494
Track MIDI Record  478
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Track name  315
Track Number  271
Track number (0 for all)  482
Track Properties  310
Track properties  252
Track selection  131
Track Type  314
Track Visualization  315
Track/Dev  313
Traitement des signaux  233
Trajet de signal avec monitoring d’effet virtuel  260
Trajet de signal avec monitoring logiciel  260
Trajet du signal  258
Trajet du signal avec monitoring  259
Transitoires (Transients)  110
Transmit MMC commands (Master)  202
Transp  161
Transparent  303
Transport Control  535
Transposition/compression temporelle  407
Travail avec l’éditeur de contrôleurs  168
Travail avec l’éditeur MIDI  163
Travail avec les marqueurs de tempo  179
Travail avec les plug-ins  415
Travail créatif avec am|pulse  112
Travail dans la fenêtre VIP  76
Treat knobs like faders  529
Trim MIDI Objects  477
Trim Objects  320
Troubleshooting  441
Tune  132
Tuning mode (mode d’accord)  119
Two Speed  85, 461
Type  344, 497
Type de Grille  299
Types de courbe  346

U
Ultra High 1  412
Ultra High 2  412
Undo  289
Undo History  289
UnFreeze (Dégel)  217, 218, 219
Ungroup Objects  328
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Use crossfades  124
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Use Snap Offset also for Grid  493
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Used numbers  185
Utilisation de la table de mixage  141
Utilisation de la table de mixage avec la souris  141
Utilisation de Samplitude comme processeur d’effet  475
Utilisation des plug-ins  418
Utilisation du Dehisser  389
Utilisation du gestionnaire de prises  454
Utilisation du réducteur de bruit  383
Utiliser l’offset pour la grille   301
Utomation de transposition  135

V
Value/Range)  51
Varipitch  462
«Velocity»  119
Verrouillage des marqueurs  46
Verrouillage des objets  71
Verrouillage vertical  298
Vertical  251, 308
Very High  412
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Video in Samplitude Window  485
View Mode  379
VIP  304
VIP au format Surround  221
VIP Buffer  526
Virtual  337
Virtual Actions  520
Visual Refresh Time  186, 200
Visualisation  50, 269
Visualisation et sélection de marqueur  92
Visualisation et sélection des pistes  91
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VST automation resolution  186, 200
VST-Instrument Editor  478
VST-Plug-ins  531
Vue générale des boutons  537

W
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Wave (Destructive)  520
Wave Editing  329
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Waveform Generator  452
Waveform Parameters  452
Wet  401, 405
Whole Project  478
Width  229
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Workspace bar  533

X

X-Sym. (réglage Pan L/R)  233
XY-Sym  233

Y
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Z

Zero Latency Monitoring (ZLM)  468
Zoom  45, 82, 347, 505
Zoom 100%  130
Zoom à l’aide de la barre de défilement  83
Zoom à l’aide de la barre d’outils de position  83
Zoom à l’aide de la souris  83
Zoom à l’aide des boutons de zoom de la barre  84
Zoom à l’aide du clavier  83
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